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Introducing Designer
Welcome to Designer

0HHW WKH DOO QHZ 'HVLJQHU IURP 0LFURJUDI[� ZLWK D QH[W�JHQHUDWLRQ

LQWHUIDFH WKDW ZRUNV WKH ZD\ \RX GR� 'HVLJQHU DQWLFLSDWHV \RXU QH[W PRYH�

XVLQJ FRQWH[W VHQVLWLYLW\ WR JLYH \RX WKH WRROV \RX QHHG DW WKH PRPHQW \RX

QHHG WKHP� 'HVLJQHU LV H[WUHPHO\ FXVWRPL]DEOH�

:KHWKHU \RX QHHG D VLPSOH FLUFOH� D VHULHV RI URWDWHG RYHUODSSLQJ LPDJHV�

FXVWRP�ZDUSHG WH[W� RU D FRPSOH[ WHFKQLFDO LOOXVWUDWLRQ� \RX FDQ GR LW ZLWK

'HVLJQHU� $QG WKH UHVXOWV ZLOO VKRZ LQ WKH KLJKHVW UHVROXWLRQ RI \RXU GLVSOD\�

SULQWHU� RU LPDJLQJ GHYLFH�
I n t r o d u c i n g  D e s i g n e r  13



'HVLJQHU JLYHV :LQGRZV XVHUV D ZKROH QHZ OHYHO RI DFFXUDF\ DQG SUHFLVLRQ LQ

WHFKQLFDO LOOXVWUDWLRQ� ,W GHOLYHUV VRSKLVWLFDWHG REMHFW FUHDWLRQ DQG HGLWLQJ

IHDWXUHV� LPSUHVVLYH WH[W KDQGOLQJ� DQG PRUH� <HW LW
V DOO VXUSULVLQJO\ HDV\ WR

OHDUQ DQG XVH�

DRAWN BY:

DATE: SCALE: SH OF
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XXXXXX

XXXXXXX

XXXXXXXX

XXXXXXX

BELT TIGHTENER

SCOTT D. WEBB
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New Features

'HVLJQHU JLYHV :LQGRZV XVHUV D ZKROH QHZ OHYHO RI DFFXUDF\ DQG SUHFLVLRQ LQ

WHFKQLFDO LOOXVWUDWLRQ� ,W GHOLYHUV VRSKLVWLFDWHG REMHFW FUHDWLRQ DQG HGLWLQJ

IHDWXUHV� LPSUHVVLYH WH[W KDQGOLQJ� DQG PRUH� <HW LW
V DOO VXUSULVLQJO\ HDV\ WR

OHDUQ

v (QKDQFHG :HE RXWSXW�([SRUW D 'HVLJQHU SURMHFW WR D -DYD $SSOHW�

v '\QDPLF 'LPHQVLRQLQJ�3RZHUIXO GLPHQVLRQ OLQHV QRZ LQFOXGH

DQJXODU DQG UDGLDO GLPHQVLRQ OLQHV�

v $UHD� 9ROXPH� DQG 3HULPHWHU FDOFXODWLRQ

v $VVRFLDWLYH 'LPHQVLRQLQJ�/LQN D GLPHQVLRQ OLQH WR WKH YHUWH[ SRLQWV

RQ DQ LWHP EHLQJ PHDVXUHG�

v 'LJLWL]HU VXSSRUW�/HWV \RX XVH D GLJLWL]HU WDEOHW DQG SXFN DV DQ LQSXW

GHYLFH�

v 7H[W VHDUFKHV

v 0DJQLILFDWLRQ HIIHFW�/HWV \RX XVH DQ REMHFW DV D YLHZLQJ OHQV�

v 2EMHFW ([SORUHU�6KRZV DOO REMHFWV E\ WKHLU QDPHV� /HWV \RX GUDJ

REMHFWV WR PRYH WKHP EHWZHHQ JURXSV DQG OD\HUV�

v '5: )LOH )RUPDW 6XSSRUW�2SHQ '5: ILOHV FUHDWHG LQ 0LFURJUDI[

:LQGRZ
V 'UDZ RU L*UDI[ EXVLQHVV *UDSKLFV GLUHFWO\ LQWR 'HVLJQHU�

v (QKDQFHG 'LVSOD\ YLHZ�6KRZV D VPRRWK YLHZ RI D 'HVLJQHU ILOH�

v 7ULPPLQJ IXQFWLRQV�7ULP REMHFWV DFFXUDWHO\ DJDLQVW RWKHU REMHFWV�

v ([WHQG � ([WHQGV RQH RU ERWK OLQHV RI D VHOHFWHG REMHFW WR PHHW D

VHFRQG REMHFW�

v $FWLYH 6QDS�'\QDPLFDOO\ FUHDWHV VQDS SRLQWV RYHU H[LVWLQJ REMHFWV�

v 6WLFN\ /LQHV�$WWDFK DW WKH HQGV WR RWKHU H[LVWLQJ REMHFWV� $ VWLFN\ OLQH

UHPDLQV DWWDFKHG WR LWV PDWHG REMHFW HYHQ LI \RX PRYH WKH REMHFW�

v 'UDJ DQ REMHFW IURP RQH OD\HU GLUHFWO\ RQWR DQRWKHU OD\HU�

v 9DULDEOH 7UDQVSDUHQF\�/HWV \RX VHW DQ REMHFW
V WUDQVSDUHQF\�

v (QKDQFHG 6KRUWFXW 0HQXV�&OLFN WKH ULJKW PRXVH EXWWRQ WR SRS XS D

FRQWH[W�VHQVLWLYH VHW RI FRPPDQGV IRU TXLFN GUDZLQJ DQG HGLWLQJ�
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��WKLV /LFHQVH�� SHUPLWV \RX WR XVH RQH FRS\ RI WKH 0LFURJUDI[

VRIWZDUH SURGXFW ��WKH 6RIWZDUH�� RQ DQ\ VLQJOH FRPSXWHU� ,I WKH

6RIWZDUH LV SHUPDQHQWO\ LQVWDOOHG RQ WKH KDUG GLVN RU RWKHU VWRUDJH

GHYLFH RI D FRPSXWHU� WKHQ WKH SHUVRQ DXWKRUL]HG WR XVH VXFK

FRPSXWHU DOVR PD\ XVH WKH 6RIWZDUH RQ D SRUWDEOH FRPSXWHU� ODSWRS

RU KRPH FRPSXWHU VR ORQJ DV WKH 6RIWZDUH LV QRW XVHG RQ ERWK

FRPSXWHUV DW WKH VDPH WLPH� ,I VXFK SHUVRQ
V DXWKRUL]DWLRQ WR XVH VXFK

FRPSXWHU FHDVHV IRU DQ\ UHDVRQ �H�J� WHUPLQDWLRQ RI HPSOR\PHQW��

WKHQ VXFK SHUVRQ
V DXWKRULW\ WR XVH WKH VRIWZDUH RQ D SRUWDEOH

FRPSXWHU� ODSWRS DQG KRPH FRPSXWHU ZLOO FHDVH� 7KH 6RIWZDUH LV

OLFHQVHG DV D VLQJOH XQLW� DQG LWV FRPSRQHQW SURJUDPV PD\ QRW EH

VHSDUDWHG IRU XVH RQ GLIIHUHQW FRPSXWHUV� <RX PXVW DFTXLUH DQG

GHGLFDWH D OLFHQVH IRU HDFK VHSDUDWH FRPSXWHU RQ ZKLFK WKH 6RIWZDUH

LV LQVWDOOHG RU UXQ IURP WKH VWRUDJH GHYLFH� $ /LFHQVH IRU WKH 6RIWZDUH

PD\ QRW EH VKDUHG RU XVHG FRQFXUUHQWO\ RQ GLIIHUHQW FRPSXWHUV�

,QVWDOODWLRQ DQG�RU XVDJH RQ D QHWZRUN VHUYHU UHTXLUHV D /LFHQVH IRU

HYHU\ XVHU ZKR DFFHVVHV WKH 6RIWZDUH DW DQ\ WLPH�
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2 2:1(56+,3� 7LWOH� RZQHUVKLS ULJKWV� DQG LQWHOOHFWXDO SURSHUW\ ULJKWV

LQ DQG WR WKH 6RIWZDUH ZLOO UHPDLQ LQ 0LFURJUDI[ DQG LV SURWHFWHG E\

8QLWHG 6WDWHV FRS\ULJKW ODZV DQG LQWHUQDWLRQDO WUHDW\ SURYLVLRQV� 7KHUH

LV QR WUDQVIHU WR \RX RI DQ\ WLWOH WR RU RZQHUVKLS RI WKH 6RIWZDUH DQG

WKLV /LFHQVH VKRXOG QRW EH FRQVWUXHG DV D VDOH RI DQ\ ULJKW LQ WKH

6RIWZDUH� <RX PXVW WUHDW WKH 6RIWZDUH OLNH DQ\ RWKHU FRS\ULJKWHG

PDWHULDOV� H[FHSW WKDW \RX PD\ HLWKHU �D� PDNH RQH FRS\ RI WKH

6RIWZDUH VROHO\ IRU EDFNXS RU DUFKLYDO SXUSRVHV� RU �E� WUDQVIHU WKH

6RIWZDUH WR D VLQJOH KDUG GLVN SURYLGHG WKDW \RX NHHS WKH RULJLQDO

VROHO\ IRU EDFNXS RU DUFKLYDO SXUSRVHV� <RX PD\ QRW FRS\ ZULWWHQ

PDWHULDOV DFFRPSDQ\LQJ WKH 6RIWZDUH� <RX PD\ XVH WKH 6RIWZDUH LQ

\RXU RZQ SHUVRQDO DQG EXVLQHVV GRFXPHQWV DV ORQJ DV \RX DUH QRW

VHOOLQJ WKH RXWSXW JHQHUDWHG E\ WKH 6RIWZDUH RU DQ\ UHODWHG VHUYLFHV�

<RX PD\ PRGLI\ WKH 6RIWZDUH DQG�RU PHUJH LW LQWR DQRWKHU FRPSXWHU

SURJUDP WR WKH H[WHQW QHFHVVDU\ IRU \RXU RZQ XVH RQ WKH QHWZRUN RU

FRPSXWHU� EXW DQ\ SRUWLRQ RI WKH 6RIWZDUH PHUJHG LQWR DQRWKHU

FRPSXWHU SURJUDP ZLOO FRQWLQXH WR EH VXEMHFW WR WKLV /LFHQVH�

3 83*5$'(6� ,I WKH 6RIWZDUH LV ODEHOHG DV DQ XSJUDGH� \RX PXVW EH

SURSHUO\ OLFHQVHG WR XVH D SURGXFW LGHQWLILHG E\ 0LFURJUDI[ DV EHLQJ

HOLJLEOH IRU WKH XSJUDGH LQ RUGHU WR XVH WKH 6RIWZDUH� 7KH 6RIWZDUH

ODEHOHG DQ �XSJUDGH� UHSODFHV DQG�RU VXSSOHPHQWV WKH SURGXFW WKDW

IRUPHG WKH EDVLV IRU \RXU HOLJLELOLW\ IRU WKH XSJUDGH� 7KH XSJUDGH PD\

QRW EH VHSDUDWHG IRU XVH IURP WKH SURGXFW� RU WUDQVIHUUHG VHSDUDWHO\

RU XVHG RQ PRUH WKDQ RQH FRPSXWHU H[FHSW DV VHW IRUWK DERYH�

4 27+(5 5(675,&7,216� 7KLV /LFHQVH LV \RXU SURRI RI OLFHQVH WR

H[HUFLVH WKH ULJKWV JUDQWHG KHUHLQ DQG PXVW EH UHWDLQHG E\ \RX� <RX

PD\ QRW UHQW RU OHDVH WKH 6RIWZDUH� EXW \RX PD\ WUDQVIHU \RXU ULJKWV

XQGHU WKLV /LFHQVH RQ D SHUPDQHQW EDVLV SURYLGHG WKDW \RX WUDQVIHU WKLV

/LFHQVH� WKH 6RIWZDUH DQG DOO DFFRPSDQ\LQJ ZULWWHQ PDWHULDOV� \RX

UHWDLQ QR FRSLHV� DQG WKH UHFLSLHQW DJUHHV WR WKH WHUPV RI WKLV /LFHQVH�

<RX PD\ QRW WUDQVODWH� GHFRPSLOH� RU GLVDVVHPEOH WKH 6RIWZDUH RU

PDNH DQ\ DWWHPSW WR GLVFRYHU WKH VRXUFH FRGH WR WKH 6RIWZDUH� ,I WKH

6RIWZDUH LV DQ XSGDWH� DQ\ WUDQVIHU PXVW LQFOXGH WKH XSGDWH DQG DOO

SULRU YHUVLRQV� )XUWKHU� \RX PD\ QRW SODFH WKH 6RIWZDUH RQWR D VHUYHU

VR WKDW LW LV DFFHVVLEOH YLD D SXEOLF QHWZRUN VXFK DV WKH ,QWHUQHW�
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5 08/7,3/( 0(',$� <RX PD\ UHFHLYH WKH 6RIWZDUH LQ PRUH WKDQ RQH

PHGLXP� 5HJDUGOHVV RI WKH W\SH RU VL]H RI WKH PHGLXP \RX UHFHLYH� \RX

PD\ XVH RQO\ WKH PHGLD DSSURSULDWH IRU \RXU VLQJOH GHVLJQDWHG

FRPSXWHU RU QHWZRUN VHUYHU� <RX PD\ QRW XVH DQ\ RWKHU PHGLD RQ

DQRWKHU FRPSXWHU RU FRPSXWHU QHWZRUN� RU ORDQ� UHQW� OHDVH� RU

WUDQVIHU WKHP WR DQRWKHU XVHU H[FHSW DV SDUW RI D WUDQVIHU RU RWKHU XVH

H[SUHVVO\ SHUPLWWHG E\ WKLV /LFHQVH�

6 /,0,7(' :$55$17<� 0,&52*5$); :$55$176 7+$7 7+(

62)7:$5( :,// 3(5)250 68%67$17,$//< $&&25',1* 72

7+( $&&203$1<,1* :5,77(1 0$7(5,$/6 )25 1,1(7< ����

'$<6 )520 7+( '$7( 2) 25,*,1$/ 385&+$6(� 0,&52*5$);

',6&/$,06 $// 27+(5 :$55$17,(6�� (,7+(5 (;35(66 25

,03/,(' �,1&/8',1* :,7+287 /,0,7$7,21� ,03/,('

:$55$17,(6 25 0(5&+$17$%,/,7< $1' ),71(66 )25 $

3$57,&8/$5 385326(� &21&(51,1* 7+,6 62)7:$5( $1'

,76 $&&203$1<,1*:5,77(1 0$7(5,$/6� 6RPH MXULVGLFWLRQV GR

QRW DOORZ OLPLWDWLRQV RQ GXUDWLRQ RI DQ LPSOLHG ZDUUDQW\� VR WKH DERYH

OLPLWDWLRQ PD\ QRW DSSO\ WR \RX� 7KLV OLPLWHG ZDUUDQW\ JLYHV \RX VSHFLILF

OHJDO ULJKWV� <RX PD\ KDYH RWKHUV ZKLFK YDU\ E\ MXULVGLFWLRQ�

7 5(0(',(6� 0LFURJUDI[
V HQWLUH OLDELOLW\ DQG \RXU H[FOXVLYH UHPHG\ ZLOO

EH UHSODFHPHQW RI WKH 6RIWZDUH E\ 0LFURJUDI[ WKDW GRHV QRW PHHW

0LFURJUDI[
V /LPLWHG :DUUDQW\ DQG WKDW LV UHWXUQHG WR 0LFURJUDI[ ZLWK

D FRS\ RI \RXU UHFHLSW� 7KLV /LPLWHG :DUUDQW\ LV YRLG LI IDLOXUH RI WKH

6RIWZDUH KDV UHVXOWHG IURP DFFLGHQW� DEXVH� RU PLVDSSOLFDWLRQ� $Q\

UHSODFHPHQW 6RIWZDUH ZLOO EH ZDUUDQWHG IRU WKH UHPDLQGHU RI WKH

RULJLQDO ZDUUDQW\ SHULRG RU WKLUW\ ���� GD\V� ZKLFKHYHU LV ORQJHU�

8 /,0,7$7,21 2) /,$%,/,7<� ,Q QR HYHQW ZLOO 0LFURJUDI[ RU LWV VXSSOLHUV

EH OLDEOH IRU DQ\ GDPDJHV ZKDWVRHYHU �LQFOXGLQJ� ZLWKRXW OLPLWDWLRQ�

GDPDJHV IRU ORVV RI EXVLQHVV SURILWV� EXVLQHVV LQWHUUXSWLRQ� ORVV RI

EXVLQHVV LQIRUPDWLRQ� RU RWKHU SUHFXQLDU\ ORVV� DULVLQJ RXW RI WKH XVH RU

LQDELOLW\ WR XVH WKH 6RIWZDUH� HYHQ LI 0LFURJUDI[ KDV EHHQ DGYLVHG RI WKH

SRVVLELOLW\ RI VXFK GDPDJHV� %HFDXVH VRPH VWDWHV GR QRW DOORZ WKH

H[FOXVLRQ RU OLPLWDWLRQV RI FRQVHTXHQWLDO RU LQFLGHQWDO GDPDJHV� WKH

DERYH OLPLWDWLRQV PD\ QRW DSSO\ WR \RX�

9 (;3257 5(675,&7,216� <RX PD\ QRW H[SRUW RU UHH[SRUW WKH

6RIWZDUH RU DQ\ XQGHUO\LQJ LQIRUPDWLRQ RI WHFKQRORJ\ H[FHSW LQ IXOO

FRPSOLDQFH ZLWK DOO 8QLWHG 6WDWHV DQG RWKHU DSSOLFDEOH ODZV DQG

UHJXODWLRQV�
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10 8�6� *29(510(17 5(675,&7(' 5,*+76� 7KH 6RIWZDUH DQG

GRFXPHQWDWLRQ DUH SURYLGHG ZLWK 5(675,&7(' 5,*+76� 8VH�

GXSOLFDWLRQ� RU GLVFORVXUH E\ WKH JRYHUQPHQW LV VXEMHFW WR UHVWULFWLRQV

DV VHW IRUWK LQ VXESDUDJUDSK �F� ��� �LL� RI WKH 5LJKWV LQ 7HFKQLFDO 'DWD

DQG &RPSXWHU 6RIWZDUH FODXVH DV ')$56 ������������ RU

VXESDUDJUDSKV �F� ���� DQG ��� RI WKH &RPPHUFLDO &RPSXWHU

6RIWZDUH�� 5HVWULFWHG 5LJKWV DW �� &)5 ���������� DV DSSOLFDEOH� DQG

DQ\ DPHQGPHQWV WKHUHWR� &RQWUDFWRU�PDQXIDFWXUHU LV 0LFURJUDI[� ,QF��

���� $UDSDKR 5G�� 5LFKDUGVRQ� 7; ������ 86$�

11 0,6&(//$1(286 3529,6,216� 7KLV /LFHQVH LV JRYHUQHG E\ WKH ODZV

RI WKH 6WDWH RI 7H[DV� 86$ �DQG QRW E\ WKH ���� 8QLWHG 1DWLRQV

&RQYHQWLRQ RQ &RQWDFWV IRU WKH ,QWHUQDWLRQDO 6DOH RI *RRGV� DV

DPHQGHG�� 7KLV LV WKH HQWLUH DJUHHPHQW EHWZHHQ XV UHODWLQJ WR WKH

6RIWZDUH DQG VXSHUVHGHV DQ\ SXUFKDVH RUGHU� FRPPXQLFDWLRQ�

DGYHUWLVLQJ� RU UHSUHVHQWDWLRQ FRQFHUQLQJ WKH 6RIWZDUH� 1R FKDQJH RU

PRGLILFDWLRQ RI WKLV /LFHQVH ZLOO EH YDOLG XQOHVV LW LV LQ ZULWLQJ DQG LV

VLJQHG E\ 0LFURJUDI[� ,I WKLV 6RIWZDUH ZDV DFTXLUHG RXWVLGH WKH 8QLWHG

6WDWHV� WKHQ ORFDO ODZ PD\ DSSO\� ,I \RX DFTXLUHG WKLV 6RIWZDUH LQ

&DQDGD� \RX DJUHH WR WKH IROORZLQJ�

7KH SDUWLHV WR WKLV /LFHQVH KDYH H[SUHVVO\ UHTXLUHG WKDW WKH /LFHQVH EH GUDZQ

XS LQ WKH (QJOLVK ODQJXDJH�

/HV SDUWLHV DX[ SUHVHQWHV RQW H[SUHVVHPHQW H[LJH TXH ODV SUHVHQWH

FRQYHQWLRQ VRLHQW UHGLJHHV HQ ODQJXH DQJODLVH�

)RU PRUH LQIRUPDWLRQ DERXW 0LFURJUDI[
V OLFHQVLQJ SROLFLHV� SOHDVH FDOO

0LFURJUDI[ &XVWRPHU 6HUYLFH DW ������������� RU ZULWH� 0LFURJUDI[

&XVWRPHU 6DOHV DQG 6HUYLFH� ���� $UDSDKR 5G�� 5LFKDUGVRQ� 7; ������ 86$�

5HYLVHG �����
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License Agreement Frequently Asked Questions

W hat is the si gnificance of the Micro grafx software license 
agreement?

7KH OLFHQVH DJUHHPHQW LV WKH GRFXPHQW XQGHU ZKLFK 0LFURJUDI[ JUDQWV \RX�

WKH HQG XVHU� WKH ULJKW WR XVH WKH VRIWZDUH SURGXFW� ,Q DGGLWLRQ WR WKH HQG

XVHU OLFHQVH DJUHHPHQW� \RXU XVH LV JRYHUQHG E\ WKH 8�6� &RS\ULJKW $FW�

How has Micro grafx chan ged its end user licensin g polic y?

0LFURJUDI[ KDV FKDQJHG LWV HQG XVHU OLFHQVH DJUHHPHQW WR VLPSOLI\ KRZ LWV

SURGXFWV DUH OLFHQVHG IRU KRPH� SRUWDEOHV� DQG ODSWRS XVH�

W hat does the license sa y?

7KH XQGHUO\LQJ SULQFLSOH RI 0LFURJUDI[
V OLFHQVLQJ SROLF\ LV WKDW HDFK XVH RI D

0LFURJUDI[ SURGXFW UHTXLUHV D OLFHQVH� (DFK OLFHQVH JUDQWV \RX WKH ULJKW WR XVH

RQH FRS\ RI WKH VRIWZDUH SURGXFW RQ \RXU FRPSXWHU� ,Q DGGLWLRQ� WKH OLFHQVH

VHWV RXW WKH UXOHV E\ ZKLFK \RX PD\ XVH WKH SURGXFW RQ D FRPSXWHU

QHWZRUN�

W hat defines "in use"?

1 /RDGHG RQ WKH KDUG GLVN�

2 $ VLQJOH FRPSXWHU DFFHVVLQJ WKH SURGXFW IURP D VHUYHU�

How do I determine how man y licenses I need for m y com pany 
to com ply with the Micro grafx license a greement?

6WDUWLQJ ZLWK WKH SULQFLSOH WKDW \RX QHHG RQH OLFHQVH IRU HDFK FRPSXWHU WKDW

XVHV WKH SURGXFW� WKHUH DUH WZR EDVLF UXOHV WKDW \RX QHHG WR IROORZ LQ

FRXQWLQJ WKH QXPEHU RI �OLFHQVHV� LQ \RXU FRPSDQ\� )LUVW� HDFK FRS\ RI WKH

SURGXFW WKDW LV LQVWDOOHG RQ D KDUG GLVN RU RWKHU VWRUDJH GHYLFH RI D FRPSXWHU

LV D �XVH� WKDW UHTXLUHV RQH OLFHQVH� 6HFRQG� LI \RX SODQ WR XVH WKH SURGXFW RQ

D FRPSXWHU QHWZRUN� DQG \RX KDYH IHZHU OLFHQVHV WKDQ WKH WRWDO QXPEHU RI

ZRUNVWDWLRQV� WKHQ \RX QHHG WR GHWHUPLQH WKH PD[LPXP QXPEHU RI

FRPSXWHUV WKDW ZLOO XVH WKH SURGXFW� 7KH WRWDO QXPEHU RI �XVHV� � DUULYHG DW

E\ DGGLQJ WKH QXPEHU RI FRSLHV WKDW \RX ZLOO KDYH LQVWDOOHG RQ KDUG GLVN SOXV

WKH PD[LPXP QXPEHU RI XVHV RQ D QHWZRUN� GHWHUPLQHV WKH QXPEHU RI

OLFHQVHV \RX QHHG�
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How do I determine the "maximum number of users" in m y 
com pany’s com puter network?

7R FRPSO\ ZLWK WKH 0LFURJUDI[ OLFHQVH DJUHHPHQW� \RX PXVW KDYH DGHTXDWH

FRQWUROV DQG PHFKDQLVPV LQ SODFH WR HQVXUH WKDW \RX KDYH DW OHDVW DV PDQ\

OLFHQVHV DV \RX KDYH XVHUV RI WKH QHWZRUN� :KLOH WKHUH LV QR VLQJOH PHWKRG

WKDW 0LFURJUDI[ UHTXLUHV RU SUHVFULEHV� \RX PXVW KDYH HOHFWURQLF RU PDQXDO

FRQWUROV RU SURFHGXUHV WR MXVWLI\ \RXU FDOFXODWLRQ RI WKH QXPEHU RI OLFHQVHV�

)RU H[DPSOH� WKHUH DUH HOHFWURQLF GHYLFHV DQG VRIWZDUH SURJUDPV WKDW OLPLW

DFFHVV WR SDUWLFXODU SURGXFWV UXQQLQJ RII D QHWZRUN VHUYHU WKDW ZRXOG FRPSO\

ZLWK WKLV UHTXLUHPHQW �VHH WKH QH[W TXHVWLRQ DERXW �HOHFWURQLF WRNHQ�

WHFKQRORJLHV��

If I load the product on the hard disk of ever y workstation on 
the network, can I still count the number of users so I don’t have 
to purchase a license for ever y workstation? Is the answer 
different if I use the so-called "electronic token" technolo gy to 
limit the actual number of users?

1R� $QG QR� /RDGLQJ WKH SURGXFW RQWR WKH KDUG GLVN RU RWKHU VWRUDJH GHYLFH

RI D QHWZRUN ZRUNVWDWLRQ LV D �XVH� WKDW UHTXLUHV D OLFHQVH� ,W PDNHV QR

GLIIHUHQFH LI \RX KDYH DQ �HOHFWURQLF WRNHQ� V\VWHP WR UHJXODWH XVH� 2I FRXUVH�

LI \RX WUDQVIHU RU �GRZQORDG� WKH SURGXFW IURP WKH VHUYHU WR D ZRUNVWDWLRQ
V

KDUG GLVN� ZKLFK UHTXLUHV RQH OLFHQVH� \RX PD\ ODWHU FRPSOHWHO\ GHOHWH WKH

SURGXFW RII WKDW KDUG GLVN WR IUHH XS WKDW RQH OLFHQVH IRU XVH HOVHZKHUH�

Do I need a se parate license for the co py of the product on the 
server?

1R� <RX QHHG QRW FRXQW WKH VHUYHU DV RQH �XVH� � SURYLGHG WKDW WKH VHUYHU

FRS\ LV PHUHO\ DFFHVVHG E\ WKH ZRUNVWDWLRQV FRQQHFWHG WR LW DQG QRW XVHG

VHSDUDWHO\�

If I have a Micro grafx a pplication loaded into the tem porar y 
memor y (RAM) of m y network, but it is iconized and not 
activel y in use, is a license re quired?

<HV� :H FRQVLGHU WKDW \RX DUH �XVLQJ� RQH RI RXU SURGXFWV ZKHQHYHU LW LV

ORDGHG RQ \RXU KDUG GLVN RU LQ 5$0� 7KXV� D SURJUDP WKDW LV LFRQL]HG

UHTXLUHV D OLFHQVH EHFDXVH LW ZDV ILUVW ORDGHG LQWR PHPRU\� RU 5$0�
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Does Micro grafx continue to allow end users to make a second 
copy of its a pplication for home and la ptop use?

<HV� ,I \RX KDYH D 0LFURJUDI[ SURGXFW ORDGHG RQ WKH KDUG GLVN RU RWKHU

VWRUDJH GHYLFH RI \RXU FRPSXWHU� WKHQ \RX PD\ PDNH D VHFRQG FRS\ IRU

KRPH DQG ODSWRS XVH VR ORQJ DV WKH 6RIWZDUH LV QRW XVHG RQ ERWK FRPSXWHUV

DW WKH VDPH WLPH� 7KH SULQFLSOH KHUH LV WR DOORZ \RX WR XVH WKH 0LFURJUDI[

SURGXFW HYHQ ZKHQ \RX DUH DZD\ IURP ZRUN� HLWKHU DW KRPH RU ZKLOH

WUDYHOLQJ� +RZHYHU� WKLV GRHV QRW DSSO\ WR SURGXFWV WKDW DUH ORDGHG RQ WKH

QHWZRUN VHUYHU� �6RPH FRPSDQLHV KDYH WKHLU RZQ UHVWULFWLRQV RQ KRPH

VRIWZDUH XVH� VR \RX PD\ QHHG WR FKHFN ZLWK \RXU V\VWHPV DGPLQLVWUDWRU RQ

WKLV WRSLF��

Is this Micro grafx license a site license? If not, how does it differ?

7KLV 0LFURJUDI[ HQG XVHU OLFHQVH LV QRW D VLWH OLFHQVH EHFDXVH HDFK XVH

UHTXLUHV D VHSDUDWH OLFHQVH�
22 i G r a f x  D e s i g n e r



Copyright and Trademark Statements

,QIRUPDWLRQ RQ WKLV GRFXPHQW LV VXEMHFW WR FKDQJH ZLWKRXW QRWLFH DQG GRHV

QRW UHSUHVHQW D FRPPLWPHQW RQ WKH SDUW RI 0LFURJUDI[� ,QF� 7KH VRIWZDUH

GHVFULEHG LQ WKLV GRFXPHQW LV IXUQLVKHG XQGHU D OLFHQVH DJUHHPHQW� 7KH

VRIWZDUH PD\ EH XVHG RU FRSLHG RQO\ LQ DFFRUGDQFH ZLWK WKH WHUPV RI WKH

DJUHHPHQW�

Copyright 

&RS\ULJKW ¿ ���� E\ 0LFURJUDI[� ,QF� $OO 5LJKWV 5HVHUYHG� 1R SDUW RI WKLV

SXEOLFDWLRQ PD\ EH UHSURGXFHG� WUDQVPLWWHG� VWRUHG LQ D UHWULHYDO V\VWHP RU

WUDQVODWHG LQWR DQ\ ODQJXDJH LQ DQ\ IRUP E\ DQ\ PHDQV ZLWKRXW WKH SHUPLVVLRQ

RI 0LFURJUDI[�

0LFURJUDI[� ,QF�

���� (DVW $UDSDKR 5G�

5LFKDUGVRQ� 7; �����

/HJDO 'HSDUWPHQW� ����� ��������

Trademark and Co pyright Acknowled gments

0LFURJUDI[� WKH 0LFURJUDI[ ORJR� $GYDQ(GJH 7HFKQRORJLHV� &RRO6KDSHV�

*UDSKLFV :RUNV� ,QVWDQW �'� /LYLQJ )ORZFKDUWV� 0LFURJUDI[ 'HVLJQHU�

0LFURJUDI[ )ORZ&KDUWHU� 0LFURJUDI[ *UDSKLFV 6XLWH� 3KRWR0DJLF� 3LFWXUH

3XEOLVKHU� 2SWLPD� 4XLFN$UW� 6LPSO\ �'� 9LVXDO �' &OLSDUW� 9LVXDO )RQW� 9LVXDO

,PDJH� 9LVXDO 6RIWZDUH� DQG :HEWULFLW\ DUH UHJLVWHUHG WUDGHPDUNV RI

0LFURJUDI[� ,QF�

$FWLYH&KDUWV� (QWHUSULVH&KDUWHU� L'LDJUDPV� L'UDZ6KDSHV� L*ULGV� L*UDI[�

L*UDI[ 6\VWHP� LQWHOOLJHQW JUDSKLFV DW ZRUN� WKH LQWHOOLJHQW JUDSKLFV IUDPHZRUN�

,62&KDUWHU� L6KDSHV� 0LFURJUDI[ &KLOL IRU &KLOGUHQ� 0LFURJUDI[ &OLSDUW�

0LFURJUDI[ 0HGLD 0DQDJHU� 0LFURJUDI[ 9LHZHU� 0LFURJUDI[ :HEFKDUWHU�

0LVFHOODQHRXV 'HVLJQ �H\HEDOO�� 1HWZRUN&KDUWHU� 3URMHFW%XLOGHU�

3URMHFW&HQWUDO� 3URFHVV :DONHU� 4XLFN9HFWRU� 6OLGH6KRZ� 6PDOO %XVLQHVV

*UDSKLFV 	 3ULQW 6WXGLR� DQG 8QORFNDEOHV DUH HLWKHU UHJLVWHUHG WUDGHPDUNV RU

WUDGHPDUNV RI 0LFURJUDI[� ,QF�
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3RUWLRQV RI WKH LPDJHU\ RQ WKH GLVF�V� VXSSOLHG E\ (QHUJ\ )LOP /LEUDU\� 'LJLWDO

(QHUJ\70 DQG 7LPHVFDSH70 ,QWHUDFWLYH� ¿ ���� (QHUJ\� $OO 5LJKWV 5HVHUYHG�

'LJLWDO (QHUJ\70 DQG 7LPHVFDSH70 ,QWHUDFWLYH DUH WUDGHPDUNV RI (QHUJ\ )LOP

/LEUDU\�

&OLS$UW &RS\ULJKW ��������� ,PDJHOLQH� ,QF�

$QLPDWLRQV &RS\ULJKW ���� ,PDJHOLQH� ,QF�

$ SRUWLRQ RI WKH LPDJHV ¿ ��������� *UDSKLF&RUS� /RV $QJHOHV� &$ 86$�

$OO 5LJKWV 5HVHUYHG�

:RRG 5LYHU *DOOHU\ LPDJHV &RS\ULJKW ¿ ���������� $OO 5LJKWV 5HVHUYHG�

(WKQLF &OLSDUW &RS\ULJKW ¿ ���� E\ &UHDWL&RP &RUSRUDWLRQ� $OO 5LJKWV

5HVHUYHG�

&OLSDUW ,PDJHV &RS\ULJKW ¿ ���� E\ &UHDWL&RP &RUSRUDWLRQ� $OO 5LJKWV

5HVHUYHG�

'LJLPDUFÙ� 0DUF&HQWUHÙ� 3LFWXUH0DUF70� DQG 0DUF6SLGHU70 ¿ &RS\ULJKW

��������� 'LJLPDUF &RUSRUDWLRQ� $OO 5LJKWV 5HVHUYHG�

,PDJH6WUHDP70 *UDSKLFV DQG 3UHVHQWDWLRQ )LOWHUV &RS\ULJKW ¿ ���������

,PDJH0DUN 6RIWZDUH /DEV� ,QF� $OO 5LJKWV 5HVHUYHG�

&RS\ULJKW ¿ ��������� ,PDJH0DUN 6RIWZDUH /DEV� ,QF� $OO 5LJKWV 5HVHUYHG�

%LWVWUHDP� %LWVWUHDP $PHULJR� %LWVWUHDP $UUXV� %LWVWUHDP %UHPHQ� %LWVWUHDP

&DUPLQD� %LWVWUHDP &DWDQHR� %LWVWUHDP &KLDQWL� %LWVWUHDP &RRSHU� %LWVWUHDP

&\EHUELW� %LWVWUHDP ,RZDQ 2OGVWO\H� %LWVWUHDP 0LVWHU (DUO� %LWVWUHDP 2UDQGD�

%LWVWUHDP 2] +DQGLFUDIW� %LWVWUHDP 6QRZFDS� 'XWFK� +DPPHUVPLWK�

0HUPDLG� 2OG 'UHDGIXO 1R� �� 3URYHQFH� 6ODWH� 6ZLVV� =XULFK� )DFHOLIW� ��LQ���

7UXH'RFÙ3ULQWLQJ 6\VWHP� 7UXH'RFÙ� 7UXH'RFÙ3)5� %LWVWUHDP )RQW

6HOHFW� %LWVWUHDP 6SHHGR� DQG %LWVWUHDP )RQW 1DYLJDWRU DUH HLWKHU UHJLVWHUHG

WUDGHPDUNV RU WUDGHPDUNV RI %LWVWUHDP� ,QF� 7KH WUDGHPDUN )RQWZDUH LV

OLFHQVHG WR %LWVWUHDP� ,QF� LQ :HVW *HUPDQ\� )UDQFH DQG WKH 8QLWHG .LQJGRP

E\ (OHFWURQLF 3ULQWLQJ 6\VWHP� /WG�
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85:� 85: ,FH $JH� ,NDUXV� /LQXV� 6LJQXV� 1LPEXV� 85: $QWLTXD� 85:

*URWHVN� 85: .ROLEUL� 85: $OFXLQ $QWLTXD� 85: /DWLQR� 85: &ODVVLFR�

85: 3DOODGLR� 1LPEXV 6DQV� 1LPEXV 5RPDQ� 1LPEXV 0RQR DUH HLWKHU

UHJLVWHUHG WUDGHPDUNV RU WUDGHPDUNV RI 85: 8QWHUQHKPHQVEHUDWXQJ� $OO

5LJKWV 5HVHUYHG�

0LFURVRIWÙ 'LUHFW;Ù 6RIWZDUH 'HYHORSPHQW .LW �6'.� LV HLWKHU D

UHJLVWHUHG WUDGHPDUN RU WUDGHPDUN RI 0LFURVRIW &RUSRUDWLRQ LQ WKH 8QLWHG

6WDWHV DQG�RU RWKHU FRXQWULHV�

'LUHFW;Ù 0HGLD 6RIWZDUH 'HYHORSPHQW .LW DQG 'LUHFW;Ù 0HGLD &RS\ULJKW

¿ ��������� 0LFURVRIW &RUSRUDWLRQ�

3RUWLRQV &RS\ULJKW ¿ ��������� 9LVXDO &RPSRQHQWV� ,QF�

,PDJH6WUHDP�5� *UDSKLFV )LOWHUV &RS\ULJKW �&� ��������� ,QVR &RUSRUDWLRQ�

$OO 5LJKWV 5HVHUYHG�

,QWHUQDWLRQDO &RUUHFW6SHOO VSHOOLQJ FRUUHFWLRQ V\VWHP ¿ ���� E\ ,162

&RUSRUDWLRQ� $OO 5LJKWV 5HVHUYHG�

,QWHUQDWLRQDO &RUUHFW6SHOO LV D WUDGHPDUN RI ,162 &RUSRUDWLRQ�

:HE 3XEOLVKLQJ :L]DUG &RS\ULJKW �&� ��������� 0LFURVRIW &RUSRUDWLRQ�

$ SRUWLRQ RI WKH LPDJHV SURYLGHG FRXUWHV\ RI ,06,� $OO ULJKWV UHVHUYHG�

$ SRUWLRQ RI WKH LPDJHV SURYLGHG FRXUWHV\ RI /DQGLV 	 *\U� $OO ULJKWV

UHVHUYHG�

$ SRUWLRQ RI WKH LPDJHV SURYLGHG FRXUWHV\ RI ,PDJH 3KRWR� $OO ULJKWV

UHVHUYHG�

$ SRUWLRQ RI WKH LPDJHV SURYLGHG FRXUWHV\ RI 7UL (QHUJ\� $OO ULJKWV UHVHUYHG�

2WKHU SURGXFWV PHQWLRQHG DUH WUDGHPDUNV RU UHJLVWHUHG WUDGHPDUNV RI WKHLU

UHVSHFWLYH FRPSDQLHV�
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Getting Started with Designer
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Getting assistance as you work

,I \RX DUH QHZ WR L*UDI[ 'HVLJQHU

2SHQ WKH 9LHZ PHQX� FOLFN 7RROEDUV� DQG PDNH VXUH WKDW WKH 6KRZ 7RRO 7LSV

RSWLRQ LV FKHFNHG DQG WKH +LQWV WRROEDU LV WXUQHG RQ�

v 7RRO 7LSV� GLVSOD\HG QHDU WKH PRXVH SRLQWHU ZKHQ \RX SDXVH RQ D WRRO

RU EXWWRQ� KHOS \RX UHODWH WKH WRROjV LPDJH WR LWV QDPH�

v 7KH +LQW WRROEDU JLYHV D EULHI GHVFULSWLRQ RI WKH WRRO� EXWWRQ� RU PHQX

LWHP \RX DUH SRLQWLQJ WR� 7KH +LQW WRROEDU DOVR GLVSOD\V �$FWLRQ +LQWV�

DV \RX GUDZ DQG HGLW REMHFWV $FWLRQ +LQWV JXLGH \RX VWHS�E\�VWHS

WKURXJK 'HVLJQHU SURFHGXUHV�

v ,I \RX DUH QRW VXUH ZKDW \RXU RSWLRQV DUH ZKLOH HGLWLQJ DQ REMHFW� FOLFN

WKH ULJKW PRXVH EXWWRQ� $ VKRUWFXW PHQX DSSHDUV� FRQWDLQLQJ

FRPPDQGV WKDW DUH DYDLODEOH IRU WKH FXUUHQW REMHFW�

:KHQ \RX ZDQW PRUH GHWDLOHG LQIRUPDWLRQ

v 7R VHH PRUH LQIRUPDWLRQ DERXW D WRRO RU EXWWRQ� SRLQW WR LW DQG SUHVV

WKH +HOS NH\ �F1�� $ SRSXS PHVVDJH WHOOV \RX KRZ WR XVH WKH WRRO RU

EXWWRQ� 7R FORVH WKH PHVVDJH� FOLFN LQVLGH LW RU SUHVV WKH ESC NH\�

v )RU TXLFN LQIRUPDWLRQ DERXW D PHQX LWHP� SUHVV WKH +HOS NH\ �F1�
ZKLOH WKH LWHP LV KLJKOLJKWHG� $ SRSXS PHVVDJH JLYHV \RX DVVLVWDQFH�7R

FORVH WKH PHVVDJH� FOLFN LQVLGH LW RU SUHVV WKH ESC NH\�

:KHQ \RX DUH XVLQJ D GLDORJ ER[� FOLFN WKH �?� EXWWRQ LQ WKH GLDORJ ER[�

:KHQ \RX DUH YLHZLQJ 'HVLJQHUjV +HOS ZLQGRZV� WKH ODUJH 'HVLJQHU +HOS

ZLQGRZ FRQWDLQV WZR �EURZVH� EXWWRQV � DQG �� &OLFN WKRVH

EXWWRQV WR SDJH EDFNZDUG RU IRUZDUG WKURXJK D VHW RI FORVHO\ UHODWHG WRSLFV�

�,I \RX SUHIHU XVLQJ WKH NH\ERDUG� SUHVV WKH < DQG > NH\V��
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7KH 'HVLJQHU 6WHSV ZLQGRZ DSSHDUV RQ WKH ULJKW�KDQG VLGH RI WKH VFUHHQ� ,W

GLVSOD\V QXPEHUHG VWHSV IRU D VSHFLILF SURFHGXUH� 7KLV ZLQGRZ VWD\V LQ IURQW

RI RWKHU ZLQGRZV VR \RX FDQ SHUIRUP HDFK VWHS ZLWKRXW 'HVLJQHUjV ZLQGRZ

FRYHULQJ XS WKH UHPDLQLQJ VWHSV�

7LS

7R FRS\ WKH WH[W IURP D +HOS ZLQGRZ WR WKH &OLSERDUG� GUDJ DFURVV WKH
WH[W� DQG WKHQ SUHVV CTRL+C�

7R FORVH DQ\ DFWLYH +HOS ZLQGRZ� SUHVV WKH ESC NH\�

Installing Designer

,QVWDOOLQJ 'HVLJQHU RQ \RXU FRPSXWHU
V KDUG GULYH LV HDV\ ZLWK WKH L*UDI[

,QVWDOOHU� 7KLV LQVWDOODWLRQ SURJUDP OHWV \RX LQVWDOO RSWLRQV QRZ� RU \RX FDQ DGG

WKHP ODWHU E\ UXQQLQJ WKH ,QVWDOOHU DJDLQ�

<RX PXVW XVH WKH L*UDI[ ,QVWDOOHU WR LQVWDOO DQ\ SDUW RI WKH 'HVLJQHU SDFNDJH�

LQFOXGLQJ IRQWV DQG LPSRUW DQG H[SRUW WUDQVODWRUV SURYLGHG �DV FRPSUHVVHG

ILOHV� ZLWK 'HVLJQHU� 7KH LQVWDOODWLRQ SURJUDP DXWRPDWLFDOO\ GHFRPSUHVVHV WKH

SURJUDP ILOHV DV LW LQVWDOOV WKHP RQWR \RXU KDUG GLVN�

,I \RX ODWHU ZDQW WR LQVWDOO DGGLWLRQDO IRQWV RU WUDQVODWRUV� UXQ WKH ,QVWDOOHU DJDLQ

DQG FKRRVH &XVWRP ,QVWDOODWLRQ LQ WKH ,QVWDOOHU PHQX�

7KH ,QVWDOOHU FKHFNV \RXU KDUG GULYH IRU IUHH GLVN VSDFH DQG OHWV \RX NQRZ

KRZ PXFK VSDFH LV QHHGHG� DV ZHOO DV KRZ PXFK VSDFH LV IUHH�

To install Desi gner from CD-ROM

1 6WDUW :LQGRZV� 7KH 3URJUDP 0DQDJHU RSHQV�

2 ,QVHUW WKH 'HVLJQHU &'�520 LQ \RXU &'�520 GULYH�

3 2SHQ WKH )LOH PHQX DQG FKRRVH 5XQ� 7KH 5XQ GLDORJ ER[ RSHQV�

4 7\SH [�?VHWXS �ZKHUH [ LV WKH GULYH OHWWHU IRU \RXU &'�520 GULYH� DQG

SUHVV HQWHU�

5 )ROORZ WKH LQVWUXFWLRQV RQ \RXU VFUHHQ�
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Installing Designer on a Network

,QVWUXFWLRQV IRU LQVWDOOLQJ 'HVLJQHU RQ D QHWZRUN DUH LQFOXGHG LQ 7KH L*UDI[

1HWZRUN ,QVWDOODWLRQ *XLGH�
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Uninstalling Designer

,Q WKH HYHQW WKDW \RX QHHG WR UHPRYH 'HVLJQHU IURP \RXU KDUG GULYH� WKH

L*UDI[ ,QVWDOOHU FDQ GHOHWH WKH SURJUDP DQG UHODWHG ILOHV� SOXV LW UHPRYHV DOO

UHIHUHQFHV WR 'HVLJQHU LQ LQLWLDOL]DWLRQ �,1,� ILOHV DQG WKH UHJLVWU\�

To remove Desi gner

1 &OLFN 6WDUW DQG VHOHFW 6HWWLQJV�

2 )URP WKH 6HWWLQJV VXEPHQX� VHOHFW &RQWURO 3DQHO�

3 )URP WKH &RQWURO 3DQHO� VHOHFW $GG�5HPRYH SURJUDPV�

4 &OLFN WKH ,QVWDOO�8QLQVWDOO WDE�

5 6HOHFW L*UDI[ 6\VWHP 8QLQVWDOOHU DQG FOLFN WKH $GG�5HPRYH EXWWRQ�

6 )ROORZ WKH LQVWUXFWLRQV RQ WKH VFUHHQ�
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Starting Designer

1RZ \RX DUH UHDG\ WR EHJLQ XVLQJ 'HVLJQHU� 7KH L*UDI[ ,QVWDOOHU FUHDWHV DQ

DSSOLFDWLRQ JURXS IRU \RX GXULQJ WKH LQVWDOODWLRQ SURFHVV�

To start Desi gner

` &OLFN 6WDUW� VHOHFW 3URJUDPV� 6HOHFW L*UDI[ IURP WKH VXEPHQX� 7KHQ

VHOHFW 'HVLJQHU�

Displaying the Welcome Screen

7KH ZHOFRPH VFUHHQ DXWRPDWLFDOO\ GLVSOD\V ZKHQ RSHQLQJ 'HVLJQHU� 'HVHOHFW

WKLV RSWLRQ WR SUHYHQW WKH GLDORJ ER[ IURP DSSHDULQJ WKH QH[W WLPH \RX VWDUW

'HVLJQHU�

Getting Around in Designer

The Desi gner W indow

7KLQN RI WKH 'HVLJQHU PDLQ ZLQGRZ DV DQ HOHFWURQLF GUDZLQJ ERDUG� 7KHUH

DUH FHUWDLQ DUHDV RI WKH ZLQGRZ WKDW DOZD\V GLVSOD\ WKH VDPH LQIRUPDWLRQ RU

RSWLRQV� )RU H[DPSOH� WKH OHIW VLGH RI WKH ZLQGRZ DOZD\V VKRZV WKH WRROER[�

DQG WKH WRS RI WKH ZLQGRZ DOZD\V VKRZV WKH PHQXV�

,I \RX DUH QHZ WR 'HVLJQHU� XVH WKLV VHFWLRQ WR KHOS LGHQWLI\ WKH PDMRU DUHDV RI

WKH 'HVLJQHU ZLQGRZ�
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7KH WRROER[� IRXQG DW WKH OHIW RI WKH PDLQ 'HVLJQHU ZLQGRZ� FRQWDLQV WRROV

WKDW OHW \RX FUHDWH DQG HGLW GUDZLQJV� 7KHUH LV DOVR D 9LHZ WRRO WKDW OHWV \RX

YLHZ \RXU GUDZLQJ DW GLIIHUHQW VL]HV�

:KHQ \RX FOLFN D WRRO LQ WKH WRROER[� WKH ULEERQ DW WKH WRS RI WKH ZLQGRZ

XVXDOO\ FKDQJHV WR VKRZ EXWWRQV WKDW OHW \RX VSHFLI\ KRZ \RX ZDQW WR XVH WKH

WRRO� )RU H[DPSOH� LI \RX ZDQW WR GUDZ D UHFWDQJOH� \RX FOLFN WKH 'UDZ WRRO LQ

WKH WRROER[� DQG WKHQ FOLFN WKH 5HFWDQJOH EXWWRQ LQ WKH ULEERQ�

Menu Commands

7KH PHQXV DUH IRXQG LQ WKH PHQX EDU DW WKH WRS RI WKH ZLQGRZ �XQGHU WKH

WLWOH EDU�� 7KHVH PHQXV JHQHUDOO\ FRQWDLQ FRPPDQGV DQG RSWLRQV WKDW OHW \RX

SHUIRUP D YDULHW\ RI DFWLRQV�

7KH PHQXV DUH JURXSHG E\ FDWHJRU\� )RU H[DPSOH� WKH (IIHFWV PHQX FRQWDLQV

FRPPDQGV WKDW FKDQJH WKH DSSHDUDQFH RI \RXU GUDZLQJ�

Hints

'HVLJQHU SURYLGHV VHYHUDO NLQGV RI KLQWV WR KHOS \RX LQ \RXU ZRUN� $V \RX

SRLQW WR D EXWWRQ� FRPPDQG� RU WRRO� D KLQW SURYLGHV D EULHI GHVFULSWLRQ RI

WKDW SDUWLFXODU HOHPHQW� $ NH\ERDUG VKRUWFXW LV RIWHQ LQFOXGHG�

<RX FDQ VKRZ RU KLGH WKH YDULRXV W\SHV RI KLQWV� <RX FDQ DOVR XQGRFN� PRYH�

UHVL]H� DQG UHVKDSH WKH IORDWLQJ KLQW ZLQGRZ WR NHHS LW YLVLEOH EXW RXW RI \RXU

ZD\�

To show or hide tool t i ps

` 2SHQ WKH 9LHZ PHQX DQG VHOHFW 7RROEDUV� 6HOHFW 6KRZ 7RRO 7LSV LQ WKH

GLDORJ ER[� :KHQ 7RRO 7LSV LV VHOHFWHG� SRLQWLQJ IRU RQH VHFRQG WR D

WRRO RU EXWWRQ ZLWK WKH PRXVH SRLQWHU GLVSOD\V WKH QDPH RI WKH WRRO RU

EXWWRQ�

To show or hide lon ger hints

1 2SHQ WKH 'LVSOD\ PHQX DQG FKRRVH +LQW /LQH� $ VXEPHQX RSHQV�
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2 6HOHFW :LQGRZ WR GLVSOD\ WKH IORDWLQJ KLQW ZLQGRZ�

7LS

<RX FDQ PRYH� UHVL]H� RU VKDSH WKH IORDWLQJ KLQW ZLQGRZ WR NHHS LW
YLVLEOH EXW RXW RI \RXU ZD\� 7R FKDQJH WKH VL]H RI WKH GLVSOD\HG
WH[W LQ WKH ZLQGRZ� RSHQ WKH &RQWURO PHQX LQ WKH IORDWLQJ KLQW
ZLQGRZ� FKRRVH WKH )RQW 6L]H FRPPDQG� DQG WKHQ FKRRVH 6PDOO�
0HGLXP� RU /DUJH�

Drawin g W indows

'LIIHUHQW GRFXPHQWV DSSHDU LQ VHSDUDWH ZLQGRZV ZLWKLQ WKH 'HVLJQHU PDLQ

ZLQGRZ� <RX FDQ GLVSOD\ PDQ\ ZLQGRZV DW D WLPH� EXW RQO\ WKH DFWLYH GUDZLQJ

ZLQGRZ UHFHLYHV WKH DFWLRQ� )RU H[DPSOH� ZKHQ \RX VDYH D GUDZLQJ� RQO\ WKH

RQH LQ WKH DFWLYH ZLQGRZ LV VDYHG�

Rulers and Grid

7KH UXOHUV DQG JULG SRLQWV DSSHDU IRU HDFK RSHQ GRFXPHQW WR KHOS \RX

PHDVXUH DQG SRVLWLRQ WKH FRPSRQHQWV RI \RXU GUDZLQJ� <RX FDQ VHW

'HVLJQHU
V SUHIHUHQFHV WR VKRZ RU KLGH WKH UXOHUV DQG JULG� FKDQJH WKH XQLW RI

PHDVXUH IRU WKH UXOHUV� DQG FKDQJH WKH VSDFLQJ RI WKH JULG SRLQWV�

Creating a New Designer Window

:KHQ \RX ZDQW WR FUHDWH D QHZ GUDZLQJ� XVH WKH 1HZ FRPPDQG LQ WKH )LOH

PHQX�
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To create a new drawin g

` 2SHQ WKH )LOH PHQX DQG FKRRVH 1HZ� 'HVLJQHU RSHQV D QHZ ZLQGRZ

FRQWDLQLQJ DQ XQWLWOHG GRFXPHQW�

7R JLYH WKH QHZ ILOH D QDPH� RSHQ WKH )LOH PHQX DQG FKRRVH WKH 6DYH RU

6DYH $V FRPPDQG� 7KH 6DYH $V GLDORJ ER[ RSHQV� 7\SH D QDPH LQ WKH )LOH

1DPH WH[W ER[ DQG SUHVV HQWHU�

'HVLJQHU OHWV \RX KDYH DV PDQ\ ILOHV RSHQ DW RQH WLPH DV \RXU FRPSXWHU
V

PHPRU\ ZLOO DOORZ� HDFK LQ LWV RZQ GUDZLQJ ZLQGRZ� 7KH WLWOH EDU RI D QHZ

ZLQGRZ GLVSOD\V k8QWLWOHG�y XQWLO \RX VDYH WKH ILOH ZLWK D VSHFLILF ILOHQDPH� ,I

\RX KDYH PRUH WKDQ RQH XQVDYHG GRFXPHQW� WKH\ DUH QDPHG 8QWLWOHG��

8QWLWOHG�� DQG VR IRUWK�

,Q DGGLWLRQ� \RX FDQ RSHQ PXOWLSOH ZLQGRZV IRU WKH VDPH GRFXPHQW WR YLHZ D

GLIIHUHQW SDJH LQ HDFK ZLQGRZ� <RX FDQ HYHQ YLHZ WKH VDPH SDJH LQ WZR

GLIIHUHQW ZLQGRZV�

'HVLJQHU RIIHUV D FRQWH[W�VHQVLWLYH� RQ�OLQH KHOS V\VWHP WKDW LV D FRPSOHWH

VRXUFH RI LQIRUPDWLRQ DERXW IHDWXUHV� FRPPDQGV� DQG GLDORJ ER[HV�

2Q�OLQH KHOS PHVVDJHV JLYH GHWDLOHG LQIRUPDWLRQ DERXW FRPPDQGV� GLDORJ

ER[HV� EXWWRQV� DQG WRROV� WHFKQLTXHV IRU GUDZLQJ DQG HGLWLQJ� DQG DGGLWLRQDO

FRQFHSWV UHODWHG WR 'HVLJQHU DQG WKH :LQGRZV HQYLURQPHQW� 8VLQJ RQ�OLQH

KHOS LV DV HDV\ DV SUHVVLQJ WKH )� NH\�
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Accessing On-line Help

<RX FDQ DFFHVV KHOS LQ RQH RI VHYHUDO ZD\V� 2QH ZD\ LV WR SRLQW WR DQ\ WRRO

RU EXWWRQ� RU VHOHFW DQ\ FRPPDQG RU GLDORJ ER[� DQG WKHQ SUHVV )� WR DFFHVV

kFRQWH[W�VHQVLWLYHy KHOS� :KHQ \RX SUHVV )�� \RX UHFHLYH D KHOS PHVVDJH

VSHFLILF WR WKH WRRO� EXWWRQ� FRPPDQG� RU GLDORJ ER[ WKDW \RX DUH FXUUHQWO\

SRLQWLQJ WR RU XVLQJ�

To use context-sensitive hel p

1 +LJKOLJKW D FRPPDQG� RSHQ D GLDORJ ER[� RU SRLQW WR D WRRO RU EXWWRQ�

2 3UHVV )�� $ FRQWH[W�VHQVLWLYH PHVVDJH DSSHDUV LQ WKH KHOS ZLQGRZ�

$QRWKHU ZD\ WR DFFHVV KHOS LQYROYHV XVLQJ WKH +HOS PHQX� 7KH +HOS PHQX

OHWV \RX DFFHVV LQIRUPDWLRQ DERXW 'HVLJQHU FRPPDQGV� WHUPV DQG SKUDVHV�

HUURU PHVVDJHV DQG VROXWLRQV� VKRUWFXW NH\V� DQG WRSLFV UHODWHG WR 'HVLJQHU

DQG WKH :LQGRZV HQYLURQPHQW�

Technical Support

0LFURJUDI[ KDV GHYHORSHG D FRPSUHKHQVLYH VXSSRUW SURJUDP WKDW ZLOO HQDEOH

FXVWRPHUV WR FKRRVH WKH VXSSRUW RSWLRQ WKDW EHVW PHHWV WKHLU SUHVDOH DQG

SRVW�VDOH UHTXLUHPHQWV� RXU VWDII RI H[SHULHQFHG WHFKQLFDO VXSSRUW DGYRFDWHV

DUH VSHFLDOLVWV LQ WKH FULWLFDO DUHDV DQG DSSOLFDWLRQV LPSRUWDQW WR \RX�

GHOLYHULQJ IDVW� IOH[LEOH� DQG FRPSUHKHQVLYH VHUYLFH IRU WKH 0LFURJUDI[

EXVLQHVV DQG SURIHVVLRQDO SURGXFWV \RX RZQ�

Com plimentar y support

Web Based Su ppor t:

7KH IROORZLQJ VXSSRUW RSWLRQV DUH DYDLODEOH IUHH RI FKDUJH WKURXJK WKH

0LFURJUDI[ :HEVLWH �� KRXUV D GD\� � GD\V D ZHHN DW

KWWS���ZZZ�PLFURJUDI[�FRP�IUDPHV�DVS"V �

X per t Knowled gebase:
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6HDUFK WKH NQRZOHGJH EDVH RI SURGXFW VSHFLILF WHFKQLFDO LVVXHV� WRS LVVXHV�

KRZ�WR TXHVWLRQV DQG VXJJHVWLRQV� DW \RXU FRQYHQLHQFH�

Users Forum:

9LHZ XVHU WR XVHU GLVFXVVLRQV RU SRVW D TXHVWLRQ IRU SHHU�WR�SHHU VXSSRUW�

Downloadable Files:

'RZQORDG DYDLODEOH SURGXFW XSGDWHV� SDWFKHV� DQG SUREOHP IL[HV�

Phone Su ppor t:

5HJLVWHUHG XVHUV DUH HQWLWOHG WR �� GD\V IUHH VXSSRUW EHJLQQLQJ IURP WKH GDWH

RI \RXU ILUVW FDOO E\ GLDOLQJ ����� ��������� 0RQGD\ WKURXJK )ULGD\� ���� D�P�

WR ���� S�P� &67�

Continued Su pport O ptions

0LFURJUDI[ RIIHUV VHYHUDO RSWLRQV WR FRQWLQXH VXSSRUW DIWHU WKH LQLWLDO �� GD\V

RI FRPSOLPHQWDU\ VXSSRUW WKDW DOORZV FXVWRPHUV WR FKRRVH WKH VHUYLFH WKDW

EHVW ILWV WKHLU QHHGV� 6XSSRUW RQ 'HPDQG RSWLRQV DUH RQ D SHU LQFLGHQW EDVLV�

,Q DGGLWLRQ� DQQXDO VXSSRUW FRQWUDFW RSWLRQV DUH DYDLODEOH SURYLGLQJ WROO�IUHH

SULRULW\ SKRQH VXSSRUW�

)RU PRUH LQIRUPDWLRQ RU WR SXUFKDVH VXSSRUW� FDOO &XVWRPHU &DUH DW �����

���������
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Tool and Button Summary
The Standard Toolbar

7KH 6WDQGDUG 7RROEDU FRQWDLQV 'HVLJQHU
V PRVW IUHTXHQWO\ XVHG EXWWRQV�

)LOH 0DQDJHPHQW

EXWWRQVV

3ULQW

6SHOO &KHFN 5HIHUHQFH 3RLQW

8QGR�5HGR

&XW
&RS\

3DVWH

6QDS 7R EXWWRQV

'UDZLQJ 7RROV

6KDUH 0HGLD

,PSRUW

+HOS
9LHZ 6L]H

&RORU 3DOHWWH
2EMHFW ([SORUHU

7RRO 1DPH 'HVFULSWLRQ

)LOH 0DQDJHPHQW

%XWWRQV

8VH WKH )LOH 0DQDJHPHQW EXWWRQV WR

FUHDWH� RSHQ� RU VDYH WR GLVNHWWH D

QHZ RU H[LVWLQJ GRFXPHQW�

3ULQW 8VH WKH 3ULQW EXWWRQ WR RSHQ WKH

3ULQW GLDORJ�

6SHOO &KHFN 8VH WKH 6SHOO &KHFN EXWWRQ WR FKHFN

WKH VSHOOLQJ RQ WKH FXUUHQW SDJH�
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&XW� &RS\� 3DVWH 8VH WKHVH EXWWRQV WR FXW� FRS\� DQG�RU

SDVWH VHOHFWHG REMHFWV RU EORFNV RI

WH[W�

8QGR�5HGR 8VH WKH 8QGR EXWWRQ WR XQGR WKH ODVW

SHUIRUPHG WDVN� 8VH WKH 5HGR EXWWRQ

WR UHDSSO\ WKH ODVW SHUIRUPHG WDVN�

6KDUH 0HGLD 8VH WKH 6KDUH 0HGLD EXWWRQ WR DFFHVV

FOLS DUW DQG RWKHU PHGLD ILOHV�

,PSRUW 8VH WKH ,PSRUW EXWWRQ WR LPSRUW D

ILOH LQWR WKH FXUUHQW GRFXPHQW�

6QDS 7R 5XOHUV 8VH WKH 6QDS 7R 5XOHUV EXWWRQ WR

WXUQ RQ RU RII WKH VQDS WR UXOHUV

RSWLRQ�

6QDS 7R *XLGH

/LQHV

8VH WKH 6QDS WR *XLGH /LQHV EXWWRQ

WR WXUQ RQ RU RII WKH VQDS WR JXLGH

OLQHV RSWLRQ�

$GG�5HPRYH

6QDS 3RLQWV

7KH $GG�5HPRYH 6QDS 3RLQWV EXWWRQV

WR DGG RU UHPRYH VQDS SRLQWV RQ D

VHOHFWHG REMHFW�

'\QDPLF 6QDS 8VH WKH '\QDPLF 6QDS EXWWRQ WR

HQDEOH WKH G\QDPLF VQDS SRLQWV

RSWLRQ�

&RORU 3DOHWWH 8VH WKH &RORU 3DOHWWH EXWWRQ WR VKRZ

RU KLGH WKH DFWLYH FRORU SDOHWWH�

'UDZLQJ 7RROV 8VH WKH 'UDZLQJ 7RROV EXWWRQ WR

RSHQ WKH GUDZLQJ WRROV ULEERQ DW WKH

ERWWRP RI \RXU 'HVLJQHU ZLQGRZ�

5HIHUHQFH 3RLQW 8VH WKH 5HIHUHQFH 3RLQW EXWWRQ WR

VKRZ RU KLGH WKH 5HIHUHQFH 3RLQW

WRROEDU�

9LHZ 6L]H %R[ 8VH WKH 9LHZ 6L]H ER[ WR FRQWURO WKH

]RRP IDFWRU RI D SDUWLFXODU SDJH�
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+HOS 8VH WKH +HOS EXWWRQ WR RSHQ

'HVLJQHU
V RQOLQH KHOS�
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Permanent Project Buttons/ Tabs

7RRO 1DPH 'HVFULSWLRQ

3DJHV %XWWRQ 8VH WKH 3DJHV %XWWRQ WR DGG SDJHV�

XSGDWH WKH PDVWHU SDJH� PRYH WR D

GLIIHUHQW SDJH� RU RSHQ WKH 3DJHV

GLDORJ ER[ WR QDPH� DGG� DQG GHOHWH

SDJHV�

0DVWHU 3DJH 7DE &OLFN WKH 0DVWHU 3DJH WDE WR DGG D

PDVWHU SDJH WR \RXU GRFXPHQW� ,WHPV

DQG IHDWXUHV� VXFK DV KHDGHUV� IRRWHUV�

ORJRV� DQG RWKHU JUDSKLFV WKDW DUH

SODFHG RQ WKH PDVWHU SDJH ZLOO DSSHDU

RQ HYHU\ SDJH RI \RXU 'HVLJQHU

GRFXPHQW�

3DJH 7DE 7KH 3DJH WDE OHWV \RX DGG QHZ SDJHV

WR \RXU GRFXPHQW DQG JR WR D

GLIIHUHQW SDJH�

/D\HUV %XWWRQ 8VH WKH /D\HUV EXWWRQ WR DGG OD\HUV�

PRYH WR D GLIIHUHQW OD\HU� RU RSHQ WKH

/D\HUV GLDORJ ER[ WR QDPH� DGG�

GHOHWH� UHDUUDQJH� FRORU� KLGH RU VKRZ�

DQG ORFN RU XQORFN OD\HUV�

/D\HU 3UREH 8VH WKH /D\HU 3UREH EXWWRQ WR VHOHFW

DQ REMHFW ZKHQ \RX DUH XQFHUWDLQ RI

ZKLFK OD\HU WR FKRRVH�

3DJHV %XWWRQ

0DVWHU 3DJH 7DE

3DJH 7DE

/D\HU 7DE

/D\HUV %XWWRQ

/D\HU 3UREH %XWWRQ
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1RWH

2Q WKH 0DVWHU 3DJH� 3DJH �� DQG /D\HU � WDEV� OHIW FOLFN WKH WDE WR PDNH WKH
SDJH DFWLYH� ULJKW FOLFN WR GLVSOD\ WKH PHQX�

/D\HU 7DE 7KH /D\HU WDE OHWV \RX DGG QHZ OD\HUV

WR \RXU GUDZLQJ DQG PRYH WR D

GLIIHUHQW OD\HU�
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Status Bar Buttons

7KH VWDWXV EDU DW WKH ERWWRP RI WKH 'HVLJQHU ZLQGRZ FRQWDLQV FXUUHQW

LQIRUPDWLRQ DERXW \RXU GUDZLQJ� LQFOXGLQJ OLQH VW\OH� LQWHULRU ILOO� W\SH RI REMHFW

VHOHFWHG� ]RRP OHYHO� DQG FRRUGLQDWHV� <RX DOVR FDQ FOLFN WKH &RRUGLQDWHV

EXWWRQ WR RSHQ WKH &RRUGLQDWHV PHQX� 7KH VWDWXV EDU FDQ EH D VLQJOH OLQH RU

D GRXEOH OLQH�

7RRO 1DPH 'HVFULSWLRQ

/LQH 6W\OH 7KH /LQH 6W\OH EXWWRQ VKRZV WKH OLQH

VW\OH DQG ZHLJKW RI WKH FXUUHQWO\

VHOHFWHG REMHFW� ,I QR REMHFW LV VHOHFWHG�

WKH /LQH EXWWRQ VKRZV WKH GHIDXOW OLQH

VW\OH DQG ZHLJKW� &OLFN WR RSHQ WKH

2EMHFW )RUPDW�/LQH )LOO GLDORJ�

)LOO 6W\OH 7KH )LOO 6W\OH EXWWRQ VKRZV WKH ILOO RI

WKH FXUUHQWO\ VHOHFWHG REMHFW� ,I QR

REMHFW LV VHOHFWHG� WKH )LOO EXWWRQ VKRZV

WKH GHIDXOW ILOO�

&OLFN WKH )LOO 6W\OH EXWWRQ WR RSHQ WKH

2EMHFW )RUPDW�,QWHULRU )LOO GLDORJ ER[

ZKHUH \RX FDQ VHOHFW FRORUV DQG WKH

W\SH RI ILOO�

&RRUGLQDWHV 7KH &RRUGLQDWHV EXWWRQ �NH\ERDUG

VKRUWFXW CTRL�4� RSHQV D GLDORJ WKDW

OHWV \RX FKDQJH WKH FRRUGLQDWH V\VWHP�

<RX FDQ DOVR RSHQ D GLDORJ ER[ WKDW

OHWV \RX XVH QXPHULF FRRUGLQDWHV WR

FRQWURO HGLWLQJ DQG GUDZLQJ DFWLRQV

WKDW XVXDOO\ UHTXLUH WKH PRXVH�

&RRUGLQDWHV %XWWRQ

/LQH 6W\OH %XWWRQ

)LOO 6W\OH %XWWRQ
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Constraint Buttons

7KH FRQVWUDLQW EXWWRQV OHW \RX DSSO\ UHVWULFWLRQV RQ KRZ REMHFWV FDQ EH

GUDZQ� $ VHOHFWHG EXWWRQ UHPDLQV RQ XQWLO \RX FOLFN LW DJDLQ WR WXUQ LW RII�

7RRO 1DPH 'HVFULSWLRQ

$QJOH &RQVWUDLQW 7KH $QJOH &RQVWUDLQW EXWWRQ IRUFHV

REMHFWV WR GUDZ LQ ���GHJUHH

LQFUHPHQWV�

3URSRUWLRQDO

&RQVWUDLQW

7KH 3URSRUWLRQDO &RQVWUDLQW EXWWRQ

IRUFHV UHFWDQJOHV WR GUDZ DV VTXDUHV

DQG HOOLSVHV WR GUDZ DV FLUFOHV�

5HYHUVH 'LUHFWLRQ 7KH 5HYHUVH 'LUHFWLRQ EXWWRQ

UHYHUVHV WKH GLUHFWLRQ 'HVLJQHU

QRUPDOO\ GUDZV REMHFWV WKDW DUH GUDZQ

IURP D VLQJOH VLGH�

)URP &HQWHU 7KH )URP &HQWHU EXWWRQ IRUFHV

REMHFWV WR GUDZ IURP D FHQWHU SRLQW

RXWZDUG�
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Select Tool

7KH 6HOHFW WRRO OHWV \RX VHOHFW REMHFWV LQ D GRFXPHQW�

Rotate/ Skew Tool

7KH 5RWDWH�6NHZ WRRO DOORZV \RX WR URWDWH DQG�RU VNHZ� RU WZLVW� D VHOHFWHG

REMHFW� <RX FDQ URWDWH DQ REMHFW E\ FOLFNLQJ DQG GUDJJLQJ D FRUQHU KDQGOH� DQG

\RX FDQ VNHZ DQ REMHFW E\ FOLFNLQJ DQG GUDJJLQJ D VLGH KDQGOH�

Edit Tool

7KH (GLW WRRO OHWV \RX H[WUXGH� ZDUS� DQG UHVKDSH REMHFWV LQ D GRFXPHQW�

:KHQ \RX FOLFN WKH (GLW WRRO� WKH ULEERQ GLVSOD\V D VHW RI EXWWRQV VSHFLILF WR

WKLV WRRO� &OLFN WKH (GLW WRRO WR YLHZ D PHQX RI WKH ZD\V WR HGLW D VHOHFWHG

REMHFW�

Reshape Buttons

7KH 5HVKDSH EXWWRQV GLVSOD\ DQ REMHFW
V DQFKRU SRLQWV DQG SXWV WKH REMHFW LQ

3RLQW 5HVKDSH PRGH� ,Q SRLQW UHVKDSH PRGH� \RX FDQ UHVKDSH WKH REMHFW E\

GUDJJLQJ LWV DQFKRU SRLQWV�

&RQYHUW WR &XUYHV

:LUHIUDPH

$GG�5HPRYH 3RLQWV

-RLQ 3RLQWV

&XW DW 3RLQW

(GLW &RUQHU�&XUYH

&XVS /RFN�8QORFN
5HGXFH 3RLQWV
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7RRO 1DPH 'HVFULSWLRQ

&RQYHUW WR &XUYHV 7KH 7R &XUYHV EXWWRQ �NH\ERDUG

VKRUWFXW CTRL�U� FRQYHUWV DQ REMHFW

VXFK DV WH[W� D UHFWDQJOH� RU DQ HOOLSVH

LQWR D FRQYHQWLRQDO REMHFW� 7KLV OHWV

\RX UHVKDSH WKH REMHFW E\ GUDJJLQJ LWV

DQFKRU SRLQWV� ,W DOVR FRQYHUWV

GLPHQVLRQ OLQHV WR JURXSV� DQG

FRQYHUWV :LQGRZV PHWDILOHV WR

'HVLJQHU REMHFWV�

:LUHIUDPH 7KH :LUHIUDPH EXWWRQ WRJJOHV

EHWZHHQ HGLWLQJ WKH REMHFW ZLWK DQG

ZLWKRXW ILOOV� (GLWLQJ ZLWK D ILOO VKRZV

WKH H[DFW UHVXOWV� EXW HGLWLQJ ZLWKRXW D

ILOO LV IDVWHU�

$GG�5HPRYH 3RLQWV 7KH $GG 3RLQW EXWWRQ SODFHV DQ

DQFKRU SRLQW ZKHUH \RX FOLFN RQ DQ

REMHFW� 7KH 5HPRYH 3RLQW EXWWRQ

UHPRYHV KLJKOLJKWHG DQFKRU SRLQWV�

5HGXFH 3RLQWV 7KH 5HPRYH 3RLQWV EXWWRQ HQDEOHV

\RX WR UHPRYH VRPH RI WKH SRLQWV LQ

WKH JUDSKLF�

-RLQ 3RLQWV 7KH -RLQ 3RLQWV EXWWRQ FRQQHFWV WZR

KLJKOLJKWHG DQFKRU SRLQWV ZLWK D

VWUDLJKW OLQH�

&XW DW 3RLQW 7KH &XW DW 3RLQW EXWWRQ FXWV WKURXJK D

OLQH FUHDWLQJ WZR VHSDUDWH DQFKRU

SRLQWV ZLWK D VPDOO HPSW\ VSDFH

EHWZHHQ WKHP�
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Warp Buttons

7KH :DUS EXWWRQV DUH XVHG WR WZLVW RU VNHZ VHOHFWHG REMHFWV� 8VH DQ\ RI WKH

SUHGHILQHG ZDUS EXWWRQV WR TXLFNO\ ZDUS D VHOHFWHG REMHFW� 7KH QRQ�

SUHGHILQHG ZDUS EXWWRQV DUH GHVFULEHG EHORZ�

(GLW &RUQHU�&XUYHV 7KH &RUQHU EXWWRQ �NH\ERDUG

VKRUWFXW CTRL��� FRQYHUWV WKH OLQHV

FRQQHFWHG WR D VHOHFWHG DQFKRU SRLQW

LQWR VWUDLJKW OLQHV� ,I DSSOLHG WR WZR

VHOHFWHG DQFKRU SRLQWV WKDW DUH

DGMDFHQW� WKH &RUQHU EXWWRQ FRQYHUWV

WKH OLQH EHWZHHQ WKH WZR SRLQWV LQWR D

VWUDLJKW OLQH�

7KH 6\PPHWULFDO &XUYH EXWWRQ

�NH\ERDUG VKRUWFXW CTRL��� FRQYHUWV

OLQHV FRQQHFWHG WR VHOHFWHG DQFKRU

SRLQWV LQWR V\PPHWULFDOO\ FXUYHG OLQHV�

&XVS /RFN�8QORFN 7KH 8QORFNHG &XVS EXWWRQ �NH\ERDUG

VKRUWFXW CTRL��� XQORFNV DQ DQFKRU
V

%Â]LHU FRQWURO SRLQWV VR \RX FDQ PRYH

WKH SRLQWV LQGHSHQGHQWO\� %\ PRYLQJ

RQH SRLQW DW D WLPH� \RX FDQ FUHDWH

VKDSHV VXFK DV D FXUYLQJ ZHGJH �WKDW LV�

D FXVS��

7KH /RFNHG &XVS EXWWRQ �NH\ERDUG

VKRUWFXW CTRL��� ORFNV WKH DQJXODU

UHODWLRQVKLS EHWZHHQ %Â]LHU FRQWURO

SRLQWV VR WKDW ZKHQ \RX GUDJ RQH RI

WKH SRLQWV� WKH RSSRVLWH PRYHV DOVR DV

UHTXLUHG WR NHHS WKH DQJOH EHWZHHQ

WKH WZR SRLQWV WKH VDPH�
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Extrude Buttons

([WUXGH EXWWRQV DUH XVHG WR SXOO VHOHFWHG REMHFWV�

7RRO 1DPH 'HVFULSWLRQ

:DUS 7\SH 8VH WKH :DUS 7\SH EXWWRQ WR HGLW D

VHOHFWHG REMHFW DV D OLQH� FXUYH� RU

%Â]LHU�

$GG�5HPRYH :DUS

(QYHORSH

8VH WKH $GG�5HPRYH :DUS (QYHORSH

EXWWRQV WR DGG RU UHPRYH WKH ZDUS

HQYHORSH� RU JULG� DURXQG D VHOHFWHG

REMHFW�

$GG 9HUWLFDO�

+RUL]RQWDO /LQHV

8VH WKH $GG 9HUWLFDO�+RUL]RQWDO /LQHV

EXWWRQV WR DGG YHUWLFDO RU KRUL]RQWDO

OLQHV WR D ZDUS HQYHORSH�

&RQYH[ :DUS

&RQFDYH :DUS

3HUVSHFWLYH :DUS

'RPH :DUS

6XQNHQ :DUS

:DUS 7\SH

$GG�5HPRYH :DUS (QYHORSH

$GG 9HUWLFDO�+RUL]RQWDO /LQHV

)LVKH\H :DUS

3LQFK :DUS

,VRPHWULF 5LJKW

,VRPHWULF /HIW

,VRPHWULF 'RZQ DQG 5LJKW

,VRPHWULF 'RZQ DQG /HIW
([WUXVLRQ 2SWLRQV

2EOLTXH ([WUXVLRQ

5HPRYH ([WUXVLRQ
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7RRO 1DPH 'HVFULSWLRQ

,VRPHWULF 5LJKW 8VH WKH ,VRPHWULF 5LJKW EXWWRQ WR

H[WUXGH DQ REMHFW WR WKH ULJKW�

,VRPHWULF /HIW 8VH WKH ,VRPHWULF /HIW EXWWRQ WR

H[WUXGH DQ REMHFW WR WKH OHIW�

,VRPHWULF 'RZQ DQG

5LJKW

8VH WKH ,VRPHWULF 'RZQ DQG 5LJKW

EXWWRQ WR H[WUXGH DQ REMHFW

GRZQZDUG DQG WR WKH ULJKW�

,VRPHWULF 'RZQ DQG

/HIW

8VH WKH ,VRPHWULF 'RZQ DQG /HIW

EXWWRQ WR H[WUXGH DQ REMHFW

GRZQZDUG DQG WR WKH OHIW�

2EOLTXH ([WUXVLRQ 8VH WKH 2EOLTXH ([WUXVLRQ EXWWRQ WR

H[WUXGH DQ REMHFW IRUZDUG ZKLOH

OHDYLQJ WKH RULJLQDO VKDSH LQWDFW�

5HPRYH ([WUXVLRQ 8VH WKH 5HPRYH ([WUXVLRQ EXWWRQ WR

UHPRYH WKH H[WUXVLRQ HIIHFWV RI D

VHOHFWHG REMHFW�

([WUXVLRQ 2SWLRQV 8VH WKH ([WUXVLRQ 2SWLRQV EXWWRQ WR

RSHQ WKH ([WUXVLRQ 2SWLRQV GLDORJ

ER[�
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View Tool

'HVLJQHU SURYLGHV PDQ\ ZD\V IRU \RX WR YLHZ \RXU ZRUN� <RX FDQ TXLFNO\

FKDQJH IURP RQH YLHZ WR DQRWKHU DV QHHGHG�

:KHQ \RX FOLFN WKH 9LHZ WRRO� D VHW RI WRROV RSHQV WR OHW \RX FKRRVH YDULRXV

YLHZV DQG IXQFWLRQV� 7KH YLHZ WRROV DUH JUD\ LI WKHUH DUH QR RSHQ GRFXPHQWV

RU LI \RX FOLFN WKH 3DJH 0DQDJHU WRRO�

7RRO 1DPH 'HVFULSWLRQ

=RRP ,Q 8VH WKH =RRP ,Q EXWWRQ �NH\ERDUG

VKRUWFXW )�� WR VHH DQG HGLW REMHFWV LQ

ILQH GHWDLO� <RX FDQ GUDJ D UHFWDQJOH WR

GHILQH WKH ]RRP DUHD IRU WKH REMHFWV

\RX ZDQW WR PDJQLI\� RU \RX FDQ FOLFN

RQ WKH GUDZLQJ WR PDJQLI\ E\ WZR

WLPHV�

=RRP 2XW 8VH WKH =RRP 2XW EXWWRQ �NH\ERDUG

VKRUWFXW CTRL�SHIFT�)�� WR FKDQJH

IURP D FORVH�XS� GHWDLOHG YLHZ WR D

EURDGHU� RYHUDOO YLHZ RI WKH SDJH�

&OLFNLQJ RQ WKLV WRRO ]RRPV RXW WZR

PDJQLILFDWLRQ OHYHOV�

=RRP ,Q

3UHYLRXV 9LHZ

=RRP 2XW

$FWXDO 6L]H

)XOO 3DJH8VHG $UHD

5HIUHVK

)XOO 6FUHHQ

3DQ
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3UHYLRXV 9LHZ 8VH WKH 3UHYLRXV 9LHZ EXWWRQ

�NH\ERDUG VKRUWFXW CTRL�)�� WR

UHWXUQ WR WKH YLHZ XVHG MXVW SULRU WR

WKH FXUUHQW YLHZ� XS WR WKH ODVW ��

YLHZV� 7KLV WRRO LV JUD\ LI WKHUH DUH QR

SUHYLRXV YLHZV�

$FWXDO 6L]H 8VH WKH $FWXDO 6L]H EXWWRQ �NH\ERDUG

VKRUWFXW SHIFT�)�� WR YLHZ REMHFWV DW

WKH VDPH VL]H WKH\ SULQW� <RX FDQ DOVR

VHOHFW DQ REMHFW DQG FOLFN WKH $FWXDO

6L]H WRRO WR FHQWHU WKH VHOHFWHG REMHFW

LQ WKH DFWLYH ZLQGRZ

8VHG $UHD 8VH WKH 8VHG $UHD EXWWRQ �NH\ERDUG

VKRUWFXW CTRL�SHIFT�)�� WR ]RRP LQ

RQ WKH SRUWLRQ RI WKH FXUUHQW SDJH

WKDW FRQWDLQV REMHFWV�

)XOO 3DJH 8VH WKH )XOO 3DJH EXWWRQ �NH\ERDUG

VKRUWFXW SHIFT�)�� WR YLHZ DOO RI WKH

REMHFWV RQ WKH FXUUHQW SDJH� 'HVLJQHU

ILWV WKH FXUUHQW SDJH LQ WKH ZLQGRZ�

)XOO 6FUHHQ 8VH WKH )XOO 6FUHHQ EXWWRQ �NH\ERDUG

VKRUWFXW )�� WR YLHZ MXVW \RXU ZRUN�

ZLWKRXW PHQXV� WLWOH EDU� RU DQ\ RWKHU

SDUW RI WKH 'HVLJQHU ZLQGRZ� 3UHVV

ESC RU FOLFN DQ\ZKHUH ZLWK WKH PRXVH

WR UHWXUQ WR WKH SUHYLRXV YLHZ�

5HIUHVK 8VH WKH 5HIUHVK EXWWRQ �NH\ERDUG

VKRUWFXW )�� WR FOHDU WKH VFUHHQ RI

XQZDQWHG IUDJPHQWV WKDW RFFDVLRQDOO\

UHVXOW IURP PDQLSXODWLQJ REMHFWV�

3DQ 8VH WKH 3DQ EXWWRQ WR PRYH WKH

GHVLUHG VHFWLRQ RI \RXU GUDZLQJ LQWR

YLHZ�
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Simple Line Tool

7KH 6LPSOH /LQH WRRO �NH\ERDUG VKRUWFXW CTRL�G� OHWV \RX GUDZ OLQHV�

FXUYHV� UHFWDQJOHV� SRO\JRQV� DQG HOOLSVHV XVLQJ D YDULHW\ RI PHWKRGV�

7RRO 1DPH 'HVFULSWLRQ

/LQH 6HJPHQW 8VH WKH /LQH 6HJPHQW EXWWRQ WR GUDZ

VWUDLJKW OLQH VHJPHQWV�

/LQH 6HJPHQW IURP

&HQWHU

8VH WKH /LQH 6HJPHQW IURP &HQWHU

EXWWRQ WR GUDZ D OLQH VHJPHQW VWDUWLQJ

IURP WKH FHQWHU DQG H[WHQGLQJ DQ

HTXDO GLVWDQFH LQ ERWK GLUHFWLRQV�

3DUDOOHO /LQH 8VH WKH 3DUDOOHO EXWWRQ WR GUDZ OLQHV

WKDW DUH SDUDOOHO WR OLQH VHJPHQWV� RU

WDQJHQW WR DUFV DQG HOOLSVHV�

3HUSHQGLFXODU /LQH 8VH WKH 3HUSHQGLFXODU EXWWRQ WR GUDZ

OLQHV WKDW DUH DW ULJKW DQJOHV WR OLQH

VHJPHQWV� DUFV� DQG HOOLSVHV�

4XDUWHU $UF /LQH 8VH WKH 4XDUWHU $UF EXWWRQ WR GUDZ

DQ DUF WKDW LV RQH TXDUWHU RI DQ HOOLSVH�

5HYHUVH 4XDUWHU

$UF

8VH WKH 5HYHUVH 4XDUWHU $UF EXWWRQ

WR GUDZ DQ LQYHUWHG DUF�

3DUDEROD 8VH WKH 3DUDEROD EXWWRQ WR GUDZ

SDUDEROLF VKDSHV�

3DUDEROD IURP

&HQWHU

8VH WKH 3DUDEROD IURP &HQWHU EXWWRQ

WR GUDZ D SDUDEROLF VKDSH IURP WKH

FHQWHU RXWZDUG�
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Compound Line Tool

7KH &RPSRXQG /LQH 7RRO OHWV \RX GUDZ OLQHDU DQG FXUYLQJ VKDSHV WKDW

FRQWDLQ PXOWLSOH SRLQWV�

�

7RRO 1DPH 'HVFULSWLRQ

,VRPHWULF 5LJKW 8VH WKH ,VRPHWULF 5LJKW EXWWRQ WR

H[WUXGH DQ REMHFW WR WKH ULJKW�

,VRPHWULF /HIW 8VH WKH ,VRPHWULF /HIW EXWWRQ WR

H[WUXGH DQ REMHFW WR WKH OHIW�

-RLQWHG /LQH 8VH WKH -RLQWHG /LQH EXWWRQ WR GUDZ

VKDSHV WKDW DUH D kFKDLQy RI FRQQHFWHG

VWUDLJKW OLQHV�

&XUYHG /LQH 8VH WKH &XUYHG /LQH EXWWRQ WR GUDZ

REMHFWV WKDW DUH D kFKDLQy RI

FRQQHFWHG� FXUYHG OLQHV�

%�6SOLQH 8VH WKH %�6SOLQH EXWWRQ OHWV \RX GUDZ

%Â]LHU VSOLQH FXUYHV� $ %�6SOLQH LV D

FXUYH GUDZQ LQVLGH D ZHGJH FUHDWHG

E\ WZR FRQVWUXFWLRQ OLQHV� )RU

H[DPSOH� k9y VKDSHG FRQVWUXFWLRQ OLQHV

ZRXOG FUHDWH D k8y VKDSHG REMHFW�

%Â]LHU &XUYH 8VH WKH %Â]LHU &XUYH EXWWRQ WR GUDZ

DQG HGLW %Â]LHU FXUYHV DW WKH VDPH

WLPH�

)UHHKDQG /LQH 8VH WKH )UHHKDQG EXWWRQ WR GUDZ

IUHHIRUP REMHFWV�

,UUHJXODU 3RO\JRQ 8VH WKH ,UUHJXODU 3RO\JRQ EXWWRQ WR

GUDZ FORVHG REMHFWV ZLWK PXOWLSOH

VLGHV�
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Sticky Line Tool

&UHDWH GLDJUDPPLQJ OLQHV ZLWK HQGV DQG SRLQWV WKDW DXWRPDWLFDOO\ DWWDFK� RU

VWLFN� WR WKH HQGV DQG SRLQWV RI RWKHU OLQHV�

7RRO 1DPH 'HVFULSWLRQ

6WLFN\ /LQH 6HJPHQW 8VH WKH 6WLFN\ /LQH 6HJPHQW EXWWRQ WR

GUDZ D VLQJOH VWLFN\ OLQH�

6WLFN\ 4XDUWHU $UF 8VH WKH 6WLFN\ 4XDUWHU $UF EXWWRQ WR

GUDZ D VWLFN\ DUF WKDW LV RQH TXDUWHU RI

DQ HOOLSVH�

6WLFN\ -RLQWHG /LQH 8VH WKH 6WLFN\ -RLQWHG /LQH EXWWRQ WR

GUDZ D VWLFN\ OLQH FRPSRVHG RI

FRQQHFWHG� VWUDLJKW OLQHV�

6WLFN\ &XUYHG /LQH 8VH WKH 6WLFN\ &XUYHG /LQH EXWWRQ WR

GUDZ D VWLFN\ OLQH FRPSRVHG RI

FRQQHFWHG� FXUYHG OLQHV�

6WLFN\ )UHHKDQG /LQH 8VH WKH 6WLFN\ )UHHKDQG /LQH EXWWRQ

WR GUDZ D IUHHIRUP OLQH WKDW VWLFNV WR

RWKHU REMHFWV�

6WLFN\ 5LJKW�DQJOH

/LQHV

8VH WKH 6WLFN\ 5LJKW�DQJOH /LQHV EXWWRQ

WR GUDZ VWLFN\ OLQHV WKDW IROORZ ULJKW�

DQJOH SDWKV EHWZHHQ RQH RU WZR

REMHFWV�

6WLFN\ %Â]LHU /LQHV 8VH WKH 6WLFN\ %Â]LHU /LQHV EXWWRQ WR

GUDZ VWLFN\ OLQHV WKDW IROORZ ULJKW�DQJOH

SDWKV� ZLWK %Â]LHU FXUYHG FRUQHUV�

EHWZHHQ RQH RU WZR REMHFWV�
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Rectangle Tool

7KH 5HFWDQJOH WRRO OHWV \RX GUDZ UHFWDQJOHV� VTXDUHV� DQG URXQGHG

UHFWDQJOHV�

7RRO 1DPH 'HVFULSWLRQ

'LDJRQDO 5HFWDQJOH 8VH WKH 'LDJRQDO 5HFWDQJOH EXWWRQ WR

GUDZ UHFWDQJOHV E\ GUDJJLQJ IURP RQH

FRUQHU WR LWV RSSRVLWH�

'LDJRQDO IURP

&HQWHU

8VH WKH 'LDJRQDO IURP &HQWHU EXWWRQ

WR GUDZ UHFWDQJOHV E\ GUDJJLQJ IURP

WKH FHQWHU WR WKH FRUQHU�

+HLJKW�:LGWK 8VH WKH +HLJKW�:LGWK EXWWRQ WR GUDZ

UHFWDQJOHV E\ GUDZLQJ WKH KHLJKW DQG

WKHQ WKH ZLGWK�

)URP &HQWHU /LQH 8VH WKH )URP &HQWHU /LQH EXWWRQ WR

GUDZ UHFWDQJOHV IURP WKH FHQWHU WR WKH

VLGH�

'LDJRQDO 6TXDUH 8VH WKH 'LDJRQDO 6TXDUH EXWWRQ WR

GUDZ VTXDUHV IURP RQH FRUQHU WR WKH

GLDJRQDOO\ RSSRVLWH FRUQHU�

'LDJRQDO 6TXDUH

IURP &HQWHU

8VH WKH 'LDJRQDO 6TXDUH IURP &HQWHU

EXWWRQ WR GUDZ VTXDUHV IURP WKH

FHQWHU WR WKH FRUQHU�

6LQJOH 6LGH 8VH WKH 6LQJOH 6LGH EXWWRQ WR GUDZ

VTXDUHV E\ GUDJJLQJ RQO\ RQH VLGH�

5RXQGHG 5HFWDQJOH 8VH WKH 5RXQGHG 5HFWDQJOH EXWWRQ WR

GUDZ UHFWDQJOHV ZLWK URXQGHG FRUQHUV�

7KH URXQGLQJ UDGLXV LV GHWHUPLQHG E\

WKH VHWWLQJ LQ WKH 5RXQGLQJ ER[�
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5RXQGLQJ %R[ 7KH 5RXQGLQJ ER[ VKRZV WKH FXUUHQW

FXUYDWXUH UDGLXV� <RX FDQ FOLFN WKH ER[

DQG W\SH D YDOXH� RU XVH WKH DUURZV

QH[W WR WKH ER[ WR VHOHFW D YDOXH� $

ODUJHU UDGLXV LQFUHDVHV WKH FXUYDWXUH� D

VPDOOHU UDGLXV GHFUHDVHV LW�
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Polygon Tool

7KH 3RO\JRQ EXWWRQ OHWV \RX GUDZ SRO\JRQ DQG VWDU VKDSHV�

7RRO 1DPH 'HVFULSWLRQ

7ULDQJOH 7R &RUQHU 8VH WKH 7ULDQJOH WR &RUQHU EXWWRQ WR

GUDZ D WULDQJOH IURP WKH FHQWHU WR WKH

FRUQHU�

7ULDQJOH 7R 6LGH 8VH WKH 7ULDQJOH WR 6LGH EXWWRQ WR

GUDZ D WULDQJOH IURP WKH FHQWHU RI WKH

WULDQJOH WR WKH PLGGOH RI WKH ERWWRP

VLGH�

7ULDQJOH 6LQJOH 6LGH 8VH WKH 7ULDQJOH 6LQJOH 6LGH EXWWRQ WR

GUDZ D WULDQJOH IURP RQH VLGH WR WKH

RWKHU�

+H[DJRQ 7R &RUQHU 8VH WKH +H[DJRQ WR &RUQHU EXWWRQ WR

GUDZ D KH[DJRQ IURP WKH FHQWHU WR D

FRUQHU�

+H[DJRQ 7R 6LGH 8VH WKH +H[DJRQ WR 6LGH EXWWRQ WR

GUDZ D KH[DJRQ IURP WKH FHQWHU WR D

VLGH�

+H[DJRQ 6LQJOH 6LGH 8VH WKH +H[DJRQ 6LQJOH 6LGH EXWWRQ

WR GUDZ D KH[DJRQ IURP RQH VLGH WR

DQRWKHU�

2FWDJRQ 7R &RUQHU 8VH WKH 2FWDJRQ 7R &RUQHU EXWWRQ WR

GUDZ DQ RFWDJRQ IURP WKH FHQWHU WR D

FRUQHU�

2FWDJRQ 7R 6LGH 8VH WKH 2FWDJRQ 7R 6LGH EXWWRQ WR

GUDZ DQ RFWDJRQ IURP WKH FHQWHU WR D

VLGH�

2FWDJRQ 6LQJOH 6LGH 8VH WKH 2FWDJRQ 6LQJOH 6LGH EXWWRQ WR

GUDZ DQ RFWDJRQ IURP RQH VLGH WR

DQRWKHU�
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7R &RUQHU 8VH WKH 7R &RUQHU EXWWRQ WR GUDZ D

SRO\JRQ IURP WKH FHQWHU WR D FRUQHU�

7R 6LGH 8VH WKH 7R 6LGH EXWWRQ WR GUDZ D

SRO\JRQ IURP WKH FHQWHU RI WKH

SRO\JRQ WR WKH PLGGOH RI D VLGH�

6LQJOH 6LGH 8VH WKH 6LQJOH 6LGH EXWWRQ WR GUDZ D

SRO\JRQ E\ GUDZLQJ MXVW RQH VLGH�

7R 3RLQW 8VH WKH 7R 3RLQW EXWWRQ WR GUDZ D VWDU

IURP WKH FHQWHU WR D SRLQW�

3RLQW WR 6LGH 8VH WKH 3RLQW WR 6LGH EXWWRQ WR GUDZ D

VWDU IURP WKH FHQWHU WR WKH PLGGOH RI D

VLGH�

3RLQW WR 3RLQW 8VH WKH 3RLQW WR 3RLQW EXWWRQ WR GUDZ

D VWDU E\ GUDZLQJ WKH GLVWDQFH

EHWZHHQ SRLQWV�

0HJDJRQ 8VH WKH 0HJDJRQ EXWWRQ WR GUDZ D

PHJDJRQ E\ FOLFNLQJ DQG GUDJJLQJ

RXWZDUG� LQZDUG� RU LQ D FLUFXODU

PRWLRQ�

&XUY\JRQ 8VH WKH &XUY\JRQ EXWWRQ WR GUDZ D

PHJDJRQ ZLWK FXUYHG SRLQWV E\ FOLFNLQJ

DQG GUDJJLQJ RXWZDUG� LQZDUG� RU LQ D

FLUFXODU PRWLRQ�

1XPEHU RI 6LGHV

%R[

8VH WKH 1XPEHU RI 6LGHV ER[ WR DVVLJQ

WKH QXPEHU RI VLGHV WR D SRO\JRQ�

PHJDJRQ� RU VWDU�
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EllipseTool

7KH (OOLSVH WRRO OHWV \RX GUDZ HOOLSVHV� FLUFOHV� DUFV� DQG SLHV�

7RRO 1DPH 'HVFULSWLRQ

'LDJRQDO (OOLSVH 8VH WKH 'LDJRQDO EXWWRQ WR GUDZ

HOOLSVHV E\ GUDJJLQJ IURP RQH FRUQHU RI

WKH ERXQGLQJ ER[ WR LWV RSSRVLWH�

(OOLSVH )URP &HQWHU 8VH WKH (OOLSVH IURP &HQWHU EXWWRQ WR

GUDZ HOOLSVHV E\ GUDJJLQJ RXWZDUG

IURP WKH FHQWHU�

+HLJKW�:LGWK 8VH WKH +HLJKW�:LGWK EXWWRQ WR GUDZ

HOOLSVHV E\ GUDJJLQJ WKH KHLJKW DQG WKHQ

WKH ZLGWK RI WKH ERXQGLQJ ER[�

&HQWHUOLQH (OOLSVH 8VH WKH &HQWHUOLQH (OOLSVH WR GUDZ

HOOLSVHV E\ GUDJJLQJ WKH FHQWHU OLQH WR

FUHDWH WKH ZLGWK RI WKH HOOLSVH� DQG

WKHQ PRYLQJ WKH FXUVRU WR VL]H WKH

KHLJKW�

&LUFOH )URP &RUQHU 8VH WKH &LUFOH )URP &RUQHU EXWWRQ WR

GUDZ FLUFOHV E\ GUDJJLQJ IURP WKH

FHQWHU�

'LDPHWHU 8VH WKH 'LDPHWHU EXWWRQ WR GUDZ D

FLUFOH E\ GUDJJLQJ LWV GLDPHWHU�

&LUFOH )URP 5DGLXV 8VH WKH &LUFOH )URP 5DGLXV EXWWRQ WR

GUDZ FLUFOHV E\ GUDJJLQJ LQ DQ\

GLUHFWLRQ�

��3RLQW &LUFOH 8VH WKH ��3RLQW &LUFOH EXWWRQ WR GUDZ

D FLUFOH E\ VSHFLI\LQJ WKUHH SRLQWV RI LWV

HGJH�
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��3RLQW $UF 8VH WKH ��3RLQW $UF EXWWRQ WR GUDZ DQ

DUF E\ VSHFLI\LQJ WZR HQG SRLQWV DQG

DQ DUFKLQJ SRLQW�

3LH 8VH WKH 3LH EXWWRQ WR GUDZ SLHV E\

PRGLI\LQJ DQ H[LVWLQJ HOOLSVH�
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Text Tool

7KH 7H[W WRRO �NH\ERDUG VKRUWFXW CTRL�W� OHWV \RX HQWHU DQG HGLW WH[W�

7RRO 1DPH 'HVFULSWLRQ

7H[W 0RGH 8VH WKH 7H[W 0RGH EXWWRQ WR HQWHU

DQG HGLW WH[W� <RX FDQ FOLFN LQ WKH

GUDZLQJ DUHD DQG HQWHU IUHHIRUP WH[W�

RU \RX FDQ GUDJ D FRQWDLQHU DQG HQWHU

EORFN WH[W�

7H[W 3DWK 8VH WKH 7H[W 3DWK EXWWRQ WR HQWHU WH[W

DORQJ WKH HGJH RI D VHOHFWHG REMHFW�

)LW 3DWK 8VH WKH )LW 3DWK EXWWRQ WR ILW IUHHIRUP

WH[W WR D SDWK RU HGLW WKH DUUDQJHPHQW

RI WH[W DOUHDG\ ILW WR D SDWK� 7KH )LW

3DWK EXWWRQ GLVSOD\V D SDOHWWH RI kTXLFN

FKRLFHy WH[W DOLJQPHQW EXWWRQV� DQG

WKH &KRRVH 3RVLWLRQ DQG 5HPRYH

&XUYH EXWWRQV�

6KDSH 7H[W 8VH WKH 6KDSH 7H[W EXWWRQ WR HQWHU

WH[W LQVLGH RI D VHOHFWHG �FORVHG�

REMHFW�

)RQW 5HFDOO 8VH WKH )RQW 5HFDOO EXWWRQ WR VHOHFW

IURP WKH ODVW WHQ IRQWV XVHG�

)RQW /LVW %R[ 7KH )RQW /LVW ER[ GLVSOD\V WKH QDPH RI

WKH FXUUHQW IRQW RU WKH IRQW RI WKH WH[W

WKDW FRQWDLQV WKH WH[W FXUVRU� 8VH WKH

GRZQ DUURZ QH[W WR WKH )RQW /LVW ER[

WR GLVSOD\ D OLVW RI DYDLODEOH IRQWV DQG WR

FKRRVH D IRQW�
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)RQW 6L]H %R[ 7KH )RQW 6L]H ER[ VKRZV WKH FXUUHQW

SRLQW VL]H RU WKH SRLQW VL]H RI WKH WH[W

WKDW FRQWDLQV WKH WH[W FXUVRU� <RX FDQ

XVH WKH DUURZV QH[W WR WKH )RQW 6L]H

ER[ WR FKDQJH WKH VL]H�

)RQW 6W\OHV 8VH WKH )RQW 6W\OHV EXWWRQV WR FKRRVH

WH[W VW\OHV� 7KH DYDLODEOH WH[W VW\OHV DUH

EROG �NH\ERDUG VKRUWFXW CTRL�E��

LWDOLF �NH\ERDUG VKRUWFXW CTRL�L��

XQGHUOLQH �NH\ERDUG VKRUWFXW

CTRL�X��

6PDOO &DSV 8VH WKH 6PDOO &DSV EXWWRQ �NH\ERDUG

VKRUWFXW CTRL�P� WR FRQYHUW DOO WH[W

WR VPDOO FDSLWDO OHWWHUV�

+RUL]RQWDO�9HUWLFDO

$OLJQPHQW

7KH +RUL]RQWDO $OLJQPHQW EXWWRQ

GLVSOD\V EXWWRQV WKDW OHW \RX FKDQJH

WKH KRUL]RQWDO DOLJQPHQW RI VHOHFWHG

WH[W� :KHQ \RX DOLJQ IUHHIRUP WH[W�

WKH WH[W LV DOLJQHG EDVHG RQ WKH SRLQW

ZKHUH \RX RULJLQDOO\ SODFHG WKH WH[W�

)RU H[DPSOH� LI \RX DUH DOLJQLQJ WR WKH

ULJKW DQG FOLFN WR HQWHU IUHHIRUP WH[W�

WKH WH[W H[WHQGV WR WKH OHIW DV \RX

W\SH�

7KH 9HUWLFDO $OLJQPHQW EXWWRQ GLVSOD\V

EXWWRQV WKDW OHW \RX FKDQJH WKH

YHUWLFDO DOLJQPHQW RI VHOHFWHG WH[W

H[FHSW LQ WH[W WKDW LV QRW LQ D

UHFWDQJXODU FRQWDLQHU�

7H[W $WWULEXWHV 7KH 7H[W $WWULEXWHV EXWWRQ �NH\ERDUG

VKRUWFXW CTRL�SHIFT�W� RSHQV WKH

7H[W $WWULEXWHV GLDORJ ER[� 7KLV GLDORJ

ER[ OHWV \RX FKDQJH IRQWV� PDUJLQV�

VSDFLQJ� DQG WDE VHWWLQJV�
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6SHOO &KHFN 7KH 6SHOO &KHFN EXWWRQ RSHQV WKH

6SHOOLQJ GLDORJ ER[ LI D PLVVSHOOLQJ LV

IRXQG�
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Dimension Tool

7KH 'LPHQVLRQ WRRO �NH\ERDUG VKRUWFXW CTRL�� >]HUR@� OHWV \RX GUDZ

GLPHQVLRQ OLQHV DQG VHW GLPHQVLRQ RSWLRQV�

7RRO 1DPH 'HVFULSWLRQ

$OLJQHG 'LPHQVLRQ 8VH WKH $OLJQHG 'LPHQVLRQ EXWWRQ WR

GUDZ GLPHQVLRQ OLQHV WR VKRZ WKH

GLDJRQDO GLVWDQFH EHWZHHQ WZR SRLQWV�

+RUL]RQWDO

'LPHQVLRQ

8VH WKH +RUL]RQWDO 'LPHQVLRQ EXWWRQ

WR GUDZ GLPHQVLRQ OLQHV WR VKRZ WKH

KRUL]RQWDO GLVWDQFH EHWZHHQ WZR

SRLQWV�

9HUWLFDO 'LPHQVLRQ 8VH WKH 9HUWLFDO 'LPHQVLRQ EXWWRQ WR

GUDZ GLPHQVLRQ OLQHV WR VKRZ WKH

YHUWLFDO GLVWDQFH EHWZHHQ WZR SRLQWV�

'LPHQVLRQ 2SWLRQV 8VH WKH 'LPHQVLRQ 2SWLRQV EXWWRQ WR

VHW GLPHQVLRQ RSWLRQV� LQFOXGLQJ

ZKHWKHU XQLWV RI PHDVXUHPHQW DQG

H[WHQVLRQ OLQHV DUH VKRZQ�

$QJXODU 'LPHQVLRQ 8VH WKH $QJXODU 'LPHQVLRQ EXWWRQ WR

FUHDWH D QHZ� DQJXODU GLPHQVLRQ OLQH�

5DGLDO 'LPHQVLRQ 8VH WKH 5DGLDO 'LPHQVLRQ EXWWRQ WR

FUHDWH D QHZ� UDGLDO GLPHQVLRQ OLQH�

'LVSOD\HG 3UHFLVLRQ

%R[

7KH 'LVSOD\HG 3UHFLVLRQ ER[ VKRZV WKH

FXUUHQW GHFLPDO SUHFLVLRQ RI WKH

GLPHQVLRQ XQLWV RI PHDVXUH� <RX FDQ

XVH WKH GRZQ DUURZ QH[W WR WKH OLVW

ER[ WR VHOHFW D QHZ SUHFLVLRQ OHYHO�

8QLWV 7KH 8QLWV EXWWRQ OHWV \RX VHOHFW WKH

XQLWV RI PHDVXUH XVHG E\ D GLPHQVLRQ

OLQH�
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7H[W $WWULEXWHV 7KH 7H[W $WWULEXWHV EXWWRQ �NH\ERDUG

VKRUWFXW CTRL�SHIFT�W� RSHQV WKH

7H[W $WWULEXWHV GLDORJ ER[� 7KLV GLDORJ

ER[ OHWV \RX FKDQJH IRQWV� PDUJLQV�

VSDFLQJ� DQG WDE VHWWLQJV�

/LQH (QGV 7KH /LQH (QGV EXWWRQ RSHQV D PHQX

WKDW OHWV \RX FKRRVH WKH W\SH DQG

SODFHPHQW RI GLPHQVLRQ OLQH HQGV�
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Callout Tool

7KH &DOORXW WRRO OHWV \RX FUHDWH FDOORXW OLQHV DQG WH[W� <RX FDQ DOVR VHW FDOORXW

RSWLRQV�

7RRO 1DPH 'HVFULSWLRQ

2QH�6HJPHQW

&DOORXW

8VH WKH 2QH�6HJPHQW &DOORXW

EXWWRQ WR FUHDWH D FDOORXW ZLWK RQH

OHJ�

7ZR�6HJPHQW

&DOORXW

8VH WKH 7ZR�6HJPHQW &DOORXW

EXWWRQ WR FUHDWH D FDOORXW ZLWK WZR

OHJV�

7KUHH�6HJPHQW

&DOORXW

8VH WKH 7KUHH�6HJPHQW &DOORXW

EXWWRQ WR FUHDWH D FDOORXW ZLWK WKUHH

OHJV�

5HVKDSH &DOORXW 8VH WKH 5HVKDSH &DOORXW EXWWRQ WR

UHVKDSH VHOHFWHG GLPHQVLRQ RU

FDOORXW OLQHV�

7H[W $WWULEXWHV 7KH 7H[W $WWULEXWHV EXWWRQ

�NH\ERDUG VKRUWFXW CTRL�SHIFT�W�

RSHQV WKH 7H[W $WWULEXWHV GLDORJ ER[�

7KLV GLDORJ ER[ OHWV \RX FKDQJH IRQWV�

PDUJLQV� VSDFLQJ� DQG WDE VHWWLQJV�

/LQH (QGV 7KH /LQH (QGV EXWWRQ RSHQV D PHQX

WKDW OHWV \RX FKRRVH WKH W\SH DQG

SODFHPHQW RI GLPHQVLRQ OLQH HQGV�

&DOORXW 2SWLRQV 8VH WKH &DOORXW 2SWLRQV EXWWRQ WR

GLVSOD\ WKH 'LPHQVLRQV GLDORJ� )URP

WKLV GLDORJ� \RX FDQ VHW JHQHUDO

RSWLRQV� WH[W RULHQWDWLRQ� WH[W

SRVLWLRQ� UDGLDO RSWLRQV� FDOORXW

RSWLRQV� DQG WROHUDQFH�
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&DOORXW 7H[W %R[ 8VH WKH &DOORXW 7H[W ER[ WR VHOHFW RU

HQWHU FDOORXW WH[W�
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Image Tool

7KH ,PDJH WRRO �NH\ERDUG VKRUWFXW CTRL�Z� OHWV \RX WUDFH DQG FURS ELWPDS

LPDJHV� <RX FDQ DOVR RSHQ \RXU VHOHFWHG ELWPDS HGLWRU LQ WKH ,PDJH 7RRO

ULEERQ�

7RRO 1DPH 'HVFULSWLRQ

(GLW ,PDJH 7KH (GLW ,PDJH EXWWRQ RSHQV \RXU

VHOHFWHG ELWPDS HGLWRU� VXFK DV 3LFWXUH

3XEOLVKHU� <RX FDQ FKDQJH WKH GHIDXOW

ELWPDS HGLWRU LQ WKH *HQHUDO SDQHO RI

WKH 3UHIHUHQFHV GLDORJ ER[�

&URS�5HPRYH &URS 7KH &URS EXWWRQ OHWV \RX VSHFLI\ D

UHFWDQJXODU DUHD RI D VHOHFWHG LPDJH WR

VKRZ� 7KH UHVW RI WKH LPDJH LV KLGGHQ�

7KH 5HPRYH &URS EXWWRQ UHVWRUHV D

SUHYLRXVO\ FURSSHG LPDJH�

,PDJH (IIHFWV 7KH ,PDJH (IIHFW EXWWRQ RSHQV WKH

0LFURJUDI[ (IIHFWV %URZVHU� 8VH WKH

(IIHFWV %URZVHU WR DSSO\ D VSHFLDO

LPDJH HIIHFW WR D VHOHFWHG REMHFW�

'URS�5HVWRUH &RORU 8VH WKH 'URS &RORU EXWWRQ WR VHOHFW D

FRORU WKDW \RX ZDQW WR EHFRPH

WUDQVSDUHQW� 8VH WKH 5HVWRUH &RORU

EXWWRQ WR UHPRYH WKH WUDQVSDUHQF\

IURP WKH LPDJH�

(GLW ,PDJH

&URS�5HPRYH

&URS

,PDJH (IIHFWV

'URS�5HVWRUH

&RORU

1XPEHU RI &RORUV,PDJH

,QIRUPDWLRQ

7UDFH

)RUHJURXQG�

%DFNJURXQG 1RLVH /HYHO

7UDFH 4XDOLW\

/LQH 7\SH
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)RUHJURXQG �

%DFNJURXQG

7KH )RUHJURXQG DQG %DFNJURXQG

EXWWRQV RSHQ D SDOHWWH IURP ZKLFK

\RX FDQ FKRRVH IRUHJURXQG DQG

EDFNJURXQG FRORUV IRU D PRQRFKURPH

ELWPDS LPDJH� 7KH DSSHDUDQFH RI

WKHVH EXWWRQV FKDQJHV WR UHIOHFW WKH

FXUUHQW VHOHFWLRQ�

,PDJH ,QIRUPDWLRQ 7KH ,PDJH ,QIRUPDWLRQ EXWWRQ VKRZV

ILOH DQG GLVSOD\ VL]H LQIRUPDWLRQ DERXW D

VHOHFWHG ELWPDS LPDJH�

7UDFH 8VH WKH 7UDFH EXWWRQ WR FUHDWH D

YHFWRU kWUDFLQJy RI WKH ELWPDS LPDJH

WKDW LV SODFHG RQ WRS RI WKH LPDJH�

7UDFH 4XDOLW\ 7KH 7UDFH 4XDOLW\ EXWWRQ RSHQV D

PHQX WKDW OHWV \RX DGMXVW KRZ

DFFXUDWHO\ DQG VPRRWKO\ 'HVLJQHU

WUDFHV D ELWPDS LPDJH�

/LQH 7\SH 7KH /LQH 7\SH EXWWRQ RSHQV D PHQX

WKDW OHWV \RX FKRRVH ZKHWKHU 'HVLJQHU

XVHV OLQHV RU FXUYHV WR FUHDWH WKH

WUDFLQJ�

1XPEHU RI &RORUV

%R[

,Q WKH 1XPEHU RI &RORUV ER[� VHOHFW

WKH QXPEHU RI FRORUV \RX ZDQW WR XVH

ZKHQ WUDFLQJ DQ LPDJH� <RX FDQ DVVLJQ

XS WR ��� FRORUV�

1RLVH /HYHO %R[ 8VH WKH 1RLVH /HYHO ER[ WR VHOHFW WKH

QRLVH OHYHO WR XVH ZKHQ WUDFLQJ DQ

LPDJH�
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Format Tool

7KH )RUPDW WRRO �NH\ERDUG VKRUWFXW CTRL�\� OHWV \RX VHOHFW FRORUV� OLQH

WKLFNQHVV� JUDGLHQW W\SHV� DQG RWKHU VW\OHV IRU REMHFWV�

Format Ribbon - Interior

7RRO 1DPH 'HVFULSWLRQ

6ROLG ,QWHULRU )LOO 8VH WKH 6ROLG ,QWHULRU )LOO EXWWRQ WR

VHOHFW DQ LQWHULRU ILOO FRORU�

*UDGLHQW ,QWHULRU )LOO 8VH WKH *UDGLHQW ,QWHULRU )LOO EXWWRQ WR

VHOHFW D JUDGLHQW LQWHULRU ILOO FRORU�

+DWFK ,QWHULRU )LOO 8VH WKH +DWFK ,QWHULRU )LOO EXWWRQ WR

VHOHFW D KDWFK� RU OLQH SDWWHUQ� LQWHULRU

ILOO�

,PDJH ,QWHULRU )LOO 8VH WKH ,PDJH ,QWHULRU )LOO EXWWRQ WR

VHOHFW DQ LPDJH WR XVH DV DQ LQWHULRU ILOO�

2EMHFW ,QWHULRU )LOO 8VH WKH 2EMHFW ,QWHULRU )LOO WR VHOHFW DQ

REMHFW WR XVH DV DQ LQWHULRU ILOO�

5HPRYH ,QWHULRU )LOO 8VH WKH 5HPRYH ,QWHULRU )LOO EXWWRQ WR

UHPRYH DQ\ W\SH RI ILOO FXUUHQWO\

DVVLJQHG WR DQ REMHFW�

,QWHULRU )LOO *DOOHU\ 8VH WKH ,QWHULRU )LOO *DOOHU\ EXWWRQ WR

VHOHFW DQ LQWHULRU ILOO IURP D SLFWRULDO OLVW

RI WKH PRVW UHFHQWO\ DSSOLHG ILOO VW\OHV�

,PDJH ,QWHULRU )LOO

6ROLG ,QWHULRU )LOO 2EMHFW ,QWHULRU )LOO ,QWHULRU )LOO *DOOHU\

5HPRYH ,QWHULRU )LOO*UDGLHQW ,QWHULRU )LOO

+DWFK ,QWHULRU )LOO
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Format Ribbon - Line

7RRO 1DPH 'HVFULSWLRQ

/LQH $WWULEXWHV 8VH WKH /LQH $WWULEXWHV EXWWRQ WR

FKRRVH D OLQH
V HQGV� VW\OH� DQG

WKLFNQHVV�

6ROLG /LQH )LOO 8VH WKH 6ROLG /LQH )LOO EXWWRQ WR VHOHFW

D OLQH
V ILOO FRORU�

*UDGLHQW /LQH )LOO 8VH WKH *UDGLHQW /LQH )LOO EXWWRQ WR

VHOHFW D JUDGLHQW OLQH ILOO FRORU�

+DWFK /LQH )LOO 8VH WKH +DWFK /LQH )LOO EXWWRQ WR

VHOHFW D KDWFK� RU SDWWHUQ� OLQH ILOO�

,PDJH /LQH )LOO 8VH WKH ,PDJH /LQH )LOO EXWWRQ WR VHOHFW

DQ LPDJH WR XVH DV D OLQH
V ILOO�

2EMHFW /LQH )LOO 8VH WKH 2EMHFW /LQH )LOO EXWWRQ WR

VHOHFW DQ REMHFW WR XVH DV D OLQH
V ILOO�

5HPRYH /LQH )LOO 8VH WKH 5HPRYH /LQH )LOO EXWWRQ WR

UHPRYH DQ\ W\SH RI ILOO FXUUHQWO\

DVVLJQHG WR D OLQH�

/LQH )LOO *DOOHU\ 8VH WKH /LQH )LOO *DOOHU\ EXWWRQ WR

VHOHFW DQ LQWHULRU OLQH ILOO IURP D

SLFWRULDO OLVW RI WKH PRVW UHFHQWO\

DSSOLHG OLQH ILOO VW\OHV�

/LQH $WWULEXWHV

6ROLG /LQH )LOO

*UDGLHQW /LQH

)LOO

+DWFK /LQH )LOO

5HPRYH /LQH )LOO

/LQH )LOO *DOOHU\

,PDJH /LQH )LOO

2EMHFW /LQH )LOO
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Format Ribbon - Other Settings

7RRO 1DPH 'HVFULSWLRQ

6ROLG 7UDQVSDUHQF\ 8VH WKH 6ROLG 7UDQVSDUHQF\ EXWWRQ WR

VHW WKH WUDQVSDUHQF\ RI WKH VHOHFWHG

REMHFW�

*UDGLHQW

7UDQVSDUHQF\

8VH WKH *UDGLHQW 7UDQVSDUHQF\

EXWWRQ WR VHW WKH WUDQVSDUHQF\ DQG

JUDGLHQW RI WKH VHOHFWHG REMHFW�

5HPRYH

7UDQVSDUHQF\

8VH WKH 5HPRYH 7UDQVSDUHQF\

EXWWRQ WR XQGR WKH WUDQVSDUHQF\

VHWWLQJV RQ WKH VHOHFWHG REMHFW�

7UDQVSDUHQF\

&RQWURO

8VH WKH VOLGLQJ 7UDQVSDUHQF\ &RQWURO

WR DGMXVW WKH DPRXQW RI WUDQVSDUHQF\

IRU WKH VHOHFWHG REMHFW�

7H[W )RUHJURXQG �

%DFNJURXQG &RORU

8VH WKH 7H[W )RUHJURXQG�

%DFNJURXQG &RORU EXWWRQV WR VHOHFW

WKH IRUHJURXQG DQG EDFNJURXQG

FRORUV IRU DQ\ VHOHFWHG WH[W�

6KRZ 6W\OHV 7RROEDU 8VH WKH 6KRZ 6W\OHV 7RROEDU EXWWRQ

WR HLWKHU VKRZ RU KLGH WKH 6W\OHV

7RROEDU�

6KRZ &RORU 3DOHWWH 8VH WKH 6KRZ &RORU 3DOHWWH EXWWRQ

WR HLWKHU VKRZ RU KLGH WKH FRORU

SDOHWWH�

6ROLG 7UDQVSDUHQF\

*UDGLHQW 7UDQVSDUHQF\

5HPRYH 7UDQVSDUHQF\

7UDQVSDUHQF\ &RQWURO

7H[W )RUHJURXQG�

%DFNJURXQG &RORU

6KRZ 6W\OHV 7RROEDU

6KRZ &RORU 3DOHWWH
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Page Manager Tool

7KH 3DJH 0DQDJHU WRRO �NH\ERDUG VKRUWFXW CTRL�G� OHWV \RX YLHZ� PRYH�

DQG SULQW SDJHV LQ 'HVLJQHU� ,W DOVR OHWV \RX FUHDWH VOLGH VKRZV XVLQJ HDFK SDJH

DV D VOLGH�

7RRO 1DPH 'HVFULSWLRQ

&UHDWH 6WDQGDORQH 8VH WKH &UHDWH 6WDQGDORQH EXWWRQ WR

VDYH D SUHVHQWDWLRQ DV DQ H[HFXWDEOH

SURJUDP ��(;(��

&RS\ WR 'LVNHWWH 8VH WKH &RS\ WR 'LVNHWWH EXWWRQ WR

FRS\ D VWDQGDORQH VLGH VKRZ WR RQH

RU PRUH GLVNHWWHV�

2SWLRQV 8VH WKH 3UHIHUHQFHV EXWWRQ WR

FKRRVH D SRLQWHU VW\OH DQG WR VHW

WUDQVLWLRQ SUHIHUHQFHV�

6WDQGDORQH 6HWXS 8VH WKH 6WDQGDORQH 6HWXS EXWWRQ WR

VHOHFW WKH QXPEHU RI FRORUV DQG WKH

VFUHHQ UHVROXWLRQ�

5XQ 6OLGH 6KRZ 8VH WKH 5XQ 6OLGH 6KRZ EXWWRQ WR

EHJLQ D VOLGHVKRZ� FRQVLVWLQJ RI DOO

VOLGHV LQ WKH GRFXPHQW RU RQO\ D

VHOHFWHG UDQJH RI VOLGHV�

&UHDWH 6WDQGDORQH

7UDQVLWLRQ (IIHFWV
&RS\ WR 'LVNHWWH

6WDQGDORQH

6HWXS

3DJH 6HWXS

5XQ 6OLGH 6KRZ

3ULQW

2SWLRQV

6HOHFW�'HVHOHFW

DOO 3DJHV

7UDQVLWLRQ /LVW

7UDQVLWLRQ 'LUHFWLRQ

7UDQVLWLRQ 6SHHG

0DQXDO�7LPHG

7UDQVLWLRQ

'XUDWLRQ
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3ULQW 7KH 3ULQW EXWWRQ RSHQV D GLDORJ ER[

WKDW OHWV \RX VHOHFW WKH SDJHV WR SULQW

DORQJ ZLWK RWKHU SULQWLQJ RSWLRQV�

3DJH 6HWXS 7KH 3DJH 6HWXS EXWWRQ OHWV \RX

VHOHFW WKH SDJH VL]H DQG RULHQWDWLRQ�

<RX FDQ DOVR FKDQJH PDUJLQV� SDJH

FRORU� DQG VXEGLYLGH WKH SDJH �E\

WLOLQJ� KHUH�

6HOHFW�'HVHOHFW DOO

3DJHV

8VH WKH 6HOHFW $OO 3DJHV EXWWRQ WR

VHOHFW DOO SDJHV LQ WKH GRFXPHQW� 8VH

WKH 'HVHOHFW $OO 3DJHV EXWWRQ

GHVHOHFWV DOO VHOHFWHG SDJHV LQ WKH

GRFXPHQW�

7UDQVLWLRQ (IIHFWV 7KH 7UDQVLWLRQ EXWWRQ RSHQV D GLDORJ

ER[ WKDW OHWV \RX FKRRVH WUDQVLWLRQ

HIIHFWV IRU VOLGHV�

7UDQVLWLRQ /LVW %R[ 7KH 7UDQVLWLRQ OLVW ER[ OHWV \RX

FKRRVH D WUDQVLWLRQ IRU VHOHFWHG VOLGHV�

7UDQVLWLRQ 'LUHFWLRQ 7KH 'LUHFWLRQV EXWWRQ LV DYDLODEOH

ZKHQ WKH WUDQVLWLRQ GLUHFWLRQ FDQ EH

FKDQJHG� 8VH WKLV EXWWRQ WR FKDQJH

WKH GLUHFWLRQ RI WKH VHOHFWHG

WUDQVLWLRQ� 7KH DSSHDUDQFH RI WKLV

EXWWRQ FKDQJHV WR UHIOHFW WKH

VHOHFWHG GLUHFWLRQ�

7UDQVLWLRQ 6SHHG

%R[

7KH 6SHHG OLVW ER[ OHWV \RX FKDQJH

WKH WUDQVLWLRQ VSHHG IRU WKH VHOHFWHG

VOLGH�

0DQXDO�7LPHG

7UDQVLWLRQ

8VH WKH 0DQXDO EXWWRQ WR DGYDQFH

WR WKH QH[W VOLGH ZLWK WKH PRXVH RU

NH\ERDUG� 8VH WKH 7LPHG EXWWRQ WR

DGYDQFH DXWRPDWLFDOO\ WR WKH QH[W

VOLGH DW D WLPHG LQWHUYDO�
T o o l  a n d  B u t t o n  Su m m a r y  71



'XUDWLRQ %R[ 7KH 'XUDWLRQ ER[ OHWV \RX HQWHU D

GXUDWLRQ LQ VHFRQGV IRU VHOHFWHG

VOLGHV�
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Setting Designer Options
Getting Started

'HVLJQHU OHWV \RX FXVWRPL]H \RXU ZRUNLQJ HQYLURQPHQW E\ VHWWLQJ \RXU

SUHIHUHQFHV IRU PDQ\ DVSHFWV RI 'HVLJQHU� <RXU SUHIHUHQFHV FDQ EH VDYHG LQ

D SURILOH RU VWDUW�XS ILOH VR WKDW WKH\ DSSO\ HYHU\ WLPH \RX UXQ 'HVLJQHU� RU

\RX FDQ UHVWULFW SUHIHUHQFHV WR \RXU FXUUHQW ZRUN VHVVLRQ E\ QRW VDYLQJ

WKHP� ,I \RX ZDQW WR PDLQWDLQ GLIIHUHQW VHWV RI SUHIHUHQFHV� \RX FDQ GHILQH

WZR RU PRUH SURILOH ILOHV� &HUWDLQ SUHIHUHQFHV� VXFK DV UXOHU XQLWV� DUH VDYHG

ZLWK WKH GRFXPHQW VR WKDW \RX GR QRW KDYH WR UHVHW WKHP HDFK WLPH \RX

RSHQ WKH GRFXPHQW� 7R VHW \RXU SUHIHUHQFHV� FOLFN 2SWLRQV IURP WKH 7RROV

PHQX�

7KH 3UHIHUHQFHV FRPPDQG GLVSOD\V D VXEPHQX WKDW OHWV \RX VHW PDQ\

GLIIHUHQW FDWHJRULHV RI SUHIHUHQFHV�

7KH FDWHJRULHV LQFOXGH JHQHUDO SUHIHUHQFHV� FXVWRPL]LQJ WKH WRROER[� UXOHU

DQG VQDS RSWLRQV� URWDWLRQ RSWLRQV� LQSXW �SULPDULO\ PRXVH� RSWLRQV� VHWWLQJV

IRU ,1, �LQLWLDOL]DWLRQ ILOHV�� DQG FKDQJLQJ \RXU SURILOH �FROOHFWLRQ RI \RXU

SHUVRQDO SUHIHUHQFHV��

Using the Status Bar

7KH VWDWXV EDU SURYLGHV FXUUHQW LQIRUPDWLRQ DERXW \RXU GUDZLQJ DQG TXLFN

DFFHVV WR YDULRXV FRPPDQGV VXFK DV OLQH WKLFNQHVV� REMHFW ILOO� DQG

FRRUGLQDWHV�
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&KRRVH 6WDWXV %DU RQ WKH 9LHZ PHQX DQG FKRRVH 6LQJOH WR GLVSOD\ WKH VLQJOH�

OLQH VWDWXV EDU� &KRRVH 'RXEOH IURP WKH 6WDWXV %DU VXEPHQX WR GLVSOD\ WKH

GRXEOH�OLQH VWDWXV EDU�

1RWH

7KH 6WDWXV %DU RSWLRQV RQ WKH 9LHZ PHQX DUH DYDLODEOH RQO\ ZKHQ WKH
6WDWXV WRROEDU LV YLVLEOH� 7R VKRZ RU KLGH WKH 6WDWXV %DU� FOLFN 7RROEDUV LQ
WKH 9LHZ PHQX�

Setting the Preview (on the View menu)

7KH 3UHYLHZ FRPPDQG RQ WKH 9LHZ PHQX DIIHFWV DOO ILOOV DQG SDWWHUQV �VROLG�

JUDGLHQW� LPDJH� REMHFW ILOO� DQG KDWFK ILOO�� <RX FDQ XVH WKH WKUHH RSWLRQV

�3URRI� 'UDIW� RU :LUHIUDPH� LQ WKH 3UHYLHZ VXEPHQX WR FRQWURO WKH GLVSOD\

IRU DOO RI WKHVH W\SHV RI ILOOV DW RQFH� ,I \RX VHW 3UHYLHZ WR 3URRI� \RX FDQ XVH

WKH LQGLYLGXDO FRPPDQGV IRU JUDGLHQW� LPDJH� REMHFW ILOO� DQG KDWFK ILOOV WR

FRQWURO WKHLU GLVSOD\ LQGLYLGXDOO\�

*HQHUDOO\� WKH 3UHYLHZ FRPPDQG RYHUULGHV \RXU VHOHFWLRQV ZLWK WKH

LQGLYLGXDO FRPPDQGV� )RU H[DPSOH� LI \RX VHOHFW 'UDIW LQ WKH 3UHYLHZ

VXEPHQX� JUDGLHQWV DUH DXWRPDWLFDOO\ VHW WR QRQH� DQG RWKHU FRPPDQGV DUH

JUD\HG

&RPPDQG 'LVSOD\

3UHYLHZ 3URRI )XOO 3UHYLHZ�DOO FRORUV DQG ILOOV DUH GLVSOD\HG�

\RX FDQ OLPLW JUDGLHQW� LPDJH� REMHFW� DQG

KDWFK ILOOV ZLWK LQGLYLGXDO FRPPDQGV�

3UHYLHZ 'UDIW 6ROLG ILOOV DUH QRUPDO� JUDGLHQWV� KDWFK ILOOV� DQG

REMHFW ILOOV DUH VROLG �ILUVW FRORU RQO\�� ,PDJH

ILOOV DQG PDVNHG REMHFWV DUH VROLG� ELWPDS

LPDJHV DUH D UHFWDQJOH ZLWK DQ ;� $OO OLQHV DUH

GLVSOD\HG DV KDLUOLQHV�

3UHYLHZ :LUHIUDPH 1R ILOOV RU OLQH HQGV DUH GLVSOD\HG� DOO OLQHV DUH

GLVSOD\HG DV KDLUOLQHV�
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<RX VHW YLHZLQJ RSWLRQV RQ WKH 9LHZ PHQX� 9LHZ RSWLRQV DIIHFW DOO RSHQ

GRFXPHQWV� QRW MXVW WKH DFWLYH ZLQGRZ�

)URP WKH :RUNVSDFH VXEPHQX� \RX FDQ HLWKHU VHOHFW RU GHVHOHFW WR VKRZ RU

KLGH WKH IROORZLQJ IURP WKH GLVSOD\�

v *ULG

v *XLGHV

v &URVVKDLUV �NH\ERDUG VKRUWFXW CTRL+H�

6KRZ *UDGLHQWV 6PRRWK %HVW JUDGLHQW GLVSOD\� ZLWK DOO FRORUV DQG

VPRRWK JUDGDWLRQV IURP RQH FRORU WR WKH

QH[W�

6KRZ *UDGLHQWV $YHUDJH $OO FRORUV DUH VKRZQ� EXW JUDGDWLRQV DUH QRW

DV VPRRWK�

6KRZ *UDGLHQWV &RDUVH )HZHU FRORUV� ZLWK EDQGLQJ�

6KRZ *UDGLHQWV 1RQH 2QO\ WKH ILUVW FRORU LV GLVSOD\HG�

6KRZ ,PDJHV �VHOHFWHG� $OO FRORUV DQG JUD\ VFDOHV LQ WKH ELWPDS DUH

GLVSOD\HG�

6KRZ ,PDJHV �GHVHOHFWHG� 5HFWDQJOH ZLWK DQ ; RQ LW WR VKRZ SRVLWLRQ

RQO\�

6KRZ 2EMHFW )LOOV

�VHOHFWHG�

2EMHFW ILOOV GLVSOD\HG�

6KRZ 2EMHFW )LOOV

�GHVHOHFWHG�

2QO\ WKH IRUHJURXQG FRORU LV GLVSOD\HG�

6KRZ +DWFK )LOOV �VHOHFWHG� +DWFK ILOOV GLVSOD\HG�

6KRZ +DWFK )LOOV

�GHVHOHFWHG�

2QO\ WKH IRUHJURXQG FRORU LV GLVSOD\HG�

6KRZ ,PDJH )LOOV �VHOHFWHG� ,PDJH ILOOV GLVSOD\HG�

6KRZ ,PDJH )LOOV

�GHVHOHFWHG�

2QO\ WKH IRUHJURXQG FRORU LV GLVSOD\HG�

&RPPDQG 'LVSOD\
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v 3ULQWHU 3DJH 7LOHV �QRQ�SULQWLQJ JXLGHOLQHV WKDW LQGLFDWH WKDW WKH SDJH LV

ODUJHU WKDQ WKH WDUJHW SULQWHUjV SDSHU VL]H�

v 5XOHUV

v 5XOHU SRVLWLRQ �WKH FRORUHG PDUNV LQ WKH UXOHUV WKDW LQGLFDWH WKH

SRVLWLRQ RI WKH PRXVH SRLQWHU�

General Options

7KH *HQHUDO SDQHO RI WKH 2SWLRQV GLDORJ ER[ OHWV \RX VHW D YDULHW\ RI KLJK�

OHYHO SUHIHUHQFHV� &OLFN 2SWLRQV IURP WKH 7RROV PHQX WR RSHQ WKH 2SWLRQV

GLDORJ ER[�

Set tin g the Recentl y Used File List

<RX FDQ VSHFLI\ KRZ PDQ\ UHFHQWO\ XVHG ILOHV \RX ZDQW 'HVLJQHU WR

UHPHPEHU� 7KH GHIDXOW YDOXH LV ��

7KH 2SHQ PHQX OLVWV WKH PRVW UHFHQWO\ XVHG ILOHV DFFRUGLQJ WR WKH QXPEHU

VSHFLILHG KHUH� 6HW WKH QXPEHU WR LQFOXGHG WKH PD[LPXP QXPEHU RI ILOHV \RX

ZDQW GLVSOD\HG IURP WKH 2SHQ PHQX�

Set tin g the Undo Event Limit

%\ GHIDXOW� WKH 8QGR DQG 5HGR FRPPDQGV RQ WKH (GLW PHQX UHYHUVH �8QGR�

RU UHYHUVH WKH UHYHUVDO �5HGR� RI WKH PRVW UHFHQW ILYH DFWLRQV� 7KH 2SWLRQV

GLDORJ ER[ OHWV \RX VSHFLI\ WKDW 'HVLJQHU UHPHPEHU IURP � WR ��� XQGR DQG

UHGR VWHSV VLQFH WKH ODVW VDYH�
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6HWWLQJ D KLJKHU QXPEHU RI VWHSV JLYHV \RX WKH IUHHGRP WR WU\ PXOWLSOH

FKDQJHV DQG WKH FDSDELOLW\ WR XQGR WKRVH FKDQJHV LI GHVLUHG� EXW WDNHV XS

PHPRU\�

,I \RX GR QRW ZDQW D FRQILUPDWLRQ PHVVDJH WR DSSHDU HDFK WLPH \RX GHOHWH

ILOHV �VXFK DV ZLWK WKH 'HOHWH FRPPDQG ZLWK WKH )LOH 2SWLRQV EXWWRQ�� \RX

FDQ GHVHOHFW WKLV RSWLRQ� ,I \RX WXUQ RII WKH FRQILUPDWLRQ PHVVDJH� ILOHV DUH

GHOHWHG DV VRRQ DV \RX LVVXH WKH FRPPDQG�

Set tin g the Auto Save Time Period

8VH WKH 0DNH %DFNXSV RSWLRQ WR UHWDLQ D FRS\ RI WKH SUHYLRXV YHUVLRQ RI DOO

GRFXPHQW ILOHV� 'HVLJQHU DSSHQGV WKH H[WHQVLRQ %$. WR WKH ILOHQDPH� :KHQ

WKH 0DNH %DFNXSV RSWLRQ LV VHOHFWHG� \RX KDYH WZR FRSLHV RI WKH GRFXPHQW

RQ GLVN�WKH FXUUHQW YHUVLRQ DQG WKH SUHYLRXVO\ VDYHG YHUVLRQ�

7KH EDFNXS YHUVLRQ LV RYHUZULWWHQ HDFK WLPH \RX VDYH WKH GRFXPHQW�

Set tin g the Make Backu ps on Save

6HOHFW WKLV RSWLRQ WR DXWRPDWLFDOO\ EDFN XS ILOHV HYHU\ WLPH \RX VDYH D

GRFXPHQW�

Set tin g the Out put to QSF

7KH 2XWSXW WR 46) RSWLRQ LV LGHDO IRU RXWSXWWLQJ GRFXPHQWV IRU SXEOLVKLQJ

RQ WKH ,QWHUQHW� 6HOHFW WKLV RSWLRQ WR RXWSXW RQO\ RQH SDJH ZKHQ XVLQJ WKH

46) IRUPDW�

Usin g Smar t Colorization

6PDUW FRORUL]DWLRQ DXWRPDWLFDOO\ DGMXVWV WKH KXH RI JURXSHG REMHFWV ZKHQ

FKDQJLQJ WKH FRORU RI WKH JURXS RI REMHFWV�

Savin g Designer Files

7KHUH DUH PDQ\ IRUPDWV LQ ZKLFK WR VDYH \RXU 'HVLJQHU ILOHV� &OLFN WKH DUURZ

EXWWRQ WR UHYHDO D OLVW RI DOO WKH DYDLODEOH IRUPDWV�
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Setting Display Options

<RX VHW GLVSOD\ SUHIHUHQFHV LQ WKH 'LVSOD\ SDQHO RI WKH 2SWLRQV GLDORJ ER[�

'LVSOD\ SUHIHUHQFHV DIIHFW DOO RSHQ GRFXPHQWV� QRW MXVW WKH DFWLYH ZLQGRZ�

&OLFN 2SWLRQV IURP WKH 7RROV PHQX WR RSHQ WKH 2SWLRQV GLDORJ ER[�

Set tin g the Auto Scroll

:KHQ VHOHFWHG� $XWR 6FUROO FDXVHV WKH ZLQGRZ WR DXWRPDWLFDOO\ VFUROO ZKHQ

\RX GUDJ DQ REMHFW EH\RQG WKH ZLQGRZ ERUGHUV� 7KLV LV HVSHFLDOO\ XVHIXO

ZKHQ \RX KDYH ]RRPHG LQ IRU FORVH ZRUN�

Suppressin g New on Star tu p

,I \RX GR QRW ZDQW 'HVLJQHU WR FUHDWH D QHZ ILOH ZKHQ \RX RSHQ LW� VHOHFW WKLV

RSWLRQ� 6HOHFWLQJ WKLV RSWLRQ PDNHV 'HVLJQHU VWDUW IDVWHU�

Set tin g the Anti-Alias O ptions

7KH HGJHV RI PDQ\ W\SHV RI JUDSKLFV FDQ RIWHQ DSSHDU IX]]\ RU EOXU LQWR

RWKHU REMHFWV� 6HOHFW DQ\ RI WKH DQWL�DOLDV RSWLRQV WR VKDUSHQ WKH RXWHU HGJHV

RI \RXU 'HVLJQHU JUDSKLFV�

Set tin g the Ima ge Out put Qualit y

8VH WKH ,PDJH 2XWSXW 4XDOLW\ ER[ WR DGMXVW WKH RXWSXW TXDOLW\ RI DOO \RXU

'HVLJQHU LPDJHV� 7KH RXWSXW TXDOLW\ FDQ EH DGMXVWHG WR KLJK� PHGLXP� RU ORZ�
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Definin g the Handle Size

7KH +DQGOH 6L]H RSWLRQ OHWV \RX VHOHFW VPDOO� PHGLXP� RU ODUJH KDQGOHV WR VXLW

\RXU SUHIHUHQFH�

Setting Ruler Options

,Q WKH 5XOHUV SDQHO RI WKH 2SWLRQV GLDORJ ER[� WKH +RUL]RQWDO DQG 9HUWLFDO

5XOHU DUHDV SURYLGH RSWLRQV DIIHFWLQJ WKH WZR UXOHUV� 7KH UXOHUV DUH

LQGHSHQGHQW� VR \RX FDQ KDYH GLIIHUHQW RSWLRQV IRU HDFK� 7KH UXOHU VHWWLQJV

DUH VDYHG ZLWK WKH GRFXPHQW�

)RU HDFK UXOHU� \RX FDQ FKRRVH D XQLW RI PHDVXUH� WKH QXPEHU RI VQDS

GLYLVLRQV IRU HDFK UXOHU XQLW� DQG KRZ WKH UXOHU LV ODEHOHG� &OLFN 2SWLRQV IURP

WKH 7RROV PHQX WR RSHQ WKH 2SWLRQV GLDORJ ER[�

Set tin g the Ruler Units

<RX FDQ FKDQJH WKH PHDVXUHPHQW XQLWV RI D UXOHU E\ FOLFNLQJ LWV 8QLWV EXWWRQ

DQG FKRRVLQJ WKH GHVLUHG XQLWV�

1RWH

<RX FDQ DOVR VHW UXOHU XQLWV DFFRUGLQJ WR D VSHFLILF VFDOH E\ XVLQJ WKH 6FDOH
'UDZLQJ :L]DUG� 6LPSO\ FOLFN 6FDOH 6HWXS IURP WKH )LOH PHQX DQG IROORZ
WKH VFUHHQ SURPSWV WR GHILQH D VFDOH RQ ZKLFK WR EDVH \RXU UXOHUV�
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Set tin g the Number of Sna ps Per Unit

7KH 6QDSV SHU 8QLW VHWWLQJ VHWV WKH QXPEHU RI GLYLVLRQV SHU XQLW� ZKLFK

DIIHFWV WKH QXPEHU RI JULG GRWV WKDW DSSHDU ZKHQ WKH JULG LV GLVSOD\HG DQG

DOVR DIIHFWV KRZ REMHFWV VQDS WR WKH UXOHUV LI 6QDS WR 5XOHUV LV VHOHFWHG� 7KH

JULG DSSHDUV DV D SDWWHUQ RI GRWWHG OLQHV WKDW FRUUHVSRQGV WR GLYLVLRQV LQ \RXU

UXOHU VHWWLQJV� <RX FDQ XVH WKH JULG DV D JXLGH IRU DOLJQLQJ REMHFWV RU

PHDVXULQJ GLVWDQFHV�

1RWH

7R SUHYHQW WKH GUDZLQJ DUHD IURP EHFRPLQJ WRR FOXWWHUHG� 'HVLJQHU OLPLWV
WKH QXPEHU RI JULG GRWV DQG UXOHU GLYLVLRQV WKDW DSSHDU�

Set tin g the Label Fre quency

7KLV YDOXH VSHFLILHV KRZ IUHTXHQWO\ D QXPEHU DSSHDUV WR ODEHO WKH UXOHU
V

XQLWV� 7KLV RSWLRQ SUHYHQWV RYHUFURZGLQJ WKH UXOHU ZKHQ LW LV VHW WR VPDOO

XQLWV� )RU H[DPSOH� ZKHQ D UXOHU LV VHW WR LQFKHV� \RX PLJKW XVH D YDOXH RI ��

EXW ZKHQ D UXOHU LV VHW WR PLOOLPHWHUV� \RX PLJKW SUHIHU D YDOXH RI ���

Set tin g Displayed Precision Coordinates

7KH 'LVSOD\HG 3UHFLVLRQ RI 5XOHU 8QLWV YDOXH VHWV WKH GHFLPDO SUHFLVLRQ RI WKH

FRRUGLQDWHV GLVSOD\HG LQ WKH VWDWXV EDU� 7KH + OLVW ER[ VHWV WKH SUHFLVLRQ IRU

WKH +RUL]RQWDO DQG ; FRRUGLQDWHV� 7KH 9 OLVW ER[ VHWV WKH SUHFLVLRQ IRU WKH

9HUWLFDO DQG < FRRUGLQDWHV�

Changing the Ruler Ori gin

7KH UXOHU RULJLQ LV WKH SRLQW� RQ RU RII WKH SDJH� ZKHUH WKH WZR UXOHUV

LQWHUVHFW DW ]HUR� 7KH GHIDXOW SRVLWLRQ IRU WKH UXOHU RULJLQ LV DW WKH XSSHU OHIW

FRUQHU RI WKH SDJH� <RX FDQ DOVR GUDJ DQG GURS WKH 5XOHU RULJLQ EXWWRQ

WR FKDQJH WKH SODFHPHQW RI WKH UXOHU RULJLQ�
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To chan ge the placement of the ruler ori gin

,I \RX KDYH VHOHFWHG 6QDS WR 5XOHUV LQ WKH 'LVSOD\ PHQX� WKH QHZ UXOHU RULJLQ

DOVR VQDSV WR WKH UXOHUV� 7KLV HQVXUHV WKDW \RXU JULG UHPDLQV WKH VDPH� ,I \RX

KDYH GHVHOHFWHG 6QDS WR 5XOHUV� WKH QHZ UXOHU RULJLQ LV SODFHG DW WKH H[DFW

SRLQW ZKHUH \RX SODFH LW�

<RX FDQ TXLFNO\ UHVHW WKH UXOHU RULJLQ WR LWV GHIDXOW SRVLWLRQ DW WKH FRUQHU RI

WKH SDJH E\ GRXEOH FOLFNLQJ WKH EXWWRQ DW WKH LQWHUVHFWLRQ RI WKH WZR UXOHUV�

1 0DNH VXUH WKDW UXOHUV DUH GLVSOD\HG� 2Q WKH 9LHZ PHQX� FOLFN 5XOHUV�

DQG WKHQ FOLFN 6KRZ 5XOHUV� LI QHFHVVDU\�

2 3RLQW WR WKH EXWWRQ DW WKH LQWHUVHFWLRQ RI WKH WZR UXOHUV DQG SUHVV DQG

KROG WKH OHIW PRXVH EXWWRQ�

3 'UDJ WKH PRXVH SRLQWHU WR WKH GHVLUHG SRVLWLRQ�

4 5HOHDVH WKH PRXVH EXWWRQ� 7KH ]HUR SRLQW RQ HDFK UXOHU FKDQJHV WR

UHIOHFW WKH QHZ SODFHPHQW�

7LSV

,I \RX KDYH VHOHFWHG 6QDS WR 5XOHUV RQ WKH 7RROV PHQX� WKH QHZ UXOHU
RULJLQ DOVR VQDSV WR WKH UXOHUV� 7KLV HQVXUHV WKDW \RXU JULG UHPDLQV WKH
VDPH� ,I \RX KDYH GHVHOHFWHG 6QDS WR 5XOHUV� WKH QHZ UXOHU RULJLQ LV SODFHG
DW WKH H[DFW SRLQW ZKHUH \RX SODFH LW�

<RX FDQ TXLFNO\ UHVHW WKH UXOHU RULJLQ WR LWV GHIDXOW SRVLWLRQ DW WKH FRUQHU RI
WKH SDJH E\ GRXEOH FOLFNLQJ WKH EXWWRQ DW WKH LQWHUVHFWLRQ RI WKH WZR UXOHUV�

Setting Snap Options

6QDS RSWLRQV OHW \RX VHOHFW RU GHVHOHFW ZKHUH 'HVLJQHU SODFHV VQDS SRLQWV RQ

DQ REMHFW� 6QDSSLQJ LV EDVHG RQ WKH UXOHU XQLWV� LI \RX FKDQJH WKH QXPEHU RI

VQDSV SHU UXOHU XQLW� \RX DOVR FKDQJH WKH QXPEHU RI VQDS SRLQWV DQG WKH

DSSHDUDQFH RI WKH RQ�VFUHHQ JULG� %\ GHIDXOW� WKH QXPEHU RI VQDSV SHU XQLW LV

WKH VDPH DV WKH VWDQGDUG UXOHU GLYLVLRQV� )RU H[DPSOH� DQ LQFK KDV �� VQDSV�

DQG D FHQWLPHWHU KDV WHQ VQDSV�
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7KH QXPEHU RI VQDSV SHU UXOHU XQLW FDQ EH FKDQJHG LQ WKH 5XOHUV SDQHO RI WKH

2SWLRQV GLDORJ ER[� 7KH UXOHUV DGMXVW WR FRUUHVSRQG WR WKH QXPEHU RI VQDSV

SHU XQLW� )RU H[DPSOH� D FHQWLPHWHU ZLWK ILYH VQDSV SHU XQLW GLVSOD\V ILYH XQLW

PDUNV LQ WKH UXOHU�

Snapping to the Ruler

6QDSSLQJ WR WKH UXOHU FDXVHV WKH PRXVH SRLQWHU WR DWWUDFW WR WKH FORVHVW UXOHU

LQWHUVHFWLRQ� ,I XVHG LQ FRQMXQFWLRQ ZLWK 'UDJJLQJ 6QDS� DQ REMHFW
V ERXQGLQJ

ER[ VQDSV WR WKH FORVHVW UXOHU LQFUHPHQW DV \RX PRYH LW�

Snapping to Guides

*XLGHV DUH QRQSULQWLQJ KRUL]RQWDO DQG YHUWLFDO UHIHUHQFH OLQHV WKDW \RX FDQ

GUDJ IURP WKH UXOHU� %\ WXUQLQJ RQ 6QDS WR *XLGHV� \RX FDQ PDNH QHDUE\

JXLGHOLQHV DWWUDFW WKH PRXVH SRLQWHU DV \RX GUDZ DQ REMHFW� LI XVHG LQ

FRQMXQFWLRQ ZLWK 'UDJJLQJ 6QDS� DQ REMHFW
V ERXQGLQJ ER[ VQDSV WR WKH

FORVHVW JXLGH OLQH DV \RX PRYH LW�

Set tin g a Dragging Snap

6HOHFW WKH 'UDJJLQJ 6QDS RSWLRQ WR FDXVH DQ REMHFW
V ERXQGLQJ ER[� UDWKHU

WKDQ WKH PRXVH SRLQWHU� WR VQDS WR WKH UXOHUV RU JXLGHV ZKHQ \RX DUH PRYLQJ

�GUDJJLQJ� WKH REMHFW� :KHQ 'UDJJLQJ 6QDS LV VHOHFWHG� WKH PRXVH SRLQWHU

ZLOO FRQWLQXH WR VQDS WR UXOHUV RU JXLGHV ZKHQ GUDZLQJ DQ REMHFW �LI 6QDS WR

5XOHU RU 6QDS WR *XLGHV LV FXUUHQWO\ VHOHFWHG��

'UDJJLQJ 6QDS KDV QR HIIHFW RQ REMHFW PRYHPHQW LI 6QDS WR 5XOHU DQG�RU

6QDS WR *XLGHV LV RII� RQH RI WKHVH PXVW EH VHOHFWHG WR DFWLYDWH WKH 'UDJJLQJ

6QDS IXQFWLRQDOLW\�
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Set tin g the D ynamic Sna p

6HOHFW WKH '\QDPLF 6QDS RSWLRQ WR SUHFLVHO\ DOLJQ VWLFN\ OLQHV� RU WR DWWDFK

GLPHQVLRQ OLQHV WR DQ REMHFW� :KHQ GLPHQVLRQ OLQHV DUH DWWDFKHG E\ VHWWLQJ

WKH G\QDPLF VQDS� WKH GLPHQVLRQ OLQHV DUH DXWRPDWLFDOO\ UHFDOFXODWHG ZKHQ

WKH REMHFW LV UHVL]HG�

To set the D ynamic Sna p

1 2Q WKH 7RROV PHQX� FOLFN 6QDS�

2 &OLFN '\QDPLF 6QDS RQ WKH VXEPHQX�

RU

&OLFN 2SWLRQV DQG WKHQ FOLFN WKH 6QDS WDE� &OLFN WKH '\QDPLF 6QDS

FKHFN ER[�

7LS

$OWHUQDWHO\� \RX FDQ VHW WKH '\QDPLF 6QDS E\ ULJKW FOLFNLQJ RQ WKH UXOHU�
VHOHFWLQJ 5XOHUV�6QDS 2SWLRQV� FOLFNLQJ WKH 6QDS WDE� DQG FOLFN WKH '\QDPLF
6QDS FKHFN ER[�

1RWH

<RX PXVW EH LQ 'UDZLQJ PRGH IRU WKH G\QDPLF VQDSV WR GLVSOD\�

To add d ynamic sna ps

1 6HOHFW DQ REMHFW�

2 2Q WKH 7RROV PHQX� FOLFN 6QDS� 6HOHFW &XVWRPL]H '\QDPLF 6QDSV IURP

WKH VXEPHQX�

3 2Q WKH &XVWRPL]H '\QDPLF 6QDSV GLDORJ ER[� FOLFN $GG�

4 2Q WKH GLDORJ ER[ GLVSOD\� FOLFN ZKHUH \RX ZDQW HDFK DGGLWLRQDO VQDS

SRLQW�

5 &OLFN $SSO\ DQG WKHQ FOLFN &ORVH�
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To delete d ynamic sna ps

1 6HOHFW DQ REMHFW�

2 2Q WKH 7RROV PHQX� FOLFN 6QDS� 6HOHFW &XVWRPL]H '\QDPLF 6QDSV IURP

WKH VXEPHQX�

3 2Q WKH &XVWRPL]H '\QDPLF 6QDSV GLDORJ ER[� FOLFN WKH VQDS SRLQW \RX

ZDQW WR GHOHWH� 7R VHOHFW PRUH WKDQ RQH VQDS SRLQW� SUHVV WKH SHIFT

NH\ ZKLOH PDNLQJ \RXU VHOHFWLRQV�

4 &OLFN 'HOHWH�

5 &OLFN $SSO\ DQG WKHQ FOLFN &ORVH�

To move d ynamic sna ps

1 6HOHFW DQ REMHFW�

2 2Q WKH 7RROV PHQX� FOLFN 6QDS� 6HOHFW &XVWRPL]H '\QDPLF 6QDSV IURP

WKH VXEPHQX�

3 2Q WKH &XVWRPL]H '\QDPLF 6QDSV GLDORJ ER[� FOLFN WKH VQDS SRLQW \RX

ZDQW WR PRYH� 7R VHOHFW PRUH WKDQ RQH VQDS SRLQW� SUHVV WKH SHIFT

NH\ ZKLOH PDNLQJ \RXU VHOHFWLRQV�

4 .HHS WKH OHIW PRXVH EXWWRQ SUHVVHG DQG GUDJ WKH VQDS SRLQW�V� WR

WKHLU QHZ ORFDWLRQ� 5HOHDVH WKH PRXVH EXWWRQ�

5 &OLFN $SSO\ DQG WKHQ FOLFN &ORVH�

Changing Snap Point Sensitivity

<RX FDQ LQFUHDVH RU GHFUHDVH WKH VHQVLWLYLW\ RI VQDS SRLQWV E\ FKDQJLQJ WKH

KDQGOH VL]H� &KRRVH D ODUJH KDQGOH VL]H WR LQFUHDVH WKH VQDS UDQJH� FKRRVH D

VPDOOHU VL]H WR GHFUHDVH WKH UDQJH�

To chan ge snap point sensitivit y

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 6HOHFW D KDQGOH VL]H� $ ODUJH KDQGOH VL]H LQFUHDVHV WKH VQDS UDQJH� D

VPDOOHU VL]H GHFUHDVHV WKH UDQJH�
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To to ggle Snap to Rulers on or off

` 2Q WKH 7RROV PHQX� SRLQW WR 6QDS DQG FOLFN 6QDS WR 5XOHUV�

To to ggle Snap to Guides on or off

` 2Q WKH 7RROV PHQX� SRLQW WR 6QDS DQG FOLFN 6QDS WR *XLGHV�

To to ggle Dynamic Sna p on or off

To to ggle Dynamic Sna p on or off

` 2Q WKH 7RROV PHQX� SRLQW WR 6QDS DQG FOLFN '\QDPLF 6QDS�

Choosing Where Snap Points Appear on an 
Object

<RX FDQ FKRRVH ZKHUH 'HVLJQHU SODFHV VQDS SRLQWV RQ DQ REMHFW� )RU

H[DPSOH� \RX PLJKW ZDQW VQDS SRLQWV WR DSSHDU RQO\ DW FRUQHUV� <RX FDQ

FKDQJH ZKHUH VQDS SRLQWV DSSHDU DW DQ\ WLPH�

Object Snap Points

7KHVH RSWLRQV OHW \RX VHOHFW RU GHVHOHFW ZKHUH 'HVLJQHU SODFHV VQDS SRLQWV�

7KH RSWLRQV LQFOXGH�

v %RXQGV

v (QG 3RLQWV

v &HQWHU 0LG 3RLQW

v 3LYRW

v &RQWURO 3RLQWV
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v 9HUWLFHV

To choose sna p point placement

1 2SHQ WKH 7RROV PHQX DQG FOLFN 2SWLRQV�

2 &OLFN 6QDS WR GLVSOD\ WKH 6QDS SDQHO�

3 &KRRVH WKH ORFDWLRQV ZKHUH \RX ZDQW VQDS SRLQWV WR DSSHDU�

4 &OLFN 2. ZKHQ \RX ILQLVK�

Changing the Number of Snaps

6QDSSLQJ LV EDVHG RQ WKH UXOHU XQLWV� LI \RX FKDQJH WKH QXPEHU RI VQDSV SHU

UXOHU XQLW� \RX DOVR FKDQJH WKH QXPEHU RI VQDS SRLQWV DQG WKH DSSHDUDQFH RI

WKH RQ�VFUHHQ JULG� %\ GHIDXOW� WKH QXPEHU RI VQDSV SHU XQLW LV WKH VDPH DV

WKH VWDQGDUG UXOHU GLYLVLRQV� )RU H[DPSOH� DQ LQFK KDV �� VQDSV� DQG D

FHQWLPHWHU KDV WHQ VQDSV�

center

vertexmidpoint

center

midpoint

midpoint

endpoint
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To chan ge the number of sna ps

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV

2 &OLFN WKH 5XOHU WDE�

3 &KDQJH WKH QXPEHU RI VQDSV SHU UXOHU XQLW� 7KH UXOHUV UHGUDZ WR

FRUUHVSRQG WR WKH QXPEHU RI VQDSV SHU XQLW� )RU H[DPSOH� D

FHQWLPHWHU ZLWK ILYH VQDSV SHU XQLW GLVSOD\V ILYH XQLW�PDUNV RQ WKH UXOHU�

Setting Rotation Options

7KH 5RWDWLRQ SDQHO OHWV \RX VHW WKH URWDWLRQ DQJOH LQFUHPHQW IRU WKH )� NH\

DQG FRQVWUDLQ URWDWLRQV WR DQJOH LQFUHPHQWV IRU PDQXDO URWDWLRQ� 7R FKDQJH

WKH URWDWLRQ XQLWV VHWWLQJ �GHJUHHV RU UDGLDQV�� FOLFN WKH 5RWDWLRQ $QJOH 8QLWV

EXWWRQ DQG FKRRVH WKH QHZ XQLW� &OLFN 2SWLRQV IURP WKH 7RROV PHQX WR

RSHQ WKH 2SWLRQV GLDORJ ER[�

Set tin g the F8 Rotation Increment

<RX FDQ FKDQJH WKH )� URWDWLRQ LQFUHPHQW E\ FOLFNLQJ WKH DUURZV EHVLGH WKH

)� 5RWDWLRQ ,QFUHPHQW ER[� HQWHULQJ D QHZ YDOXH� RU GUDJJLQJ WKH UHG QHHGOH

LQ WKH GLDO FRQWURO�

Set tin g a Manual Rotation Increment

6HWWLQJ 0DQXDO 5RWDWLRQ ,QFUHPHQW WR D QRQ�]HUR YDOXH� FRQVWUDLQV PDQXDO

URWDWLRQ WR LQFUHPHQWV RI WKH VSHFLILHG YDOXH� )RU H[DPSOH� LI \RX VHW WKH

URWDWLRQ DQJOH WR �� GHJUHHV� DQ REMHFW URWDWHV LQ LQFUHPHQWV RI �� GHJUHHV

ZKHQ \RX GUDJ LWV FRUQHU URWDWLRQ KDQGOHV� 7R FKDQJH WKH 0DQXDO 5RWDWLRQ

,QFUHPHQW� HQWHU D QHZ YDOXH RU GUDJ WKH UHG QHHGOH LQ WKH GLDO FRQWURO�
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Setting Input Options

7KH ,QSXW SDQHO OHWV \RX VHW SUHIHUHQFHV IRU \RXU PRXVH EXWWRQV DQG VHOHFW

'HVLJQHU VKRUWFXW NH\V� &OLFN 2SWLRQV IURP WKH 7RROV PHQX WR RSHQ WKH

2SWLRQV GLDORJ ER[�

�

Set tin g the Left But ton Click

%\ GHIDXOW� LI \RX SRLQW WR DQ REMHFW LQ \RXU GRFXPHQW DQG GRXEOH FOLFN WKH

OHIW PRXVH EXWWRQ� \RX HQWHU D UHVKDSH PRGH� �,I \RX GRXEOH FOLFN D ELWPDS

RU DQ HPEHGGHG REMHFW� DQRWKHU SURJUDP FDSDEOH RI HGLWLQJ WKH REMHFW LV

ODXQFKHG LQVWHDG�� ,I \RX SUHVV DQG KROG WKH ALT NH\ DQG WKHQ SRLQW DQG FOLFN

WKH OHIW PRXVH EXWWRQ� \RX FDQ VHOHFW RYHUODSSLQJ REMHFWV LQ VXFFHVVLRQ DV LQ

SUHYLRXV YHUVLRQV RI 'HVLJQHU�

7LS

,I \RX SUHIHU� \RX FDQ FKDQJH WKH VHWWLQJV LQ WKH ,QSXW SDQHO WR UHYHUVH WKH
XVH RI WKH ALT NH\ ZLWK WKHVH WZR IXQFWLRQV�

Set tin g Combinations Com patibilit y

6HOHFW D PRXVH DQG CTRL�SHIFT FRPSDWLELOLW\ ZLWK HLWKHU 2IILFH�� RU

'HVLJQHU ��[�
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Set tin g the Ri ght But ton Click

7KH GHIDXOW IXQFWLRQ RI D VLQJOH FOLFN RI WKH ULJKW PRXVH EXWWRQ GLVSOD\V WKH

PRXVH PHQX� ZKLFK GLVSOD\V FRPPDQGV WKDW JLYH \RX TXLFN DFFHVV WR

IXQFWLRQV WKDW PD\ QRW EH GLVSOD\HG LQ WKH FXUUHQW ULEERQ� 7KH GHIDXOW VHWWLQJ

IRU ALT�ULJKW PRXVH EXWWRQ LV DQ DVVLJQHG FRPPDQG RU WRRO VLPLODU WR

SUHYLRXV YHUVLRQV RI 'HVLJQHU�

Set tin g the Intellimouse W heel

6HW WKH RSWLRQ WR HLWKHU ]RRP RU VFUROO ZKHQ \RX ULJKW�FOLFN RYHU DQ

XQVHOHFWHG REMHFW RU WKH ZKLWH VSDFH RI D FXUUHQW SDJH�

Employing Designer 3.x Shor tcuts

6HOHFW WKLV RSWLRQ WR XVH 'HVLJQHU ��[ VKRUWFXWV� ,I \RX DUH XSJUDGLQJ IURP

'HVLJQHU ��[� \RX FDQ XVH WKH VDPH VKRUWFXWV�

Setting Profile Options

<RX DOVR FDQ PDQDJH kSUHIHUHQFH SURILOHVy �ZKLFK DUH 352 ILOH W\SHV WKDW

FRQWDLQ DOO RI \RXU SHUVRQDO SUHIHUHQFHV�� :KHQ \RX FKDQJH SUHIHUHQFHV�

WKH\ DUH VDYHG DXWRPDWLFDOO\ WR WKH 8VHUQDPH�352 ILOH� ZKLFK LV WKH VWDQGDUG

ILOH WKDW VWRUHV \RXU SUHIHUHQFHV� 'HVLJQHU DOVR OHWV \RX VDYH \RXU SUHIHUHQFHV

WR RWKHU SURILOHV� 8QOLNH ZLWK ,1, ILOHV� ZKHQ \RX FKDQJH WR D GLIIHUHQW SURILOH�

WKH FKDQJHV WDNH HIIHFW LPPHGLDWHO\�

3URILOHV DUH D FROOHFWLRQ RI DOO RI \RXU SUHIHUHQFHV� <RX PD\ ZDQW WR XVH D

GLIIHUHQW SURILOH IRU GLIIHUHQW NLQGV RI ZRUN �VXFK DV JUDSKLF GHVLJQ RU

WHFKQLFDO LOOXVWUDWLRQ�� <RX PD\ ZDQW WR FKDQJH SUHIHUHQFHV IRU RQH SDUWLFXODU

VHVVLRQ RU SURMHFW� DQG WKHQ UHWXUQ WR \RXU QRUPDO SUHIHUHQFHV� ,I PRUH WKDQ

RQH SHUVRQ LV UXQQLQJ 'HVLJQHU IURP D ILOH VHUYHU RU VKDULQJ D FRPSXWHU�

HDFK SHUVRQ FDQ VDYH DQG XVH KLV RU KHU RZQ SUHIHUHQFHV�

,Q DGGLWLRQ� \RX FDQ VKDUH SUHIHUHQFH ILOHV ZLWK RWKHUV� 6\VWHP $GPLQLVWUDWRUV

PD\ ZDQW WR XVH WKH VDPH SUHIHUHQFH ILOH IRU PXOWLSOH FRPSXWHUV WR HQVXUH

FRQVLVWHQF\�
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<RX FDQ XVH WKH 3URILOH SDQHO RI WKH 2SWLRQV GLDORJ ER[ WR FKRRVH D GLIIHUHQW

SURILOH� HOHFW WR VDYH WKDW FKRLFH ZKHQ \RX FORVH 'HVLJQHU� DQG HQWHU RU HGLW

D GHVFULSWLRQ RI D SURILOH� &OLFN 2SWLRQV IURP WKH 7RROV PHQX WR RSHQ WKH

2SWLRQV GLDORJ ER[�

To chan ge or select a different profile

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &OLFN WKH 3URILOH WDE� 7KH 3URILOH SDQHO RSHQV�

3 &KRRVH D GLIIHUHQW 352 ILOH IURP WKH 3URILOH 'RFXPHQW OLVW ER[�

4 6HOHFW 6DYH RQ ([LW LI \RX ZDQW 'HVLJQHU WR XVH WKH QHZ SURILOH WKH

QH[W WLPH 'HVLJQHU LV RSHQHG�

5 &OLFN 2.� 'HVLJQHU QRZ XVHV WKH SUHIHUHQFHV LQ WKH SURILOH WR ZKLFK

\RX FKDQJHG� DQG DQ\ FKDQJHV WR \RXU SUHIHUHQFHV DUH VWRUHG WKHUH�

To create a new profile

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &KRRVH 3URILOH� 7KH 3URILOH SDQHO RSHQV�

3 &OLFN WKH )LOH 2SWLRQV EXWWRQ DQG FKRRVH 1HZ� 7KH 1HZ 3URILOH

'RFXPHQW GLDORJ ER[ RSHQV�

4 7\SH D ILOHQDPH IRU WKH QHZ SURILOH DQG SUHVV HQWHU� 7KH 1HZ 3URILOH

'RFXPHQW GLDORJ ER[ FORVHV� DQG WKH QHZ ILOHQDPH DSSHDUV DV WKH

FXUUHQW 3URILOH�
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To co py a profile

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &OLFN 3URILOH� 7KH 3URILOH SDQHO RSHQV�

3 &OLFN WKH )LOH 2SWLRQV EXWWRQ DQG FKRRVH &RS\� 7KH &RS\ 3URILOH

'RFXPHQW GLDORJ ER[ RSHQV�

4 7\SH D QHZ ILOHQDPH DQG SUHVV HQWHU� 7KH &RS\ 3URILOH 'RFXPHQW

GLDORJ ER[ FORVHV� 7KH QHZ ILOHQDPH LV OLVWHG DV DQ RSWLRQ LQ WKH 3URILOH

'RFXPHQW OLVW ER[�

To delete a profile

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &OLFN 3URILOH� 7KH 3URILOH SDQHO RSHQV�

3 &KRRVH D ILOH LQ WKH 3URILOH 'RFXPHQW OLVW ER[ WKDW \RX ZDQW WR GHOHWH�

4 &OLFN WKH )LOH 2SWLRQV EXWWRQ DQG FKRRVH 'HOHWH� <RX DUH DVNHG WR

FRQILUP WKDW \RX ZDQW WR GHOHWH WKH SURILOH�

5 &OLFN <HV WR FRQILUP WKH GHOHWLRQ�

To rename a profile

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &KRRVH 3URILOH� 7KH 3URILOH SDQHO RSHQV�

3 &OLFN WKH )LOH 2SWLRQV EXWWRQ DQG FKRRVH 5HQDPH� 7KH 5HQDPH

3URILOH 'RFXPHQW GLDORJ ER[ RSHQV�

4 7\SH D QHZ ILOHQDPH DQG SUHVV HQWHU� 7KH 5HQDPH 3URILOH 'RFXPHQW

GLDORJ ER[ FORVHV� DQG WKH UHQDPHG SURILOH DSSHDUV DV WKH FXUUHQW

3URILOH 'RFXPHQW�

To update a profile

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &KRRVH 3URILOH� 7KH 3URILOH SDQHO RSHQV�
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3 &OLFN WKH )LOH 2SWLRQV EXWWRQ DQG FKRRVH 8SGDWH� 7KH FXUUHQW SURILOH

LV XSGDWHG ZLWK DQ\ SUHIHUHQFHV WKDW KDYH FKDQJHG VLQFH WKH ODVW WLPH

WKH SURILOH ZDV VDYHG RU XSGDWHG�

1RWH

<RX FDQ DOVR FOLFN WKH )LOH 2SWLRQV EXWWRQ WR FUHDWH D QHZ SURILOH�
FRS\ D SURILOH� GHOHWH D SURILOH� UHQDPH D SURILOH� RU XSGDWH D
SURILOH�

Setting Registry Options

:LQGRZV �� SURJUDPV VDYH VWDWXV DQG RWKHU LQIRUPDWLRQ LQ D ILOH FDOOHG WKH

V\VWHP UHJLVWU\� &KDQJHV LQ WKH UHJLVWU\ DUH GHWHFWHG E\ WKH :LQGRZV

RSHUDWLQJ V\VWHP DQG SURJUDPV WKDW PRQLWRU WKH UHJLVWU\�

0RVW SURJUDPV VDYH VWDWXV LQIRUPDWLRQ LQ D ILOH FDOOHG WKH V\VWHP UHJLVWU\�

&KDQJHV LQ WKH UHJLVWU\ DUH GHWHFWHG E\ WKH :LQGRZV RSHUDWLQJ V\VWHP DQG

SURJUDPV WKDW PRQLWRU WKH UHJLVWU\�

1RUPDOO\� \RX GR QRW KDYH WR FKDQJH UHJLVWU\ HQWULHV GLUHFWO\� :KHQ \RX ILUVW

LQVWDOO 'HVLJQHU� VHWWLQJV DUH DXWRPDWLFDOO\ PDGH WR WKH UHJLVWU\� DQG ZKHQ \RX

PDNH FKDQJHV YLD WKH :LQGRZV &RQWURO 3DQHO� WKH QHZ VHWWLQJV DQG

SUHIHUHQFHV DUH PDGH DXWRPDWLFDOO\ WR WKH UHJLVWU\ DV ZHOO�

1RUPDOO\� \RX GR QRW KDYH WR FKDQJH UHJLVWU\ HQWULHV GLUHFWO\� )RU H[DPSOH�

v :KHQ \RX ILUVW LQVWDOO 'HVLJQHU� VHWWLQJV DUH DXWRPDWLFDOO\ VWRUHG LQ WKH

UHJLVWU\�

v :KHQ \RX FKDQJH D VHWWLQJ LQ WKH :LQGRZV &RQWURO 3DQHO� WKH VHWWLQJ

LV DXWRPDWLFDOO\ VWRUHG LQ WKH UHJLVWU\�

7KH UHJLVWU\ HQWULHV IRU 'HVLJQHU UHIOHFW \RXU V\VWHP
V KDUGZDUH DQG

RSHUDWLQJ V\VWHP VSHFLILFDWLRQV� 6HYHUDO HQWULHV DUH FUHDWHG E\ WKH 0LFURJUDI[

LQVWDOOHU ZKHQ \RX LQVWDOO 'HVLJQHU�
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:KHQ QHFHVVDU\� \RX FDQ XVH WKH 5HJLVWU\ WDE RI WKH 2SWLRQV GLDORJ ER[ WR

HGLW WKRVH HQWULHV DQG WR FUHDWH QHZ HQWULHV DV QHHGHG�

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &OLFN WKH 5HJLVWU\ WDE�

3 &KRRVH WKH NH\ QDPH IURP WKH .H\ OLVW ER[�

4 ,Q WKH 9DOXH 1DPH OLVW� FOLFN WKH QDPH ZKRVH YDOXH \RX ZDQW WR

FKDQJH�

5 +LJKOLJKW WKH ROG YDOXH DQG W\SH WKH QHZ YDOXH RYHU LW�

6 &OLFN 2. WR FRQILUP WKH FKDQJH DQG WR FORVH WKH 2SWLRQV GLDORJ ER[�

To add a new value to a re gistr y key

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &OLFN WKH 5HJLVWU\ WDE�
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3 &KRRVH WKH NH\ QDPH IURP WKH .H\ OLVW ER[�

4 &OLFN WKH 1HZ 9DOXH EXWWRQ�

5 7\SH WKH QDPH RI WKH QHZ YDOXH� ,I WKH YDOXH LV QXPHULF� FOLFN 1XPHULF

9DOXH 7\SH�

6 ,Q WKH 9DOXH ER[� W\SH WKH QHZ YDOXH�

7 &OLFN 2. WR FRQILUP WKH DGGLWLRQ DQG WR FORVH WKH 2SWLRQV GLDORJ ER[�

To delete a value from a re gistr y key

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &OLFN WKH 5HJLVWU\ WDE�

3 &KRRVH WKH NH\ QDPH IURP WKH .H\ OLVW ER[�

4 &KRRVH D QDPH IURP WKH 9DOXH 1DPH OLVW ER[�

5 &OLFN WKH 'HOHWH 9DOXH EXWWRQ�

6 &OLFN 2. WR FRQILUP WKH GHOHWLRQ DQG WR FORVH WKH 2SWLRQV GLDORJ ER[�
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Setting Spelling Options

7KH 6SHOOLQJ 2SWLRQV GLDORJ ER[ DOORZV \RX WR FXVWRPL]H WKH ZD\ \RX XVH WKH

'HVLJQHU 6SHOO &KHFN� &OLFN 2SWLRQV IURP WKH 7RROV PHQX WR RSHQ WKH

2SWLRQV GLDORJ ER[�

Setting Guide Lines

$ JXLGH OLQH LV D KRUL]RQWDO RU YHUWLFDO OLQH \RX FDQ XVH IRU DOLJQPHQW RU YLVXDO

UHIHUHQFH� *XLGH OLQHV FDQ KHOS RUJDQL]H WKH OD\RXW RI \RXU GUDZLQJ E\ JXLGLQJ

WKH SODFHPHQW RI \RXU REMHFWV� <RX FDQ XVH JXLGH OLQHV DV YLVXDO FXHV IRU

ZKHUH WR SODFH REMHFWV� RU \RX FDQ VQDS REMHFWV WR JXLGHV IRU PRUH H[DFW

SODFHPHQW� *XLGHV DSSHDU RQ VFUHHQ EXW GR QRW SULQW�
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Adding Guide Lines

$ JXLGH OLQH LV D KRUL]RQWDO RU YHUWLFDO OLQH \RX FDQ XVH IRU DOLJQPHQW RU YLVXDO

UHIHUHQFH� *XLGH OLQHV FDQ KHOS RUJDQL]H WKH OD\RXW RI \RXU GUDZLQJ E\ JXLGLQJ

WKH SODFHPHQW RI \RXU REMHFWV� <RX FDQ XVH JXLGH OLQHV DV YLVXDO FXHV IRU

SODFLQJ REMHFWV� RU \RX FDQ VQDS REMHFWV WR JXLGH OLQHV IRU PRUH H[DFW

SODFHPHQW� *XLGH OLQHV DSSHDU RQ VFUHHQ EXW GR QRW SULQW�

<RX FDQ DGG DV PDQ\ JXLGH OLQHV DV \RX QHHG� <RX DOVR FDQ PRYH JXLGH OLQHV

E\ GUDJJLQJ WKHP WR QHZ ORFDWLRQV RQ WKH VFUHHQ ZLWK WKH VHOHFWLRQ SRLQWHU�

7R UHPRYH D JXLGH OLQH� MXVW GUDJ DQG GURS LW RQWR WKH UXOHU ZLWK WKH VHOHFWLRQ

SRLQWHU�

To add a guide line

1 0RYH WKH VHOHFWLRQ SRLQWHU WR WKH WRS RU VLGH UXOHU �IRU D KRUL]RQWDO RU

YHUWLFDO JXLGHOLQH� UHVSHFWLYHO\��

2 3UHVV DQG KROG WKH OHIW PRXVH EXWWRQ� DQG GUDJ D JXLGH OLQH WR WKH

GHVLUHG SRVLWLRQ LQ WKH GUDZLQJ DUHD�

3 5HOHDVH WKH OHIW PRXVH EXWWRQ�
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Setting Up Units of Measure

7KH XQLWV RI PHDVXUH LQ 'HVLJQHU DUH H[WUHPHO\ IOH[LEOH DQG FDQ EH VHW

VHSDUDWHO\ IRU HYHU\ IXQFWLRQ WKDW XVHV D PHDVXUHPHQW XQLW� )RU H[DPSOH� \RX

FDQ VSHFLI\ GLIIHUHQW PHDVXUHPHQW XQLWV IRU UXOHUV� SDJH VL]H� OLQH WKLFNQHVV�

DQG GLPHQVLRQ OLQHV� 7KH FXUUHQW XQLWV VHWWLQJ IRU D SDUWLFXODU IXQFWLRQ

DSSHDUV RQ WKH 8QLWV EXWWRQ LQ WKH GLDORJ ER[ �RU ULEERQ� IRU WKDW IXQFWLRQ�

)RU H[DPSOH� LI WKH PHDVXUHPHQW XQLW IRU SDJH VL]H LV LQFKHV� WKH 8QLWV EXWWRQ

LQ WKH 3DJH 6HWXS GLDORJ ER[ UHDGV �LQ��

:KHQ VSHFLI\LQJ WKH PHDVXUHPHQW XQLWV� \RX FDQ FKRRVH IURP D VHW RI

VWDQGDUG XQLWV� DQRWKHU VHW RI SUHGHILQHG XQLWV� RU FUHDWH \RXU RZQ FXVWRP

XQLWV� <RX FDQ DOVR VHW D VFDOH WR UHODWH RQH XQLW RI PHDVXUH WR DQRWKHU�

7KH XQLWV VHWWLQJV WKDW \RX XVH ZLWK D GUDZLQJ DUH VDYHG ZLWK WKH GUDZLQJ VR

WKDW \RX GR QRW KDYH WR UHVHW WKHP HDFK WLPH \RX RSHQ WKH ILOH�

Setting Standard Units

8QLWV FDQ EH OLQHDU �WR PHDVXUH OHQJWK� RU UDGLDO �WR PHDVXUH DQJOHV�� /LQHDU

XQLWV DUH XVHG WR PHDVXUH VSDWLDO GLVWDQFHV� 5DGLDO XQLWV DUH XVHG WR PHDVXUH

DQJXODU RULHQWDWLRQ RU GLUHFWLRQ�

7KH VWDQGDUG OLQHDU XQLWV DUH LQFKHV� FHQWLPHWHUV� PLOOLPHWHUV� SRLQWV� SLFDV�

SLFDV DQG SRLQWV� DQG FLFHURV� 7KH VWDQGDUG UDGLDO XQLWV DUH GHJUHHV DQG

UDGLDQV�

2WKHU SUHGHILQHG XQLWV LQFOXGH IHHW� IHHW DQG LQFKHV� NLORPHWHUV� PHWHUV�

PLOHV� ZHHNV DQG GD\V� \DUGV� DQG \DUGV DQG IHHW�

Changing a Units Setting

7KH FXUUHQWO\ VHOHFWHG XQLWV VHWWLQJ IRU D SDUWLFXODU IXQFWLRQ DSSHDUV RQ WKH

DSSURSULDWH 8QLWV EXWWRQ IRU WKDW IXQFWLRQ� 7KH IROORZLQJ VWHSV DSSO\

VSHFLILFDOO\ WR FKDQJLQJ WKH XQLWV VHWWLQJ RI WKH 3DJH 6HWXS GLDORJ ER[� EXW WKH

SURFHGXUH LV YLUWXDOO\ LGHQWLFDO IRU RWKHU GLDORJ ER[HV�
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To chan ge the units settin g for the page size

1 2SHQ WKH )LOH PHQX DQG FKRRVH 3DJH 6HWXS� 7KH 3DJH 6HWXS GLDORJ

ER[ RSHQV�

2 &OLFN WKH 8QLWV EXWWRQ �PDUNHG ZLWK DQ DEEUHYLDWLRQ IRU D VWDQGDUG

XQLW� VXFK DV kLQy RU kFPy�� $ PHQX RSHQV�

3 &KRRVH WKH GHVLUHG XQLWV VHWWLQJ IURP WKH PHQX�

4 7KH PHQX FORVHV DQG WKH 8QLWV EXWWRQ LQ WKH 3DJH 6HWXS GLDORJ ER[

FKDQJHV WR UHIOHFW WKH QHZ VHWWLQJ�

5 &OLFN 2. WR FORVH WKH 3DJH 6HWXS GLDORJ ER[�

Defining Scale Units

,I \RX GR VFDOH GUDZLQJV� \RX FDQ XVH WKH &XVWRP 8QLWV GLDORJ ER[ WR GHILQH D

VFDOH XQLW� ZKLFK LV D UDWLR RI RQH XQLW RI PHDVXUH WR DQRWKHU� )RU H[DPSOH�

\RX FRXOG GHILQH D VFDOH RI �� IHHW SHU LQFK DQG GUDZ D ODQGVFDSH DW WKDW

VFDOH� RU GHILQH D VFDOH RI � ZHHNV SHU FHQWLPHWHU DQG GUDZ D WLPHOLQH FKDUW

DW WKDW VFDOH�
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7R VKRZ VFDOHG GLVWDQFHV LQ D GUDZLQJ� XVH GLPHQVLRQ OLQHV ZLWK WKH

GLPHQVLRQ XQLWV VHW WR WKH VFDOH XQLWV� ,I \RX DOVR ZDQW WR VHH WKH VFDOH XVHG E\

WKH UXOHUV� VHW WKH XQLWV IRU WKH UXOHUV WR WKH VFDOH XQLWV� ,Q WKH IROORZLQJ

H[DPSOH� WKH GLPHQVLRQ XQLWV DUH VHW WR � PHWHUV SHU FHQWLPHWHU�

<RX GHILQH QHZ XQLWV XVLQJ WKH &XVWRP 8QLWV GLDORJ ER[� <RX FDQ RSHQ WKH

&XVWRP 8QLWV GLDORJ ER[ E\ FKRRVLQJ &XVWRP 8QLWV LQ WKH 7RROV PHQX� RU E\

FOLFNLQJ DQ\ 8QLWV EXWWRQ DQG FKRRVLQJ &XVWRP 8QLWV�

$IWHU GHILQLQJ D QHZ VFDOH XQLW� \RX FDQ DGG LW WR \RXU FXUUHQW SURILOH� RU MXVW

VDYH LW WR WKH FXUUHQW GUDZLQJ� ,I \RX DGG LW WR \RXU SURILOH� WKH VFDOH XQLWV DUH

DYDLODEOH LQ RWKHU GUDZLQJV \RX PDNH� 1HZ XQLWV WKDW KDYH EHHQ VDYHG WR D

SURILOH DUH GHVLJQDWHG E\ D SOXV VLJQ LQ IURQW RI WKH XQLW
V QDPH LQ WKH 'HILQHG

8QLWV OLVW ER[�
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To define 

a scale unit of 2 feet per inch

1 2SHQ WKH 7RROV PHQX DQG FKRRVH &XVWRP 8QLWV� 7KH 'HILQHG

&XVWRP 8QLWV GLDORJ ER[ RSHQV�

2 &OLFN $GG 8QLW� 7KH $GG &XVWRP 8QLW GLDORJ RSHQV�

3 &OLFN LQ WKH 8QLW 1DPH ILHOG DQG W\SH WKH QDPH )HHW �VFDOH ���

4 ,Q WKH 3ULPDU\ 8QLW VHFWLRQ� HQWHU � LQ WKH 6FDOH ILHOG�

5 ,Q WKH /DEHO ILHOG� HQWHU P�

6 ,Q WKH 5HDO :RUOG 8QLWV VHFWLRQ� VHOHFW &HQWLPHWHUV IURP WKH GURS OLVW�

7 &OLFN 2.�

7LS

7KH XQLW \RX HQWHUHG DERYH RQO\ GHILQHV D SULPDU\ XQLW� ,I QHHGHG� \RX DOVR
FDQ VSHFLI\ D VHFRQGDU\ XQLW� <DUGV DQG IHHW� IHHW DQG LQFKHV� DQG ZHHNV
DQG GD\V DUH DOO H[DPSOHV RI GHILQLWLRQV ZLWK SULPDU\ DQG VHFRQGDU\ XQLWV�

To apply scale units to a dimension line

1 &OLFN WKH 'LPHQVLRQ WRRO �
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2 &OLFN WKH 8QLWV EXWWRQ LQ WKH ULEERQ� $ PHQX RSHQV�

3 &KRRVH 0RUH 8QLWV� 7KH $YDLODEOH 8QLWV GLDORJ ER[ RSHQV�

4 +LJKOLJKW WKH VFDOH XQLWV \RX ZDQW WR XVH�

5 &OLFN 2.�

Defining Unscaled Units

%HVLGHV GHILQLQJ VFDOHG XQLWV� WKH &XVWRP 8QLWV GLDORJ ER[ OHWV \RX GHILQH

QHZ XQVFDOHG XQLWV RI PHDVXUH� 7KH SURFHGXUH IRU GHILQLQJ XQVFDOHG XQLWV LV

LGHQWLFDO WR WKDW IRU GHILQLQJ VFDOHG XQLWV �H[SODLQHG LQ WKH SUHYLRXV VHFWLRQ�

H[FHSW WKDW \RX GR QRW VSHFLI\ D VFDOHG UDWLR ZKHQ \RX GHILQH WKH XQLW�

,QVWHDG� \RX VSHFLI\ DQ DFFXUDWH FRQYHUVLRQ UDWLR IRU WKH XQLW� VXFK DV ����

PHWHUV SHU NLORPHWHU�

Updating Unit Settings

'HVLJQHU JLYHV \RX H[FHSWLRQDO IOH[LELOLW\ LQ GHILQLQJ VFDOH XQLWV ZLWKRXW

FDXVLQJ XQZDQWHG FKDQJHV� 1RWH WKDW FKDQJLQJ D XQLWjV YDOXHV LQ WKH &XVWRP

8QLWV GLDORJ ER[ GRHV QRW DXWRPDWLFDOO\ FKDQJH WKH RYHUDOO XQLWV GHILQLWLRQ IRU

WKH UXOHUV LQ WKH FXUUHQW GUDZLQJ� 7R FKDQJH WKH UXOHU XQLW VHWWLQJV� FKRRVH

WKH VHWWLQJ DJDLQ LQ WKH 5XOHUV�6QDS WDE RI WKH 2SWLRQV GLDORJ ER[�

,Q DGGLWLRQ� FKDQJLQJ D XQLWjV YDOXHV LQ WKH &XVWRP 8QLWV GLDORJ ER[ GRHV QRW

DXWRPDWLFDOO\ FKDQJH WKH RYHUDOO XQLWV GHILQLWLRQ IRU DQ\ RWKHU GUDZLQJV XVLQJ

WKDW XQLW� 7KLV LV EHFDXVH WKH YDULRXV XQLWV VHW IRU GLIIHUHQW IXQFWLRQV DUH VDYHG

ZLWK HDFK 'HVLJQHU GUDZLQJ�

)RU H[DPSOH� VXSSRVH WKDW WKH UXOHUV DUH VHW WR D FXVWRP VFDOH XQLW FDOOHG

0HWHUV �6FDOHG�� ZKLFK GHILQHV D VFDOH RI � PHWHUV SHU FHQWLPHWHU� <RX RSHQ

WKH 7RROV 0HQX� FOLFN &XVWRP 8QLWV� DQG HGLW WKLV VFDOH XQLW E\ FKDQJLQJ LWV

VFDOH WR �� PHWHUV SHU FHQWLPHWHU� 7KH UXOHU XQLW VHWWLQJV GR QRW FKDQJH

XQOHVV \RX RSHQ WKH 7RROV 0HQX� FOLFN 2SWLRQV DQG 5XOHUV�6QDS� DQG

GHOLEHUDWHO\ FKDQJH WKH 5XOHU 8QLW WR 0HWHUV �6FDOHG� DJDLQ�
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Defining Units with the Scale Drawing Wizard

'HVLJQHU JLYHV \RX H[FHSWLRQDO IOH[LELOLW\ LQ GHILQLQJ VFDOH XQLWV ZLWKRXW

FDXVLQJ XQZDQWHG FKDQJHV� 7KH 6FDOH 'UDZLQJ :L]DUG DOORZV \RX WR VHW XS

VFDOH XQLWV HDVLO\ DQG DFFXUDWHO\�

To set units with the Scale Drawin g W izard

1 2Q WKH )LOH PHQX� FOLFN 6FDOH 6HWXS�

2 &OLFN WKH DSSURSULDWH PHDVXUHPHQW V\VWHP� ,PSHULDO RU 0HWULF� &OLFN

1H[W�

3 ,I \RX VHOHFWHG ,PSHULDO� FOLFN WKH DSSURSULDWH VFDOH W\SH� $UFKLWHFWXUDO

RU (QJLQHHULQJ� &OLFN 1H[W�

RU

,I \RX VHOHFWHG 0HWULF� ILUVW VHOHFW D EDVH XQLW W\SH� 1H[W� HQWHU KRZ

PDQ\ XQLWV \RX ZDQW WR EH UHSUHVHQWHG E\ RQH EDVH XQLW RQ WKH

GUDZLQJ� 7KHQ \RX QHHG WR HQWHU WKH ODEHO WKDW ZLOO EH DVVRFLDWHG ZLWK

WKH XQLWV� &OLFN 1H[W�

4 &OLFN WKH DSSURSULDWH VFDOH VHWWLQJ� &OLFN 1H[W�

5 &OLFN WKH DSSOLFDEOH 'HVLJQHU GUDZLQJ�

6 &OLFN )LQLVK�

Deleting a Defined Unit

<RX FDQ GHOHWH D GHILQHG XQLW IURP WKH OLVW RI DYDLODEOH XQLWV E\ VHOHFWLQJ LW LQ

WKH 'HILQHG 8QLWV OLVW ER[ DQG FOLFNLQJ 'HOHWH 8QLW EXWWRQ LQ WKH GLDORJ� 7KH

GHILQHG XQLW LV QRW GHOHWHG IURP RWKHU GUDZLQJV XVLQJ WKDW XQLW� 7KH GHOHWHG

XQLW UHPDLQV LQ XVH ZKHUH \RX KDYH DSSOLHG LW DOUHDG\� EXW \RX FDQ QRW FKRRVH

WKDW XQLW IRU IXWXUH XVHV�
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Setting Up a Page

8VH WKH 3DJH 6HWXS FRPPDQG RQ WKH )LOH PHQX WR FKDQJH WKH VL]H DQG

RULHQWDWLRQ RI WKH FXUUHQW SDJH LQ WKH DFWLYH ZLQGRZ�

KH 3DJH 6HWXS FRPPDQG LQ WKH )LOH PHQX WR FKDQJH WKH VL]H� PDUJLQV� DQG

RULHQWDWLRQ RI WKH DFWLYH ZLQGRZ
V RQ�VFUHHQ SDJH� <RX FDQ FKDQJH SDJH

VHWWLQJV EHIRUH� GXULQJ� RU DIWHU FUHDWLQJ D GUDZLQJ�

1RWH

,I \RX FKDQJH WKH SDJH VHWXS� DQG \RX SODQ WR SULQW \RXU ZRUN� \RX VKRXOG
FKDQJH WKH SULQWHU VHWXS WR PDWFK� 6HH WKH FKDSWHU k3ULQWLQJ <RXU :RUNy
IRU LQIRUPDWLRQ RQ FKDQJLQJ \RXU SULQWHU VHWXS�

1HZ SDJH VHWWLQJV DUH DSSOLHG LPPHGLDWHO\ WR WKH FXUUHQW SDJH LQ WKH DFWLYH

ZLQGRZ�

,QGLYLGXDO SDJHV LQ \RXU GRFXPHQW FDQ KDYH GLIIHUHQW VL]HV� RULHQWDWLRQV� DQG

SDJH ILOOV� LI GHVLUHG� 7R DSSO\ WKH VDPH VL]H� RULHQWDWLRQ� DQG SDJH ILOO WR DOO

SDJHV LQ WKH GRFXPHQW� VHOHFW $SSO\ WR $OO 3DJHV� 7KLV RSWLRQ� OLNH 8VH 0DVWHU

3DJH� IRUFHV DOO SDJHV WR EH XQLIRUP�

Setting Page Options

&OLFN WKH 3DJH 6L]H WDE WR UHYHDO WKH RSWLRQV VHWWLQJV GLDORJ ER[�

�
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Set tin g the Page Size 

8VH WKH 3DJH 6L]H OLVW ER[ WR FKRRVH WKH VL]H RI WKH FXUUHQW SDJH� <RX FDQ

FKRRVH IURP VWDQGDUG SDJH VL]HV RU FKRRVH &XVWRP 6L]H DQG FUHDWH \RXU

RZQ E\ DGMXVWLQJ WKH :LGWK DQG +HLJKW PHDVXUHPHQWV� ,I \RX HQWHU

GLPHQVLRQV IRU :LGWK DQG +HLJKW WKDW GR QRW PDWFK RQH RI WKH VWDQGDUG

SDJH VL]HV� WKH 3DJH 6L]H VHOHFWLRQ FKDQJHV WR &XVWRP 6L]H�

Usin g a Master Pa ge

,I \RX FKRRVH WKH 8VH 0DVWHU 3DJH RSWLRQ� WKH SDJH PDWFKHV WKH VL]H�

RULHQWDWLRQ� DQG SDJH ILOO �LI DQ\� RI WKH PDVWHU SDJH� 7R HGLW WKH PDVWHU SDJH�

FOLFN WKH 3DJH EXWWRQ �DW WKH ERWWRP OHIW RI WKH DFWLYH ZLQGRZ� DQG FKRRVH

0DVWHU 3DJH� �6HH WKH VHFWLRQ k8VLQJ WKH 0DVWHU 3DJHy LQ WKLV FKDSWHU IRU

PRUH LQIRUPDWLRQ��

Set tin g the Page Orientation

7KH 3DJH 2ULHQWDWLRQ RSWLRQV GHWHUPLQH WKH SDJH OD\RXW� 6HOHFW 3RUWUDLW WR

OD\RXW WKH SDJH VR WKDW WKH YHUWLFDO GLPHQVLRQ LV ORQJHU WKDQ WKH KRUL]RQWDO

GLPHQVLRQ� 6HOHFW /DQGVFDSH WR OD\RXW WKH SDJH VR WKDW WKH KRUL]RQWDO

GLPHQVLRQ LV ORQJHU WKDQ WKH YHUWLFDO GLPHQVLRQ�

Usin g the Printable Area 

&KRRVH WKH 8VH 3ULQWDEOH $UHD RSWLRQ WR IRUFH WKH RQ�VFUHHQ SDJH WR UHIOHFW

\RXU SULQWHU
V SDJH VL]H DQG PDUJLQV� )RU H[DPSOH� LI \RXU SULQWHU XVHV DQ ����

[ ��� SDJH ZLWK ��� LQFK PDUJLQV� WKH RQ�VFUHHQ SDJH PDWFKHV LW�

Set tin g the W idth/Hei ght

7KH :LGWK DQG +HLJKW ER[HV VKRZ WKH PHDVXUHPHQWV IRU WKH FXUUHQW SDJH

VL]H� <RX FDQ FUHDWH D FXVWRP SDJH VL]H E\ FKDQJLQJ WKHVH VHWWLQJV� &OLFN WKH

DUURZV WR FKDQJH LWV VHWWLQJ�

Definin g Units

7KH 8QLWV EXWWRQ VKRZV WKH FXUUHQW SDJH VL]H PHDVXUHPHQW XQLWV� 7R FKDQJH

WKH XQLWV VHWWLQJ� FOLFN WKH 8QLWV EXWWRQ DQG FKRRVH WKH GHVLUHG XQLWV�
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Applying to All O pen Pages

,QGLYLGXDO SDJHV LQ \RXU GRFXPHQW FDQ KDYH GLIIHUHQW VL]HV� RULHQWDWLRQV� DQG

SDJH ILOOV� LI GHVLUHG� 7R DSSO\ WKH VDPH VL]H� RULHQWDWLRQ� DQG SDJH ILOO WR DOO

SDJHV LQ WKH GRFXPHQW� VHOHFW $SSO\ WR $OO 3DJHV� 7KLV RSWLRQ� OLNH 8VH 0DVWHU

3DJH� IRUFHV DOO SDJHV WR EH XQLIRUP�

Page T ilin g

3DJH 7LOLQJ VKRZV WKH QXPEHU RI FROXPQV DQG URZV RI WLOHV XVHG ZKHQ WKH

FXUUHQW SDJH VL]H LV SULQWHG WR WKH WDUJHW SULQWHU� ,I WKH SDJH VL]H LV VHW WR XVH

3ULQWDEOH $UHD DQG WKH 3DJH 2ULHQWDWLRQ PDWFKHV WKH RULHQWDWLRQ RI WKH

WDUJHW SULQWHU� QR WLOLQJ LV XVHG� DQG WKH QXPEHU IRU FROXPQV DQG URZV DUH

ERWK VHW WR ��

,I \RX HQWHU QHZ YDOXHV IRU FROXPQV DQG URZV� WKH SDJH VL]H FKDQJHV WR

PDWFK� 6HH WKH FKDSWHU k3ULQWLQJ <RXU :RUNy IRU DQ H[SODQDWLRQ RI WLOLQJ� ,I

\RX ZDQW WR GLVSOD\ WLOH OLQHV RQ \RXU VFUHHQ DV \RX ZRUN� RSHQ WKH 9LHZ

PHQX DQG FKRRVH :RUNVSDFH� DQG WKHQ FKRRVH 6KRZ 3ULQWHU 3DJH 7LOHV

IURP WKH :RUNVSDFH VXEPHQX�

Setting Margins

&OLFN WKH 0DUJLQV WDE WR RSHQ WKH 0DUJLQV SDQHO RI WKH 3DJH 6HWXS GLDORJ

ER[� ,W LV KHUH ZKHUH \RX FDQ VSHFLI\ \RXU PDUJLQV� GLVSOD\ RU KLGH FURS

PDUNV� DQG FKRRVH D SDJH ILOO FRORU DV WKRXJK \RX ZHUH ZRUNLQJ RQ FRORUHG

SDSHU�

Using the Master Page

(YHU\ 'HVLJQHU GRFXPHQW KDV D PDVWHU SDJH� <RX FDQ XVH WKH PDVWHU SDJH WR

PDNH DOO WKH SDJHV LQ \RXU GRFXPHQW FRQVLVWHQW LQ VL]H� RULHQWDWLRQ� PDUJLQV�

DQG SDJH ILOO� 7KH VL]H RI WKH PDVWHU SDJH GHIDXOWV WR PDWFK WKH SULQWDEOH DUHD

RI \RXU WDUJHW SULQWHU�

,I \RX ZDQW FHUWDLQ JUDSKLF RU WH[W REMHFWV� VXFK DV D WLWOH RU ERUGHU� WR

DSSHDU RQ HYHU\ SDJH� \RX FDQ SODFH WKHVH REMHFWV RQ WKH PDVWHU SDJH�

7KHVH UHSHDWHG REMHFWV DUH FDOOHG PDVWHU LWHPV�
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To set u p and use the master page

1 &UHDWH D QHZ GRFXPHQW�

2 &OLFN WKH 0DVWHU 3DJH WDE DW WKH ERWWRP OHIW RI WKH ZLQGRZ� 7KH

PDVWHU SDJH GLVSOD\V�

3 &OLFN 3DJH 6HWXS RQ WKH )LOH PHQX� 7KH 3DJH 6HWXS GLDORJ ER[ RSHQV�

4 &KRRVH SDJH VL]H DQG RULHQWDWLRQ� DQG DGMXVW WKH PDUJLQV LI QHFHVVDU\�

5 ,I \RX ZDQW D EDFNJURXQG FRORU RU ILOO� FKRRVH WKH 3DJH )LOO RSWLRQ� FOLFN

WKH 3DJH )LOO EXWWRQ � DQG FKRRVH D ILOO VW\OH LQ WKH )LOO GLDORJ ER[�

6 &OLFN 2. WR FORVH WKH 3DJH 6HWXS GLDORJ ER[�

7 3ODFH DQ\ LWHPV RQ WKH PDVWHU SDJH WKDW \RX ZDQW WR DSSHDU RQ DOO

\RXU SDJHV�

8 8VH WKH 0DVWHU 3DJH DV WKH 3DJH 6L]H IRU DOO RWKHU SDJHV LQ \RXU

GRFXPHQW�

7LSV

<RX FDQ FUHDWH DQG HGLW REMHFWV RQ WKH PDVWHU SDJH DV ZLWK RWKHU SDJHV E\
FOLFNLQJ WKH 3DJH EXWWRQ� FKRRVLQJ 0DVWHU 3DJH� DQG PDNLQJ \RXU FKDQJHV�
+RZHYHU� \RX FDQQRW VHOHFW RU FKDQJH PDVWHU LWHPV XQOHVV WKH PDVWHU
SDJH LV WKH FXUUHQW SDJH� WKLV SURWHFWV WKH PDVWHU LWHPV IURP DFFLGHQWDO
FKDQJHV�

,I \RX KDYH D SDJH LQ WKH GRFXPHQW WKDW \RX ZDQW WR EH GLIIHUHQW IURP WKH
UHVW� \RX FDQ GLVSOD\ WKDW SDJH� FKRRVH WKH 3DJH 6HWXS FRPPDQG� DQG
FKDQJH WKH 3DJH 6L]H LQ WKH 3DJH 6HWXS GLDORJ ER[ WR VRPHWKLQJ RWKHU WKDQ
8VH 0DVWHU 3DJH� <RX FDQ WKHQ PDNH DQ\ FKDQJHV \RX ZDQW WR RULHQWDWLRQ�
PDUJLQV� DQG VR IRUWK� 0DVWHU LWHPV GR QRW DSSHDU RQ SDJHV WKDW DUH QRW
VHW XS WR XVH WKH PDVWHU SDJH�

Using Multiple Pages

'HVLJQHU OHWV \RX XVH DV PDQ\ SDJHV DV \RX QHHG IRU \RXU GRFXPHQWV�

,QGLYLGXDO SDJHV LQ D GRFXPHQW FDQ EH RI GLIIHUHQW VL]HV DQG RULHQWDWLRQV

�SRUWUDLW� ODQGVFDSH�� (DFK SDJH FDQ EH VHW XS GLIIHUHQWO\ LI QHHGHG�
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<RX FDQ XVH WKH 3DJH 0DQDJHU WRRO WR VHOHFW DQ\ QXPEHU RI SDJHV LQ \RXU

GRFXPHQW DQG VHW WKHP XS ZLWK WKH VDPH VL]H� RULHQWDWLRQ� PDUJLQV� SDJH ILOO�

DQG VR IRUWK�

,I \RX ZDQW WR UHPRYH DQ REMHFW IURP D SDJH WHPSRUDULO\� \RX FDQ GUDJ LW RII

RI WKH SDJH RQWR WKH ZRUNLQJ DUHD� 7KH REMHFW UHPDLQV WKHUH XQWLO \RX QHHG

LW DJDLQ� +RZHYHU� LI \RX VHOHFW DQRWKHU SDJH� LW LV QRW YLVLEOH�

Setting Up Multiple Pages

<RX FDQ XVH WKH 3DJH 0DQDJHU WRRO WR VHOHFW DQ\ QXPEHU RI SDJHV LQ \RXU

GRFXPHQW DQG VHW WKHP XS ZLWK WKH VDPH VL]H� RULHQWDWLRQ� PDUJLQV� SDJH ILOO�

DQG VR IRUWK�

To set u p multi ple pages

1 2SHQ D GRFXPHQW ZLWK PXOWLSOH SDJHV�

2 &OLFN WKH 3DJH 0DQDJHU WRRO LQ WKH WRROER[� 7KXPEQDLO LPDJHV DUH

GLVSOD\HG IRU HDFK SDJH LQ WKH GRFXPHQW�

3 3UHVV DQG KROG CTRL DQG VHOHFW HDFK SDJH \RX ZDQW WR VHWXS�

4 &OLFN WKH 3DJH 6HWXS EXWWRQ LQ WKH ULEERQ� 7KH 3DJH 6HWXS GLDORJ

ER[ RSHQV�

5 &KRRVH WKH SDJH VL]H� RULHQWDWLRQ� PDUJLQV� DQG VR IRUWK�

To select multi ple pages

1 ,Q 3DJH 0DQDJHU YLHZ� \RX FDQ VLPSO\ FOLFN WKH GHVLUHG SDJH WR VHOHFW

LW�&OLFN WKH 3DJH 0DQDJHU WRRO � 7KH GUDZLQJ DUHD FKDQJHV WR 3DJH

0DQDJHU YLHZ�

2 &OLFN WKH ILUVW SDJH \RX ZDQW WR VHOHFW�

3 3UHVV DQG KROG SHIFT DQG FOLFN WKH ODVW SDJH \RX ZDQW WR VHOHFW�

'HVLJQHU VHOHFWV HYHU\ SDJH EHWZHHQ WKH WZR SDJHV \RX VHOHFWHG�
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To select multi ple pages that are not next to each other

1 &OLFN WKH 3DJH 0DQDJHU WRRO � 7KH GUDZLQJ DUHD FKDQJHV WR 3DJH

0DQDJHU YLHZ�

2 &OLFN WKH ILUVW SDJH \RX ZDQW WR VHOHFW�

3 3UHVV DQG KROG CTRL DQG FOLFN WKH RWKHU SDJHV \RX ZDQW WR VHOHFW� 2QO\

WKH SDJHV \RX FOLFN DUH VHOHFWHG�

To view a different page in the document

` &OLFN WKH 3DJH WDE RI WKH SDJH \RX ZDQW WR YLHZ� <RX PD\ QHHG WR VFUROO�

RU

&OLFN WKH 3DJHV EXWWRQ WR RSHQ WKH 3DJH GLDORJ� +LJKOLJKW WKH SDJH \RX

ZDQW WR YLHZ DQG FOLFN RU GRXEOH�FOLFN 6HOHFW�

7LS

<RX FDQ HDVLO\ PRYH IURP SDJH WR SDJH ZLWK WKH NH\ERDUG VKRUWFXWV
CTRL+PAGE UP� CTRL+PAGE DOWN� CTRL+HOME� DQG CTRL+END�
3UHVV CTRL+PAGE UP WR PRYH WR WKH QH[W �KLJKHU�QXPEHUHG� SDJH�
3UHVV CTRL+PAGE DOWN WR PRYH WR WKH SUHYLRXV �ORZHU�QXPEHUHG�
SDJH� 3UHVV CTRL+HOME WR PRYH WR WKH ILUVW SDJH� 3UHVV CTRL+END WR
PRYH WR WKH ODVW SDJH�

To sort pages in a document into a different order

1 2SHQ D GRFXPHQW ZLWK PXOWLSOH SDJHV�

2 &OLFN WKH 3DJH 0DQDJHU WRRO � 7KH GUDZLQJ DUHD FKDQJHV WR 3DJH

0DQDJHU YLHZ�
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3 6HOHFW D SDJH DQG GUDJ LW WR WKH EHJLQQLQJ� HQG� RU PLGGOH RI WKH

VHTXHQFH�

7LSV

$ YHUWLFDO FXUVRU EDU GLVSOD\V DV \RX GUDJ WKH SDJH WR D GLIIHUHQW SRLQW LQ
WKH VHTXHQFH� LQGLFDWLQJ LWV SRVLWLRQ� $V \RX VRUW SDJHV� WKH\ DUH
DXWRPDWLFDOO\ UHQXPEHUHG�

,I \RXU GRFXPHQW KDV PRUH SDJHV WKDQ ILW RQ WKH VFUHHQ� XVH WKH VFUROO EDU
WR GLVSOD\ WKH RWKHU SDJHV�

7R LQVHUW D SDJH EHWZHHQ WZR RWKHU SDJHV� \RX FDQ DGG D QHZ SDJH DW WKH
HQG RI WKH GRFXPHQW �LQ WKH QRUPDO VLQJOH�SDJH YLHZ� DQG WKHQ GUDJ WKH
QHZ SDJH LQWR WKH FRUUHFW VHTXHQFH �LQ 3DJH 0DQDJHU YLHZ��

To rename a page

%\ GHIDXOW� 'HVLJQHU QDPHV WKH SDJHV 3DJH �� 3DJH �� DQG VR IRUWK� <RX FDQ

FKDQJH WKH GHIDXOW SDJH QDPHV WR JLYH HDFK SDJH LQ \RXU GUDZLQJ D XQLTXH

QDPH�

1 5LJKW�FOLFN WKH 3DJH WDE RI WKH SDJH \RX ZDQW WR UHQDPH� 7KH 3DJH

PHQX RSHQV�

2 &OLFN 5HQDPH 3DJH�

3 7\SH LQ WKH SDJH QDPH DQG FOLFN 2N�

RU

1 &OLFN WKH 3DJHV EXWWRQ LQ WKH ORZHU OHIW FRUQHU RI WKH ZLQGRZ� 7KH

3DJHV GLDORJ RSHQV�

2 8QGHU &XUUHQW 3DJH� VHOHFW WKH SDJH \RX ZDQW WR UHQDPH�

3 3RLQW WR WKH 3DJH QDPH WH[W ER[ DQG FOLFN WKH OHIW PRXVH EXWWRQ�

4 7\SH D QHZ SDJH QDPH DQG SUHVV ENTER�

To add a page

1 &OLFN WKH 3DJHV EXWWRQ DW WKH ERWWRP OHIW RI WKH DFWLYH ZLQGRZ� 7KH

3DJH GLDORJ RSHQV�
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2 &OLFN $GG RU ULJKW�FOLFN RQ D SDJH WDE DQG VHOHFW $GG 3DJH IURP WKH

PHQX�

7LS

<RX FDQ DOVR FOLFN WKH $GG EXWWRQ LQ WKH 3DJHV GLDORJ ER[ DV DQRWKHU ZD\
WR DGG D QHZ SDJH WR WKH HQG RI WKH GRFXPHQW�

To delete a page

<RX FDQ GHOHWH DQ\ SDJH LQ \RXU GRFXPHQW H[FHSW WKH FXUUHQW SDJH RU WKH

PDVWHU SDJH� :KHQ \RX GHOHWH D SDJH IURP \RXU GRFXPHQW� WKH HQWLUH

FRQWHQWV RI WKH SDJH DUH GHOHWHG DV ZHOO�

1 &OLFN WKH 3DJHV EXWWRQ DW WKH ERWWRP OHIW RI WKH DFWLYH ZLQGRZ�

2 7KH 3DJHV GLDORJ ER[ RSHQV�

3 +LJKOLJKW D SDJH QDPH DQG FOLFN 'HOHWH WR GHOHWH WKH VSHFLILHG SDJH

DQG LWV FRQWHQWV

RU

5LJKW�FOLFN WKH SDJH WR GHOHWH DQG VHOHFW 'HOHWH 3DJH IURP WKH PHQX�

7LS

'RXEOH FOLFN D SDJH LQ WKH 3DJHV GLDORJ ER[ WR PDNH LW WKH FXUUHQW SDJH�
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Setting Up Layers

<RX FDQ PDQDJH OD\HUV LQ RWKHU ZD\V ZLWK WKH /D\HUV GLDORJ ER[� <RX FDQ GR

DQ\ RI WKH RSHUDWLRQV RQ D VLQJOH OD\HU� DQG \RX FDQ ZRUN ZLWK PXOWLSOH OD\HUV

ZKHQ UHPRYLQJ� ORFNLQJ� XQORFNLQJ� VKRZLQJ� DQG KLGLQJ OD\HUV�

Benefits of Layers

'HVLJQHU OHWV \RX FUHDWH OD\HUV IRU HDFK SDJH RI \RXU GRFXPHQW� 7KLV DOORZV

\RX WR SODFH VRPH REMHFWV RQ RQH OD\HU� RWKHUV RQ DQRWKHU OD\HU� DQG VR RQ�

MXVW DV \RX PLJKW ZLWK VHYHUDO RYHUKHDG WUDQVSDUHQFLHV�

/D\HUV KHOS \RX�

v 0DQDJH FRPSOH[ GUDZLQJV ZLWK PDQ\ RYHUODSSLQJ REMHFWV

v &DWHJRUL]H REMHFWV WKDW ORJLFDOO\ EHORQJ WRJHWKHU E\ OD\HU

v 9LHZ FHUWDLQ REMHFWV LQ \RXU GUDZLQJ ZKLOH KLGLQJ RWKHUV

v (DVLO\ VHOHFW DQG HGLW REMHFWV

v 3URWHFW REMHFWV IURP DFFLGHQWDO FKDQJHV

v 7UDFH IURP D WHPSODWH RQ DQRWKHU OD\HU

v 3ULQW FHUWDLQ REMHFWV RQO\

(DFK SDJH LQ D 'HVLJQHU GUDZLQJ KDV RQH OD\HU E\ GHIDXOW� /D\HUV UHPDLQ

SHUIHFWO\ DOLJQHG ZLWK RQH DQRWKHU� 'HVLJQHU DXWRPDWLFDOO\ QXPEHUV OD\HUV IRU

\RX� 7KH WRWDO QXPEHU RI OD\HUV \RX FDQ XVH LV YLUWXDOO\ XQOLPLWHG��������

'HVLJQHU OHWV \RX GR WKH IROORZLQJ ZLWK OD\HUV�
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v 1DPH WKH OD\HUV

v $GG DQG UHPRYH OD\HUV

v &KDQJH WKH RUGHU RI OD\HUV

v /RFN OD\HUV �VR WKDW REMHFWV FDQQRW EH PRYHG RU FKDQJHG�

v 'LVSOD\ RU KLGH VHOHFWHG OD\HUV

v 6SHFLI\ OD\HUV DV SULQWDEOH RU QRQ�SULQWDEOH

v 8VH RQH FRORU �IRU HDV\ LGHQWLILFDWLRQ� RU PXOWLSOH FRORUV RQ D OD\HU

v 0RYH REMHFWV IURP RQH OD\HU WR DQRWKHU

v (GLW DOO WKH OD\HUV RU HGLW RQH OD\HU DW D WLPH

1RWH

'HVLJQHU GRHV QRW VWRUH D OD\HU WKDW KDV QR REMHFWV RQ LW XQOHVV \RX KDYH
QDPHG WKH OD\HU�

Basic Layer Tasks

<RX FDQ FOLFN WKH /D\HU EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ WR RSHQ

WKH /D\HU PHQX� ZKLFK OLVWV WKH QXPEHUV DQG QDPHV RI DOO WKH OD\HUV RQ WKH

FXUUHQW SDJH� ZLWK WKH FXUUHQW OD\HU KLJKOLJKWHG�

)URP WKLV PHQX \RX FDQ

v &KDQJH WR D GLIIHUHQW OD\HU

v $GG D OD\HU

v 2SHQ WKH /D\HUV GLDORJ ER[ IRU RWKHU RSHUDWLRQV
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To chan ge to a different la yer

` &OLFN WKH /D\HU WDE RI WKH OD\HU \RX ZDQW WR PDNH DFWLYH�

RU

&OLFN WKH /D\HUV EXWWRQ DQG FKRRVH WKH OD\HU LQ WKH /D\HUV GLDORJ�

7LS

<RX FDQ HDVLO\ PRYH IURP OD\HU WR OD\HU ZLWK WKH NH\ERDUG
VKRUWFXWV SHIFT+PAGE UP DQG SHIFT+PAGE DOWN� 3UHVV
SHIFT+PAGE UP WR PRYH WR D KLJKHU�QXPEHUHG OD\HU� 3UHVV
SHIFT+PAGE DOWN WR PRYH WR D ORZHU�QXPEHUHG OD\HU�

To select multi ple layers

1 &UHDWH RU RSHQ D GRFXPHQW ZLWK PXOWLSOH OD\HUV�

2 &OLFN WKH /D\HUV EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH

/D\HUV GLDORJ ER[ RSHQV�

3 &KRRVH WKH ILUVW OD\HU \RX ZDQW WR VHOHFW�

4 3UHVV DQG KROG SHIFT DQG FKRRVH WKH ODVW OD\HU \RX ZDQW WR VHOHFW�

(YHU\ OD\HU EHWZHHQ WKH WZR OD\HUV LV VHOHFWHG�

7LS

'RXEOH FOLFN D OD\HU LQ WKH /D\HUV GLDORJ ER[ WR PDNH LW WKH FXUUHQW
OD\HU�

To select multi ple layers that are not next to each other

1 &UHDWH RU RSHQ D GRFXPHQW ZLWK PXOWLSOH OD\HUV�

2 &OLFN WKH /D\HUV EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH

/D\HUV GLDORJ ER[ RSHQV�

3 &KRRVH WKH ILUVW OD\HU \RX ZDQW WR VHOHFW�
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4 3UHVV DQG KROG CTRL DQG FKRRVH WKH RWKHU OD\HUV \RX ZDQW WR VHOHFW�

2QO\ WKH OD\HUV \RX FKRRVH DUH VHOHFWHG�

1RWH

%\ GHIDXOW� 'HVLJQHU QDPHV WKH OD\HUV /D\HU �� /D\HU �� DQG VR IRUWK�
<RX FDQ FKDQJH WKHVH QDPHV WR JLYH HDFK OD\HU LQ \RXU GUDZLQJ D
XQLTXH QDPH�

To rename a la yer

1 5LJKW�FOLFN WKH OD\HU \RX ZDQW WR UHQDPH�

2 6HOHFW 5HQDPH OD\HU IURP WKH PHQX�

3 7\SH LQ WKH OD\HU QDPH�

4 &OLFN 2N�

RU

1 &OLFN WKH /D\HUV EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH /D\HU

PHQX RSHQV�

2 &OLFN WKH /D\HUV EXWWRQ LQ WKH PHQX� 7KH /D\HUV GLDORJ ER[ RSHQV�

3 +LJKOLJKW WKH QDPH RI WKH OD\HU \RX ZDQW WR UHQDPH�

4 3RLQW WR WKH /D\HU 1DPH WH[W ER[ DQG FOLFN WKH OHIW PRXVH EXWWRQ�

5 7\SH D QHZ QDPH DQG SUHVV HQWHU� 7KH QHZ QDPH DSSHDUV LQ WKH OLVW RI

QDPHV�

To add and remove la yers

1 5LJKW�FOLFN RQ D OD\HU WDE�

2 7R DGG D OD\HU� FKRRVH $GG /D\HU IURP WKH PHQX�

RU

7R GHOHWH D OD\HU� FKRRVH 'HOHWH /D\HU IURP WKH PHQX�

RU

1 &OLFN WKH /D\HUV EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH

/D\HUV GLDORJ ER[ RSHQV�
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2 7R DGG D OD\HU� FOLFN WKH $GG /D\HU EXWWRQ�

3 7R UHPRYH D OD\HU� FKRRVH WKH OD\HU \RX ZDQW WR UHPRYH DQG FOLFN WKH

'HOHWH /D\HU EXWWRQ� 7KH OD\HU LV UHPRYHG DQG DOO REMHFWV RQ WKDW OD\HU

DUH GHOHWHG�

1RWH

:KHQ \RX UHPRYH D OD\HU� DOO REMHFWV RQ WKDW OD\HU DUH GHOHWHG� <RX
FDQQRW UHPRYH WKH FXUUHQW OD\HU�

To chan ge the order of la yers

1 5LJKW�FOLFN RQ D OD\HU WDE�

2 8VH WKH 0RYH /D\HU 8S DQG 0RYH /D\HU 'RZQ FRPPDQGV LQ WKH

/D\HUV PHQX�

RU

1 &OLFN WKH /D\HU EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH /D\HU

PHQX RSHQV�

2 &OLFN WKH /D\HUV EXWWRQ LQ WKH PHQX� 7KH /D\HUV GLDORJ ER[ RSHQV�

3 7R PRYH D OD\HU XS WKH OLVW� FKRRVH WKH OD\HU \RX ZDQW WR PRYH DQG

FOLFN WKH 0RYH 8S EXWWRQ�

4 7R PRYH D OD\HU GRZQ WKH OLVW� FKRRVH WKH OD\HU \RX ZDQW WR PRYH DQG

FOLFN WKH 0RYH 'RZQ EXWWRQ�

To move an ob ject from one la yer to another

1 6HOHFW WKH REMHFW \RX ZDQW WR PRYH WR DQRWKHU OD\HU�

2 5LJKW�FOLFN RQ WKH DFWLYH OD\HU WDE� 7KH /D\HU PHQX RSHQV�

3 6HOHFW 0RYH WR /D\HU IURP WKH PHQX�

4 'RXEOH FOLFN WKH QDPH RI WKH OD\HU WR ZKLFK \RX ZDQW WR PRYH� 7KH

VHOHFWHG REMHFW PRYHV WR WKH FKRVHQ �QRZ FXUUHQW� OD\HU�
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To edit all la yers

1 5LJKW�FOLFN RQ D OD\HU WDE DQG VHOHFW (GLW $OO /D\HUV�

RU

&OLFN WKH /D\HUV EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH

/D\HUV GLDORJ ER[ RSHQV�

2 6HOHFW WKH (GLW $OO /D\HUV RSWLRQ� <RX FDQ QRZ VHOHFW DQG HGLW DOO

REMHFWV RQ DOO OD\HUV� 'HVHOHFW WKLV RSWLRQ WR UHWXUQ WR VLQJOH�OD\HU

VHOHFWLRQ DQG HGLWLQJ�

1RWH

<RX FDQQRW PRYH DQ REMHFW RQ D ORZHU OD\HU LQ IURQW RI DQ REMHFW
RQ D KLJKHU OD\HU� <RX FDQ� KRZHYHU� FKDQJH WKH RUGHU RI OD\HUV VR
WKDW WKH HQWLUH OD\HU DQG LWV FRQWHQWV PRYH LQ IURQW RI DQRWKHU OD\HU�

Locking and Unlocking Layers

:KHQ D OD\HU LV ORFNHG� LW FDQ HLWKHU EH GLVSOD\HG RU KLGGHQ� EXW LW FDQQRW EH

HGLWHG RU GHOHWHG� <RX FDQQRW ORFN WKH FXUUHQW OD\HU�

To lock or unlock la yers

1 ULJKW�FOLFN RQ D OD\HU WDE DQG FKRRVH /RFNHG�

RU

&OLFN WKH /D\HU EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH /D\HUV

GLDORJ ER[ RSHQV�

2 7R ORFN D OD\HU� FKRRVH WKH OD\HU \RX ZDQW WR ORFN DQG FOLFN WKH /RFN

/D\HU EXWWRQ�

3 7R XQORFN D OD\HU� FKRRVH WKH OD\HU \RX ZDQW WR XQORFN DQG FOLFN WKH

8QORFN /D\HU EXWWRQ�

Showing and Hiding Layers

<RX FDQQRW KLGH WKH FXUUHQW OD\HU� ,I \RX PDNH D KLGGHQ OD\HU WKH FXUUHQW

OD\HU� LW LV QR ORQJHU KLGGHQ�
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+LGGHQ OD\HUV DUH QRW SULQWHG� VR \RX FDQ KLGH OD\HUV QRW RQO\ LQ \RXU GLVSOD\

EXW DOVR LQ \RXU SULQWRXW� ,I \RX ZDQW WR SULQW DOO RI WKH OD\HUV LQ WKH GUDZLQJ�

EH VXUH WR VKRZ DOO WKH OD\HUV EHIRUH \RX SULQW�

To show or hide la yers

1 5LJKW�FOLFN RQ D OD\HU WDE DQG VHOHFW 9LVLEOH IURP WKH PHQX�

RU

&OLFN WKH /D\HUV EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH

/D\HUV GLDORJ ER[ RSHQV�

2 7R VKRZ D OD\HU� FKRRVH WKH OD\HU \RX ZDQW WR VKRZ DQG FOLFN WKH 6KRZ

EXWWRQ�

3 7R KLGH D OD\HU� FKRRVH WKH OD\HU \RX ZDQW WR KLGH DQG FOLFN WKH +LGH

EXWWRQ�

Hiding and Locking Individual Objects

,Q DGGLWLRQ WR OHWWLQJ \RX KLGH RU ORFN DOO REMHFWV RQ D VSHFLILHG OD\HU� 'HVLJQHU

DOVR OHWV \RX KLGH RU ORFN LQGLYLGXDO REMHFWV�

7HPSRUDULO\ KLGLQJ REMHFWV PD\ VSHHG VFUHHQ UHGUDZ WLPH� HVSHFLDOO\ LI WKH

REMHFWV LQFOXGH JUDGLHQW ILOOV RU ELWPDSV� /RFNLQJ REMHFWV PD\ EH GHVLUDEOH LI

\RX ZDQW WR HQVXUH WKDW \RX GR QRW DFFLGHQWDOO\ PRYH RU UHVL]H WKHP�

To hide or lock individual ob jects

1 6HOHFW RQH RU PRUH REMHFWV WR KLGH RU ORFN�

2 2SHQ WKH $UUDQJH PHQX�

3 &KRRVH +LGH RU /RFN�

To show or unlock all ob jects

1 2SHQ WKH $UUDQJH PHQX�

2 &KRRVH 6KRZ $OO RU 8QORFN $OO�
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Using Multicolor or Single-Color Layers

<RX FDQ PDNH HYHU\ REMHFW RQ D SDUWLFXODU OD\HU WKH VDPH FRORU�

8VLQJ VLQJOH�FRORU OD\HUV FDQ KHOS \RX YLVXDOO\ NHHS WUDFN RI ZKLFK REMHFWV DUH

RQ ZKLFK OD\HU� 'HVLJQHU OHWV \RX PL[ VLQJOH�FRORU OD\HUV DQG PXOWLSOH�FRORU

OD\HUV LQ WKH VDPH GUDZLQJ�

%\ GHIDXOW� D OD\HU LV PXOWLFRORUHG� ,I \RX OLPLW D SDUWLFXODU OD\HU WR D VLQJOH

FRORU� DOO H[LVWLQJ REMHFWV DQG DOO VXEVHTXHQW REMHFWV DUH ILOOHG ZLWK WKH VLQJOH

FRORU� <RX FDQ XVH WKH FXUUHQW GHIDXOW OD\HU FRORU RU FOLFN WKH /D\HU &RORU

EXWWRQ WR FKRRVH D GLIIHUHQW FRORU�

To chan ge a layer to a sin gle-color la yer

1 &OLFN WKH /D\HUV EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH

/D\HUV GLDORJ ER[ RSHQV�

2 &KRRVH WKH OD\HU WKDW \RX ZDQW WR PDNH D VLQJOH FRORU�

3 &OLFN WKH /D\HU &RORU EXWWRQ� $ FRORU SDOHWWH RSHQV�

4 &KRRVH D FRORU IURP WKH FRORU SDOHWWH�

5 &OLFN WKH 6LQJOH�FRORU EXWWRQ� $Q LQGLFDWRU DSSHDUV WR PDUN WKH FKRVHQ

OD\HU DV DOO RQH FRORU�

1RWH

,I \RX VNLS VWHSV � DQG � DERYH� WKH GHIDXOW OD\HU FRORU LV DSSOLHG�

7R FKDQJH D OD\HU EDFN WR D PXOWLFRORU OD\HU� RSHQ WKH /D\HUV GLDORJ ER[�

FKRRVH WKH OD\HU� DQG FOLFN WKH 0XOWLFRORU EXWWRQ� 7KH REMHFWV RQ WKH OD\HU

FKDQJH EDFN WR WKHLU SUHYLRXV FRORUV�
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Printable Layers

<RX FDQ PDNH OD\HUV SULQWDEOH RU QRQ�SULQWDEOH� %\ GHIDXOW� DOO OD\HUV DUH

SULQWDEOH�

7LS

+LGGHQ OD\HUV FDQQRW EH VHW WR SULQWDEOH�

To make a la yer printable or non- printable

1 5LJKW�FOLFN WKH OD\HU WDE DQG VHOHFW 3ULQWDEOH IURP WKH PHQX�

RU

&OLFN WKH /D\HUV EXWWRQ DW WKH ERWWRP RI WKH DFWLYH ZLQGRZ� 7KH

/D\HUV GLDORJ ER[ RSHQV�

2 7R PDNH D OD\HU SULQWDEOH� FKRRVH WKH OD\HU \RX ZDQW WR SULQW DQG FOLFN

WKH 3ULQWDEOH /D\HU EXWWRQ�

3 7R PDNH D OD\HU QRQ�SULQWDEOH� FKRRVH WKH OD\HU \RX GR QRW ZDQW WR

SULQW DQG FOLFN WKH 1RQ�3ULQWDEOH /D\HU EXWWRQ�
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Setting Up Coordinates

'HVLJQHU XVHV FRRUGLQDWHV IRU SUHFLVH GUDZLQJ DQG SRVLWLRQLQJ� <RX FDQ

GLVSOD\ FRRUGLQDWHV WR UHIHUHQFH WKH FXUUHQW PRXVH SRVLWLRQ� WKH RULJLQ DQG

VL]H RI D VHOHFWHG REMHFW� WKH RULJLQ DQG HQGSRLQW RI D VHOHFWHG REMHFW� RU WKH

RULHQWDWLRQ DQG UDWH RI H[SDQVLRQ GXULQJ WUDQVIRUPDWLRQV� &RRUGLQDWHV FDQ

DOVR EH XVHG WR GUDZ� PRYH� RU UHVL]H DQ REMHFW�

Displaying Coordinates

&RRUGLQDWHV DUH GLVSOD\HG LQ WKH VWDWXV EDU� :KHQ QR REMHFW LV VHOHFWHG� WKH

VWDWXV EDU VKRZV WKH FRRUGLQDWHV RI WKH PRXVH SRLQWHU� :KHQ DQ REMHFW LV

VHOHFWHG� WKH VWDWXV EDU VKRZV WKH FRRUGLQDWHV RI WKH VHOHFWHG REMHFW� 'XULQJ

D WUDQVIRUPDWLRQ VXFK DV PDQXDOO\ UHVL]LQJ DQ REMHFW� WKH VWDWXV EDU VKRZV WKH

FRRUGLQDWHV RI WKH WUDQVIRUPDWLRQ�

Choosing a Coordinate System

'HVLJQHU FDQ XVH &DUWHVLDQ �UHFWDQJXODU� RU SRODU �UDGLDO� FRRUGLQDWHV� ,Q WKH

SRODU FRRUGLQDWH V\VWHP� \RX FDQ H[SUHVV DQJOHV LQ GHJUHHV RU UDGLDQV�

Using Cartesian Coordinates

&DUWHVLDQ FRRUGLQDWHV XVH WKH IDPLOLDU YHUWLFDO DQG KRUL]RQWDO D[HV� 7KH

YHUWLFDO D[LV LV FDOOHG <� DQG WKH KRUL]RQWDO D[LV LV FDOOHG ;�
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7KH ; DQG < D[HV FRUUHVSRQG FORVHO\ WR WKH UXOHUV LQ WKH 'HVLJQHU ZLQGRZ�

7KH UXOHU RULJLQ LV WKH LQWHUVHFWLRQ RI WKH WZR D[HV� ZKHUH ; �� < �� ,I WKH

RULJLQ LV VHW DW WKH WRS OHIW RI D SDJH� WKH YDOXHV IRU ; JR IURP OHIW WR ULJKW� DQG

WKH YDOXHV IRU < JR IURP WRS WR ERWWRP� MXVW OLNH WKH UXOHUV�

,I \RX GUDJ WKH UXOHU RULJLQ WR WKH FHQWHU RI WKH SDJH� WKH D[HV DQG UXOHUV DUH

UHSRVLWLRQHG ZLWK UHVSHFW WR WKH SDJH�
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Using Polar Coordinates

3RODU FRRUGLQDWHV XVH D GLIIHUHQW PHWKRG WR UHIHUHQFH HDFK SRLQW RQ WKH

SDJH� ,QVWHDG RI KDYLQJ WZR VWUDLJKW D[HV� SRODU FRRUGLQDWHV PHDVXUH WKH

GLVWDQFH IURP WKH FHQWHU DQG WKH DQJOH IURP WKH D[LV�

7KH GLVWDQFH IURP WKH FHQWHU LV FDOOHG 5 �IRU UDGLXV�� 5 LV PHDVXUHG LQ LQFKHV�

FHQWLPHWHUV� RU VRPH RWKHU OLQHDU XQLW RI PHDVXUH� $QJOHV DUH FDOOHG $ DQG

DUH PHDVXUHG LQ GHJUHHV RU UDGLDQV� 'HJUHHV DQG UDGLDQV DUH ERWK UDGLDO�

UDWKHU WKDQ OLQHDU� XQLWV RI PHDVXUH� 2QH UDGLDQ LV HTXDO WR DSSUR[LPDWHO\ ����

GHJUHHV�

7R ILQG D SRLQW ZKHUH 5 HTXDOV � DQG $ HTXDOV �� GHJUHHV� ILQG � DW ]HUR

GHJUHHV DQG WKHQ PRYH DORQJ WKDW FLUFOH XQWLO \RX UHDFK �� GHJUHHV�

R=3, A=45°

2 4 6
0°

45°

90°

135°

180°

225° 315°

270°
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7KH ]HUR GHJUHH SRLQW RI WKH SRODU FRRUGLQDWH V\VWHP FRUUHVSRQGV WR

'HVLJQHU
V KRUL]RQWDO UXOHU� 7KH UXOHU RULJLQ LV WKH FHQWHU RI WKH SRODU

FRRUGLQDWH PRGHO� ,I WKH RULJLQ LV VHW DW WKH WRS OHIW RI D SDJH� WKH UHODWLRQVKLS

RI WKH V\VWHP WR WKH SDJH LV DV VKRZQ LQ WKH IROORZLQJ GLDJUDP�

,I \RX GUDJ WKH UXOHU RULJLQ WR WKH FHQWHU RI WKH SDJH� WKH UXOHUV DQG V\VWHP

DUH UHSRVLWLRQHG ZLWK UHVSHFW WR WKH SDJH�

To choose a coordinate s ystem

1 &OLFN WKH &RRUGLQDWHV EXWWRQ LQ WKH VWDWXV EDU�

2 &KRRVH &DUWHVLDQ� 3RODU �5DGLDQV�� RU 3RODU �'HJUHHV�� 7KH SRVLWLRQ

DQG REMHFW LQIRUPDWLRQ UHIOHFWV WKH QHZ FRRUGLQDWH V\VWHP�

Drawing with Coordinates

&RRUGLQDWHV JLYH \RX D PRUH SUHFLVH PHWKRG RI GUDZLQJ WKDQ XVLQJ WKH

PRXVH� ,QVWHDG RI SRLQWLQJ� FOLFNLQJ� DQG GUDJJLQJ WKH PRXVH� \RX FDQ HQWHU

QXPEHUV IRU FRRUGLQDWHV IRU DQ REMHFWjV RULJLQ �VWDUWLQJ SRLQW� DQG LWV HQGLQJ

SRLQW� RU IRU DQ REMHFWjV ZLGWK DQG KHLJKW�
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7KH &RRUGLQDWHV GLDORJ ER[ JLYHV \RX VHYHUDO PHWKRGV IRU VSHFLI\LQJ WKH VL]H

DQG SRVLWLRQ RI DQ REMHFW� DV ZHOO DV VRPH DFWLRQV WKDW OHW \RX SRLQW DQG FOLFN

ZLWK WKH NH\ERDUG� ZLWKRXW XVLQJ D PRXVH RU RWKHU SRLQWLQJ GHYLFH�

7KH IROORZLQJ H[DPSOH VKRZV KRZ WR GUDZ D UHFWDQJOH E\ HQWHULQJ

FRRUGLQDWHV� ,W LV DVVXPHG WKDW WKH UXOHUV DUH VHW WR LQFKHV� 7KH XSSHU OHIW

FRUQHU RI WKH UHFWDQJOH LV SRVLWLRQHG DW WKH SRLQW ������ 7KH UHFWDQJOH LV WHQ

LQFKHV ZLGH DQG WKUHH LQFKHV KLJK�

To draw a rectan gle with coordinates

1 &OLFN WKH &RRUGLQDWHV EXWWRQ LQ WKH VWDWXV EDU DQG FKRRVH

&RRUGLQDWHV� 7KH &RRUGLQDWHV GLDORJ ER[ RSHQV�

2 &OLFN &UHDWH D 1HZ� WKHQ VHOHFW 5HFWDQJOH IURP WKH OLVW�

3 &OLFN WKH GRZQ DUURZ LQ WKH 0HWKRG OLVW ER[ DQG FKRRVH :LGWK�

+HLJKW� LI QHFHVVDU\�

4 ,Q WKH 3RVLWLRQ VHFWLRQ FKRRVH WKH WRS OHIW KDQGOH LQ WKH )URP OLVW�

5 3ODFH WKH FXUVRU DW WKH ; VFUROO ER[� 7\SH � DQG SUHVV WKH 7DE NH\�

6 ,Q WKH < VFUROO ER[� W\SH �� <RX KDYH QRZ VSHFLI LHG WKH ; DQG <

FRRUGLQDWHV IRU WKH VWDUWLQJ SRLQW RI WKH UHFWDQJOH�

7 ,Q WKH :LGWK VFUROO ER[� W\SH �� DQG SUHVV WDE� 7KH ZLGWK RI WKH

UHFWDQJOH LV �� FHQWLPHWHUV�

8 ,Q WKH +HLJKW VFUROO ER[� W\SH ��

9 3UHVV HQWHU RU FOLFN &UHDWH� 'HVLJQHU GUDZV WKH UHFWDQJOH RQ WKH SDJH

ZLWK WKH H[DFW VWDUWLQJ SRLQW DQG GLPHQVLRQV WKDW \RX HQWHUHG�

10 &OLFN &ORVH WR FORVH WKH &RRUGLQDWHV GLDORJ ER[�
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Setting Object Names and Other Properties

<RX FDQ DVVLJQ QDPHV WR REMHFWV DQG JURXSV RI REMHFWV LQ \RXU GUDZLQJ� 7KLV

OHWV \RX FUHDWH D OLVW RI REMHFWV� VHOHFW REMHFWV E\ QDPH� DQG FUHDWH \RXU RZQ

OLEUDU\ RI FOLS DUW� <RX FDQ DVVLJQ QDPHV� FRVWV� DQG RWKHU ILHOGV WR FRPSOH[

HQJLQHHULQJ GUDZLQJV�

7KH 2EMHFW 3URSHUWLHV GLDORJ ER[ OHWV \RX VHW REMHFW SURSHUWLHV DFFRUGLQJ WR

FXVWRPL]HG ILHOGV DQG YDOXHV�

�

To name (or rename ) an ob ject

1 6HOHFW DQ REMHFW�

2 2Q WKH 2EMHFW PHQX� FOLFN 3URSHUWLHV� 7KH 3URSHUWLHV GLDORJ ER[

RSHQV�

3 7\SH D QDPH LQ WKH 2EMHFW 1DPH ER[ DQG FOLFN $SSO\�

4 &OLFN &ORVH�

To create a new field

1 6HOHFW DQ REMHFW�

2 2Q WKH 2EMHFW PHQX� FOLFN 3URSHUWLHV� 7KH 3URSHUWLHV GLDORJ ER[

RSHQV� 1RWLFH WKH QDPH RI WKH REMHFW WKDW DSSHDUV LQ WKH 2EMHFW

1DPH ER[�

3 &OLFN $GG�

4 7\SH &RVW� IRU H[DPSOH� LQ WKH )LHOG ER[ DQG SUHVV WKH WDE NH\�

5 7\SH ����� IRU H[DPSOH LQ WKH 9DOXH ER[ DQG FOLFN $SSO\ RU SUHVV WKH

(QWHU NH\�
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6 5HSHDW VWHSV � WKURXJK � WR DGG DGGLWLRQDO ILHOGV DQG YDOXHV�

7 &OLFN &ORVH

.
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Working with Files
'HVLJQHU OHWV \RX GLVSOD\ PRUH WKDQ RQH ILOH DW D WLPH� <RX FDQ DOVR KDYH

PRUH WKDQ RQH ZLQGRZ FRQWDLQLQJ WKH VDPH GRFXPHQW� /LNH RWKHU

:LQGRZV DSSOLFDWLRQV WKDW OHW \RX RSHQ PXOWLSOH GRFXPHQWV� \RX FDQ VHOHFW

WKH &DVFDGH DQG 7LOH FRPPDQGV LQ WKH :LQGRZ PHQX WR DUUDQJH PXOWLSOH

ZLQGRZV RQ \RXU VFUHHQ�

7KH FXUUHQWO\ VHOHFWHG GUDZLQJ ZLQGRZ LV WKH DFWLYH ZLQGRZ� 7KH DFWLYH

ZLQGRZ �ZLWK WKH WLWOH EDU KLJKOLJKWHG� UHFHLYHV WKH QH[W DFWLRQ� 2QO\ RQH

GUDZLQJ ZLQGRZ LV DFWLYH DW D WLPH�
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<RX FDQ UHVL]H D ZLQGRZ PDQXDOO\ DQG FDQ PD[LPL]H� UHVWRUH� DQG PLQLPL]H

DQ RSHQ ZLQGRZ E\ FOLFNLQJ WKH DSSURSULDWH EXWWRQ DW WKH WRS ULJKW RI WKH

ZLQGRZ� $IWHU \RX PLQLPL]H D ZLQGRZ� \RX FDQ VHOHFW WKH $UUDQJH ,FRQV

FRPPDQG LQ 'HVLJQHU
V :LQGRZ PHQX WR DXWRPDWLFDOO\ VSDFH WKH PLQLPL]HG

GRFXPHQW LFRQV HYHQO\ RQ \RXU VFUHHQ�

1RWH

7R VHOHFW REMHFWV RQ PXOWLSOH OD\HUV SULRU WR H[SRUW� RSHQ WKH /D\HUV GLDORJ
ER[� VHOHFW (GLW $OO /D\HUV� FORVH WKH GLDORJ ER[� DQG WKHQ VHOHFW WKH GHVLUHG
REMHFWV RQ WKH GHVLUHG OD\HUV RI WKH FXUUHQW SDJH�

Opening Files

7R HGLW RU YLHZ D ILOH LQ 'HVLJQHU� \RX ILUVW RSHQ� RU ORDG� WKH ILOH XVLQJ WKH

2SHQ FRPPDQG LQ WKH )LOH PHQX �NH\ERDUG VKRUWFXW CTRL+O��

7R FKDQJH IROGHUV� SRLQW WR WKH IROGHU FRQWDLQLQJ WKH GRFXPHQW WKDW \RX ZDQW

WR RSHQ DQG GRXEOH FOLFN WKH OHIW PRXVH EXWWRQ� 7KH ILOH QDPHV LQ WKH IROGHU

DSSHDU DW WKH OHIW�

<RX DOVR FDQ W\SH WKH GLUHFWRU\ QDPH VHSDUDWHG ZLWK EDFNVODVKHV� )RU

H[DPSOH� W\SH F�?L*UDI[?GHVLJQHU?WXWRULDOV DQG SUHVV HQWHU�

7R TXLFNO\ VFUROO WR D VSHFLILF ILOHQDPH� \RX FDQ FOLFN WKH )LOH 1DPH OLVW DQG

W\SH WKH ILUVW FKDUDFWHU RI D ILOHQDPH� 7KH OLVW MXPSV WR WKH ILUVW ILOH EHJLQQLQJ

ZLWK WKDW FKDUDFWHU�

(DFK WLPH \RX FKRRVH WKH 2SHQ FRPPDQG LQ WKH )LOH PHQX� WKH 2SHQ GLDORJ

ER[ UHFDOOV WKH PRVW UHFHQWO\ XVHG GULYH DQG GLUHFWRU\�

:KHQ \RX RSHQ D '5: GRFXPHQW ZLWK PXOWLSOH SDJHV� \RX UHFHLYH D GLDORJ

ER[ DVNLQJ KRZ \RX ZDQW WR RSHQ WKH GRFXPHQW�

v ,I HDFK SDJH LQ WKH RULJLQDO GRFXPHQW FRQWDLQV D VHSDUDWH GUDZLQJ� FOLFN

6SOLW 8S 3DJHV� 'HVLJQHU UHWDLQV WKH FRQWHQWV RQ PXOWLSOH SDJHV DV WKH\

ZHUH LQ WKH RULJLQDO '5: ILOH�
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v ,I D ODUJH GUDZLQJ VSDQV VHYHUDO SDJHV LQ WKH RULJLQDO GRFXPHQW� FOLFN

(QODUJH 'RFXPHQW� 7KH HQWLUH GUDZLQJ LV ORDGHG DV D VLQJOH�SDJH

GUDZLQJ� 7KH SDJH VL]H LV HQODUJHG WR LQFOXGH DOO RI WKH XVHG SDJHV RI

WKH RULJLQDO GUDZLQJ�

To open a file

1 2Q WKH )LOH PHQX� FOLFN 2SHQ� 7KH 2SHQ GLDORJ ER[ RSHQV� �.H\ERDUG

VKRUWFXW CTRL+O�

2 &OLFN WKH GULYH WKDW FRQWDLQV WKH GRFXPHQW \RX ZDQW WR RSHQ�

3 'RXEOH FOLFN WKH DSSURSULDWH IROGHU�

4 &OLFN D ILOHQDPH WR VHH D SUHYLHZ RI WKH GUDZLQJ�

5 &OLFN 2SHQ� 7KH GUDZLQJ DSSHDUV LQ WKH GUDZLQJ DUHD�

1RWH

7KH 2SHQ GLDORJ ER[ GRHV QRW VKRZ D ILOH SUHYLHZ IRU '5: ILOHV�
:KHQ \RX RSHQ D '5: ILOH� LW LV DXWRPDWLFDOO\ FRQYHUWHG WR D '6)
ILOH DQG WKH H[WHQVLRQ LV FKDQJHG WR '6)�

<RX DOVR FDQ W\SH WKH IROGHU QDPH VHSDUDWHG ZLWK EDFNVODVKHV� )RU

H[DPSOH� W\SH C:\IGRAFX\DESIGNER\TUTORIAL DQG SUHVV

ENTER�

7R TXLFNO\ VFUROO WR D VSHFLILF ILOHQDPH� \RX FDQ FOLFN DQ\ZKHUH LQ
WKH OLVW RI ILOH QDPHV DQG WKHQ W\SH WKH ILUVW FKDUDFWHU RI WKH
ILOHQDPH� 7KH OLVW MXPSV WR WKH ILUVW ILOH EHJLQQLQJ ZLWK WKDW
FKDUDFWHU�

(DFK WLPH \RX FOLFN WKH 2SHQ FRPPDQG RQ WKH )LOH PHQX� WKH
2SHQ GLDORJ ER[ UHFDOOV WKH PRVW UHFHQWO\ XVHG GULYH DQG IROGHU�
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To create a new file

` &OLFN 1HZ RQ WKH )LOH PHQX� 'HVLJQHU RSHQV D QHZ ZLQGRZ FRQWDLQLQJ

DQ XQWLWOHG GRFXPHQW� �.H\ERDUG VKRUWFXW CTRL+N�

7LS

,I WKH 6WDQGDUG WRROEDU LV GLVSOD\HG� \RX FDQ FOLFN WKH 1HZ EXWWRQ
�

To name a new file

1 &OLFN 6DYH RU 6DYH $V RQ WKH )LOH PHQX� 7KH 6DYH $V GLDORJ ER[ RSHQV�

2 7\SH D QDPH LQ WKH )LOH 1DPH WH[W ER[ DQG SUHVV ENTER�

7LS

7KH NH\ERDUG VKRUWFXW IRU 6DYH LV CTRL+S�

,I WKH 6WDQGDUG WRROEDU LV GLVSOD\HG� \RX FDQ FOLFN WKH 6DYH EXWWRQ
�

Recalling a File

7KH UHFDOO OLVW LQ WKH )LOH PHQX FRQWDLQV WKH ODVW IRXU GRFXPHQWV \RX RSHQHG

RU VDYHG LQ 'HVLJQHU� 7KLV FRPPDQG OHWV \RX TXLFNO\ DFFHVV WKH PRVW UHFHQWO\

XVHG GRFXPHQWV�

1RWH

,I D ILOH LV GHOHWHG RU LV RQ D GULYH WKDW LV QRW FXUUHQWO\ DYDLODEOH� LW VWLOO PD\
DSSHDU LQ WKH VXEPHQX� :KHQ \RX FKRRVH RQH RI WKHVH ILOHV� 'HVLJQHU
GLVSOD\V D PHVVDJH VWDWLQJ WKDW LW FDQQRW ILQG WKH ILOH�
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To open a recentl y used file

` &OLFN WKH ILOHQDPH RI WKH UHFHQWO\ XVHG GRFXPHQW RQ WKH )LOH PHQX�

1RWH

,I D GRFXPHQW KDV EHHQ GHOHWHG RU LV RQ D GULYH WKDW LV QRW
FXUUHQWO\ DYDLODEOH� 'HVLJQHU GLVSOD\V D PHVVDJH VWDWLQJ WKDW LW
FDQQRW ILQG WKH GRFXPHQW�

Closing a File

<RX FDQ FORVH WKH ILOH LQ WKH DFWLYH ZLQGRZ LQ RQH RI ILYH ZD\V�

v &OLFN WKH &ORVH EXWWRQ LQ WKH WRS ULJKW FRUQHU RI WKH ZLQGRZ�

v 2SHQ WKH )LOH PHQX DQG FKRRVH &ORVH�

v 2SHQ WKH GRFXPHQW &RQWURO PHQX DQG FKRRVH &ORVH�

v 'RXEOH FOLFN WKH &RQWURO PHQX ER[ DW WKH WRS OHIW RI WKH GUDZLQJ

ZLQGRZ�

v 3UHVV CTRL+F4�

,I WKH ILOH \RX DUH ZRUNLQJ ZLWK KDV FKDQJHV� DQG \RX KDYH QRW VDYHG WKH ODWHVW

FKDQJHV� 'HVLJQHU DVNV \RX WR VHOHFW RQH RI WKUHH FKRLFHV� <HV� 1R� RU &DQFHO�

v <HV VDYHV WKH ODWHVW FKDQJHV WR \RXU GUDZLQJ� ,I \RX KDYH QRW SUHYLRXVO\

VDYHG WKH GUDZLQJ� WKH 6DYH $V GLDORJ ER[ RSHQV� 7\SH D QDPH LQ WKH

WH[W ER[ DQG SUHVV HQWHU�

v 1R GRHV QRW VDYH FKDQJHV WR WKH FXUUHQW ILOH DQG FORVHV WKH GRFXPHQW�

v &DQFHO FDQFHOV WKH &ORVH FRPPDQG DQG UHWXUQV \RX WR WKH FXUUHQW

GRFXPHQW�
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To close a file

` &OLFN &ORVH �NH\ERDUG VKRUWFXW CTRL+F4� RU &ORVH $OO RQ WKH )LOH

PHQX� RU FOLFN WKH �;� &ORVH EXWWRQ DW WKH ULJKW VLGH RI WKH GRFXPHQWjV

ZLQGRZ�

1RWH

$OO RSHQ GRFXPHQWV DUH FORVHG LI \RX FORVH 'HVLJQHU�

To make a co py of a file

1 &OLFN 2SHQ RQ WKH )LOH PHQX� 7KH 2SHQ GLDORJ ER[ RSHQV�

2 &OLFN WKH ULJKW PRXVH EXWWRQ RQ WKH QDPH RI WKH ILOH \RX ZDQW WR FRS\�

3 &OLFN &RS\ RQ WKH VKRUWFXW PHQX�

4 'RXEOH�FOLFN WKH IROGHU ZKHUH \RX ZDQW WKH FRS\ WR UHVLGH�

5 &OLFN WKH ULJKW PRXVH EXWWRQ RXWVLGH RI DQ\ ILOH QDPHV� DQG FOLFN 3DVWH�

To delete a file

1 2Q WKH )LOH PHQX� FOLFN 2SHQ� 7KH 2SHQ GLDORJ ER[ RSHQV�

2 &OLFN WKH ULJKW PRXVH EXWWRQ RQ WKH QDPH RI WKH ILOH \RX ZDQW WR

GHOHWH�

3 2Q WKH VKRUWFXW PHQX� FOLFN 'HOHWH�

4 &OLFN <HV WR GHOHWH WKH ILOH RU FOLFN 1R WR FDQFHO WKH GHOHWLRQ�

1RWH

'HOHWLQJ PD\ HLWKHU GHOHWH WKH ILOH RU PRYH WKH ILOH WR WKH 5HF\FOH
%LQ� GHSHQGLQJ RQ KRZ \RX KDYH VHW WKH SURSHUWLHV RI WKH 5HF\FOH
%LQ�

To rename a file

1 2Q WKH )LOH PHQX� FOLFN 2SHQ� 7KH 2SHQ GLDORJ ER[ RSHQV�
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2 &OLFN WKH ULJKW PRXVH EXWWRQ RQ WKH QDPH RI WKH ILOH \RX ZDQW WR

UHQDPH�

3 2Q WKH VKRUWFXW PHQX� FOLFN 5HQDPH�

4 7\SH WKH QHZ ILOHQDPH DQG H[WHQVLRQ DQG SUHVV ENTER�

Finding a File

,I \RX DUH QRW VXUH RI WKH ORFDWLRQ RI D ILOH� \RX FDQ OHW 'HVLJQHU VHDUFK IRU LW�

<RX FDQ VSHFLI\ D VHDUFK SDWK WKDW LQFOXGHV WKH GULYH� GLUHFWRU\� DQG

VXEGLUHFWRULHV� RU \RX FDQ VHDUFK IRU D ILOH RQ PXOWLSOH GLVN GULYHV�

7LS

,I 'HVLJQHU OLVWV PXOWLSOH ILOHV IRXQG LQ D VHDUFK� \RX FDQ VHOHFW WKH GHVLUHG
ILOHV IURP WKLV OLVW DQG WKHQ RSHQ DOO WKH ILOHV DW RQFH� HYHQ LI WKH ILOHV DUH LQ
GLIIHUHQW GLUHFWRULHV RU VXEGLUHFWRULHV�

To find a file

1 2Q WKH )LOH PHQX� FOLFN 2SHQ� 7KH 2SHQ GLDORJ ER[ RSHQV�

2 &OLFN )LQG� 7KH )LQG )LOH GLDORJ ER[ RSHQV�

3 7\SH WKH QDPH RI WKH ILOH \RX ZDQW WR VHDUFK IRU�

4 7\SH D GULYH DQG IROGHU� RU FOLFN WKH %URZVH EXWWRQ WR VHDUFK IRU WKH

IROGHU�

5 &OLFN )LQG QHZ� 'HVLJQHU OLVWV WKH QDPHV DQG ORFDWLRQV RI PDWFKLQJ ILOHV�

6 +LJKOLJKW RQH RU PRUH ILOH QDPHV IURP WKH VHDUFK OLVW�
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7 &OLFN 2SHQ� (DFK VHOHFWHG GRFXPHQW RSHQV LQ LWV RZQ ZLQGRZ�

7LS

<RX FDQ XVH ZLOG�FDUG FKDUDFWHUV �IRU H[DPSOH� *.DSF� WR ILQG ILOHV
RI WKH VDPH W\SH RU ILOHV ZLWK VLPLODU QDPHV�

,I 'HVLJQHU OLVWV PXOWLSOH ILOHV IRXQG LQ D VHDUFK� \RX FDQ VHOHFW WKH
GHVLUHG ILOHV IURP WKLV OLVW DQG WKHQ RSHQ DOO WKH ILOHV DW RQFH� HYHQ LI
WKH ILOHV DUH LQ GLIIHUHQW IROGHUV RU VXEIROGHUV�

Saving a File

<RX VKRXOG PDNH D KDELW RI VDYLQJ \RXU ZRUN RIWHQ� 7KLV KHOSV WR HQVXUH WKDW

\RXU ILOHV DUH VDYHG LQ WKH HYHQW RI D SRZHU LQWHUUXSWLRQ RU D KDUGZDUH RU

VRIWZDUH SUREOHP�

7KH ILUVW WLPH \RX VDYH D QHZ GRFXPHQW ILOH� \RX FDQ QDPH LW DQG FKRRVH

ZKHUH \RX ZDQW WR VWRUH LW� $IWHUZDUGV� HDFK WLPH \RX FKRRVH WKH 6DYH

FRPPDQG� DQ\ FKDQJHV WR WKH ILOH DUH VDYHG�

To save a file

1 ,I \RX KDYH PRUH WKDQ RQH GRFXPHQW RSHQ� VHOHFW WKH ZLQGRZ RI WKH

GRFXPHQW \RX ZDQW WR VDYH�

2 2Q WKH )LOH PHQX� FOLFN 6DYH� ,I \RX DUH VDYLQJ D GRFXPHQW IRU WKH ILUVW

WLPH� WKH 6DYH $V GLDORJ ER[ RSHQV� ,I \RX DOUHDG\ KDYH VDYHG WKH ILOH�

\RXU FKDQJHV DUH VDYHG LQ WKH ILOH \RX QDPHG HDUOLHU�

3 7\SH WKH ILOHQDPH \RX ZDQW� ,I \RX GR QRW SURYLGH DQ H[WHQVLRQ� '6) LV

XVHG�

4 &KRRVH WKH GULYH DQG IROGHU LQ ZKLFK \RX ZDQW WR VWRUH WKH ILOH�

5 &KRRVH WKH ILOH IRUPDW \RX ZDQW LQ WKH ILOH W\SH OLVW ER[ LI \RX ZDQW WR

VDYH WKH GRFXPHQW DV D GLIIHUHQW IRUPDW�

6 &OLFN 6DYH WR VDYH WKH ILOH�
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0DNH D KDELW RI VDYLQJ \RXU ZRUN RIWHQ� 7KLV KHOSV WR HQVXUH WKDW \RXU ILOHV

DUH VDYHG LQ WKH HYHQW RI D SRZHU LQWHUUXSWLRQ RU D KDUGZDUH RU VRIWZDUH

SUREOHP�

7KH ILUVW WLPH \RX VDYH D QHZ GRFXPHQW ILOH� \RX FDQ QDPH LW DQG FKRRVH

ZKHUH \RX ZDQW WR VWRUH LW� $IWHUZDUGV� HDFK WLPH \RX FKRRVH WKH 6DYH

FRPPDQG� DQ\ FKDQJHV WR WKH ILOH DUH VDYHG�

Impor t and Ex por t

<RX DOVR FDQ LPSRUW DQG H[SRUW LPDJH ILOHV LQ VHYHUDO ILOH IRUPDWV� DQG \RX

FDQ LPSRUW DQG H[SRUW FRORU SDOHWWHV�

W hen you close Desi gner

,I DQ\ RI WKH ILOHV \RX DUH ZRUNLQJ ZLWK KDYH FKDQJHV� DQG \RX KDYH QRW VDYHG

WKHP EHIRUH FORVLQJ 'HVLJQHU� WKH 6DYH &KDQJHV GLDORJ ER[ RSHQV DQG

UHTXHVWV WKDW \RX VHOHFW RQH RI WKUHH FKRLFHV� <HV� 1R� RU &DQFHO�

v &OLFN <HV WR VDYH FKDQJHV WR WKH FXUUHQW GUDZLQJ EHIRUH FORVLQJ

'HVLJQHU� ,I \RX KDYH QRW SUHYLRXVO\ VDYHG WKH GUDZLQJ� WKH 6DYH $V

GLDORJ ER[ RSHQV� 7\SH D QDPH LQ WKH WH[W ER[ DQG SUHVV ENTER�

v &OLFN 1R WR FORVH 'HVLJQHU ZLWKRXW VDYLQJ FKDQJHV WR \RXU GUDZLQJ�

v &OLFN &DQFHO WR FDQFHO WKH ([LW FRPPDQG DQG UHWXUQ WR 'HVLJQHU�

Saving Copies of a File

7KH 6DYH $V FRPPDQG LQ WKH )LOH PHQX �NH\ERDUG VKRUWFXW CTRL+SHIFT+S�

OHWV \RX UHQDPH D GRFXPHQW VR WKDW \RX KDYH WKH RULJLQDO GRFXPHQW DQG D

QHZ YHUVLRQ� 7KLV RSWLRQ LV XVHIXO IRU PDNLQJ D FRS\ RI D ILOH�

To save a co py of a file

1 2Q WKH )LOH PHQX� FOLFN 6DYH $V� 7KH 6DYH $V GLDORJ ER[ RSHQV�

�.H\ERDUG VKRUWFXW CTRL+SHIFT+S�

2 7\SH D GLIIHUHQW ILOHQDPH IRU WKH GRFXPHQW FRS\�

3 &KRRVH WKH GULYH DQG IROGHU LQ ZKLFK \RX ZDQW WR VWRUH WKH FRS\�
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4 &OLFN 6DYH� $ FRS\ RI WKH GRFXPHQW LV VWRUHG ZLWK WKH QHZ ILOHQDPH�

To revert to a saved file

1 2Q WKH )LOH PHQX� FOLFN 5HYHUW 7R 6DYHG� 'HVLJQHU DVNV LI \RX DUH VXUH

\RX ZDQW WR LJQRUH DOO FKDQJHV EHIRUH LW UHYHUWV WR WKH SUHYLRXV

YHUVLRQ�

2 &OLFN <HV WR RSHQ WKH PRVW UHFHQWO\ VDYHG YHUVLRQ RI WKH GRFXPHQW� RU

FOLFN 1R WR UHWXUQ WR WKH FXUUHQW GRFXPHQW�

1RWH

7KLV FRPPDQG UHVWRUHV WKH GRFXPHQW WR WKH PRVW UHFHQWO\ VDYHG YHUVLRQ�
XQGRLQJ DOO FKDQJHV PDGH VLQFH \RX ODVW VDYHG WKH ILOH�

Closing Designer

7KH ([LW FRPPDQG LQ WKH )LOH PHQX FORVHV 'HVLJQHU� 8VH WKLV FRPPDQG

ZKHQ \RX ILQLVK ZRUNLQJ ZLWK WKH SURJUDP RU ZKHQ \RX ZDQW WR IUHH

PHPRU\ WR ZRUN LQ DQRWKHU DSSOLFDWLRQ�

<RX FDQ FORVH 'HVLJQHU LQ RQH RI IRXU ZD\V�

v &KRRVH WKH ([LW FRPPDQG LQ WKH )LOH PHQX�

v &KRRVH WKH &ORVH FRPPDQG LQ WKH &RQWURO PHQX IRU 'HVLJQHU
V PDLQ

ZLQGRZ�

v 'RXEOH FOLFN WKH &RQWURO PHQX ER[ RI 'HVLJQHU
V PDLQ ZLQGRZ�

v 3UHVV ALT+F4�

,I DQ\ RI WKH ILOHV \RX DUH ZRUNLQJ ZLWK KDYH FKDQJHV� DQG \RX KDYH QRW VDYHG

WKHP EHIRUH FORVLQJ 'HVLJQHU� WKH 6DYH &KDQJHV GLDORJ ER[ RSHQV DQG

UHTXHVWV WKDW \RX VHOHFW RQH RI WKUHH FKRLFHV� <HV� 1R� RU &DQFHO�

v <HV VDYHV FKDQJHV WR WKH FXUUHQW GUDZLQJ EHIRUH FORVLQJ 'HVLJQHU� ,I

\RX KDYH QRW SUHYLRXVO\ VDYHG WKH GUDZLQJ� WKH 6DYH $V GLDORJ ER[

RSHQV� 7\SH D QDPH LQ WKH WH[W ER[ DQG SUHVV HQWHU�

v 1R FORVHV 'HVLJQHU ZLWKRXW VDYLQJ FKDQJHV WR \RXU GUDZLQJ�

v &DQFHO FDQFHOV WKH ([LW FRPPDQG DQG UHWXUQV \RX WR 'HVLJQHU�
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To close Desi gner

v 2Q WKH )LOH PHQX� FOLFN ([LW� �.H\ERDUG VKRUWFXW ALT+F4�� RU

v 2Q 'HVLJQHUjV WLWOH EDU� FOLFN WKH �;� &ORVH EXWWRQ�
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Importing and Exporting Files

'HVLJQHU XVHV WKH L*UDI[ 6KDUH 0HGLD WR LPSRUW IURP DQG H[SRUW WR

VWDQGDUG ILOH�IRUPDWV IRU YHFWRU JUDSKLFV� ELWPDS JUDSKLFV� DQG WH[W� 7KLV

IHDWXUH OHWV \RX XVH DQG VKDUH ILOHV FUHDWHG RU XVHG E\ RWKHU DSSOLFDWLRQV�

Import/ Export Filters

7KH LQVWDOODWLRQ &' LQFOXGHV ILOWHUV �VRPHWLPHV NQRZQ DV FRQYHUWHUV RU

WUDQVODWRUV� IRU PDQ\ GLIIHUHQW ILOH IRUPDWV� :KHQ \RX LPSRUW D ILOH� WKH 6KDUH

0HGLD XVHV D ILOWHU WR FRQYHUW WKH ILOH FUHDWHG ZLWK DQRWKHU DSSOLFDWLRQ LQWR

'HVLJQHU
V IRUPDW� :KHQ \RX H[SRUW� D ILOWHU LV XVHG WR FRQYHUW WKH ILOH LQWR

DQRWKHU SURJUDP
V IRUPDW�

1RWH

'HVLJQHU FDQ RSHQ '6)� '6�� '5:� *5)� DQG 0*; ILOHV� <RX DOVR FDQ
LPSRUW DQ\ RI WKHVH ILOH W\SHV�

Multi ple pages and la yers durin g im port/ex port

:KHQ \RX LPSRUW D ILOH ZLWK PRUH WKDQ RQH SDJH �VXFK DV '6)� '6�� '5:�

RU 0*;�� RQO\ WKH REMHFWV RQ WKH ILUVW SDJH DUH LPSRUWHG� 7KH LPSRUWHG

REMHFWV DUH DGGHG WR WKH FXUUHQW SDJH DQG OD\HU LQ 'HVLJQHU�

:KHQ \RX LPSRUW D ILOH ZLWK PRUH WKDQ RQH OD\HU �VXFK DV '6�� '5:� RU

0*;�� DOO WKH REMHFWV RQ DOO WKH OD\HUV DUH LPSRUWHG� +RZHYHU� WKH LPSRUWHG

REMHFWV DUH DGGHG WR WKH FXUUHQW SDJH DQG OD\HU LQ 'HVLJQHU� WKH LPSRUWHG

REMHFWV DUH QR ORQJHU RQ VHSDUDWH OD\HUV�

:KHQ \RX XVH WKH &XVWRP ,QVWDOODWLRQ RSWLRQ� WKH 0LFURJUDI[ ,QVWDOOHU OHWV

\RX LQVWDOO RQO\ WKH ILOWHUV� IRQWV� DQG FOLS DUW WKDW \RX QHHG� ,I \RX QHHG D ILOWHU

WKDW LV QRW LQVWDOOHG� UXQ WKH ,QVWDOOHU DJDLQ� FKRRVH &XVWRP ,QVWDOODWLRQ� DQG

LQVWDOO LW�
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1HZ ILOWHUV DUH GHYHORSHG DQG DGGHG WR 'HVLJQHU IURP WLPH WR WLPH�

1RWH

,I \RX GR QRW KDYH WKH ILOWHU IRU D VSHFLILF IRUPDW� WKDW IRUPDW ZLOO EH PLVVLQJ
LQ WKH ,PSRUW�([SRUW GLDORJ ER[HV� 8VH WKH :LQGRZV 1RWHSDG WR H[DPLQH
WKH ILOH 0*;;/$7(�/2* LQ \RXU :LQGRZV IROGHU� 7KDW ILOH FRQWDLQV D ORJ
RI DQ\ LPSRUW�H[SRUW SUREOHPV� <RX PD\ QHHG WR UHLQVWDOO L*UDI[ 'HVLJQHU
ZLWK D &XVWRP LQVWDOODWLRQ� WR PDNH VXUH DOO WKH ILOWHUV DUH LQVWDOOHG�
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Importing Files

7KH ,PSRUW FRPPDQG �NH\ERDUG VKRUWFXW CTRL+1� OHWV \RX LPSRUW JUDSKLF

DQG WH[W ILOHV LQWR 'HVLJQHU� 'HVLJQHU FDQ LPSRUW WKH IROORZLQJ ILOH W\SHV�

([WHQVLRQ 'HVFULSWLRQ

$%& $%& )ORZ&KDUWHU

$)� $%& )ORZ&KDUWHU ���

$)� $%& )ORZ&KDUWHU ���

$, $GREH ,OOXVWUDWRU

%03 :LQGRZV %LWPDS

&'5 &RUHO'5$:� ���

&*0 &RPSXWHU *UDSKLFV 0HWDILOH

&0; &RUHO &OLSDUW )RUPDW

&70 &OHDU 7H[W &*0

'*1 0LFUR6WDWLRQ 'HVLJQHU )LOH

',% :LQGRZV ',%

'5: 0LFURJUDI[ GUDZLQJ

':) $XWR'HVN 'UDZLQJ :HE )RUPDW

':* $XWR&$' 'UDZLQJ )LOH �����

';) $XWR'HVN $XWR&$'

(0) :LQGRZV (QKDQFHG 0HWDILOH

(36 $GREH ,OOXVWUDWRU (QFDSVXODWHG 3RVW6FULSW

)/2 )ORZ&KDUWHU

)3; )3; )RUPDW

*(0 *(0 0HWDILOH �*(0 'UDZ� $UWOLQH�

*,) &RPSX6HUYH ELWPDS
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+*/ +3 *UDSKLFV /DQJXDJH

,*6 ,*(6 'UDZLQJ

,*; L*UDI[ 3URIHVVLRQDO

-3* -3(* �-RLQW 3KRWRJUDSKLF ([SHUWV *URXS� ELWPDS

3&' .RGDN 3KRWR &' ELWPDS

3&7 0DFLQWRVK 3,&7

3&; =6RIW ELWPDS �3& 3DLQWEUXVK�

3') $GREH $FUREDW

3)' 2SWLPD

31* &RPSX6HUYH 31*

33� L*UDI[ ,PDJH � 0*; 3LFW3XE ���

33� L*UDI[ ,PDJH � 0*; 3LFW3XE ���

33) L*UDI[ ,PDJH � 0*; 3LFW3XE

36 3RVW 6FULSW

36' $GREH 3KRWRVKRS

5$6 6XQ 5DVWHU

6�' L*UDI[ �' � 0LFURJUDI[ �'

6&7 6FLWH[ &7

7*$ 7DUJD ELWPDS

7,) 7,)) �7DJ ,PDJH )LOH )RUPDW� ELWPDS

96' 9LVLR 'UDZLQJ

:0) :LQGRZV 0HWDILOH

:3* :RUG3HUIHFW RU 'UDZ3HUIHFW JUDSKLFV

([WHQVLRQ 'HVFULSWLRQ
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1RWH

'HVLJQHU FDQ RSHQ '6)� '6�� '5:� *5)� DQG 0*; ILOHV� <RX DOVR FDQ
LPSRUW DQ\ RI WKHVH ILOH W\SHV�

Multi ple pages and la yers durin g im port

:KHQ \RX LPSRUW D ILOH ZLWK PRUH WKDQ RQH SDJH �VXFK DV '6)� '6�� '5:�

RU 0*;�� RQO\ WKH REMHFWV RQ WKH ILUVW SDJH DUH LPSRUWHG� 7KH LPSRUWHG

REMHFWV DUH DGGHG WR WKH FXUUHQW SDJH DQG OD\HU LQ 'HVLJQHU�

:KHQ \RX LPSRUW D ILOH ZLWK PRUH WKDQ RQH OD\HU �VXFK DV '6�� '5:� RU

0*;�� DOO WKH REMHFWV RQ DOO WKH OD\HUV DUH LPSRUWHG� +RZHYHU� WKH LPSRUWHG

REMHFWV DUH DGGHG WR WKH FXUUHQW SDJH DQG OD\HU LQ 'HVLJQHU� WKH LPSRUWHG

REMHFWV DUH QR ORQJHU RQ VHSDUDWH OD\HUV�

1RWH

'HVLJQHU FDQ RSHQ '6)� '6�� '5:� *5)� DQG 0*; ILOHV� <RX DOVR FDQ
LPSRUW DQ\ RI WKHVH ILOH W\SHV�

To im port a file

1 2Q WKH )LOH PHQX� FOLFN ,PSRUW� 7KH ,PSRUW GLDORJ ER[ RSHQV�

2 &OLFN WKH GRZQ DUURZ LQ WKH )LOHV RI 7\SH OLVW ER[�

3 &KRRVH WKH W\SH RI ILOH \RX ZDQW WR LPSRUW�

4 &KDQJH WR WKH GULYH DQG IROGHU \RX ZDQW�

5 +LJKOLJKW WKH QDPH RI WKH ILOH \RX ZDQW WR LPSRUW�

6 &OLFN 6HWXS LI \RX ZDQW WR FKDQJH LPSRUW VHWWLQJV �LI DYDLODEOH��
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7 &OLFN ,PSRUW� 7KH GLDORJ ER[ FORVHV DQG WKH LPSRUWHG ILOH DSSHDUV LQ

WKH GUDZLQJ DUHD�

1RWH

,I \RX VNLS VWHS �� 'HVLJQHU XVHV WKH VHWWLQJV SUHYLRXVO\ XVHG ZKHQ
LPSRUWLQJ WKLV ILOH W\SH� 7KH DYDLODEOH LPSRUW VHWWLQJV YDU\ GHSHQGLQJ RQ WKH
ILOH W\SH \RX ZDQW WR LPSRUW�

7LS

)LOHV LQ WKH +HZOHWW�3DFNDUG *UDSKLFV /DQJXDJH �+3*/� IRUPDW DUH
VRPHWLPHV QDPHG ZLWK D 3/7 �SORWWHU� H[WHQVLRQ� %HIRUH LPSRUWLQJ D
SORWWHU ILOH� PDNH VXUH LW KDV D 3/7 H[WHQVLRQ VR WKDW 'HVLJQHU ZLOO OLVW LW LQ
WKH ,PSRUW GLDORJ ER[�

Exporting Files

7KH ([SRUW FRPPDQG �NH\ERDUG VKRUWFXW CTRL+2� OHWV \RX H[SRUW

'HVLJQHU ILOHV IRU XVH LQ RWKHU SURJUDPV� 'HVLJQHU FDQ H[SRUW WKH IROORZLQJ

ILOH W\SHV� 6HH ,PSRUWLQJ )LOHV IRU D OLVW RI ILOH H[WHQVLRQV DQG GHVFULSWLRQV�

([WHQVLRQ 'HVFULSWLRQ

$%& $%& )ORZ&KDUWHU

$)� $%& )ORZ&KDUWHU ���

$)� $%& )ORZ&KDUWHU ���

$, $GREH ,OOXVWUDWRU

%03 :LQGRZV %LWPDS

&'5 &RUHO'5$:� ���

&*0 &RPSXWHU *UDSKLFV 0HWDILOH

&0; &RUHO &OLSDUW )RUPDW
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(QFDSVXODWHG 3RVW6FULSW ILOHV FDQ EH H[SRUWHG LQ RQH RI IRXU ZD\V� ZLWK QR

KHDGHU RU SUHYLHZ� ZLWK QR SUHYLHZ� ZLWK D 7,)) SUHYLHZ� RU ZLWK D :0)

SUHYLHZ� ,I \RX SODQ WR H[SRUW DQ (36 ILOH DQG LPSRUW LW LQWR D 0DFLQWRVK

DSSOLFDWLRQ �ZKLFK LV W\SLFDO ZKHQ VHQGLQJ ILOHV WR D VHUYLFH EXUHDX�� \RX

VKRXOG H[SRUW ZLWK QR KHDGHU RU SUHYLHZ�

1RWH

6HYHUDO VHWWLQJV LQ WKH 'HVLJQHU UHJLVWU\ HQWULHV FRQWURO KRZ 'HVLJQHU ILOHV
DUH H[SRUWHG� )RU PRUH LQIRUPDWLRQ� UHIHU WR .H\ QDPH� 7UDQVODWLRQ LQ WKH KHOS
WRSLF 'HVLJQHU UHJLVWU\ NH\V DQG YDOXHV�

Multi ple pages and la yers durin g expor t

:KHQ \RX H[SRUW D 'HVLJQHU ILOH ZLWK PRUH WKDQ RQH SDJH� RQO\ WKH REMHFWV

RQ WKH FXUUHQW SDJH DUH H[SRUWHG� ,I DQ\ REMHFWV DUH VHOHFWHG RQ WKH FXUUHQW

SDJH� RQO\ WKH VHOHFWHG REMHFWV DUH H[SRUWHG�

&70 &OHDU 7H[W &*0

'*1 0LFUR6WDWLRQ 'HVLJQHU )LOH

',% :LQGRZV ',%

'5: 0LFURJUDI[ GUDZLQJ

':) $XWR'HVN 'UDZLQJ :HE )RUPDW

':* $XWR&$' 'UDZLQJ )LOH �����

';) $XWR'HVN $XWR&$'

(0) :LQGRZV (QKDQFHG 0HWDILOH

(36 $GREH ,OOXVWUDWRU (QFDSVXODWHG 3RVW6FULSW

)/2 )ORZ&KDUWHU

)3; )3; )RUPDW

([WHQVLRQ 'HVFULSWLRQ
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:KHQ \RX H[SRUW D 'HVLJQHU ILOH ZLWK PRUH WKDQ RQH OD\HU WR WKH '6)� '6��

RU '5: ILOH W\SH� VHOHFWHG REMHFWV �HYHQ WKRVH RQ PXOWLSOH OD\HUV� DUH

H[SRUWHG WR RQH OD\HU� ,I QR REMHFWV DUH VHOHFWHG� DOO OD\HUV DQG REMHFWV DUH

H[SRUWHG� DQG WKH PXOWLSOH OD\HUV DUH UHWDLQHG�

:KHQ \RX H[SRUW D 'HVLJQHU ILOH WR DQ\ ILOH W\SH RWKHU WKDQ '6)� '6�� RU

'5:� DOO REMHFWV RQ WKH FXUUHQW SDJH DUH H[SRUWHG WR RQH OD\HU�

1RWHV

7R VHOHFW REMHFWV RQ PXOWLSOH OD\HUV SULRU WR H[SRUW� RSHQ WKH /D\HUV GLDORJ
ER[� VHOHFW (GLW $OO /D\HUV� FORVH WKH GLDORJ ER[� DQG WKHQ VHOHFW WKH GHVLUHG
REMHFWV RQ WKH GHVLUHG OD\HUV RI WKH FXUUHQW SDJH�

'HVLJQHU FDQ VDYH WR '6� �9HUVLRQ ��[� DQG 0*; �0LFURJUDI[ FOLS DUW�
ILOHV� <RX FDQ DOVR H[SRUW WR '6) LI QHHGHG�

To export a file

1 6HOHFW WKH REMHFWV \RX ZDQW WR H[SRUW� ,I QR REMHFWV DUH VHOHFWHG� WKH

HQWLUH SDJH LV H[SRUWHG�

2 2Q WKH )LOH PHQX� FOLFN ([SRUW� 7KH ([SRUW GLDORJ ER[ RSHQV�

3 &KRRVH D GULYH DQG IROGHU IRU WKH H[SRUWHG ILOH
V GHVWLQDWLRQ� LI

QHFHVVDU\�

4 7\SH D QDPH IRU WKH ILOH�

5 &OLFN WKH GRZQ DUURZ LQ WKH 6DYH DV 7\SH OLVW ER[�

6 &KRRVH WKH W\SH RI ILOH \RX ZDQW WR H[SRUW� 'HVLJQHU DXWRPDWLFDOO\

DGGV WKH SURSHU H[WHQVLRQ WR WKH ILOHQDPH�

7 &OLFN 6HWXS LI \RX ZDQW WR FKDQJH H[SRUW VHWWLQJV �LI DYDLODEOH��

8 &OLFN ([SRUW� 'HVLJQHU H[SRUWV WKH ILOH LQ WKH FKRVHQ IRUPDW�

1RWH

,I \RX VNLS VWHS �� 'HVLJQHU XVHV WKH VHWWLQJV SUHYLRXVO\ XVHG ZKHQ
H[SRUWLQJ WKLV ILOH W\SH� 7KH DYDLODEOH H[SRUW VHWWLQJV YDU\
GHSHQGLQJ RQ WKH ILOH W\SH \RX ZDQW WR H[SRUW�
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Drawing Objects
What is a Designer Object?

$Q REMHFW LV WKH EDVLF HOHPHQW RI D 'HVLJQHU GUDZLQJ� 'HVLJQHU REMHFWV DUH

YHFWRU�EDVHG� WKHLU VKDSHV DQG SRVLWLRQV DUH GHILQHG JHRPHWULFDOO\� 8QOLNH

ELWPDSSHG REMHFWV� YHFWRU�EDVHG REMHFWV FDQ EH UHVL]HG ZLWK QR ORVV RI

LPDJH TXDOLW\� 7KH\ SULQW DW WKH UHVROXWLRQ RI WKH SULQWHU� DQG WKH\ DUH

GLVSOD\HG DW WKH UHVROXWLRQ RI WKH GLVSOD\ GHYLFH�

<RX FUHDWH GUDZLQJV E\ GUDZLQJ� DUUDQJLQJ� DQG HGLWLQJ REMHFWV� <RX FDQ

PDQLSXODWH REMHFWV LQ D YDULHW\ RI ZD\V WR HQKDQFH DQG KHOS RUJDQL]H \RXU

GUDZLQJ� )RU H[DPSOH� REMHFWV FDQ EH FRORUHG� FRPELQHG� GXSOLFDWHG� DQG

HQODUJHG�
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Basics of Drawing

'UDZLQJ ZLWK 'HVLJQHU LV HDV\� <RX VHOHFW WKH VKDSH \RX ZDQW WR GUDZ� DQG

WKHQ GUDJ WKH PRXVH WR GUDZ WKH REMHFW� 'HVLJQHU JLYHV \RX WKH SUHFLVLRQ

DQG IOH[LELOLW\ \RX QHHG WR GUDZ DOPRVW DQ\ VKDSH LPDJLQDEOH�

'HVLJQHU JLYHV \RX WKUHH GLIIHUHQW RSWLRQV IRU GUDZLQJ REMHFWV�

Drawing with the Toolbar and Ribbon

7KHUH DUH ILYH SULPDU\ VKDSH WRROV RQ WKH 'HVLJQHU WRROEDU� &OLFN RQ DQ\

VKDSH WR UHYHDO D GUDZLQJ ULEERQ�

)URP WKH GUDZLQJ ULEERQ� VHOHFW WKH GUDZLQJ EXWWRQ PRVW DSSURSULDWH IRU

\RXU 'HVLJQHU SURMHFW�

To draw an ob ject usin g the ribbon

1 &OLFN WKH 6LPSOH /LQH WRRO LQ WKH WRROER[�

2 &OLFN D GUDZLQJ PHWKRG� )RU H[DPSOH� FOLFN WKH /LQH 6HJPHQW EXWWRQ

WR GUDZ D VWUDLJKW OLQH�

3 0RYH WKH SRLQWHU RQWR WKH GUDZLQJ DUHD DQG GUDJ WR FUHDWH WKH

GHVLUHG REMHFW�

7LS

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

To draw usin g the last drawin g method

:KHQ WKH SRLQWHU LV D VHOHFW SRLQWHU� \RX FDQ DXWRPDWLFDOO\ UHWXUQ WR WKH

SUHYLRXV GUDZLQJ PHWKRG�

1 3RLQW WR DQ HPSW\ DUHD DQG GRXEOH FOLFN WKH OHIW PRXVH EXWWRQ�
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2 <RXU FXUVRU FKDQJHV EDFN WR WKH ODVW GUDZLQJ WRRO XVHG� 'UDJ WR FUHDWH

DQ REMHFW�

To draw with crosshairs

` 3UHVV WKH NH\ERDUG VKRUWFXW CTRL+H WR WXUQ FURVVKDLUV RQ RU RII�

Canceling and Redoing an Action6RPHWLPHV \RX ZLOO ZDQW

WR VWRS DQ DFWLRQ WKDW \RX KDYH QRW \HW ILQLVKHG� RU XQGR WKH ODVW FKDQJH \RX

PDGH� ,I \RX FKDQJH \RXU PLQG DIWHU XQGRLQJ DQ DFWLRQ� \RX FDQ UHGR LW�

8VH WKH ESC NH\ WR LQWHUUXSW DQ DFWLRQ EHIRUH \RX FRPSOHWH LW�

8VH 8QGR WR UHYHUVH DQ DFWLRQ� RU HYHQW� WKDW \RX MXVW FRPSOHWHG �NH\ERDUG

VKRUWFXW CTRL+Z�� <RX FDQ XQGR XS WR ��� RI WKH ODVW HYHQWV� GHSHQGLQJ RQ

WKH XQGR HYHQW OLPLW VHWWLQJ�

8VH 5HGR WR UHGR DQ DFWLRQ�

7LS

8QGR DQG 5HGR DIIHFW RQO\ DFWLRQV WKDW KDYH RFFXUUHG VLQFH WKH ODVW
WLPH \RX VDYHG WKH GUDZLQJ� )RU H[DPSOH� LI \RX PRYH DQ REMHFW DQG
WKHQ VDYH WKH GUDZLQJ� \RX FDQQRW XQGR WKH PRYH�

8VH WKH 5HVHW 7UDQVIRUP FRPPDQG WR UHPRYH DOO WUDQVIRUPDWLRQV� VXFK DV

PRYHPHQWV RU URWDWLRQV� IURP VHOHFWHG REMHFWV� 5HVHWWLQJ DQ REMHFW

WUDQVIRUPDWLRQ�

v 5HWXUQV WKH REMHFW WR LWV RULJLQDOO\ GUDZQ SRVLWLRQ DQG VL]H�

v 5HPRYHV DOO VNHZV DQG URWDWLRQV WKDW \RX KDYH DSSOLHG�

v 5HPRYHV ZDUSV�

v 5HWXUQV WKH RULJLQ WR WKH REMHFWjV FHQWHU�

7LS

)LOOV DQG UHVKDSHG SRLQWV DUH QRW DIIHFWHG E\ 5HVHW 7UDQVIRUP� $OVR�
GXSOLFDWLQJ DQ REMHFW LV D WUDQVIRUPDWLRQ WKDW FDQQRW EH UHVHW�
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To cancel an action before com pletin g it

` 3UHVV WKH ESC NH\�

7LS

,I \RX DUH GUDZLQJ D OLQH EXW GHFLGH \RX GRQjW ZDQW WR GUDZ LW DIWHU
DOO� SUHVV ESC� ,I \RX DUH PRYLQJ DQ REMHFW EXW GHFLGH WR FDQFHO WKH PRYH�
SUHVV ESC DQG WKH REMHFW UHWXUQV WR LWV RULJLQDO SRVLWLRQ�

To undo an action

` 2Q WKH (GLW PHQX� FOLFN 8QGR�

RU

8VH WKH NH\ERDUG VKRUWFXW CTRL�=�

7LS

<RX FDQ VHW WKH XQGR HYHQW OLPLW RQ WKH *HQHUDO WDE RI WKH 2SWLRQV GLDORJ
ER[ �RQ WKH 7RROV PHQX� FOLFN 2SWLRQV� DQG FOLFN *HQHUDO��

To redo an action

` 2Q WKH (GLW PHQX� FOLFN 5HGR �NH\ERDUG VKRUWFXW CTRL+SHIFT+Z��

7LS

<RX FDQ VHW WKH XQGR HYHQW�OLPLW RQ WKH *HQHUDO WDE RI WKH 2SWLRQV GLDORJ
ER[ �RQ WKH 7RROV PHQX� FOLFN 2SWLRQV��

Resetting an Object Transformation

8VH WKH 5HVHW 7UDQVIRUP FRPPDQG WR UHPRYH DOO WUDQVIRUPDWLRQV� VXFK DV

PRYHPHQWV RU URWDWLRQV� IURP VHOHFWHG REMHFWV� 7R UHVHW D WUDQVIRUPDWLRQ�

VHOHFW WKH REMHFWV WR UHVHW� RSHQ WKH &KDQJH PHQX� DQG FKRRVH 5HVHW

7UDQVIRUP�
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v 5HVHWWLQJ DQ REMHFW WUDQVIRUPDWLRQ�

v 5HWXUQV DQ REMHFW WR LWV RULJLQDOO\ GUDZQ SRVLWLRQ DQG VL]H�

v 5HPRYHV DOO VNHZV DQG URWDWLRQV WKDW \RX KDYH DSSOLHG�

v 5HPRYHV ZDUSV�

v 5HWXUQV WKH RULJLQ WR WKH REMHFW
V FHQWHU�

1RWH

)LOOV DQG UHVKDSHG SRLQWV DUH QRW DIIHFWHG E\ 5HVHW 7UDQVIRUP� $OVR�
GXSOLFDWLQJ DQ REMHFW LV QRW D WUDQVIRUPDWLRQ WKDW FDQ EH UHVHW�

To reset an ob ject transformation

1 6HOHFW WKH REMHFWV WR UHVHW�

2 2Q WKH $UUDQJH PHQX� FOLFN 5HVHW 7UDQVIRUP�
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Drawing with the Constraint Tools

7KH &RQVWUDLQW WRROV UHVWULFW� RU FRQVWUDLQ� WKH ZD\ LQ ZKLFK REMHFWV DUH

GUDZQ� $ VHOHFWHG EXWWRQ UHPDLQV RQ XQWLO \RX FOLFN LW DJDLQ WR WXUQ LW RII�

Constraining with the Keyboard

<RX FDQ XVH NH\VWURNHV WR DFWLYDWH FRQVWUDLQWV� .H\VWURNHV DFWLYDWH D

FRQVWUDLQW RQO\ ZKLOH WKH NH\ LV SUHVVHG�

<RX FDQ XVH D NH\ WR WRJJOH WKH HIIHFW RI D FRQVWUDLQW EXWWRQ� )RU H[DPSOH� LI

\RX SUHVV DQG KROG CTRL ZKLOH WKH $QJOH &RQVWUDLQW EXWWRQ LV VHOHFWHG� \RX

WXUQ RII WKH FRQVWUDLQW�

Constraining to a 15-degree Angle

<RX FDQ XVH WKH $QJOH &RQVWUDLQW EXWWRQ �RU SUHVV 6KLIW� WR IRUFH OLQHV WR

GUDZ DW D ���GHJUHH DQJOH� 7KLV FRQVWUDLQW LV XVHIXO IRU GUDZLQJ OLQHV �DQG

REMHFW HGJHV� WKDW DUH SHUIHFWO\ KRUL]RQWDO RU YHUWLFDO�

Constraining to a Square or Circle

8VH WKH 3URSRUWLRQDO &RQVWUDLQW EXWWRQ �RU SUHVV 6KLIW� WR IRUFH UHFWDQJXODU

RU HOOLSWLFDO VKDSHV WR GUDZ DV VTXDUHV RU FLUFOHV� UHVSHFWLYHO\�

Reversing the Drawing Direction

8VH WKH 5HYHUVH 'LUHFWLRQ EXWWRQ �RU SUHVV CTRL� WR UHYHUVH WKH GLUHFWLRQ

'HVLJQHU QRUPDOO\ GUDZV REMHFWV FUHDWHG IURP D VLQJOH VLGH �IRU H[DPSOH�

GUDZLQJ D VTXDUH IURP D VLQJOH VLGH�� 6HH WKH VSHFLILF GUDZLQJ PHWKRG \RX DUH

XVLQJ IRU GHWDLOV�
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Using the From Center Button

8VH WKH )URP &HQWHU EXWWRQ �RU SUHVV CTRL� WR IRUFH 'HVLJQHU WR GUDZ WKH

REMHFW IURP WKH FHQWHU RXWZDUG� 'UDZLQJ IURP WKH FHQWHU FDQ EH XVHIXO

ZKHQ \RX ZDQW WKH FHQWHU RI WKH REMHFW WR EH DW D SDUWLFXODU SRLQW�
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Drawing with Snap Points

<RX FDQ XVH REMHFW VQDS WR kVQDS�y RU DWWUDFW� WKH HQG RI D OLQH WR D SRLQW RQ

D REMHFW� 7KHVH SRLQWV� RU VQDS SRLQWV� DWWUDFW WKH HQGV RI OLQHV OLNH D PDJQHW

ZKHQ WKH\ DUH QHDU�

6QDS SRLQWV DSSHDU DV VPDOO UHG VTXDUHV RQ D REMHFW� <RX FDQ XVH VQDS SRLQWV

WR GUDZ D OLQH RU RWKHU REMHFW WKDW SHUIHFWO\ WRXFKHV WKH REMHFW� 6QDS SRLQWV

FDQ KHOS VKRZ WKH V\PPHWULFDO IRUP RI D REMHFW ZKHQ \RX QHHG WR GUDZ� IRU

H[DPSOH� D OLQH WKURXJK WKH H[DFW FHQWHU RI D FLUFOH� 6QDS SRLQWV DSSHDU RQO\

RQ WKH ERXQGLQJ ER[ RI WH[W DQG ZDUSHG REMHFWV�

�

1RWH

6QDS SRLQWV DUH QRW DWWDFKHG WR DQ REMHFW DQG GR QRW PRYH ZKHQ WKH
REMHFW LV PRYHG RU GHOHWHG�

6QDS 3RLQWV
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Adding Snap Points to an Object

&OLFN WKH $GG 6QDS 3RLQWV EXWWRQ LQ WKH (GLW ULEERQ WR DGG VQDS SRLQWV WR

VHOHFWHG REMHFWV �NH\ERDUG VKRUWFXW CTRL+N�� <RX FDQ DOVR FOLFN WKH 6QDS

3RLQWV EXWWRQ LQ WKH VWDWXV EDU� LI GLVSOD\HG� 6QDS SRLQWV DUH SODFHG DW WKH

ORFDWLRQV VHOHFWHG LQ WKH 5XOHUV�6QDS SDQHO RI WKH 3UHIHUHQFHV GLDORJ ER[�

To add sna p points to an ob ject

1 6HOHFW WKH REMHFWV \RX ZDQW WR KDYH VQDS SRLQWV�

2 &OLFN WKH $GG 6QDS 3RLQWV EXWWRQ LQ WKH PHQX EDU� 6QDS SRLQWV DUH

SODFHG DW WKH ORFDWLRQV VHOHFWHG RQ WKH 5XOHUV�6QDS WDE RI WKH 2SWLRQV

GLDORJ ER[�

7LS

<RX FDQ VHOHFW $GG 6QDS 3RLQWV ZLWK WKH NH\ERDUG XVLQJ CTRL+F7

Removing Snap Points from an Object

&OLFN WKH 5HPRYH 6QDS SRLQWV EXWWRQ LQ WKH (GLW ULEERQ WR UHPRYH DOO VQDS

SRLQWV IURP WKH GUDZLQJ DUHD? �NH\ERDUG VKRUWFXW CTRL�VKLIW�Q�� <RX FDQ

DOVR FOLFN WKH 6QDS 3RLQWV EXWWRQ LQ WKH VWDWXV EDU� LI GLVSOD\HG�

)RU LQVWUXFWLRQV RQ VHWWLQJ VQDS SRLQW RSWLRQV� VHH k6HWWLQJ 3UHIHUHQFHVy LQ

&KDSWHU ��
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To remove sna p points

` &OLFN WKH 5HPRYH 6QDS 3RLQWV EXWWRQ LQ WKH PHQX EDU� $OO VQDS

SRLQWV IURP WKH GUDZLQJ DUHD DUH UHPRYHG�

7LS

<RX FDQ VHOHFW 5HPRYH 6QDS 3RLQWV ZLWK WKH NH\ERDUG XVLQJ
CTRL+SHIFT+F7 <RX FDQ DOVR FOLFN WKH 6QDS 3RLQWV EXWWRQ RQ WKH
VWDWXV EDU� LI GLVSOD\HG�

Using Connect-A-Draw

&RQQHFW�$�'UDZ LV D 'HVLJQHU IHDWXUH WKDW PDNHV LW HDV\ WR FKDLQ WKH HQGV

RI RSHQ REMHFWV DV \RX GUDZ WKHP� <RX FDQ XVH WKLV PHWKRG WR FUHDWH DQ

REMHFW PDGH RI VHYHUDO GLIIHUHQW OLQH W\SHV� )RU H[DPSOH� \RX FDQ GUDZ D

VWUDLJKW OLQH� WKHQ FKDLQ LW WR D FXUYH� WKHQ FKDLQ LW WR D IUHHKDQG REMHFW� DQG

VR RQ�

To chain lines while drawin g

1 'UDZ D VHJPHQW RI WKH OLQH�

2 6HOHFW D GLIIHUHQW GUDZLQJ PHWKRG� LI \RX ZLVK� +ROORZ ER[HV DSSHDU DW

ERWK HQGV RI WKH OLQH�

3 3RLQW WR D KROORZ ER[ DW RQH HQG RI WKH OLQH DQG GUDZ WKH QH[W SRUWLRQ

RI WKH REMHFW�

4 5HSHDW VWHSV � DQG � WR FKDLQ PRUH VHJPHQWV�
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To chain an existin g open ob ject

1 6HOHFW WKH REMHFW \RX ZDQW WR DXJPHQW�

2 6HOHFW D GUDZLQJ PHWKRG� +ROORZ ER[HV DSSHDU DW ERWK HQGV RI WKH

OLQH ZKHQ DQ DSSOLFDEOH PHWKRG LV VHOHFWHG�

3 3RLQW WR D ER[ DW RQH HQG RI WKH OLQH DQG GUDZ WKH QH[W SRUWLRQ RI WKH

REMHFW�

4 5HSHDW VWHSV � DQG � WR FKDLQ PRUH VHJPHQWV�
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Choosing Drawing Shapes and Objects

(YHU\ 'HVLJQHU GUDZLQJ LV OLWWOH PRUH WKDQ D FRPSRVLWLRQ RI VKDSHV DQG

REMHFWV� 7KH GHVLJQHU WRROEDU LV FRPSRVHG RI EXWWRQV WKDW OHW \RX FUHDWH DQ\

VKDSH RU REMHFW LPDJLQDEOH� <RXU 'HVLJQHU VKDSH DQG REMHFWV FDQ EHJLQ

VLPSO\ DQG GHYHORS LQWR XQLTXH DQG IXQFWLRQDO JUDSKLFV DFFRUGLQJ WR \RXU

RZQ VSHFLILFDWLRQV�

7KH VWDQGDUG 'HVLJQHU VKDSHV DQG REMHFWV DUH DV IROORZV�

v 6LPSOH /LQHV

v &RPSRXQG /LQHV

v 6WLFN\ /LQHV

v 5HFWDQJOHV

v 3RO\JRQV

v (OOLSVHV

Drawing Simple Lines

&OLFN WKH 6LPSOH /LQH WRRO �NH\ERDUG VKRUWFXW CTRL+D� WR GLVSOD\ WKH VLPSOH

OLQH GUDZLQJ EXWWRQV LQ WKH ULEERQ DW WKH WRS RI WKH 'HVLJQHU ZLQGRZ� 7KHVH

EXWWRQV DUH XVHG WR GUDZ FXUYHV� UHFWDQJOHV� SRO\JRQV� DQG HOOLSVHV�

To draw a sim ple line se gment

7KH /LQH 6HJPHQW EXWWRQ GUDZV VLQJOH� VWUDLJKW OLQHV�

1 &OLFN WKH 6LPSOH /LQH WRRO LQ WKH WRROER[�

/LQH 6HJPHQW

3DUDOOHO /LQH

3HUSHQGLFXODU /LQH

4XDUWHU $UF

3DUDEROD
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2 &OLFN WKH /LQH 6HJPHQW EXWWRQ LQ WKH ULEERQ�

3 0RYH WKH SRLQWHU WR WKH GUDZLQJ DUHD�

4 'UDJ WR GUDZ WKH OLQH�

5 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK GUDZLQJ WKH OLQH�

7LSV

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

7R FRQVWUDLQ WKH OLQH WR D ���GHJUHH DQJOH� VHOHFW WKH $QJOH &RQVWUDLQW
EXWWRQ � 7R GUDZ IURP WKH FHQWHU RXWZDUG� SUHVV DQG KROG CTRL ZKLOH
GUDZLQJ RU VHOHFW WKH )URP &HQWHU EXWWRQ �

Drawing Parallel Lines

7KH 3DUDOOHO /LQH EXWWRQ GUDZV D OLQH WKDW LV SDUDOOHO RU WDQJHQW WR D OLQH

VHJPHQW� DUF� HOOLSVH� RU UHFWDQJOH�
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To draw a parallel or tan gent line

1 &OLFN WKH 6LPSOH /LQH WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH 6HJPHQW EXWWRQ LQ WKH ULEERQ�

3 'UDZ \RXU LQLWLDO OLQH VHJPHQW E\ GUDJJLQJ LW DFURVV \RXU 'HVLJQHU SDJH�

4 &OLFN WKH 3DUDOOHO /LQH EXWWRQ LQ WKH ULEERQ�

5 0RYH WKH SRLQWHU QHDU WKH REMHFW� DQG SUHVV DQG KROG WKH OHIW PRXVH

EXWWRQ�

6 'UDJ WKH SRLQWHU WKH GHVLUHG GLVWDQFH IURP WKH OLQH RU FXUYH WR GUDZ

WKH VHFRQG OLQH�

7 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK GUDZLQJ WKH OLQH�

7LS

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

Drawing Perpendicular Lines

7KH 3HUSHQGLFXODU /LQH EXWWRQ GUDZV D OLQH WKDW LV SHUSHQGLFXODU WR D

OLQH VHJPHQW� DUF� HOOLSVH� RU UHFWDQJOH�

To draw a perpendicular line

1 &OLFN WKH 6LPSOH /LQH WRRO LQ WKH WRROER[� LI QHFHVVDU\�

2 2Q WKH ULEERQ� FOLFN WKH /LQH 6HJPHQW EXWWRQ
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3 'UDZ \RXU LQLWLDO OLQH VHJPHQW E\ GUDJJLQJ LW DFURVV \RXU 'HVLJQHU SDJH�

4 2Q WKH ULEERQ� FOLFN WKH 3HUSHQGLFXODU /LQH EXWWRQ �

5 0RYH WKH SRLQWHU QHDU \RXU ILUVW OLQH� DQG SUHVV DQG KROG WKH OHIW

PRXVH EXWWRQ�

6 'UDJ WKH SRLQWHU WKH GHVLUHG GLVWDQFH IURP WKH OLQH RU FXUYH WR GUDZ

WKH OLQH�

7 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK GUDZLQJ WKH OLQH�

7LSV

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

7R GUDZ IURP WKH FHQWHU RXWZDUG� SUHVV DQG KROG CTRL ZKLOH GUDZLQJ� RU
FOLFN WKH )URP &HQWHU EXWWRQ �

Extending a Line

<RX FDQ H[WHQG D VWUDLJKW OLQH DW WKH HQG RI DQ RSHQ REMHFW ZLWK WKH 3DUDOOHO

DQG 3HUSHQGLFXODU OLQH EXWWRQV� 7KH DGGHG OLQH PDLQWDLQV WKH VORSH RI WKH

RULJLQDO OLQH� RU LV DW D ULJKW DQJOH WR WKH RULJLQDO IRU WKH 3DUDOOHO DQG

3HUSHQGLFXODU EXWWRQV� UHVSHFWLYHO\�

7R H[WHQG D VWUDLJKW OLQH� GRXEOH FOLFN WKH OLQH \RX ZDQW WR H[WHQG� FOLFN WKH

6LPSOH /LQH WRRO LQ WKH WRROER[� FOLFN WKH /LQH 6HJPHQW EXWWRQ LQ WKH ULEERQ�

DQG FOLFN WKH 3DUDOOHO RU 3HUSHQGLFXODU EXWWRQ� 3RLQW WR WKH HQG RI WKH OLQH \RX

ZDQW WR H[WHQG DQG GUDJ WKH H[WHQGHG OLQH

�
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To extend a strai ght line

1 'RXEOH FOLFN WKH OLQH \RX ZDQW WR H[WHQG�

2 &OLFN WKH 6LPSOH /LQH WRRO LQ WKH WRROER[�

3 &OLFN WKH 3DUDOOHO EXWWRQ RU WKH 3HUSHQGLFXODU EXWWRQ LQ WKH

ULEERQ�

4 3RLQW WR WKH HQG RI WKH OLQH \RX ZDQW WR H[WHQG� DQG GUDJ WR H[WHQG

OLQH�

7LS

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

To draw an arc

7KH ��3RLQW $UF EXWWRQ GUDZV RQH� WZR� RU WKUHH TXDUWHUV RI DQ HOOLSVH�

1 &OLFN WKH (OOLSVH WRRO LQ WKH WRROER[�

2 &OLFN WKH ��3RLQW $UF EXWWRQ LQ WKH ULEERQ�

3 'UDJ WR GUDZ D OLQH EHWZHHQ WKH ILUVW WZR SRLQWV� 5HOHDVH WKH PRXVH

EXWWRQ� 7KH DUF DSSHDUV RQ WKH VFUHHQ DQG FKDQJHV VL]H DQG

SURSRUWLRQ DV \RX GUDJ WKH SRLQWHU�
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4 &OLFN WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK GUDZLQJ WKH DUF�

7LSV

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

8VH WKH 3URSRUWLRQDO &RQVWUDLQW EXWWRQ WR IRUFH 'HVLJQHU WR GUDZ
UDGLDO DUFV WKDW DUH RQH�TXDUWHU RI D SHUIHFW FLUFOH�

8VH WKH 5HYHUVH 'LUHFWLRQ EXWWRQ WR FRQWURO WKH ERZLQJ GLUHFWLRQ RI
WKH DUF� :KHQ WKH EXWWRQ LV QRW VHOHFWHG �WKH GHIDXOW�� WKH DUF ERZV WR WKH
ULJKW DV \RX GUDZ XSZDUG DQG OHIW DV \RX GUDZ GRZQZDUG� 7KH RSSRVLWH
RFFXUV ZKHQ WKH EXWWRQ LV VHOHFWHG�
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Drawing a Parabola

7KH 3DUDEROD EXWWRQ GUDZV SDUDEROLF VKDSHV� <RX FUHDWH SDUDERODV E\

GUDZLQJ D OLQH DQG WKHQ ERZLQJ WKH OLQH RXWZDUG �� PXFK OLNH SXOOLQJ DQ HODVWLF

VWULQJ�

To draw a parabola

1 &OLFN WKH 6LPSOH /LQH WRRO LQ WKH WRROER[�

2 &OLFN WKH 3DUDEROD EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ WKH SDUDEROD�

4 'UDJ ZKHUH \RX ZDQW WR SODFH WKH RWKHU HQG RI WKH SDUDEROD� 5HOHDVH

WKH PRXVH EXWWRQ�

5 0RYH WKH SRLQWHU WR ZKHUH \RX ZDQW WKH KLJKHVW SRLQW RI WKH FXUYH�

6 &OLFN WKH PRXVH EXWWRQ WR ILQLVK GUDZLQJ WKH SDUDEROD�

7LS

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH
9LHZ PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

7R FRQVWUDLQ WKH OLQH LQ VWHSV � DQG � WR D ���GHJUHH DQJOH� VHOHFW
WKH $QJOH &RQVWUDLQW EXWWRQ �

7R GUDZ WKH OLQH LQ VWHSV � DQG � IURP WKH FHQWHU RXWZDUG� SUHVV
DQG KROG CTRL ZKLOH GUDZLQJ� RU VHOHFW WKH )URP &HQWHU EXWWRQ

�
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Drawing Compound Lines

&OLFN WKH &RPSRXQG /LQH WRRO �NH\ERDUG VKRUWFXW CTRL+SHIFT+W� WR

GLVSOD\ WKH FRPSRXQG OLQH GUDZLQJ EXWWRQV LQ WKH ULEERQ DW WKH WRS RI WKH

'HVLJQHU ZLQGRZ� 7KHVH EXWWRQV DUH XVHG WR GUDZ REMHFWV IURP FRQQHFWHG

OLQHV DQG FXUYHV� VXFK DV MRLQWHG OLQHV� FXUYHV� %�VSOLQHV� %Â]LHU FXUYHV�

IUHHKDQG REMHFWV� DQG LUUHJXODU SRO\JRQV�

Drawing Jointed Lines

7KH -RLQWHG /LQH EXWWRQ GUDZV REMHFWV WKDW DUH D �FKDLQ� RI FRQQHFWHG

VWUDLJKW OLQHV�

-RLQWHG OLQHV DUH RSHQ XQOHVV WKH ODVW SRLQW LV WKH VDPH DV WKH ILUVW� WKHQ

'HVLJQHU DXWRPDWLFDOO\ FORVHV LW� ,I \RX ZDQW WR FORVH DQ RSHQ MRLQWHG OLQH�

VHOHFW WKH REMHFW� RSHQ WKH &KDQJH PHQX� FKRRVH &RPELQH� DQG FKRRVH WKH

&RQQHFW &ORVHG FRPPDQG� 7KH HQGV DUH FRQQHFWHG ZLWK D VWUDLJKW OLQH�

&XUYHG /LQH

%�6SOLQH

)UHHKDQG /LQH

-RLQWHG /LQH

%Â]LHU &XUYH

)UHHKDQG /LQH
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To draw a jointed line

1 &OLFN WKH &RPSRXQG /LQH WRRO LQ WKH WRROER[�

2 &OLFN WKH -RLQWHG /LQH EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ WKH MRLQWHG OLQH� DQG FOLFN WKH OHIW

PRXVH EXWWRQ�

4 0RYH WKH PRXVH WR WKH VHFRQG SRLQW� DQG FOLFN WKH OHIW PRXVH EXWWRQ�

5 5HSHDW IRU HDFK VHJPHQW RU SRLQW�

6 3UHVV ESC ZKHQ \RX ILQLVK�

7LS

3UHVV CTRL RU FOLFN WKH $QJOH &RQVWUDLQW EXWWRQ WR FRQVWUDLQ WKH
OLQH WR D ���GHJUHH DQJOH�

Drawing Curves

7KH &XUYHG /LQH EXWWRQ GUDZV REMHFWV WKDW DUH D �FKDLQ� RI FRQQHFWHG�

FXUYLQJ �SDUDEROLF VSOLQH� OLQHV�

2EMHFWV GUDZQ ZLWK WKH &XUYHG /LQH EXWWRQ DUH RSHQ XQOHVV WKH ODVW

SRLQW LV WKH VDPH DV WKH ILUVW� WKHQ 'HVLJQHU DXWRPDWLFDOO\ FORVHV LW� ,I \RX ZDQW

WR FORVH DQ RSHQ FXUYH� VHOHFW WKH REMHFW� FOLFN &RQQHFW &ORVHG RQ WKH

$UUDQJH PHQX� 7KH HQGV DUH FRQQHFWHG ZLWK D VWUDLJKW OLQH�
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To draw a curve

1 &OLFN WKH &RPSRXQG /LQH WRRO LQ WKH WRROER[�

2 &OLFN WKH &XUYHG /LQH EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ WKH FXUYH� DQG FOLFN WKH OHIW PRXVH

EXWWRQ�

4 'UDJ WR GUDZ D OLQH� DQG FOLFN WKH OHIW PRXVH EXWWRQ�

5 'UDJ WKH SRLQWHU� 7KH OLQH FXUYHV LQ WKH GLUHFWLRQ \RX PRYH WKH

SRLQWHU� &OLFN WKH OHIW PRXVH EXWWRQ�

6 5HSHDW VWHSV � DQG � WR DGG PRUH FXUYHG VHJPHQWV�

7 3UHVV ESC ZKHQ \RX ILQLVK�

7LSV

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

7R FRQVWUDLQ WKH OLQH WR DQJOHV WKDW DUH PXOWLSOHV RI �� GHJUHHV� FOLFN WKH
$QJOH &RQVWUDLQW EXWWRQ �

Drawing Bézier Curves

7KH %Â]LHU &XUYH EXWWRQ GUDZV %Â]LHU FXUYHV� $IWHU D OLWWOH SUDFWLFH� \RX

FDQ XVH WKLV WRRO WR FUHDWH VPRRWK� FXUYLQJ REMHFWV LQ PXFK OHVV WLPH WKDQ LW

WDNHV XVLQJ RWKHU WRROV�
$OWKRXJK GUDZLQJ %Â]LHU FXUYHV WDNHV VRPH SUDFWLFH� LWjV ZRUWK WKH HIIRUW� ,I \RX DUH

QHZ WR %Â]LHU FXUYHV� SUDFWLFH UHVKDSLQJ VRPH FXUYHG REMHFWV ZLWK WKHP EHIRUH WU\LQJ

WR GUDZ ZLWK %Â]LHU FXUYHV�
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To draw a Bézier curve

1 &OLFN WKH &RPSRXQG /LQH WRRO LQ WKH WRROER[�

2 &OLFN WKH %Â]LHU &XUYH EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ WKH FXUYH� DQG FOLFN WKH OHIW PRXVH

EXWWRQ�

4 0RYH WKH SRLQWHU ZKHUH \RX ZDQW WR SODFH WKH VHFRQG SRLQW� 3UHVV

DQG KROG WKH OHIW PRXVH EXWWRQ XQWLO 'HVLJQHU FRQQHFWV WKH WZR

HQGSRLQWV�

5 'UDJ WKH SRLQWHU WR FKDQJH WKH FXUYDWXUH RI WKH OLQH� 5HOHDVH WKH

PRXVH EXWWRQ ZKHQ \RX KDYH WKH FXUYH WKDW \RX ZDQW�

RU

5HOHDVH WKH PRXVH EXWWRQ ZLWKRXW GUDJJLQJ WR FUHDWH D FXVS �DQ

DQJOH��

6 5HSHDW VWHSV � DQG � WR GUDZ PRUH �FRQQHFWHG� FXUYHV�

7 3UHVV ESC ZKHQ \RX ILQLVK�

7LSV

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

:KHQ \RX GUDZ %Â]LHU FXUYHV� WKH ILUVW PRXVH SUHVV SODFHV WKH ILUVW
DQFKRU� WKH VHFRQG PRXVH SUHVV DQG GUDJ SODFHV WKH VHFRQG DQFKRU DQG
FKDQJHV WKDW DQFKRUjV FRQWURO SRLQWV�

%H VXUH WR SUHVV WKH OHIW PRXVH EXWWRQ IRU ORQJHU WKDQ D �FOLFN� ZKHQ
SODFLQJ WKH VHFRQG DQG VXEVHTXHQW %Â]LHU SRLQWV� 3UHVVLQJ WKH PRXVH
EXWWRQ IRU RQH VHFRQG VKRXOG EH ORQJ HQRXJK� ,I \RX FOLFN WKH PRXVH
EXWWRQ� \RX HQG WKH %Â]LHU GUDZLQJ DFWLRQ�

2EMHFWV GUDZQ ZLWK %Â]LHU &XUYH DUH RSHQ XQOHVV WKH ODVW SRLQW LV WKH
VDPH DV WKH ILUVW� WKHQ 'HVLJQHU DXWRPDWLFDOO\ FORVHV LW� ,I \RX ZDQW WR FORVH
DQ RSHQ FXUYH� VHOHFW WKH REMHFW� FOLFN &RPELQH RQ WKH &KDQJH PHQX� DQG
FOLFN &RQQHFW &ORVHG� 7KH HQGV DUH FRQQHFWHG ZLWK D VWUDLJKW OLQH�
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Drawing B-Splines

7KH %�6SOLQH EXWWRQ GUDZV %�VSOLQH FXUYHV� %�VSOLQHV DUH VPRRWK FXUYHV

EDVHG RQ DW OHDVW WKUHH SRLQWV� 7KH FXUYH WRXFKHV WKH ILUVW DQG ODVW SRLQWV DQG

LV SXOOHG E\ WKH PLGGOH SRLQW�

2EMHFWV GUDZQ ZLWK WKH %�6SOLQH EXWWRQ DUH RSHQ XQOHVV WKH ODVW SRLQW LV

WKH VDPH DV WKH ILUVW� WKHQ 'HVLJQHU DXWRPDWLFDOO\ FORVHV LW� ,I \RX ZDQW WR

FORVH DQ RSHQ FXUYH� VHOHFW WKH REMHFW� DQG FOLFN &RQQHFW &ORVHG RQ WKH

$UUDQJH PHQX� 7KH HQGV DUH FRQQHFWHG ZLWK D VWUDLJKW OLQH�

To draw a B-s pline

1 &OLFN WKH &RPSRXQG /LQH WRRO LQ WKH WRROER[�

2 &OLFN WKH %�6SOLQH EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ WKH FXUYH� DQG FOLFN WKH OHIW PRXVH

EXWWRQ�

4 'UDJ WR GUDZ WKH ILUVW OLQH RI WKH FXUYH� DQG FOLFN WKH OHIW PRXVH

EXWWRQ�

5 'UDJ WR GUDZ WKH VHFRQG OLQH RI WKH FXUYH� DQG FOLFN WKH OHIW PRXVH

EXWWRQ�

6 5HSHDW VWHS � WR GUDZ DGGLWLRQDO �FRQQHFWHG� FXUYHV�

7 3UHVV ESC ZKHQ \RX ILQLVK�

7LS

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH
9LHZ PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

Drawing Freehand Objects

7KH )UHHKDQG EXWWRQ GUDZV IUHHIRUP REMHFWV DV LI \RX ZHUH GUDZLQJ ZLWK

SHQFLO DQG SDSHU�
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7KLV EXWWRQ LV HVSHFLDOO\ XVHIXO LI \RX DUH XVLQJ D GLJLWL]LQJ SDG DQG SHQ WR

WUDFH GUDZLQJV� :KHQ \RX ILQLVK GUDZLQJ� 'HVLJQHU DXWRPDWLFDOO\ VPRRWKV WKH

REMHFW DQG FRQYHUWV LW WR FXUYHV�

)UHHKDQG REMHFWV DUH RSHQ XQOHVV WKH ODVW SRLQW LV WKH VDPH DV WKH ILUVW� WKHQ

'HVLJQHU DXWRPDWLFDOO\ FORVHV LW� ,I \RX ZDQW WR FORVH DQ RSHQ IUHHKDQG

REMHFW� VHOHFW LW� RSHQ WKH $UUDQJH PHQX� DQG FKRRVH WKH &RQQHFW &ORVHG

FRPPDQG� 7KH HQGV DUH FRQQHFWHG ZLWK D VWUDLJKW OLQH�

To draw a freehand ob ject

1 &OLFN WKH &RPSRXQG /LQH EXWWRQ LQ WKH WRROER[�

2 &OLFN WKH )UHHKDQG EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ GUDZLQJ�

4 'UDJ WR GUDZ WKH REMHFW�

5 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK GUDZLQJ�

7LSV

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

)UHHKDQG REMHFWV DUH RSHQ XQOHVV WKH ODVW SRLQW LV WKH VDPH DV WKH ILUVW�
WKHQ 'HVLJQHU DXWRPDWLFDOO\ FORVHV LW� ,I \RX ZDQW WR FORVH DQ RSHQ
IUHHKDQG REMHFW� VHOHFW LW� FOLFN &RPELQH RQ WKH &KDQJH PHQX� DQG FOLFN
&RQQHFW &ORVHG� 7KH HQGV DUH FRQQHFWHG ZLWK D VWUDLJKW OLQH�

Drawing Irregular Polygons

7KH ,UUHJXODU 3RO\JRQ EXWWRQ OHWV \RX GUDZ FORVHG REMHFWV ZLWK PXOWLSOH

VLGHV�
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6HH 'UDZLQJ 5HJXODU 3RO\JRQV DQG 'UDZLQJ 6WDUV WR GUDZ SRO\JRQV� VXFK DV

WULDQJOHV DQG VWDUV� LQ ZKLFK HDFK VLGH LV WKH VDPH OHQJWK�

To draw an irre gular polygon

1 &OLFN WKH &RPSRXQG /LQH WRRO LQ WKH WRROER[�

2 &OLFN WKH ,UUHJXODU 3RO\JRQ EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ WKH SRO\JRQ�

4 'UDJ WR GUDZ WKH ILUVW VLGH RI WKH SRO\JRQ� 5HOHDVH WKH PRXVH EXWWRQ

ZKHQ \RX KDYH WKH ILUVW VLGH GUDZQ DV \RX ZDQW LW�

5 0RYH WKH SRLQWHU ZKHUH \RX ZDQW WR SODFH WKH WKLUG SRLQW� &OLFN WKH

OHIW PRXVH EXWWRQV�

6 5HSHDW VWHS � WR SODFH PRUH SRLQWV� LI \RX ZLVK�

7 3UHVV ESC ZKHQ \RX ILQLVK�

7LSV

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

&OLFN WKH $QJOH &RQVWUDLQW EXWWRQ WR FRQVWUDLQ WKH OLQH WR D ���GHJUHH
DQJOH�
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Drawing Sticky Lines

&OLFN WKH 6WLFN\ /LQH 7RRO �NH\ERDUG VKRUWFXW CTRL+SHIFT+U� WR GLVSOD\ WKH

VWLFN\ OLQH GUDZLQJ EXWWRQV LQ WKH ULEERQ DW WKH WRS RI WKH 'HVLJQHU ZLQGRZ�

7KHVH EXWWRQV DUH XVHG WR FUHDWH GLDJUDPPLQJ OLQHV ZLWK HQGV DQG SRLQWV

WKDW DXWRPDWLFDOO\ DWWDFK� RU VWLFN� WR WKH HQGV DQG SRLQWV RI RWKHU OLQHV�

To draw a stick y line

1 6HOHFW WKH 6WLFN\ /LQH WRRO LQ WKH WRROER[�

2 &OLFN ZKHUH \RX ZDQW WKH OLQH WR VWDUW�

3 .HHSLQJ WKH PRXVH EXWWRQ SUHVVHG� PRYH WKH SRLQWHU ZKHUH \RX ZDQW

WKH OLQH WR HQG�

4 7R FRPSOHWH WKH OLQH� UHOHDVH WKH PRXVH EXWWRQ�

To draw a stick y quarter arc

1 6HOHFW WKH 6WLFN\ 4XDUWHU $UF WRRO LQ WKH WRROER[�

2 &OLFN ZKHUH \RX ZDQW WKH OLQH WR VWDUW�

3 .HHSLQJ WKH PRXVH EXWWRQ SUHVVHG� PRYH WKH SRLQWHU ZKHUH \RX ZDQW

WKH OLQH WR HQG�

4 7R FRPSOHWH WKH OLQH� UHOHDVH WKH PRXVH EXWWRQ�

To draw a stick y jointed line

1 6HOHFW WKH 6WLFN\ -RLQWHG /LQH WRRO LQ WKH WRROER[�

6WLFN\ /LQH 6HJPHQW

6WLFN\ 4XDUWHU $UF

6WLFN\ -RLQWHG /LQH

6WLFN\ &XUYHG /LQH

6WLFN\ )UHHKDQG /LQH

6WLFN\ 5LJKW�DQJOH /LQHV

6WLFN\ %Â]LHU /LQHV
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2 &OLFN ZKHUH \RX ZDQW WKH OLQH WR VWDUW�

3 .HHSLQJ WKH PRXVH EXWWRQ SUHVVHG� PRYH WKH SRLQWHU ZKHUH \RX ZDQW

WKH OLQH WR VWRS�

4 5HOHDVH WKH PRXVH EXWWRQ DQG FOLFN DQG GUDJ WKH OLQH DJDLQ� PRYLQJ WKH

SRLQWHU ZKHUH \RX ZDQW WKH OLQH WR HQG�

5 7R FRPSOHWH WKH OLQH� UHOHDVH WKH PRXVH EXWWRQ DQG SUHVV ESC�

To draw a stick y curved line

1 6HOHFW WKH 6WLFN\ &XUYHG /LQH WRRO LQ WKH WRROER[�

2 &OLFN ZKHUH \RX ZDQW WKH OLQH WR VWDUW�

3 .HHSLQJ WKH PRXVH EXWWRQ SUHVVHG� PRYH WKH SRLQWHU ZKHUH \RX ZDQW

WKH OLQH WR FXUYH�

4 5HOHDVH WKH PRXVH EXWWRQ DQG FOLFN DQG GUDJ WKH OLQH DJDLQ� PRYLQJ WKH

SRLQWHU ZKHUH \RX ZDQW WKH OLQH WR HQG�

5 7R FRPSOHWH WKH OLQH� UHOHDVH WKH PRXVH EXWWRQ DQG SUHVV ESC�

To draw a stick y freehand line

1 6HOHFW WKH 6WLFN\ )UHHKDQG /LQH WRRO LQ WKH WRROER[�

2 &OLFN ZKHUH \RX ZDQW WKH OLQH WR VWDUW�

3 .HHSLQJ WKH PRXVH EXWWRQ SUHVVHG� PRYH WKH SRLQWHU ZKHUH \RX ZDQW

WKH OLQH WR HQG�

4 7R FRPSOHWH WKH OLQH� UHOHDVH WKH PRXVH EXWWRQ�

To draw a stick y right-an gle line

1 6HOHFW WKH 6WLFN\ 5LJKW�$QJOH /LQH WRRO LQ WKH WRROER[�

2 &OLFN ZKHUH \RX ZDQW WKH OLQH WR VWDUW�

3 .HHSLQJ WKH PRXVH EXWWRQ SUHVVHG� PRYH WKH SRLQWHU ZKHUH \RX ZDQW

WKH OLQH WR HQG�

4 7R FRPSOHWH WKH OLQH� UHOHDVH WKH PRXVH EXWWRQ�
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To draw a stick y Bézier line

1 6HOHFW WKH 6WLFN\ %Â]LHU /LQH WRRO LQ WKH WRROER[�

2 &OLFN ZKHUH \RX ZDQW WKH OLQH WR VWDUW�

3 .HHSLQJ WKH PRXVH EXWWRQ SUHVVHG� PRYH WKH SRLQWHU ZKHUH \RX ZDQW

WKH OLQH WR HQG�

4 7R FRPSOHWH WKH OLQH� UHOHDVH WKH PRXVH EXWWRQ�
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Drawing Rectangular Objects

&OLFN WKH 5HFWDQJOH 7RRO �NH\ERDUG VKRUWFXW CTRL+SHIFT+X� WR GLVSOD\ WKH

UHFWDQJOH GUDZLQJ EXWWRQV LQ WKH ULEERQ DW WKH WRS RI WKH 'HVLJQHU ZLQGRZ�

7KHVH EXWWRQV DUH XVHG WR GUDZ UHFWDQJXODU REMHFWV IURP RSSRVLWH FRUQHUV

RU IURP D VLQJOH VLGH� <RX DOVR FDQ GUDZ D UHFWDQJOH EDVHG RQ LWV KHLJKW DQG

ZLGWK�

1RWH

$OWKRXJK kUHFWDQJOHy UHIHUV WR ERWK VTXDUHV DQG UHFWDQJOHV� kVTXDUHy
PHDQV RQO\ SHUIHFW VTXDUH VKDSHV�

Drawing a Rectangle or Square

7KHUH DUH VHYHQ PHWKRGV IRU GUDZLQJ D UHFWDQJOH� WKH 'LDJRQDO� WKH +HLJKW�

:LGWK� DQG WKH 6LQJOH 6LGH PHWKRGV�

v 'LDJRQDO IURP FHQWHU

v )URP FHQWHU OLQH

v 'LDJRQDO VTXDUH

v 'LDJRQDO VTXDUH IURP FHQWHU

v 6LQJOH VLGH

'LDJRQDO

6LQJOH 6LGH+HLJKW�:LGWK

5RXQGHG 5HFWDQJOH

5RXQGLQJ %R[

'LDJRQDO IURP &HQWHU

'LDJRQDO 6TXDUH

)URP &HQWHUOLQH

6TXDUH )URP &HQWHU
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Using the Diagonal Method

7KH 'LDJRQDO PHWKRG LV RQH RI WKH PRVW LQWXLWLYH ZD\V WR GUDZ UHFWDQJOHV

EHFDXVH \RX MXVW GUDJ GLDJRQDOO\ WR FUHDWH WKH UHFWDQJOH�

Using the Height/ Width Method

7KH +HLJKW�:LGWK PHWKRG OHWV \RX GUDZ UHFWDQJOHV DQG E\ VSHFLI\LQJ WKH

KHLJKW DQG ZLGWK�

Using the Single Side Method2

1

3
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7KH 6LQJOH 6LGH PHWKRG GUDZV RQO\ VTXDUHV� &OLFN WKH 6LQJOH 6LGH EXWWRQ

DQG GUDJ WR GUDZ RQH HGJH RI WKH VTXDUH� 7KH UHVW RI WKH VTXDUH GUDZV

DXWRPDWLFDOO\� :KHQ \RX ILQLVK� UHOHDVH WKH PRXVH EXWWRQ�

1RWHV

7KHUH DUH WZR ZD\V WR GUDZ D VTXDUH� <RX FDQ XVH WKH 6LQJOH 6LGH PHWKRG
RU \RX FDQ FKRRVH WKH GLDJRQDO GUDZLQJ PHWKRG DQG DFWLYDWH WKH

3URSRUWLRQDO &RQVWUDLQW EXWWRQ �RU SUHVV SHIFT��

%\ GHIDXOW� VTXDUHV GUDZ GRZQ DV \RX GUDJ ULJKW� DQG XS DV \RX GUDJ OHIW�

6HOHFW WKH 5HYHUVH EXWWRQ IRU WKH RSSRVLWH WR RFFXU�

To draw a rectan gle or square usin g the Dia gonal method

1 &OLFN WKH 5HFWDQJOH WRRO LQ WKH WRROER[�

2 &OLFN WKH 'LDJRQDO EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ WKH UHFWDQJOH DQG GUDJ WKH SRLQWHU WR

WKH RSSRVLWH FRUQHU�

4 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK WKH UHFWDQJOH�

7LS

3UHVV SHIFT ZKLOH GUDZLQJ WKH UHFWDQJOH WR IRUFH D VTXDUH�

To draw a rectan gle or parallelo gram usin g the Hei ght/W idth 
method

1 &OLFN WKH 5HFWDQJOH WRRO LQ WKH WRROER[�

2 &OLFN WKH +HLJKW�:LGWK EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ WKH UHFWDQJOH RU SDUDOOHORJUDP�

4 'UDJ WR GUDZ WKH ILUVW HGJH�
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5 5HOHDVH WKH PRXVH EXWWRQ�

6 0RYH WKH SRLQWHU WR GUDZ WKH UHVW RI WKH REMHFW�

7 &OLFN WKH ULJKW PRXVH EXWWRQ �DQG UHOHDVH SHIFT LI \RX GUHZ D

UHFWDQJOH� ZKHQ \RX ILQLVK�

Drawing Rectangles with Rounded Corners

7KH 5RXQGHG 5HFWDQJOH EXWWRQ OHWV \RX FUHDWH UHFWDQJOHV DQG VTXDUHV

ZLWK URXQGHG FRUQHUV� <RX FDQ LQFUHDVH RU GHFUHDVH WKH FXUYH RI WKH FRUQHU

�EHIRUH LW LV GUDZQ� E\ LQFUHDVLQJ RU GHFUHDVLQJ WKH UDGLXV� $ ODUJHU UDGLXV

LQFUHDVHV WKH FXUYDWXUH� D VPDOOHU UDGLXV GHFUHDVHV LW�

To draw a rounded rectan gle

1 &OLFN WKH 5HFWDQJOH WRRO LQ WKH WRROER[�

2 )URP WKH ULEERQ� FOLFN WKH PHWKRG EXWWRQ RI \RXU FKRLFH�

3 &OLFN WKH 5RXQGHG 5HFWDQJOH EXWWRQ LQ WKH ULEERQ�

4 &KDQJH WKH UDGLXV LQ WKH 5DGLXV ER[� LI \RX ZLVK�

1RWH

<RX FDQ URXQG UHFWDQJOHV FUHDWHG ZLWK WKH +HLJKW�:LGWK EXWWRQ
RQO\ LI \RX FRQVWUDLQHG WKH UHFWDQJOH ZKLOH GUDZLQJ LW�

5 3RLQW WR ZKHUH \RX ZDQW WR EHJLQ WKH UHFWDQJOH�

6 'UDZ WKH UHFWDQJOH�
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Rounding Existing Rectangles

<RX FDQ URXQG WKH FRUQHUV RI H[LVWLQJ UHFWDQJOHV WKDW KDYH QRW EHHQ URWDWHG�

VNHZHG� FRQYHUWHG WR FXUYHV� RU ZDUSHG� 5HFWDQJOHV GUDZQ ZLWK WKH +HLJKW�

:LGWK PHWKRG� )URP &HQWHUOLQH PHWKRG� RU 6LQJOH 6LGH PHWKRG PXVW KDYH

EHHQ GUDZQ DW D ���GHJUHH DQJOH EHIRUH \RX FDQ URXQG WKH FRUQHUV�

7LS

7R GUDZ D ���GHJUHH DQJOH� XVH WKH $QJOH &RQVWUDLQW EXWWRQ�

To add rounded corners to an existin g rectan gle

1 'RXEOH FOLFN WKH UHFWDQJOH ZLWK WKH VHOHFW SRLQWHU� $ EOXH KDQGOH

DSSHDUV QHDU WKH UHFWDQJOHjV XSSHU OHIW FRUQHU� ,I VHYHUDO KROORZ

KDQGOHV DSSHDU RQ WKH UHFWDQJOH� WKLV PHWKRG FDQQRW EH XVHG�

2 'UDJ WKH EOXH KDQGOH WRZDUG WKH FHQWHU RI WKH UHFWDQJOH�

3 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK URXQGLQJ WKH FRUQHUV�

7LS

<RX FDQ URXQG UHFWDQJOHV FUHDWHG ZLWK +HLJKW�:LGWK RQO\ LI
\RX FRQVWUDLQHG WKH UHFWDQJOH ZKLOH GUDZLQJ LW�

<RX FDQ DOVR URXQG UHFWDQJOH FRUQHUV E\ VHOHFWLQJ WKH UHFWDQJOH
DQG FOLFNLQJ WKH 3RLQW 5HVKDSH EXWWRQ RQ WKH 5LEERQ�
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Drawing Regular Polygons

&OLFN WKH 5HJXODU 3RO\JRQ WRRO �NH\ERDUG VKRUWFXW CTRL+SHIFT+Y� WR GLVSOD\

WKH UHJXODU SRO\JRQ GUDZLQJ EXWWRQV LQ WKH ULEERQ DW WKH WRS RI WKH 'HVLJQHU

ZLQGRZ� 7KHVH EXWWRQV DUH XVHG WR GUDZ UHFWDQJXODU REMHFWV IURP RSSRVLWH

FRUQHUV RU IURP D VLQJOH VLGH� <RX DOVR FDQ GUDZ D UHJXODU SRO\JRQ IURP

FHQWHU WR FRUQHU� IURP FHQWHU WR VLGH� DQG IURP MXVW RQH VLGH

7KHUH DUH WKUHH ZD\V WR GUDZ D SRO\JRQ� WKH 7R &RUQHU� 7R 6LGH� DQG 6LQJOH

6LGH PHWKRGV� <RX FDQ XVH WKH PHWKRG WKDW VXLWV \RXU QHHGV RU SUHIHUHQFHV�

,I \RX ZDQW WR GUDZ LUUHJXODU SRO\JRQV �SRO\JRQV LQ ZKLFK QRW DOO WKH VLGHV DUH

HTXDO�� XVH WKH &RPSRXQG /LQH WRRO�

Using the To Corner Method

7KH 7R &RUQHU PHWKRG OHWV \RX GUDZ SRO\JRQV IURP WKH FHQWHU WR DQ\

SDUWLFXODU FRUQHU�

7ULDQJOH WR &RUQHU

3RO\JRQ WR &RUQHU

7ULDQJOH 6LQJOH 6LGH

6WDU WR 3RLQW

6WDU WR 6LGH

0HJDJRQ

&XUY\JRQ
1XPEHU RI 6LGHV %R[7ULDQJOH 7R 6LGH

+H[DJRQ WR &RUQHU

+H[DJRQ WR 6LGH

+H[DJRQ 6LQJOH 6LGH

2FWRJRQ WR &RUQHU

2FWRJRQ WR 6LGH

2FWRJRQ 6LQJOH 6LGH

3RO\JRQ WR 6LGH

3RO\JRQ 6LQJOH 6LGH

6WDU 3RLQW WR 3RLQW
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Using the To Side Method

7KH 7R 6LGH PHWKRG OHWV \RX GUDZ SRO\JRQV IURP WKH FHQWHU WR D VLGH�

Using the Single Side Method

7KH 6LQJOH 6LGH PHWKRG OHWV \RX FUHDWH SRO\JRQV E\ GUDZLQJ RQO\ RQH VLGH�

'HVLJQHU GUDZV WKH RWKHU VLGHV�

'UDJ 6LQJOH 6LGH WR GUDZ RQH HGJH RI WKH SRO\JRQ� 7KH UHVW RI WKH

SRO\JRQ LV GUDZQ DXWRPDWLFDOO\� 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK�

To draw a polygon from center to a corner or a side

1 &OLFN WKH 3RO\JRQ WRRO LQ WKH WRROER[�

2 &OLFN WKH 7R &RUQHU EXWWRQ LQ WKH ULEERQ� RU FOLFN WKH 7R 6LGH

EXWWRQ LQ WKH ULEERQ�

3 (QWHU WKH QXPEHU RI VLGHV IRU WKH SRO\JRQ LQ WKH 6LGHV ER[ �WKUHH RU

PRUH��

4 3RLQW ZKHUH \RX ZDQW WKH FHQWHU RI WKH SRO\JRQ�
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5 'UDJ WR GUDZ WKH SRO\JRQ�

6 5HOHDVH WKH PRXVH EXWWRQ ZKHQ WKH SRO\JRQ LV WKH VL]H \RX ZDQW�

7LSV

,I \RX GR QRW VHH WKH 7RROER[ RU WKH 5LEERQ� FOLFN 7RROEDUV RQ WKH 9LHZ
PHQX� DQG WKHQ FOLFN WKH 7RROER[ DQG 5LEERQ LWHPV�

7R FRQVWUDLQ SRO\JRQV WR PXOWLSOHV RI �� GHJUHHV� VHOHFW WKH $QJOH
&RQVWUDLQW EXWWRQ �

To draw a polygon from the center to a side

1 &OLFN WKH 3RO\JRQ WRRO LQ WKH WRROER[�

2 &OLFN WKH 7R 6LGH EXWWRQ LQ WKH ULEERQ�

3 (QWHU WKH QXPEHU RI VLGHV IRU WKH SRO\JRQ LQ WKH 6LGHV ER[ �WKUHH RU

PRUH��

4 3RLQW ZKHUH \RX ZDQW WKH FHQWHU RI WKH SRO\JRQ�

5 'UDJ WR GUDZ WKH SRO\JRQ�

6 5HOHDVH WKH PRXVH EXWWRQ ZKHQ WKH SRO\JRQ LV WKH VL]H \RX ZDQW�

7LSV

7R FRQVWUDLQ SRO\JRQV WR D ���GHJUHH DQJOH� VHOHFW WKH $QJOH &RQVWUDLQW
EXWWRQ �

3UHVV SHIFT WR TXLFNO\ VZLWFK WR GUDZLQJ IURP FHQWHU WR FRUQHU�
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Drawing Stars

'HVLJQHU OHWV \RX GUDZ VWDU VKDSHV ZLWK DQ\ QXPEHU RI

SRLQWV�

To draw a star

1 &OLFN WKH SRO\JRQ WRRO LQ WKH WRROER[�

2 &OLFN DQ\ RI WKH WKUHH 6WDU EXWWRQV LQ WKH ULEERQ� )RU H[DPSOH� FOLFN WKH

7R 3RLQW EXWWRQ� WKH 7R 6LGH EXWWRQ� RU WKH 3RLQW WR 3RLQW EXWWRQ�

DFFRUGLQJ WR \RXU GUDZLQJ SUHIHUHQFH�

3 7\SH WKH QXPEHU RI SRLQWV IRU WKH VWDU LQ WKH 6LGHV ER[� LI \RX ZLVK�

4 3UHVV DQG KROG WKH OHIW PRXVH EXWWRQ DQG GUDZ D SRO\JRQ� 7R

FRPSOHWH WKH VWDU� UHOHDVH WKH PRXVH EXWWRQ�

To draw a curv ygon

1 &OLFN WKH FXUY\JRQ WRRO LQ WKH WRROER[�

2 3RLQW WKH FXUVRU ZKHUH \RX ZDQW WKH FXUY\JRQ WR VWDUW�

3 .HHSLQJ WKH PRXVH EXWWRQ SUHVVHG� PRYH WKH SRLQWHU WR FUHDWH WKH

FXUY\JRQ�

4 <RX FDQ FKDQJH WKH VKDSH RI WKH FXUY\JRQ E\ SUHVVLQJ WKH PRXVH

EXWWRQ ZKLOH PRYLQJ WKH SRLQWHU� &RQWLQXH XQWLO \RX DUH VDWLVILHG ZLWK

WKH FXUY\JRQ�

5 7R FRPSOHWH WKH FXUY\JRQ� HLWKHU SUHVV ESC RU GRXEOH�FOLFN RXWVLGH RI

WKH FXUY\JRQ�
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Drawing Elliptical Objects

&OLFN WKH (OOLSVH WRRO �NH\ERDUG VKRUWFXW CTRL+SHIFT+Z� WR GLVSOD\ WKH HOOLSVH

GUDZLQJ EXWWRQV LQ WKH ULEERQ DW WKH WRS RI WKH 'HVLJQHU ZLQGRZ� 7KHVH

EXWWRQV DUH XVHG WR GUDZ D FLUFOH IURP RQH HGJH WR WKH RSSRVLWH HGJH� RU DQ

HOOLSVH IURP RQH FRUQHU WR WKH RSSRVLWH FRUQHU� <RX DOVR FDQ GUDZ DQ HOOLSVH

E\ VSHFLI\LQJ LWV KHLJKW DQG ZLGWK� RU D FLUFOH E\ VHOHFWLQJ WKUHH SRLQWV�

<RX DOVR FDQ XVH WKH (OOLSVH EXWWRQ WR GUDZ DQ HOOLSWLFDO DUF E\ VSHFLI\LQJ

WKUHH SRLQWV RI WKH DUF�

$Q HOOLSVH GUDZQ ZLWK WKH +HLJKW�:LGWK PHWKRG RU WKH &HQWHUOLQH PHWKRG

PXVW EH GUDZQ DW D ���GHJUHH DQJOH EHIRUH \RX FDQ UHVKDSH LW LQWR D ZHGJH

RU DQ DUF�

1RWH

k(OOLSVHy UHIHUV WR ERWK HOOLSVHV DQG FLUFOHV� EXW kFLUFOHy GHVFULEHV RQO\
SHUIHFW FLUFXODU VKDSHV�

Constraining with the Keyboard

<RX FDQ XVH NH\VWURNHV WR DFWLYDWH FRQVWUDLQWV� .H\VWURNHV DFWLYDWH D

FRQVWUDLQW RQO\ ZKLOH WKH NH\ LV SUHVVHG�

<RX FDQ XVH D NH\ WR WRJJOH WKH HIIHFW RI D FRQVWUDLQW EXWWRQ� )RU H[DPSOH� LI

\RX SUHVV DQG KROG CTRL ZKLOH WKH $QJOH &RQVWUDLQW EXWWRQ LV VHOHFWHG� \RX

WXUQ RII WKH FRQVWUDLQW�

'LDJRQDO

+HLJKW�:LGWK 'LDPHWHU

��3RLQW &LUFOH

��3RLQW $UF

3LH)URP &HQWHU

)URP &HQWHUOLQH

'LDJRQDO &LUFOH

5DGLXV
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Constraining to a 15-degree Angle

<RX FDQ XVH WKH $QJOH &RQVWUDLQW EXWWRQ �RU SUHVV CTRL� WR IRUFH OLQHV WR

GUDZ DW D ���GHJUHH DQJOH� 7KLV FRQVWUDLQW LV XVHIXO IRU GUDZLQJ OLQHV �DQG

REMHFW HGJHV� WKDW DUH SHUIHFWO\ KRUL]RQWDO RU YHUWLFDO�

7KLV EXWWRQ DOVR IRUFHV KRUL]RQWDO DQG YHUWLFDO PRYHPHQWV� DQG URWDWLRQV DQG

VNHZV RI ���GHJUHH LQFUHPHQWV�

Constraining to a Square or Circle

8VH WKH 3URSRUWLRQDO &RQVWUDLQW EXWWRQ �RU SUHVV CTRL� WR IRUFH UHFWDQJXODU

RU HOOLSWLFDO VKDSHV WR GUDZ DV VTXDUHV RU FLUFOHV� UHVSHFWLYHO\�

Reversing the Drawing Direction

8VH WKH 5HYHUVH 'LUHFWLRQ EXWWRQ �RU SUHVV SHIFT� WR UHYHUVH WKH GLUHFWLRQ

'HVLJQHU QRUPDOO\ GUDZV REMHFWV FUHDWHG IURP D VLQJOH VLGH �IRU H[DPSOH�

GUDZLQJ D VTXDUH IURP D VLQJOH VLGH�� 6HH WKH VSHFLILF GUDZLQJ PHWKRG \RX DUH

XVLQJ IRU GHWDLOV�

Using the From Center Button

8VH WKH )URP &HQWHU EXWWRQ �RU SUHVV SHIFT� WR IRUFH 'HVLJQHU WR GUDZ WKH

REMHFW IURP WKH FHQWHU RXWZDUG� 'UDZLQJ IURP WKH FHQWHU FDQ EH XVHIXO

ZKHQ \RX ZDQW WKH FHQWHU RI WKH REMHFW WR EH DW D SDUWLFXODU SRLQW�
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Using the Diagonal Method

7KH 'LDJRQDO PHWKRG OHWV \RX GUDZ DQ HOOLSVH GLDJRQDOO\ IURP RQH FRUQHU RI

LWV ERXQGLQJ ER[ WR WKH RSSRVLWH�

To draw an elli pse usin g the Diagonal method

1 &OLFN WKH (OOLSVH WRRO LQ WKH WRROER[�

2 &OLFN WKH 'LDJRQDO EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR EHJLQ WKH HOOLSVHjV �LQYLVLEOH� UHFWDQJXODU

ERXQGLQJ ER[�

4 'UDJ GLDJRQDOO\ WR GUDZ WKH HOOLSVH�

5 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK�

7LS

3UHVV SHIFT ZKLOH GUDZLQJ WKH HOOLSVH WR IRUFH D FLUFOH�

1

2
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Using the Height/ Width Method

7KH +HLJKW�:LGWK PHWKRG OHWV \RX GUDZ DQ HOOLSVH E\ VSHFLI\LQJ WKH KHLJKW

DQG ZLGWK RI LWV ERXQGLQJ ER[�

Using the Diameter Method

7KH 'LDPHWHU PHWKRG OHWV \RX GUDZ FLUFOHV IURP RQH HGJH RI WKH FLUFOH WR

WKH RSSRVLWH HGJH� 'UDJ WR GUDZ WKH FLUFOH� 5HOHDVH WKH PRXVH EXWWRQ ZKHQ

\RX ILQLVK�

Using the 3-Point Circle Method

7KH ��3RLQW &LUFOH PHWKRG OHWV \RX GUDZ D FLUFOH E\ VSHFLI\LQJ WKUHH SRLQWV

RQ LWV HGJH�

7LSV

�(OOLSVH� UHIHUV WR ERWK HOOLSVHV DQG FLUFOHV� EXW �FLUFOH� GHVFULEHV RQO\ SHUIHFW
FLUFXODU VKDSHV�

$Q HOOLSVH GUDZQ ZLWK WKH +HLJKW�:LGWK PHWKRG PXVW EH GUDZQ DW D ���
GHJUHH DQJOH EHIRUH \RX FDQ UHVKDSH LW LQWR D ZHGJH RU DQ DUF�

7KHUH DUH WKUHH ZD\V WR GUDZ D FLUFOH� <RX FDQ XVH WKH 'LDPHWHU PHWKRG
RU WKH ��3RLQW &LUFOH PHWKRG� RU \RX FDQ FKRRVH RQH RI WKH HOOLSWLFDO
GUDZLQJ PHWKRGV DQG DFWLYDWH WKH 3URSRUWLRQDO &RQVWUDLQW EXWWRQ �

1

2 3
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To draw a circle usin g the 3-Point Circle method

1 &OLFN WKH (OOLSVH WRRO LQ WKH WRROER[�

2 &OLFN WKH ��3RLQW &LUFOH EXWWRQ LQ WKH ULEERQ�

3 3RLQW ZKHUH \RX ZDQW WR SODFH WKH ILUVW SRLQW RQ WKH FLUFOH� 3UHVV DQG

KROG WKH OHIW PRXVH EXWWRQ�

4 'UDJ WKH SRLQWHU ZKHUH \RX ZDQW WR SODFH WKH VHFRQG SRLQW� 5HOHDVH

WKH PRXVH EXWWRQ�

5 0RYH WKH SRLQWHU ZKHUH \RX ZDQW WR SODFH WKH WKLUG SRLQW� &OLFN WKH

OHIW PRXVH EXWWRQ WR GUDZ WKH FLUFOH�

Drawing an Elliptical Arc

$Q HOOLSWLFDO DUF LV D VHJPHQW RI DQ HOOLSVH� 7KHUH DUH WZR ZD\V WR GUDZ DQ

HOOLSWLFDO DUF� WKH ��3RLQW $UF DQG WKH 7UDFH DQ (OOLSVH PHWKRGV�
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Using the 3-Point Arc Method

7KH ��3RLQW $UF PHWKRG OHWV \RX GUDZ DQ DUF E\ VSHFLI\LQJ WKUHH SRLQWV RQ

WKH DUF�

7LS

<RX FDQ GUDZ TXDUWHU DUFV XVLQJ WKH 4XDUWHU $UF EXWWRQ � :LWK
TXDUWHU DUFV \RX GRQjW ILUVW GUDZ DQ HOOLSVH� EXW \RX DUH OLPLWHG WR GUDZLQJ
RQO\ RQH TXDUWHU RI DQ HOOLSVH� �6HH 'UDZLQJ (OOLSWLFDO 2EMHFWV IRU PRUH
LQIRUPDWLRQ��

To draw a 3- point elli ptical arc

1 &OLFN WKH (OOLSVH WRRO LQ WKH WRROER[�

2 &OLFN WKH ��3RLQW $UF EXWWRQ LQ WKH ULEERQ�

3 'UDJ WKH DUFjV GLDPHWHU DQG UHOHDVH WKH PRXVH EXWWRQ�

4 0RYH WKH SRLQWHU WR FUHDWH WKH DUF�

5 &OLFN WKH OHIW PRXVH EXWWRQ WR GUDZ WKH DUF�

Tracing the Arc of an Ellipse

<RX FDQ XVH WKH HGJH RI DQ H[LVWLQJ HOOLSVH WR GUDZ DQ HOOLSWLFDO DUF LI \RX KDYH

QRW URWDWHG� VNHZHG� RU FRQYHUWHG WKH HOOLSVH WR FXUYHV� 7KH DUF WUDFHV DORQJ

WKH HGJH RI WKH HOOLSVH DQG UHSODFHV WKH HOOLSVH�
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To draw an elli ptical arc b y tracin g an elli pse

1 'UDZ WKH HOOLSVH WR XVH DV D WHPSODWH IRU WKH DUF�

2 6HOHFW WKH HOOLSVH�

3 &OLFN WKH (GLW WRRO DQG 3RLQW 5HVKDSH EXWWRQ LQ WKH ULEERQ�

4 3RVLWLRQ WKH SRLQWHU RXWVLGH WKH HOOLSVH�

5 'UDJ LQ D FLUFXODU PRWLRQ RXWVLGH RI WKH HOOLSVH� $Q DUF GUDZV RQ WRS RI

WKH HOOLSVH
V HGJH�

6 5HOHDVH WKH PRXVH EXWWRQ DQG SUHVV ESC ZKHQ \RX ILQLVK�

1RWH

<RX FDQ DOVR FUHDWH DUFV IURP SLH ZHGJHV DV ORQJ DV WKH ZHGJHV
KDYH QRW EHHQ VNHZHG� URWDWHG� RU FRQYHUWHG WR FXUYHV�

Editing an Arc

<RX FDQ OHQJWKHQ RU VKRUWHQ DQ DUF E\ GRXEOH FOLFNLQJ WKH DUF DQG GUDJJLQJ LQ

D FLUFXODU PRWLRQ RXWVLGH WKH REMHFW�

<RX FDQ DOVR XVH WKH (GLW ULEERQ� 6HOHFW WKH DUF� FOLFN WKH (GLW WRRO � DQG

FOLFN WKH 3RLQW 5HVKDSH EXWWRQ � 7KHQ GUDJ LQ D FLUFXODU PRWLRQ RXWVLGH

WKH REMHFW�

Drawing a Pie Wedge

<RX XVH DQ H[LVWLQJ HOOLSVH WR GUDZ LQGLYLGXDO RU PXOWLSOH SLH ZHGJHV� <RX FDQ

GUDZ VHYHUDO SLH ZHGJHV WR FUHDWH D FLUFXODU SLH� RU \RX FDQ FUHDWH MXVW D

SRUWLRQ RI WKH SLH�
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(DFK SLH ZHGJH LV D FORVHG REMHFW WKDW \RX FDQ VHOHFW DQG HGLW LQGLYLGXDOO\� )RU

H[DPSOH� \RX FDQ FUHDWH D FKDUW LQ ZKLFK HDFK ZHGJH RI WKH SLH LV D GLIIHUHQW

FRORU�

To draw pie wed ges usin g the ribbon

1 'UDZ DQ HOOLSVH�

2 &OLFN WKH 3LH EXWWRQ LQ WKH ULEERQ�

3 3RVLWLRQ WKH SRLQWHU QHDU WKH HOOLSVH DQG GUDJ LQ D FLUFXODU PRWLRQ WR

FUHDWH WKH ILUVW ZHGJH�

4 5HOHDVH WKH PRXVH EXWWRQ ZKHQ WKH ZHGJH LV WKH VL]H \RX ZDQW�

5 5HSHDW VWHSV � DQG � WR DGG PRUH DGMDFHQW ZHGJHV WR WKH SLH�

6 3UHVV ESC RU FOLFN RXWVLGH WKH REMHFW ZKHQ \RX ILQLVK�

1RWH

<RX FDQQRW FUHDWH D SLH IURP DQ HOOLSVH �RU HOOLSWLFDO DUF� WKDW KDV
EHHQ FRQYHUWHG WR FXUYHV� URWDWHG� RU VNHZHG�

Converting an Ellipse into a Pie Wedge

<RX HGLW DQ HOOLSVH �RU HOOLSWLFDO DUF� WR FKDQJH LW LQWR D SLH ZHGJH� 'RXEOH

FOLFN WKH HOOLSVH ZLWK WKH VHOHFW SRLQWHU WR VHOHFW LW IRU UHVKDSLQJ� WKHQ GUDJ WKH

SRLQWHU LQ D FLUFXODU PRWLRQ LQVLGH WKH HOOLSVH� 3UHVV ESC RU GRXEOH FOLFN ZKHQ

\RX ILQLVK�

To convert an elli pse into a pie wed ge

1 'RXEOH FOLFN WKH HOOLSVH ZLWK WKH VHOHFW SRLQWHU WR VHOHFW LW IRU

UHVKDSLQJ�
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2 'UDJ WKH SRLQWHU LQ D FLUFXODU PRWLRQ LQVLGH WKH HOOLSVH� �'UDJJLQJ

RXWVLGH WKH HOOLSVH FUHDWHV DQ DUF LQVWHDG RI D ZHGJH��

3 3UHVV ESC RU GRXEOH FOLFN ZKHQ \RX ILQLVK�
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Working with Objects
Using the Object Explorer

7KH 2EMHFW ([SORUHU OLVWV WKH LWHPV LQ WKH FXUUHQW GUDZLQJ� <RX FDQ XVH WKH

2EMHFW ([SORUHU WR VHOHFW� PRYH� HGLW� UHPRYH� DQG HYHQ UHQDPH LWHPV�
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$ ��� RU ��� V\PERO DFFRPSDQLHV HDFK SDUHQW� $ SDUHQW LV DQ LWHP LQ WKH

GUDZLQJ �VXFK DV D SDJH� OD\HU� RU REMHFW� WKDW FRQWDLQV RWKHU LWHPV� 7R

H[SDQG WKH OLVW WR VKRZ WKH UHVRXUFHV EHORQJLQJ WR WKH SDUHQW� FOLFN WKH ���

V\PERO RU GRXEOH�FOLFN WKH SDUHQW� 7KH OLVW H[SDQGV� DQG WKH V\PERO FKDQJHV

WR D ��� V\PERO� &OLFN WKH ��� V\PERO RU GRXEOH�FOLFN WKH SDUHQW WR FROODSVH WKH

OLVW DJDLQ�

7R VHOHFW DQ REMHFW� FOLFN LWV QDPH� 7KH 2EMHFW ([SORUHU XVHV KLJKOLJKWLQJ WR

VKRZ ZKLFK LWHPV \RX KDYH VHOHFWHG� 7R VHOHFW PXOWLSOH UHVRXUFHV� KROG GRZQ

WKH SHIFT RU CTRL NH\ DV \RX FOLFN�

7R GLVSOD\ DQ REMHFWjV VKRUWFXW PHQX� ULJKW�FOLFN WKH REMHFW
V QDPH�

7R UHDUUDQJH WKH KLHUDUFK\ RI DQ REMHFW� GUDJ LW WR LWV QHZ SDUHQW�

7R UHQDPH DQ LWHP� FOLFN LWV QDPH� SDXVH EULHIO\� DQG WKHQ FOLFN WKH QDPH D

VHFRQG WLPH�

7R GLVSOD\ WKH 2EMHFW ([SORUHU DV D VHSDUDWH ZLQGRZ� GUDJ LW E\ LWV ERUGHU�
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Selecting an Object

'HVLJQHU RIIHUV \RX PDQ\ ZD\V WR HGLW� WUDQVIRUP� DQG UHVKDSH REMHFWV� <RX

FDQ VHOHFW� FRS\� SDVWH� UHVL]H� JURXS� FRQQHFW� DQG DOLJQ REMHFWV� DV ZHOO DV OLQN

DQG HPEHG :LQGRZV 2/( REMHFWV�

:KHQ \RX ZDQW WR DSSO\ DQ\ DFWLRQ WR DQ REMHFW� \RX ILUVW PXVW VHOHFW LW�

(LJKW VPDOO EOXH ER[HV FDOOHG KDQGOHV DSSHDU DURXQG DQ REMHFW ZKHQ LW LV

VHOHFWHG �LI WKH REMHFW LV D OLQH� RQO\ WZR KDQGOHV DSSHDU� RQH DW HDFK HQG�� ,I

VHYHUDO REMHFWV DUH VHOHFWHG DW RQFH� RXWHU KDQGOHV DSSHDU VXUURXQGLQJ DOO WKH

VHOHFWHG REMHFWV�

'HVLJQHU JLYHV \RX ILYH ZD\V WR VHOHFW REMHFWV�

v &OLFN WR VHOHFW�

v 6HOHFW DOO�

v 'UDJ WR EORFN VHOHFW�

v 6HOHFW E\ SURSHUW\�

v &OLFN REMHFW QDPHV LQ WKH 2EMHFW ([SORUHU�

1RWH

:DWFK WKH KDQGOHV� 7KH\ FDQ KHOS \RX GHWHUPLQH LI \RX
YH VHOHFWHG WKH
FRUUHFW REMHFW ZKHQ WKHUH DUH PDQ\ REMHFWV LQ RQH DUHD� <RX DOVR FDQ XVH
WKH VWDWXV EDU DW WKH ERWWRP RI WKH GUDZLQJ ZLQGRZ WR KHOS GHWHUPLQH LI
\RX
YH VHOHFWHG WKH FRUUHFW REMHFW� 7KH VWDWXV EDU VKRZV WKH VKDSH
VHOHFWHG� VXFK DV 5HFWDQJOH� /LQH� (OOLSVH� 3RO\JRQ� DQG VR RQ�

Clicking to Select Objects

7R VHOHFW REMHFWV E\ FOLFNLQJ� \RX PXVW EH LQ VHOHFW PRGH� <RX DUH LQ VHOHFW

PRGH ZKHQ WKH SRLQWHU EHFRPHV D VHOHFW SRLQWHU� 7KHUH DUH WZR ZD\V WR

HQWHU VHOHFW PRGH�
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7R VHOHFW DQ REMHFW� SRLQW WR LW ZLWK WKH WLS RI WKH VHOHFW SRLQWHU DQG FOLFN WKH

OHIW PRXVH EXWWRQ� <RX PXVW SRLQW WR DQ HOHPHQW RI WKH REMHFW VXFK DV D OLQH

RU FRORU� )RU H[DPSOH� WR VHOHFW DQ XQILOOHG FLUFOH� \RX SRLQW DQG FOLFN WKH HGJH

RI WKH FLUFOH� QRW WKH KROORZ LQWHULRU� ,I WKH LQWHULRU LV ILOOHG� \RX FDQ FOLFN

DQ\ZKHUH LQ WKH LQWHULRU WR VHOHFW WKH REMHFW�

,I \RX DUH LQ D GUDZLQJ PRGH� \RX FDQ SRLQW WR WKH REMHFW ZLWK D GUDZLQJ

SRLQWHU DQG GRXEOH FOLFN WR VHOHFW LW� 7KH EOXH KDQGOHV DSSHDU WR LQGLFDWH WKDW

WKH REMHFW LV VHOHFWHG�

1RWH

6LQJOH FOLFNLQJ DQ REMHFW LQ GUDZLQJ PRGH UHVXOWV LQ LPSOLHG VHOHFWLRQ RI WKH
REMHFW� LQGLFDWHG E\ D KROORZ VHOHFWLRQ KDQGOH� �)RU GHWDLOV RQ LPSOLHG
VHOHFWLRQ� VHH WKH VHFWLRQ k,PSOLHG 6HOHFWLRQy ODWHU LQ WKLV FKDSWHU��

7R VHOHFW DGGLWLRQDO REMHFWV� SUHVV DQG KROG VKLIW DQG FOLFN WKH RWKHU REMHFWV

WKDW \RX ZDQW WR LQFOXGH� %H FDUHIXO QRW WR PRYH WKH SRLQWHU ZKLOH FOLFNLQJ RU

\RX
OO PRYH WKH REMHFW�
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To select an ob ject b y clickin g it

` 7R VHOHFW DQ REMHFW� SRLQW WR LW ZLWK WKH WLS RI WKH VHOHFW SRLQWHU DQG FOLFN

WKH OHIW PRXVH EXWWRQ�

7LSV

<RX PXVW SRLQW WR DQ HOHPHQW RI WKH REMHFW VXFK DV D OLQH RU FRORU� )RU
H[DPSOH� WR VHOHFW DQ XQILOOHG FLUFOH� \RX SRLQW DQG FOLFN WKH HGJH RI WKH
FLUFOH� QRW WKH KROORZ LQWHULRU� ,I WKH LQWHULRU LV ILOOHG� \RX FDQ FOLFN DQ\ZKHUH
LQ WKH LQWHULRU WR VHOHFW WKH REMHFW�

,I \RX DUH LQ D GUDZLQJ PRGH� \RX FDQ SRLQW WR WKH REMHFW ZLWK D GUDZLQJ
SRLQWHU DQG GRXEOH FOLFN WR VHOHFW LW� 7KH EOXH KDQGOHV DSSHDU WR LQGLFDWH
WKDW WKH REMHFW LV VHOHFWHG�

6LQJOH FOLFNLQJ DQ REMHFW LQ GUDZLQJ PRGH UHVXOWV LQ ,PSOLHG 6HOHFWLRQ RI WKH
REMHFW� LQGLFDWHG E\ D KROORZ VHOHFWLRQ KDQGOH�

7R VHOHFW DGGLWLRQDO REMHFWV� SUHVV DQG KROG CTRL DQG FOLFN WKH RWKHU
REMHFWV WKDW \RX ZDQW WR LQFOXGH�

%H FDUHIXO QRW WR PRYH WKH SRLQWHU ZKLOH FOLFNLQJ RU \RXjOO PRYH WKH REMHFW�

Selecting Overlapping Objects

<RX FDQ VHOHFW RYHUODSSLQJ REMHFWV E\ SUHVVLQJ ALT ZKLOH FOLFNLQJ� (DFK FOLFN

VHOHFWV DQ REMHFW GHHSHU LQ WKH VWDFN� VWDUWLQJ ZLWK WKH REMHFW LQ IURQW�

7LS

8VLQJ ALT IRUFHV 'HVLJQHU WR DYRLG WKH URWDWH�VNHZ PRGH ZKHQ \RX FOLFN
DQ DOUHDG\�VHOHFWHG REMHFW� ,W DOVR OHWV \RX FOLFN DQ\ZKHUH LQVLGH DQ XQILOOHG
REMHFW WR VHOHFW LW�
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Deselecting Objects

&OLFN WKH OHIW PRXVH EXWWRQ DQ\ZKHUH DZD\ IURP DOO REMHFWV WR GHVHOHFW DOO

VHOHFWHG REMHFWV� ,I \RX ZDQW WR GHVHOHFW VRPH REMHFWV� EXW QRW RWKHUV� SRLQW

WR WKH REMHFW \RX ZDQW WR GHVHOHFW� SUHVV DQG KROG SHIFT� DQG FOLFN WKH OHIW

PRXVH EXWWRQ� 3RLQW WR DQRWKHU REMHFW WR GHVHOHFW DQG FOLFN DJDLQ� 5HOHDVH

SHIFT ZKHQ \RX ILQLVK�

Implied Selection

<RX FDQ FKDQJH DQ REMHFWjV LQWHULRU ILOO� OLQH VW\OH� RU RWKHU VW\OH DWWULEXWH

LPPHGLDWHO\ DIWHU GUDZLQJ LW ZLWKRXW H[SOLFLWO\ VHOHFWLQJ LW� 5HPHPEHULQJ WKH

ODVW GUDZQ REMHFW LV FDOOHG LPSOLHG VHOHFWLRQ�

,PSOLFLWO\ VHOHFWHG FORVHG REMHFWV KDYH RQH KROORZ KDQGOH� ,PSOLFLWO\ VHOHFWHG

RSHQ REMHFWV KDYH D KROORZ KDQGOH DW HDFK HQGSRLQW�

7LSV

6LQJOH FOLFNLQJ RQ DQ REMHFW ZKHQ \RXjUH LQ GUDZLQJ PRGH DOVR LPSOLFLWO\
VHOHFWV WKH REMHFW�

,PSOLFLWO\ VHOHFWHG REMHFWV FDQQRW EH UHVL]HG RU URWDWHG ZLWKRXW ILUVW
VHOHFWLQJ WKHP� &OLFN DZD\ IURP WKH REMHFW WR GHVHOHFW LW� &OLFN WKH (GLW WRRO
RU GRXEOH FOLFN WKH REMHFW WR H[SOLFLWO\ VHOHFW LW�
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Block Selecting Objects

<RX FDQ VHOHFW REMHFWV E\ XVLQJ WKH VHOHFW SRLQWHU WR GUDJ D UHFWDQJXODU EORFN

DURXQG WKH REMHFWV \RX ZDQW WR VHOHFW� 7R EORFN VHOHFW� \RX PXVW EH LQ HGLW

PRGH� 7KH HQWLUH REMHFW PXVW EH HQFORVHG LQ WKH UHFWDQJXODU EORFN EHIRUH

WKDW REMHFW LV VHOHFWHG�

1RWH

<RX FDQ DOVR EORFN VHOHFWLQJ REMHFWV E\ VHOHFWLQJ WKH $OZD\V EORFN VHOHFWV
RSWLRQ RQ WKH ,QSXW WDE RI WKH 2SWLRQV GLDORJ� 7R DFFHVV WKLV GLDORJ� VHOHFW
2SWLRQV IURP WKH 7RROV PHQX DQG FOLFN WKH ,QSXW WDE�

7LS

7KH HQWLUH REMHFW PXVW EH HQFORVHG LQ WKH UHFWDQJXODU EORFN EHIRUH WKDW
REMHFW LV VHOHFWHG�

<RX FDQ FDQFHO D EORFN VHOHFWLRQ E\ SUHVVLQJ ESC EHIRUH UHOHDVLQJ WKH
PRXVH EXWWRQ�

&KHFN WKH 6WDWXV %DU WR GHWHUPLQH KRZ PDQ\ REMHFWV \RX KDYH EORFN
VHOHFWHG� ,I \RX KDYH VHOHFWHG �� REMHFWV� IRU H[DPSOH� WKH VWDWXV WRROEDU
VKRZV 2EMHFWV �����
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Selecting All Objects

8VH DQ\ RI WKHVH PHWKRGV WR VHOHFW DOO WKH REMHFWV RQ WKH SDJH�

v 2Q WKH (GLW PHQX� &OLFN 6HOHFW $OO

v 3UHVV WKH NH\ERDUG VKRUWFXW CTRL+A RU F2

7R VHOHFW DOO REMHFWV H[FHSW WKRVH FXUUHQWO\ VHOHFWHG� SUHVV CTRL+SHIFT+A RU

SHIFT+F2�

Selecting by Name or Physical Characteristic

7KH 6HOHFW FRPPDQG RQ WKH (GLW PHQX �NH\ERDUG VKRUWFXW CTRL+SHIFT+F2�
RSHQV WKH 6HOHFW GLDORJ ER[� 7KLV GLDORJ ER[ OHWV \RX VHOHFW REMHFWV EDVHG RQ

WKHLU DWWULEXWHV DQG SURSHUWLHV�

7KH 6HOHFW 2EMHFW GLDORJ ER[ VKRZV D OLVW RI SRVVLEOH SK\VLFDO FKDUDFWHULVWLFV�

VXFK DV OLQH VW\OH� ILOO VW\OH� DQG IRQW� 6HOHFW DQ REMHFW DQG VHOHFW WKH DWWULEXWHV

IRU ZKLFK \RX ZDQW WR VHDUFK� 'HVLJQHU VHOHFWV RWKHU REMHFWV RQ WKH SDJH

ZLWK PDWFKLQJ DWWULEXWHV�
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)RU H[DPSOH� WR VHDUFK IRU REMHFWV ZLWK D \HOORZ LQWHULRU DQG ��SRLQW OLQH

WKLFNQHVV� VHOHFW DQ REMHFW PDWFKLQJ WKRVH VSHFLILFDWLRQV DQG VHOHFW ,QWHULRU )LOO

6W\OH DQG /LQH 7KLFNQHVV� $OO REMHFWV RQ WKH SDJH ZLWK D \HOORZ LQWHULRU DQG D

��SRLQW WKLFNQHVV DUH VHOHFWHG�

To select ob jects b y attribute

1 6HOHFW WKH REMHFW XSRQ ZKLFK \RX ZDQW WR EDVH \RXU VHDUFK�

2 2SHQ WKH (GLW PHQX DQG FKRRVH 6HOHFW� 7KH 6HOHFW GLDORJ ER[ RSHQV�

3 6HOHFW WKH DWWULEXWHV IRU ZKLFK WR VHDUFK� )RU H[DPSOH� LI WKH VHOHFWHG

REMHFW KDV D UHG LQWHULRU DQG \RX FKRRVH ILOO FRORU� DOO REMHFWV ZLWK UHG

LQWHULRUV DUH VHOHFWHG�

4 &OLFN 6HOHFW�

Selecting Objects by Property Value

<RX FDQ W\SH D YDOXH LQWR WKH 3URSHUW\ 9DOXH WH[W ER[ DQG VHOHFW REMHFWV

ZLWK WKDW YDOXH� 7KH YDOXH LV DVVRFLDWHG ZLWK WKH SURSHUW\ FKRVHQ LQ WKH

3URSHUW\ GURS�GRZQ OLVW ER[� <RX FDQ HLWKHU VHOHFW RWKHU REMHFWV ZLWK WKH

VDPH YDOXH RU XVH ZLOGFDUG FKDUDFWHUV WR GHVLJQDWH WKH SRUWLRQV RI QDPHV WR

VHDUFK IRU�

)RU H[DPSOH� LI WKH YDOXH IRU WKH SURSHUW\ k1DPHy LV kEROW��y EXW \RX ZDQW WR

VHOHFW DOO W\SHV RI EROWV� \RX FDQ W\SH kEROW
y WR VHOHFW EROW�� EROW�� DQG VR RQ�

:LOGFDUG FKDUDFWHUV OHW \RX VHDUFK IRU SDUWLDO PDWFKHV� 8VH k"y IRU VLQJOH

FKDUDFWHUV� XVH k
y IRU PXOWLSOH FKDUDFWHUV�

To select ob jects b y propert y value

1 2SHQ WKH (GLW PHQX DQG FKRRVH 6HOHFW� 7KH 6HOHFW GLDORJ ER[ RSHQV�

2 &KRRVH D SURSHUW\ \RX ZDQW WR VHDUFK IRU LQ WKH )LHOG OLVW ER[�

3 7\SH WKH YDOXH RI WKH SURSHUW\� <RX FDQ XVH ZLOGFDUG FKDUDFWHUV WR

VHDUFK IRU SDUWLDO PDWFKHV�

4 &OLFN 6HOHFW�
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Selecting Matching Objects

$IWHU \RX HQWHU WKH FKDUDFWHULVWLFV RI WKH REMHFWV \RX ZDQW WR VHOHFW� \RX FDQ

FOLFN 6HOHFW WR VHOHFW DOO PDWFKLQJ REMHFWV RQ WKH FXUUHQW OD\HU DQG SDJH�

,I \RX ZDQW WR VHOHFW DGGLWLRQDO VHWV RI REMHFWV ZLWKRXW GHVHOHFWLQJ WKH

FXUUHQW REMHFWV� FOLFN $SSHQG� VHOHFW DQRWKHU VHW RI REMHFWV� FOLFN $SSHQG

DJDLQ� DQG VR RQ�

<RX FDQ VHOHFW PDWFKLQJ REMHFWV RQH DW D WLPH E\ XVLQJ WKH 1H[W 0DWFKLQJ

2EMHFW RSWLRQ� &OLFN 6HOHFW WR GHVHOHFW WKH ILUVW REMHFW DQG VHOHFW WKH QH[W

RQH�

Other Clicking Actions

&OLFN DQ DOUHDG\�VHOHFWHG REMHFW ZLWK WKH VHOHFW SRLQWHU WR SODFH LW LQ URWDWH�

VNHZ PRGH� 5RWDWH�VNHZ VHOHFWLRQ LV LQGLFDWHG E\ WKH DSSHDUDQFH RI VSHFLDO

URWDWH DQG VNHZ KDQGOHV�

'RXEOH FOLFN DQ REMHFW ZLWK WKH VHOHFW SRLQWHU WR SODFH LW LQ UHVKDSH PRGH�

'LIIHUHQW W\SHV RI REMHFWV KDYH GLIIHUHQW UHVKDSLQJ LQGLFDWRUV�
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7R EH FHUWDLQ WKDW \RX DUH LQ WKH FRUUHFW PRGH� FKHFN WKH GRXEOH�OLQH VWDWXV

WRROEDU� ,I WKH REMHFW LV VHOHFWHG IRU 5RWDWH�6NHZ� WKH GRXEOH OLQH VWDWXV

WRROEDU VKRZV 5RWDWH DQG 6NHZ 0RGH� ,I WKH REMHFW LV VHOHFWHG IRU UHVKDSLQJ�

WKH VWDWXV WRROEDU VKRZV WKH UHVKDSH PRGH� 7R WXUQ RQ WKH VWDWXV WRROEDU�

FOLFN 6WDWXV %DU RQ WKH 9LHZ PHQX� DQG FOLFN 'RXEOH�

Moving an Object

<RX FDQ PRYH DQ REMHFW LQ VHYHUDO ZD\V� <RX FDQ PRYH DQ REMHFW XVLQJ WKH

PRXVH RU ZLWK WKH DUURZ NH\V RQ \RXU NH\ERDUG� <RX FDQ DOVR PRYH DQ

REMHFW QXPHULFDOO\ IRU PRUH SUHFLVLRQ� ,W LV DOVR SRVVLEOH WR PRYH DQ REMHFW

ZKLOH GUDZLQJ LW�

7LS

+ROG WKH PRXVH VWLOO IRU RQH VHFRQG ZKHQ PRYLQJ DQ REMHFW WR GLVSOD\ D
ZLUHIUDPH RXWOLQH RI WKH REMHFW WR KHOS \RX SRVLWLRQ LW�

To move an ob ject with the mouse

1 6HOHFW RQH RU PRUH REMHFWV \RX ZDQW WR PRYH�

2 3RVLWLRQ WKH SRLQWHU DQ\ZKHUH LQVLGH WKH REMHFW RU JURXS RI REMHFWV

�GR QRW SODFH WKH SRLQWHU RQ D KDQGOH��

3 'UDJ WKH REMHFW WR WKH QHZ SRVLWLRQ�
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4 5HOHDVH WKH PRXVH EXWWRQ�

1RWH

,Q RUGHU WR EH DEOH WR VHOHFW DQ REMHFW DQG PRYH LW ZLWK RQH PRWLRQ� VHOHFW
2SWLRQV IURP WKH 7RROV PHQX DQG FOLFN WKH ,QSXW WDE RQ WKH 2SWLRQV
GLDORJ� &OLFN WKH 6HOHFWV DQG PRYHV RQH REMHFW RSWLRQ�

7LSV

+ROG WKH PRXVH VWLOO IRU RQH VHFRQG ZKHQ PRYLQJ DQ REMHFW WR GLVSOD\ D
ZLUHIUDPH RXWOLQH RI WKH REMHFW WR KHOS \RX SRVLWLRQ LW�

<RX FDQ FDQFHO D PRYH E\ SUHVVLQJ ESC EHIRUH UHOHDVLQJ WKH OHIW PRXVH
EXWWRQ� 7KH REMHFW UHWXUQV WR LWV RULJLQDO SRVLWLRQ�

8VH WKH FRRUGLQDWHV GLVSOD\HG LQ WKH 6WDWXV %DU WR SRVLWLRQ REMHFWV
SUHFLVHO\�

To move an ob ject with the arrow ke ys

1 6HOHFW RQH RU PRUH REMHFWV \RX ZDQW WR PRYH�

2 3RLQW DQ\ZKHUH LQVLGH WKH REMHFW RU JURXS RI REMHFWV �GR QRW SRLQW WR

D KDQGOH��

3 3UHVV DQG KROG WKH VSDFHEDU�

4 3UHVV DQ DUURZ NH\ WR QXGJH WKH REMHFW�

5 5HOHDVH WKH VSDFHEDU ZKHQ \RX ILQLVK�

Moving an Object While Drawing it

7KLV XVHIXO IHDWXUH OHWV \RX PRYH DQ REMHFW EHIRUH \RX ILQLVK GUDZLQJ LW�

7R PRYH DQ REMHFW ZKLOH GUDZLQJ� SUHVV DQG KROG WKH ULJKW PRXVH EXWWRQ

ZLWKRXW UHOHDVLQJ WKH OHIW PRXVH EXWWRQ� 0RYH WKH RXWOLQH RI WKH XQILQLVKHG

GUDZLQJ WR LWV QHZ SRVLWLRQ� 5HOHDVH WKH ULJKW PRXVH EXWWRQ DQG FRQWLQXH

GUDZLQJ�
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To move an ob ject while drawin g

1 6WDUW GUDZLQJ�

2 3UHVV DQG KROG WKH ULJKW PRXVH EXWWRQ ZLWKRXW UHOHDVLQJ WKH OHIW

PRXVH EXWWRQ�

3 0RYH WKH RXWOLQH RI WKH XQILQLVKHG GUDZLQJ WR LWV QHZ SRVLWLRQ�

4 5HOHDVH WKH ULJKW PRXVH EXWWRQ DQG FRQWLQXH GUDZLQJ�

Constraining an Object’s Movement

3UHVV DQG KROG 6+,)7 ZKLOH PRYLQJ DQ REMHFW WR VQDS WR D SDWK RI PRYHPHQW

WKDW LV LQ ���GHJUHH LQFUHPHQWV IURP WKH RULJLQDO SRVLWLRQ� <RX FDQ XVH WKLV

WHFKQLTXH WR FRQVWUDLQ WKH REMHFW
V PRYHPHQW WR D YHUWLFDO SDWK �� GHJUHHV

RU ��� GHJUHHV� RU D KRUL]RQWDO SDWK ��� GHJUHHV RU ��� GHJUHHV�� 8VLQJ 6+,)7

LQ WKLV ZD\ RYHUULGHV WKH 6QDS WR 5XOHUV FRPPDQG LQ WKH 7RROV�6QDS PHQX� LI

QHFHVVDU\� WR FRQVWUDLQ WR WKH ���GHJUHH DQJOH�

Applying Multiple Changes to an Object

<RX FDQ XVH WKH 7UDQVIRUP GLDORJ ER[ WR PDNH D VHULHV RI FKDQJHV WR DQ

REMHFW E\ UHFRUGLQJ HDFK LQGLYLGXDO FKDQJH� WKHQ DSSO\LQJ WKHP DOO DW WKH

VDPH WLPH�

)RU H[DPSOH� \RX FDQ PRYH DQ REMHFW � LQFKHV ULJKW� � LQFK GRZQ� DQG WKHQ

PDNH LW WZLFH DV ODUJH� <RX DOVR FDQ DSSO\ WKHVH WUDQVIRUPDWLRQV WR RWKHU

REMHFWV� LI \RX ZDQW�

To apply multi ple chan ges to an ob ject

1 2Q WKH $UUDQJH PHQX� FOLFN 7UDQVIRUP�

2 &OLFN RQH RI WKH VXEPHQX FRPPDQGV WR GLVSOD\ WKH 7UDQVIRUP GLDORJ

ER[�

3 &OLFN WKH 'HWDLOV EXWWRQ WR VKRZ WKH 0XOWLSOH 7UDQVIRUPV DUHD�

4 &OLFN D WUDQVIRUP WDE DQG VHOHFW WKH WUDQVIRUPDWLRQ DPRXQWV� RULJLQ�

DQG WKH QXPEHU RI FRSLHV�
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5 &OLFN $GG LQ WKH 0XOWLSOH 7UDQVIRUPV DUHD� 7KH WUDQVIRUP W\SH DQG

DPRXQW DSSHDUV�

6 5HSHDW VWHSV � DQG � WR DGG PRUH WUDQVIRUPDWLRQV WR WKH OLVW�

7 6HOHFW DQ REMHFW DQG FOLFN $SSO\ WR DSSO\ WKH PXOWLSOH WUDQVIRUPV�

Updating a Remembered Transformation

5HPHPEHUHG WUDQVIRUPV UHPDLQ LQ WKH PXOWLSOH WUDQVIRUPV ER[ XQWLO \RX

FORVH 'HVLJQHU RU WUDQVIRUP DQ REMHFW DQG UHRSHQ WKH 7UDQVIRUP GLDORJ ER[�

<RX FDQ XSGDWH D UHPHPEHUHG WUDQVIRUP EDVHG RQ LWV FXUUHQW VHWWLQJV�

To update a remembered transformation

1 2Q WKH $UUDQJH PHQX� FOLFN 7UDQVIRUP�

2 &OLFN RQH RI WKH VXEPHQX FRPPDQGV WR GLVSOD\ WKH 7UDQVIRUP GLDORJ

ER[�

3 &OLFN WKH 'HWDLOV EXWWRQ WR VKRZ WKH 0XOWLSOH 7UDQVIRUPV DUHD�

4 +LJKOLJKW WKH UHPHPEHUHG WUDQVIRUP \RX ZDQW WR FKDQJH

5 0DNH WKH FKDQJHV LQ WKH OHIW SRUWLRQ RI WKH GLDORJ ER[� DQG FOLFN

0RGLI\� 7KH QHZ PHDVXUHPHQWV DSSHDU�

To delete a remembered transformation

1 &OLFN (PSW\ WR GHOHWH DOO UHPHPEHUHG WUDQVIRUPV� RU

2 &OLFN 'HOHWH WR GHOHWH WKH ODVW WUDQVIRUP RQ WKH OLVW�

Duplicating Objects

7KHUH DUH IRXU ZD\V WR GXSOLFDWH DQ REMHFW�

v )URP WKH (GLW PHQX� VHOHFW 'XSOLFDWH�

v )URP WKH (GLW PHQX� VHOHFW &ORQH�

v 3UHVV CTRL DQG GUDJ D FRS\�
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v 8VH WKH &RSLHV RSWLRQ LQ WKH 7UDQVIRUP GLDORJ ER[�

To dra g a copy

1 6HOHFW WKH REMHFW \RX ZDQW WR FRS\�

2 3UHVV DQG KROG CTRL�

3 'UDJ WKH GXSOLFDWH REMHFW WR D QHZ SRVLWLRQ�

4 5HOHDVH WKH PRXVH EXWWRQ DQG WKHQ UHOHDVH CTRL�

To du plicate usin g the menu

1 6HOHFW WKH REMHFW \RX ZDQW WR FRS\�

2 )URP WKH (GLW PHQX� VHOHFW 'XSOLFDWH�

1RWH

<RX FDQ VHW WKH RIIVHW IRU WKH GXSOLFDWH E\ VHOHFWLQJ 2SWLRQV IURP WKH
7RROV PHQX DQG FOLFNLQJ WKH *HQHUDO WDE� (QWHU WKH KRUL]RQWDO DQG YHUWLFDO
XQLWV LQ WKH 2IIVHW )RU 'XSOLFDWH VHFWLRQ�

7R FUHDWH D GXSOLFDWH ZLWK QR RIIVHW� VHOHFW &ORQH IURP WKH (GLW PHQX� ZLWK
WKH REMHFW VHOHFWHG�

7LS

7R URWDWH RU VNHZ D FRS\ RI DQ REMHFW� SUHVV DQG KROG CTRL ZKLOH URWDWLQJ
RU VNHZLQJ�

Scaling Objects

Resizing Objects Manually

<RX FDQ FKDQJH WKH VL]H DQG VKDSH RI DQ REMHFW E\ VHOHFWLQJ LW DQG GUDJJLQJ

RQH RI LWV KDQGOHV�
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7KHUH DUH WZR W\SHV RI KDQGOHV� FRUQHU DQG VLGH�

v &RUQHU KDQGOHV �DW WKH IRXU FRUQHUV RI WKH ERXQGLQJ ER[� HQODUJH RU

VKULQN DQ REMHFW ZKLOH PDLQWDLQLQJ LWV RULJLQDO SURSRUWLRQV�

RU

v 6LGH KDQGOHV �DW WKH FHQWHU RI HDFK VLGH RI WKH ERXQGLQJ ER[� VWUHWFK

DQ REMHFW DQG FKDQJH LWV SURSRUWLRQV�

To resize an ob ject manuall y

1 6HOHFW WKH REMHFW WR UHVL]H�

2 0RYH WKH SRLQWHU WR RQH RI WKH REMHFW
V HLJKW KDQGOHV�

3 'UDJ WKH KDQGOH WR UHVL]H WKH REMHFW�

4 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK�

7LS

7R NHHS \RXU LPDJH SURSRUWLRQDO� SUHVV DQG KROG WKH SHIFT NH\
ZKLOH GUDJJLQJ D FRUQHU KDQGOH� 3UHVV DQG KROG WKH CTRL NH\ ZKLOH
GUDJJLQJ D FRUQHU KDQGOH WR UHVL]H D UHFWDQJOH WR D VTXDUH RU DQ
HOOLSVH WR D FLUFOH�
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Resizing Objects Numerically

<RX FDQ XVH WKH 6FDOH SDQHO LQ WKH 7UDQVIRUP GLDORJ ER[ WR SUHFLVHO\ UHVL]H DQ

REMHFW� 2SHQ WKH &KDQJH PHQX� FKRRVH 7UDQVIRUP� DQG FKRRVH 6FDOH WR

GLVSOD\ WKH 6FDOH SDQHO RI WKH 7UDQVIRUP GLDORJ ER[�

1RWH

7KH PHDVXUHPHQWV RI WKH ODVW WUDQVIRUPDWLRQ DSSHDU LQ WKH 7UDQVIRUP
GLDORJ ER[� )RU H[DPSOH� LI \RX PDQXDOO\ UHVL]H DQ REMHFW WR ��� RI LWV
RULJLQDO VL]H DQG RSHQ WKH 7UDQVIRUP GLDORJ ER[� �� DSSHDUV LQ WKH 6FDOH
SDQHO�

<RX QXPHULFDOO\ UHVL]H DQ REMHFW E\ VHOHFWLQJ D REMHFW DQG HQWHULQJ D

SHUFHQWDJH RI WKH FXUUHQW VL]H� 7KH FXUUHQW VL]H LV ����� $ QXPEHU EHORZ

���� GHFUHDVHV� DQG D QXPEHU DERYH ���� LQFUHDVHV WKH VL]H� 'HVLJQHU

GLVSOD\V D SUHYLHZ RI WKH UHVL]HG REMHFW DV D UHFWDQJXODU RXWOLQH�

7KH KRUL]RQWDO QXPEHU DIIHFWV WKH VLGH�WR�VLGH VL]H� WKH YHUWLFDO QXPEHU

DIIHFWV WKH WRS�WR�ERWWRP VL]H� 7KH KRUL]RQWDO DQG YHUWLFDO VL]HV DUH WKH VDPH

XQOHVV \RX GHVHOHFW WKH 3URSRUWLRQDO 6FDOH RSWLRQ�
W o r k i n g  w i t h  O b j e c t s  159



7KH 6FDOH SDQHO RI WKH 7UDQVIRUP GLDORJ ER[ OHWV \RX UHVL]H DQ REMHFW EDVHG

RQ LWV FXUUHQW VL]H� )RU H[DPSOH� LI \RX HQODUJH D FLUFOH WR ���� DQG WKHQ W\SH

200 WR HQODUJH LW WR DQRWKHU ����� WKH FLUFOH LV HQODUJHG DQ DGGLWLRQDO

DPRXQW�

1RWH

%HIRUH \RX FDQ WUDQVIRUP DQ REMHFW LPSRUWHG DV D :0) ILOH� \RX PXVW
FRQYHUW WKH REMHFW WR FXUYHV�

To resize an ob ject numericall y

1 6HOHFW WKH REMHFW WR VFDOH�

2 2SHQ WKH $UUDQJH PHQX DQG FKRRVH 7UDQVIRUP�

3 &KRRVH 6FDOH WR GLVSOD\ WKH 6FDOH SDQHO�

4 6HOHFW WKH RULJLQ RI WKH UHVL]H LQ WKH 2ULJLQ OLVW ER[� LI \RX ZDQW�

5 7\SH D QXPEHU LQ WKH +RUL]RQWDO DQG 9HUWLFDO ER[HV� $ UHG RXWOLQH RI

WKH UHVL]HG REMHFW DSSHDUV DV D SUHYLHZ�

6 7\SH WKH QXPEHU RI FRSLHV \RX ZDQW WR PDNH� LI DQ\�

7 &OLFN $SSO\ WR DFFHSW WKH FKDQJH�

1RWH

<RX FDQ DOVR UHVL]H DQ REMHFW QXPHULFDOO\ E\ XVLQJ WKH &RRUGLQDWHV GLDORJ�
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Scaling an Object in the Transform Dialog Box

,I \RX GLVSOD\ WKH 7UDQVIRUP GLDORJ ER[ E\ FOLFNLQJ 7UDQVIRUP DQG WKHQ 5HSHDW

/DVW RQ WKH $UUDQJH PHQX� WKH PHDVXUHPHQWV RI WKH ODVW WUDQVIRUPDWLRQ

DSSHDU LQ WKH 7UDQVIRUP GLDORJ ER[� )RU H[DPSOH� LI \RX PDQXDOO\ UHVL]H DQ

REMHFW WR ��� RI LWV RULJLQDO VL]H DQG XVH 5HSHDW /DVW WR RSHQ WKH 7UDQVIRUP

GLDORJ ER[� 50 DSSHDUV LQ WKH 6FDOH SDQHO�

$ UHVL]H GRHV QRW DSSHDU LI \RX UHVL]H DQ REMHFW ZKLOH WKH 7UDQVIRUP GLDORJ

ER[ LV RSHQ�

Making Equally Resized Copies

<RX FDQ FUHDWH DQ DUUD\ RI HTXDOO\ VL]HG FRSLHV E\ XVLQJ WKH WUDQVIRUP GLDORJ

ER[� 7\SH WKH QXPEHU RI FRSLHV \RX ZDQW WR PDNH� 7KH RULJLQDO REMHFW LV QRW

DIIHFWHG� 'HVLJQHU VKRZV WKH ILUVW DQG ODVW SUHYLHZ FRS\ LQ UHG DQG RWKHU

FRSLHV LQ EOXH� 2QO\ WKH ILUVW ILYH DQG ODVW ILYH FRSLHV DUH SUHYLHZHG�
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Flipping Objects

Flipping Manually

To fli p an ob ject manuall y

` 'UDJ D KDQGOH DFURVV WKH REMHFW
V RSSRVLWH VLGH�

7LS

7KH DFWLRQ LV VLPLODU WR WXUQLQJ WKH SDJH RI D ERRN�
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Flipping Numerically

<RX FDQ XVH WKH )OLS SDQHO RI WKH 7UDQVIRUP GLDORJ ER[ WR IOLS DQ REMHFW DW D

VSHFLILF DQJXODU YDOXH�

:KHQ \RX IOLS DQ REMHFW QXPHULFDOO\� \RX VSHFLI\ DQ LPDJLQDU\ OLQH WKDW SDVVHV

WKURXJK RU EHVLGH DQ REMHFW DW DQ\ DQJOH� 7KH REMHFW EHKDYHV DV WKRXJK LW LV

KLQJHG WR WKH OLQH� DQG IOLSV RYHU LW�

7R QXPHULFDOO\ IOLS DQ REMHFW� \RX VSHFLI\ DQ LPDJLQDU\ OLQH WKDW SDVVHV

WKURXJK RU EHVLGH DQ REMHFW DW DQ\ DQJOH� 7KH REMHFW EHKDYHV DV WKRXJK LW LV

KLQJHG WR WKH OLQH DQG IOLSV RYHU LW�

7R IOLS DQ REMHFW DW D VSHFLILHG DQJOH� VHOHFW WKH SRLQW DV ZKLFK WKH IOLS RFFXUV

IURP WKH 2ULJLQ OLVW ER[� DQG WKHQ W\SH DQ DQJOH IRU WKH IOLS D[LV LQ WKH DQJOH

ER[�

<RX FDQ SODFH WKH LPDJLQDU\ D[LV DW ZKLFK IOLSSLQJ RFFXUV DW DQ\ RI WKH WHQ

REMHFW RULJLQ SRLQWV� )RU H[DPSOH� VHOHFW WKH FHQWHU RULJLQ WR IOLS DQ REMHFW

DURXQG D FHQWUDO D[LV� RU VHOHFW WKH ULJKW PLGGOH RULJLQ WR IOLS WKH REMHFW

DURXQG LWV ULJKW VLGH�

To fli p an ob ject horizontall y or verticall y

1 6HOHFW WKH REMHFW \RX ZDQW WR IOLS�

2 2Q WKH $UUDQJH PHQX� FOLFN 7UDQVIRUP� DQG WKHQ FOLFN )OLS WR GLVSOD\

WKH )OLS SDQHO�
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3 &KRRVH )OLS +RUL]RQWDO WR IOLS WKH REMHFW KRUL]RQWDOO\ �OLNH D SDJH LQ D

ERRN�� RU FKRRVH )OLS 9HUWLFDO�

To fli p an ob ject at a specified an gle

1 6HOHFW WKH REMHFW \RX ZDQW WR IOLS�

2 2Q WKH &KDQJH PHQX� FOLFN 7UDQVIRUP�

3 &KRRVH )OLS WR GLVSOD\ WKH )OLS SDQHO�

4 ,Q WKH 2ULJLQ OLVW ER[� VHOHFW D SRLQW RQ WKH REMHFW� 7KLV LV WKH SRLQW WKDW

WKH IOLS D[LV SDVVHV WKURXJK�

5 7\SH DQ DQJOH IURP � WR ��� LQ WKH $QJOH ER[ RU GUDJ WKH UHG QHHGOH

WR VSHFLI\ D IOLS DQJOH�

7LS

<RX FDQ SODFH WKH LPDJLQDU\ D[LV DW ZKLFK IOLSSLQJ RFFXUV DW DQ\ RI WKH WHQ
REMHFW RULJLQ SRLQWV� )RU H[DPSOH� VHOHFW WKH FHQWHU RULJLQ WR IOLS DQ REMHFW
DURXQG D FHQWUDO D[LV� RU VHOHFW WKH ULJKW PLGGOH RULJLQ WR IOLS WKH REMHFW
DURXQG LWV ULJKW VLGH�

To make co pies of an ob ject while fli pping it

1 6HOHFW WKH REMHFW \RX ZDQW WR IOLS�

2 2Q WKH $UUDQJH PHQX� FOLFN 7UDQVIRUP�

3 &KRRVH )OLS WR GLVSOD\ WKH )OLS SDQHO�
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4 7\SH WKH QXPEHU RI FRSLHV LQ WKH &RSLHV ER[� 'HVLJQHU UHSHDWV WKH

IOLSSLQJ� SODFLQJ FRSLHV RQ WRS RI RQH DQRWKHU�

7LS

$V D VKRUWFXW� SUHVV )� WR IOLS KRUL]RQWDOO\� 3UHVV SHIFT�)� WR IOLS
YHUWLFDOO\�

Rotating Objects

Rotating Objects Manually

7KH PDQXDO PHWKRG OHWV \RX XVH WKH SRLQWHU WR URWDWH DQ REMHFW� <RX

PDQXDOO\ URWDWH E\ GUDJJLQJ D FRUQHU KDQGOH LQ D FLUFXODU PRWLRQ DURXQG D

SLYRW SRLQW�

To rotate an ob ject manuall y

1 6HOHFW WKH REMHFW \RX ZDQW WR URWDWH� DQG WKHQ FOLFN WKH 5RWDWH�6NHZ

EXWWRQ LQ WKH WRROEDU�

2 'UDJ WKH SLYRW SRLQW WR D QHZ ORFDWLRQ� HYHQ RXWVLGH WKH REMHFW� LI \RX

ZDQW�

3 0RYH WKH SRLQWHU WR D FRUQHU KDQGOH�

4 'UDJ LQ D FLUFXODU PRWLRQ DURXQG WKH REMHFW�
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5 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX DUH ILQLVKHG�

7LS

3UHVV DQG KROG &75/ ZKLOH GUDJJLQJ D FRUQHU KDQGOH WR FRQVWUDLQ
WKH URWDWLRQ RI DQ REMHFW WR ���GHJUHH LQFUHPHQWV� 3UHVV DQG KROG
SHIFT ZKLOH GUDJJLQJ D FRUQHU KDQGOH WR URWDWH D FRS\ RI DQ
REMHFW�

<RX FDQ FDQFHO D URWDWLRQ E\ SUHVVLQJ ESC EHIRUH UHOHDVLQJ WKH OHIW PRXVH

EXWWRQ� 7KH REMHFW UHWXUQV WR LWV RULJLQDO SRVLWLRQ�

Constraining Manual Rotation

<RX FDQ FRQVWUDLQ URWDWLRQV WR IL[HG LQFUHPHQWV E\ VHWWLQJ D 0DQXDO 5RWDWLRQ

,QFUHPHQW YDOXH LQ WKH 5RWDWLRQ SDQHO RI WKH 2SWLRQV GLDORJ ER[� )RU

H[DPSOH� LI WKH 0DQXDO 5RWDWLRQ ,QFUHPHQW LV VHW WR �� GHJUHHV� WKHQ DQ

REMHFW URWDWHV LQ ���GHJUHH LQFUHPHQWV ZKHQ \RX GUDJ LWV FRUQHU KDQGOHV�

To chan ge the Manual Rotation Increment

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV�

2 &OLFN 5RWDWLRQ WR JR WR WKH 5RWDWH WDE�

3 (QWHU WKH URWDWLRQ DPRXQW LQ WKH 0DQXDO 5RWDWLRQ ,QFUHPHQW ER[ �RU

GUDJ WKH UHG QHHGOH LQ WKH GLDO FRQWURO��
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Using the Preset Rotation Key

<RX FDQ URWDWH DQ REMHFW D SUHVHW DPRXQW E\ VHOHFWLQJ WKH REMHFW DQG

SUHVVLQJ F8� (DFK WLPH \RX SUHVV F8� WKH REMHFW LV URWDWHG WKH SUHVHW DPRXQW�

7KH LQLWLDO VHWWLQJ IRU WKH F8 NH\ LV �� GHJUHHV�

To chan ge the rotation ke y settin g

1 )URP WKH 7RROV PHQX� FOLFN 2SWLRQV� 7KH 2SWLRQV GLDORJ RSHQV�

2 &OLFN 5RWDWLRQ�

3 ,Q WKH )� 5RWDWLRQ ,QFUHPHQW ER[� GUDJ WKH UHG QHHGOH WR WKH GHVLUHG

LQFUHPHQW� RU W\SH LQ WKH DQJOH�

4 &OLFN 2. WR FORVH WKH 2SWLRQV GLDORJ�

Rotating Objects Numerically

<RX FDQ XVH WKH 5RWDWH SDQHO RI WKH 7UDQVIRUP GLDORJ ER[ WR SUHFLVHO\ URWDWH

DQ REMHFW E\ VSHFLI\LQJ WKH GHJUHH RI URWDWLRQ� 2SHQ WKH $UUDQJH PHQX�

FKRRVH 7UDQVIRUP� DQG FKRRVH 5RWDWH WR GLVSOD\ WKH 5RWDWH SDQHO�
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Setting the Rotation Angle

:KHQ \RX FKRRVH 5HSHDW 7UDQVIRUP� WKH PHDVXUHPHQWV RI WKH ODVW

WUDQVIRUPDWLRQ DSSHDU LQ WKH 7UDQVIRUP GLDORJ ER[� )RU H[DPSOH� LI \RX

PDQXDOO\ URWDWH DQ REMHFW �� GHJUHHV DQG FKRRVH 5HSHDW 7UDQVIRUP� ��

DSSHDUV LQ WKH $QJOH ER[�

Changing the Pivot Point

7KH SLYRW SRLQW GHIDXOWV WR WKH FHQWHU RI WKH REMHFW� EXW \RX FDQ GUDJ LW

DQ\ZKHUH LQVLGH RU RXWVLGH WKH REMHFW�

<RX FDQ SHUPDQHQWO\ UHSRVLWLRQ DQ REMHFW
V SLYRW SRLQW E\ SUHVVLQJ 6+,)7

ZKLOH GUDJJLQJ LW WR D QHZ SRVLWLRQ� 7R UHWXUQ WKH SHUPDQHQW SLYRW SRLQW WR

WKH FHQWHU RI WKH REMHFW� XVH D FHQWHU VQDS SRLQW DQG WKHQ SUHVV 6+,)7 DQG

GUDJ WKH SLYRW SRLQW EDFN WR WKH FHQWHU�

To rotate an ob ject numericall y

1 6HOHFW WKH REMHFW WR URWDWH�

2 2Q WKH $UUDQJH PHQX� FOLFN 7UDQVIRUP� $ VXEPHQX RSHQV�

3 &OLFN 5RWDWH WR GLVSOD\ WKH 5RWDWH SDQHO�

4 7\SH D QXPEHU LQ WKH $QJOH ER[� RU GUDJ WKH GLDO WR VSHFLI\ D URWDWLRQ

DQJOH�

5 6HOHFW D QHZ SLYRW SRLQW LQ WKH 2ULJLQ OLVW ER[� LI \RX ZLVK�

6 &OLFN $SSO\ WR URWDWH WKH REMHFW�
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Copying Rotated/ Skewed Objects

<RX FDQ FUHDWH DQ DUUD\ RI URWDWHG RU VNHZHG REMHFWV EHWZHHQ WKH RULJLQDO

REMHFW DQG LWV ILQDO SRVLWLRQ� 'HVLJQHU VKRZV WKH ILUVW DQG ODVW SUHYLHZ FRS\ LQ

UHG DQG RWKHU FRSLHV LQ EOXH� 2QO\ WKH ILUVW ILYH DQG ODVW ILYH FRSLHV DUH

SUHYLHZHG�

To co py rotated/skewed ob jects

1 6HOHFW WKH REMHFW WR URWDWH�

2 )URP WKH $UUDQJH PHQX� FOLFN 7UDQVIRUP� $ VXEPHQX RSHQV�

3 &OLFN 5RWDWH RU 6NHZ DQG W\SH WKH VSHFLILFDWLRQV \RX ZDQW�

4 7\SH WKH QXPEHU RI FRSLHV \RX ZDQW WR FUHDWH�

5 &OLFN $SSO\ WR GUDZ WKH FRSLHV�
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Grouping Rotated/ Skewed Copies

2IWHQ LW LV EHVW WR JURXS FRSLHV WRJHWKHU ZKLOH URWDWLQJ� PRYLQJ� VFDOLQJ� RU

VNHZLQJ D SDUWLFXODU REMHFW� %\ GRLQJ VR� \RX FDQ HDVLO\ PRYH D JURXS RI

REMHFWV DW RQFH ZLWKRXW GLVUXSWLQJ WKH SRVLWLRQLQJ RI HDFK LQGLYLGXDO REMHFW

<RX FDQ FUHDWH DQ DUUD\ RI VNHZHG REMHFWV EHWZHHQ WKH RULJLQDO REMHFW DQG

LWV ILQDO SRVLWLRQ�
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Changing the Order of Objects

<RX FDQ UHRUGHU WKH VWDFNLQJ DUUDQJHPHQW RI REMHFWV ZLWK WKH 2UGHU

FRPPDQG RQ WKH &KDQJH PHQX�

<RX FDQ RQO\ FKDQJH WKH RUGHU RI REMHFWV RQ WKH FXUUHQW OD\HU� ,I \RX DUH

XVLQJ PXOWLSOH OD\HUV� REMHFWV RQ XSSHU OD\HUV DOZD\V DSSHDU RQ WRS RI REMHFWV

RQ ORZHU OD\HUV�

To chan ge the order of ob jects

1 6HOHFW RQH RU PRUH REMHFWV�

2 2Q WKH $UUDQJH PHQX� FOLFN 2UGHU DQG FOLFN D FRPPDQG RQ WKH 2UGHU

VXEPHQX�

7LS

<RX FDQ FOLFN WKH ULJKW PRXVH EXWWRQ WR RSHQ WKH VKRUWFXW PHQX� DQG FOLFN
DQ RUGHULQJ FRPPDQG�

&RPPDQG $FWLRQ

%ULQJ )RUZDUG 0RYHV WKH FXUUHQWO\ VHOHFWHG REMHFW RQH OHYHO

WRZDUG WKH IURQW �NH\ERDUG VKRUWFXW SHIFT+F10�

6HQG %DFNZDUG 0RYHV WKH FXUUHQWO\ VHOHFWHG REMHFW RQH OHYHO

WRZDUG WKH EDFN �NH\ERDUG VKRUWFXW SHIFT+F9�

%ULQJ WR )URQW 0RYHV WKH FXUUHQWO\ VHOHFWHG REMHFW LQ IURQW RI DOO

RWKHU REMHFWV RQ WKH FXUUHQW OD\HU �NH\ERDUG

VKRUWFXW F10�

6HQG WR %DFN 0RYHV WKH FXUUHQWO\ VHOHFWHG REMHFW EHKLQG DOO

RWKHU REMHFWV RQ WKH FXUUHQW OD\HU �NH\ERDUG

VKRUWFXW F9�

5HYHUVH 5HYHUVHV WKH VWDFNLQJ RUGHU RI WKH VHOHFWHG REMHFWV�

)RU H[DPSOH� WKH RUGHU �� �� �� � EHFRPHV �� �� �� �

�NH\ERDUG VKRUWFXW CTRL+SHIFT+F9�
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Grouping Objects

:KHQ \RX FUHDWH D GUDZLQJ ZLWK PDQ\ REMHFWV� LW LV XVHIXO WR JURXS REMHFWV

WRJHWKHU WR KHOS RUJDQL]H \RXU GUDZLQJ� *URXSLQJ PDNHV LW HDVLHU WR VHOHFW

REMHFWV� DQG PDNHV LW SRVVLEOH WR PDQLSXODWH VHYHUDO REMHFWV DW RQFH�

*URXS REMHFWV ZKHQ \RX ZDQW WR FUHDWH D FROOHFWLRQ RI LQGLYLGXDO REMHFWV�

*URXSLQJ GRHV QRW FKDQJH DQ REMHFWjV DSSHDUDQFH�

&KDQJLQJ D VW\OH RI DQ REMHFW JURXS FKDQJHV DOO REMHFWV LQ WKH JURXS WR WKH

QHZ VW\OH� )RU H[DPSOH� LI \RX VHOHFW D JURXS RI REMHFWV DQG FKDQJH WKH

LQWHULRU ILOO FRORU WR UHG� DOO REMHFWV LQ WKH JURXS EHFRPH UHG XQOHVV \RX KDYH

VPDUW FRORUL]DWLRQ�

To grou p objects

1 6HOHFW WKH REMHFWV \RX ZDQW LQ WKH JURXS �WKH\ GRQjW KDYH WR EH

DGMDFHQW�

2 2Q WKH $UUDQJH PHQX� FOLFN *URXS�

RU

&OLFN WKH ULJKW PRXVH EXWWRQ WR RSHQ WKH VKRUWFXW PHQX DQG FOLFN

*URXS� RU SUHVV F5 �NH\ERDUG VKRUWFXW��

Ungrouping Objects

<RX FDQ XQJURXS REMHFWV WR UHWXUQ WKHP WR WKHLU RULJLQDO� XQJURXSHG VWDWH�

To un grou p objects

1 6HOHFW WKH JURXS WR EUHDN DSDUW

2 2Q WKH $UUDQJH PHQX� FOLFN 8QJURXS�

RU
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&OLFN WKH ULJKW PRXVH EXWWRQ WR RSHQ WKH VKRUWFXW PHQX DQG FOLFN

8QJURXS� RU SUHVV SHIFT+F5 �NH\ERDUG VKRUWFXW��

7LSV

,I \RX KDYH JURXSV ZLWKLQ JURXSV� XVH WKH 8QJURXS FRPPDQG PRUH WKDQ
RQFH WR EUHDN XS DOO WKH JURXSV�

7KHUH DUH WZR RWKHU ZD\V WR XQJURXS D VHOHFWHG JURXS�

Working with Grouped Objects

,Q PDQ\ ZD\V� JURXSHG REMHFWV DUH VLPLODU WR LQGLYLGXDO REMHFWV� )RU H[DPSOH�

FKDQJLQJ OLQH DQG ILOO VW\OHV DIIHFWV WKH ZKROH JURXS� DQG PRYLQJ D JURXS LV OLNH

PRYLQJ RQH REMHFW� <RX FDQ DOVR VNHZ DQG URWDWH JURXSV�

Editing a Grouped Object

,I \RX ZDQW WR UHVKDSH RU FKDQJH WKH FRORU RI RQH REMHFW LQ D JURXS� \RX FDQ

ILUVW EUHDN DSDUW WKH JURXS RU \RX FDQ VHOHFW RQO\ WKH REMHFW ZLWKLQ WKH JURXS

WKDW \RX ZDQW WR HGLW�

<RX FDQ DOVR HGLW REMHFWV WKDW EHORQJ WR JURXSV ZLWKLQ RWKHU JURXSV� 3RLQW WR

WKH REMHFW RU JURXS \RX ZDQW WR HGLW DQG FRQWLQXH GRXEOH FOLFNLQJ XQWLO WKH

JURXS \RX ZDQW WR HGLW GLVSOD\V WKH KDWFK HGLW ERUGHU� :KHQ \RX ILQLVK�

GRXEOH FOLFN RXWVLGH WKH JURXSV XQWLO WKH KDWFK HGLW ERUGHU GLVDSSHDUV�
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To edit an ob ject without un grou ping it

1 8VLQJ WKH VHOHFW SRLQWHU� GRXEOH FOLFN WKH REMHFW JURXS WKDW FRQWDLQV

WKH REMHFW \RX ZDQW WR HGLW� $ KDWFK HGLW ERUGHU DSSHDUV DURXQG WKH

JURXS�

2 6HOHFW WKH REMHFW WR HGLW� %OXH KDQGOHV DSSHDU DURXQG WKH VHOHFWHG

REMHFW� (GLW RU PRYH LW DV \RX ZRXOG DQ\ REMHFW�

3 'RXEOH FOLFN DQ\ZKHUH RXWVLGH WKH JURXS ZKHQ \RX ILQLVK�

7LS

7R VHOHFW DGGLWLRQDO REMHFWV ZLWKLQ WKH JURXS� SUHVV DQG KROG SHIFT
DQG FOLFN WKH RWKHU REMHFWV WKDW \RX ZDQW WR VHOHFW�

Adding a New Object to a Group

<RX FDQ DGG DQ REMHFW WR D JURXS RI REMHFWV� 'RXEOH FOLFN WKH JURXS WR ZKLFK

\RX ZDQW WR DGG DQ REMHFW� DQG GUDZ RU SDVWH DQRWKHU REMHFW� ,W LV

DXWRPDWLFDOO\ LQFOXGHG LQVLGH WKH HGLWLQJ ERUGHU DQG EHFRPHV SDUW RI WKH

JURXS� 'RXEOH FOLFN RXWVLGH WKH HGLW ERUGHU ZKHQ \RX ILQLVK DGGLQJ REMHFWV�

Removing an Object from a Group

<RX FDQ VHSDUDWH DQ REMHFW IURP LWV JURXS ZLWKRXW EUHDNLQJ DSDUW WKH JURXS�

'RXEOH FOLFN WKH REMHFW LQ WKH JURXS� $Q HGLW ERUGHU DSSHDUV DURXQG WKH

JURXS� 6HOHFW WKH REMHFW \RX ZDQW WR UHPRYH� &OLFN &XW RQ WKH (GLW PHQX�

'RXEOH FOLFN RXWVLGH WKH JURXS DQG SDVWH WKH REMHFW ZKHUH \RX ZDQW LW� <RX

FDQ DOVR SUHVV DEL WR GHOHWH WKH REMHFW�
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Connecting Objects

7KH &RQQHFW FRPPDQGV OHW \RX MRLQ REMHFWV� PDNLQJ LW HDV\ WR FUHDWH

FRPSOH[ VKDSHV�

1RWH

<RX FDQQRW FRQQHFW WH[W� JURXSHG REMHFWV� RU ELWPDSV�

Connect Open

<RX FDQ XVH WKH &RQQHFW 2SHQ FRPPDQG WR FRPELQH WZR RU PRUH REMHFWV

ZLWK RSHQ HQGSRLQWV� 7KH &RQQHFW 2SHQ FRPPDQG MRLQV VHOHFWHG REMHFWV

E\ GUDZLQJ D OLQH EHWZHHQ WKH RSHQ HQGSRLQWV� OHDYLQJ WKH ODVW VLGH RSHQ�

Connect Open

To connect o pen

1 6HOHFW WKH REMHFWV \RX ZDQW WR FRQQHFW

2 2Q WKH $UUDQJH PHQX� FOLFN &RQQHFW 2SHQ� RU SUHVV CTRL+F11�

Connect Closed

<RX FDQ XVH WKH &RQQHFW &ORVHG FRPPDQG WR FORVH RSHQ VKDSHV RU WR

FRQQHFW DQG ILOO FORVHG VKDSHV� <RX FDQ XVH &RQQHFW &ORVHG ZLWK RQH RU

PRUH REMHFWV�
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2Q VHOHFWHG REMHFWV ZLWK RSHQ HQGSRLQWV� WKH &RQQHFW &ORVHG FRPPDQG

GUDZV D OLQH EHWZHHQ DOO HQGSRLQWV� FUHDWLQJ D FRPSOHWHO\ FORVHG VKDSH�

2Q VHOHFWHG REMHFWV ZLWK QR HQGSRLQWV �DOUHDG\ FORVHG VKDSHV�� WKH &RQQHFW

&ORVHG FRPPDQG FRQQHFWV WKH REMHFWV DQG WKH UHVXOWLQJ REMHFW LV ILOOHG ZLWK

WKH ILOO FRORU RI WKH ILUVW GUDZQ REMHFW �WKH RQH LQ EDFN�� 1RWH WKDW LQ WKLV FDVH

QR OLQHV DUH GUDZQ�

connect closed

To connect closed

1 6HOHFW WKH REMHFWV \RX ZDQW WR FRQQHFW�

2 2Q WKH $UUDQJH PHQX� FOLFN &RQQHFW &ORVH� RU SUHVV F11 �NH\ERDUG

VKRUWFXW��
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Connect Closed when Objects Overlap

,I \RX XVH &RQQHFW &ORVHG RQ RYHUODSSLQJ REMHFWV WKDW DUH FORVHG� WKH IURQW

REMHFW FXWV RU kSXQFKHVy D KROH LQ WKH XQGHUO\LQJ REMHFW�

,I WKH WRS REMHFW H[WHQGV RII WKH HGJH RI WKH ERWWRP REMHFW� WKH H[WHQGLQJ

SRUWLRQ LV ILOOHG� 6HOHFW )LOO 2YHUODSV LQ WKH )RUPDW GLDORJ ER[ WR ILOO WKH

RYHUODSSLQJ SRUWLRQ DOVR �WKDW LV� WKH KROH LQ WKH ERWWRP REMHFW LV ILOOHG��

Disconnecting Objects

$IWHU DSSO\LQJ &RQQHFW 2SHQ� \RX FDQ XVH 'LVFRQQHFW WR UHVWRUH DQ REMHFW

WR LWV RULJLQDO� GLVFRQQHFWHG REMHFWV� +RZHYHU� DIWHU DSSO\LQJ &RQQHFW &ORVHG

WR DQ RSHQ FRQQHFWHG REMHFW� \RX FDQ QR ORQJHU UHVWRUH WKH RULJLQDO REMHFWV�

To disconnect connected ob jects

1 6HOHFW WKH FRQQHFWHG REMHFW \RX ZDQW WR GLVFRQQHFW�
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2 2Q WKH $UUDQJH PHQX� FOLFN 'LVFRQQHFW� RU SUHVV SHIFT+F11�
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Aligning Objects

Aligning Objects to the Page

<RX FDQ DOLJQ RQH RU PRUH REMHFWV WR VHYHUDO SRVLWLRQV RQ WKH SDJH� )RU

H[DPSOH� \RX FDQ DOLJQ DQ REMHFW WR WKH H[DFW FHQWHU RI WKH SDJH� <RX FDQ

RSHQ WKH $OLJQ GLDORJ ER[ E\ SUHVVLQJ $/7���
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Keyboard Shortcuts for ali gnin g objects

To ali gn ob jects to a page

1 6HOHFW WKH REMHFWV \RX ZDQW WR DOLJQ�

2 )URP WKH $UUDQJH PHQX� FOLFN $OLJQ� �.H\ERDUG VKRUWFXW $/7����

3 ,Q WKH $OLJQ 6HOHFWLRQ� FOLFN 7R 3DJH�

4 &OLFN D YHUWLFDO DQG�RU KRUL]RQWDO DOLJQPHQW EXWWRQ� 7KH SUHYLHZ ER[

VKRZV DQ H[DPSOH RI WKH DOLJQPHQW�

5 &OLFN $SSO\ WR DOLJQ WKH REMHFWV�

$FWLRQ .H\ERDUG 6KRUWFXW

$OLJQ WR SDJH FHQWHU CTRL+SHIFT+5

$OLJQ WR SDJH PLGGOH CTRL+SHIFT+6

$OLJQ WR UXOHUV ALT+2

$OLJQ WR SDJH OHIW CTRL+SHIFT+3

$OLJQ WR SDJH WRS CTRL+SHIFT+4

$OLJQ WR SDJH ULJKW CTRL+SHIFT+7

$OLJQ WR SDJH ERWWRP CTRL+SHIFT+8

-XVWLI\ WR SDJH KRUL]RQWDOO\ CTRL+SHIFT+9

-XVWLI\ WR SDJH YHUWLFDOO\ CTRL+SHIFT+0
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Aligning Objects as a Group

6HOHFW $OLJQ 2EMHFWV DV *URXS WR DOLJQ WKH VHOHFWHG REMHFWV WR D SDJH DV D

JURXS�

1RWH

$OLJQ 2EMHFWV DV *URXS WUHDWV WKH VHOHFWHG REMHFWV DV D JURXS RQO\ IRU WKH
$OLJQ WR 3DJH FRPPDQG� ,W GRHV QRW DFWXDOO\ JURXS WKH REMHFWV RU DIIHFW WKH
RSHUDWLRQ RI RWKHU FRPPDQGV�

Aligning Objects to Other Objects

<RX FDQ DOLJQ REMHFWV WR HDFK RWKHU� )RU H[DPSOH� LI \RX VHOHFW WKUHH REMHFWV

DQG DOLJQ WKHP WR WKH FHQWHU� WKH\ DUH VWDFNHG LQ WKH FHQWHU RI WKH ERXQGLQJ

ER[�

'HVLJQHU XVHV WKH ERXQGLQJ ER[ WKDW VXUURXQGV DOO VHOHFWHG REMHFWV DV WKH

EDVLV IRU DOLJQPHQW� )RU H[DPSOH� LI \RX VHOHFW WKUHH REMHFWV DQG DOLJQ WKHP DW

WRS OHIW� WKH\ DOLJQ WR WKH WRS OHIW FRUQHU RI WKH VXUURXQGLQJ ERXQGLQJ ER[�

$FWLRQ .H\ERDUG 6KRUWFXW

$OLJQ WR OHIW ALT+3

$OLJQ WR FHQWHU ALT+5

$OLJQ WR ULJKW ALT+7

-XVWLI\ KRUL]RQWDOO\ ALT+9

$OLJQ WR WRS ALT+4

$OLJQ WR PLGGOH ALT+6

$OLJQ WR ERWWRP ALT+8

-XVWLI\ YHUWLFDOO\ ALT+0
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To ali gn ob jects to each other

1 6HOHFW WKH REMHFWV \RX ZDQW WR DOLJQ�

2 2Q WKH $UUDQJH PHQX� FOLFN $OLJQ�

3 &OLFN 7R 2EMHFW LQ WKH $OLJQ 6HOHFWLRQ VHFWLRQ�

4 &OLFN D YHUWLFDO DQG�RU KRUL]RQWDO DOLJQPHQW EXWWRQ� 7KH SUHYLHZ ER[

LQ WKH SDQHO VKRZV DQ H[DPSOH RI WKH DOLJQPHQW�

5 &OLFN $SSO\ WR DOLJQ WKH REMHFWV�

Aligning Objects to a Path

<RX FDQ DOLJQ REMHFWV DORQJ WKH SDWK RI DQRWKHU REMHFW� )RU H[DPSOH� \RX FDQ

GUDZ D FXUYH DQG DOLJQ D VHULHV RI VWDUV DORQJ LW� *URXSHG DQG WH[W REMHFWV

FDQQRW EH XVHG DV D SDWK �EXW \RX FDQ DOLJQ WKHP WR D SDWK��

,W LV HDV\ WR JHW WKH DOLJQPHQW \RX ZDQW EHFDXVH 'HVLJQHU SUHYLHZV WKH HIIHFW

RI DOLJQPHQW VHWWLQJV DV \RX FKRRVH WKHP� :KHQ WKH DOLJQPHQW SUHYLHZ

VKRZV WKH DUUDQJHPHQW \RX ZDQW� \RX FDQ DSSO\ WKH DOLJQPHQW�
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7KH $OLJQ 7R 3DWK GLDORJ ER[ LV XVHG WR DOLJQ REMHFWV WR D SDWK� )URP WKH

$UUDQJH PHQX� SRLQW WR $OLJQ� DQG FOLFN 7R 3DWK�

1RWHV

7KH $OLJQ 7R 3DWK SDQHO LV XVHG RQO\ WR DOLJQ REMHFWV �RU WH[W WKDW KDV EHHQ
FRQYHUWHG LQWR FXUYHV� WR D SDWK�

'HVLJQHU UHPRYHV ZDUSV� URWDWLRQV� DQG VNHZV RI REMHFWV WKDW DUH DOLJQHG
WR D SDWK� &RQYHUW WKH REMHFWV WR FXUYHV �NH\ERDUG VKRUWFXW CTRL+R�
EHIRUH DOLJQLQJ WKHP LI \RX ZDQW WR NHHS WKHLU SUHYLRXV WUDQVIRUPDWLRQV�

Distributing Multiple Objects Evenly

<RX FDQ XVH WKH MXVWLI\ VHWWLQJ LQ WKH DOLJQPHQW GLDORJ ER[ WR GLVWULEXWH

REMHFWV DORQJ WKH SDWK�
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'HVLJQHU UHPRYHV ZDUSV� URWDWLRQV� DQG VNHZV RI REMHFWV WKDW DUH GLVWULEXWHG

DORQJ D SDWK� ,I \RX ZDQW WR NHHS WKHLU SUHYLRXV WUDQVIRUPDWLRQV� FRQYHUW WKH

REMHFWV WR FXUYHV �NH\ERDUG VKRUWFXW CTRL+R� EHIRUH \RX GLVWULEXWH WKHP�

Selecting the Path Object

7KH 6HOHFW 3DWK IRU $OLJQPHQW EXWWRQV VHOHFW WKH REMHFW WR XVH DV D SDWK IRU

WKH RWKHU REMHFWV� 7KH LQLWLDO SDWK VHOHFWLRQ LV WKH REMHFW WKDW SURYLGHV WKH

ORQJHVW SDWK� (DFK WLPH \RX FOLFN D 6HOHFW 3DWK IRU $OLJQPHQW EXWWRQ� WKH SDWK

REMHFW FKDQJHV�

7KH 3UHYLRXV EXWWRQ F\FOHV WKURXJK REMHFWV LQ WKH RSSRVLWH RUGHU LQ

ZKLFK WKH\ ZHUH GUDZQ�

7KH 1H[W EXWWRQ F\FOHV WKURXJK REMHFWV LQ WKH RUGHU LQ ZKLFK WKH\ ZHUH

GUDZQ�

Changing the Alignment Justification

7KH -XVWLILFDWLRQ EXWWRQV VHW WKH SRVLWLRQ RI WKH DOLJQHG REMHFWV LQ UHODWLRQ WR

WKH DOLJQPHQW SRLQW�

7KH /HIW EXWWRQ SRVLWLRQV REMHFWV VR WKH OHIW HGJH RI WKH OHIW�PRVW REMHFW

DOLJQV WR WKH DOLJQPHQW SRLQW�

7KH &HQWHU EXWWRQ FHQWHUV REMHFWV DURXQG WKH DOLJQPHQW SRLQW�

7KH 5LJKW EXWWRQ SRVLWLRQV REMHFWV VR WKH ULJKW HGJH RI WKH ULJKW�PRVW

REMHFW DOLJQV WR WKH DOLJQPHQW SRLQW�

7KH -XVWLI\ EXWWRQ VSDFHV REMHFWV HYHQO\ RQ WKH SDWK�

RT_Changing_the_Ali gnment_Justification
RT_Changing_the_Alignment_Justification
$OLJQLQJ 2EMHFWV WR WKH 3DJH
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$OLJQLQJ 2EMHFWV WR 2WKHU 2EMHFWV

$OLJQLQJ 2EMHFWV WR D 3DWK

6HOHFWLQJ WKH 3DWK 2EMHFW

Changing the Alignment Pitch

7KH 3LWFK EXWWRQV VHW WKH RULHQWDWLRQ� RU SLWFK� RI WKH DOLJQHG REMHFWV LQ

UHODWLRQ WR WKH SDWK� &OLFN WKH FXUUHQW 3LWFK EXWWRQ WR GLVSOD\ WKH RWKHU SLWFK

RSWLRQV�

7KH 5RWDWH WR 3DWK EXWWRQ DOLJQV WKH REMHFWV DORQJ D SDWK E\ URWDWLQJ� EXW

QRW FKDQJLQJ WKH VKDSHV�

7KH )ROORZ 3DWK EXWWRQ SODFHV REMHFWV DORQJ D SDWK ZLWKRXW VNHZLQJ RU

URWDWLQJ WKH VKDSHV�

RT_Changing_the_Ali gnment_Pitch
RT_Changing_the_Alignment_Pitch
$OLJQLQJ 2EMHFWV WR WKH 3DJH

$OLJQLQJ 2EMHFWV WR 2WKHU 2EMHFWV

$OLJQLQJ 2EMHFWV WR D 3DWK

&KDQJLQJ WKH $OLJQPHQW 3LWFK

Changing the Alignment Direction

7KH 'LUHFWLRQ EXWWRQV VHW WKH GLUHFWLRQ LQ ZKLFK REMHFWV DOLJQ DORQJ WKH SDWK�

7KH %DFNZDUG EXWWRQ DOLJQV REMHFWV LQ WKH RSSRVLWH GLUHFWLRQ LQ ZKLFK

WKH SDWK ZDV GUDZQ �WKH DOLJQPHQW GLUHFWLRQ LV HQGSRLQW WR RULJLQ��

7KH )RUZDUG 'LUHFWLRQ EXWWRQ DOLJQV REMHFWV LQ WKH GLUHFWLRQ LQ ZKLFK WKH

SDWK ZDV GUDZQ �WKH DOLJQPHQW GLUHFWLRQ LV RULJLQ WR HQGSRLQW��

RT_Changing_the_Ali gnment_Direction
RT_Changing_the_Alignment_Direction
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$OLJQLQJ 2EMHFWV WR WKH 3DJH

$OLJQLQJ 2EMHFWV WR 2WKHU 2EMHFWV

$OLJQLQJ 2EMHFWV WR D 3DWK

Changing the Alignment Offset

7KH 2IIVHW � ER[ FRQWUROV ZKHUH REMHFWV YHUWLFDOO\ UHVW RQ D SDWK� $Q RIIVHW

RI ��� DOLJQV WKH ERWWRP RI WKH REMHFWV WR WKH SDWK� DQ RIIVHW RI � DOLJQV WKH

PLGGOH RI WKH REMHFWV WR WKH SDWK� DQG DQ RIIVHW RI ���� DOLJQV WKH WRS RI WKH

REMHFWV WR WKH SDWK�

$Q RIIVHW JUHDWHU WKDQ ��� �WR WKH OLPLW RI ���� DOLJQV WKH ERWWRP RI WKH

REMHFWV DERYH WKH SDWK� $Q RIIVHW OHVV WKDQ ���� �WR WKH OLPLW RI ����� DOLJQV

WKH WRS RI WKH REMHFWV EHORZ WKH SDWK�

RT_Changing_the_Ali gnment_Offset
RT_Changing_the_Alignment_Offset
$OLJQLQJ 2EMHFWV WR WKH 3DJH

$OLJQLQJ 2EMHFWV WR 2WKHU 2EMHFWV

$OLJQLQJ 2EMHFWV WR D 3DWK

Changing the Alignment Point

7KH $OLJQPHQW 3RLQW EXWWRQV VHW WKH ORFDWLRQ RQ WKH SDWK RI WKH SRLQW XVHG

WR DOLJQ WKH REMHFWV� 7KH DOLJQPHQW SRLQW FDQ EH VHW WR WKH IL[HG ORFDWLRQV RI

OHIW� FHQWHU� DQG ULJKW IRU RSHQ SDWKV RU WRS� OHIW� ULJKW� DQG ERWWRP IRU FORVHG

SDWKV�

RT_Changing_the_Ali gnment_Point
RT_Changing_the_Alignment_Point
$OLJQLQJ 2EMHFWV WR WKH 3DJH

$OLJQLQJ 2EMHFWV WR 2WKHU 2EMHFWV

$OLJQLQJ 2EMHFWV WR D 3DWK
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To set the ali gnment point to a custom location

1 &OLFN 7R 3DWK WR GLVSOD\ WKH $OLJQ 7R 3DWK WDE�

2 ,I WKH $OLJQ 7R 3DWK WDE REVFXUHV WKH REMHFWV \RX ZDQW WR DOLJQ� GUDJ LW

RXW RI WKH ZD\�

3 &OLFN WKH &KRRVH 3RVLWLRQ EXWWRQ �

4 'UDJ WKH UHG $OLJQPHQW 3RLQW WR WKH ORFDWLRQ WKDW \RX ZDQW

To ali gn ob jects to a path

1 6HOHFW WKH REMHFWV \RX ZDQW WR DOLJQ� LQFOXGLQJ WKH REMHFW \RX ZDQW WR

XVH DV D SDWK�

2 2Q WKH &KDQJH PHQX� FOLFN $OLJQ� $ VXEPHQX RSHQV�

3 &OLFN 7R 3DWK WR GLVSOD\ WKH $OLJQ 7R 3DWK WDE�

4 ,I WKH $OLJQ 7R 3DWK WDE REVFXUHV WKH REMHFWV \RX ZDQW WR DOLJQ� GUDJ LW

RXW RI WKH ZD\�

5 &KRRVH WKH REMHFW WR XVH DV WKH SDWK E\ FOLFNLQJ WKH 3UHYLRXV EXWWRQ

RU WKH 1H[W EXWWRQ LQ WKH $OLJQ 7R 3DWK WDE XQWLO WKH SUHYLHZ

UHFWDQJOHV DUH VKRZQ DORQJ WKH GHVLUHG SDWK�

6 &KRRVH WKH $OLJQPHQW 3RLQW WKDW \RX ZDQW�

7 &KDQJH WKH MXVWLILFDWLRQ� SLWFK� DQG GLUHFWLRQ VHWWLQJV� LI \RX ZLVK�

8 &OLFN $SSO\ WR DOLJQ WKH REMHFWV�

7LS

&OLFN 8QGR WR UHWXUQ REMHFWV WR WKHLU XQDOLJQHG SRVLWLRQV�
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Copying and Pasting Objects

<RX FDQ FRS\ REMHFWV IURP D GUDZLQJ WR WKH :LQGRZV &OLSERDUG DQG SDVWH

WKH REMHFW LQWR DQRWKHU 'HVLJQHU GUDZLQJ RU DQRWKHU :LQGRZV SURJUDP�

&RS\LQJ DQG SDVWLQJ WR WKH &OLSERDUG LV DQ HDV\ ZD\ WR PRYH REMHFWV IURP

RQH 'HVLJQHU GUDZLQJ WR DQRWKHU� <RX FDQ DOVR PRYH GUDZLQJV DQG WH[W IURP

'HVLJQHU WR PDQ\ RWKHU :LQGRZV SURJUDPV� RU IURP D :LQGRZV SURJUDP

WR 'HVLJQHU�

7KH &RS\ DQG &XW FRPPDQGV ERWK PRYH VHOHFWHG REMHFWV WR WKH &OLSERDUG�

v &RS\ SODFHV D FRS\ RI WKH VHOHFWHG REMHFW RQ WKH &OLSERDUG�

v &XW UHPRYHV WKH RULJLQDO REMHFW IURP WKH GUDZLQJ DQG SODFHV LW RQ WKH

&OLSERDUG�

7KH 3DVWH FRPPDQG UHWULHYHV REMHFWV IURP WKH &OLSERDUG DQG SODFHV WKHP LQ

\RXU GUDZLQJ� %HIRUH \RX FDQ SDVWH� \RX PXVW FRS\ RU FXW DQ REMHFW WR WKH

&OLSERDUG� <RX FDQ UHSHDWHGO\ SDVWH WKH VDPH REMHFW IURP WKH &OLSERDUG

XQWLO \RX FXW RU FRS\ D QHZ REMHFW WR WKH &OLSERDUG�

7LS

8VH HLWKHU CTRL+V RU SHIFT+INS DV D NH\ERDUG VKRUWFXW IRU WKH 3DVWH
FRPPDQG�

Pasting Inside

7KH 3DVWH ,QVLGH FRPPDQG �RQ WKH (IIHFWV�0DVNLQJ PHQX� OHWV \RX PDVN DQ

REMHFW�

Paste Special

8VH 3DVWH 6SHFLDO RQ WKH (GLW PHQX WR VLPXOWDQHRXVO\ SDVWH DQG OLQN WKH

REMHFW�
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Replacing Objects

8VH WKH 5HSODFH GLDORJ ER[ �VHOHFW 5HSODFH RQ WKH $UUDQJH PHQX� WR FRQWURO

KRZ VHOHFWHG REMHFWV DUH UHSODFHG E\ WKRVH IURP WKH &OLSERDUG�

Replacing with Multiple Objects

,I \RX VHOHFW VHYHUDO REMHFWV WR UHSODFH� 'HVLJQHU GLVWULEXWHV &OLSERDUG

REMHFWV WR UHSODFH VHOHFWHG REMHFWV� 7KH ILUVW REMHFW LQ WKH &OLSERDUG �IURP

EDFN WR IURQW LI QR UHRUGHULQJ KDV WDNHQ SODFH� UHSODFHV WKH ILUVW RULJLQDO

REMHFW� WKH VHFRQG &OLSERDUG REMHFW UHSODFHV WKH VHFRQG RULJLQDO REMHFW� DQG

VR RQ�

6HOHFW WKH *URXS &OLSERDUG 2EMHFWV RSWLRQ WR UHSODFH HDFK VHOHFWHG REMHFW

ZLWK WKH HQWLUH FRQWHQWV RI WKH &OLSERDUG�

,I \RX KDYH VHYHUDO REMHFWV VHOHFWHG EXW RQO\ RQH LQ WKH &OLSERDUG� HDFK

VHOHFWHG REMHFW LV UHSODFHG ZLWK WKH &OLSERDUG REMHFW�

To replace an ob ject

1 &XW RU FRS\ RQH RU PRUH REMHFWV WR WKH &OLSERDUG�

2 6HOHFW WKH REMHFW RU JURXS RI REMHFWV WR UHSODFH�

3 2Q WKH $UUDQJH PHQX� FOLFN 5HSODFH� 7KH 5HSODFH GLDORJ ER[ RSHQV�

4 &KDQJH WKH UHSODFHPHQW RSWLRQV� LI \RX ZLVK�

5 &OLFN $SSO\� 7KH REMHFW LQ WKH GUDZLQJ DUHD LV UHSODFHG ZLWK WKH

FRQWHQWV RI WKH &OLSERDUG�

Pasting to Fit

<RX FDQ XVH WKH 6FDOH WR )LW RSWLRQ LQ WKH 5HSODFH GLDORJ ER[ WR IRUFH D

&OLSERDUG REMHFW WR VFDOH XS RU GRZQ WR FRPSOHWHO\ ILOO WKH ERXQGLQJ DUHD RI

WKH RULJLQDO REMHFW�
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Aligning while Pasting

7KH $OLJQ WR %RUGHU RSWLRQ LQ WKH 5HSODFH GLDORJ ER[ OHWV \RX SRVLWLRQ D

UHSODFHPHQW REMHFW LQVLGH WKH ERXQGLQJ ER[ RI WKH REMHFW LW UHSODFHV� 7KLV

RSWLRQ GRHV QRW FKDQJH WKH REMHFW
V SURSRUWLRQV�
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OLE (Object Linking and Embedding)

<RX FDQ XVH WKH /LQNV GLDORJ ER[ WR PDQDJH 2/( OLQNV WKDW \RX KDYH FUHDWHG�

7R RSHQ WKH /LQNV GLDORJ ER[� FOLFN 2/( /LQNV RQ WKH (GLW PHQX�

:KHQ \RX SDVWH DQ REMHFW� \RX FDQ HVWDEOLVK D FRQQHFWLRQ� RU OLQN� EHWZHHQ

WKH SDVWHG REMHFW DQG LWV VRXUFH� 7KLV FRQQHFWLRQ LV XVXDOO\ FDOOHG �2/(�� IRU

2EMHFW /LQNLQJ DQG (PEHGGLQJ�

Embedding/ Inserting OLE Objects

:KHQHYHU SRVVLEOH� 'HVLJQHU HPEHGV DQ REMHFW ZKLOH SDVWLQJ LW� 'RXEOH

FOLFNLQJ DQ HPEHGGHG REMHFW DXWRPDWLFDOO\ RSHQV WKH SURJUDP LQ ZKLFK WKH

REMHFW ZDV FUHDWHG VR \RX FDQ HGLW LW� <RX FDQ DOVR VHOHFW WKH REMHFW� FOLFN WKH

ULJKW PRXVH EXWWRQ� DQG FOLFN (GLW RQ WKH VKRUWFXW PHQX WR HGLW WKH

HPEHGGHG REMHFW�

'HVLJQHU DXWRPDWLFDOO\ HPEHGV WKH REMHFW LI WKH REMHFW
V DVVRFLDWHG SURJUDP

LV D UHJLVWHUHG 2/( VHUYHU� 7R ILQG RXW LI WKH REMHFW LV DQ 2/( REMHFW� VHOHFW LW

DQG ORRN DW WKH VWDWXV EDU WR VHH LI 2/( 2EMHFW LV GLVSOD\HG�

8VH WKH 3DVWH EXWWRQ WR SDVWH DQG HPEHG WKH REMHFW LQWR \RXU GUDZLQJ� ,I

WKH VRXUFH SURJUDP LV 2/(�FRPSDWLEOH� WKH REMHFW LV DXWRPDWLFDOO\

HPEHGGHG ZKHQ LW LV SDVWHG� 7KH IRUPDW RI WKH RULJLQDO REMHFW LV KLJKOLJKWHG�

%HVLGHV XVLQJ 3DVWH WR HPEHG REMHFWV IURP 2/(�FRPSDWLEOH SURJUDPV� RU

\RX FDQ XVH ,QVHUW 2EMHFW�

,QVHUW 2EMHFW OHWV \RX HLWKHU�

v ,QVHUW DQ\ ILOH WKDW LV DVVRFLDWHG ZLWK D UHJLVWHUHG 2/( VHUYHU SURJUDP

RQ \RXU FRPSXWHU� ,I \RX FKRRVH WR OLQN WR WKH ILOH� WKH LQVHUWHG REMHFW

UHIOHFWV DQ\ FKDQJHV \RX PDNH WR WKH ILOH�

RU
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v 2SHQ DQ 2/(�FRPSDWLEOH SURJUDP� FUHDWH D QHZ REMHFW LQ WKH

SURJUDP� DQG LQVHUW WKH REMHFW LQWR 'HVLJQHU� <RX GRQ
W KDYH WR VDYH

WKH REMHFW DV D ILOH�

7LSV

,I \RX SDVWH �HPEHG� IURP D QRQ�GUDZLQJ SURJUDP VXFK DV 0LFURVRIW
:RUG� WKH REMHFW LV VRPHWLPHV SDVWHG DV D SLFWXUH �XVXDOO\ DQ LFRQ�� ,I \RX
ZDQW WR SDVWH HGLWDEOH WH[W� \RX PXVW SDVWH LW ZLWKRXW HPEHGGLQJ RU OLQNLQJ
LW� 2Q WKH (GLW PHQX� FOLFN 3DVWH 6SHFLDO� VHOHFW 7H[W� DQG WKHQ FOLFN 3DVWH�

$OWKRXJK \RX PXVW KDYH WKH HPEHGGHG REMHFW
V DVVRFLDWHG SURJUDP RQ
\RXU V\VWHP� \RX GRQ
W KDYH WR KDYH WKH RULJLQDO ILOH� 7KLV PDNHV
HPEHGGLQJ XVHIXO IRU SRUWDEOH FRPSXWHUV ZKHUH GLVN VSDFH LV DW D
SUHPLXP�

To insert an OLE ob ject

1 2Q WKH ,QVHUW PHQX� FOLFN 2/( 2EMHFW� 7KH ,QVHUW 2EMHFW GLDORJ ER[

RSHQV�

2 &OLFN &UHDWH 1HZ� DQG WKHQ VHOHFW WKH W\SH RI REMHFW WKDW \RX ZDQW WR

FUHDWH� &OLFN 2.� 7KH RWKHU SURJUDP RSHQV�

3 8VH WKH SURJUDP WR FUHDWH WKH REMHFW�

4 :KHQ \RX ILQLVK� SUHVV WKH ESC NH\� 7KH REMHFW LV LQVHUWHG LQ WKH

'HVLJQHU GUDZLQJ�

7LS

2QO\ 2/(�FRPSDWLEOH�SURJUDP REMHFWV DUH OLVWHG LQ WKH ,QVHUW 2EMHFW
GLDORJ ER[�

To create an OLE ob ject

1 2Q WKH ,QVHUW PHQX� FOLFN 2/( 2EMHFW� 7KH ,QVHUW 2EMHFW GLDORJ ER[

RSHQV�

2 &OLFN WKH &UHDWH IURP )LOH RSWLRQ�

3 &OLFN WKH /LQN RSWLRQ LI \RX ZDQW WR OLQN UDWKHU WKDQ HPEHG WKH REMHFW�
192 i G r a f x  D e s i g n e r



4 &OLFN %URZVH� ORFDWH WKH ILOH� DQG FOLFN 2SHQ�

7LS

2QO\ 2/(�FRPSDWLEOH�SURJUDP REMHFWV DUH OLVWHG LQ WKH ,QVHUW 2EMHFW
GLDORJ ER[�

Linking OLE Objects

/LQNLQJ OHWV \RX PDLQWDLQ DQ LQYLVLEOH FRQQHFWLRQ EHWZHHQ DQ 2/( REMHFW DQG

LWV RULJLQDO �VRXUFH� ILOH� /LQNLQJ LV XVHG ZLWK SDVWLQJ DQG LV VRPHWLPHV FDOOHG

SDVWH OLQNLQJ� :KHQ \RX SDVWH OLQN DQ REMHFW LQWR 'HVLJQHU� \RX FDQ PDNH

FKDQJHV WR WKH REMHFW
V RULJLQDO ILOH� ,I \RX XSGDWH WKH RULJLQDO ILOH� WKH

'HVLJQHU GRFXPHQW DOVR XSGDWHV�

'HVLJQHU PXVW KDYH DFFHVV WR WKH REMHFW
V RULJLQDO ILOH EHIRUH \RX FDQ HGLW LW�

)RU H[DPSOH� LI WKH ILOH /,1.�7,) LV ORFDWHG RQ GULYH $� EH VXUH WKH GLVNHWWH

FRQWDLQLQJ /,1.�7,) LV LQVHUWHG LQ WKH GULYH EHIRUH \RX DWWHPSW WR HGLW WKH

OLQNHG REMHFW�

7LS

/LQNLQJ LV D ZD\ IRU PRUH WKDQ RQH XVHU WR FRQQHFW WR WKH VDPH ILOH� )RU
H[DPSOH� OLQNLQJ FDQ EH KHOSIXO RQ D QHWZRUN ZKHUH VHYHUDO XVHUV DUH
ZRUNLQJ ZLWK WKH VDPH ILOH� 8VHUV DUH OLQNHG WR D PDVWHU ILOH VR WKDW
ZKHQHYHU RQH XVHU PDNHV D FKDQJH� WKH PDVWHU DQG DOO OLQNHG ILOHV VKRZ
WKH FKDQJH�

To link an OLE ob ject

1 &UHDWH WKH REMHFW LQ LWV RULJLQDO SURJUDP DQG VDYH LW DV D ILOH�

2 &RS\ WKH REMHFW \RX ZDQW WR OLQN WR WKH &OLSERDUG�

3 &ORVH WKH RULJLQDO SURJUDP LI \RX ZDQW�

4 2SHQ 'HVLJQHU� LI QHFHVVDU\�

5 2Q 'HVLJQHU
V (GLW PHQX� FOLFN 3DVWH 6SHFLDO� 7KH 3DVWH 6SHFLDO GLDORJ

ER[ RSHQV�
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6 &OLFN 3DVWH /LQN� 7KH REMHFW LV SDVWHG LQ WKH FHQWHU RI WKH SDJH�

7LS

<RX PXVW VDYH WKH OLQNHG REMHFW DV D ILOH�

To edit a linked/embedded ob ject

1 'RXEOH FOLFN WKH REMHFW WR HGLW� 7KH SURJUDP LQ ZKLFK WKH REMHFW ZDV

FUHDWHG �WKH VHUYHU� RSHQV DQG GLVSOD\V WKH REMHFW�

2 (GLW WKH REMHFW�

3 2Q WKH )LOH PHQX� FOLFN 6DYH WR XSGDWH WKH FKDQJHV LQ 'HVLJQHU�

4 &ORVH WKH VHUYHU SURJUDP ZKHQ \RX ILQLVK HGLWLQJ�

5 &OLFN <HV WR VDYH WKH OLQNHG ILOH DQG XSGDWH WKH REMHFW LQ 'HVLJQHU� FOLFN

1R WR GLVUHJDUG FKDQJHV PDGH VLQFH \RX ODVW VDYHG WKH OLQNHG ILOH�

7LS

$QRWKHU ZD\ WR HGLW D OLQNHG REMHFW LV WR FOLFN /LQNV RQ WKH (GLW PHQX�
VHOHFW WKH /LQN WR HGLW LQ WKH /LQNV GLDORJ ER[� DQG FOLFN (GLW�

Activating Linked Objects

<RX PLJKW ZDQW WR SOD\ RU DFWLYDWH FHUWDLQ W\SHV RI REMHFWV LQVWHDG RI HGLWLQJ

WKHP� )RU H[DPSOH� \RX FDQ SOD\ VRXQG� PXVLF� RU DQLPDWLRQ REMHFWV WKDW \RX

KDYH OLQNHG LQ \RXU GUDZLQJ�

,I \RX VHOHFW D OLQNHG YLGHR FOLS� IRU H[DPSOH� WKH VKRUWFXW PHQX IRU WKH

REMHFW GLVSOD\V WKH LWHP /LQNHG 9LGHR &OLS 2EMHFW� 7KH PHQX VXE�LWHPV

LQFOXGH D 3OD\ RSWLRQ� 1RQ�DFWLRQ REMHFWV� VXFK DV SLFWXUHV� FDQ RQO\ EH

HGLWHG�
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Viewing an OLE Link

/LQNV DUH GLVSOD\HG LQ WKH /LQNV GLDORJ ER[� $ GHVFULSWLRQ RI HDFK OLQN LQFOXGHV

WKH QDPH RI WKH VRXUFH DSSOLFDWLRQ� WKH W\SH RI OLQNHG REMHFW �IRU H[DPSOH�

SLFWXUH RU WH[W�� WKH ILOHQDPH� DQG ZKHWKHU WKH REMHFW XSGDWHV DXWRPDWLFDOO\

RU PDQXDOO\�

Updating an OLE Object

<RX FDQ XSGDWH REMHFWV DXWRPDWLFDOO\ RU PDQXDOO\ E\ VHOHFWLQJ $XWRPDWLF RU

0DQXDO LQ WKH /LQNV GLDORJ ER[� $XWRPDWLF XSGDWHV D OLQNHG REMHFW ZKHQHYHU

\RX FKDQJH LW� 0DQXDO RQO\ XSGDWHV WKH REMHFW ZKHQ \RX FOLFN 8SGDWH 1RZ LQ

WKH /LQNV GLDORJ ER[ DQG ZKHQ \RX FOLFN <HV ZKHQHYHU \RX DUH SURPSWHG WR

XSGDWH OLQNV�

7LS

6RPH 2/( SURJUDPV GRQ
W DXWRPDWLFDOO\ XSGDWH� ,Q WKRVH FDVHV� \RX PXVW
FKRRVH 6DYH WR XSGDWH�

Breaking an OLE Link

7KH &DQFHO /LQN FRPPDQG EUHDNV WKH OLQN EHWZHHQ DQ REMHFW DQG LWV VRXUFH

SURJUDP �VHUYHU��

To break an OLE link

1 6HOHFW WKH OLQNHG REMHFW LQ 'HVLJQHU�

2 2Q WKH (GLW PHQX� FOLFN 2/( /LQNV�

3 &OLFN &DQFHO /LQN�

4 <RX DUH DVNHG LI \RX ZDQW WR VHYHU WKH OLQN SHUPDQHQWO\� &OLFN <HV WR

EUHDN WKH OLQN� FOLFN 1R WR FDQFHO DQG OHDYH WKH OLQN XQEURNHQ�
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Changing the Location of a Linked File

:KHQ \RX HVWDEOLVK D OLQN� 'HVLJQHU �UHPHPEHUV� WKH ORFDWLRQ DQG QDPH RI

WKH VRXUFH ILOH� ,I \RX PRYH RU UHQDPH WKH ILOH� \RX PXVW WHOO 'HVLJQHU WKH

QHZ ORFDWLRQ DQG ILOHQDPH LQ RUGHU WR UHHVWDEOLVK WKH OLQN�

To chan ge an OLE link

1 6HOHFW WKH REMHFW LQ 'HVLJQHU�

2 2Q WKH (GLW PHQX� FOLFN 2/( /LQNV� 7KH /LQNV GLDORJ ER[ RSHQV�

3 &OLFN &KDQJH /LQN� 7KH &KDQJH OLQN GLDORJ ER[ RSHQV�

4 &KDQJH WR WKH GLUHFWRU\ ZKHUH WKH VRXUFH ILOH LV ORFDWHG DQG VHOHFW WKH

QHZ ILOHQDPH� LI QHFHVVDU\�

5 &OLFN 2.� 7KH OLQN LV UHHVWDEOLVKHG�
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Overview of Point Reshaping

:KHQ \RX VHOHFW DQ REMHFW IRU SRLQW UHVKDSLQJ� \RX FDQ GUDJ LWV DQFKRUV�

<RX FDQ UHVKDSH DQ\ REMHFW XVLQJ

WKLV PHWKRG� EXW UHFWDQJOHV� HOOLSVHV� DQG DUFV UHVKDSH LQ SUHGHILQHG ZD\V

ZKHQ \RX GUDJ WKHLU DQFKRUV�

7KH 3RLQW 5HVKDSH PRGH OHWV \RX FKDQJH WKH VKDSH RI DQ REMHFW E\ GUDJJLQJ

RQH RU PRUH RI LWV DQFKRUV�

1RWH

6SHFLDO REMHFWV FDQ EH UHVKDSHG RQO\ LQ VSHFLILF ZD\V LQ 3RLQW 5HVKDSH
PRGH� <RX FDQ LGHQWLI\ WKHVH VSHFLDO FDVHV EHFDXVH WKH\ VKRZ VROLG
DQFKRUV ZKHQ VHOHFWHG IRU 3RLQW 5HVKDSLQJ�

To select an ob ject for Point Resha ping

1 6HOHFW WKH REMHFW�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 )URP WKH PHQX� VHOHFW WKH 5HVKDSH 3RLQWV FRPPDQG�

RU

5LJKW�FOLFN WKH PRXVH EXWWRQ WR RSHQ WKH PHQX�

RU

6HOHFW WKH REMHFW� SUHVV DQG KROG CTRL� DQG FOLFN�
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Displaying an Anchor’s Control Points

$Q DQFKRU
V FRQWURO SRLQWV DUH YLVLEOH RQO\ GXULQJ FXUYH UHVKDSLQJ� ,I DQ

REMHFW LV QRW LQ &XUYH 5HVKDSH PRGH� \RX FDQ SXW LW LQ &XUYH 5HVKDSH PRGH

E\ VHOHFWLQJ WKH REMHFW� FOLFNLQJ WKH (GLW WRR/ � DQG FKRRVLQJ WKH 5HVKDSH

&XUYH FRPPDQG�

7R GLVSOD\ DQ HGJH
V FRQWURO SRLQWV� FOLFN RQH RI WKH HGJH
V DQFKRUV� %HFDXVH

WKHUH DUH %Â]LHU FRQWURO SRLQWV IRU HDFK DQFKRU RQ D HGJH� \RX PXVW GHFLGH

ZKLFK DQFKRU
V FRQWURO SRLQWV \RX ZDQW WR XVH WR UHVKDSH WKH HGJH� $IWHU D

OLWWOH H[SHULHQFH ZLWK FRQWURO�SRLQW UHVKDSLQJ� WKLV FKRLFH ZLOO XVXDOO\ EH

REYLRXV�

%Â]LHU FRQWURO SRLQWV ORRN OLNH VPDOO FKHFNHUERDUGV� 'UDJJLQJ D FRQWURO SRLQW

FKDQJHV WKH VKDSH RI WKH HGJH DVVRFLDWHG ZLWK WKH SRLQW� &RQWURO SRLQWV DUH

DOZD\V FRQQHFWHG WR DQFKRUV� 7KLQN RI D FRQWURO SRLQW DV D PDJQHW WKDW

DWWUDFWV WKH HGJH� :KHQ \RX GUDJ D FRQWURO SRLQW� LWV DQFKRU GRHV QRW FKDQJH

SRVLWLRQ�

7LS

:KHQ \RX PRYH WKH PRXVH SRLQWHU
RYHU D FRQWURO SRLQW� 'HVLJQHU GUDZV D SUHYLHZ OLQH EHWZHHQ WKH FRQWURO
SRLQW DQG LWV DQFKRU� 7KLV OHWV \RX TXLFNO\ LGHQWLI\ WKH DQFKRU WR ZKLFK D
FRQWURO SRLQW LV FRQQHFWHG�
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To resha pe by movin g an anchor

1 6HOHFW WKH REMHFW WKDW \RX ZDQW WR UHVKDSH�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 )URP WKH PHQX� FOLFN WKH 5HVKDSH 3RLQWV FRPPDQG�

RU

&OLFN WKH ULJKW PRXVH EXWWRQ WR RSHQ WKH PHQX�

RU

+ROG CTRL DQG FOLFN WKH REMHFW�

4 ,I WKH REMHFW VKRZV D VROLG DQFKRU �LQGLFDWLQJ D VSHFLDO 3RLQW 5HVKDSH

FDVH�� FOLFN WKH ULJKW PRXVH EXWWRQ DQG FOLFN 7R &XUYHV� 7KLV FDQFHOV

WKH VSHFLDO UHVKDSH GHILQLWLRQ DQG GLVSOD\V WKH REMHFW
V KROORZ DQFKRUV�

5 &OLFN DQ DQFKRU WR VHOHFW LW� ,W WXUQV VROLG�

6 'UDJ WKH DQFKRU WR D QHZ ORFDWLRQ� 7KH REMHFW
V VKDSH FKDQJHV�

7LSV

7R FUHDWH D FRS\ RI DQ DQFKRU� SUHVV DQG KROG SHIFT DV \RX GUDJ LW�

7R FRQVWUDLQ DQ DQFKRU
V DQJXODU PRYHPHQW WR ���GHJUHH LQFUHPHQWV�
SUHVV DQG KROG CTRL DV \RX GUDJ LW�

To move multi ple anchors

1 6HOHFW WKH REMHFW WKDW \RX ZDQW WR UHVKDSH�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[�

3 )URP WKH PHQX� FOLFN WKH 5HVKDSH 3RLQWV FRPPDQG�

RU

&OLFN WKH ULJKW PRXVH EXWWRQ WR RSHQ WKH PHQX�

RU

+ROG CTRL DQG FOLFN WKH REMHFW�
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4 ,I WKH REMHFW VKRZV D VROLG DQFKRU �LQGLFDWLQJ D VSHFLDO 3RLQW 5HVKDSH

FDVH�� FOLFN WKH ULJKW PRXVH EXWWRQ DQG FOLFN 7R &XUYHV� 7KLV FDQFHOV

WKH VSHFLDO UHVKDSH GHILQLWLRQ DQG GLVSOD\V WKH REMHFW
V KROORZ DQFKRUV�

5 'UDJ D ER[ DURXQG WKH DQFKRUV \RX ZDQW WR VHOHFW�

RU

&OLFN WKH ILUVW DQFKRU \RX ZDQW WR VHOHFW

6 3UHVV DQG KROG SHIFT� DQG FOLFN WKH RWKHU DQFKRUV \RX ZDQW WR VHOHFW�

6HOHFWHG DQFKRUV EHFRPH VROLG�

7 'UDJ DQ\ VHOHFWHG DQFKRU� $OO DQFKRUV IROORZ WKH PRYHPHQW�

7LS

,I \RX VWDUW WR GUDJ D ER[ DURXQG DQFKRUV DQG WKHQ FKDQJH \RXU PLQG�
SUHVV ESC WR FDQFHO WKH ER[�

Overview of Curve Reshaping

:KHQ \RX VHOHFW DQ REMHFW IRU FXUYH UHVKDSLQJ� \RX FDQ GUDJ LWV FRQWURO

SRLQWV�

7R XVH FXUYH UHVKDSLQJ RQ VSHFLDO REMHFWV VXFK DV WH[W� UHFWDQJOHV� HOOLSVHV� RU

DUFV� \RX PXVW ILUVW FRQYHUW WKHP WR FXUYHV�
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Movin g a sin gle anchor

0RYLQJ DQ DQFKRU LV WKH VLPSOHVW ZD\ WR UHVKDSH DQ REMHFW� $V \RX GUDJ DQ

DQFKRU� WKH OLQHV FRQQHFWLQJ LW WR RWKHU DQFKRUV FKDQJH�

Movin g multi ple anchors

<RX FDQ PRYH VHYHUDO DQFKRUV VLPXOWDQHRXVO\ E\ VHOHFWLQJ WKH DQFKRUV DQG

GUDJJLQJ RQH RI WKHP

7LS

,I \RX VWDUW WR GUDJ D ER[ DURXQG DQFKRUV DQG WKHQ FKDQJH \RXU PLQG�
SUHVV ESC WR FDQFHO WKH ER[�

7KH &XUYH 5HVKDSH PRGH OHWV \RX FKDQJH WKH VKDSH RI DQ REMHFW E\ GUDJJLQJ

LWV %H]LHU FRQWURO SRLQWV� 7KLV W\SH RI UHVKDSLQJ FUHDWHV FXUYHG HGJHV� 7KH

IXUWKHU \RX GUDJ D %H]LHU FRQWURO SRLQW� WKH PRUH \RX FXUYH DQ HGJH�

7R VHOHFW� 'R WKLV�

2QH DQFKRU &OLFN WKH DQFKRU�

0XOWLSOH DQFKRUV 'UDJ D ER[ DURXQG WKH DQFKRUV� RU SUHVV DQG KROG

SHIFT DQG FOLFN WKH DQFKRUV�

$OO DQFKRUV 2Q WKH (GLW PHQX� FOLFN 6HOHFW $OO� RU SUHVV CTRL 
+A.

$OO H[FHSW

FXUUHQWO\ VHOHFWHG

DQFKRUV

3UHVV DQG KROG SHIFT DQG FOLFN 6HOHFW $OO RQ WKH (GLW

PHQX� RU SUHVV CTRL+SHIFT+A�
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7DNH VRPH WLPH WR SUDFWLFH UHVKDSLQJ %Â]LHU FXUYHV� ,W
V D VNLOO WKDW
V ZRUWK

OHDUQLQJ LI \RX SODQ WR GUDZ DQG HGLW FXUYHG REMHFWV�

To select an ob ject for Curve Resha ping

1 6HOHFW WKH REMHFW�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 )URP WKH PHQX� VHOHFW 5HVKDSH &XUYHV� RU VHOHFW WKH REMHFW� SUHVV DQG

KROG CTRL+SHIFT� DQG FOLFN�

RU

&OLFN WKH ULJKW PRXVH EXWWRQ WR RSHQ WKH PHQX�

7LS

$QFKRUV DSSHDU RQ DQ REMHFW ZKHQ WKH REMHFW LV LQ D UHVKDSH PRGH� ,I \RX
DUH QRW FHUWDLQ ZKLFK UHVKDSH PRGH WKH REMHFW LV LQ� FKHFN WKH SRLQWHU�
7KH SRLQWHU LV VKDSHG OLNH DQ DQFKRU LQ 3RLQW 5HVKDSH PRGH DQG D FRQWURO
SRLQW LQ &XUYH 5HVKDSH PRGH�

Adding and Deleting Anchors

<RX FDQ DGG QHZ RU GHOHWH H[LVWLQJ DQFKRUV WR KHOS LQ UHVKDSLQJ� 8VH WKH

$GG 3RLQW DQG 5HPRYH 3RLQW EXWWRQV RQ WKH (GLW ULEERQ WR DGG DQG

GHOHWH DQFKRUV� <RX FDQ DGG DQG UHPRYH DQFKRUV LQ HLWKHU 3RLQW RU &XUYH

5HVKDSH PRGHV�

Anchor deleted
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To add a new anchor to an ob ject

1 6HOHFW WKH REMHFW�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 2Q WKH PHQX� VHOHFW 5HVKDSH 3RLQWV RU 5HVKDSH &XUYHV�

4 ,I WKH REMHFW VKRZV D VROLG DQFKRU �LQGLFDWLQJ D VSHFLDO 3RLQW 5HVKDSH

FDVH�� FOLFN WKH ULJKW PRXVH EXWWRQ DQG FOLFN 7R &XUYHV� 7KLV FDQFHOV

WKH VSHFLDO UHVKDSH GHILQLWLRQ DQG GLVSOD\V WKH REMHFW
V KROORZ DQFKRUV�

5 &OLFN WKH $GG 3RLQW EXWWRQ �

6 &OLFN ZKHUH \RX ZDQW WR DGG DQFKRU�

<RX DOVR FDQ DGG DQFKRUV WR DQ REMHFW E\ SRLQWLQJ ZKHUH \RX ZDQW DQ

DQFKRU� KROGLQJ CTRL� DQG FOLFNLQJ WKH OHIW PRXVH EXWWRQ�

To delete an anchor

1 ,I QHFHVVDU\� GRXEOH�FOLFN WKH REMHFW WR DOORZ SRLQW UHVKDSLQJ�

2 &OLFN WKH DQFKRU \RX ZDQW WR GHOHWH�

3 2Q WKH ULEERQ� FOLFN WKH 5HPRYH 3RLQW EXWWRQ � 2QO\ WKH VHOHFWHG

DQFKRUV DUH GHOHWHG�

7LS

6HOHFW WKH DQFKRU DQG SUHVV WKH DEL NH\�
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Breaking Apart at an Anchor

<RX FDQ VOLFH DQ REMHFW DW DQ DQFKRU� $IWHU \RX VOLFH WKH REMHFW� WKH VLQJOH

DQFKRU EHFRPHV WZR DQFKRUV WKDW \RX FDQ PRYH VHSDUDWHO\�

To break a part an ob ject at an anchor

1 6HOHFW WKH REMHFW \RX ZDQW WR VOLFH�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 6HOHFW 5HVKDSH 3RLQWV RU 5HVKDSH &XUYH IURP WKH PHQX�

4 ,I WKH REMHFW VKRZV D VROLG DQFKRU �LQGLFDWLQJ D VSHFLDO 3RLQW�5HVKDSH

FDVH�� FOLFN WKH ULJKW PRXVH EXWWRQ DQG FOLFN 7R &XUYHV� 7KLV FRQYHUWV

WKH VSHFLDO REMHFW WR FXUYHV DQG GLVSOD\V WKH REMHFW
V KROORZ DQFKRUV�

5 6HOHFW WKH DQFKRU WR EUHDN DSDUW�

6 &OLFN WKH 6OLFH EXWWRQ � 7KH OLQH LV QRZ VHYHUHG DW WKH DQFKRU�

Reshaping Curves and Corners

Convertin g a corner to a curve

<RX FDQ SURGXFH V\PPHWULFDO FXUYHV LQ 3RLQW 5HVKDSH PRGH E\ FRQYHUWLQJ

DQ DQFKRU WR D V\PPHWULFDO FXUYH SRLQW� $IWHU \RX FRQYHUW DQ DQFKRU WR D

V\PPHWULFDO FXUYH SRLQW� GUDJJLQJ WKH SRLQW UHVKDSHV WKH FRQQHFWHG HGJHV DV

FXUYHV�
204 i G r a f x  D e s i g n e r



Convertin g a curve to a corner

<RX FDQ UHPRYH WKH FXUYH IURP DQ REMHFW ZKHUH LW SDVVHV WKURXJK DQ DQFKRU

E\ FRQYHUWLQJ WKH DQFKRU IURP D FXUYH WR D FRUQHU� 7KH FRUQHU DQFKRU DFWV

OLNH D KLQJH�

To resha pe a curve

1 6HOHFW WKH REMHFW WKDW \RX ZDQW WR UHVKDSH�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[�

3 6HOHFW 5HVKDSH &XUYH LQ WKH PHQX RU +ROG CTRL+SHIFT DQG FOLFN WKH

REMHFW RU FOLFN WKH ULJKW PRXVH EXWWRQ WR GLVSOD\ WKH PHQX�

4 6HOHFW DQ DQFKRU RQ WKH HGJH WKDW \RX ZDQW WR UHVKDSH�

&KHFNHUERDUG�VKDSHG FRQWURO SRLQWV DSSHDU QHDU WKH DQFKRU�

5 'UDJ WKH FRQWURO SRLQWV WR FKDQJH WKH HGJH
V VKDSH�

Converting to Curves

7KH &RQYHUW 7R &XUYHV FRPPDQG �NH\ERDUG VKRUWFXW CTRL+R� DQG

&RQYHUW WR &XUYHV EXWWRQ FRQYHUW DQ REMHFW VXFK DV WH[W� D UHFWDQJOH� RU DQ

HOOLSVH LQWR D FRQYHQWLRQDO REMHFW� 7KLV OHWV \RX HGLW WKH REMHFW ZLWK UHVKDSH

SRLQWV� ,W DOVR GRHV WKH IROORZLQJ�

v &RQYHUWV GLPHQVLRQ OLQHV WR JURXSV�

v &RQYHUWV D :LQGRZV PHWDILOH WR 'HVLJQHU REMHFWV�

v &RQYHUWV RWKHU VKDSHV WR SDWK REMHFWV DQG FKDQJHV WKHP VR WKDW

'HVLJQHU GRHV QRW UHPHPEHU DQ\ SUHYLRXV WUDQVIRUPV GRQH WR WKHP�

1RWH

<RX FDQQRW FRQYHUW DQ REMHFW EDFN LQWR D VSHFLDO REMHFW� H[FHSW E\ XVLQJ
8QGR�
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Creating Symmetrical Curves

$Q DQFKRU RQ D FXUYH KDV WZR FRQWURO SRLQWV� 7KH 6\PPHWULFDO &XUYH

EXWWRQ �NH\ERDUG VKRUWFXW CTRL+7� FDXVHV WKH VHFRQG FRQWURO SRLQW WR

PLUURU WKH PRYHPHQW RI WKH ILUVW� <RX FDQ XVH WKH 6\PPHWULFDO &XUYH

EXWWRQ WR KHOS PDLQWDLQ WKH FXUYH RI DQ REMHFW�

To convert a corner to a s ymmetrical curve

1 6HOHFW WKH REMHFW WKDW \RX ZDQW WR UHVKDSH�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 6HOHFW 5HVKDSH SRLQWV IURP WKH PHQX RU FOLFN WKH ULJKW PRXVH EXWWRQ

RU KROG CTRL DQG FOLFN WKH REMHFW�

4 ,I WKH REMHFW VKRZV D VROLG DQFKRU �LQGLFDWLQJ D VSHFLDO 3RLQW�5HVKDSH

FDVH�� FOLFN WKH ULJKW PRXVH EXWWRQ DQG FOLFN 7R &XUYHV� 7KLV FDQFHOV

WKH VSHFLDO UHVKDSH GHILQLWLRQ DQG GLVSOD\V WKH REMHFW
V KROORZ DQFKRUV�

5 &OLFN DQ DQFKRU WR VHOHFW LW� ,W WXUQV VROLG�

6 2Q WKH ULEERQ� FOLFN WKH 6\PPHWULFDO &XUYH EXWWRQ � 7KH OLQHV

WRXFKLQJ WKH DQFKRU EHFRPH V\PPHWULFDO FXUYHV�

To convert a curve to a corner

1 6HOHFW WKH REMHFW WKDW \RX ZDQW WR UHVKDSH�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO � DQG VHOHFW 5HVKDSH 3RLQWV RU

5HVKDSH &XUYH�
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3 ,I WKH REMHFW VKRZV D VROLG DQFKRU �LQGLFDWLQJ D VSHFLDO 3RLQW�5HVKDSH

FDVH�� FOLFN WKH ULJKW PRXVH EXWWRQ DQG FOLFN 7R &XUYHV� 7KLV FDQFHOV

WKH VSHFLDO UHVKDSH GHILQLWLRQ DQG GLVSOD\V WKH REMHFW
V KROORZ DQFKRUV�

4 6HOHFW WKH DQFKRU�

5 &OLFN WKH &RUQHU EXWWRQ RQ WKH 5LEERQ�

Creating a Corner

<RX FDQ FUHDWH D FRUQHU� RU QRQ�FXUYLQJ DQFKRU� DW DQ\ SRLQW RQ D FXUYH ZLWK

WKH &RUQHU EXWWRQ �NH\ERDUG VKRUWFXW CTRL+5�� /LQHV WKDW SDVV WKURXJK
QRQ�FXUYLQJ DQFKRUV ORVH WKHLU FXUYDWXUH�

<RX FDQ DOVR FUHDWH D FRUQHU DW WKH HQG RI D OLQH WR UHPRYH D FXUYH RQ D OLQH�

To create a corner

1 6HOHFW WKH REMHFW WKDW \RX ZDQW WR UHVKDSH�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 2Q WKH ULEERQ� FOLFN WKH &XUYH 5HVKDSH EXWWRQ RU KROG

CTRL+SHIFT DQG FOLFN WKH REMHFW�

4 6HOHFW DQ DQFKRU RQ WKH FXUYH�

5 &OLFN WKH &RUQHU EXWWRQ � 7KH OLQHV WRXFKLQJ WKH DQFKRU EHFRPH

VWUDLJKW VR WKDW D FRUQHU LV IRUPHG DW WKH DQFKRU�

RT_To_create_a_corner
RT_To_create_a_corner
7R VHOHFW DQ REMHFW IRU 3RLQW 5HVKDSLQJ

&UHDWLQJ D &RUQHU
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&UHDWLQJ D &XVS

Creating a Cusp

$ FXVS LV DQ DQFKRU ZKHUH WZR %H]LHU FXUYHV LQWHUVHFW DW GLIIHUHQW DQJOHV�

UHVXOWLQJ LQ DQ HOERZ VKDSH� &XVSV DUH FUHDWHG E\ PRYLQJ RQH FRQWURO SRLQW

LQGHSHQGHQWO\ RI WKH VHFRQG FRQWURO SRLQW� <RX FDQ XQORFN DQ DQFKRU
V

FRQWURO SRLQWV VR \RX FDQ PRYH WKHP LQGHSHQGHQWO\ XVLQJ WKH 8QORFNHG

&XVS EXWWRQ �NH\ERDUG VKRUWFXW CTRL+6��

$IWHU FUHDWLQJ WKH VKDSH WKDW \RX ZDQW E\ PRYLQJ WKH FRQWURO SRLQWV

LQGHSHQGHQWO\� \RX FDQ UH�ORFN WKH FRQWURO SRLQWV XVLQJ WKH /RFNHG &XVS

EXWWRQ �NH\ERDUG VKRUWFXW CTRL+4�� /RFNLQJ FRQWURO SRLQWV ORFNV WKH

DQJXODU UHODWLRQVKLS EHWZHHQ WKH SRLQWV VR WKDW ZKHQ \RX GUDJ RQH RI WKH

SRLQWV� WKH RSSRVLWH PRYHV DOVR DV UHTXLUHG WR NHHS WKH DQJOH EHWZHHQ WKH

WZR SRLQWV WKH VDPH� $Q DQFKRU
V FRQWURO SRLQWV DUH ORFNHG DXWRPDWLFDOO\ E\

FRQYHUWLQJ WKH DQFKRU WR D V\PPHWULFDO FXUYH RU FRUQHU�

To create a cus p

1 6HOHFW WKH REMHFW WKDW \RX ZDQW WR UHVKDSH�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 6HOHFW 5HVKDSH &XUYH RQ WKH PHQX RU KROG CTRL+SHIFT DQG FOLFN WKH

REMHFW�

4 6HOHFW DQ DQFKRU RQ WKH FXUYH�

5 &OLFN WKH 8QORFNHG &XVS EXWWRQ �
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6 'UDJ RQH RI WKH FRQWURO SRLQWV� +DOI RI WKH FXVS LV IRUPHG�

7 'UDJ WKH VHFRQG FRQWURO SRLQW WR FUHDWH WKH VHFRQG KDOI RI WKH FXVS�

7LS

7R ORFN RU XQORFN D FRQWURO SRLQW� SUHVV DQG KROG SHIFT ZKLOH GUDJJLQJ WKH
SRLQW� 7KH ORFNHG RU XQORFNHG VWDWXV RI WKH SRLQW VZLWFKHV ZKLOH WKH SHIFT
NH\ LV SUHVVHG�

Cut at Point

&XWWLQJ RSHQV D FORVHG REMHFW DQG FUHDWHV WZR HQGSRLQWV ZKHUHYHU WKH FXW

RFFXUV� <RX FDQ FXW D OLQH LQ HLWKHU 3RLQW RU &XUYH 5HVKDSH PRGHV�
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To cut an ob ject

1 6HOHFW WKH REMHFW�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 6HOHFW 5HVKDSH 3RLQWV RU 5HVKDSH &XUYH IURP WKH PHQX�

4 ,I WKH REMHFW VKRZV D VROLG DQFKRU �LQGLFDWLQJ D VSHFLDO 3RLQW 5HVKDSH

FDVH�� FOLFN WKH ULJKW PRXVH EXWWRQ DQG FOLFN 7R &XUYHV� 7KLV FDQFHOV

WKH VSHFLDO UHVKDSH GHILQLWLRQ DQG GLVSOD\V WKH REMHFW
V KROORZ DQFKRUV�

5 &OLFN WKH &XW DW 3RLQW EXWWRQ �

6 'UDJ DFURVV WKH OLQH WR EH FXW� $ QHZ� VROLG DQFKRU DSSHDUV DW WKH FXW

ORFDWLRQ�

1RWH

<RX FDQ VOLFH RQO\ RQH OLQH DW D WLPH� 0DNH VXUH \RX FOLFN WKH &XW DW 3RLQW
EXWWRQ EHIRUH PDNLQJ HDFK VOLFH�

Overview of Special Objects

5HFWDQJOHV� HOOLSVHV� DQG DUFV FDQ EH UHVKDSHG RQO\ LQ VSHFLILF ZD\V LQ UHVKDSH

PRGH� <RX FDQ LGHQWLI\ WKHVH VSHFLDO FDVHV EHFDXVH WKH\ VKRZ VROLG DQFKRUV

ZKHQ VHOHFWHG IRU 5HVKDSLQJ�

v 7KH VSHFLDO 5HFWDQJOH 5HVKDSH PRGH IRU UHFWDQJOHV OHWV \RX URXQG RU

VKDUSHQ WKH FRUQHUV RI D UHFWDQJOH E\ GUDJJLQJ WKH VROLG DQFKRU WRZDUG

WKH FHQWHU RI WKH UHFWDQJOH�

v 7KH VSHFLDO (OOLSVH RU &RQLF 5HVKDSH PRGH IRU HOOLSVHV OHWV \RX FKDQJH

DQ HOOLSVH LQWR D SLH�VKDSHG ZHGJH RU DQ DUF� 7R FKDQJH WKH HOOLSVH LQWR

D SLH�VKDSHG ZHGJH� GUDJ WKH VROLG DQFKRU WRZDUG WKH FHQWHU RI WKH

HOOLSVH� 7R FKDQJH WKH HOOLSVH LQWR DQ DUF� GUDJ WKH VROLG DQFKRU DURXQG

WKH RXWVLGH RI WKH HOOLSVH�
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v 7KH VSHFLDO (OOLSVH RU &RQLF 5HVKDSH PRGH IRU DUFV OHWV \RX FKDQJH DQ

DUF LQWR D SLH�VKDSHG ZHGJH E\ GUDJJLQJ HLWKHU RI WKH WZR VROLG

DQFKRUV WRZDUG WKH LQVLGH RI WKH DUF�

1RWH

7R UHVKDSH D UHFWDQJOH� HOOLSVH� RU DQ DUF LQ RWKHU ZD\V� \RX PXVW ILUVW
FRQYHUW LW WR D FXUYH�

To convert a s pecial ob ject to curves

` 6HOHFW WKH REMHFW� FOLFN WKH (GLW WRRO � DQG VHOHFW 5HVKDSH &XUYH RU

5HVKDSH 3RLQWV IURP WKH PHQX�

RU

` 'RXEOH FOLFN WKH REMHFW WR SXW LW LQ UHVKDSH PRGH �GHSHQGV RQ WKH

2SWLRQV�,QSXW VHWWLQJV�� FOLFN WKH ULJKW PRXVH EXWWRQ� DQG FOLFN 7R

&XUYHV RQ WKH PRXVH PHQ� RU FOLFN WKH 7R &XUYHV EXWWRQ RQ WKH HGLW

ULEERQ�

RU

` 6HOHFW WKH REMHFW� 5LJKW FOLFN DQG VHOHFW 5HVKDSH &XUYH RU 5HVKDSH

3RLQWV IURP WKH PHQX�

Joining Endpoints of an Open Object

<RX FDQ MRLQ WKH WZR HQGSRLQWV RI DQ RSHQ REMHFW E\ XVLQJ WKH -RLQ 3RLQWV

EXWWRQ � 7KH WZR SRLQWV DUH MRLQHG ZLWK D VWUDLJKW OLQH�
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To join end points of an o pen ob ject

1 6HOHFW WKH REMHFW WKDW \RX ZDQW WR MRLQ�

2 ,Q WKH 7RROER[� FOLFN WKH (GLW WRRO �

3 6HOHFW 5HVKDSH 3RLQWV RU 5HVKDSH &XUYH IURP WKH PHQX�

4 6HOHFW RQH RI WKH HQGSRLQWV� ,W WXUQV VROLG�

5 3UHVV DQG KROG SHIFT� DQG VHOHFW WKH RWKHU HQGSRLQW� ,W WXUQV VROLG�

6 &OLFN WKH -RLQ 3RLQWV EXWWRQ � 3UHVV ESC WR H[LW UHVKDSH PRGH� 7KH

REMHFW LV QRZ FORVHG DQG ILOOHG ZLWK WKH GHIDXOW LQWHULRU ILOO�
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Smoothing an Object

,I DQ REMHFW RU FXUYH FRQWDLQV PDQ\ WZLVWV DQG WXUQV� \RX FDQ VPRRWK LWV

DSSHDUDQFH E\ HOLPLQDWLQJ VRPH RI LWV DQFKRUV�

2EMHFWV SURGXFHG E\ WUDFLQJ ELWPDSV VRPHWLPHV KDYH DQ XQGHVLUDEO\ ODUJH

QXPEHU RI DQFKRUV� %\ UHGXFLQJ WKH QXPEHU RI DQFKRUV LQ D WUDFHG REMHFW�

\RX RIWHQ FDQ LPSURYH WKH REMHFW
V DSSHDUDQFH� 5HGXFLQJ WKH QXPEHU RI

DQFKRUV LQ DQ REMHFW DOVR FDQ LPSURYH LWV SULQWLQJ VSHHG�

To smooth an ob ject

1 6HOHFW WKH REMHFW�

2 2Q WKH 2EMHFW PHQX� FOLFN 5HGXFH 3RLQWV�

3 ,Q WKH 5HGXFH 3RLQWV GLDORJ ER[� GUDJ WKH 3RLQWV VOLGLQJ EDU WRZDUG /HVV�

7KH IXUWKHU \RX GUDJ WKH VOLGLQJ EDU� WKH PRUH SRLQWV 'HVLJQHU WULHV WR

HOLPLQDWH�

7LS

,I \RX GRQ
W OLNH WKH HIIHFW RI WKH SRLQW UHGXFWLRQ� <RX FDQ UHVWRUH WKH
RULJLQDO VKDSH� 2Q WKH (GLW PHQX� FOLFN 8QGR 5HGXFH 3RLQWV�

Trimming Objects

,QVLGH REMHFWV DQG RXWVLGH REMHFWV FDQ EH WULPPHG�

To trim an inside ob ject

1 2Q WKH (IIHFWV PHQX� VHOHFW 7ULP DQG WKHQ FOLFN 7ULP ,QVLGH 2EMHFW RQ

WKH VXEPHQX�

2 6HOHFW WKH REMHFW WR EH WULPPHG�

3 6HOHFW WKH WULPPLQJ REMHFW� 7KH LQVLGH REMHFW LV WULPPHG�
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To trim an outside ob ject

1 2Q WKH (IIHFWV PHQX� VHOHFW 7ULP DQG WKHQ FOLFN 7ULP 2XWVLGH 2EMHFW

RQ WKH VXEPHQX�

2 6HOHFW WKH WULPPLQJ REMHFW�

3 6HOHFW WKH REMHFW WR EH WULPPHG� 7KH VHOHFWHG REMHFW LV WULPPHG�

Outlining Objects

<RX FDQ RXWOLQH RQH REMHFW RU D JURXS RI REMHFWV�

To outline an ob ject

1 6HOHFW RQH RU PRUH REMHFWV�

2 2Q WKH (IIHFWV PHQX� VHOHFW 0RGLI\ DQG WKHQ FOLFN 2XWOLQH RQ WKH

VXEPHQX�

3 $Q RXWOLQH RI WKH REMHFW RU JURXS RI REMHFWV LV FUHDWHG�

1RWH

7KH RXWOLQH LV SODFHG RQ WRS RI WKH RULJLQDO REMHFW� 7R YLHZ WKH RXWOLQH�
VHOHFW DQG PRYH WKH RXWOLQH�
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Using Dimensions
Using Dimensions

'LPHQVLRQ OLQHV VKRZ WKH VL]H� OHQJWK� GLVWDQFH� RU RWKHU PHDVXUHPHQWV

UHODWHG WR REMHFWV LQ D GUDZLQJ�

7KH 'HVLJQHU GLPHQVLRQ IHDWXUHV DUH SRZHUIXO DQG HDV\�WR�XVH� 7KH

GLPHQVLRQ FDSDELOLWLHV RI 'HVLJQHU LQFOXGH�

v 'LPHQVLRQ OLQHV FDQ PHDVXUH WKH DOLJQHG �GLDJRQDO�� KRUL]RQWDO� RU

YHUWLFDO GLVWDQFHV EHWZHHQ SRLQWV�

v 'LPHQVLRQ OLQHV DUH G\QDPLF REMHFWV WKDW DXWRPDWLFDOO\ UHFDOFXODWH

WKHLU PHDVXUHPHQWV ZKHQ VFDOHG� PRYHG� URWDWHG� RU VNHZHG�

v 'LPHQVLRQ OLQHV FDQ EH RIIVHW IURP WKHLU PHDVXUHG SRLQWV WR LPSURYH

DSSHDUDQFH DQG WR DLG FODULW\�
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v 'LPHQVLRQ OLQHV FDQ KDYH D YDULHW\ RI OLQH HQGV� LQFOXGLQJ DUURZKHDGV�

EDUV� DQG ER[HV�

v 'LPHQVLRQ OLQHV FDQ LQGLFDWH GLVWDQFH ZLWK LQVLGH RU RXWVLGH DUURZV�

v <RX FDQ SRVLWLRQ WKH GLPHQVLRQ XQLWV DERYH� RQ� RU EHORZ D GLPHQVLRQ

OLQH� DQG DGMXVW WKHLU RULHQWDWLRQ�

v <RX FDQ SRVLWLRQ WKH GLPHQVLRQ XQLWV DQ\ZKHUH DORQJ D GLPHQVLRQ OLQH�

RU H[WHQG WKH XQLWV EH\RQG HLWKHU HQG RI WKH OLQH�

v <RX FDQ VHW WKH GHJUHH RI SUHFLVLRQ� IRQW� DQG IRQW VL]H LQGLYLGXDOO\ IRU

HDFK GLPHQVLRQ OLQH�

v <RX FDQ VSHFLI\ WKH XQLWV RI PHDVXUH� LQFOXGLQJ FXVWRP XQLWV� IRU HDFK

GLPHQVLRQ OLQH� <RX FDQ DOVR VHW D VFDOH WR UHODWH RQH XQLW RI PHDVXUH

WR DQRWKHU�

v <RX FDQ DGG WH[W EHIRUH DQG DIWHU WKH GLPHQVLRQ YDOXH IRU D GLPHQVLRQ

OLQH�

v 7KH GLPHQVLRQ XQLWV WKDW \RX XVH ZLWK D GUDZLQJ DUH VDYHG ZLWK WKH

GUDZLQJ VR WKDW \RX GR QRW KDYH WR UHVHW WKHP HDFK WLPH \RX RSHQ WKH

ILOH�
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Drawing Dimension Lines

7KH 'LPHQVLRQ WRRO �NH\ERDUG VKRUWFXW CTRL+0� LV XVHG WR GUDZ

GLPHQVLRQ OLQHV�

The Dimension Ribbon

7KH 'LPHQVLRQ WRRO �NH\ERDUG VKRUWFXW CTRL+0� LV XVHG WR GUDZ

GLPHQVLRQ OLQHV� 7R GUDZ D GLPHQVLRQ OLQH� FOLFN WKH $OLJQHG� +RUL]RQWDO�

9HUWLFDO� $QJXODU� RU 5DGLDO EXWWRQ LQ WKH ULEERQ DQG WKHQ GUDJ WKH OLQH IURP

RQH SRLQW WR DQRWKHU WR PHDVXUH WKH GLVWDQFH� 7R RIIVHW WKH GLPHQVLRQ OLQH

IURP WKH SRLQWV PHDVXUHG� \RX GUDJ WKH SRLQWHU DZD\ IURP WKH GLPHQVLRQ

OLQH� %DVHG XSRQ ZKHWKHU \RX KDYH VHOHFWHG DQ DOLJQHG� D KRUL]RQWDO� RU D

YHUWLFDO PHDVXUH� 'HVLJQHU FDOFXODWHV WKH GLVWDQFH EHWZHHQ WKH SRLQWV DQG

GLVSOD\V LW LQ WKH XQLWV \RX VSHFLI\�

$OLJQHG 'LPHQVLRQ

+RUL]RQWDO�9HUWLFDO

'LPHQVLRQ

'LPHQVLRQ 2SWLRQV

$QJXODU�5DGLDO

'LPHQVLRQ

5HVKDSH

'LVSOD\HG 3UHFLVLRQ

8QLWV

7H[W $WWULEXWHV

/LQH (QGV
&HQWHU 7H[W

$QJOH &RQVWUDLQW
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$IWHU GUDZLQJ D GLPHQVLRQ OLQH� \RX FDQ HDVLO\ UHVKDSH LW DQG HGLW LWV RWKHU

DWWULEXWHV� LQFOXGLQJ WH[W DOLJQPHQW� OLQH WKLFNQHVV� DQG OLQH HQGV�

7LS

'LPHQVLRQ OLQHV DUH JHQHUDOO\ DGGHG WR D GUDZLQJ DIWHU WKH GUDZLQJ LV
FUHDWHG� 7R PDNH LW HDV\ WR DOLJQ GLPHQVLRQ OLQHV WR WKH HQGSRLQWV RI
VKDSHV� VHOHFW WKH (QG 3RLQWV RSWLRQ LQ WKH 5XOHUV�6QDS SDQHO RI WKH
2SWLRQV GLDORJ ER[� 7KHQ XVH VQDS SRLQWV WR IRUFH WKH PRXVH SRLQWHU WR
PRYH SUHFLVHO\ WR DQ HQGSRLQW� 8VH '\QDPLF 6QDS WR EH OLQNHG WR WKH
REMHFW�

7KH $OLJQHG EXWWRQ OHWV \RX GUDZ GLPHQVLRQ OLQHV WKDW PHDVXUH WKH

GLDJRQDO GLVWDQFH EHWZHHQ WZR SRLQWV�

7KH +RUL]RQWDO EXWWRQ OHWV \RX GUDZ GLPHQVLRQ OLQHV WKDW PHDVXUH WKH

KRUL]RQWDO GLVWDQFH EHWZHHQ WZR SRLQWV� ,I WZR SRLQWV DUH GLDJRQDO WR HDFK

RWKHU� D KRUL]RQWDO GLPHQVLRQ OLQH VWLOO PHDVXUHV WKH KRUL]RQWDO GLVWDQFH

EHWZHHQ WKH SRLQWV�
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7KH 9HUWLFDO EXWWRQ OHWV \RX GUDZ GLPHQVLRQ OLQHV WKDW PHDVXUH WKH

YHUWLFDO GLVWDQFH EHWZHHQ WZR SRLQWV� ,I WZR SRLQWV DUH GLDJRQDO WR HDFK

RWKHU� D YHUWLFDO GLPHQVLRQ OLQH VWLOO PHDVXUHV WKH YHUWLFDO GLVWDQFH EHWZHHQ

WKH SRLQWV�

To draw a dimension line

1 &OLFN WKH 'LPHQVLRQ WRRO LQ WKH WRROER[ RU CTRL+0 �]HUR��

2 &OLFN WKH $OLJQHG� +RUL]RQWDO� 9HUWLFDO� $QJXODU� RU 5DGLDO EXWWRQ LQ WKH

ULEERQ�

3 0RYH WKH SRLQWHU WR WKH VWDUWLQJ SRLQW RI WKH REMHFW \RX ZDQW WR

PHDVXUH� DQG SUHVV DQG KROG WKH OHIW PRXVH EXWWRQ� 8VH G\QDPLF VQDS

SRLQWV WR OLQN WR DQ REMHFW�

4 'UDJ WKH SRLQWHU WR WKH HQGSRLQW RI WKH REMHFW \RX ZDQW WR PHDVXUH

DQG UHOHDVH WKH PRXVH EXWWRQ� <RX FDQ XVH CTRL WR FRQVWUDLQ WKH

DQJOH WR LQFUHPHQWV RI �� GHJUHHV� $ GLPHQVLRQ OLQH DSSHDUV EHWZHHQ

WKH WZR SRLQWV� 7KH EOXH KDQGOH DW WKH FXUVRU ORFDWLRQ LQGLFDWHV WKH

SRVLWLRQ RI WKH GLPHQVLRQ WH[W�

5 0RYH WKH PRXVH LQ WKH DSSURSULDWH GLUHFWLRQ WR RIIVHW WKH GLPHQVLRQ

OLQH DQG WR DGMXVW WKH ORFDWLRQ RI WKH GLPHQVLRQ XQLWV� <RX FDQ XVH

SHIFT WR IRUFH WKH DOLJQPHQW SRLQW WR WKH FHQWHU�

6 $IWHU SRVLWLRQLQJ WKH GLPHQVLRQ OLQH DQG WH[W� FOLFN WKH OHIW PRXVH

EXWWRQ WR ILQLVK GUDZLQJ WKH GLPHQVLRQ OLQH�

7LS

,I \RX PDNH D PLVWDNH ZKLOH GUDZLQJ D GLPHQVLRQ OLQH� \RX FDQ SUHVV ESC
WR VWDUW RYHU�
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Using Constraint Buttons

7KH &HQWHU 7H[W EXWWRQ IRUFHV WKH GLPHQVLRQ XQLWV WR EH FHQWHUHG

EHWZHHQ WKH GLPHQVLRQ HQGSRLQWV� 'HVHOHFW WKH &HQWHU 7H[W EXWWRQ WR

SRVLWLRQ WKH GLPHQVLRQ XQLWV PDQXDOO\�

1RWH� 3UHVV SHIFT ZKLOH GUDZLQJ D GLPHQVLRQ OLQH WR IRUFH WKH RSSRVLWH VWDWH

RI WKH &HQWHU 7H[W EXWWRQ� )RU H[DPSOH� SUHVVLQJ SHIFT ZKHQ WKH &HQWHU

7H[W EXWWRQ LV GHVHOHFWHG WXUQV RQ WKH WH[W FHQWHULQJ FRQVWUDLQW �ZKLOH SHIFT

LV SUHVVHG��

7KH $QJOH &RQVWUDLQW EXWWRQ IRUFHV GLPHQVLRQ OLQHV WR GUDZ RQO\ LQ ���

GHJUHH LQFUHPHQWV�

1RWH

3UHVV CTRL ZKLOH GUDZLQJ D GLPHQVLRQ OLQH WR IRUFH WKH RSSRVLWH VWDWH RI
WKH $QJOH &RQVWUDLQW EXWWRQ� )RU H[DPSOH� SUHVVLQJ CTRL ZKLOH WKH $QJOH
&RQVWUDLQW EXWWRQ LV VHOHFWHG WXUQV RII WKH FRQVWUDLQW �ZKLOH CTRL LV
SUHVVHG��

Setting Displayed Precision

7KH 'LVSOD\HG 3UHFLVLRQ OLVW ER[ VKRZV WKH FXUUHQW GHFLPDO SUHFLVLRQ RI WKH

GLPHQVLRQ XQLWV� <RX FDQ FKDQJH WKH QXPEHU RI GHFLPDO SODFHV VKRZQ E\

FOLFNLQJ WKH GRZQ DUURZ QH[W WR WKH ER[ DQG FKRRVLQJ DQRWKHU VHWWLQJ�

Editing Dimension Lines

Reshaping Dimension Lines

$IWHU GUDZLQJ D GLPHQVLRQ OLQH� \RX FDQ DGMXVW WKH SRVLWLRQ RI LWV HQGSRLQWV

DQG GLPHQVLRQ XQLWV ZLWK WKH 5HVKDSH EXWWRQ �
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To resha pe a dimension line

1 &OLFN WKH 'LPHQVLRQ WRRO LQ WKH WRROER[�

2 6HOHFW WKH GLPHQVLRQ OLQH \RX ZDQW WR UHVKDSH E\ SRLQWLQJ DQG FOLFNLQJ

WKH OHIW PRXVH EXWWRQ�

3 &OLFN WKH 5HVKDSH EXWWRQ LQ WKH ULEERQ� 6ROLG EOXH KDQGOHV DSSHDU

DW WKH OLQHjV HQGSRLQWV DQG XQLWV ORFDWLRQ�

4 'UDJ WKH KDQGOHV WKDW \RX ZDQW WR FKDQJH WR WKHLU QHZ SRVLWLRQV� <RX

FDQ XVH SHIFT WR IRUFH WKH DOLJQPHQW SRLQW WR WKH FHQWHU�

5 3UHVV ESC RU GRXEOH FOLFN WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK�

7LS

7R HQWHU WKH GLPHQVLRQ UHVKDSH PRGH TXLFNO\� GRXEOH FOLFN D GLPHQVLRQ
OLQH ZLWK WKH VHOHFW SRLQWHU�

Setting Line Ends

7KH /LQH (QGV EXWWRQ OHWV \RX FRQWURO WKH DSSHDUDQFH RI WKH GLPHQVLRQ

OLQH� 7KH RSWLRQV DYDLODEOH LQFOXGH WKH IROORZLQJ�

v 7KH W\SH RI OLQH HQG PDUNHU� 7KH SUHGHILQHG W\SHV LQFOXGH

DUURZKHDGV� EDUV� VTXDUHV� FLUFOHV� DQG WULDQJOHV� <RX FDQ DOVR GHILQH

FXVWRP OLQH HQGV�

v :KHWKHU WKH VDPH RU GLIIHUHQW PDUNHUV DUH XVHG DW HDFK HQG RI WKH

OLQH�

v 7KH VL]H� SODFHPHQW� DQG DQJOH RI WKH OLQH HQG PDUNHUV�

v 7KH WKLFNQHVV RI WKH OLQH�

v 7KH VW\OH RI WKH OLQH �VROLG� GRWWHG� RU GDVKHG��

To choose a line end

1 &OLFN WKH 'LPHQVLRQ WRRO LQ WKH WRROER[�
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2 6HOHFW WKH GLPHQVLRQ OLQH \RX ZDQW WR PRGLI\�

3 &OLFN WKH /LQH (QGV EXWWRQ LQ WKH ULEERQ� 7KH /LQH (QGV PHQX

RSHQV�

4 &OLFN WKH GHVLUHG OLQH HQG LQ WKH PHQX� 7R FKRRVH RWKHU OLQH HQGV DQG

RWKHU OLQH RSWLRQV� FOLFN (QGV WR RSHQ WKH /LQH (QGV GLDORJ ER[�

7LSV

7KH /LQH (QGV PHQX GLVSOD\V WKH PRVW UHFHQWO\ VHOHFWHG OLQH HQGV�

Transforming Dimension Lines

'LPHQVLRQ OLQHV DUH G\QDPLF REMHFWV� 7KLV SRZHUIXO IHDWXUH PHDQV WKDW QR

PDWWHU KRZ \RX WUDQVIRUP �PRYH� URWDWH� VNHZ� RU VFDOH� D GLPHQVLRQ OLQH�

'HVLJQHU ZLOO DFFXUDWHO\ FDOFXODWH LWV OHQJWK�

7UDQVIRUPLQJ D GLPHQVLRQ OLQH GRHV QRW FKDQJH WKH OLQHjV DOLJQHG� KRUL]RQWDO�

RU YHUWLFDO GHILQLWLRQ� )RU H[DPSOH� D KRUL]RQWDO GLPHQVLRQ OLQH FRQWLQXHV WR

PHDVXUH WKH KRUL]RQWDO GLVWDQFH EHWZHHQ LWV HQGSRLQWV� HYHQ ZKHQ URWDWHG

LQWR D YHUWLFDO SRVLWLRQ �RI FRXUVH� WKH KRUL]RQWDO GLVWDQFH EHWZHHQ WZR

YHUWLFDOO\ DOLJQHG SRLQWV LV ]HUR��

To rotate a drawin g with dimension lines

1 6HOHFW WKH REMHFWV WKDW \RX ZDQW WR URWDWH� LQFOXGLQJ WKH GLPHQVLRQ

OLQHV�

2 &OLFN WKH JURXSHG REMHFWV D VHFRQG WLPH WR GLVSOD\ WKH URWDWLRQ

KDQGOHV�

3 'UDJ WKH SLYRW SRLQW WR D QHZ ORFDWLRQ� LI \RX ZDQW�

4 'UDJ WKH KDQGOHV WR URWDWH WKH GUDZLQJ� 7R SUHYLHZ WKH FXUUHQW

ORFDWLRQ RI WKH URWDWHG GUDZLQJ� SDXVH EULHIO\ ZKLOH VWLOO KROGLQJ GRZQ

WKH OHIW PRXVH EXWWRQ�
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Setting Dimension Text Options

7KH 6KRZ 'LPHQVLRQ 7H[W RSWLRQ LQ WKH *HQHUDO SDQHO RI WKH 'LPHQVLRQV

GLDORJ ER[ GHWHUPLQHV ZKHWKHU GLPHQVLRQ XQLWV DUH VKRZQ RU KLGGHQ� 6HOHFW

WKLV RSWLRQ WR VKRZ WKH XQLWV� 'HVHOHFW WKLV RSWLRQ WR KLGH WKH XQLWV�

7KH FXUUHQWO\ VHOHFWHG XQLWV VHWWLQJ DSSHDUV LQ WKH 8QLWV EXWWRQ� &OLFN WKLV

EXWWRQ WR FKDQJH WKLV VHWWLQJ�

7KH 3UHFLVLRQ OLVW ER[ VKRZV WKH FXUUHQW GHFLPDO SUHFLVLRQ RI WKH GLPHQVLRQ

XQLWV� 7R FKDQJH WKLV VHWWLQJ� FOLFN WKH GRZQ DUURZ QH[W WR WKH ER[�

7KH 3UHIL[ DQG 6XIIL[ WH[W ER[HV OHW \RX HQWHU WH[W WR DSSHDU EHIRUH DQG

DIWHU WKH XQLWV RI D GLPHQVLRQ OLQH�

7KH 6KRZ ([WHQVLRQ /LQHV RSWLRQ GHWHUPLQHV ZKHWKHU H[WHQVLRQ OLQHV DUH

VKRZQ RU KLGGHQ� 6HOHFW WKLV RSWLRQ WR VKRZ H[WHQVLRQ OLQHV� 'HVHOHFW WKLV

RSWLRQ WR KLGH H[WHQVLRQ OLQHV�

7KH *DS ER[ VSHFLILHV WKH DPRXQW RI VSDFH EHWZHHQ WKH SRLQWV PHDVXUHG E\

D GLPHQVLRQ OLQH DQG WKH VWDUW RI LWV H[WHQVLRQ OLQHV�

7KH ([WHQVLRQ ER[ VSHFLILHV KRZ IDU H[WHQVLRQ OLQHV SURWUXGH EH\RQG D

GLPHQVLRQ OLQH�

7KH 8VH 2XWVLGH $UURZV RSWLRQ GHWHUPLQHV ZKHWKHU GLPHQVLRQ OLQHV VKRZ

DUURZV SRLQWLQJ RXWZDUGV RU LQZDUGV�

7KH 2XWVLGH $UURZ /HQJWK ER[ VSHFLILHV WKH OHQJWK RI RXWVLGH DUURZV�

To add Prefix and Suffix text to a dimension line

1 &OLFN WKH 'LPHQVLRQ WRRO LQ WKH WRROER[�

2 6HOHFW WKH GLPHQVLRQ OLQH \RX ZDQW WR PRGLI\�

3 &OLFN WKH 'LPHQVLRQ 2SWLRQV EXWWRQ LQ WKH ULEERQ� 7KH

'LPHQVLRQV GLDORJ ER[ RSHQV�

4 &OLFN WKH *HQHUDO EXWWRQ WR GLVSOD\ WKH *HQHUDO SDQHO� LI QHFHVVDU\�

5 &OLFN WKH 3UHIL[ WH[W ER[ DQG HQWHU WKH WH[W \RX ZDQW WR DSSHDU EHIRUH

WKH GLPHQVLRQ XQLWV� RU
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6 &OLFN WKH 6XIIL[ WH[W ER[ DQG HQWHU WKH WH[W \RX ZDQW WR DSSHDU DIWHU

WKH GLPHQVLRQ XQLWV�

7 &OLFN $SSO\ WR DGG WKH WH[W WR WKH GLPHQVLRQ XQLWV�

7LS

7R VHW RSWLRQ GHIDXOWV VR WKDW WKH\ DSSO\ WR DOO VXEVHTXHQW GLPHQVLRQ OLQHV
WKDW \RX GUDZ� GHVHOHFW DOO GLPHQVLRQ OLQHV� FOLFN WKH 'LPHQVLRQ 2SWLRQV
EXWWRQ� DQG WKHQ VHOHFW WKH GLPHQVLRQ RSWLRQV WKDW \RX ZDQW�

Text Orientation Options

7KH 7H[W 2ULHQWDWLRQ SDQHO RI WKH 'LPHQVLRQV GLDORJ ER[ VHWV WKH RULHQWDWLRQ

RI WKH GLPHQVLRQ XQLWV LQ UHODWLRQ WR WKH GLPHQVLRQ OLQH�

6HOHFW $OLJQHG )DFH 8S WR IRUFH GLPHQVLRQ XQLWV WR GLVSOD\ VR WKDW WKH EDVH RI

WKH WH[W LV RULHQWHG DORQJ WKH GLPHQVLRQ OLQH� EXW WKH WH[W LV DOZD\V XSULJKW LQ

UHODWLRQ WR WKH OLQH�

6HOHFW 7RZDUGV 2EMHFW WR IRUFH GLPHQVLRQ XQLWV WR GLVSOD\ VR WKDW WKH EDVH RI

WKH WH[W LV RULHQWHG DORQJ WKH GLPHQVLRQ OLQH� )RU D KRUL]RQWDO GLPHQVLRQ OLQH

LQ ZKLFK WKH H[WHQVLRQV DUH EHORZ WKH OLQH� WKH GLPHQVLRQ XQLWV DUH GLVSOD\HG

XSVLGH GRZQ�

6HOHFW +RUL]RQWDO WR IRUFH WKH GLPHQVLRQ XQLWV WR GLVSOD\ KRUL]RQWDOO\� HYHQ

IRU YHUWLFDO DQG DOLJQHG GLPHQVLRQ OLQHV�

6HOHFW +RU]��9HUW� WR IRUFH WKH GLPHQVLRQ XQLWV WR GLVSOD\ KRUL]RQWDOO\ IRU

KRUL]RQWDO DQG DOLJQHG OLQHV� DQG YHUWLFDOO\ IRU YHUWLFDO OLQHV�

6HOHFW &XVWRP $QJOH WR GLVSOD\ GLPHQVLRQ XQLWV DW D VSHFLILF DQJOH� 7R VHW WKH

FXVWRP DQJOH� \RX FDQ HLWKHU GUDJ WKH UHG QHHGOH LQ WKH GLDO FRQWURO RU FOLFN LQ

WKH $QJOH WH[W ER[ DQG HQWHU D VSHFLILF YDOXH�

To set a custom an gle

1 &OLFN WKH 'LPHQVLRQ WRRO LQ WKH WRROER[�

2 6HOHFW WKH GLPHQVLRQ OLQH \RX ZDQW WR PRGLI\�
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3 &OLFN WKH 'LPHQVLRQ 2SWLRQV EXWWRQ LQ WKH ULEERQ� 7KH

'LPHQVLRQV GLDORJ ER[ RSHQV�

4 &OLFN WKH 7H[W 2ULHQWDWLRQ EXWWRQ WR GLVSOD\ WKH 7H[W 2ULHQWDWLRQ

SDQHO� LI QHFHVVDU\�

5 7\SH D QXPEHU LQ WKH $QJOH WH[W ER[ RU GUDJ WKH UHG QHHGOH LQ WKH GLDO

FRQWURO WR VSHFLI\ D FXVWRP DQJOH�

6 &OLFN WKH &XVWRP $QJOH RSWLRQ WR VHOHFW LW�

7 &OLFN $SSO\ WR GLVSOD\ WKH GLPHQVLRQ DW WKH FXVWRP DQJOH�

7LS

7R VHW RSWLRQ GHIDXOWV VR WKDW WKH\ DSSO\ WR DOO VXEVHTXHQW GLPHQVLRQ OLQHV
WKDW \RX GUDZ� GHVHOHFW DOO GLPHQVLRQ OLQHV� FOLFN WKH 'LPHQVLRQ 2SWLRQV
EXWWRQ� DQG WKHQ VHOHFW WKH GLPHQVLRQ RSWLRQV WKDW \RX ZDQW�

Text Position Options

7KH 7H[W 3RVLWLRQ SDQHO RI WKH 'LPHQVLRQV GLDORJ ER[ VHWV WKH SRVLWLRQ RI WKH

GLPHQVLRQ XQLWV LQ UHODWLRQ WR WKH GLPHQVLRQ OLQH�

7KH +RUL]RQWDO 7H[W 3RVLWLRQ RSWLRQV GHWHUPLQH ZKHWKHU WKH XQLWV GLVSOD\ RQ

WKH WH[W SRLQW RI WKH GLPHQVLRQ OLQH RU DUH DOLJQHG OHIW� FHQWHU� RU ULJKW�

7KH 9HUWLFDO 7H[W 3RVLWLRQ RSWLRQV GHWHUPLQH ZKHWKHU WKH XQLWV GLVSOD\

DERYH� RQ� RU EHORZ WKH GLPHQVLRQ OLQH�

To display units above a dimension line

1 &OLFN WKH 'LPHQVLRQ WRRO LQ WKH WRROER[�

2 6HOHFW WKH GLPHQVLRQ OLQH \RX ZDQW WR PRGLI\�

3 &OLFN WKH 'LPHQVLRQ 2SWLRQV EXWWRQ LQ WKH ULEERQ� 7KH

'LPHQVLRQV GLDORJ ER[ RSHQV�

4 &OLFN WKH 7H[W 3RVLWLRQ EXWWRQ WR GLVSOD\ WKH 7H[W 3RVLWLRQ SDQHO� LI

QHFHVVDU\�
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5 &OLFN $ERYH /LQH �XQGHU 9HUW 7H[W 3RVLWLRQ� WR VHOHFW WKLV RSWLRQ�

6 &OLFN $SSO\ WR UHSRVLWLRQ WKH GLPHQVLRQ XQLWV�

7LS

7R VHW RSWLRQ GHIDXOWV VR WKDW WKH\ DSSO\ WR DOO VXEVHTXHQW GLPHQVLRQ OLQHV
WKDW \RX GUDZ� GHVHOHFW DOO GLPHQVLRQ OLQHV� FOLFN WKH 'LPHQVLRQ 2SWLRQV
EXWWRQ� DQG WKHQ VHOHFW WKH GLPHQVLRQ RSWLRQV WKDW \RX ZDQW�
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Using Color
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Display

,I WKH XSGDWH RI WKH GLVSOD\ LQ WKH &RORU 3LFNHU GLDORJ ER[ LV WRR VORZ RQ \RXU

FRPSXWHU� \RX FDQ FKDQJH WKH UHVROXWLRQ WR VSHHG LW XS� 7KH FKRLFHV DUH

)LQH� $YHUDJH� DQG &RDUVH� &RDUVH� ZKLFK GLVSOD\V IHZHU FRORUV� LV WKH IDVWHVW�

)LQH� ZKLFK GLVSOD\V PRUH FRORUV� LV WKH VORZHVW�

Setting Color Options

&OLFN 2SWLRQV WR RSHQ D PHQX WKDW OHWV \RX FKDQJH WKH UHVROXWLRQ RI WKH

GLDORJ ER[ GLVSOD\� FKDQJH WKH FRORU JULG� RU FKDQJH WKH ZD\ &0<. FRORUV DUH

DXWRPDWLFDOO\ �QRUPDOL]HG� IRU XQGHUFRORU UHPRYDO� ,I 6SRW &RORU LV VHOHFWHG�

\RX FDQ FKRRVH WR VKRZ RU KLGH WKH FRORU QDPHV�

Using Dithered Colors

0RQLWRUV DQG SULQWHUV XVH D SURFHVV FDOOHG GLWKHULQJ WR FRPSHQVDWH IRU WKH

LQDELOLW\ WR GLVSOD\ VRPH FRORUV� 'LWKHULQJ VLPXODWHV FRORU E\ SODFLQJ GRWV RI

GLIIHUHQW FRORUV QH[W WR HDFK RWKHU LQ D SDWWHUQ� 7KXV� GLWKHULQJ OHWV \RX

GLVSOD\ RQ D VFUHHQ� DQG SULQW RQ VRPH SULQWHUV� FRORUV WKDW DUH DFWXDOO\ QRW

DYDLODEOH�

,I D FRORU LV VXSSRUWHG RQ \RXU PRQLWRU DQG JUDSKLFV DGDSWHU� LW LV GLVSOD\HG� ,I

D FRORU LV QRW VXSSRUWHG� LW LV FKDQJHG WR WKH FORVHVW FRORU DYDLODEOH RQ WKH

JUDSKLFV DGDSWHU� 7KH FRORU LV FKDQJHG WR WKH FORVHVW FRORU RU GLWKHUHG FRORU

DYDLODEOH ZKHQ SULQWHG RU ZKHQ GLVSOD\HG RQ DQRWKHU GHYLFH�
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Black Component

7KH . YDOXH �WUXH EODFN� LV DGGHG WR FRPSHQVDWH IRU LQN LPSXULWLHV LQ SURFHVV

FRORU SULQWLQJ� 7KH SHUFHQWDJH RI EODFN LQ D FRORU LV WKHRUHWLFDOO\ HTXLYDOHQW WR

WKH VDPH SHUFHQWDJH RI F\DQ� PDJHQWD� DQG \HOORZ�

%\ GHIDXOW� WKH &RORU 3LFNHU GLVSOD\V WKH EODFN FRPSRQHQW VOLGHU WR OHW \RX

PDQXDOO\ DGMXVW WKH SHUFHQWDJH RI EODFN LQ D FRORU� <RX DOVR FDQ FKRRVH WR OHW

'HVLJQHU QRUPDOL]H WKH &0<. SHUFHQWDJHV DXWRPDWLFDOO\� 7KDW LV� WKH

SHUFHQWDJHV IRU &� 0� DQG < DUH UHGXFHG RU LQFUHDVHG VR WKDW WKH SHUFHQWDJH

IRU EODFN LV DV KLJK DV SRVVLEOH� 7KLV WHFKQLTXH LV NQRZQ DV XQGHUFRORU UHPRYDO

�8&5�� ,I \RX DGG D FRORU DQG WKHQ UHRSHQ WKH GLDORJ ER[� WKH SHUFHQWDJHV

PD\ GLIIHU HYHQ WKRXJK WKH FRORU LV WKH VDPH�

Choosing Colors

Using the Color Picker

'HVLJQHU RIIHUV VWDWH�RI�WKH�DUW FRORU PL[LQJ FDSDELOLWLHV DQG WKH IOH[LELOLW\ WR

OHW \RX HDVLO\ FKRRVH DQG XVH DQ\ FRORU IURP WKH IXOO VSHFWUXP�

<RX FDQ XVH D FRORU PRGHO WR FKRRVH DQ\ FRORU� <RX FDQ XVH ZKLFKHYHU FRORU

PRGHO \RX SUHIHU �+/6� 5*%� RU &0<.� WR FKRRVH FRORUV� 7KH &RORU 3LFNHU

LV D WRRO WKDW OHWV \RX FKRRVH D FRORU IURP WKH IXOO UDQJH RI SRVVLEOH FRORUV DQG

DGG LW WR WKH &RORU 3DOHWWH�

<RX FDQ FOLFN RQH RI WKH ILUVW WKUHH EXWWRQV DW WKH WRS RI WKH GLDORJ ER[ WR

VHOHFW D FRORU PRGHO �5*%� &0<.� RU +/6�� �7KH IRXUWK EXWWRQ LV IRU VSRW

FRORUV XVLQJ D FRORU PDWFKLQJ V\VWHP VXFK DV 3$1721(��

1XPHULF YDOXHV IRU WKH FXUUHQW FRORU DSSHDU DORQJ WKH ULJKW IRU HDFK FRORU

PRGHO� 7KH YDOXHV VKRZ WKH DPRXQW RI FRORU XVHG WR FUHDWH WKH GLVSOD\HG

FRORU� )RU H[DPSOH� ��� 5HG� ��� *UHHQ� DQG ��� %OXH FUHDWH SLQN� 7KH VDPH

SLQN FDQ EH FUHDWHG ZLWK �� &\DQ� ��� 0DJHQWD� ��� <HOORZ� DQG �� %ODFN�

<RX FDQ XVH ZKLFKHYHU FRORU PRGHO \RX SUHIHU WR FKRRVH FRORUV�

7KH QXPHULF YDOXHV IRU WKH VHOHFWHG PRGHO DSSHDU LQ EODFN� 7KH YDOXHV IRU

WKH PRGHOV QRW VHOHFWHG DUH JUD\� $V \RX PDNH FKDQJHV WR WKH YDOXHV RI WKH

VHOHFWHG FRORU PRGHO� DOO RI WKH YDOXHV UHIOHFW FRUUHVSRQGLQJ FKDQJHV�
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7KH XQGHUO\LQJ PRGHO WKDW UHSUHVHQWV WKH IXOO UDQJH RI FRORUV LV OLNH D WKUHH�

GLPHQVLRQDO FXEH� 7KH FRORU UHILQHU ER[ VKRZV WZR RI WKHVH GLPHQVLRQV�

ZKLOH WKH VOLGHU EHORZ WKH FRORU UHILQHU ER[ VKRZV WKH WKLUG GLPHQVLRQ�

7KH OLVW ER[ JLYHV \RX FKRLFHV IRU WZR RI WKH FRPSRQHQWV RI WKH VHOHFWHG

FRORU PRGHO� 7KHVH WZR FRPSRQHQWV DUH LOOXVWUDWHG DV ZLGWK DQG KHLJKW LQ

WKH FRORU UHILQHU ER[� 7KH WKLUG FRPSRQHQW RI WKH FRORU PRGHO �GHSWK LQ WKH

FXELFDO FRORU PRGHO� LV FRQWUROOHG E\ WKH KRUL]RQWDO VOLGHU�

)RU H[DPSOH� LI \RX VHOHFW WKH +/6 FRORU PRGHO DQG VHOHFW +XH�/LJKWQHVV LQ

WKH OLVW ER[� KXH LV ZLGWK �OHIW DQG ULJKW�� OLJKWQHVV LV KHLJKW �XS DQG GRZQ��

DQG VDWXUDWLRQ LV GHSWK �WKH VOLGHU��

7LS

,I \RX DUH QHZ WR FRORU PRGHOV� VWDUW ZLWK WKH +/6 PRGHO�

To open the Color Picker dialo g box

1 &OLFN 3DOHWWH 2SWLRQV LQ WKH FRORU SDOHWWH WLWOH EDU� $ PHQX RSHQV�

2 &OLFN $GG &RORU�

3 ,I WKH FXUUHQW SDOHWWH LV WKH PDVWHU SDOHWWH� WKH 3DOHWWH 1DPH GLDORJ

ER[ RSHQV�

4 (QWHU D QHZ QDPH IRU WKH FRS\� 7KH &RORU 3LFNHU GLDORJ ER[ RSHQV�

1RWH

<RX FDQQRW FKDQJH WKH PDVWHU SDOHWWH�

Choosing HLS Colors

&OLFN WKH +/6 WDE LQ WKH &RORU 3LFNHU GLDORJ ER[ WR XVH WKH +/6 �+XH�

/LJKWQHVV� 6DWXUDWLRQ� FRORU PRGHO�
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,I \RX VWDUW ZLWK EODFN �KLJKOLJKW EODFN LQ WKH SDOHWWH�� \RX FDQ FKRRVH JUD\

VFDOHV �VKDGHV RI JUD\� E\ OHDYLQJ WKH VDWXUDWLRQ DW ]HUR DQG FKDQJLQJ WKH

GHJUHH RI OLJKWQHVV�

7KH +XH YDOXHV IRU SULPDU\ FRORUV DUH UHG ���� \HOORZ ����� JUHHQ ������ F\DQ

������ EOXH ������ DQG PDJHQWD ������

7KH +XH YDOXHV UDQJH IURP � WR ��� GHJUHHV �HTXLYDOHQW WR VHWWLQJV RQ D

FRORU ZKHHO� ZKHUH � LV WKH VDPH DV ����� 7KH +XH VHWWLQJ VHOHFWV D VWDUWLQJ

FRORU YDOXH� 7KH /LJKWQHVV YDOXH DGGV D SHUFHQWDJH RI ZKLWH RU EODFN WR WKH

KXH DQG VKRZV WKH SHUFHQWDJH RI OLJKWQHVV LQ WKH VKDGH� ,QFUHDVLQJ OLJKWQHVV

DGGV ZKLWH� GHFUHDVLQJ OLJKWQHVV DGGV EODFN� 7KH 6DWXUDWLRQ YDOXH GHFUHDVHV

RU LQFUHDVHV WKH SHUFHQWDJH RI FRORU LQ D VHOHFWHG KXH� ,QFUHDVLQJ VDWXUDWLRQ

DGGV FRORU� GHFUHDVLQJ VDWXUDWLRQ DGGV JUD\�

7KH VWDQGDUG VHWWLQJ IRU D KXH LV ��� OLJKWQHVV DQG ���� VDWXUDWLRQ� ,I \RX

KLJKOLJKW SXUH UHG LQ WKH SDOHWWH� WKH +/6 YDOXHV GLVSOD\ +XH DW � GHJUHHV�

/LJKWQHVV DW ���� DQG 6DWXUDWLRQ DW �����

Choosing RGB Colors

<RX FDQ FOLFN WKH 5*% WDE LQ WKH &RORU 3LFNHU GLDORJ ER[ WR XVH WKH 5*%

�5HG� *UHHQ� %OXH� FRORU PRGHO�

7KH QXPHULF YDOXHV IRU 5� *� DQG % UHSUHVHQW DPRXQWV RI WKH DGGLWLYH

SULPDU\ FRORUV UHG� JUHHQ� DQG EOXH� 7KH YDOXH IRU HDFK SULPDU\ FRORU FDQ

UDQJH IURP � WKURXJK ���� :KHQ WKHVH WKUHH FRORUV DUH FRPELQHG

�PD[LPXP YDOXHV RI HDFK�� WKH UHVXOW LV ZKLWH� :KHQ QRQH RI WKH FRORUV DUH

SUHVHQW �]HUR YDOXHV IRU HDFK�� WKH UHVXOW LV EODFN� 7KH 5*% PRGHO LV DQ

DGGLWLYH FRORU PRGHO EHFDXVH WKH WKUHH SULPDU\ FRORUV DUH FRPELQHG WR

SURGXFH SXUH ZKLWH�

Choosing CMYK Colors

&OLFN &0<. LQ WKH &RORU 3LFNHU GLDORJ ER[ WR XVH WKH &0<. �&\DQ�

0DJHQWD� <HOORZ� %ODFN� FRORU PRGHO�
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$V ZLWK WKH RWKHU FRORU PRGHOV� \RX FDQ FKRRVH D FRORU FRPELQDWLRQ IURP

WKH OLVW ER[ �&\DQ�0DJHQWD� &\DQ�<HOORZ� RU <HOORZ�0DJHQWD� WR XVH DV WKH

KHLJKW DQG ZLGWK RI WKH PRGHO DV LOOXVWUDWHG LQ WKH FRORU UHILQHU ER[� 7KH

WKLUG FRORU LV FRQWUROOHG E\ WKH VOLGHU GLUHFWO\ EHORZ WKH FRORU UHILQHU ER[�

7KH IRXUWK FRORU� EODFN� LV FRQWUROOHG E\ WKH ERWWRP VOLGHU�

7KH QXPHULF YDOXHV IRU &� 0� DQG < UHSUHVHQW SHUFHQWDJHV RI WKH VXEWUDFWLYH

SULPDU\ FRORUV F\DQ �OLJKW EOXH�� PDJHQWD� DQG \HOORZ� ZKLFK DUH FRPSOHPHQWV

RI UHG� JUHHQ� DQG EOXH� :KHQ WKHVH WKUHH FRORUV DUH FRPELQHG ����� RI

HDFK�� WKH WKHRUHWLFDO UHVXOW LV EODFN� EXW LPSXULWLHV LQ SULQWLQJ LQNV UHVXOW LQ D

PXGG\ EURZQ� :KHQ QRQH RI WKH FRORUV DUH SUHVHQW ��� RI HDFK�� WKH UHVXOW

LV ZKLWH� 7KH &0<. PRGHO LV D VXEWUDFWLYH FRORU PRGHO EHFDXVH WKH WKUHH

SULPDU\ FRORUV DUH UHPRYHG WR SURGXFH EODFN�

To chan ge the wa y Designer normalizes CMYK percenta ges

1 &OLFN WKH 8QGHUFRORU 5HPRYDO EXWWRQ LQ WKH &RORU 3LFNHU�&0<.

GLDORJ ER[�

2 &OLFN 0DQXDO LI \RX ZDQW WR SUHYHQW 'HVLJQHU IURP QRUPDOL]LQJ WKH

&0<. SHUFHQWDJHV�

RU

&OLFN D SHUFHQWDJH LI \RX ZDQW WR DOORZ 'HVLJQHU WR QRUPDOL]H WKH

&0<. YDOXHV� �)RU H[DPSOH� FOLFN ���� IRU FRPSOHWH QRUPDOL]DWLRQ RU

��� IRU KDOI QRUPDOL]DWLRQ��

7LS

,I \RX FOLFN D SHUFHQWDJH LQ VWHS � DERYH� WKH EODFN FRPSRQHQW VOLGHU DW WKH
ERWWRP RI WKH GLDORJ ER[ GLVDSSHDUV�

Naming a Color

7KH FRORU VZDWFK DW WKH WRS ULJKW RI WKH GLDORJ ER[ VKRZV WKH QHZ FRORU DV

\RX PL[ LW� <RX FDQ DVVLJQ D QDPH WR WKLV FRORU VZDWFK� 1DPHV FDQ LQFOXGH

QXPEHUV DQG VSDFHV�
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To name a color

1 &OLFN WKH 1HZ &RORU FRORU VZDWFK LQ WKH &RORU 3LFNHU GLDORJ ER[�

2 7\SH D QDPH�

3 3UHVV TAB RU FOLFN DQRWKHU ILHOG� 7KH QDPH LV GLVSOD\HG RQ WKH FRORU

VZDWFK�

7LS

:KHQ \RX FOLFN $GG WR DGG WKH FRORU WR WKH FXUUHQW SDOHWWH� 'HVLJQHU
VWRUHV WKH DVVLJQHG QDPH ZLWK WKH FRORU�

Using a Color Model

'HVLJQHU� EHJLQQLQJ ZLWK YHUVLRQ ���� VWRUHV FRORUV LQ WKH FRORU PRGHO �+/6�

&0<.� RU 5*%� LQ ZKLFK WKH\ ZHUH RULJLQDOO\ FUHDWHG� ZKHUHDV HDUOLHU

YHUVLRQV RI 'HVLJQHU RQO\ VWRUH FRORUV LQ WKH 5*% IRUPDW� 7KLV FDSDELOLW\ LV

HVSHFLDOO\ LPSRUWDQW IRU JUDSKLF GHVLJQHUV� ZKR W\SLFDOO\ FUHDWH FRORUV ZLWK

WKH &0<. FRORU PRGHO� EHFDXVH LW HQVXUHV SUHFLVH PDWFKLQJ EHWZHHQ FRORU

GHILQLWLRQ DQG VWRUDJH�

<RX FDQ XVH D FRORU PRGHO WR FKRRVH DQ\ FRORU� <RX FDQ XVH ZKLFKHYHU FRORU

PRGHO \RX SUHIHU �+/6� 5*%� RU &0<.� WR FKRRVH FRORUV� 7KH &RORU 3LFNHU

LV D WRRO WKDW OHWV \RX FKRRVH D FRORU IURP WKH IXOO UDQJH RI SRVVLEOH FRORUV DQG

DGG LW WR WKH &RORU 3DOHWWH�

7LS

,I \RX DUH QHZ WR FRORU PRGHOV� VWDUW ZLWK WKH +/6 PRGHO�

To choose colors with a color model

1 &OLFN 3DOHWWH 2SWLRQV LQ WKH &RORU 3DOHWWH WLWOH EDU�

2 &OLFN $GG &RORU�
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3 ,I WKH FXUUHQW SDOHWWH LV WKH PDVWHU SDOHWWH� \RX DUH DVNHG LI \RX ZDQW

WR PDNH D FRS\ RI WKH PDVWHU SDOHWWH� &OLFN <HV DQG HQWHU D QHZ QDPH

IRU WKH FRS\� 7KH &RORU 3LFNHU GLDORJ ER[ RSHQV�

4 &OLFN D FRORU PRGHO WDE�

5 &OLFN WKH GRZQ DUURZ DW WKH ULJKW RI WKH OLVW ER[ WR FKRRVH WKH ILUVW

WZR GLPHQVLRQV IRU WKH FRORU UHILQHU ER[ �IRU H[DPSOH� +XH�/LJKWQHVV��

6 (QWHU WKH GHVLUHG YDOXH LQ WKH FXUUHQW FRORU PRGHOjV VFUROO ER[HV�

7 &RQWLQXH WR DGMXVW WKH VHWWLQJV LQ WKH VHOHFWHG FRORU PRGHO XQWLO \RX

KDYH PL[HG WKH GHVLUHG FRORU� <RX FDQ DOVR SUHVV DQG KROG WKH PRXVH

EXWWRQ� DQG GUDJ WKH FRORU UHILQHU FXUVRU DQG WKH VOLGHU

8 &OLFN $GG WR DGG WKH QHZ FRORU WR WKH FXUUHQW SDOHWWH�

9 5HSHDW VWHSV � WKURXJK � WR DGG PRUH FRORUV WR WKH SDOHWWH�

Converting Color Model Values

'HVLJQHU VWRUHV D FRORU ZLWK WKH QXPHULF YDOXHV LQ WKH FRORU PRGHO LQ ZKLFK

LW ZDV FUHDWHG� :KHQ \RX GLVSOD\ WKH QDPHV RI FRORUV LQ WKH FXUUHQW &RORU

3DOHWWH� WKH FRORU PRGHO DQG FRUUHVSRQGLQJ YDOXHV DUH GLVSOD\HG ZLWK D

VDPSOH VZDWFK RI WKH FRORU DQG D QDPH� LI DQ\�

)RU H[DPSOH� \RX FDQ DGG D FRORU WR D SDOHWWH XVLQJ WKH &RORU 3LFNHU�

VSHFLI\LQJ 5*% YDOXHV RI �� ���� DQG ���� 7KHQ \RX FDQ FRQYHUW WKH FRORU WR

&0<. YDOXHV ����� ��� �� DQG ���

To convert values to another color model

1 &OLFN 3DOHWWH 2SWLRQV LQ WKH &RORU 3DOHWWH WLWOH EDU�

2 &OLFN 3DOHWWH 0DQDJHU� 7KH 3DOHWWH 0DQDJHU GLDORJ ER[ RSHQV�

3 &OLFN WKH FRORU \RX ZDQW WR FRQYHUW DQG FOLFN 0RGHO� $ PHQX RSHQV

ZLWK D FKHFN PDUN E\ WKH QDPH RI WKH FRORUjV FXUUHQW PRGHO�

4 &OLFN WKH FRORU PRGHO WR ZKLFK \RX ZDQW WR FRQYHUW�

5 &OLFN 2.� 7KH VHOHFWHG FRORU LV VWRUHG ZLWK WKH QHZ FRORU PRGHO�
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Mixing Your Own Color

,I \RX QHHG D VLPSOH PHWKRG WR FUHDWH D FRORU DQG \RX GR QRW QHHG WR VDYH

WKH FRORU LQ D SDOHWWH IRU ODWHU XVH� \RX FDQ XVH WKH )LOO�6ROLG GLDORJ ER[ WR

FUHDWH LW� 7KLV PHWKRG ZRUNV DV D WHPSRUDU\ FRORU SDOHWWH WR OHW \RX VHOHFW

WZR WR IRXU FRORUV DQG PL[ WKHP DV D SDLQWHU ZRXOG RQ D SDOHWWH�

,I \RX SODQ WR UHXVH WKH FRORU ODWHU RU \RX QHHG WR XVH D FRORU PRGHO �+/6�

&0<.� RU 5*%�� \RX PD\ ZDQW WR XVH WKH &RORU 3LFNHU GLDORJ ER[ DQG DGG

WKH FRORU WR WKH &RORU 3DOHWWH�

To mix colors usin g the Fill-Solid dialo g box

1 2Q WKH )RUPDW PHQX� VHOHFW ,QWHULRU )LOO DQG WKHQ VHOHFW 6ROLG IURP WKH

VXEPHQX�

RU

2Q WKH )RUPDW PHQX� VHOHFW /LQH )LOO DQG WKHQ VHOHFW 6ROLG IURP WKH

VXEPHQX�

2 &OLFN WKH &RORU 0L[HU EXWWRQ�

3 &OLFN D FRUQHU RI WKH PL[LQJ SDOHWWH� $ SXOO�GRZQ SDOHWWH RSHQV�

&KRRVH D FRORU IURP WKH SDOHWWH�

4 5HSHDW VWHSV � DQG � WR FKRRVH D FRORU IRU HDFK FRUQHU RI WKH PL[LQJ

SDOHWWH� 7KH FRORU WUDQVLWLRQV FKDQJH WR UHIOHFW WKH PL[ RI FRORUV�

5 6HOHFW RQH RU PRUH FRORU VTXDUHV LQ WKH PL[LQJ SDOHWWH WR FKRRVH WKH

GHVLUHG FRORU�V��

6 &OLFN $GG DQG &ORVH� 7KH &RORU 3LFNHU GLDORJ FORVHV DQG \RXU QHZ

FRORU�V� QRZ DSSHDU LQ WKH 2EMHFW )RUPDW GLDORJ SDOHWWH�

7 6HOHFW WKH LQWHULRU RU OLQH ILOO FRORU DQG FOLFN $SSO\�

Finding an Object's Color Values

,I \RX ZDQW WR NQRZ ZKDW FRORUV DUH DOUHDG\ XVHG LQ D GUDZLQJ� \RX FDQ VHOHFW

HDFK REMHFW DQG ILQG LWV FRORUV�
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To find the interior and line color of an ob ject

1 6HOHFW WKH REMHFW

2 2Q WKH )RUPDW PHQX� VHOHFW ,QWHULRU )LOO DQG WKHQ VHOHFW 6ROLG IURP WKH

VXEPHQX�

RU

3 2Q WKH )RUPDW PHQX� VHOHFW /LQH )LOO DQG WKHQ VHOHFW 6ROLG IURP WKH

VXEPHQX�

4 7KH 2EMHFW )RUPDW GLDORJ RSHQV� 7KH ILOO FRORU DQG FRORU YDOXHV GLVSOD\�

7LS

7KH VHW RI FRORU YDOXHV LV VWDWHG LQ WKH FRORU PRGHO RULJLQDOO\ XVHG WR FUHDWH
WKH FRORU� )RU H[DPSOH� WKH YDOXH IRU \HOORZ PLJKW EH HLWKHU 5*% ���� ����
�� RU &0<. �� �� ���� �� GHSHQGLQJ RQ ZKHWKHU WKH FRORU ZDV FUHDWHG LQ
WKH 5*% RU &0<. FRORU PRGHO�
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Using the Color Palette

7KH &RORU 3DOHWWH LV D WRROEDU FRQWDLQLQJ WKH FXUUHQW FRORUV \RX FDQ XVH LQ D

GUDZLQJ� ,W LV HVSHFLDOO\ FRQYHQLHQW ZKHQ \RX
UH ZRUNLQJ ZLWK ODUJH SDOHWWHV

RU QDPHG FRORUV�

<RX FDQ GRFN� PRYH� UHVL]H DQG UHVKDSH WKH &RORU 3DOHWWH WR NHHS LW KDQG\

EXW RXW RI \RXU ZD\� &RORUV LQ WKH FXUUHQW SDOHWWH DUH DOZD\V DYDLODEOH� QR

PDWWHU ZKLFK WRRO \RX VHOHFW RU ZKLFK ULEERQ \RX GLVSOD\�

Palettes Included with Designer

'HVLJQHU LQFOXGHV SUHGHILQHG FRORU SDOHWWHV SOXV WKH IOH[LELOLW\ WR GHVLJQ DQG

DVVHPEOH \RXU RZQ SDOHWWHV WKDW EHVW PDWFK KRZ \RX ZRUN�

$ GHIDXOW SDOHWWH� FDOOHG WKH PDVWHU SDOHWWH� LV DXWRPDWLFDOO\ LQVWDOOHG ZKHQ

\RX LQVWDOO 'HVLJQHU� 7R SURWHFW DJDLQVW DFFLGHQWDO FKDQJHV� WKH PDVWHU SDOHWWH

FDQQRW EH FKDQJHG� GHOHWHG� RU PHUJHG� +RZHYHU� \RX FDQ PDNH D FRS\ RI LW�

JLYH LW D QHZ QDPH� DQG WKHQ PDNH DGGLWLRQV� GHOHWLRQV� RU RWKHU FKDQJHV�

<RX VHOHFW WKH FXUUHQW SDOHWWH RQ WKH 2SWLRQV PHQX RQ WKH &RORU 3DOHWWH� ,I

WKH PDVWHU SDOHWWH LV WKH FXUUHQW SDOHWWH� DQG \RX DWWHPSW WR DGG D FRORU�

GHOHWH D FRORU� UHQDPH WKH PDVWHU SDOHWWH� RU UHQDPH D FRORU LQ WKH PDVWHU

SDOHWWH� D GLDORJ ER[ UHPLQGV \RX WKDW \RX PXVW VDYH D FRS\ RI WKH PDVWHU

SDOHWWH�

7KH 3DOHWWH 1DPH GLDORJ ER[ RSHQV� 7\SH D QHZ QDPH IRU WKH FRS\ RI WKH

PDVWHU SDOHWWH DQG SUHVV ENTER� <RX FDQ WKHQ PDNH FKDQJHV WR WKH QHZ

SDOHWWH� ZKRVH QDPH LV DGGHG WR WKH OLVW RI DYDLODEOH SDOHWWHV RQ WKH 3DOHWWH

2SWLRQV PHQX DQG WKH 3DOHWWH 0DQDJHU GLDORJ ER[�

'HVLJQHU OHWV \RX PL[ \RXU RZQ FRORUV DQG DGG WKHP WR DQ H[LVWLQJ SDOHWWH�

RU \RX FDQ FUHDWH D QHZ SDOHWWH WKDW LQFOXGHV RQO\ WKH FRORUV \RX ZDQW�

'HVLJQHU DOVR LQFOXGHV WKH 3$1721(Ù VSRW DQG SURFHVV FRORUV� ZKLFK DUH

DYDLODEOH RQ WKH 6SRW &RORU WDE RI WKH &RORU 3LFNHU GLDORJ ER[�

To open the Color Palette

` 2Q WKH 9LHZ PHQX� VHOHFW &RORU 3DOHWWH� 7KH &RORU 3DOHWWH RSHQV�
U s i n g  C o l o r  215



RU

&OLFN WKH &RORU 3DOHWWH EXWWRQ RQ WKH VWDQGDUG WRROEDU�
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Using Lines, Fills, and Patterns
Overview of the Style Tools

'HVLJQHU
V VW\OH WRROV JLYH \RX D YDULHW\ RI ZD\V WR FKDQJH DQG DVVLJQ FRORUV�

ILOO SDWWHUQV� DQG PDQ\ RWKHU VW\OH DWWULEXWHV IRU DQ\ REMHFW \RX GUDZ�

<RX FDQ DVVLJQ ILOOV DQG SDWWHUQV WR ERWK OLQHV DQG WKH LQWHULRUV RI FORVHG

REMHFWV� %HVLGHV VROLG FRORUV� \RX FDQ XVH

v *UDGLHQW ILOOV �JUDGXDO FKDQJHV IURP RQH FRORU WR DQRWKHU�

v +DWFK SDWWHUQV

v ,PDJH �ELWPDS� SDWWHUQV

v 2EMHFW ILOOV �ZLWK UHSHWLWLRQV RI DQRWKHU REMHFW�

,Q DGGLWLRQ� \RX FDQ

v 3DVWH RQH REMHFW LQVLGH DQRWKHU WR DFKLHYH D PDVNLQJ HIIHFW

v &RS\ DOO WKH VW\OH DWWULEXWHV IURP RQH REMHFW DQG DSSO\ WKHP WR

DQRWKHU

Style Attributes for Lines Onl y

)RU OLQHV� \RX FDQ FKDQJH WKH
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v &RORU

v 6W\OH �D SDWWHUQ RI GRWV DQG GDVKHV�

v /LQH WKLFNQHVV

v /LQH HQG PDUNHUV IRU VWUDLJKW OLQHV DQG DOO RSHQ REMHFWV �DUFV� FXUYHV�

HOOLSWLFDO DUFV� IUHHKDQG REMHFWV� SDUDERODV� DQG MRLQWHG OLQHV�

/LQHV DOVR DUH XVHG DV ERUGHUV RI FORVHG REMHFWV� <RX FDQ FKDQJH WKHLU

v &RORU

v 6W\OH

v 7KLFNQHVV

,Q DGGLWLRQ� \RX FDQ PDNH D OLQH LQYLVLEOH WR KLGH DQ REMHFWjV ERUGHU�

Using Fills with Text

6RPH LQWHULRU ILOOV� VXFK DV KDWFK ILOOV DQG REMHFW ILOOV� KDYH ERWK D IRUHJURXQG

DQG EDFNJURXQG FRORU� 'RQ
W FRQIXVH WKLV W\SH RI EDFNJURXQG FRORU ZLWK WKH

WH[W EDFNJURXQG FRORU WKDW \RX VHW LQ )RQWV SDQHO RI WKH 7H[W GLDORJ ER[�

,I \RX KDYH DSSOLHG D KDWFK ILOO RU REMHFW ILOO WR WH[W� FOLFNLQJ D FRORU LQ WKH

&RORU 3DOHWWH ZLWK WKH OHIW PRXVH EXWWRQ DORQH VHWV WKH IRUHJURXQG LQWHULRU

FRORU� 7R VHW WKH EDFNJURXQG LQWHULRU FRORU� SRLQW WR D FRORU� SUHVV DQG KROG

SHIFT DQG FOLFN WKH OHIW PRXVH EXWWRQ�
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Using the Object Format Dialog Box

<RX FDQ DFFHVV DQ\ SDQHO RI WKH 2EMHFW )RUPDW GLDORJ ER[ ZLWK WKH FOLFN RI D

EXWWRQ� <RX FDQ VHOHFW OLQH RU LQWHULRU FRORUV DQG DQ\ W\SH RI ILOO IRU OLQHV RU

LQWHULRUV�

Interior Fill panel of the Object Format dialog box

Selection Tabs

7KH WDEV DFURVV WKH WRS RI WKH 2EMHFW )RUPDW GLDORJ ER[ OHW \RX VHOHFW OLQH

DWWULEXWHV� WH[W ILOOV� JUDGLHQW ILOOV� DQG REMHFW SRVLWLRQLQJ� DQG RWKHU LQWHULRU

REMHFW SURSHUWLHV�

Format Buttons

:LWKLQ HDFK SDQHO H[LVW VSHFLILF EXWWRQV GHVLJQHG WR SHUIRUP VSHFLILF

IRUPDWWLQJ IXQFWLRQV� +ROG WKH FXUVRU DERYH D EXWWRQ WR YLHZ WKH EXWWRQ
V

QDPH� 7KH EXWWRQ
V IXQFWLRQ LV GHVFULEHG LQ 'HVLJQHU
V KLQW ZLQGRZ�

Format buttons on the Line Fill panel of the Object Format dialog box.
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Apply Button and Close Button

$V ZLWK PDQ\ RI WKH GLDORJ ER[HV LQ 'HVLJQHU� WKH )LOO GLDORJ ER[ VWD\V RSHQ WR

OHW \RX DSSO\ FKDQJHV WR REMHFWV ZLWKRXW KDYLQJ WR RSHQ WKH GLDORJ ER[

UHSHDWHGO\� <RX FDQ FOLFN $SSO\ HDFK WLPH \RX ZDQW WR DSSO\ D FKDQJH WR D

VHOHFWHG REMHFW� 7KH GLDORJ ER[ GRHV QRW FORVH XQWLO \RX FOLFN &ORVH�

Formatting Lines

Setting Line Styles

<RX FDQ FKRRVH D GRWWHG RU GDVKHG OLQH VW\OH IRU VHOHFWHG OLQHV� <RX DOVR FDQ

VHW D VW\OH IRU OLQHV EHIRUH \RX GUDZ WKHP�

7R VSHHG \RXU ZRUN� WKH /LQH 6W\OH PHQX NHHSV WUDFN RI WKH PRVW UHFHQW OLQH

VW\OH SDWWHUQV \RX KDYH XVHG�

To choose a line st yle from the menu

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH 6W\OH EXWWRQ LQ WKH ULEERQ� 7KH /LQH 6W\OH PHQX

RSHQV�

3 &OLFN D VW\OH LQ WKH PHQX� 7KH VHOHFWHG OLQH RU ERUGHU FKDQJHV WR WKH

QHZ VW\OH�

7LSV

,I QR REMHFWV DUH VHOHFWHG� VXEVHTXHQW OLQHV DQG REMHFW ERUGHUV GUDZ LQ WKH
QHZ VW\OH� <RX FDQ DSSO\ D OLQH VW\OH WR D OLQH RI DQ\ WKLFNQHVV�

<RX DOVR FDQ FKRRVH IURP RWKHU OLQH VW\OHV LQ WKH /LQH�6W\OH GLDORJ ER[�

To choose a line st yle from the Line-St yle dialo g box

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�
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2 &OLFN WKH /LQH 6W\OH EXWWRQ LQ WKH ULEERQ� 7KH /LQH 6W\OH PHQX

RSHQV�

3 &OLFN 6W\OH� 7KH /LQH�6W\OH GLDORJ ER[ RSHQV�

4 &OLFN WKH VW\OH \RX ZDQW�

5 &OLFN $SSO\� 7KH VHOHFWHG OLQH RU ERUGHU FKDQJHV WR WKH QHZ VW\OH�

7LS

,I QR REMHFWV DUH VHOHFWHG� VXEVHTXHQW OLQHV DQG REMHFW ERUGHUV GUDZ LQ WKH
QHZ VW\OH� 7KH QHZ VW\OH DSSHDUV LQ WKH /LQH 6W\OH PHQX IRU ODWHU XVH�

Setting Line Ends

<RX FDQ FKRRVH IURP D YDULHW\ RI OLQH HQGV WR HQKDQFH \RXU GUDZLQJ�

/LQHV �RSHQ REMHFWV� FDQ KDYH HQG PDUNHUV DW RQH RU ERWK HQGV� 7KH OLQH

HQGV LQFOXGH DUURZKHDGV� OLQHV� VTXDUHV� FLUFOHV� DQG WULDQJOHV� <RX FDQ VHW WKH

OLQH HQGV ILUVW� VR WKDW HYHU\ OLQH DSSHDUV ZLWK WKH QHZ HQG PDUNHU� RU \RX

FDQ FKDQJH WKH HQGV RI VHOHFWHG OLQHV�

<RX FDQ DGG OLQH HQGV WR DQ\ RSHQ REMHFW� <RX FDQ VHW ERWK HQGV RI D OLQH WR

EH WKH VDPH RU GLIIHUHQW IRU HDFK HQG� <RX DOVR FDQ KDYH DQ HQG PDUNHU RQ

RQO\ RQH HQG RI D OLQH� (DFK OLQH KDV D �ILUVW HQG� DQG D �ODVW HQG�� GHSHQGLQJ

RQ ZKLFK HQG LV WKH VWDUWLQJ SRLQW ZKHQ WKH OLQH LV GUDZQ�

$V \RX VHOHFW OLQH HQGV� WKH HQGV \RX FKRRVH DUH DGGHG WR WKH /LQH (QGV

PHQX� 7KH PHQX VKRZV WKH PRVW UHFHQWO\ VHOHFWHG OLQH HQGV�

To choose a line end from the menu

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH (QGV EXWWRQ LQ WKH ULEERQ� 7KH /LQH (QGV PHQX

RSHQV�
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3 &OLFN D OLQH HQG VDPSOH� $ VHOHFWHG OLQH FKDQJHV WR WKH QHZ HQGV�

7LSV

,I QR OLQH LV VHOHFWHG� VXEVHTXHQW OLQHV GUDZ ZLWK WKH QHZ HQGV�

<RX DOVR FDQ FKRRVH IURP RWKHU OLQH HQGV LQ WKH /LQH�(QGV GLDORJ ER[� <RX
FDQ HYHQ FUHDWH QHZ OLQH HQGV DQG SDVWH WKHP LQWR WKH GLDORJ ER[�

To choose ends from the Line-Ends dialo g box

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH (QGV EXWWRQ LQ WKH ULEERQ� 7KH /LQH (QGV PHQX

RSHQV�

3 &OLFN (QGV� 7KH /LQH�(QGV GLDORJ ER[ RSHQV�

4 ,Q WKH SUHYLHZ ZLQGRZ� FOLFN WKH HQG RI WKH OLQH \RX ZDQW WR FKDQJH�

�7KH HQG RQ WKH OHIW LV WKH ILUVW HQG� WKH HQG RQ WKH ULJKW LV WKH ODVW

HQG��

5 &OLFN WKH EXWWRQ RI WKH GHVLUHG OLQH HQG� XVLQJ WKH VFUROO DUURZV WR

ORFDWH WKH RQH \RX ZDQW�

6 &OLFN $SSO\� $ VHOHFWHG OLQH FKDQJHV WR WKH QHZ VW\OH� LI QR REMHFWV DUH

VHOHFWHG� VXEVHTXHQW OLQHV GUDZ LQ WKH QHZ VW\OH�

1RWHV

7KH GHIDXOW RSWLRQV DUH 6DPH 7\SH DQG 6DPH $WWULEXWHV IRU ERWK HQGV RI
WKH OLQH� <RX FDQ GHVHOHFW WKHVH RSWLRQV WR XVH WZR GLIIHUHQW HQG W\SHV RU
WR PDNH WKH WZR HQGV D GLIIHUHQW VL]H� DQJOH� DQG VR IRUWK�

7R UHVHW WKH OLQH HQG WR QRQH� \RX FDQ FOLFN 1R (QGV LQ WKH /LQH (QGV
PHQX RU FKRRVH WKH OLQH ZLWK QR HQG LQ WKH GLDORJ ER[�

7R GUDZ D *DQWW FKDUW ZLWK 'HVLJQHU� VHW WKH GLPHQVLRQV RI OLQHV WR ZHHNV
DQG GD\V �XQLWV VHWWLQJ LQ WKH *HQHUDO SDQHO RI WKH 'LPHQVLRQV GLDORJ ER[�
DQG XVH WULDQJOHV IRU OLQH HQGV�
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To add line ends to the Line-Ends dialo g box

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH (QGV EXWWRQ LQ WKH ULEERQ� 7KH /LQH (QGV PHQX

RSHQV�

3 &OLFN (QGV� 7KH /LQH�(QGV GLDORJ ER[ RSHQV�

4 'UDZ DQ REMHFW WR EH XVHG DV D OLQH HQG�

5 2Q WKH (GLW PHQX� FOLFN &RS\ WR FRS\ \RXU OLQH HQG WR WKH &OLSERDUG�

6 &OLFN WKH 3DVWH EXWWRQ LQ WKH /LQH�(QGV GLDORJ ER[� 7KH OLQH HQG \RX

FUHDWHG LV DGGHG WR WKH JDOOHU\ RI HQGV�

7LSV

<RX FDQ QRZ FKRRVH WKH OLQH HQG \RX FUHDWHG IURP WKLV GLDORJ ER[�

,I WKH OLQH HQG \RX DGG LV DQ REMHFW ZLWK ZHLJKWHG OLQHV� VHOHFW :HLJKWHG
DQG WKHQ VHOHFW 6FDOH ZLWK WKH 2EMHFW LQ WKH /LQH�7KLFNQHVV GLDORJ ER[ VR
WKDW OLQHV DUH VFDOHG FRUUHFWO\ ZKHQ WKH REMHFW LV UHGXFHG�

<RX DOVR FDQ UHPRYH OLQH HQGV \RX FUHDWHG DQG SDVWHG LQWR WKH /LQH�(QGV
GLDORJ ER[� �<RX FDQQRW UHPRYH HQGV RULJLQDOO\ LQFOXGHG ZLWK 'HVLJQHU��

To remove line ends from the Line-Ends dialo g box

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH (QGV EXWWRQ LQ WKH ULEERQ� 7KH /LQH (QGV PHQX

RSHQV�

3 &OLFN (QGV� 7KH /LQH�(QGV GLDORJ ER[ RSHQV�

4 6HOHFW WKH OLQH HQG \RX ZDQW WR UHPRYH�
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5 &OLFN 5HPRYH� 7KH OLQH HQG LV UHPRYHG IURP WKH JDOOHU\�

7LS

<RX FDQQRW UHPRYH HQGV RULJLQDOO\ LQFOXGHG ZLWK 'HVLJQHU�

Editing Line Ends

,I \RX QHHG WR DGMXVW WKH SRVLWLRQ RU DSSHDUDQFH RI D OLQH HQG� \RX FDQ VFDOH�

PRYH� URWDWH� RU IOLS WKH OLQH HQG UHODWLYH WR LWV OLQH� <RX FDQ ZDWFK WKH

SUHYLHZ LQ WKH /LQH�(QGV GLDORJ ER[ WR VHH WKH HIIHFW \RXU DGMXVWPHQWV KDYH�

([SHULPHQW ZLWK WKH FRQWUROV WR UHDFK WKH UHVXOW \RX ZDQW�

Scalin g a Line End

&KDQJH WKH VL]H RI D OLQH HQG E\ FKDQJLQJ WKH YDOXH RI :LGWK � DQG +HLJKW ��

7KH GHIDXOW YDOXHV DUH ����� ZKLFK LV WKH RULJLQDO VL]H� &KDQJLQJ ERWK WKHVH

YDOXHV WR ��� PDNHV WKH OLQH HQG KDOI WKH RULJLQDO VL]H� FKDQJLQJ WKH YDOXHV WR

���� PDNHV WKH OLQH HQG WZLFH WKH RULJLQDO VL]H� 7R VFDOH WKH OLQH HQG

SURSRUWLRQDOO\� FKDQJH :LGWK � DQG +HLJKW � WKH VDPH DPRXQW�

Movin g a Line End

<RX FDQ PRYH� RU RIIVHW� D OLQH HQG IURP LWV OLQH E\ LQFUHDVLQJ RU GHFUHDVLQJ

WKH YDOXHV LQ WKH ; 2IIVHW � RU < 2IIVHW �� =HUR LV WKH GHIDXOW SRVLWLRQ�

,QFUHDVLQJ WKH SHUFHQWDJH IRU ; 2IIVHW PRYHV WKH OLQH HQG DZD\ IURP WKH

OLQH� 'HFUHDVLQJ WKH SHUFHQWDJH IRU ; 2IIVHW �XVLQJ D QHJDWLYH YDOXH� PRYHV

WKH HQG WRZDUG WKH PLGGOH RI WKH OLQH�

,QFUHDVLQJ WKH SHUFHQWDJH IRU < 2IIVHW PRYHV WKH OLQH HQG XS� 'HFUHDVLQJ WKH

SHUFHQWDJH IRU < 2IIVHW �XVLQJ D QHJDWLYH YDOXH� PRYHV WKH OLQH HQG GRZQ�
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Rotatin g a Line End

<RX FDQ URWDWH D OLQH HQG UHODWLYH WR WKH OLQH E\ FKDQJLQJ WKH YDOXH IRU $QJOH�

7KH GHIDXOW YDOXH �QR URWDWLRQ� LV ]HUR GHJUHHV�

Settin g Line St yles

,I \RX VHOHFW 8VH /LQH� WKH FXUUHQW OLQH WKLFNQHVV DQG ILOO DWWULEXWHV DUH DSSOLHG

WR WKH OLQH HQG� ,I \RX ZDQW WR UHWDLQ WKH RULJLQDO VW\OH DWWULEXWHV RI DQ REMHFW

\RX DUH SDVWLQJ LQWR WKH OLQH HQG JDOOHU\� GHVHOHFW WKLV RSWLRQ�

To edit line ends

1 6HOHFW WKH OLQH ZLWK WKH HQGV \RX ZDQW WR HGLW�

2 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

3 &OLFN WKH /LQH (QGV EXWWRQ LQ WKH ULEERQ� 7KH /LQH (QGV PHQX

RSHQV�

4 &OLFN (QGV� 7KH /LQH�(QGV GLDORJ ER[ RSHQV�

5 &KRRVH WKH VHWWLQJV \RX ZDQW WR DSSO\ WR WKH OLQH HQGV�
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Using Weighted Lines

:HLJKWHG OLQHV DUH OLQHV WKDW DUH WKLFNHU WKDQ D �KDLUOLQH�� $ KDLUOLQH �WKH

GHIDXOW� LV WKH WKLQQHVW OLQH WKDW FDQ EH GLVSOD\HG RU SULQWHG RQ D VSHFLILF

GHYLFH� &DS RSWLRQV DIIHFW WKH HQGV RI OLQHV� MRLQ RSWLRQV DIIHFW WKH

LQWHUVHFWLRQ RI OLQHV�

<RX FDQ VHW WKH WKLFNQHVV RI OLQHV DQG WKH FDS DQG MRLQ RSWLRQV RI OLQHV ZLWK

/LQH 7KLFNQHVV LQ WKH 6W\OH 5LEERQ WRROEDU� ,I QR REMHFWV DUH VHOHFWHG� \RX

VHW D QHZ GHIDXOW ZKHQ \RX FKDQJH WKH OLQH WKLFNQHVV RU FDS DQG MRLQ RSWLRQV�

6XEVHTXHQW OLQHV GLVSOD\ ZLWK WKH VHOHFWHG ZLGWK� KHLJKW� DQG DQJOH� ,Q

DGGLWLRQ� \RX FDQ FKDQJH WKH ZHLJKWHG OLQH RSWLRQV IRU D VHOHFWHG OLQH�

)RU VLPSOH ZHLJKWHG OLQHV� WKH ZLGWK DQG KHLJKW DUH WKH VDPH� DQG WKH SHQ

DQJOH LV VHW WR ]HUR GHJUHHV� <RX FKDQJH RQO\ WKH ZLGWK �WKLFNQHVV� RI WKH OLQH�

)RU D GLIIHUHQW HIIHFW� 'HVLJQHU FDQ VLPXODWH D FDOOLJUDSK\ SHQ �ZKRVH WLS LV

W\SLFDOO\ WDOOHU WKDQ LW LV ZLGH� DQG WKH ZD\ LW PLJKW EH XVHG �DW DQ DQJOH LQ

UHODWLRQ WR WKH SDJH�� ,I \RX VHOHFW &DOOLJUDSKLF OLQHV� \RX FDQ VHW WKH ZLGWK�

KHLJKW� DQG DQJOH RI WKH �SHQ WLS��

7KH /LQH 7KLFNQHVV PHQX GLVSOD\V SUHYLRXVO\ XVHG ZHLJKWHG OLQHV VR \RX FDQ

FKRRVH WKHP GLUHFWO\ IURP WKH PHQX�

Setting the Line Thickness

<RX FDQ FKRRVH D OLQH WKLFNQHVV GLUHFWO\ IURP WKH /LQH 7KLFNQHVV PHQX� RU

\RX FDQ FKDQJH WKH WKLFNQHVV RI D OLQH LQ WKH /LQH�7KLFNQHVV GLDORJ ER[� /LQH

WKLFNQHVV FDQ UDQJH IURP D IUDFWLRQ RI D SRLQW XS WR ��� SRLQWV �� LQFKHV��

<RX DOVR FDQ FXVWRPL]H DQG HGLW OLQH DWWULEXWHV� <RX FDQ

v &KDQJH WKH WKLFNQHVV RI D OLQH�

v &KDQJH WKH FDS DQG MRLQ RSWLRQV�

v &UHDWH FDOOLJUDSKLF OLQHV�

v &KRRVH ZKHWKHU WKH OLQH WKLFNQHVV FKDQJHV ZKHQ DQ REMHFW LV VFDOHG�
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To choose a line thickness from the menu

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH 7KLFNQHVV EXWWRQ LQ WKH ULEERQ� 7KH /LQH 7KLFNQHVV

PHQX RSHQV�

3 &OLFN D OLQH WKLFNQHVV� $ VHOHFWHG OLQH FKDQJHV WR WKH QHZ WKLFNQHVV�

7LSV

,I QR REMHFW LV VHOHFWHG� VXEVHTXHQW OLQHV GUDZ LQ WKH QHZ WKLFNQHVV�

To set the line thickness in the Line-Thickness dialo g box

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH 7KLFNQHVV EXWWRQ LQ WKH ULEERQ� 7KH /LQH 7KLFNQHVV

PHQX RSHQV�

3 &OLFN 7KLFNQHVV� 7KH /LQH�7KLFNQHVV GLDORJ ER[ RSHQV�

4 &OLFN WKH YDOXH LQ WKH :LGWK ER[ DQG W\SH D QXPEHU WR FKDQJH WKH

WKLFNQHVV �ZLGWK DQG KHLJKW DUH WKH VDPH��

5 &OLFN $SSO\�

7LS

,I WKH 6FDOH ZLWK 2EMHFW RSWLRQ LV VHOHFWHG� WKH OLQH WKLFNQHVV LQFUHDVHV RU
GHFUHDVHV ZKHQ WKH REMHFW LV UHVL]HG� ,I 6FDOH ZLWK 2EMHFW LV QRW VHOHFWHG�
WKH OLQH WKLFNQHVV UHPDLQV WKH VDPH ZKHQ WKH REMHFW LV UHVL]HG�
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Setting Join and Cap Options

<RX FDQ FKRRVH WKH VKDSH RI WKH FRUQHU LQWHUVHFWLRQ DQG WKH HQGV RI OLQHV�

'HVLJQHU RIIHUV WKUHH FKRLFHV IRU HDFK� 6HOHFW WKH RSWLRQV \RX ZDQW LQ WKH

/LQH�7KLFNQHVV GLDORJ ER[� $ SUHYLHZ OLQH �LQ WKH XSSHU ULJKW� VKRZV D UHG

OLQH LQ WKH FHQWHU WR VKRZ WKH HIIHFW RI GLIIHUHQW FDS RSWLRQV�

Settin g Cap Options

&DS RSWLRQV GHWHUPLQH WKH DSSHDUDQFH RI WKH HQGV RI OLQHV�

v 7KH 5RXQG &DS RSWLRQ SODFHV WKH FHQWHU SRLQW RI D FLUFOH DW WKH HQG

SRLQW RI WKH OLQH� �7KH GLDPHWHU RI WKH FLUFOH PDWFKHV WKH WKLFNQHVV RI

WKH OLQH��

v 7KH 6TXDUH &DS RSWLRQ SODFHV WKH FHQWHU SRLQW RI D VTXDUH DW WKH HQG

SRLQW RI WKH OLQH� �7KH ZLGWK DQG KHLJKW RI WKH VTXDUH PDWFK WKH

WKLFNQHVV RI WKH OLQH��

v 7KH )ODW &DS RSWLRQ HQGV WKH OLQH DW WKH HQG SRLQW RI WKH OLQH�

Settin g Join O ptions

-RLQ RSWLRQV GHWHUPLQH WKH DSSHDUDQFH RI WKH FRUQHU LQWHUVHFWLRQ RI OLQHV LQ

DQ REMHFW�

v 7KH 5RXQG -RLQ RSWLRQ SODFHV WKH FHQWHU SRLQW RI D FLUFOH DW WKH YHUWH[

RI WZR OLQH HQGV� �7KH GLDPHWHU RI WKH FLUFOH PDWFKHV WKH WKLFNQHVV RI

WKH OLQHV��

v 7KH 0LWUH -RLQ RSWLRQ FUHDWHV D SRLQWHG LQWHUVHFWLRQ WKDW LV WKH WUXH

LQWHUVHFWLRQ RI WZR OLQHV�

v 7KH %HYHO -RLQ RSWLRQ DYHUDJHV WKH DQJOHV RI WKH WZR OLQHV� FUHDWLQJ D

EOXQW LQWHUVHFWLRQ�

7LSV

([SHULPHQW ZLWK WKH URXQGHG FDS RSWLRQ DQG D OLQH VW\OH RI VKRUW GDVKHV WR
REWDLQ D GRWWHG �UDWKHU WKDQ GDVKHG� OLQH VW\OH�

:KHQ \RX VHOHFW WKH 0LWUH -RLQ RSWLRQ LQ WKH /LQH�7KLFNQHVV GLDORJ ER[�
DQ\ OLQHV WKDW PHHW DW DQJOHV VKDUSHU WKDQ �� GHJUHHV DUH GUDZQ ZLWK
EHYHOHG MRLQV� 7KLV SUHYHQWV REMHFWV IURP KDYLQJ H[WUHPHO\ SRLQWHG MRLQV�
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To set join and ca p options

1 &OLFN WKH )RUPDW WRRO PS LQ WKH WRROER[�

2 &OLFN WKH /LQH 7KLFNQHVV EXWWRQ LQ WKH ULEERQ� 7KH /LQH 7KLFNQHVV

PHQX RSHQV�

3 &OLFN 7KLFNQHVV� 7KH /LQH�7KLFNQHVV GLDORJ ER[ RSHQV�

4 &OLFN WKH FDS DQG MRLQ RSWLRQV UHSHDWHGO\ XQWLO \RX RQHV \RX ZDQW DUH

GLVSOD\HG�

5 &OLFN $SSO\�

Creating Calligraphic Lines

<RX FDQ GUDZ FDOOLJUDSKLF OLQHV ZLWK 'HVLJQHU E\ VHOHFWLQJ ERWK :HLJKWHG DQG

&DOOLJUDSKLF LQ WKH /LQH�7KLFNQHVV GLDORJ ER[� 7KHQ \RX FKDQJH WKH 3HQ

:LGWK� +HLJKW� DQG $QJOH VHWWLQJV� &DOOLJUDSKLF OLQHV FDQ DGG D PRUH QDWXUDO

ORRN WR PDQ\ GUDZLQJV� HVSHFLDOO\ ZKHQ XVHG ZLWK FXUYHG OLQHV�

7R PDNH D OLQH FDOOLJUDSKLF� \RX FKDQJH WKH YDOXH IRU WKH ZLGWK RU KHLJKW LQ

UHODWLRQ WR WKH RWKHU� $V \RX H[SHULPHQW WR ILQG WKH ULJKW VHWWLQJV� WKH GLDORJ

ER[ VKRZV D SUHYLHZ RI WKH OLQHV�
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7KH SULPDU\ ZD\ WR VHW FDOOLJUDSKLF OLQHV LV WR DGMXVW WKH ZLGWK DQG KHLJKW

VHWWLQJV� 7KH OLQHV ZLWK WKH PRVW �IODLU� DUH SURGXFHG E\ FKRRVLQJ YHU\

GLIIHUHQW ZLGWK DQG KHLJKW VHWWLQJV� )RU H[DPSOH� D YHU\ WKLQ EXW YHU\ WDOO

VHWWLQJ ZLOO SURGXFH D FDOOLJUDSKLF OLQH HYHQ ZLWKRXW DGMXVWLQJ WKH 3HQ $QJOH

VHWWLQJ�

$GMXVWLQJ WKH 3HQ $QJOH VHWWLQJ FDQ HQKDQFH WKH HIIHFWV FUHDWHG ZLWK WKH

:LGWK DQG +HLJKW VHWWLQJV� ,Q D FDOOLJUDSKLF OLQH� WKH 3HQ $QJOH VHWWLQJ IRUFHV

WKH SHQ WLS WR VWD\ DW WKH FKRVHQ DQJOH� PXFK DV D FDOOLJUDSKLF SHQ LV KHOG DW

SDUWLFXODU DQJOHV WR DFKLHYH FHUWDLQ HIIHFWV�

RT_Creatin g_Calli graphic_Lines
RT_Creating_Calligraphic_Lines
6HWWLQJ /LQH 6W\OHV

6HWWLQJ /LQH (QGV

(GLWLQJ /LQH (QGV

8VLQJ :HLJKWHG /LQHV

6HWWLQJ WKH /LQH 7KLFNQHVV

6HWWLQJ -RLQ DQG &DS 2SWLRQV

To create calli graphic lines

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH 7KLFNQHVV EXWWRQ LQ WKH ULEERQ� 7KH /LQH 7KLFNQHVV

PHQX RSHQV�

3 &OLFN 7KLFNQHVV� 7KH /LQH�7KLFNQHVV GLDORJ ER[ RSHQV�

4 &OLFN :HLJKWHG DQG &DOOLJUDSKLF� &KRLFHV IRU :LGWK� +HLJKW� DQG 3HQ

$QJOH DSSHDU�

5 7\SH WKH :LGWK� +HLJKW� DQG 3HQ $QJOH \RX ZDQW� 7KH SHQ WLS LV VKRZQ

LQ WKH SUHYLHZ DUHD�

6 &OLFN $SSO\�

7LS

<RX FDQ GUDJ WKH UHG QHHGOH LQ WKH SUHYLHZ DUHD WR VHW WKH SHQ DQJOH�
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RT_To_choose_a_line_style_from_the_menu
6HWWLQJ /LQH 6W\OHV

6HWWLQJ /LQH (QGV

(GLWLQJ /LQH (QGV

8VLQJ :HLJKWHG /LQHV

6HWWLQJ WKH /LQH 7KLFNQHVV

6HWWLQJ -RLQ DQG &DS 2SWLRQV

&UHDWLQJ &DOOLJUDSKLF /LQHV
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Formatting Objects

Selecting a Solid Color Fill

<RX FDQ FKRRVH D FRORU IRU DQ REMHFW EHIRUH RU DIWHU \RX GUDZ LW� 6HOHFWLQJ D

FRORU DIIHFWV DOO VHOHFWHG REMHFWV� ,I QR REMHFWV DUH VHOHFWHG� VHOHFWLQJ D FRORU

VHWV WKH FRORU IRU WKH QH[W REMHFW \RX GUDZ�

To choose an ob ject's color from the Ob ject Format dialo g box

1 6HOHFW DQ REMHFW�

2 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

3 &OLFN WKH 6ROLG ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ WR FKDQJH WKH

FRORU RI WKH LQWHULRU�

RU

&OLFN WKH /LQH )LOO EXWWRQ WR FKDQJH WKH FRORU RI WKH OLQH� $ PHQX

RSHQV�

4 &OLFN D FRORU LQ WKH SDOHWWH WR FKRRVH WKH REMHFWjV FRORU�

5 &OLFN $SSO\ WR FKDQJH WKH REMHFWjV OLQH RU LQWHULRU FRORU�

7LSV

,I QR REMHFW LV VHOHFWHG� \RX VHW D QHZ GHIDXOW FRORU�

7R VSHHG \RXU ZRUN� WKH 6ROLG VXEPHQX NHHSV WUDFN RI WKH PRVW UHFHQWO\
XVHG VROLG FRORU ILOOV� &OLFN WKH VROLG ILOO LQ WKH VXEPHQX DV \RX ZRXOG DQ\
RWKHU FRPPDQG�

To select an invisible fill or line

1 6HOHFW WKH REMHFW \RX ZDQW WR KDYH DQ LQYLVLEOH ILOO�

2 &OLFN WKH )RUPDW WRRO �
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3 &OLFN WKH 5HPRYH ,QWHULRU )LOO EXWWRQ RU WKH 5HPRYH /LQH EXWWRQ�

7LSV

&OLFN WKH OHIW PRXVH EXWWRQ IRU LQWHULRU ILOO� ULJKW PRXVH EXWWRQ IRU OLQH ILOO

$OWHUQDWH PHWKRG� 6HOHFW WKH REMHFW� FOLFN WKH )RUPDW WRRO � FOLFN
,QWHULRU )LOO �RU /LQH )LOO �� DQG FOLFN ,QYLVLEOH�

$OWHUQDWH PHWKRG� 6HOHFW WKH REMHFW� FOLFN WKH )RUPDW WRRO � FOLFN
,QWHULRU )LOO� FOLFN 6ROLG� DQG FOLFN &XVWRP� :KHQ WKH )LOO GLDORJ ER[ RSHQV�
FOLFN WKH FXUUHQW ILOO EXWWRQ �6ROLG � *UDGLHQW � +DWFK � ,PDJH �
RU 2EMHFW � WR �WXUQ RII� WKH FXUUHQW ILOO�

$OWHUQDWH PHWKRG IRU OLQHV� 6HOHFW D OLQH� FOLFN /LQH 6W\OH LQ WKH 6W\OH
5LEERQ WRROEDU� DQG FOLFN ,QYLVLEOH�

$OWHUQDWH PHWKRG IRU OLQHV� &OLFN WKH /LQHV 6W\OH EXWWRQ � FOLFN 6W\OH� DQG
FOLFN WKH ,QYLVLEOH RSWLRQ LQ WKH /LQH�6W\OH GLDORJ ER[�

Using Fill Options

'HVLJQHU OHWV \RX FRQWURO ZKHWKHU RYHUODSV RU FXW�RXWV DUH ILOOHG DQG

ZKHWKHU WKH LQWHULRU LV ILOOHG EHIRUH RU DIWHU WKH OLQH� )RU PRUH LQIRUPDWLRQ

RQ RYHUODSV DQG FXW�RXWV� VHH &RQQHFWLQJ 2EMHFWV�

Fillin g Overla ps

'HVLJQHU OHWV \RX FRQWURO ZKHWKHU WKH RYHUODSSLQJ DUHDV RI DQ REMHFW DUH

ILOOHG RU VNLSSHG�

Overlaps f illed and skipped
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Fill Before or After Line

<RX FDQ VSHFLI\ ZKHWKHU DQ REMHFW
V LQWHULRU LV ILOOHG EHIRUH RU DIWHU LWV OLQH LV

GUDZQ�

Fill before and after

v 7KH )LOO %HIRUH /LQH DQG )LOO $IWHU /LQH FRPPDQGV GR QRW DSSO\ WR

KDLUOLQHV� 2EMHFWV ZLWK RQO\ KDLUOLQHV DUH QRW DIIHFWHG� <RX FDQ LQFUHDVH

WKH WKLFNQHVV RI WKH OLQHV DQG WKHQ XVH HLWKHU RI WKH FRPPDQGV� ,I \RX

DSSO\ HLWKHU RI WKH FRPPDQGV WR DQ REMHFW WKDW LQFOXGHV ERWK KDLUOLQHV

DQG ZHLJKWHG OLQHV� RQO\ WKH ZHLJKWHG OLQHV DUH DIIHFWHG�

v 7KH )LOO $IWHU /LQH RSWLRQ FDQ ZRUN ZHOO IRU VKDGRZ HIIHFWV�

To set fill o ptions

1 2SHQ WKH 2EMHFW )RUPDW GLDORJ�

2 &OLFN )LOO 2YHUODSV RU 6NLS 2YHUODSV WR VHW WKH RYHUODS ILOO RSWLRQ�

3 &OLFN )LOO %HIRUH /LQH DQG )LOO $IWHU /LQH WR VHW WKH ILOO GUDZ VHTXHQFH

RSWLRQ�
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Using Gradient Fills

$ JUDGLHQW LV D ILOO WKDW PDNHV D JUDGXDO WUDQVLWLRQ EHWZHHQ FRORUV� *UDGLHQWV

FDQ DGG PRUH UHDOLVWLF GHSWK WR D GUDZLQJ DQG SURYLGH D OHVV PHFKDQLFDO IHHO

WR PDQ\ LOOXVWUDWLRQV� <RX FDQ FUHDWH OLQHDU� UDGLDO� FRQLFDO� DQG VTXDUH JUDGLHQW

ILOOV�

/LQHDU JUDGLHQWV DUH WKH VLPSOHVW RI WKH IRXU� ZLWK D JUDGXDO IDGH RI RQH FRORU

WR DQRWKHU LQ D VSHFLILHG GLUHFWLRQ ZLWKLQ DQ REMHFW�

5DGLDO �FLUFXODU� DQG VTXDUH JUDGLHQWV IDGH IURP RQH FRORU LQ WKH LQQHU SDUW RI

WKH ILOO WR DQRWKHU FRORU LQ WKH RXWHU SDUW RI WKH ILOO� $ 6TXDUH JUDGLHQW IDGHV

IURP RQH FRORU LQ WKH LQQHU SDUW WR WKH RXWHU SDUW LQ D VTXDUH SDWWHUQ�

$ VLPSOH JUDGLHQW ILOO IDGHV IURP DQ\ RQH VHOHFWHG FRORU WR DQ\ RWKHU VHOHFWHG

FRORU� 'HVLJQHU HYHQ OHWV \RX XVH JUDGLHQW ILOOV PDGH XS RI PDQ\ FRORUV� )RU

H[DPSOH� \RX FDQ HDVLO\ FUHDWH UDLQERZ HIIHFWV�

<RX FKRRVH WKH WZR RU PRUH FRORUV XVHG LQ D JUDGLHQW ILOO LQ WKH )LOO�*UDGLHQW

GLDORJ ER[�

7R VSHHG \RXU ZRUN� WKH *UDGLHQW VXEPHQX NHHSV WUDFN RI WKH PRVW UHFHQWO\

XVHG JUDGLHQW ILOOV� &KRRVH WKH JUDGLHQW ILOO LQ WKH VXEPHQX DV \RX ZRXOG DQ\

RWKHU FRPPDQG�
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Making Gradient Fills Draw Faster

%HFDXVH JUDGLHQW ILOOV WDNH WLPH WR GUDZ RQ \RXU VFUHHQ� \RX FDQ VSHHG WKHP

E\ FKRRVLQJ D GLIIHUHQW GLVSOD\ RSWLRQ�

&KRRVLQJ 6PRRWK SURGXFHV WKH KLJKHVW GLVSOD\ TXDOLW\ RQ \RXU VFUHHQ EXW

UHGUDZV PRUH VORZO\� ZKLOH &RDUVH SURGXFHV WKH ORZHVW GLVSOD\ TXDOLW\ EXW

UHGUDZV TXLFNO\� :KHQ 1RQH LV VHOHFWHG� RQO\ WKH ILUVW FRORU RI WKH JUDGLHQW LV

GLVSOD\HG� <RX DOZD\V VHH D JUDGLHQW ZKHQ \RX SULQW WKH GRFXPHQW�

To make gradient fills draw faster

` 2Q WKH 9LHZ PHQX� SRLQW WR 6KRZ *UDGLHQWV� 7KHQ FOLFN 6PRRWK�

$YHUDJH� &RDUVH� RU 1RQH� $OO JUDGLHQWV LQ DOO GRFXPHQWV GUDZ XVLQJ WKH

RSWLRQV \RX FKRRVH�

To add a gradient fill to a selected ob ject

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[� 7KH )RUPDW ULEERQ GLVSOD\V�

2 &OLFN WKH *UDGLHQW ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ� RU WKH

*UDGLHQW /LQH )LOO EXWWRQ � 7KH )LOO�*UDGLHQW SDQH RSHQV�

3 &OLFN D FRORU LQ WKH &RORU 3DOHWWH�

4 &OLFN WKH SRLQW DERYH WKH FRORU EDQG DW �����

5 &OLFN DQRWKHU FRORU LQ WKH &RORU 3DOHWWH�

6 &OLFN D JUDGLHQW EXWWRQ�

7 7R HGLW� GUDJ WKH HQG FLUFOHV WR FRQWURO WKH DQJOH� 0RYH WKH RULJLQ

VTXDUH WR FRQWURO WKH JUDGLHQW FHQWHU�

7LS

&OLFN $SSO\� 7KH REMHFW UHGUDZV ZLWK WKH QHZ JUDGLHQW�$V D VKRUWFXW�
GRXEOH FOLFN D JUDGLHQW LQVWHDG RI FKRRVLQJ WKH JUDGLHQW DQG WKHQ FOLFNLQJ
$SSO\�
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v <RX FDQ XVH PDQ\ FRORUV LQ D JUDGLHQW ILOO� LQVWHDG RI RQO\ WZR� WR FUHDWH

PXOWLFRORU JUDGLHQWV DQG UDLQERZ HIIHFWV� &OLFN DERYH WKH FRORU EDQG WR

FUHDWH D QHZ FRORU SRLQW DQG WKHQ FKRRVH D FRORU LQ WKH SDOHWWH� <RX

FDQ FRQWLQXH WR DGG DGGLWLRQDO FRORU SRLQWV LQ WKLV ZD\� <RX FDQ GUDJ

HDFK SRLQW WR WKH GHVLUHG ORFDWLRQ RQ WKH FRORU EDQG �WU\ VSDFLQJ WKHP

HYHQO\� WR FRQWURO KRZ WKH ILOO JUDGXDWHV IURP RQH FRORU WR DQRWKHU� 7R

GHOHWH D FRORU SRLQW� GUDJ LW RII RI WKH GLDORJ ER[�

8 <RX FDQ TXLFNO\ FKDQJH WKH ILUVW DQG ODVW FRORUV IRU D JUDGLHQW ILOO LQ D

VHOHFWHG REMHFW ZLWKRXW XVLQJ WKH )LOO�*UDGLHQW GLDORJ ER[� 6HOHFW WKH

REMHFW ZLWK D JUDGLHQW ILOO� FOLFN RQH FRORU LQ WKH FRORU SDOHWWH� SUHVV DQG

KROG SHIFT� DQG FOLFN DQRWKHU FRORU LQ WKH SDOHWWH�
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Using Hatch Fills

<RX FDQ ILOO REMHFWV ZLWK KDWFK SDWWHUQV WKDW DUH FRPSRVHG RI YHFWRU�EDVHG

OLQHV�

2EMHFWV ZLWK KDWFK SDWWHUQV KDYH WZR LQWHULRU FRORUV� RQH IRU WKH KDWFK

SDWWHUQ �IRUHJURXQG� DQG RQH IRU WKH EDFNJURXQG�

'HQVH SDWWHUQV VKRZ OHVV RI WKH EDFNJURXQG FRORU� DQG VSDUVH SDWWHUQV VKRZ

PRUH EDFNJURXQG FRORU� %\ H[SHULPHQWLQJ ZLWK GLIIHUHQW SDWWHUQV DQG FRORUV�

\RX FDQ SURGXFH LQWHUHVWLQJ HIIHFWV�

7R VSHHG \RXU ZRUN� WKH +DWFK VXEPHQX NHHSV WUDFN RI WKH PRVW UHFHQWO\

XVHG KDWFK ILOOV� &KRRVH WKH KDWFK ILOO LQ WKH PHQX DV \RX ZRXOG DQ\ RWKHU

FRPPDQG�

Making Hatch Patterns Draw Faster

,I KDWFK SDWWHUQV WDNH WRR PXFK WLPH WR GUDZ RQ \RXU VFUHHQ� \RX FDQ KLGH

WKHP E\ WXUQLQJ KDWFK ILOOV RII LQ WKH GUDZLQJ�

To make hatch patterns draw faster

` 2Q WKH 9LHZ PHQX� FOLFN 6KRZ +DWFK )LOOV WR WRJJOH ZKHWKHU KDWFK ILOOV

VKRZ LQ \RXU GUDZLQJ�

To choose a hatch pattern

1 6HOHFW DQ REMHFW�

2 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

3 &OLFN WKH +DWFK ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ� RU WKH +DWFK

/LQH )LOO EXWWRQ � 7KH )LOO�+DWFK GLDORJ ER[ RSHQV�

4 &OLFN D SDWWHUQ�

5 7R FKDQJH WKH IRUHJURXQG FRORU� VHOHFW )RUHJURXQG� SRLQW WR D FRORU LQ

WKH SDOHWWH� DQG FOLFN WKH OHIW PRXVH EXWWRQ�
234 i G r a f x  D e s i g n e r



6 7R FKDQJH WKH EDFNJURXQG FRORU� VHOHFW %DFNJURXQG� SRLQW WR D FRORU LQ

WKH SDOHWWH� DQG FOLFN WKH OHIW PRXVH EXWWRQ�

7 &OLFN $SSO\� 7KH REMHFW UHGUDZV ZLWK WKH QHZ KDWFK SDWWHUQ DQG

FRORUV�

7LSV

$V D VKRUWFXW� GRXEOH FOLFN D KDWFK SDWWHUQ LQVWHDG RI FKRRVLQJ WKH SDWWHUQ
DQG WKHQ FOLFNLQJ $SSO\�

<RX FDQ TXLFNO\ FKDQJH WKH IRUHJURXQG DQG EDFNJURXQG FRORUV IRU D KDWFK
ILOO LQ D VHOHFWHG REMHFW ZLWKRXW XVLQJ WKH )LOO�+DWFK GLDORJ ER[� 6HOHFW DQ
REMHFW ZLWK D KDWFK ILOO� FOLFN RQH FRORU LQ WKH SDOHWWH LQ WKH 6W\OH 5LEERQ
WRROEDU� DQG WKHQ SUHVV DQG KROG SHIFT DQG FOLFN DQRWKHU FRORU LQ WKH
SDOHWWH�

7KH EDFNJURXQG FRORU LV RSDTXH E\ GHIDXOW� <RX FDQ PDNH WKH EDFNJURXQG
FRORU WUDQVSDUHQW E\ VHOHFWLQJ WKH %DFNJURXQG 7UDQVSDUHQW RSWLRQ LQ WKH
)LOO�+DWFK GLDORJ ER[�

Changing the Line Thickness and Spacing of Hatch 
Fills

<RX FDQ FKDQJH ERWK WKH OLQH WKLFNQHVV DQG VSDFLQJ RI KDWFK OLQHV�

Line Thickness

7KH GHIDXOW YDOXH IRU KDWFK OLQH WKLFNQHVV LV ����� 6HWWLQJ WKLV YDOXH WR ����

PDNHV WKH OLQHV WZLFH DV KHDY\� VHWWLQJ LW WR ��� PDNHV WKH OLQHV KDOI DV KHDY\�

Line Spacin g

7KH GHIDXOW YDOXH IRU WKH VSDFLQJ EHWZHHQ KDWFK OLQHV LV ���� �QR FKDQJH��

6HWWLQJ WKLV YDOXH WR ���� GRXEOHV WKH VSDFH EHWZHHQ KDWFK OLQHV� VHWWLQJ LW WR

��� FXWV WKH VSDFH EHWZHHQ KDWFK OLQHV LQ KDOI�

To chan ge the line thickness and s pacin g of hatch fills

1 6HOHFW DQ REMHFW�
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2 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

3 &OLFN WKH +DWFK ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ� RU WKH +DWFK

/LQH )LOO EXWWRQ � 7KH )LOO�+DWFK GLDORJ ER[ RSHQV�

4 (QWHU QHZ YDOXHV IRU WKH OLQH WKLFNQHVV DQG VSDFLQJ�

5 &OLFN $SSO\� 7KH REMHFW UHGUDZV ZLWK WKH QHZ OLQH WKLFNQHVV DQG

VSDFLQJ IRU WKH KDWFK SDWWHUQ�
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Using Image Fills

<RX FDQ DGG LPDJH �ELWPDS� SDWWHUQV WR REMHFWV� <RX FDQ FUHDWH DQG VDYH

\RXU RZQ SDWWHUQV ZLWK 3LFWXUH 3XEOLVKHU�

7KH ,QWHULRU )LOO DQG /LQH )LOO PHQXV FRQWDLQ WKH ,PDJH FRPPDQG IRU LPDJH

�ELWPDS� SDWWHUQV� 7KH ,PDJH FRPPDQG SURYLGHV D VHW RI SDWWHUQV

FRPSRVHG RI LQGLYLGXDO SL[HOV �GRWV��

<RX FKRRVH WKH SDWWHUQ IRU D VHOHFWHG REMHFW LQ WKH )LOO�,PDJH GLDORJ ER[�

,I WKH LPDJH ILOO SDWWHUQ LV DOO RQH FRORU �PRQRFKURPH�� \RX FDQ FKDQJH WKH

IRUHJURXQG DQG EDFNJURXQG FRORU� 7R VHW WKH IRUHJURXQG DQG EDFNJURXQG

FRORUV IRU D PRQRFKURPH LPDJH ILOO LQ D VHOHFWHG REMHFW� VHOHFW DQ REMHFW ZLWK

DQ LPDJH ILOO� FOLFN RQH FRORU LQ WKH FRORU SDOHWWH LQ WKH 6W\OH 5LEERQ WRROEDU�

DQG WKHQ SUHVV DQG KROG SHIFT DQG FOLFN DQRWKHU FRORU LQ WKH SDOHWWH� <RX

DOVR FDQ VHOHFW FRORUV IRU WKH IRUHJURXQG DQG EDFNJURXQG FRORU VZDWFKHV LQ

WKH )LOO�,PDJH GLDORJ ER[�

7R VSHHG \RXU ZRUN� WKH ,PDJH VXEPHQX NHHSV WUDFN RI WKH PRVW UHFHQWO\

XVHG LPDJH ILOOV� &KRRVH WKH LPDJH ILOO LQ WKH VXEPHQX DV \RX ZRXOG DQ\ RWKHU

FRPPDQG�

To set the ima ge pattern

1 6HOHFW DQ REMHFW�

2 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

3 &OLFN WKH ,PDJH ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ� RU WKH ,PDJH

/LQH )LOO EXWWRQ �

4 6HOHFW D FDWHJRU\ IURP WKH SXOO�GRZQ OLVW� 7KH )LOO�,PDJH GLDORJ ER[

RSHQV�

5 &OLFN D SDWWHUQ WR VHOHFW LW�
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6 &OLFN $SSO\� 7KH REMHFW UHGUDZV ZLWK WKH QHZ SDWWHUQ�

7LSV

$V D VKRUWFXW� GRXEOH FOLFN DQ LPDJH SDWWHUQ LQVWHDG RI FKRRVLQJ WKH
SDWWHUQ DQG WKHQ FOLFNLQJ $SSO\�

3ORWWHUV DQG PDQ\ ILOP UHFRUGHUV GR QRW VXSSRUW ELWPDS SDWWHUQV RU
RSDTXH EDFNJURXQGV�

Making Image Fills Draw Faster

,I LPDJH ILOOV WDNH WRR PXFK WLPH WR GUDZ RQ \RXU VFUHHQ� \RX FDQ KLGH WKHP

E\ WXUQLQJ LPDJH ILOOV RII LQ WKH GUDZLQJ� 'HVHOHFWLQJ LPDJH ILOOV KDV QR HIIHFW

RQ \RXU GUDZLQJ ZKHQ LW LV SULQWHG�

To make ima ge fills draw faster

` 2Q WKH 9LHZ PHQX� FOLFN ,PDJH )LOOV WR WRJJOH ZKHWKHU LPDJH ILOOV VKRZ LQ

\RXU GUDZLQJ�

Changing the Image Scale

7KH )LOO�,PDJH GLDORJ ER[ LQFOXGHV D VFUROO ER[ WR FKDQJH WKH VFDOH RI WKH

LPDJH�

7KH GHIDXOW YDOXH IRU ,PDJH 6FDOH LV ����� 6HWWLQJ WKLV YDOXH WR ���� PDNHV

WKH LPDJH WZLFH DV ODUJH� VHWWLQJ LW WR ��� PDNH WKH LPDJH KDOI DV ODUJH�

To chan ge the ima ge scale

1 6HOHFW DQ REMHFW�

2 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

3 &OLFN WKH ,PDJH ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ� RU WKH ,PDJH

/LQH )LOO EXWWRQ � 7KH )LOO�,PDJH GLDORJ ER[ RSHQV�
238 i G r a f x  D e s i g n e r



4 (QWHU D YDOXH LQ WKH ,PDJH 6FDOH DUHD WR FKDQJH WKH VL]H RI WKH LPDJH�

5 &OLFN $SSO\� 7KH REMHFW UHGUDZV ZLWK WKH QHZ LPDJH VL]H�

Creating Image Patterns

<RX FDQ FUHDWH \RXU RZQ LPDJH �ELWPDS� SDWWHUQV �VXFK DV D WH[WXUH RU SDUW

RI D SKRWR LPDJH� ZLWK D ELWPDS�HGLWLQJ SURJUDP� DQG SDVWH WKHVH SDWWHUQV

LQWR WKH )LOO�,PDJH GLDORJ ER[�

7LS

<RX FDQ ODXQFK L*UDI[ ,PDJH IURP WKH %LWPDS 5LEERQ�

To add ima ge patterns

1 &UHDWH RU LPSRUW D ELWPDS SDWWHUQ LQ \RXU ELWPDS�HGLWLQJ SURJUDP�

2 2Q WKH (GLW PHQX� FOLFN &RS\ WR FRS\ \RXU SDWWHUQ WR WKH &OLSERDUG�

3 ,Q 'HVLJQHU� FOLFN WKH )RUPDW WRRO LQ WKH WRROER[�

4 &OLFN WKH ,PDJH ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ� RU WKH ,PDJH

/LQH )LOO EXWWRQ � 7KH )LOO�,PDJH GLDORJ ER[ RSHQV�

5 &OLFN 3DVWH� 7KH LPDJH SDWWHUQ \RX FUHDWHG LV DGGHG WR WKH JDOOHU\ RI

SDWWHUQV�

Removing Image Patterns

<RX FDQ UHPRYH LPDJH �ELWPDS� SDWWHUQV \RX FUHDWHG DQG SDVWHG LQWR WKH

)LOO�,PDJH GLDORJ ER[� <RX FDQQRW UHPRYH SDWWHUQV RULJLQDOO\ LQFOXGHG ZLWK

'HVLJQHU�
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To remove ima ge patterns

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH ,PDJH ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ�

RU WKH ,PDJH /LQH )LOO EXWWRQ � 7KH )LOO�,PDJH GLDORJ ER[ RSHQV�

3 &OLFN WKH SDWWHUQ \RX ZDQW WR UHPRYH WR VHOHFW LW�

4 &OLFN 5HPRYH� 7KH LPDJH SDWWHUQ LV UHPRYHG IURP WKH JDOOHU\ RI

SDWWHUQV�

5 &OLFN $SSO\� 7KH VHOHFWHG REMHFW LV ILOOHG ZLWK UHSHWLWLRQV RI WKH REMHFW

FKRVHQ IURP WKH JDOOHU\ LQ WKH GLDORJ ER[�

7LSV

2EMHFW ILOO SDWWHUQV DXWRPDWLFDOO\ LQFUHDVH RU GHFUHDVH LQ VL]H ZKHQ \RX
VFDOH �UHVL]H� WKH ODUJHU REMHFW WKDW FRQWDLQV WKH REMHFW ILOO�

,I WKH REMHFW ILOO SDWWHUQ LV DOO RQH FRORU �PRQRFKURPH�� LWV FRORU LV WKH
IRUHJURXQG FRORU� 7R FKDQJH WKH IRUHJURXQG FRORU� VHOHFW )RUHJURXQG�
SRLQW WR D FRORU LQ WKH SDOHWWH� DQG FOLFN WKH OHIW PRXVH EXWWRQ� 7R FKDQJH
WKH EDFNJURXQG FRORU� VHOHFW %DFNJURXQG� SRLQW WR D FRORU LQ WKH SDOHWWH�
DQG FOLFN WKH OHIW PRXVH EXWWRQ�

<RX FDQ TXLFNO\ FKDQJH WKH IRUHJURXQG DQG EDFNJURXQG FRORUV IRU D
PRQRFKURPH REMHFW ILOO LQ D VHOHFWHG REMHFW ZLWKRXW XVLQJ WKH )LOO�2EMHFW
GLDORJ ER[� 7R FKDQJH WKH IRUHJURXQG FRORU� VHOHFW DQ REMHFW ILOO DQG FOLFN D
FRORU LQ WKH FRORU SDOHWWH LQ WKH 6W\OH 5LEERQ WRROEDU� 7R FKDQJH WKH
EDFNJURXQG FRORU� SUHVV DQG KROG SHIFT DQG FOLFN DQRWKHU FRORU LQ WKH
SDOHWWH�
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Using Object Fills

<RX FDQ ILOO DQ REMHFW ZLWK D SDWWHUQ PDGH RI RWKHU REMHFWV�

<RX FDQ ILOO D FORVHG RU FRQQHFWHG REMHFW ZLWK D UHSHDWLQJ SDWWHUQ RI RWKHU

REMHFWV� 2EMHFW ILOOV GUDZ LQ D JULG SDWWHUQ ZLWKLQ WKH VKDSH RI WKH REMHFW \RX

FKRRVH� H[WHQGLQJ WR WKH ERUGHUV RI WKH REMHFW�

'HVLJQHUjV )LOO � 2EMHFW GLDORJ ER[ KDV D JDOOHU\ RI REMHFW ILOOV IURP ZKLFK WR

FKRRVH� <RX FDQ XVH WKHVH REMHFW ILOOV RU FUHDWH \RXU RZQ�

7R VSHHG \RXU ZRUN� WKH 2EMHFW VXEPHQX NHHSV WUDFN RI WKH PRVW UHFHQWO\

XVHG REMHFW ILOOV� &KRRVH WKH REMHFW ILOO LQ WKH VXEPHQX DV \RX ZRXOG DQ\

RWKHU FRPPDQG�

2EMHFWV ZLWK REMHFW ILOOV FDQ KDYH WZR LQWHULRU FRORUV� RQH IRU WKH ILOO SDWWHUQ

�IRUHJURXQG� DQG RQH IRU WKH EDFNJURXQG� 7KH EDFNJURXQG FRORU LV RSDTXH

E\ GHIDXOW� <RX FDQ PDNH WKH EDFNJURXQG FRORU WUDQVSDUHQW E\ VHOHFWLQJ WKH

%DFNJURXQG 7UDQVSDUHQW RSWLRQ LQ WKH )LOO�2EMHFW GLDORJ ER[�

'HQVH SDWWHUQV VKRZ OHVV RI WKH EDFNJURXQG FRORU� DQG VSDUVH SDWWHUQV VKRZ

PRUH EDFNJURXQG FRORU� %\ H[SHULPHQWLQJ ZLWK GLIIHUHQW SDWWHUQV DQG FRORUV�

\RX FDQ SURGXFH LQWHUHVWLQJ HIIHFWV�

Adding and Removing Object Fills

,I \RX ZDQW WR FUHDWH DQ REMHFW ILOO DQG XVH LW ODWHU� \RX FDQ VDYH LW LQ WKH

JDOOHU\ LQ WKH )LOO�2EMHFW GLDORJ ER[�

To add an ob ject to the galler y

1 'UDZ WKH REMHFW WR EH DGGHG WR WKH JDOOHU\ DQG VHOHFW LW�

2 2Q WKH (GLW PHQX� FOLFN &RS\ WR FRS\ WKH REMHFW WR WKH &OLSERDUG�

3 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

4 &OLFN WKH 2EMHFW ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ� RU WKH 2EMHFW

/LQH )LOO EXWWRQ � 7KH )LOO�2EMHFW GLDORJ ER[ RSHQV�
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5 &OLFN 3DVWH WR SDVWH WKH REMHFW LQWR WKH JDOOHU\�

7LS

<RX DOVR FDQ UHPRYH REMHFWV WKDW \RX KDYH DGGHG WR WKH JDOOHU\ LQ WKH )LOO�
2EMHFW GLDORJ ER[� �<RX FDQQRW UHPRYH DQ\ RI WKH RULJLQDO REMHFW ILOOV WKDW
FRPH ZLWK 'HVLJQHU��

To remove an ob ject from the galler y

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

2 &OLFN WKH 2EMHFW ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ� RU WKH 2EMHFW

/LQH )LOO EXWWRQ � 7KH )LOO�2EMHFW GLDORJ ER[ RSHQV�

3 &OLFN WKH REMHFW ILOO \RX ZDQW WR GHOHWH�

4 &OLFN 5HPRYH� 7KH REMHFW LV GHOHWHG IURP WKH JDOOHU\�

Editing Object Fills

<RX FDQ FUHDWH IDVFLQDWLQJ HIIHFWV E\ FUHDWLQJ \RXU RZQ XQLTXH REMHFW ILOOV�

<RX FDQ FKDQJH WKH DUUDQJHPHQW� IOLS FKDUDFWHULVWLFV� URWDWLRQ� VL]H� DQG

VSDFLQJ RI DQ REMHFW ILOO� <RX FDQ DGG D QHZ REMHFW�ILOO SDWWHUQ RU UHSODFH D

SDWWHUQ \RX SUHYLRXVO\ DGGHG ZLWK D QHZ RQH� <RX FDQ HYHQ XVH PXOWLSOH

REMHFWV RI GLIIHUHQW VKDSHV�

1RWH

<RX FDQQRW UHSODFH DQ\ RI WKH RULJLQDO REMHFW�ILOO SDWWHUQV LQFOXGHG ZLWK
'HVLJQHU�

To edit ob ject fills

1 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�
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2 &OLFN WKH 2EMHFW ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ�

RU WKH 2EMHFW /LQH )LOO EXWWRQ � 7KH )LOO�2EMHFW GLDORJ ER[ RSHQV�

3 6HOHFW WKH SDWWHUQ WKDW \RX ZDQW WR HGLW IURP WKH JDOOHU\�

4 &OLFN (GLW� 7KH (GLW 2EMHFW )LOO GLDORJ ER[ RSHQV�

5 0DNH \RXU HGLWV �DUUDQJHPHQW� IOLS� URWDWH� VL]H� DQG VR IRUWK��

6 &OLFN 2N DQG WKHQ FOLFN $GG RU 5HSODFH WR DGG WKH HGLWHG REMHFW ILOO WR

WKH REMHFW ILOO JDOOHU\�

7LS

<RX FDQ FOLFN 5HSODFH WR UHSODFH D VHOHFWHG REMHFW ILOO LQ WKH JDOOHU\�

Making Object Fills Draw Faster

,I REMHFW ILOOV WDNH WRR PXFK WLPH WR GUDZ RQ \RXU VFUHHQ� \RX FDQ KLGH WKHP

E\ WXUQLQJ REMHFW ILOOV RII LQ WKH GUDZLQJ� 'HVHOHFWLQJ REMHFW ILOOV KDV QR HIIHFW

RQ \RXU GUDZLQJ ZKHQ LW LV SULQWHG�

To make ob ject fills draw faster

` 2Q WKH 9LHZ PHQX� FOLFN 6KRZ 2EMHFW )LOOV WR WRJJOH ZKHWKHU REMHFW ILOOV

VKRZ LQ \RXU GUDZLQJ�

To fill an ob ject with other ob jects

1 6HOHFW WKH REMHFW \RX ZDQW WR ILOO�

2 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[�

3 &OLFN WKH 2EMHFW ,QWHULRU )LOO EXWWRQ LQ WKH ULEERQ� RU WKH 2EMHFW

/LQH )LOO EXWWRQ �

4 6HOHFW WKH FDWHJRU\ IURP WKH SXOO�GRZQ OLVW� 7KH )LOO�2EMHFW GLDORJ ER[

RSHQV�
U s i n g  L i n e s ,  F i l l s ,  a n d  P a t t e r n s  243



5 &OLFN WKH REMHFW \RX ZDQW WR XVH IRU WKH ILOO�

Arranging Object Fills

<RX FDQ &HQWHU DQ REMHFW� 7LOH �UHSHDW� E\ 5RZ� RU 7LOH �UHSHDW� E\ &ROXPQ�

<RX PXVW FKRRVH RQH RI WKH WLOLQJ RSWLRQV WR XVH PDQ\ RI WKH RWKHU IHDWXUHV

LQ WKH (GLW 2EMHFW )LOO GLDORJ ER[� <RX PXVW FKRRVH D )OLS RSWLRQ RU FKDQJH

WKH YDOXH IRU 6WDJJHU � WR VHH D GLIIHUHQFH EHWZHHQ 7LOH E\ 5RZ DQG 7LOH E\

&ROXPQ�

Rotating Object Fills

6HOHFWLQJ WKH 3DWWHUQ RSWLRQ URWDWHV WKH ZKROH REMHFW�ILOO SDWWHUQ� VHOHFWLQJ

2EMHFW URWDWHV HDFK LQGLYLGXDO REMHFW�

7KH $QJOH YDOXH VHWV WKH DQJOH RI URWDWLRQ� <RX FDQ HLWKHU HQWHU D YDOXH LQ

GHJUHHV GLUHFWO\ RU GUDJ WKH UHG QHHGOH LQ WKH GLDO FRQWURO�

1RWH

<RX FDQ XVH D ELWPDS LQ DQ REMHFW ILOO� EXW LW FDQQRW EH URWDWHG�

Scaling and Positioning Object Fills

<RX FDQ FKDQJH WKH VL]H RI WKH REMHFW E\ FKDQJLQJ WKH YDOXH RI :LGWK � DQG

+HLJKW �� 7KH GHIDXOW YDOXHV DUH ����� ZKLFK LV WKH RULJLQDO VL]H� &KDQJLQJ

ERWK WKHVH YDOXHV WR ��� PDNHV WKH REMHFW KDOI WKH RULJLQDO VL]H� FKDQJLQJ WKH

YDOXHV WR ���� PDNHV WKH REMHFW WZLFH WKH RULJLQDO VL]H� 7R VFDOH WKH REMHFW

SURSRUWLRQDOO\� FKDQJH :LGWK � DQG +HLJKW � WKH VDPH DPRXQW�
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<RX FDQ DGMXVW WKH VSDFLQJ RI WLOHG REMHFWV E\ FKDQJLQJ WKH YDOXHV IRU ;

6SDFLQJ � �KHLJKW� DQG < 6SDFLQJ � �ZLGWK�� (QWHULQJ D QHJDWLYH YDOXH FDXVHV

REMHFWV WR RYHUODS� HQWHULQJ D SRVLWLYH YDOXH FUHDWHV VSDFH EHWZHHQ REMHFWV� $

YDOXH RI ]HUR PDNHV WKH ERXQGLQJ ER[HV RI WKH REMHFWV IOXVK ZLWK RQH

DQRWKHU�

<RX FDQ SDQ WKH HQWLUH REMHFW ILOO SDWWHUQ ZLWKLQ WKH ODUJHU REMHFW E\ DGMXVWLQJ

WKH YDOXHV IRU ; 6KLIW � �KHLJKW� DQG < 6KLIW � �ZLGWK�� 7KHVH YDOXHV OHW \RX

FRQWURO KRZ WKH ILOO SDWWHUQ ORRNV DW WKH HGJHV RI WKH ODUJHU REMHFW�

$GMXVWLQJ WKH 6WDJJHU � OHWV \RX VWDJJHU WKH SRVLWLRQ RI HYHU\ RWKHU URZ RU

FROXPQ� )RU H[DPSOH� WR LOOXVWUDWH D EULFN ZDOO� \RX PLJKW VHW WKH 6WDJJHU � WR

���

Flipping Object Fills

7R IOLS REMHFWV� \RX PXVW VHOHFW HLWKHU $ERXW ; �YHUWLFDO� RU $ERXW <

�KRUL]RQWDO�� 7KLV VSHFLILHV WKH FRRUGLQDWH D[LV DERXW ZKLFK WKH REMHFWV DUH

IOLSSHG�
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Masking Objects

<RX FDQ PDVN DQ REMHFW WR WKH VKDSH RI DQ\ RWKHU REMHFW�

<RX FDQ SDVWH DQ REMHFW RU ELWPDS LQWR DQRWKHU FORVHG RU FRQQHFWHG REMHFW

LQ 'HVLJQHU� 7KH REMHFW \RX SDVWH LV PDVNHG E\ WKH RWKHU VKDSH� ,Q WKH

H[DPSOH EHORZ� D GUDZLQJ LV PDVNHG E\ WH[W WKDW KDV EHHQ FRQYHUWHG WR

FXUYHV DQG FRQQHFWHG FORVHG�

To mask an ob ject

1 6HOHFW DQ REMHFW WKDW \RX ZDQW WR PDVN�

2 2Q WKH (GLW PHQX� FOLFN &RS\ WR FRS\ WKH REMHFW WR WKH &OLSERDUG�

3 6HOHFW DQ REMHFW WKDW \RX ZDQW WR XVH DV D PDVN RXWOLQH�

4 2Q WKH (IIHFWV PHQX� VHOHFW 0DVNLQJ DQG WKHQ FOLFN 3DVWH ,QVLGH� $ EOXH

HGLW ERUGHU DSSHDUV DURXQG WKH PDVN�RXWOLQH REMHFW�

5 3UHVV DQG KROG WKH OHIW PRXVH EXWWRQ XQWLO DQ RXWOLQH RI WKH REMHFW WR

EH SDVWHG LQVLGH DSSHDUV�

6 3RVLWLRQ WKH REMHFW DQG UHOHDVH WKH PRXVH EXWWRQ� $ FRS\ RI WKH ILUVW

REMHFW LV SDVWHG LQVLGH WKH VHFRQG RQH�
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Filling Several Objects with a Continuous Fill

<RX FDQ FUHDWH D FRQWLQXRXV ILOO DFURVV VHYHUDO REMHFWV WKDW GR QRW WRXFK� $OO

W\SHV RI ILOOV FDQ VSDQ REMHFWV� EXW JUDGLHQWV� REMHFW ILOOV� DQG PDVNHG REMHFWV

DUH WKH PRVW LQWHUHVWLQJ�

Not connected

Connected

:KHQ \RX FRQQHFW REMHFWV ZLWK WKH &RQQHFW &ORVHG FRPPDQG� WKH REMHFWV

ILOO ZLWK WKH FXUUHQW FRORU DQG SDWWHUQ� ,I \RX ILOO D VHW RI FRQQHFWHG REMHFWV

ZLWK D JUDGLHQW� PDVNHG REMHFW� RU REMHFW ILOO� WKH ILOO VSDQV WKH VHW RI

FRQQHFWHG REMHFWV� HYHQ LI WKH FRPSRQHQW REMHFWV RI WKH RYHUDOO FRQQHFWHG

REMHFW GR QRW WRXFK� 7KH H[DPSOH DERYH VKRZV FRQQHFWHG REMHFWV ILOOHG ZLWK

D VLQJOH GLDJRQDO JUDGLHQW�
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Using the Style Toolbar

)URP WKH 6W\OH WRROEDU� \RX FDQ DGG� PRGLI\� LPSRUW� DQG DSSO\ VW\OHV� $ VW\OH

FRQVLVWV RI DQ\ RU DOO RI WKH IROOZLQJ DWWULEXWHV�

v %RWK LQWHULRU DQG OLQH ILOO

v )LOOV �VROLG� LPDJH� JUDGLHQW� KDWFK� DQG REMHFW�

v /LQH WKLFNQHVV� FDS DQG MRLQ RSWLRQV� DQG FDOOLJUDSKLF OLQHV

v /LQH HQGV DQG OLQH VW\OH

v 7H[W DWWULEXWHV

To apply a st yle

1 2Q WKH 6W\OH WRROEDU� VHOHFW D VW\OH IURP WKH GURS OLVW�

2 6HOHFW RQH RU PRUH REMHFWV�

3 &OLFN WKH $SSO\ 6W\OH EXWWRQ RQ WKH 6W\OH WRROEDU� 7KH VW\OH

DWWULEXWHV DUH DSSOLHG WR WKH VHOHFWHG REMHFW�V��

1RWH

<RX FDQ VHOHFW HLWKHU WKH VW\OH RU WKH REMHFW ILUVW�

To modif y a st yle

1 2Q WKH 6W\OH WRROEDU� FOLFN WKH 0RGLI\ 6W\OH EXWWRQ � 7KH 6W\OH

GLDORJ GLVSOD\V�

2 2Q WKH 6W\OH GLDORJ� FOLFN FRUUHVSRQGLQJ EXWWRQ IRU WKH DWWULEXWH \RX

ZDQW WR PRGLI\� 7KH 2EMHFW )RUPDW GLDORJ GLVSOD\V�

3 0DNH WKH PRGLILFDWLRQV DQG FOLFN 2. WR VDYH�

4 &OLFN $SSO\ DQG WKHQ FOLFN 2.� 7KH VW\OH LV PRGLILHG�
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To add a st yle

1 2Q WKH 6W\OH WRROEDU� FOLFN WKH $GG 6W\OH EXWWRQ � 7KH 6W\OH GLDORJ

GLVSOD\V�

2 ,Q WKH 6W\OH /LVW� HQWHU D QDPH IRU WKH QHZ VW\OH DQG SUHVV (QWHU� 7KH

)LOO� /LQH� DQG 7H[W 6W\OH EXWWRQV EHFRPH DFWLYH�

3 8VLQJ WKH )LOO� /LQH� DQG 7H[W 6W\OH EXWWRQV� FUHDWH WKH QHZ VW\OH�

4 &OLFN 2.� 7KH QHZ VW\OH QRZ DSSHDUV LQ WKH VW\OH GURS OLVW�

To im port a st yle

1 2Q WKH 6W\OH WRROEDU� FOLFN WKH 6W\OH 2SWLRQV EXWWRQ � 7KH 6W\OH

GLDORJ GLVSOD\V�

2 &OLFN WKH ,PSRUW EXWWRQ� 7KH ,PSRUW 6W\OHV GLDORJ GLVSOD\V�

3 &OLFN WKH 2SHQ )LOH EXWWRQ� 7KH 2SHQ GLDORJ GLVSOD\V� 6HOHFW WKH ILOH

\RX ZDQW WR LPSRUW DQG FOLFN WKH 2SHQ EXWWRQ�

4 7KH VW\OH LVLPSRUWHG DQG DYDLODEOH IRU VHOHFWLRQ�
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Reusing Style Attributes

Copying and Applying Styles

$Q\ RI WKH IROORZLQJ VW\OH DWWULEXWHV� RQFH DSSOLHG WR DQ REMHFW� FDQ EH

UHDSSOLHG WR RWKHU REMHFWV�

v %RWK LQWHULRU DQG OLQH ILOO

v )LOOV �VROLG� LPDJH� JUDGLHQW� KDWFK� DQG REMHFW�

v /LQH WKLFNQHVV� FDS DQG MRLQ RSWLRQV� DQG FDOOLJUDSKLF OLQHV

v /LQH HQGV DQG OLQH VW\OH

,I \RX VSHQG WLPH DSSO\LQJ VHYHUDO VW\OH DWWULEXWHV WR D VLQJOH REMHFW� \RX PD\

ZDQW WR DSSO\ DOO RI WKH VDPH VW\OHV WR RWKHU REMHFWV DOO DW RQFH� 7R GR WKLV�

\RX FDQ XVH WKH &RS\ 6W\OH DQG $SSO\ 6W\OH FRPPDQGV�

To co py st yle attributes from one ob ject to another

1 6HOHFW DQ REMHFW ZLWK WKH VW\OH DWWULEXWHV \RX ZDQW WR FRS\�

2 2Q WKH )RUPDW PHQX� FOLFN 3LFN 8S 2EMHFW 6W\OH�

3 6HOHFW WKH REMHFW WR ZKLFK \RX ZDQW WR DSSO\ WKH VW\OH DWWULEXWHV�

4 2Q WKH )RUPDW PHQX� FOLFN $SSO\ 2EMHFW 6W\OH� 7KH VW\OH DWWULEXWHV DUH

FRSLHG IURP WKH ILUVW REMHFW DQG DSSOLHG WR WKH VHFRQG REMHFW�

1RWH

,I PRUH WKDQ RQH REMHFW LV VHOHFWHG DQG WKH REMHFWV KDYH GLIIHUHQW VW\OH
DWWULEXWHV� WKH 3LFNXS 2EMHFW 6W\OH FRPPDQG LV QRW DYDLODEOH�

Setting Default Styles

:KHQ \RX VHW D QHZ GHIDXOW ILOO RU FRORU� WKH QH[W REMHFW \RX GUDZ ZLOO KDYH

WKHVH VW\OH DWWULEXWHV� 'HVLJQHU JLYHV \RX VHYHUDO ZD\V WR VHW GHIDXOW VW\OHV�
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2QH ZD\ WR VHW D QHZ GHIDXOW ILOO RU OLQH VW\OH LV WR GHVHOHFW DOO REMHFWV DQG

WKHQ FKRRVH DQ\ ILOO SDWWHUQ RU OLQH VW\OH IURP WKH )LOO GLDORJ ER[� /LQH GLDORJ

ER[� RU WKH )RUPDW 5LEERQ� 7KH GHIDXOW ILOOV DQG VW\OHV IRU LQWHULRU DQG OLQH DUH

VKRZQ LQ WKH VWDWXV EDU �LI GLVSOD\HG��

7LS

,I \RX ZDQW WR VHW QHZ GHIDXOW VW\OHV EDVHG RQ DQ H[LVWLQJ REMHFW� MXVW VHOHFW
WKH REMHFW DQG FOLFN 6HW 'HIDXOW 6W\OH RQ WKH )RUPDW PHQX� $OO RI WKH VW\OH
DWWULEXWHV RI WKH VHOHFWHG REMHFW� LQFOXGLQJ LQWHULRU ILOOV� OLQH ILOOV� DQG OLQH
VW\OHV� EHFRPH WKH QHZ GHIDXOWV�
U s i n g  L i n e s ,  F i l l s ,  a n d  P a t t e r n s  251



252 i G r a f x  D e s i g n e r



U s i n g  L i n e s ,  F i l l s ,  a n d  P a t t e r n s  253



254 i G r a f x  D e s i g n e r



U s i n g  L i n e s ,  F i l l s ,  a n d  P a t t e r n s  255



256 i G r a f x  D e s i g n e r



U s i n g  L i n e s ,  F i l l s ,  a n d  P a t t e r n s  257



258 i G r a f x  D e s i g n e r



Using Text
'HVLJQHU
V WH[W IHDWXUHV DUH HDV\ WR XVH DQG JLYH \RX D KLJK GHJUHH RI

IOH[LELOLW\� )RU H[DPSOH� \RX FDQ GHVLJQ EURFKXUHV� ORJRV� FKDUWV� VOLGHV�

SRVWHUV� WHFKQLFDO LOOXVWUDWLRQV� VFDOH GUDZLQJV� SURGXFW VSHFV� VFKHPDWLFV�

EOXHSULQWV� DQG HYHQ QHZVOHWWHUV ZLWK 'HVLJQHU�

Installing Fonts

'HVLJQHU UHFRJQL]HV IRQWV WKDW DUH ORDGHG ZLWK WKH L*UDI[ LQVWDOOHU� IRQWV

LQVWDOOHG ZLWK $GREH 7\SH 0DQDJHU� DQG 7UXH7\SH IRQWV LQVWDOOHG ZLWK WKH

:LQGRZV &RQWURO 3DQHO�

,Q DGGLWLRQ WR EHLQJ XVHG E\ 'HVLJQHU� WKH IRQWV \RX DGG ZLWK DQ\ RI WKHVH

PHWKRGV DUH XVHG E\ RWKHU :LQGRZV DSSOLFDWLRQV VXFK DV 0LFURVRIW :RUG

DQG :RUGSDG�

$GGLQJ PDQ\ IRQWV JLYHV \RX PRUH FKRLFHV� EXW D ODUJH QXPEHU RI IRQWV XVHV

PRUH PHPRU\ DQG LQFUHDVHV WKH WLPH QHHGHG WR ORDG 'HVLJQHU DQG RWKHU

:LQGRZV SURJUDPV�

Selecting Fonts, Sizes, and Styles

<RX FDQ VSHFLI\ W\SH FKDUDFWHULVWLFV EHIRUH \RX HQWHU WH[W� RU \RX FDQ

FKDQJH WKHP IRU H[LVWLQJ WH[W� $ WH[W REMHFW FDQ FRQWDLQ DQ\ FRPELQDWLRQ RI

IRQWV� IRQW VL]HV� DQG VW\OHV�

<RX FDQ VHOHFW IRQWV� IRQW VL]HV� DQG VW\OHV ZLWK WKH 7H[W ULEERQ� WKH 7H[W

GLDORJ ER[� RU WKH VKRUWFXW PHQX�
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Fonts

7KH DYDLODEOH IRQWV DUH OLVWHG LQ WKH )RQW /LVW ER[� 7KH LFRQ SUHFHGLQJ WKH IRQW

QDPH GHVFULEHV WKH W\SH RI IRQW�

1RWHV

,I D EOXH TXHVWLRQ PDUN LFRQ DSSHDUV� LW LQGLFDWHV WKDW VHOHFWHG WH[W VDYHG LQ
WKH GRFXPHQW LV LQ D IRQW WKDW LV QRW FXUUHQWO\ LQVWDOOHG RQ \RXU FRPSXWHU�

7R ORFDWH D IRQW LQ WKH )RQW OLVW ER[ TXLFNO\� RSHQ WKH OLVW ER[ DQG W\SH WKH
ILUVW OHWWHU RI WKH IRQW QDPH�

Font Sizes

<RX VHOHFW WKH VL]H RI WKH IRQW LQ WKH )RQW 6L]H OLVW ER[� <RX FDQ VHOHFW D VL]H

IURP � WR ����� SRLQWV E\ FOLFNLQJ WKH DUURZV EHVLGH WKH ER[� RU \RX FDQ W\SH

D FXVWRP VL]H ������ IRU H[DPSOH��

,FRQ 7\SH RI IRQW

7UXH7\SH IRQW

$GREH 7\SH � IRQW

3ULQWHU �GHYLFH� IRQW
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<RX DOVR FDQ UHVL]H D VHOHFWHG WH[W REMHFW XVLQJ WKH FRUQHU KDQGOHV� RU VWUHWFK

LW ZLWK WKH PLGGOH RU VLGH KDQGOHV� 7KH QHZ VL]H DSSHDUV LQ WKH )RQW 6L]H OLVW

ER[�

7LS

<RX FDQ DOVR FOLFN WKH )RQW 5HFDOO EXWWRQ DQG VHOHFW RQH RI WKH ODVW WHQ
IRQWV XVHG�

Font Styles

7KH IROORZLQJ VW\OHV DUH DYDLODEOH LQ 'HVLJQHU�

To apply text attributes with the Text ribbon

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 6HOHFW WKH WH[W REMHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

3 &OLFN WKH DWWULEXWH LQ WKH 7H[W ULEERQ WKDW \RX ZDQW WR DSSO\� 7KH

FKDQJHV DUH PDGH WR WKH VHOHFWHG WH[W�

7LS

<RX FDQ XVH NH\ERDUG VKRUWFXWV IRU DSSO\LQJ DWWULEXWHV WR VHOHFWHG DQG
KLJKOLJKWHG WH[W� 3UHVV WKH NH\ERDUG VKRUWFXW RQFH WR DSSO\ WKH VW\OH� 3UHVV
LW DJDLQ WR UHPRYH WKH VW\OH�

Tempus Tempus
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To select text attributes with the Text dialo g box

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 6HOHFW WKH WH[W REMHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

3 &OLFN WKH 7H[W $WWULEXWHV EXWWRQ LQ WKH 7H[W ULEERQ� 7KH 7H[W GLDORJ

ER[ RSHQV�

4 &OLFN WKH )RQWV EXWWRQ WR GLVSOD\ WKH )RQWV SDQHO� LI QHFHVVDU\�

5 &KRRVH WKH DWWULEXWHV \RX ZDQW WR DSSO\ DQG FOLFN $SSO\� 7KH FKDQJHV

DUH PDGH WR WKH VHOHFWHG WH[W�

7LSV

3UHVV CTRL+SHIFT+T WR RSHQ WKH 7H[W GLDORJ ER[ TXLFNO\�

<RX GR QRW QHHG WR FORVH WKH GLDORJ ER[ WR DSSO\ WKH FKDQJHV�

To apply a defined st yle to text

1 +LJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

2 &OLFN WKH ULJKW PRXVH EXWWRQ� $ VKRUWFXW PHQX RSHQV�

3 &KRRVH WKH GHVLUHG VW\OH IURP WKH PHQX�

$FWLRQ .H\ERDUG VKRUWFXW

%ROG CTRL+B

,WDOLF CTRL+I

8QGHUOLQH CTRL+U

6PDOO &DSV CTRL+M

6XSHUVFULSW CTRL+K

6XEVFULSW CTRL+SHIFT+K
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To apply a text attribute usin g the shortcut menu

1 6HOHFW WKH WH[W REMHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

2 &OLFN WKH ULJKW PRXVH EXWWRQ� 7KH VKRUWFXW PHQX DSSHDUV�

3 &KRRVH WKH DWWULEXWH \RX ZDQW WR DSSO\ RQ WKH VKRUWFXW PHQX� 7KH

FKDQJHV DUH PDGH WR WKH VHOHFWHG WH[W�

To chan ge text line and interior color

1 6HOHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

2 3RLQW WR D FRORU LQ WKH &RORU 3DOHWWH DQG FOLFN WKH OHIW PRXVH EXWWRQ WR

FKDQJH WKH LQWHULRU FRORU�

3 3RLQW WR D FRORU LQ WKH &RORU 3DOHWWH DQG FOLFN WKH ULJKW PRXVH EXWWRQ

WR FKDQJH WKH OLQH FRORU�

7LS

7R VHW D FRORU WR LQYLVLEOH RU XQILOOHG� FOLFN WKH ; LQ WKH &RORU 3DOHWWH
WRROEDU�

1RWH

<RX FDQ XVH WKH )RQWV SDQHO RI WKH 7H[W GLDORJ ER[ WR VHW WKH WH[W
IRUHJURXQG FRORU �ILOO FRORU� DQG EDFNJURXQG FRORU �FRORU RXWVLGH WKH WH[W
LWVHOI� RI D VHOHFWHG WH[W REMHFW� EXW QRW RI WH[W \RX KDYH KLJKOLJKWHG�

To chan ge text back ground color

1 6HOHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

2 &OLFN WKH )RUPDW WRRO�

3 &OLFN WKH %DFNJURXQG &RORU EXWWRQ� $ SDOHWWH GLVSOD\V�

4 3RLQW WR D FRORU LQ WKH SDOHWWH DQG FOLFN WKH OHIW PRXVH EXWWRQ�
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5 &OLFN $SSO\�

7LS

<RX GR QRW QHHG WR FORVH WKH GLDORJ ER[ WR DSSO\ WKH FKDQJHV�
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Using Freeform Text and Block Text

7KHUH DUH WZR W\SHV RI WH[W LQ 'HVLJQHU� IUHHIRUP WH[W DQG EORFN WH[W�

)UHHIRUP DQG EORFN WH[W OHW \RX FUHDWH WH[W REMHFWV �DQ\ REMHFW FRPSRVHG RI

WH[W� LQ VOLJKWO\ GLIIHUHQW ZD\V� %ORFN WH[W LV FUHDWHG LQVLGH D FRQWDLQHU� ZKLOH

IUHHIRUP WH[W KDV QR FRQWDLQHU�

Adding Freeform Text

8VH IUHHIRUP WH[W ZKHQ \RX ZDQW WR FUHDWH WLWOHV� VKRUW VHQWHQFHV� RU ODEHOV�

IRU H[DPSOH� 7R FUHDWH IUHHIRUP WH[W� FOLFN WKH 7H[W WRRO� FOLFN WKH 7H[W 0RGH

EXWWRQ �LI QHFHVVDU\ WR GLVSOD\ WKH WH[W SRLQWHU�� FOLFN LQ WKH GUDZLQJ DUHD WR

LQVHUW WKH WH[W FXUVRU� DQG W\SH WKH WH[W�

)UHHIRUP WH[W FDQQRW IORZ IURP RQH WH[W REMHFW WR DQRWKHU� QRU GRHV LW XVH

PDUJLQV� �ZRUG ZUDS�� RU LQGHQWV� 5HVL]LQJ D IUHHIRUP WH[W REMHFW FKDQJHV WKH

VL]H RI WKH WH[W� <RX FDQQRW ZUDS IUHHIRUP WH[W DURXQG DQ REMHFW �UHSHO

WH[W��

To add freeform text

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 7H[W 0RGH EXWWRQ WR GLVSOD\ WKH WH[W SRLQWHU� LI QHFHVVDU\�

3 3RLQW ZKHUH \RX ZDQW WKH WH[W WR EHJLQ� &OLFN WKH OHIW PRXVH EXWWRQ WR

GLVSOD\ WKH WH[W FXUVRU�

4 7\SH WKH WH[W� ,I \RX PDNH D PLVWDNH� SUHVV BACKSPACE WR HUDVH LW�

5 3UHVV ESC RU GRXEOH FOLFN WKH OHIW PRXVH EXWWRQ DZD\ IURP WKH WH[W

ZKHQ \RX ILQLVK HQWHULQJ WKH WH[W�
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Adding Block Text

%ORFN WH[W LV XVHIXO ZKHQ \RX ZDQW WR FUHDWH ODUJH EORFNV RI WH[W� 7R FUHDWH

EORFN WH[W� FOLFN WKH 7H[W WRRO� FOLFN WKH 7H[W 0RGH EXWWRQ �LI QHFHVVDU\ WR

GLVSOD\ WKH WH[W SRLQWHU�� GUDZ D ER[ WR FRQWDLQ WKH WH[W� DQG W\SH WKH WH[W�

<RX FDQ FRQQHFW WH[W EORFNV VR WKDW WKH WH[W IORZV IURP RQH FRQWDLQHU WR

DQRWKHU� DQG \RX FDQ DVVLJQ PDUJLQV� 5HVL]LQJ EORFN WH[W FKDQJHV WKH VL]H RI

WKH FRQWDLQHU� EXW QRW WKH WH[W�

<RX DGG EORFN WH[W E\ FUHDWLQJ D FRQWDLQHU DQG W\SLQJ WH[W LQVLGH LW� ,I \RX DGG

PRUH WH[W WKDQ FDQ ILW LQ WKH WH[W FRQWDLQHU� LW H[WHQGV EHORZ WKH ER[ DQG LV

LQYLVLEOH� (QODUJH WKH FRQWDLQHU RU IORZ WKH H[WUD WH[W WR DQRWKHU FRQWDLQHU WR

VHH LW� 6HH )ORZLQJ 7H[W)ORZLQJ 7H[W IRU PRUH LQIRUPDWLRQ�

<RX FDQ HQWHU RU HGLW WH[W RQO\ ZKHQ WKH WH[W FXUVRU LV YLVLEOH� $OO WH[W LV

HQWHUHG LQ WKH GUDZLQJ DUHD� =RRP LQ WR YLHZ DQG HGLW WKH FKDUDFWHUV� LI

QHFHVVDU\ �RU XVH WKH (GLW 7H[W ZLQGRZ DV GHVFULEHG LQ (GLWLQJ 7H[W(GLWLQJ

7H[W�
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7KH DSSHDUDQFH RI WKH WH[W GHSHQGV RQ WKH IRQW� VL]H� DQG VW\OH VHWWLQJV� 7R

VHW QHZ GHIDXOWV IRU WH[W DWWULEXWHV� GHVHOHFW DOO REMHFWV DQG WKHQ FKRRVH WKH

GHVLUHG IRQW� VL]H� VW\OH� DQG VR RQ�

To add a text block

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 7H[W 0RGH EXWWRQ WR GLVSOD\ WKH WH[W SRLQWHU� LI QHFHVVDU\�

3 3RLQW ZKHUH \RX ZDQW WKH WH[W WR EHJLQ�

4 3UHVV DQG KROG WKH OHIW PRXVH EXWWRQ� DQG GUDJ WKH SRLQWHU WR FUHDWH D

ER[ ZLWK GDVKHG OLQHV� 7KH ER[ LV WKH WH[W FRQWDLQHU�

5 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK WKH ER[� 7KH WH[W FXUVRU

DSSHDUV LQVLGH WKH FRQWDLQHU�

6 7\SH WKH WH[W�

7 3UHVV ESC ZKHQ \RX ILQLVK HQWHULQJ WKH WH[W�

Converting between Block and Freeform Text

<RX FDQ XVH WKH &OLSERDUG WR FRQYHUW EORFN WH[W WR IUHHIRUP WH[W DQG

IUHHIRUP WH[W WR EORFN WH[W� (DFK SDUDJUDSK RI EORFN WH[W FRQYHUWV WR D VLQJOH

OLQH RI IUHHIRUP WH[W�
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To convert between block text and freeform text

1 +LJKOLJKW WKH WH[W \RX ZDQW WR FRQYHUW�

2 2Q WKH (GLW PHQX� FOLFN &RS\ �RU &XW� WR SODFH WKH WH[W RQ WKH

&OLSERDUG�

3 'RXEOH FOLFN DQ\ZKHUH RXWVLGH WKH WH[W DUHD WR GHVHOHFW DOO WH[W�

4 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

5 0RYH WKH WH[W SRLQWHU ZKHUH \RX ZDQW WR SODFH WKH IUHHIRUP WH[W� DQG

FOLFN WKH OHIW PRXVH EXWWRQ WR SODFH WKH WH[W FXUVRU�

6 2Q WKH (GLW PHQX� FOLFN 3DVWH� 7KH WH[W DSSHDUV LQ WKH QHZ IRUPDW�

7 3UHVV ESC ZKHQ \RX ILQLVK HGLWLQJ�

7LS

,Q VWHS �� \RX FDQ GUDZ D FRQWDLQHU WR FRQWDLQ WKH WH[W� 3UHVV DQG KROG WKH
OHIW PRXVH EXWWRQ� DQG GUDJ D FRQWDLQHU LQ ZKLFK WR SODFH EORFN WH[W�
5HOHDVH WKH PRXVH EXWWRQ�
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Editing Text

HT_Editin g_Text_in_a_W indow

7KH (GLW 7H[W ZLQGRZ SURYLGHV D PHWKRG RI HGLWLQJ WH[W WKDW FDQ EH TXLFNHU

DQG PRUH FRQYHQLHQW WKDQ HGLWLQJ WH[W LQ WKH GUDZLQJ DUHD� 7KH (GLW 7H[W

ZLQGRZ PDNHV LW HDV\ WR HGLW WH[W WR ZKLFK \RX KDYH DSSOLHG JUDSKLF HIIHFWV

VXFK DV ZDUSLQJ� EHFDXVH LW GLVSOD\V WKH WH[W ZLWKRXW WKRVH HIIHFWV� <RX FDQ

DOVR XVH WKH (GLW 7H[W ZLQGRZ WR HGLW WH[W WKDW LV WRR VPDOO WR YLHZ ZLWKRXW

]RRPLQJ LQ�

7KH (GLW 7H[W ZLQGRZ VKRZV DQG OHWV \RX DSSO\ VW\OH DWWULEXWHV VXFK DV EROG

DQG LWDOLF�

<RX FDQ HGLW ERWK IUHHIRUP DQG EORFN WH[W LQ WKH (GLW 7H[W ZLQGRZ� 7R RSHQ

WKH (GLW 7H[W ZLQGRZ IRU DOO WH[W H[FHSW ZDUSHG WH[W� SUHVV DQG KROG SHIFT

DQG FOLFN WKH WH[W ZLWK WKH WH[W SRLQWHU� 7R RSHQ WKH (GLW 7H[W ZLQGRZ IRU

ZDUSHG WH[W� MXVW FOLFN WKH WH[W ZLWK WKH WH[W SRLQWHU �ZLWKRXW SUHVVLQJ SHIFT��

HT_Editing_Text_in_a_Window
7R HGLW WH[W

7R DSSO\ D GHILQHG VW\OH WR WH[W
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To edit text

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 7H[W 0RGH EXWWRQ WR GLVSOD\ WKH WH[W SRLQWHU� LI QHFHVVDU\�

3 3RLQW WR WKH WH[W ZLWK WKH WH[W SRLQWHU�

4 3UHVV DQG KROG SHIFT� DQG FOLFN ZLWK WKH OHIW PRXVH EXWWRQ� 7KH (GLW

7H[W ZLQGRZ RSHQV�

5 (GLW WKH WH[W LQ WKH ZLQGRZ�

7LS

,I WKH WH[W FXUVRU LV SRVLWLRQHG ZLWKLQ WH[W� SUHVV ESC EHIRUH IROORZLQJ WKH
SURFHGXUH JLYHQ DERYH�

RT_To_open_the_Edit_Text_window
RT_To_open_the_Edit_Text_window
7R DSSO\ D GHILQHG VW\OH WR WH[W

To paste text as freeform text

1 &RS\ WKH WH[W \RX ZDQW LQ DQRWKHU SURJUDP�

2 &KDQJH WR 'HVLJQHU�

3 3UHVV CTRL+V WR SDVWH WKH WH[W LQWR 'HVLJQHU

4 3UHVV ESC ZKHQ \RX ILQLVK HGLWLQJ WKH WH[W�

RT_To_im por t_text_from_a_text_file
RT_To_import_text_from_a_text_file
7R DSSO\ D GHILQHG VW\OH WR WH[W

,PSRUWLQJ 7H[W

To paste text as block text

1 &RS\ WKH WH[W \RX ZDQW LQ DQRWKHU SURJUDP�

2 &KDQJH WR 'HVLJQHU�
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3 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

4 &OLFN WKH 7H[W 0RGH EXWWRQ WR GLVSOD\ WKH WH[W SRLQWHU� LI QHFHVVDU\�

5 3RLQW ZKHUH \RX ZDQW WKH WH[W WR EHJLQ�

6 3UHVV DQG KROG WKH OHIW PRXVH EXWWRQ� DQG GUDJ WKH SRLQWHU WR FUHDWH D

ER[ ZLWK GDVKHG OLQHV� 7KH ER[ LV WKH WH[W FRQWDLQHU�

7 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK WKH ER[� 7KH WH[W FXUVRU

DSSHDUV LQVLGH WKH FRQWDLQHU�

8 3UHVV CTRL+V WR SDVWH WKH WH[W LQWR 'HVLJQHU

9 3UHVV ESC ZKHQ \RX ILQLVK HGLWLQJ WKH WH[W�

RT_To_im por t_text_from_a_text_file
RT_To_import_text_from_a_text_file
7R DSSO\ WH[W DWWULEXWHV ZLWK WKH 7H[W ULEERQ

7R DSSO\ D GHILQHG VW\OH WR WH[W

,PSRUWLQJ 7H[W

3DVWLQJ 7H[W LQVLGH DQ 2EMHFW

To paste text inside an ob ject

<RX FDQ SDVWH WH[W LQVLGH D FRQWDLQHU WKDW PDWFKHV D FORVHG REMHFW
V RXWOLQH�
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1 &RS\ RU FXW WH[W WR WKH &OLSERDUG�

2 6HOHFW D FORVHG REMHFW�

3 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

4 &OLFN WKH 6KDSH 7H[W EXWWRQ RQ WKH 7H[W ULEERQ�

5 2Q WKH (GLW PHQX� FOLFN 3DVWH�

6 3UHVV ESC ZKHQ \RX ILQLVK HGLWLQJ WKH WH[W�

RT_To_paste_text_inside_of_an_ob ject
RT_To_paste_text_inside_of_an_object
,PSRUWLQJ 7H[W

Changing Paragraph Spacing

<RX FDQ FKDQJH WKH DPRXQW RI VSDFH EHWZHHQ SDUDJUDSKV ZLWK WKH SDUDJUDSK

VSDFLQJ RSWLRQV LQ WKH 6SDFLQJ SDQHO RI WKH 7H[W GLDORJ ER[� 6SDFLQJ LV

PHDVXUHG LQ WKH FXUUHQWO\ VHOHFWHG XQLW �SRLQWV� IRU H[DPSOH��

1RWH

,I %HIRUH 3DUDJUDSK RU $IWHU 3DUDJUDSK LV VHW WR ]HUR� 'HVLJQHU
DXWRPDWLFDOO\ XVHV WKH FXUUHQW OHDGLQJ IRU WKH SDUDJUDSK� ZKLFK UHVXOWV LQ
QR H[WUD VSDFH EHIRUH RU DIWHU WKH SDUDJUDSK�

Changing Line Spacing

(DFK IRQW LQ GHVLJQHU KDV LWV RZQ GHIDXOW OLQH DQG FKDUDFWHU VSDFLQJ� <RX FDQ

FKDQJH WKH VSDFLQJ EHWZHHQ FKDUDFWHUV� ZRUGV� OLQHV� DQG SDUDJUDSKV�

7KH VSDFH EHWZHHQ OLQHV RI WH[W LV FDOOHG OHDGLQJ� /HDGLQJ LV PHDVXUHG �LQ

SRLQWV� IURP EDVHOLQH WR EDVHOLQH� 7KH GHIDXOW LV WKH FXUUHQW IRQW VL]H SOXV

DSSUR[LPDWHO\ ��� RI WKH IRQW VL]H �WKH SHUFHQW PD\ YDU\ IURP IRQW WR IRQW��

)RU H[DPSOH� LI WKH FXUUHQW IRQW LV �� SRLQWV� WKHQ WKH GHIDXOW OHDGLQJ LV

DSSUR[LPDWHO\ ���� SRLQWV�
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<RX FDQ FKDQJH WKH OHDGLQJ LQ VHOHFWHG EORFN WH[W RU VSHFLI\ OHDGLQJ IRU EORFN

WH[W \RX DUH JRLQJ WR HQWHU� ,I D VHOHFWHG EORFN WH[W FRQWDLQV GLIIHUHQW VL]HV RI

WH[W� 'HVLJQHU GLVSOD\V OHDGLQJ IRU WKH ODUJHVW IRQW�

1RWH

<RX FDQQRW FKDQJH WKH OHDGLQJ RI IUHHIRUP WH[W�

To chan ge text leadin g

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 6HOHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

3 &OLFN WKH 7H[W $WWULEXWHV EXWWRQ LQ WKH 7H[W ULEERQ� 7KH 7H[W GLDORJ

ER[ RSHQV�

4 &OLFN WKH 6SDFLQJ EXWWRQ WR GLVSOD\ WKH 6SDFLQJ SDQHO� LI QHFHVVDU\�

5 &OLFN WKH EXWWRQ EHVLGH WKH OLQH OHDGLQJ ER[ DQG W\SH D QHZ QXPEHU

IRU WKH DPRXQW RI OHDGLQJ�
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6 &OLFN $SSO\ WR FKDQJH WKH OHDGLQJ�

7LSV

<RX GR QRW QHHG WR FORVH WKH GLDORJ ER[ WR DSSO\ WKH FKDQJHV�

<RX DOVR FDQ FKDQJH EORFN WH[W OHDGLQJ PDQXDOO\� ,QVHUW WKH WH[W FXUVRU LQWR
WKH EORFN DQG SUHVV DQG KROG SHIFT ZKLOH GUDJJLQJ WKH ERWWRP FRQWDLQHU
KDQGOH XS RU GRZQ� 3UHVV CTRL ZKLOH GUDJJLQJ WR FKDQJH WKH VSDFLQJ
EHWZHHQ SDUDJUDSKV�

Changing Character Spacing

<RX FDQ LQFUHDVH RU GHFUHDVH WKH VSDFLQJ EHWZHHQ ZRUGV DQG FKDUDFWHUV E\

FKDQJLQJ WKH �QRUPDO� VSDFLQJ SHUFHQWDJH� 7KH GHIDXOW IRU ZRUGV LV ����

VSDFLQJ� WKH GHIDXOW IRU FKDUDFWHUV LV ���� VSDFLQJ� 'HFUHDVLQJ WKH SHUFHQWDJH

GHFUHDVHV WKH VSDFLQJ EHWZHHQ OHWWHUV RU ZRUGV� LQFUHDVLQJ WKH SHUFHQWDJH

LQFUHDVHV WKH VSDFLQJ�

7LS

<RX FDQ DOVR PDQXDOO\ FKDQJH FKDUDFWHU VSDFLQJ LQ EORFN WH[W� ,QVHUW WKH
WH[W FXUVRU LQWR WKH EORFN DQG SUHVV DQG KROG SHIFT ZKLOH GUDJJLQJ WKH
ULJKW FRQWDLQHU KDQGOH OHIW RU ULJKW� 3UHVV CTRL ZKLOH GUDJJLQJ WR FKDQJH
WKH VSDFLQJ EHWZHHQ ZRUGV�

To chan ge word and character s pacin g

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�
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2 6HOHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

3 &OLFN WKH 7H[W $WWULEXWHV EXWWRQ LQ WKH 7H[W ULEERQ� 7KH 7H[W GLDORJ

ER[ RSHQV�

4 &OLFN WKH 6SDFLQJ EXWWRQ WR GLVSOD\ WKH 6SDFLQJ SDQHO� LI QHFHVVDU\�

5 7\SH D QHZ QXPEHU LQ WKH ,QWHU :RUG RU ,QWHU &KDUDFWHU VSDFLQJ ER[�

6 &OLFN $SSO\ WR FKDQJH WKH VSDFLQJ�

7LSV

<RX GR QRW QHHG WR FORVH WKH GLDORJ ER[ WR DSSO\ WKH FKDQJHV�

Kerning

To kern text

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 7H[W 0RGH EXWWRQ WR GLVSOD\ WKH WH[W SRLQWHU� LI QHFHVVDU\�

3 3RLQW WR WKH FKDUDFWHUV WR NHUQ� DQG SUHVV WKH OHIW PRXVH EXWWRQ WR

SODFH WKH WH[W FXUVRU EHWZHHQ WKHP�

4 3UHVV DQG KROG CTRL DQG SUHVV WKH LEFT ARROW RU RIGHT ARROW WR
PRYH WKH FKDUDFWHUV FORVHU WRJHWKHU RU IDUWKHU DSDUW� UHVSHFWLYHO\�

7LS

8VH WKH 9LHZ WRRO WR ]RRP LQ RQ WKH WH[W \RX ZDQW WR NHUQ� 7KH FORVHU
\RX ]RRP� WKH HDVLHU LW LV WR VHH WKH NHUQLQJ HIIHFW�
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Resizing a Text Container

<RX FDQ UHVL]H WKH WH[W FRQWDLQHU DURXQG EORFN WH[W WR FKDQJH WKH WH[W IORZ�

5HVL]LQJ D WH[W FRQWDLQHU GRHV QRW RWKHUZLVH FKDQJH WKH DSSHDUDQFH RI WKH

WH[W�

7R GLVSOD\ WKH WH[W FRQWDLQHU DURXQG EORFN WH[W VR WKDW \RX FDQ UHVL]H LW� FOLFN

WKH WH[W EORFN RQFH ZLWK WKH WH[W SRLQWHU� RU GRXEOH FOLFN WKH WH[W EORFN ZLWK

WKH VHOHFW SRLQWHU�

'UDJJLQJ D FRQWDLQHU KDQGOH UHVL]HV WKH FRQWDLQHU� 7KH WH[W UHIORZV WR

DFFRPPRGDWH WKH QHZ FRQWDLQHU VL]H� EXW WKH WH[W VL]H DQG VW\OH DWWULEXWHV

GR QRW FKDQJH�

To resize a text container

1 'LVSOD\ WKH WH[W FRQWDLQHU� LI QHFHVVDU\�

2 0RYH WKH SRLQWHU WR D FRQWDLQHU KDQGOH�

3 'UDJ WKH KDQGOH WR D QHZ SRVLWLRQ�

4 5HOHDVH WKH PRXVH EXWWRQ�

5 5HSHDW VWHSV � WKURXJK � WR DGMXVW WKH RWKHU KDQGOH� LI GHVLUHG�

6 3UHVV ESC ZKHQ \RX ILQLVK UHVL]LQJ WKH FRQWDLQHU�
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Importing Text

<RX FDQ FRPSRVH WH[W LQ D ZRUG SURFHVVLQJ RU RWKHU :LQGRZV SURJUDP DQG

LPSRUW LW LQWR \RXU 'HVLJQHU GUDZLQJ�

7KHUH DUH WZR ZD\V WR EULQJ WH[W LQWR 'HVLJQHU� <RX FDQ SDVWH WH[W LQWR

'HVLJQHU IURP WKH &OLSERDUG� RU \RX FDQ LPSRUW WH[W DV D SODLQ �$6&,,� RU

5LFK 7H[W )RUPDW �57)� WH[W ILOH�

7H[W FDQ EH LPSRUWHG DV IUHHIRUP RU EORFN WH[W� ,I \RX LPSRUW $6&,, WH[W �IRU

H[DPSOH� D 7;7 ILOH�� LW DSSHDUV LQ WKH FXUUHQW IRQW DQG VW\OH� ,I \RX LPSRUW

57) WH[W� LW DSSHDUV LQ WKH IRQW DQG VW\OH LQ ZKLFK LW ZDV RULJLQDOO\ FUHDWHG�

To im port text from a text file

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 7H[W 0RGH EXWWRQ WR GLVSOD\ WKH WH[W SRLQWHU� LI QHFHVVDU\�

3 &OLFN D WH[W REMHFW WR LQVHUW WKH WH[W FXUVRU�

RU

%HJLQ D QHZ WH[W REMHFW �FOLFN IRU IUHHIRUP� GUDJ IRU EORFN WH[W��

4 2Q WKH 7RROV PHQX� FOLFN ,PSRUW� 7KH ,PSRUW GLDORJ ER[ RSHQV�

5 6HOHFW )LOHV RI W\SH $6&,, 7H[W �
�7;7� WR LPSRUW UHJXODU $6&,, WH[W RU

VHOHFW 5LFK 7H[W )RUPDW �
�57)� WR LPSRUW 57) WH[W�

6 +LJKOLJKW WKH ILOH WR LPSRUW DQG FOLFN ,PSRUW� 7KH WH[W DSSHDUV�

7 3UHVV ESC ZKHQ \RX ILQLVK HGLWLQJ�

7LS

<RX FDQ SUHVV CTRL+1 WR RSHQ WKH ,PSRUW GLDORJ ER[ TXLFNO\�
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Setting Indents, Tabs, and Leaders

<RX FDQ PRYH WKH ILUVW OLQH RI VHOHFWHG SDUDJUDSKV LQ EORFN WH[W WR WKH OHIW RU

ULJKW RI WKH OHIW PDUJLQ E\ FKDQJLQJ WKH ILUVW OLQH LQGHQW� ,I \RX VHOHFW D WH[W

REMHFW� WKH ILUVW OLQH RI HDFK SDUDJUDSK VHSDUDWHG E\ D UHWXUQ LV LQGHQWHG� ,I

\RX KLJKOLJKW D SRUWLRQ RI RQH RU PRUH SDUDJUDSKV� RQO\ WKH ILUVW OLQHV RI

WKRVH SDUDJUDSKV DUH LQGHQWHG�

$ SRVLWLYH LQGHQW PRYHV WKH WH[W WRZDUG WKH ULJKW �DZD\ IURP WKH OHIW

PDUJLQ�� D QHJDWLYH LQGHQW PRYHV WKH WH[W WRZDUG WKH OHIW �LQVLGH RI WKH OHIW

PDUJLQ��

To indent the first line of a paragraph

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 6HOHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

3 &OLFN WKH 7H[W $WWULEXWHV EXWWRQ LQ WKH 7H[W ULEERQ� 7KH 7H[W GLDORJ

ER[ RSHQV�

4 &OLFN WKH 0DUJLQV EXWWRQ WR GLVSOD\ WKH 0DUJLQV SDQHO� LI QHFHVVDU\�

5 7\SH D SRVLWLYH QXPEHU LQ WKH )LUVW ,QGHQW ER[ WR LQGHQW WKH ILUVW OLQH RI

HDFK SDUDJUDSK WR WKH ULJKW� W\SH D QHJDWLYH QXPEHU WR LQGHQW WR WKH

OHIW�
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6 &OLFN $SSO\ WR LQGHQW WKH WH[W�

7LS

,Q VWHS �� LI \RX SUHIHU \RX FDQ RSHQ WKH 7H[W GLDORJ ER[ E\ FOLFNLQJ
0DUJLQV LQ WKH )RUPDW PHQX�

v <RX GR QRW QHHG WR FORVH WKH GLDORJ ER[ WR DSSO\ WKH FKDQJHV�

Setting Tabs

7DE VWRSV DUH UHODWLYH WR WKH WH[W REMHFW� )RU H[DPSOH� LI WKH ILUVW WDE VWRS LV��

SLFDV� WKH ILUVW WDE LV �� SLFDV IURP WKH OHIW PDUJLQ� ,I WKH VHFRQG WDE VWRS LV ���

SLFDV� LW LV ��� SLFDV IURP WKH OHIW PDUJLQ� DQG VR RQ� 7H[W REMHFWV PDLQWDLQ WKHLU

RULJLQDO WDE SRVLWLRQV HYHQ LI \RX PRYH WKH REMHFW�

To set tab sto ps

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 7H[W $WWULEXWHV EXWWRQ LQ WKH 7H[W ULEERQ WR RSHQ WKH

7H[W GLDORJ ER[�

3 &OLFN WKH 7DE 6WRSV EXWWRQ WR GLVSOD\ WKH 7DE 6WRSV SDQHO� LI

QHFHVVDU\�

4 6HOHFW WKH W\SH RI WDE VWRS� LI \RX ZDQW�

5 7\SH D SRVLWLRQ IRU WKH WDE VWRS LQ WKH 3RVLWLRQ ER[�

6 &OLFN WKH $GG 7DE EXWWRQ WR DGG D VLQJOH WDE VWRS� RU FOLFN WKH

5HSHDW 7DE EXWWRQ WR DGG UHSHDWLQJ WDE VWRSV�
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7 &OLFN $SSO\ WR HQWHU WKH WDE VWRSV�

7LS

<RX GR QRW QHHG WR FORVH WKH GLDORJ ER[ WR DSSO\ WKH FKDQJHV�

Setting Leaders

/HDGHUV DUH FKDUDFWHUV VXFK DV SHULRGV � � �� K\SKHQV � � �� DQG XQGHUVFRUHV �

B � WKDW DSSHDU WR WKH OHIW RI WDEXODWHG WH[W�

To set leaders

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 7H[W $WWULEXWHV EXWWRQ LQ WKH 7H[W ULEERQ WR RSHQ WKH

7H[W GLDORJ ER[�

3 &OLFN WKH 7DE 6WRSV EXWWRQ WR GLVSOD\ WKH 7DE 6WRSV SDQHO� LI

QHFHVVDU\�

4 6HOHFW D FXUUHQW WDE LQ WKH &XUUHQW 7DEV DUHD�

5 6HOHFW D OHDGHU LQ WKH /HDGHU ER[�

6 &OLFN WKH $GG 7DE EXWWRQ � $ GLDORJ ER[ DSSHDUV DVNLQJ LI \RX ZDQW

WR RYHUZULWH WKH H[LVWLQJ WDE�

7 &OLFN <HV� 7KH SUHYLRXV WDE LV UHSODFHG ZLWK WKH QHZ RQH ZLWK WKH

OHDGHUV \RX FKRVH DVVRFLDWHG ZLWK LW
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8 &OLFN $SSO\ WR SXW WKH QHZ WDE VWRSV LQ VHOHFWHG WH[W�

7LS

<RX GR QRW QHHG WR FORVH WKH GLDORJ ER[ WR DSSO\ WKH FKDQJHV�

Using Automatic Hyphenation

'HVLJQHU FDQ DXWRPDWLFDOO\ K\SKHQDWH ZRUGV WR KHOS GHFUHDVH WKH UDJJHGQHVV

RI OHIW MXVWLILHG WH[W� DQG WR KHOS PDLQWDLQ FKDUDFWHU DQG ZRUG VSDFLQJ LQ

MXVWLILHG WH[W�

To use automatic h yphenation

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 6HOHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR K\SKHQDWH�

3 &OLFN WKH 7H[W $WWULEXWHV EXWWRQ LQ WKH 7H[W ULEERQ� 7KH 7H[W GLDORJ

ER[ RSHQV�

4 &OLFN WKH 6SDFLQJ EXWWRQ WR GLVSOD\ WKH 6SDFLQJ SDQHO� LI QHFHVVDU\�

5 6HOHFW WKH 8VH $XWRPDWLF +\SKHQDWLRQ RSWLRQ�

6 &OLFN $SSO\ WR FKDQJH WKH VSDFLQJ�

7LS

<RX GR QRW QHHG WR FORVH WKH GLDORJ ER[ WR DSSO\ WKH FKDQJHV�

Using Drop Caps

$ GURS FDS LV DQ HQODUJHG ILUVW FDSLWDO OHWWHU LQ D VHOHFWLRQ RI WH[W� $ GURS FDS

LV FUHDWHG E\ ORZHULQJ WKH EDVHOLQH RI WKH ILUVW FKDUDFWHU LQ D SDUDJUDSK VR

WKDW LW DOLJQV ZLWK WKH EDVHOLQH RI WKH ODVW LQGHQWHG OLQH�
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<RX FUHDWH GURS FDSV E\ LQFUHDVLQJ WKH SHUFHQWDJH RI WKH FXUUHQW IRQW KHLJKW�

)RU H[DPSOH� ���� GRXEOHV WKH VL]H RI WKH ILUVW OHWWHU RI WKH SDUDJUDSK�

To create an init ial dro p cap

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 6HOHFW RU KLJKOLJKW WKH WH[W \RX ZDQW WR FKDQJH�

3 &OLFN WKH 7H[W $WWULEXWHV EXWWRQ WR RSHQ WKH 7H[W GLDORJ ER[�

4 &OLFN WKH 6SDFLQJ EXWWRQ WR GLVSOD\ WKH 6SDFLQJ SDQHO� LI QHFHVVDU\�

5 6HOHFW WKH 8VH 'URS &DSV RSWLRQ�

6 &KDQJH WKH SHUFHQWDJH IRU WKH GURS FDS VL]H�

7 &OLFN $SSO\�

7LS

<RX GR QRW QHHG WR FORVH WKH GLDORJ ER[ WR DSSO\ WKH FKDQJHV�
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Aligning Text

Text Alignment Options

<RX FDQ DOLJQ WH[W KRUL]RQWDOO\ RU YHUWLFDOO\� +RUL]RQWDO WH[W DOLJQPHQW DOLJQV

WH[W IURP OHIW WR ULJKW DQG YHUWLFDO DOLJQPHQW DOLJQV WH[W IURP WRS WR ERWWRP�

Horizontal alignment options

Vertical alignment options
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7KH NH\ERDUG VKRUWFXWV IRU DOLJQLQJ WH[W DUH OLVWHG LQ WKH WDEOH EHORZ�

1RWH

9HUWLFDOO\ MXVWLILHG WH[W LJQRUHV SUHYLRXV OHDGLQJ VHWWLQJV�

Aligning Freeform Text

<RX FDQ FKRRVH DQ DOLJQPHQW RSWLRQ EHIRUH RU DIWHU \RX HQWHU IUHHIRUP WH[W�

,I \RX VHOHFW DQ DOLJQPHQW RSWLRQ EHIRUH HQWHULQJ WH[W� WKH WH[W LV DOLJQHG WR

WKH FXUVRU
V SRVLWLRQ� )RU H[DPSOH� LI WKH WH[W LV DOLJQHG DW WKH ULJKW� WKH FXUVRU

GRHV QRW PRYH DQG WH[W DSSHDUV WR WKH OHIW RI WKH FXUVRU DV \RX W\SH�

,I \RX VHOHFW D IUHHIRUP WH[W REMHFW RU KLJKOLJKW RQO\ WKH WH[W \RX ZDQW WR

DOLJQ� WKH DOLJQPHQW LV EDVHG RQ WKH ERXQGLQJ ER[ WKDW VXUURXQGV WKH WH[W�

7KH ERXQGLQJ ER[ LV DV ZLGH DV WKH ORQJHVW OLQH RI WH[W DQG DV WDOO DV WKH

QXPEHU RI OLQHV RI WH[W�

1RWH

)UHHIRUP WH[W FDQQRW EH MXVWLILHG YHUWLFDOO\ RU KRUL]RQWDOO\�

$FWLRQ .H\ERDUG VKRUWFXW

$OLJQ WR OHIW CTRL+SHIFT+L

$OLJQ WR FHQWHU CTRL+SHIFT+C

$OLJQ WR ULJKW CTRL+SHIFT+R

$OLJQ WR WRS CTRL+SHIFT+O

$OLJQ WR PLGGOH CTRL+SHIFT+M

$OLJQ WR ERWWRP CTRL+SHIFT+B

)XOO MXVWLI\ KRUL]RQWDO CTRL+SHIFT+J

)RUFH MXVWLI\ KRUL]RQWDO CTRL+SHIFT+F
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Aligning Block Text

<RX FDQ FKRRVH DQ DOLJQPHQW RSWLRQ EHIRUH RU DIWHU \RX HQWHU EORFN WH[W�

<RX FDQ VHW WKH DOLJQPHQW RSWLRQ EHIRUH HQWHULQJ WH[W RU VHOHFW D WH[W EORFN

DQG FKDQJH WKH DOLJQPHQW RI WKH HQWLUH EORFN� <RX DOVR FDQ KLJKOLJKW RQO\ WKH

SDUDJUDSKV \RX ZDQW WR DOLJQ� 7H[W LV DOLJQHG WR WKH FRQWDLQHU�

7H[W LQ D VKDSH LV DOLJQHG DIWHU LW LV SDVWHG LQWR WKH VKDSH� 7KH WH[W LV DOLJQHG

ZLWKLQ WKH HGJHV RI WKH VKDSH�

Fitting Text to a Path

'HVLJQHU
V ILW�WR�SDWK IHDWXUHV OHW \RX DOLJQ WH[W WR DQ\ VKDSH� LQFOXGLQJ FXUYHV�

FLUFOHV� DQG DQJOHV WR FUHDWH FRPSOH[ HIIHFWV� <RX FDQ HLWKHU HQWHU WKH WH[W

GLUHFWO\ RQWR D SDWK RU ILW H[LVWLQJ IUHHIRUP WH[W WR D SDWK� $IWHU ILWWLQJ WH[W WR

D SDWK� \RX FDQ VWLOO HGLW WKH WH[W DQG FKDQJH WH[W DWWULEXWHV�

,W LV HDV\ WR JHW WKH WH[W ILW WKDW \RX ZDQW EHFDXVH 'HVLJQHU SUHYLHZV RQ \RXU

SDJH WKH HIIHFW RI DOLJQPHQW VHWWLQJV DV \RX FKRRVH RU FKDQJH WKHP�

%HFDXVH 'HVLJQHU UHPHPEHUV WKH SDWK WKDW \RX XVHG WR DOLJQ WKH WH[W� \RX

FDQ UHVKDSH WKH SDWK REMHFW� RU HYHQ GHOHWH LW� ZLWKRXW DIIHFWLQJ WKH DOLJQHG

WH[W�
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<RX FDQ HGLW WH[W RQ D SDWK MXVW DV \RX ZRXOG DQ\ RWKHU WH[W� )RU H[DPSOH�

\RX FDQ FKDQJH WKH SDWK DOLJQPHQW� FRORU� IRQW� RU NHUQLQJ RI WKH WH[W� <RX

FDQ DOVR GHOHWH WKH VKDSH XVHG WR DUUDQJH WKH WH[W LI \RX GR QRW ZDQW WKH

REMHFW WR EH YLVLEOH�

Entering Text along a Path

7KH 3DWK 7H[W EXWWRQ OHWV \RX W\SH WH[W GLUHFWO\ RQWR DQ REMHFW
V SDWK� 7KH

WH[W LV ILWWHG WR WKH SDWK XVLQJ WKH FXUUHQW VHWWLQJV� $IWHU HQWHULQJ WH[W� \RX

FDQ HDVLO\ FKDQJH WKH ILWWLQJ RSWLRQV WR JHW WKH WH[W DOLJQPHQW WKDW \RX ZDQW�

To enter text directl y alon g an ob ject’s path

1 6HOHFW WKH REMHFW DORQJ ZKLFK \RX ZDQW WR SODFH WKH WH[W�

2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 3DWK 7H[W EXWWRQ � 7KH WH[W FXUVRU DSSHDUV RQ WKH SDWK�

4 7\SH WKH WH[W� ZKLFK DSSHDUV DORQJ WKH REMHFW DV \RX W\SH�

5 3UHVV ESC ZKHQ \RX ILQLVK�

Using the Path Fit Palette

7KH 3DWK )LW SDOHWWH PDNHV LW HDV\ WR SURGXFH TXLFNO\ WKH WH[W HIIHFWV WKDW \RX

ZDQW ZKHQ DOLJQLQJ H[LVWLQJ WH[W WR D SDWK RU ZKHQ HGLWLQJ WKH DOLJQPHQW RI

WH[W DOUHDG\ ILW WR D SDWK� 7KH 3DWK )LW SDOHWWH SURYLGHV �TXLFN FKRLFH� EXWWRQV

WKDW OHW \RX VSHFLI\ FRPELQDWLRQV RI WKH IROORZLQJ�

v 7H[W DOLJQPHQW� OHIW� ULJKW� RU FHQWHU

v 7H[W SRVLWLRQ� DERYH �RXWVLGH� RU EHORZ �LQVLGH� WKH SDWK

v 7H[W RULHQWDWLRQ� QRUPDO RU XSVLGH GRZQ

,I \RX DUH ILWWLQJ IUHHIRUP WH[W WR D SDWK� \RX PXVW VHOHFW ERWK WKH IUHHIRUP

WH[W DQG WKH SDWK REMHFW WR HQDEOH WKH 3DWK )LW EXWWRQ� ,I \RX DUH HGLWLQJ WKH

DOLJQPHQW RI WH[W DOUHDG\ ILW WR D SDWK� \RX FDQ HQDEOH WKH 3DWK )LW EXWWRQ

HLWKHU E\ VHOHFWLQJ WKH ILWWHG WH[W RU E\ VHOHFWLQJ WKH ILWWHG WH[W DQG SDWK

REMHFW�
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7KH TXLFN FKRLFH EXWWRQV VKRZ D VDPSOH SDWK DQG DQ DUURZ WR LQGLFDWH WKH

WH[W DUUDQJHPHQW� 7KH ORFDWLRQ RI WKH DUURZ LQ UHODWLRQ WR WKH VDPSOH SDWK

LQGLFDWHV WKH WH[W DOLJQPHQW DQG SRVLWLRQ� 7KH GLUHFWLRQ RI WKH DUURZ

LQGLFDWHV WKH WH[W RULHQWDWLRQ �ZKLFK VLGH LV XS��

Using the Choose Position Ribbon

,I WKH TXLFN FKRLFH EXWWRQV GR QRW SURYLGH WKH WH[W DOLJQPHQW WKDW \RX ZDQW�

\RX FDQ FXVWRP DOLJQ WKH WH[W ZLWK WKH EXWWRQV LQ WKH &KRRVH 3RVLWLRQ

ULEERQ� 7KH EXWWRQV LQ WKH 5LEERQ OHW \RX VHW VHSDUDWHO\ WKH DOLJQPHQW�

SRVLWLRQ� RIIVHW� GLUHFWLRQ� DQG SLWFK RI WKH WH[W� 7KH &KRRVH 3RVLWLRQ EXWWRQ

DOVR OHWV \RX PDQXDOO\ DGMXVW WKH DOLJQPHQW SRLQW E\ GUDJJLQJ LW DORQJ WKH SDWK�

&OLFN &KRRVH 3RVLWLRQ LQ WKH 3DWK )LW SDOHWWH WR GLVSOD\ WKH &KRRVH 3RVLWLRQ

ULEERQ� $IWHU FUHDWLQJ WKH SDWK ILW WKDW \RX ZDQW� GRXEOH FOLFN WKH OHIW PRXVH

EXWWRQ RU SUHVV ESC WR FOHDU WKH &KRRVH 3RVLWLRQ ULEERQ�

To set text ali gnment for text on a path

1 6HOHFW WKH WH[W \RX ZDQW WR DOLJQ�

2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 3DWK )LW EXWWRQ � $ SDOHWWH RSHQV�

4 &OLFN &KRRVH 3RVLWLRQ� 7KH &KRRVH 3RVLWLRQ ULEERQ RSHQV�

5 &OLFN DQ DOLJQPHQW EXWWRQ IRU WKH DOLJQPHQW \RX ZDQW�
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6 3UHVV ESC ZKHQ \RX ILQLVK�

7LSV

7KH /HIW $OLJQ EXWWRQ SRVLWLRQV WH[W VR WKH OHIW HGJH RI WKH WH[W DOLJQV
WR WKH DOLJQPHQW SRLQW�

7KH &HQWHU $OLJQ EXWWRQ FHQWHUV WH[W DURXQG WKH DOLJQPHQW SRLQW�

7KH 5LJKW $OLJQ EXWWRQ SRVLWLRQV WH[W VR WKH ULJKW HGJH RI WKH WH[W
DOLJQV WR WKH DOLJQPHQW SRLQW�

<RX FDQ SUHVV TAB WR F\FOH WKURXJK WKH /HIW� &HQWHU� DQG 5LJKW DOLJQPHQW
VHWWLQJV�

<RX FDQ FOLFN &KRRVH 3RVLWLRQ LQ WKH 3DWK )LW SDOHWWH DQG FOLFN WR VSHFLI\ D
FXVWRP DOLJQPHQW SRLQW�

To set text position for text on a path

1 6HOHFW WKH WH[W \RX ZDQW WR FKDQJH WKH SRVLWLRQ RI�

2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 3DWK )LW EXWWRQ � $ SDOHWWH RSHQV�

4 &OLFN &KRRVH 3RVLWLRQ� 7KH &KRRVH 3RVLWLRQ ULEERQ RSHQV�

5 &OLFN WKH $ERYH 3DWK EXWWRQ RU %HORZ 3DWK EXWWRQ WR VSHFLI\

WKH SRVLWLRQ IRU WKH WH[W�

7LSV

7KH $ERYH EXWWRQ SRVLWLRQV WKH WH[W DERYH DQ RSHQ SDWK REMHFW RU
RXWVLGH RI D FORVHG SDWK REMHFW�

7KH %HORZ EXWWRQ SRVLWLRQV WKH WH[W EHORZ DQ RSHQ SDWK REMHFW RU
LQVLGH RI D FORVHG SDWK REMHFW�

To chan ge the offset of text on a path

1 6HOHFW WKH WH[W \RX ZDQW WR FKDQJH WKH RIIVHW RI�
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2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 3DWK )LW EXWWRQ � $ SDOHWWH RSHQV�

4 &OLFN &KRRVH 3RVLWLRQ� 7KH &KRRVH 3RVLWLRQ ULEERQ RSHQV�

5 (QWHU WKH RIIVHW SHUFHQWDJH \RX ZDQW LQ WKH 2IIVHW 3HUFHQWDJH ER[�

7LSV

$Q RIIVHW RI �� DOLJQV WKH WH[W RQ WKH SDWK�

7KH DOLJQPHQW RIIVHW LV UHODWLYH WR ZKHWKHU WKH WH[W LV SRVLWLRQHG DERYH RU
EHORZ WKH SDWK� $ SRVLWLYH RIIVHW �WR WKH OLPLW RI ����� VKLIWV WKH WH[W DZD\
IURP WKH SDWK� $ QHJDWLYH RIIVHW �� �WR WKH OLPLW RI ����� VKLIWV WKH WH[W
SDVW WKH SDWK�

To chan ge the direction of text on a path

1 6HOHFW WKH WH[W \RX ZDQW WR FKDQJH WKH RIIVHW RI�

2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 3DWK )LW EXWWRQ � $ SDOHWWH RSHQV�

4 &OLFN &KRRVH 3RVLWLRQ� 7KH &KRRVH 3RVLWLRQ ULEERQ RSHQV�

5 &OLFN WKH 5HYHUVH EXWWRQ RU )RUZDUG EXWWRQ WR VHW WKH

GLUHFWLRQ \RX ZDQW�

7LSV

7KH 5HYHUVH EXWWRQ DOLJQV WH[W LQ D FRXQWHU FORFNZLVH GLUHFWLRQ IRU
PRVW VLPSOH SDWKV� 7KLV JHQHUDOO\ GLVSOD\V WKH WH[W XSVLGH GRZQ LQ UHODWLRQ
WR WKH WRS RI WKH SDWK�

7KH )RUZDUG EXWWRQ DOLJQV WH[W LQ D FORFNZLVH GLUHFWLRQ IRU PRVW
VLPSOH SDWKV� 7KLV JHQHUDOO\ GLVSOD\V WKH WH[W XSULJKW LQ UHODWLRQ WR WKH WRS
RI WKH SDWK�
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To chan ge the ali gnment pitch of text on a path

1 6HOHFW WKH WH[W \RX ZDQW WR FKDQJH WKH DOLJQPHQW SLWFK RI�

2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 3DWK )LW EXWWRQ � $ SDOHWWH RSHQV�

4 &OLFN &KRRVH 3RVLWLRQ� 7KH &KRRVH 3RVLWLRQ ULEERQ RSHQV�

5 &OLFN WKH DOLJQPHQW EXWWRQ WR VHW WKH DOLJQPHQW \RX ZDQW�

7LSV

7KH 5RWDWH EXWWRQ DOLJQV WKH WH[W E\ URWDWLQJ WKH FKDUDFWHUV DORQJ
WKH SDWK�

7KH 6NHZ 9HUW EXWWRQ DOLJQV WKH WH[W E\ VNHZLQJ WKH FKDUDFWHUV
YHUWLFDOO\�

7KH 6NHZ +RU] EXWWRQ DOLJQV WKH WH[W E\ VNHZLQJ WKH FKDUDFWHUV
KRUL]RQWDOO\�

7KH 1R 5RWDWLRQ EXWWRQ DOLJQV WKH WH[W ZLWKRXW VNHZLQJ RU URWDWLQJ
WKH FKDUDFWHUV� 7KLV SURGXFHV WKH IDVWHVW UHGUDZ� 8VH WKLV SLWFK DV D GUDIW
PRGH ZKLOH \RX DUH PRGLI\LQJ WKH DOLJQPHQW SRLQW� $IWHU WKH DOLJQPHQW
SRLQW LV VHW FRUUHFWO\� FKRRVH WKH SLWFK VHWWLQJ \RX ZDQW�

'UDJJLQJ D FRQWDLQHU KDQGOH UHVL]HV WKH FRQWDLQHU� 7KH WH[W UHIORZV WR

DFFRPPRGDWH WKH QHZ FRQWDLQHU VL]H� EXW WKH WH[W VL]H DQG VW\OH DWWULEXWHV

GR QRW FKDQJH�

To resize a text container

1 'LVSOD\ WKH WH[W FRQWDLQHU� LI QHFHVVDU\�

2 0RYH WKH SRLQWHU WR D FRQWDLQHU KDQGOH�

3 'UDJ WKH KDQGOH WR D QHZ SRVLWLRQ�

4 5HOHDVH WKH PRXVH EXWWRQ�

5 5HSHDW VWHSV � WKURXJK � WR DGMXVW WKH RWKHU KDQGOH� LI GHVLUHG�

6 3UHVV ESC ZKHQ \RX ILQLVK UHVL]LQJ WKH FRQWDLQHU�
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Importing Text

<RX FDQ FRPSRVH WH[W LQ D ZRUG SURFHVVLQJ RU RWKHU :LQGRZV SURJUDP DQG

LPSRUW LW LQWR \RXU 'HVLJQHU GUDZLQJ�

7KHUH DUH WZR ZD\V WR EULQJ WH[W LQWR 'HVLJQHU� <RX FDQ SDVWH WH[W LQWR

'HVLJQHU IURP WKH &OLSERDUG� RU \RX FDQ LPSRUW WH[W DV D SODLQ �$6&,,� RU

5LFK 7H[W )RUPDW �57)� WH[W ILOH�

7H[W FDQ EH LPSRUWHG DV IUHHIRUP RU EORFN WH[W� ,I \RX LPSRUW $6&,, WH[W �IRU

H[DPSOH� D 7;7 ILOH�� LW DSSHDUV LQ WKH FXUUHQW IRQW DQG VW\OH� ,I \RX LPSRUW

57) WH[W� LW DSSHDUV LQ WKH IRQW DQG VW\OH LQ ZKLFK LW ZDV RULJLQDOO\ FUHDWHG�

To im port text from a text file

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 7H[W 0RGH EXWWRQ WR GLVSOD\ WKH WH[W SRLQWHU� LI QHFHVVDU\�

3 &OLFN D WH[W REMHFW WR LQVHUW WKH WH[W FXUVRU�

RU

%HJLQ D QHZ WH[W REMHFW �FOLFN IRU IUHHIRUP� GUDJ IRU EORFN WH[W��

4 2Q WKH 7RROV PHQX� FOLFN ,PSRUW� 7KH ,PSRUW GLDORJ ER[ RSHQV�

5 6HOHFW )LOHV RI W\SH $6&,, 7H[W �
�7;7� WR LPSRUW UHJXODU $6&,, WH[W RU

VHOHFW 5LFK 7H[W )RUPDW �
�57)� WR LPSRUW 57) WH[W�

6 +LJKOLJKW WKH ILOH WR LPSRUW DQG FOLFN ,PSRUW� 7KH WH[W DSSHDUV�

7 3UHVV ESC ZKHQ \RX ILQLVK HGLWLQJ�

7LS

<RX FDQ SUHVV CTRL+1 WR RSHQ WKH ,PSRUW GLDORJ ER[ TXLFNO\�
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Setting Indents, Tabs, and Leaders

<RX FDQ PRYH WKH ILUVW OLQH RI VHOHFWHG SDUDJUDSKV LQ EORFN WH[W WR WKH OHIW RU

ULJKW RI WKH OHIW PDUJLQ E\ FKDQJLQJ WKH ILUVW OLQH LQGHQW� ,I \RX VHOHFW D WH[W

REMHFW� WKH ILUVW OLQH RI HDFK SDUDJUDSK VHSDUDWHG E\ D UHWXUQ LV LQGHQWHG� ,I

\RX KLJKOLJKW D SRUWLRQ RI RQH RU PRUH SDUDJUDSKV� RQO\ WKH ILUVW OLQHV RI

WKRVH SDUDJUDSKV DUH LQGHQWHG�

To remove text from a path

1 6HOHFW WKH WH[W \RX ZDQW WR UHPRYH IURP D SDWK�

2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 3DWK )LW EXWWRQ � $ SDOHWWH RSHQV�

4 &OLFN 5HPRYH &XUYH� 7KH WH[W LV UHPRYHG IURP WKH SDWK� ,W LV QRZ

IUHHIRUP WH[W�

To place existin g freeform text alon g an existin g object’s path

1 6HOHFW ERWK WKH IUHHIRUP WH[W DQG WKH REMHFW WR ZKLFK \RX ZDQW WR

DOLJQ LW�

2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 3DWK )LW EXWWRQ � 7KH 3DWK )LW SDOHWWH RSHQV�

4 &OLFN WKH GHVLUHG TXLFN FKRLFH EXWWRQ� 7KH WH[W LV SXW DORQJ WKH SDWK�

7LSV

<RX FDQ FOLFN &KRRVH 3RVLWLRQ DQG VSHFLI\ D FXVWRP DOLJQPHQW�

6XEVFULSWV� VXSHUVFULSWV� DQG VPDOO FDSV DUH QRW UHWDLQHG LQ WH[W WKDW LV ILW WR
D SDWK�
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Text Inside of an Object

7H[W LQVLGH RI DQ REMHFW LV D IRUP RI EORFN WH[W� $ FRQWDLQHU LV FUHDWHG WKDW

PDWFKHV WKH HGJHV RI WKH REMHFW� <RX FDQ FUHDWH PDUJLQV EDVHG RQ WKH

GLVWDQFH RI WKH WH[W IURP WKH FRQWDLQHU�

<RX FDQ IORZ WH[W LQVLGH RI DQ REMHFW IURP RQH FRQWDLQHU WR DQRWKHU� )RU

H[DPSOH� \RX FDQ IORZ D EORFN RI WH[W LQVLGH DQ REMHFW WR D EORFN RI WH[W

RXWVLGH WKH REMHFW� 6HH )ORZLQJ 7H[W IRU PRUH LQIRUPDWLRQ�

To place text inside of an ob ject

1 6HOHFW D FORVHG REMHFW�

2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 6KDSH 7H[W EXWWRQ LQ WKH 7H[W ULEERQ� 7KH WH[W FXUVRU

DSSHDUV LQVLGH WKH VHOHFWHG REMHFW�

4 7\SH� SDVWH� RU LPSRUW WKH WH[W�

5 3UHVV ESC ZKHQ \RX ILQLVK�

7LS

$IWHU \RX SODFH WH[W LQVLGH RI DQ REMHFW� \RX FDQ PRYH RU GHOHWH WKH REMHFW
ZLWKRXW DIIHFWLQJ WKH WH[W� 3RLQW LQVLGH WKH REMHFW� SUHVV ALT DQG FOLFN WKH
OHIW PRXVH EXWWRQ� 7H[W 2EMHFW DSSHDUV LQ WKH VWDWXV EDU DW WKH ERWWRP RI
WKH 'HVLJQHU ZLQGRZ ZKHQ WKH WH[W LV VHOHFWHG� WKH W\SH RI REMHFW �VKDSH�
DSSHDUV ZKHQ WKH REMHFW LV VHOHFWHG� 3UHVV DEL WR GHOHWH WKH REMHFW ZKHQ
LW LV VHOHFWHG�
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Splitting and Joining Text

<RX FDQ EUHDN PXOWL�OLQH WH[W REMHFWV LQWR LQGLYLGXDO REMHFWV� RU MRLQ PXOWLSOH

WH[W REMHFWV LQWR D VLQJOH� PXOWL�OLQH REMHFW�

6SOLWWLQJ DQG MRLQLQJ WH[W LV XVHIXO ZKHQ \RX ZDQW WR TXLFNO\ HQWHU RU LPSRUW

VHYHUDO OLQHV RI WH[W DQG SRVLWLRQ WKHP ODWHU� )RU H[DPSOH� LI \RXU GUDZLQJ KDV

D GR]HQ ODEHOV� LW LV HDVLHU WR HQWHU WKH ODEHOV DV D VLQJOH REMHFW� DQG WKHQ VSOLW

LW DQG PRYH WKH ODEHOV LQGLYLGXDOO\�

To split a multi-line text ob ject

1 6HOHFW WKH WH[W REMHFW�

2 2Q WKH &KDQJH PHQX� SRLQW WR 7H[W DQG FOLFN 6SOLW 7H[W� (DFK OLQH RI

WH[W EHFRPHV D VHSDUDWH WH[W REMHFW�

To join text ob jects

1 6HOHFW WKH WH[W REMHFWV WR MRLQ�

2 2Q WKH &KDQJH PHQX� SRLQW WR 7H[W DQG FOLFN -RLQ 7H[W� 7KH WH[W

EHFRPHV RQH REMHFW EDVHG RQ WKH ORFDWLRQ RI WKH ILUVW WH[W REMHFW�
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Reshaping Text

<RX FDQ FRQYHUW WH[W WR FXUYHV WR UHVKDSH LW OLNH D QRQ�WH[W REMHFW� 7R

FRQYHUW WH[W WR FXUYHV� VHOHFW WKH WH[W REMHFW� RSHQ WKH &KDQJH 0HQX� DQG

FOLFN &RQYHUW 7R &XUYHV�

1RWH

$IWHU \RX FRQYHUW WH[W WR FXUYHV� \RX FDQQRW FRQYHUW LW EDFN WR WH[W�

To resha pe a war ped ob ject

1 6HOHFW WKH REMHFW�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[�

3 &OLFN WKH :DUS EXWWRQ LQ WKH ULEERQ�

4 &OLFN WKH :DUS 7\SH EXWWRQ �

5 &OLFN WKH %H]LHU :DUS EXWWRQ �

Reshaping Block Text

<RX FDQ UHVKDSH D EORFN WH[W FRQWDLQHU WR FKDQJH LWV WH[W IORZ� 7H[W

FRQWDLQHUV DUH UHVKDSHG DV FXUYHG REMHFWV XVLQJ WKH &XUYH 5HVKDSH EXWWRQ

LQ WKH (GLW ULEERQ� 7KH RSWLRQV DYDLODEOH IRU UHVKDSLQJ D WH[W FRQWDLQHU LQFOXGH

DGGLQJ DQG GHOHWLQJ DQFKRUV� FUHDWLQJ FRUQHUV DQG V\PPHWULFDO FXUYHV� DQG

FUHDWLQJ ORFNHG RU XQORFNHG FXVSV�

5HVKDSLQJ D WH[W FRQWDLQHU GRHV QRW FKDQJH WKH VL]H RU VW\OH RI WKH WH[W LQ WKH

FRQWDLQHU�
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To resha pe a block text ob ject with anchors

1 6HOHFW WKH EORFN WH[W \RX ZDQW WR UHVKDSH�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[ DQG FOLFN WKH &XUYH 5HVKDSH

EXWWRQ LQ WKH (GLW ULEERQ�

3 3RLQW WR DQ XQVHOHFWHG DQFKRU�

4 3UHVV WKH OHIW PRXVH EXWWRQ DQG GUDJ WKH SRLQW WR D QHZ ORFDWLRQ� 7KH

WH[W FRQWDLQHU
V VKDSH FKDQJHV�

5 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK� 7KH WH[W UHIORZV WR

PDLQWDLQ LWV PDUJLQV�

6 5HSHDW VWHSV � WKURXJK � WR UHVKDSH RWKHU HGJHV RI WKH FRQWDLQHU�

7LS

<RX FDQ DOVR UHVKDSH D WH[W FRQWDLQHU E\ GUDJJLQJ LWV FRQWURO SRLQWV�

To resha pe a block text ob ject with control points

1 6HOHFW WKH EORFN WH[W \RX ZDQW WR UHVKDSH�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[ DQG FOLFN WKH &XUYH 5HVKDSH

EXWWRQ LQ WKH (GLW ULEERQ�

3 &OLFN DQ DQFKRU WR VHOHFW LW� ,W WXUQV VROLG�

4 'UDJ D FRQWURO SRLQW� 7KH WH[W FRQWDLQHU
V VKDSH FKDQJHV�

5 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK� 7KH WH[W UHIORZV WR

PDLQWDLQ LWV PDUJLQV�

6 5HSHDW VWHSV � WKURXJK � WR UHVKDSH RWKHU HGJHV RI WKH FRQWDLQHU�
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Wrapping Text around an Object

<RX FDQ IRUFH EORFN WH[W WR DXWRPDWLFDOO\ ZUDS DURXQG DQ REMHFW E\ VHWWLQJ

WKH REMHFW WR UHSHO EORFN WH[W

1RWH

<RX FDQQRW UHSHO IUHHIRUP WH[W RU WH[W LQVLGH DQ REMHFW� $OVR� \RX FDQQRW
UHSHO WH[W IURP JURXSHG REMHFWV RU ELWPDSV�

To repel text

1 6HOHFW WKH REMHFW IRU WKH WH[W WR ZUDS DURXQG�
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2 2Q WKH &KDQJH PHQX� SRLQW WR 7H[W DQG FOLFN 5HSHO 7H[W� 7KH WH[W

ZUDSV DURXQG WKH REMHFW�

1RWH

<RX FDQQRW UHSHO IUHHIRUP WH[W� <RX FDQQRW UHSHO WH[W IURP ELWPDSV RU
REMHFWV LQVLGH D JURXS�

7LSV

2EMHFWV UHSHO WH[W UHJDUGOHVV RI WKH OD\HU� )RU H[DPSOH� DQ REMHFW RQ OD\HU
RQH UHSHOV WH[W RQ OD\HU WZR� (YHQ REMHFWV RQ OD\HUV WKDW DUH QRW YLVLEOH
UHSHO WH[W�

7R WXUQ RII UHSHO WH[W PRGH IRU D SDUWLFXODU REMHFW� VHOHFW WKH REMHFW DQG
UHSHDW WKH VWHSV DERYH�

Flowing Text

%ORFN WH[W LV DOZD\V VXUURXQGHG E\ DQ LQYLVLEOH ERXQGDU\ FDOOHG D FRQWDLQHU�

<RX FDQ FRQQHFW WH[W FRQWDLQHUV VR WKDW EORFN WH[W IORZV IURP RQH FRQWDLQHU

WR DQRWKHU� <RX FDQ IORZ WH[W DPRQJ DQ\ QXPEHU RI WH[W FRQWDLQHUV

�LQFOXGLQJ WH[W LQ VKDSHV�� <RX FDQ HLWKHU FRQQHFW H[LVWLQJ WH[W FRQWDLQHUV RU

FUHDWH D QHZ WH[W FRQWDLQHU WKDW IORZV IURP DQ H[LVWLQJ RQH� <RX FDQQRW IORZ

WR D GLIIHUHQW SDJH�

7H[W RYHUIORZV D FRQWDLQHU ZKHQ WKHUH LV PRUH WH[W WKDQ FDQ ILW LQWR WKH

FRQWDLQHU� :KHQ \RX HGLW WH[W� DQ RYHUIORZ KDQGOH �D VPDOO ���� DSSHDUV DW

WKH ORZHU ULJKW ERUGHU RI WKH FRQWDLQHU WR VKRZ WKDW WKHUH LV RYHUIORZLQJ

WH[W� 7H[W IORZV IURP WKH EDFN REMHFW WR WKH IURQW REMHFW� ,I \RX GRQ
W UHRUGHU

WKH REMHFWV� WH[W IORZV IURP WKH ILUVW GUDZQ WR WKH ODVW GUDZQ REMHFW�

To create a new flowin g text container

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 7H[W 0RGH EXWWRQ WR GLVSOD\ WKH WH[W SRLQWHU� LI QHFHVVDU\�
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3 &OLFN WKH WH[W ZLWK WKH WH[W SRLQWHU�

4 &OLFN WKH RYHUIORZ KDQGOH WR FUHDWH D VHFRQG EORFN RI WKH VDPH VL]H

QHDU WKH RULJLQDO�

7LS

,I \RX ZLVK� \RX FDQ SRLQW WR WKH RYHUIORZ KDQGOH� SUHVV DQG KROG WKH OHIW
PRXVH EXWWRQ� DQG GUDJ D VHFRQG EORFN RI WKH VDPH VL]H WR D QHZ ORFDWLRQ�

Flowing Text between Containers

,I \RX KDYH DOUHDG\ FUHDWHG WZR RU PRUH WH[W EORFNV� \RX FDQ FRQQHFW WKHP

VR WKDW WH[W IORZV IURP RQH WR WKH RWKHU� ,I \RX DGG RU GHOHWH WH[W LQ RQH

FRQWDLQHU� WKH RWKHU WH[W EORFNV DOVR DGMXVW�

To flow text from one container to another

1 6HOHFW WKH WH[W FRQWDLQHUV WR FRQQHFW�

2 2Q WKH &KDQJH PHQX� SRLQW WR 7H[W DQG FOLFN )ORZ 7H[W� 7KH WH[W

FRQWDLQHUV DUH FRQQHFWHG�

7LS

<RX FDQ IORZ WH[W WKURXJK DQ\ QXPEHU RI WH[W FRQWDLQHUV DW WKH VDPH WLPH�
7H[W IORZV IURP WKH EDFN FRQWDLQHU �WKH RQH GUDZQ ILUVW� WR WKH IURQW
FRQWDLQHU�
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Checking Spelling

<RX FDQ FKHFN WKH VSHOOLQJ LQ DOO RI \RXU GUDZLQJV DQG GRFXPHQWV FUHDWHG LQ

'HVLJQHU�

'HVLJQHU FDQ FKHFN WKH VSHOOLQJ RI DOO WKH WH[W LQ WKH GRFXPHQW� RU MXVW WKH

WH[W \RX VHOHFW� )RU H[DPSOH� LI \RX ZDQW WR FKHFN RQH ZRUG� KLJKOLJKW WKH

ZRUG DQG FOLFN WKH 6SHOOLQJ EXWWRQ�

'HVLJQHU FKHFNV VSHOOLQJ E\ FRPSDULQJ ZRUGV LQ \RXU GRFXPHQW ZLWK ZRUGV

LQ D GLFWLRQDU\� 7KH GHIDXOW GLFWLRQDU\ LV D ILOH FRQWDLQLQJ WKRXVDQGV RI ZRUGV�

,I 'HVLJQHU ILQGV D ZRUG LQ \RXU GUDZLQJ WKDW LV QRW LQ WKH GLFWLRQDU\� WKH

ZRUG LV GLVSOD\HG DV D SRVVLEOH PLVVSHOOLQJ�

7KHUH DUH PDQ\ W\SHV RI ZRUGV WKDW DUH QRW LQ WKH GLFWLRQDU\� 3URSHU QDPHV�

ZRUGV ZLWK QXPEHUV� IRUHLJQ ZRUGV� DQG VRPH DEEUHYLDWLRQV DUH FRPPRQO\

GLVSOD\HG DV SRVVLEOH PLVVSHOOLQJV� <RX FDQ XVH WKH $GG EXWWRQ WR DGG D

GLVSOD\HG ZRUG WR WKH GLFWLRQDU\ VR WKDW LW ZLOO QRW EH FRQVLGHUHG D

PLVVSHOOLQJ LQ WKH IXWXUH�

To check s pellin g in a drawin g

1 6HOHFW WKH WH[W \RX ZDQW WR FKHFN�

2 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

3 &OLFN WKH 6SHOOLQJ EXWWRQ LQ WKH 7H[W ULEERQ� ,I D PLVVSHOOHG ZRUG LV

IRXQG� 'HVLJQHU RSHQV WKH 6SHOOLQJ GLDORJ ER[�

4 7\SH WKH FRUUHFW VSHOOLQJ IRU WKH ZRUG LQ WKH &KDQJH 7R ER[ DQG FOLFN

&KDQJH� RU

5 &OLFN ,JQRUH RU ,JQRUH $OO WR LJQRUH WKH ZRUG RU HYHU\ LQVWDQFH RI WKH

ZRUG� UHVSHFWLYHO\� RU

6 6HOHFW RQH RI WKH ZRUGV LQ WKH 6XJJHVWLRQV ER[ DQG FOLFN &KDQJH RU

&KDQJH $OO�
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7 &OLFN $GG WR DGG WKH ZRUG WR WKH GLFWLRQDU\ DQG FRQWLQXH�

7LSV

'HVLJQHU FKHFNV WKH VSHOOLQJ RI WH[W REMHFWV RQO\� 7H[W WKDW KDV EHHQ
FRQYHUWHG WR FXUYHV LV QRW FKHFNHG�

7R FKHFN WKH HQWLUH GRFXPHQW� OHDYH DOO WH[W XQVHOHFWHG�

$V D VKRUWFXW IRU VWHSV � DQG �� FOLFN WKH 6SHOOLQJ EXWWRQ RQ WKH
6WDQGDUG WRROEDU�

To ignore miss pelled words

` &OLFN ,JQRUH WR VNLS WKH ZRUG LQ WKH 1RW LQ 'LFWLRQDU\ DUHD ZLWKRXW

FKDQJLQJ LW�

To chan ge the miss pelled word

` &OLFN WKH &KDQJH EXWWRQ WR FKDQJH WKH KLJKOLJKWHG ZRUG LQ \RXU

GRFXPHQW WR WKH ZRUG LQ WKH &KDQJH 7R ER[�

To add the miss pelled word to the dictionar y

` &OLFN $GG WR DGG WKH ZRUG LQ WKH &KDQJH 7R ER[ WR WKH FXUUHQWO\

VHOHFWHG GLFWLRQDU\�

7LS

7KH FXUUHQWO\ VHOHFWHG GLFWLRQDU\ DSSHDUV LQ WKH $GG :RUGV WR OLVW ER[�

Using Dictionaries

7KH GHIDXOW GLFWLRQDU\ LV FDOOHG WKH VWDQGDUG GLFWLRQDU\� <RX FDQ HQODUJH WKH

VWDQGDUG GLFWLRQDU\ E\ DGGLQJ ZRUGV ZLWK WKH $GG RSWLRQ�
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<RX FDQ FUHDWH DGGLWLRQDO GLFWLRQDULHV� RU FXVWRP GLFWLRQDULHV� WR XVH ZLWK WKH

VWDQGDUG GLFWLRQDU\� )RU H[DPSOH� LI \RX DUH ZRUNLQJ RQ D GUDZLQJ FRQWDLQLQJ

FKHPLFDO QDPHV DQG DEEUHYLDWLRQV� \RX FDQ FUHDWH D FXVWRP GLFWLRQDU\ FDOOHG

�&+(0,&$/�',&� WR XVH LQ DGGLWLRQ WR WKH VWDQGDUG GLFWLRQDU\�

To create a new custom dictionar y

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 6SHOOLQJ EXWWRQ LQ WKH 7H[W ULEERQ� 7KH 6SHOOLQJ GLDORJ

ER[ RSHQV�

3 &OLFN WKH 2SWLRQV EXWWRQ WR RSHQ WKH 2SWLRQV � 6SHOOLQJ GLDORJ ER[�

4 &OLFN 1HZ� 7KH 6DYH $V GLDORJ ER[ RSHQV�

5 7\SH D QDPH IRU WKH GLFWLRQDU\� �'HVLJQHU DXWRPDWLFDOO\ DGGV WKH �GLF�

H[WHQVLRQ��

6 &OLFN 6DYH� 'HVLJQHU DGGV WKH GLFWLRQDU\ WR WKH OLVW RI &XVWRP

'LFWLRQDULHV�

7LS

,I VRPHRQH KDV JLYHQ \RX D FXVWRP GLFWLRQDU\ ZLWK WKHLU ZRUGV LQ LW� \RX
FDQ DGG LW XVLQJ WKH $GG EXWWRQ LQ WKH 2SWLRQV � 6SHOOLQJ GLDORJ ER[�
VHOHFWLQJ WKH GLFWLRQDU\� DQG FKRRVLQJ 2SHQ� 'HVLJQHU DGGV WKH GLFWLRQDU\
WR WKH OLVW RI &XVWRP 'LFWLRQDULHV�

To use a custom dictionar y

1 &OLFN WKH 7H[W WRRO LQ WKH WRROER[�

2 &OLFN WKH 6SHOOLQJ EXWWRQ LQ WKH 7H[W ULEERQ� 7KH 6SHOOLQJ GLDORJ

ER[ RSHQV�

3 &OLFN WKH 2SWLRQV EXWWRQ WR RSHQ WKH 2SWLRQV � 6SHOOLQJ GLDORJ ER[�
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4 &OLFN WKH FKHFN ER[ LQ IURQW RI WKH GLFWLRQDU\ \RX ZDQW WR XVH�

7LS

'HVLJQHU FRQVXOWV DOO GLFWLRQDULHV LQ WKH $GG :RUGV WR OLVW ER[�

Using Special Characters

6SHFLDO FKDUDFWHUV VXFK DV XPODXWV� WUDGHPDUN V\PEROV� IUDFWLRQV� DQG RSHQ

DQG FORVH TXRWDWLRQ PDUNV GR QRW DSSHDU RQ PRVW NH\ERDUGV� :KHQ \RX

ZDQW WR XVH D VSHFLDO FKDUDFWHU� \RX HLWKHU PXVW LQVHUW WKHP E\ HQWHULQJ WKHLU

FRGH RQ WKH QXPHULF NH\SDG RU E\ XVLQJ WKH SURJUDP FDOOHG &KDUDFWHU 0DS

WKDW DFFRPSDQLHV :LQGRZV�

$OWKRXJK PRVW IRQWV FRQWDLQ D FRPSOHWH VHW RI VSHFLDO FKDUDFWHUV� VRPH IRQWV

GR QRW� )RU H[DPSOH� LI \RX DUH XVLQJ D IRQW WKDW GRHV QRW FRQWDLQ WKH VSHFLDO

V\PERO �Í�� \RX PXVW FKDQJH WR D IRQW WKDW GRHV FRQWDLQ LW LQ RUGHU WR LQVHUW

WKDW REMHFW�

Using the Keypad

(DFK FKDUDFWHU LQ D IRQW LV DVVRFLDWHG ZLWK D QXPEHU� )RU H[DPSOH� �Í� KDV WKH

QXPEHU ����� UHJDUGOHVV RI WKH IRQW� 7KH QXPEHU LV FDOOHG DQ $16, �$PHULFDQ

1DWLRQDO 6WDQGDUGV ,QVWLWXWH� FKDUDFWHU FRGH�

Dingbats

7H[W IRQWV XVH WKH VWDQGDUG $16, FKDUDFWHU FRGHV� 1RQ�WH[W IRQWV VXFK DV

GLQJEDWV DUH DVVLJQHG FKDUDFWHU FRGHV� EXW WKHUH LV QR VWDQGDUG� <RX PXVW XVH

HLWKHU WKH NH\SDG RU WKH :LQGRZV &KDUDFWHU 0DS WR LQVHUW QRQ�WH[W

FKDUDFWHUV�
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The Windows Character Map

7KH :LQGRZV &KDUDFWHU 0DS LV D SURJUDP LQFOXGHG ZLWK :LQGRZV ���� <RX

FDQ XVH LW WR VHOHFW FKDUDFWHUV WR FRS\ WR WKH &OLSERDUG DQG SDVWH LQWR \RXU

WH[W� &RQVXOW \RXU :LQGRZV GRFXPHQWDWLRQ IRU PRUH LQIRUPDWLRQ�

To insert a character with the ke ypad

1 6HOHFW WKH IRQW WR XVH�

2 3ODFH WKH WH[W FXUVRU ZKHUH \RX ZDQW WKH VSHFLDO FKDUDFWHU�

3 7XUQ RQ NUM LOCK RQ WKH NH\SDG� LI QHFHVVDU\�

4 3UHVV DQG KROG ALT DQG W\SH 0 �]HUR� DQG WKH WKUHH GLJLW FKDUDFWHU

FRGH� )RU H[DPSOH� WR LQVHUW WKH FRS\ULJKW V\PERO� SUHVV DQG KROG ALT

DQG W\SH 0169 RQ WKH NH\SDG�

5 5HOHDVH ALT � 7KH VSHFLDO FKDUDFWHU LV LQVHUWHG LQ WKH WH[W�

7LS

<RX PXVW XVH WKH QXPHULF NH\SDG LQ VWHS �� <RX FDQQRW XVH WKH QXPEHU
NH\V WKDW DUH DERYH WKH OHWWHUV RQ \RXU NH\ERDUG�
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Creating Special Effects
Warping Effects

:DUSLQJ OHWV \RX GLVWRUW DQ REMHFW E\ FKDQJLQJ WKH VXUIDFH RQ ZKLFK LW ZDV

GUDZQ� )RU H[DPSOH� LI \RX ZULWH \RXU QDPH RQ D GHIODWHG EDOORRQ DQG WKHQ

LQIODWH WKH EDOORRQ� \RXU QDPH EHFRPHV ZDUSHG�

<RX FDQ XVH ZDUSLQJ WR FUHDWH HIIHFWV WKDW DUH GLIILFXOW WR GUDZ� VXFK DV D

ZDWHU GURSOHW RU D KLOO\ VXUIDFH� <RX FDQ DOVR XVH ZDUSLQJ WR FUHDWH XQXVXDO

WH[W HIIHFWV� VXFK DV WH[W EHLQJ SXOOHG GRZQ D GUDLQ� $ ZDUSHG HIIHFW FDQ EH

HGLWHG OLNH DQ\ WZR�GLPHQVLRQDO REMHFW� <RX FDQ ZDUS JURXSHG RU

FRQQHFWHG REMHFWV�
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:KHQ \RX ZDUS DQ REMHFW� 'HVLJQHU SODFHV D ZDUS HQYHORSH RYHU LW� 7KH

HQYHORSH DSSHDUV DV D EOXH ZDUSLQJ JULG� $V \RX FKDQJH WKH HQYHORSH� WKH

REMHFW FKDQJHV XQGHUQHDWK�

<RX FDQ UHVKDSH WKH ZDUS HQYHORSH ZLWK OLQHV� FXUYHV� RU %H]LHU FRQWURO

SRLQWV� 7KH GHIDXOW UHVKDSH PHWKRG LV WKH ODVW RQH XVHG�

<RX FDQ DGG DQ XQZDUSHG� UHFWDQJXODU HQYHORSH WR DQ REMHFW� 7KH SUHYLRXV�

ZDUSHG HQYHORSH LV UHSODFHG ZLWK D QHZ HQYHORSH� 7KH REMHFW XQGHUQHDWK LV

XQFKDQJHG�

<RX FDQ XVH WKH 5HPRYH :DUS EXWWRQ WR UHPRYH WKH ODVW ZDUS HQYHORSH

\RX DGGHG� 5HPRYLQJ D ZDUS HQYHORSH UHVWRUHV WKH REMHFW XQGHUQHDWK WR LWV

SUHYLRXV VKDSH� ,I \RX KDYH DSSOLHG D VHULHV RI ZDUS HQYHORSHV WR DQ REMHFW�

\RX FDQ UHPRYH WKHP RQH DW D WLPH LQ UHYHUVH RUGHU ZLWK WKH 5HPRYH :DUS

EXWWRQ�

<RX FDQ LQFUHDVH WKH QXPEHU RI KRUL]RQWDO DQG YHUWLFDO OLQHV LQ D ZDUS

HQYHORSH WR JLYH \RX PRUH FRQWURO RYHU WKH ZDUS�

To war p an ob ject

1 6HOHFW WKH REMHFW WR ZDUS�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[�
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3 &OLFN :DUS EXWWRQ LQ WKH PHQX� $ EOXH ZDUS HQYHORSH DSSHDUV RYHU

WKH REMHFW�

4 3RLQW WR D KDQGOH DQG GUDJ LW WR FKDQJH WKH HQYHORSH�

5 5HSHDW VWHS � WR FUHDWH WKH GHVLUHG ZDUS�

6 'RXEOH FOLFN RU SUHVV ESC ZKHQ \RX ILQLVK WR UHPRYH WKH HQYHORSH�

To resha pe the war p envelo pe

1 6HOHFW WKH REMHFW WR ZDUS�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[�

3 &OLFN :DUS LQ WKH PHQX� $ EOXH ZDUS HQYHORSH DSSHDUV RYHU WKH

REMHFW�

4 &OLFN WKH :DUS 7\SH EXWWRQ DQG FKRRVH KRZ \RX ZDQW WR UHVKDSH WKH

ZDUS HQYHORSH�

5 &OLFN /LQH :DUS IURP WKH PHQX WR UHVKDSH WKH HQYHORSH ZLWK OLQHV

DQG QR FXUYHV�

6 &OLFN &XUYH :DUS IURP WKH PHQX WR FUHDWH FXUYLQJ OLQHV ZKHQ \RX

UHVKDSH SRLQWV RQ WKH HQYHORSH�

7 &OLFN %H]LHU :DUS IURP WKH PHQX WR UHVKDSH WKH HQYHORSH ZLWK %H]LHU

FRQWURO SRLQWV� <RX FDQ XVH WKH &XVS� &XUYH� DQG 6\PPHWULFDO &XUYH

EXWWRQV WR PRGLI\ WKH FRQWURO SRLQWVj PRYHPHQWV� LI \RX ZDQW�

8 3RLQW WR D KDQGOH DQG GUDJ LW WR FKDQJH WKH HQYHORSH�

9 5HSHDW VWHSV � DQG � WR FUHDWH WKH GHVLUHG ZDUS�

10 'RXEOH FOLFN RU SUHVV ESC ZKHQ \RX ILQLVK WR UHPRYH WKH HQYHORSH�

To add a new war p envelo pe

1 6HOHFW WKH REMHFW WR ZDUS�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[�

3 &OLFN :DUS RQ WKH PHQX� $ EOXH ZDUS HQYHORSH DSSHDUV RYHU WKH

REMHFW�

4 3RLQW WR D KDQGOH DQG GUDJ LW WR FKDQJH WKH HQYHORSH�
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5 5HSHDW VWHS � WR FUHDWH WKH GHVLUHG ZDUS�

6 &OLFN WKH $GG :DUS EXWWRQ RQ WKH ULEERQ� 7KH SUHYLRXV� ZDUSHG

HQYHORSH LV UHSODFHG ZLWK D QHZ HQYHORSH� 7KH REMHFW XQGHUQHDWK LV

XQFKDQJHG�

7 5HSHDW VWHSV � WKURXJK � WR FUHDWH WKH GHVLUHG ZDUS�

8 'RXEOH FOLFN RU SUHVV ESC ZKHQ \RX ILQLVK WR UHPRYH WKH HQYHORSH�

To remove a war p envelo pe

1 6HOHFW WKH REMHFW WR ZDUS�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[�

3 &OLFN :DUS RQ WKH PHQX� $ EOXH ZDUS HQYHORSH DSSHDUV RYHU WKH

REMHFW�

4 3RLQW WR D KDQGOH DQG GUDJ LW WR FKDQJH WKH HQYHORSH�

5 &OLFN WKH 5HPRYH :DUS EXWWRQ � 7KH REMHFW LV UHVWRUHG WR LWV

SUHYLRXV VKDSH�

6 'RXEOH FOLFN RU SUHVV ESC ZKHQ \RX ILQLVK WR UHPRYH WKH HQYHORSH�

To increase the densit y of a war p envelo pe

1 6HOHFW WKH REMHFW WR ZDUS�

2 &OLFN WKH (GLW WRRO LQ WKH WRROER[�

3 &OLFN :DUS RQ WKH PHQX� $ EOXH ZDUS HQYHORSH DSSHDUV RYHU WKH

REMHFW�

4 &OLFN WKH $GG +RUL]RQWDO /LQHV EXWWRQ WR GRXEOH WKH QXPEHU RI

KRUL]RQWDO HQYHORSH JULG OLQHV� RU

5 &OLFN WKH $GG 9HUWLFDO /LQHV EXWWRQ WR GRXEOH WKH QXPEHU RI

YHUWLFDO JULG OLQHV�

6 3RLQW WR D KDQGOH DQG GUDJ LW WR FKDQJH WKH HQYHORSH�

7 5HSHDW VWHS � WR FUHDWH WKH GHVLUHG ZDUS�
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8 'RXEOH FOLFN RU SUHVV ESC ZKHQ \RX ILQLVK WR UHPRYH WKH HQYHORSH�
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Skewing Effects

Skewing Manually

7KH PDQXDO PHWKRG OHWV \RX XVH WKH SRLQWHU WR VNHZ �VODQW� DQ REMHFW� <RX

PDQXDOO\ VNHZ E\ GUDJJLQJ D VLGH KDQGOH�

1RWH

%LWPDSV FDQQRW EH VNHZHG�

To skew an ob ject manuall y

1 &OLFN WKH 5RWDWH�6NHZ WRRO LQ WKH WRROEDU�

2 3RLQW WR D VLGH KDQGOH RI WKH REMHFW�

3 'UDJ WKH KDQGOH WR VNHZ WKH REMHFW�
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4 5HOHDVH WKH KDQGOH ZKHQ \RX DUH GRQH�

7LS

3UHVV DQG KROG CTRL ZKLOH GUDJJLQJ D VLGH KDQGOH WR FRQVWUDLQ WKH
VNHZLQJ RI DQ REMHFW WR ���GHJUHH LQFUHPHQWV� 3UHVV DQG KROG
SHIFT ZKLOH GUDJJLQJ D VLGH KDQGOH WR VNHZ D FRS\ RI DQ REMHFW�

<RX FDQ FDQFHO D VNHZ E\ SUHVVLQJ ESC EHIRUH UHOHDVLQJ WKH OHIW PRXVH

EXWWRQ 7KH REMHFW UHWXUQV WR LWV RULJLQDO SRVLWLRQ�

Skewing Numerically

<RX FDQ XVH WKH 6NHZ SDQHO RI WKH 7UDQVIRUP GLDORJ ER[ WR SUHFLVHO\ VNHZ D

REMHFW E\ VSHFLI\LQJ WKH GHJUHH RI VNHZ� 2SHQ WKH $UUDQJH PHQX� FKRRVH

7UDQVIRUP� DQG FKRRVH 6NHZ WR GLVSOD\ WKH 6NHZ SDQHO�

7KH 6NHZ SDQHO OHWV \RX VNHZ D REMHFW EDVHG RQ LWV FXUUHQW VKDSH� )RU

H[DPSOH� LI \RX VNHZ D VTXDUH �� GHJUHHV DQG WKHQ W\SH 45 WR VNHZ LW

DQRWKHU �� GHJUHHV� WKH REMHFW LV VNHZHG RQ DGGLWLRQDO �� GHJUHHV�

To skew an ob ject numericall y

1 6HOHFW WKH REMHFW \RX ZDQW WR VNHZ�

2 )URP WKH $UUDQJH PHQX� FOLFN 7UDQVIRUP�
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3 &OLFN 6NHZ WR GLVSOD\ WKH 6NHZ SDQHO�

4 7\SH DQ DQJOH IURP -89 WR 89 LQ WKH +RUL]RQWDO $QJOH ER[� RU GUDJ WKH

GLDO WR VSHFLI\ DQ DQJOH�

5 7\SH DQ DQJOH IURP -89 WR 89 LQ WKH 9HUWLFDO $QJOH ER[� RU GUDJ WKH

GLDO WR VSHFLI\ DQ DQJOH�

6 6HOHFW D GLIIHUHQW SLYRW SRLQW IRU WKH VODQW LQ WKH 2ULJLQ OLVW ER[� LI \RX

ZDQW�

7 &OLFN $SSO\ WR VNHZ WKH REMHFW�

To specif y a degree of slant

1 6HOHFW WKH REMHFW \RX ZDQW WR VNHZ�

2 2Q WKH $UUDQJH PHQX� FOLFN 7UDQVIRUP� $ VXEPHQX RSHQV�

3 &OLFN 6NHZ WR GLVSOD\ WKH 6NHZ SDQHO�

4 7\SH DQ DQJOH IURP �89 WR 89 LQ WKH +RUL]RQWDO $QJOH ER[� RU GUDJ WKH

GLDO WR VSHFLI\ DQ DQJOH�

5 7\SH DQ DQJOH IURP �89 WR 89 LQ WKH 9HUWLFDO $QJOH ER[� RU GUDJ WKH GLDO

WR VSHFLI\ DQ DQJOH�

6 6HOHFW D GLIIHUHQW SLYRW SRLQW IRU WKH VODQW LQ WKH 2ULJLQ OLVW ER[� LI \RX

ZDQW�

7 &OLFN $SSO\ WR VNHZ WKH REMHFW�
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Transparency

Applying Variable Transparency

HT_Transparency

<RX FDQ DSSO\ YDULDEOH WUDQVSDUHQF\ WR D FORVHG REMHFW� <RX FDQ DSSO\ WKH

WUDQVSDUHQF\ HYHQO\ DFURVV WKH REMHFW RU DSSO\ D OLQHDU� UDGLDO� VTXDUH� RU

FRQLFDO WUDQVSDUHQF\ JUDGLHQW�

1RWH

7UDQVSDUHQF\ LV QRW VXSSRUWHG LQ REMHFWV H[SRUWHG WR YHFWRU IRUPDWV�
+RZHYHU� LW LV VXSSRUWHG LQ ELWPDS IRUPDWV�

7LSV

$OWKRXJK \RX FDQ DSSO\ JUDGLHQW WUDQVSDUHQF\ WR DQ REMHFW WKDW KDV D
JUDGLHQW FRORU�ILOO� LW
V D JRRG LGHD WR H[SHULPHQW ZLWK JUDGLHQW
WUDQVSDUHQF\ RQ REMHFWV WKDW KDYH VROLG FRORU ILOOV�

,I \RX DSSO\ WUDQVSDUHQF\ WR DQ REMHFW ZLWK LQYLVLEOH FRORU ILOO� WKH
WUDQVSDUHQF\ LV DSSDUHQW RQO\ DORQJ WKH REMHFW
V OLQH� )LOO WKH REMHFW ZLWK DQ
RSDTXH FRORU�

RT_Transparency
RT_Transparency
HT_Transparency
7R DSSO\ YDULDEOH WUDQVSDUHQF\ WR DQ REMHFW

7R UHPRYH WUDQVSDUHQF\ IURP DQ REMHFW

To apply variable trans parency to an ob ject

1 6HOHFW D FORVHG REMHFW�

2 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[ WR GLVSOD\ WKH )RUPDW ULEERQ�
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3 2Q WKH ULEERQ� FOLFN HLWKHU WKH 6ROLG 7UDQVSDUHQF\ EXWWRQ RU WKH

*UDGLHQW 7UDQVSDUHQF\ EXWWRQ� 7KH 2EMHFW )RUPDW GLDORJ ER[ DSSHDUV�

4 ,I \RX ZDQW D G\QDPLF SUHYLHZ� FOLFN WKH 3UHYLHZ EXWWRQ�

5 'UDJ WKH 7UDQVSDUHQF\ &RQWURO VOLGHU WR DGMXVW WKH WUDQVSDUHQF\�

6 &OLFN WKH $SSO\ EXWWRQ ZKHQ \RX KDYH ILQLVKHG�

7LS

,I QR REMHFW LV VHOHFWHG� \RX VHW D QHZ GHIDXOW WUDQVSDUHQF\�

To remove trans parency from an ob ject

1 6HOHFW WKH REMHFW�

2 &OLFN WKH )RUPDW WRRO LQ WKH WRROER[ WR GLVSOD\ WKH )RUPDW ULEERQ�

3 2Q WKH ULEERQ� FOLFN WKH 5HPRYH 7UDQVSDUHQF\ EXWWRQ

RU

'UDJ WKH 7UDQVSDUHQF\ &RQWURO VOLGHU DOO WKH ZD\ WR WKH OHIW�
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Magnification

Using an Object to Magnify Other Objects

HT_Magnification

<RX FDQ XVH D FORVHG REMHFW DV D OHQV WKURXJK ZKLFK \RX YLHZ RWKHU REMHFWV�

<RX FDQ VSHFLI\ WKH OHYHO RI PDJQLILFDWLRQ� DQG \RX FDQ VSHFLI\ WKH SRUWLRQ RI

WKH GUDZLQJ WKDW LV PDJQLILHG�

1RWH

7KLV WRRO PDJQLILHV RQO\ WKRVH REMHFWV WKDW DUH IDUWKHU WRZDUG WKH EDFN
WKDQ WKH PDJQLI\LQJ REMHFW�

RT_Magnification
RT_Magnification
HT_Magnification
7R DSSO\ PDJQLILFDWLRQ

7R UHPRYH DQ REMHFW
V PDJQLILFDWLRQ

To apply magnification

1 &UHDWH RU VHOHFW WKH REMHFW WKDW ZLOO EHFRPH D PDJQLI\LQJ REMHFW�

2 0RYH WKH REMHFW WR WKH DUHD \RX ZDQW WR PDJQLI\�

3 2Q WKH 7RROV PHQX� FOLFN 0DJQLI\� 7KH 0DJQLI\ GLDORJ ER[ DSSHDUV�

4 &OLFN WKH (QDEOH FKHFNER[ WR VSHFLI\ WKDW \RX ZDQW WR PDNH WKH

FXUUHQWO\ VHOHFWHG REMHFW D PDJQLI\LQJ REMHFW�

5 6HW WKH PDJQLILFDWLRQ DPRXQW DV GHVLUHG� $ VHWWLQJ RI OHVV WKDQ ���

VKULQNV WKH YLHZHG DUHD LQVWHDG RI PDJQLI\LQJ LW�

6 &OLFN WKH $SSO\ EXWWRQ WR XSGDWH WKH PDJQLI\LQJ REMHFW ZLWK WKH DUHD

EHLQJ PDJQLILHG�

7 0RYH DQG UHVL]H WKH VKDSH DV UHTXLUHG WR VKRZ WKH GHVLUHG YLHZLQJ

SRLQW ZLWKLQ LW�
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8 :KHQ \RX DUH VDWLVILHG ZLWK WKH YLHZLQJ SRLQW� FOLFN WKH )UHH]H

9LHZSRLQW FKHFNER[� DQG FOLFN $SSO\ WR ORFN WKH YLHZ� $IWHU IUHH]LQJ

WKH YLHZLQJ SRLQW� \RX FDQ PRYH WKH PDJQLI\LQJ REMHFW DQG FKDQJH LWV

VKDSH� VL]H� DQG PDJQLILFDWLRQ OHYHO ZLWKRXW FKDQJLQJ WKH YLHZLQJ SRLQW�

7LS

7R XSGDWH WKH YLHZLQJ SRLQW� FOHDU WKH )UHH]H YLHZSRLQW FKHFNER[� FOLFN
$SSO\� DQG PRYH WKH PDJQLI\LQJ REMHFW WR WKH QHZ GHVLUHG SRVLWLRQ�

RT_To_A pply_Magnification
RT_To_Apply_Magnification
8VLQJ DQ 2EMHFW WR 0DJQLI\ 2WKHU 2EMHFWV

7R UHPRYH DQ REMHFW
V PDJQLILFDWLRQ

To remove an ob ject’s ma gnification

1 6HOHFW WKH REMHFW�

2 2Q WKH 7RROV PHQX� FOLFN 0DJQLI\� 7KH 0DJQLI\ GLDORJ ER[ DSSHDUV�

3 &OLFN WKH (QDEOH FKHFNER[ WR FOHDU LW�

4 &OLFN WKH $SSO\ EXWWRQ�

RT_To_remove_an_ob jects_ma gnification
RT_To_remove_an_objects_magnification
8VLQJ DQ 2EMHFW WR 0DJQLI\ 2WKHU 2EMHFWV

7R DSSO\ PDJQLILFDWLRQ
288 i G r a f x  D e s i g n e r



Blending Effects

%OHQGLQJ OHWV \RX EOHQG RQH VKDSH DQG FRORU LQWR DQRWKHU� <RX FDQ SURGXFH

WZR W\SHV RI HIIHFWV E\ EOHQGLQJ REMHFWV� 7UDQVIRUPDWLRQ (IIHFWV DQG

+LJKOLJKWLQJ (IIHFWV�

<RX FDQ VSHFLI\ WKH QXPEHU RI WUDQVIRUPDWLRQV� RU VWHSV� EHWZHHQ WKH WZR

REMHFWV LQ WKH %OHQG GLDORJ ER[� (DFK VWHS LV D GLIIHUHQW REMHFW VOLJKWO\ FKDQJHG

WR ORRN PRUH OLNH WKH VHFRQG REMHFW� 7KH PRUH VWHSV \RX XVH� WKH FORVHU �DQG

VPRRWKHU� WKH WUDQVIRUPLQJ REMHFWV DUH� <RX FDQ XVH DV PDQ\ DV ���� VWHSV�

'HVLJQHU EOHQGV D SRLQW RQ WKH ILUVW REMHFW WR D FRUUHVSRQGLQJ SRLQW RQ WKH

VHFRQG REMHFW� <RX FDQ FKDQJH WKH RULJLQV RI WKH REMHFWV EHIRUH EOHQGLQJ�

2EMHFWV DUH GUDZQ HLWKHU FORFNZLVH RU FRXQWHUFORFNZLVH IURP D VWDUWLQJ

SRLQW� )RU H[DPSOH� FORVHG REMHFWV DUH GUDZQ FRXQWHUFORFNZLVH� :KHQ

'HVLJQHU EOHQGV REMHFWV� LW PDWFKHV FRUUHVSRQGLQJ SRLQWV RI WKH WZR REMHFWV

VR WKDW WKH RUGHU WKH SRLQWV ZHUH GUDZQ GHWHUPLQHV WKH DSSHDUDQFH RI WKH

EOHQG� <RX FDQ UHYHUVH WKH ZD\ 'HVLJQHU QRUPDOO\ FRPSDUHV SRLQWV LI \RX

GRQjW OLNH WKH UHVXOWV RI WKH EOHQG

2EMHFWV EOHQG IURP WKH EDFN WR WKH IURQW REMHFW �WKH REMHFW LQ IURQW LV WKH

RQH \RX GUHZ ODVW�� �<RX FDQ FKDQJH WKH RUGHU RI REMHFWV�� 'HVLJQHU FDQQRW

EOHQG SDWWHUQV� EXW LW EOHQGV WKH SDWWHUQ FRORU DQG SODFHV WKH SDWWHUQ LQ DOO

WKH WUDQVIRUPDWLRQV�
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,I WKH REMHFWV KDYH GLIIHUHQW SDWWHUQV �IRU H[DPSOH� D KDWFK DQG D JUDGLHQW��

'HVLJQHU SODFHV WKH SDWWHUQ RI WKH IURQW REMHFW LQ DOO WKH WUDQVIRUPDWLRQV�

'HVLJQHU GRHV QRW SODFH ELWPDS SDWWHUQV LQ WUDQVIRUPDWLRQV�

7LSV

%OHQGLQJ UHVXOWV DUH XVXDOO\ EHWWHU ZLWK XQFRPSOLFDWHG REMHFWV�

/DUJH QXPEHUV RI VWHSV FDQ VORZ UHGUDZ WLPH�

<RX PD\ KDYH WR WU\ VHYHUDO GLIIHUHQW VHWWLQJV WR ILQG WKH RQHV WKDW JLYH WKH
HIIHFW \RX ZDQW�

'HVLJQHU FDQQRW EOHQG JURXSHG� ELWPDS� RU WH[W REMHFWV� <RX FDQ &RQYHUW
7H[W WR &XUYHV DQG WKHQ EOHQG LW�

Transformation Effects

7KLV EOHQGLQJ HIIHFW JLYHV WKH LOOXVLRQ RI RQH REMHFW FKDQJLQJ LQWR DQRWKHU�

Highlighting Effects

7KLV EOHQGLQJ HIIHFW OHWV \RX JLYH �VSRW� KLJKOLJKWV DQG VKDGRZV WR \RXU

GUDZLQJV WR KHOS JLYH WKHP GHSWK� %OHQGLQJ WR FUHDWH D KLJKOLJKW JLYHV D

JUDGLHQW�OLNH HIIHFW� EXW LW OHWV \RX FUHDWH KLJKOLJKWV DQG VKDGRZV ZLWK PRUH

WUDQVLWLRQV�
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To blend two ob jects

1 6HOHFW WKH REMHFWV \RX ZDQW WR EOHQG�

2 &OLFN %OHQG LQ WKH (IIHFWV PHQX� 7KH %OHQG GLDORJ ER[ RSHQV�

3 &KRRVH WKH VHWWLQJV \RX ZDQW�

4 &OLFN $SSO\� 7KH REMHFWV DUH EOHQGHG� 7KH GLDORJ ER[ VWD\V RSHQ VR \RX

FDQ FRQWLQXH WR EOHQG REMHFWV�

7LS

<RX PD\ KDYH WR WU\ VHYHUDO GLIIHUHQW VHWWLQJV WR ILQG WKH RQHV WKDW JLYH WKH
HIIHFW \RX ZDQW�

To chan ge the ori gins before blendin g

1 6HOHFW WKH REMHFWV \RX ZDQW WR EOHQG�

2 2Q WKH (IIHFWV PHQX� FOLFN %OHQG� 7KH %OHQG GLDORJ ER[ RSHQV�

3 &OLFN &KRRVH 2ULJLQV�

4 2Q WKH EDFN REMHFW� FOLFN D KROORZ ER[ WR VHOHFW WKDW SRVLWLRQ DV WKH

RULJLQ�

5 2Q WKH IURQW REMHFW� FOLFN WKH KROORZ ER[ LQ WKH SRVLWLRQ \RX ZDQW WR

FRUUHVSRQG WR WKH SRLQW \RX FOLFNHG RQ WKH EDFN REMHFW�

6 &OLFN &KRRVH 2ULJLQV DJDLQ WR GHVHOHFW LW�

7 &KRRVH WKH RWKHU VHWWLQJV \RX ZDQW�

8 &OLFN $SSO\� 7KH REMHFWV DUH EOHQGHG� 7KH GLDORJ ER[ VWD\V RSHQ VR \RX

FDQ FRQWLQXH WR EOHQG REMHFWV�

7LS

<RX PD\ KDYH WR WU\ VHYHUDO GLIIHUHQW VHWWLQJV WR ILQG WKH RQHV WKDW JLYH WKH
HIIHFW \RX ZDQW�
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To reverse the blend direction

1 6HOHFW WKH REMHFWV \RX ZDQW WR EOHQG�

2 &OLFN %OHQG LQ WKH (IIHFWV PHQX� 7KH %OHQG GLDORJ ER[ RSHQV�

3 &OLFN 5HYHUVH 'LUHFWLRQ�

4 &KRRVH WKH RWKHU VHWWLQJV \RX ZDQW�

5 &OLFN $SSO\� 7KH REMHFWV DUH EOHQGHG� 7KH GLDORJ ER[ VWD\V RSHQ VR \RX

FDQ FRQWLQXH WR EOHQG REMHFWV�

7LS

<RX PD\ KDYH WR WU\ VHYHUDO GLIIHUHQW VHWWLQJV WR ILQG WKH RQHV WKDW JLYH WKH
HIIHFW \RX ZDQW�
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Special Text Effects

'HVLJQHU OHWV \RX FUHDWH D YDULHW\ RI VSHFLDO HIIHFWV� LQFOXGLQJ ZUDSSLQJ WH[W

DURXQG DQ REMHFW DQG IORZLQJ WH[W IURP RQH FRQWDLQHU WR DQRWKHU�

Converting Text to Curves

<RX FDQ FRQYHUW RXWOLQH IRQWV LQWR VWDQGDUG 'HVLJQHU REMHFWV� 7KLV OHWV \RX

UHVKDSH WH[W MXVW DV \RX ZRXOG DQ\ RWKHU 'HVLJQHU REMHFW�

&RQYHUWLQJ WH[W WR FXUYHV LV XVHIXO ZKHQ \RX ZDQW WR UHVKDSH WH[W RU FUHDWH

D GUDZLQJ WKDW FDQ EH RSHQHG RQ D FRPSXWHU WKDW GRHV QRW KDYH WKH RULJLQDO

W\SHIDFH� <RX FDQ FRQYHUW ERWK IUHHIRUP DQG EORFN WH[W WR FXUYHV�

$OO IRQWV LQFOXGHG ZLWK 'HVLJQHU DUH VFDODEOH RXWOLQH IRQWV� 7KH PRVW

FRPPRQ RXWOLQH IRQWV DUH 7UXH7\SH DQG 7\SH �� ,I \RX WU\ WR FRQYHUW D QRQ�

RXWOLQH IRQW� 'HVLJQHU VXEVWLWXWHV WKH GHIDXOW IRQW EHIRUH FRQYHUWLQJ LW�

<RX FDQ FKDQJH WKH GHIDXOW IRQW E\ PRGLI\LQJ DQ HQWU\ LQ \RXU V\VWHP UHJLVWU\�

2Q WKH 5HJLVWU\ WDE RI WKH 2SWLRQV GLDORJ ER[� DGG WKH 9DOXH 1DPH

'HIDXOW)RQW WR WKH 0J[JUH NH\� DQG VHW LWV YDOXH WR WKH QDPH RI WKH IRQW \RX

ZDQW WR XVH �IRU H[DPSOH� 7LPHV 1HZ 5RPDQ��
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$IWHU \RX FRQYHUW WH[W WR FXUYHV� WKH REMHFWV DUH QR ORQJHU WH[W REMHFWV� <RX

FDQQRW LQVHUW RU GHOHWH WH[W� FKHFN WKH VSHOOLQJ� FKDQJH DQ\ RI WKH SDUDJUDSK

RSWLRQV� RU PDNH DQ\ RWKHU WH[W HGLWV� 7H[W FRQYHUWHG WR REMHFW RXWOLQHV FDQ

EH FKDQJHG EDFN WR WH[W RQO\ ZLWK WKH 8QGR FRPPDQG�

To convert text to ob ject outlines

1 6HOHFW WKH WH[W WR FRQYHUW�

2 &OLFN &RQYHUW WR &XUYHV LQ WKH 2EMHFW PHQX�

3 2Q WKH $UUDQJH PHQX� FOLFN 'LVFRQQHFW� <RX FDQ QRZ FOLFN LQGLYLGXDO

FKDUDFWHUV WR VHOHFW WKHP� 7KH WH[W FRQYHUWV WR DQ REMHFW RXWOLQH�
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Working with Bitmap Images
Overview of Working with Bitmap Images

<RX FDQ PRYH� UHVL]H� GHOHWH� UHRUGHU �PRYH LW WR WKH IURQW� IRU H[DPSOH��

IOLS KRUL]RQWDOO\ RU YHUWLFDOO\� GXSOLFDWH� DQG FURS D ELWPDS� <RX FDQ DOVR

FRORU D ELWPDS LPDJH LI \RX KDYH LPSRUWHG LW DV PRQRFKURPH�

8VH L*UDI[ %XVLQHVV ,PDJH ZKHQ \RX ZDQW WR HGLW D ELWPDS LPDJH

H[WHQVLYHO\ �IRU H[DPSOH� LI \RX ZDQW WR FKDQJH D IURZQ WR D VPLOH LQ D

SKRWRJUDSK��

7LSV

<RX FDQQRW URWDWH RU VNHZ ELWPDS LPDJHV LQ 'HVLJQHU� 8VH 3LFWXUH
3XEOLVKHU WR URWDWH RU VNHZ D ELWPDS LPDJH�

<RX FDQQRW HGLW ELWPDS LPDJHV OLNH YHFWRU GUDZLQJV� +RZHYHU� \RX FDQ
WUDFH D ELWPDS WR SURGXFH D 'HVLJQHU REMHFW WKDW \RX FDQ HGLW�

%LWPDSV FDQ DGG YDULHW\ DQG YLVXDO DSSHDO WR \RXU GUDZLQJV� +HUH DUH VRPH

H[DPSOHV RI ZKDW \RX FDQ GR ZLWK ELWPDSV�

v $GG VFDQQHG SKRWRJUDSKV WR D UHSRUW RU SUHVHQWDWLRQ�

v 8VH D ELWPDS DV D EDFNJURXQG IRU \RXU LOOXVWUDWLRQ�

v &UHDWH D OLEUDU\ RI ELWPDS LPDJHV WR XVH LQ \RXU GUDZLQJV�

v 7UDFH ELWPDSV DQG WKHQ HGLW WKH WUDFLQJ OLNH DQ RUGLQDU\ 'HVLJQHU

REMHFW�
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v $GG WH[W� ERUGHUV� RU D GURS VKDGRZ WR HQKDQFH WKH ELWPDS�

7LS

<RX FDQ SULQW D ELWPDS RQ D SULQWHU� EXW QRW RQ D SHQ SORWWHU�

Bitmap Import Options

<RX FDQ LPSRUW WKH IROORZLQJ ELWPDS IRUPDWV LQWR D 'HVLJQHU GRFXPHQW�

%03� ',%� *,)� -3*� 3&'� 3&;� 5$6� 7*$� DQG 7,)�

<RX FDQ FOLFN 6HWXS LQ WKH ,PSRUW GLDORJ ER[ WR FKDQJH KRZ D ELWPDS ORRNV

ZKHQ \RX LPSRUW LW� )RU H[DPSOH� \RX FDQ LPSRUW D FRORU LPDJH DV D

JUD\VFDOH LPDJH LI \RX LQWHQG WR UHSURGXFH LW RQ D QRQ�FRORU SULQWHU�

&KDQJLQJ DQ LPSRUW RSWLRQ GRHV QRW FKDQJH WKH RULJLQDO ELWPDS ILOH�

%\ GHIDXOW� 'HVLJQHU LPSRUWV WKH LPDJH DV LW ZDV RULJLQDOO\ VDYHG� ,I \RX FKDQJH

WKH LPSRUW RSWLRQV E\ XVLQJ 6HWXS LQ WKH ,PSRUW GLDORJ ER[� WKH QHZ LPSRUW

RSWLRQV EHFRPH WKH QHZ GHIDXOW IRU DOO ELWPDS LPDJHV�

7R OHDUQ PRUH DERXW LPSRUWLQJ� VHH ,PSRUWLQJ DQG ([SRUWLQJ )LOHV

Editing a Bitmap Image

<RX FDQ HGLW D ELWPDS LPDJH E\ VHOHFWLQJ LW� FOLFNLQJ WKH %LWPDS WRRO � DQG

FKRRVLQJ DQ HGLWLQJ RSWLRQ LQ WKH %LWPDS ULEERQ� ,I \RX ZDQW WR PDNH PRUH

H[WHQVLYH HGLWV WR DQ LPDJH� \RX FDQ XVH D ELWPDS�HGLWLQJ SURJUDP VXFK DV

3LFWXUH 3XEOLVKHU�

<RX FDQ XVH 'HVLJQHU WR FURS RU WUDFH D ELWPDS LPDJH WKDW LV QRW DQ 2/(

REMHFW� :KHQ \RX GRXEOH FOLFN D QRQ�2/( ELWPDS LPDJH� 3LFWXUH 3XEOLVKHU

RSHQV WR HGLW WKH ELWPDS LPDJH�

,I \RX ZDQW WR HGLW D ELWPDS LPDJH WKDW LV DQ 2/( REMHFW �DV LQGLFDWHG LQ

'HVLJQHUjV VWDWXV EDU�� \RX FDQQRW HGLW LW ZLWK 'HVLJQHUjV FURSSLQJ RU WUDFLQJ

WRROV� :KHQ \RX GRXEOH FOLFN WKH 2/( REMHFW� WKH SURJUDP WKDW VXSSOLHG WKH

REMHFW DXWRPDWLFDOO\ RSHQV WR HGLW WKH REMHFW�
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<RX FDQ RSHQ L*UDI[ %XVLQHVV ,PDJH ZLWK WKH (GLW %LWPDS EXWWRQ LQ WKH

%LWPDS ULEERQ� <RX FDQ DOVR PRYH SLFWXUHV EHWZHHQ 3LFWXUH 3XEOLVKHU DQG

'HVLJQHU XVLQJ WKH &OLSERDUG RU WKH ,PSRUW DQG ([SRUW FRPPDQGV�

1RWH

$ ELWPDS LPDJH WKDW LV SDVWHG DV DQ 2/( REMHFW �WKDW LV� LW LV HPEHGGHG RU
OLQNHG� FDQQRW EH HGLWHG LQ 'HVLJQHU�

Coloring Monochrome Images

<RX FDQ FKDQJH WKH IRUHJURXQG DQG EDFNJURXQG RI D VHOHFWHG PRQRFKURPH

ELWPDS LPDJH ZLWK WKH )RUHJURXQG EXWWRQ DQG %DFNJURXQG EXWWRQ� 6HOHFW

WKH LPDJH� FOLFN WKH )RUHJURXQG EXWWRQ RU %DFNJURXQG EXWWRQ� DQG FOLFN D

FRORU IURP WKH FRORU SDOHWWH�

7KH IRUHJURXQG FRORU FKDQJHV WKH FRORU RI WKH LPDJH LWVHOI� 7KH EDFNJURXQG

FRORU FKDQJHV WKH FRORU RI WKH VXUURXQGLQJ DUHD�

7LS

7R LPSRUW DQ LPDJH DV PRQRFKURPH� VHOHFW 0RQRFKURPH IURP WKH VHWXS
RSWLRQV LQ WKH ,PSRUW GLDORJ ER[� 7KH QHZO\ LPSRUWHG LPDJH LV EODFN
�IRUHJURXQG FRORU� DQG ZKLWH �EDFNJURXQG FRORU��

Cropping a Bitmap Image

&URSSLQJ OHWV \RX VKRZ RQO\ WKH SDUW RI WKH ELWPDS LPDJH \RX ZDQW� WKH UHVW

LV KLGGHQ� &URSSHG SRUWLRQV RI WKH ELWPDS DUH UHWDLQHG VR \RX FDQ XQFURS

WKHP ODWHU�

&URSSLQJ LV DQ HGLWLQJ WHFKQLTXH WKDW FDQ LPSURYH \RXU ILQDO GUDZLQJ� )RU

H[DPSOH� \RX FDQ HOLPLQDWH GLVWUDFWLQJ DUHDV RI DQ LPDJH WR KHOS IRFXV RQ WKH

FHQWHU RI LQWHUHVW� <RX DOVR FDQ FURS WR HOLPLQDWH HUURUV RU WR KHOS ILW WKH

ELWPDS LQWR WKH OD\RXW�
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&URSSLQJ DQ LPDJH LQ 'HVLJQHU LQYROYHV WZR VWHSV� FUHDWLQJ D UHFWDQJXODU

PDVN ODUJH HQRXJK WR VKRZ WKH GHVLUHG DUHD� DQG PRYLQJ WKH LPDJH VR WKDW

WKH FRUUHFW DUHD VKRZV WKURXJK WKH PDVN�

7LS

,Q 'HVLJQHU ��� DQG EHIRUH� \RX PRYHG WKH PDVN LQVWHDG RI WKH LPDJH�

To cro p an ima ge in Desi gner

1 6HOHFW WKH ELWPDS LPDJH \RX ZDQW WR FURS�

2 &OLFN WKH %LWPDS WRRO LQ WKH WRROER[�

3 &OLFN WKH &URS EXWWRQ LQ WKH ULEERQ� 7KH ELWPDS LV KLJKOLJKWHG DQG

KDQGOHV DSSHDU DURXQG WKH FURS PDVN�

4 5HVL]H WKH FURS PDVN XQWLO LW LV WKH VL]H \RX ZDQW�

5 0RYH WKH SRLQWHU RQWR WKH LPDJH� 3UHVV DQG KROG WKH PRXVH EXWWRQ�

DQG SRVLWLRQ WKH LPDJH XQGHU WKH FURS PDVN�

6 5HOHDVH WKH PRXVH EXWWRQ ZKHQ \RX ILQLVK�

7 5HSHDW VWHSV � WKURXJK � WR DGMXVW WKH FURS� LI QHFHVVDU\�

8 'RXEOH FOLFN RU SUHVV ESC WR VWRS FURSSLQJ�
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Tracing Bitmaps

7UDFLQJ D ELWPDS LPDJH FUHDWHV D YHFWRU FRS\ WKDW FORVHO\ UHVHPEOHV WKH

RULJLQDO LPDJH� :KHQ XVLQJ D VLPSOH ELWPDS LPDJH� LW LV RIWHQ HDVLHU DQG OHVV

VSDFH FRQVXPLQJ WR WUDFH LW DQG WKHQ HGLW WKH YHFWRU WUDFLQJ�

9HFWRU GUDZLQJV XVH OHVV GLVN VSDFH DQG PHPRU\ WKDQ ELWPDSV� 6LQFH GUDZLQJ

ILOHV FRQWDLQLQJ ELWPDSV FDQ EH TXLWH ODUJH� FRQYHUWLQJ ELWPDS LPDJHV WR

YHFWRU GUDZLQJV VDYHV GLVN VSDFH�

<RX FDQ FUHDWH LQWHUHVWLQJ YLVXDO HIIHFWV E\ WUDFLQJ� )RU H[DPSOH� ZLWK D OLWWOH

H[SHULPHQWDWLRQ� \RX FDQ FUHDWH VW\OL]HG JUDSKLFV RU GUDZLQJV WKDW ORRN OLNH

HWFKLQJV�

Basics of Tracing

'HVLJQHU WUDFHV DQ LPDJH E\ VHDUFKLQJ LW IRU FRORU RU JUD\VFDOH YDULDWLRQV�

:KHQ WKH FRORU GLIIHUHQFH LV JUHDW HQRXJK� 'HVLJQHU GUDZV D OLQH EHWZHHQ

WKH GLIIHUHQW FRORUV�

:KHQ 'HVLJQHU ILQLVKHV WUDFLQJ� WKH RULJLQDO ELWPDS LPDJH LV EHKLQG WKH

WUDFLQJ DQG WKH WUDFLQJ LV VHOHFWHG�

Tracin g an Entire Bitma p Image

3UHVV DQG KROG SHIFT DQG FOLFN WKH ELWPDS LPDJH�

Tracin g the Rectan gular Area of a Bitma p Image

6HOHFW WKH ELWPDS LPDJH DQG GUDJ D UHFWDQJOH RYHU DQ DUHD RI WKH LPDJH� 7KH

DUHD LQ WKH UHFWDQJOH LV WUDFHG�

Tracin g an Object in a Bitma p Image

:HOO�GHILQHG DUHDV LQ DQ LPDJH DUH FDOOHG REMHFWV� )RU H[DPSOH� LQ DQ LPDJH

FRQWDLQLQJ D EHDFK EDOO LQ WKH RFHDQ� WKH EHDFK EDOO LV DQ REMHFW� 7KH PRUH DQ

REMHFW FRQWUDVWV ZLWK LWV VXUURXQGLQJ DUHD� WKH PRUH VXFFHVVIXO WKH WUDFLQJ ZLOO

EH�

7R WUDFH DQ REMHFW� VHOHFW WKH LPDJH DQG FOLFN LQVLGH WKH REMHFW WR WUDFH LW�
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Stop Tracin g

3UHVV ESC WR VWRS D WUDFH EHIRUH LW LV FRPSOHWHG�

Setting Tracing Options

7UDFLQJ RSWLRQV OHW \RX GHWHUPLQH WKH PHWKRG DQG GHJUHH RI GHWDLO 'HVLJQHU

XVHV WR WUDFH ELWPDS LPDJHV� <RX VHW WUDFLQJ RSWLRQV LQ WKH %LWPDS ULEERQ�

2SWLRQV UHPDLQ LQ HIIHFW XQWLO \RX FKDQJH WKHP�

Showing and Hiding the Bitmap

8VH WKH 6KRZ %LWPDS EXWWRQ WR VKRZ RU KLGH WKH ELWPDS� &KRRVH 6KRZ

�WKH GHIDXOW� WR GLVSOD\ WKH RULJLQDO ELWPDS LPDJH DV LW DSSHDUHG EHIRUH WKH

WUDFH� &KRRVH +LGH WR FRQFHDO WKH ELWPDS LPDJH DIWHU LW LV WUDFHG VR WKDW RQO\

WKH WUDFHG REMHFWV DSSHDU�

Setting the Trace Quality

8VH WKH 7UDFH 4XDOLW\ EXWWRQ WR DGMXVW KRZ DFFXUDWHO\ DQG VPRRWKO\

'HVLJQHU WUDFHV D ELWPDS�

&KRRVH )LQH IRU WKH KLJKHVW TXDOLW\ WUDFH� )LQH WUDFLQJV XVH WKH ODUJHVW

QXPEHU RI UHVKDSH SRLQWV� )LQH WUDFLQJV FDQ XVH D ORW RI PHPRU\ DQG EH

GLIILFXOW WR HGLW EHFDXVH WKH\ FUHDWH D ODUJH QXPEHU RI DQFKRUV�

$YHUDJH VHWWLQJ LV WKH GHIDXOW� ,Q PRVW VLWXDWLRQV� DYHUDJH WUDFLQJ LV WKH EHVW

FKRLFH�

&RDUVH SURGXFHV WKH OHDVW DFFXUDWH WUDFLQJ EHFDXVH LW XVHV WKH IHZHVW SRLQWV�

&RDUVH WUDFLQJV XVH WKH OHDVW PHPRU\ DQG DUH WKH HDVLHVW WR HGLW�

Setting Noise and Color Controls

<RX FDQ UHVWULFW WKH QXPEHU RI FRORUV LQ WKH UHVXOW RI D WUDFH� &OLFN WKH

&RORUV ER[ RQ WKH %LWPDS ULEERQ� DQG WKHQ FOLFN WKH PD[LPXP QXPEHU RI

FRORUV WKDW \RX ZDQW WKH WUDFH WR KDYH�
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7KH QRLVH FRQWURO RQ WKH %LWPDS ULEERQ KHOSV HOLPLQDWH VWUD\ SL[HOV

LQWURGXFHG E\ D SRRU�TXDOLW\ LPDJH� <RX FDQ HQWHU D YDOXH UDQJLQJ IURP �

WKURXJK ���� /DUJHU QXPEHUV H[FOXGH ODUJHU JURXSV RI VWUD\ SL[HOV�

Setting the Line Type

8VH WKH /LQH 7\SH EXWWRQ WR FKRRVH ZKHWKHU 'HVLJQHU XVHV OLQHV RU

FXUYHV WR FUHDWH WKH WUDFLQJ�

&KRRVH /LQHV WR FUHDWH WUDFLQJV ZLWK VWUDLJKW OLQH VHJPHQWV �QR FXUYHV�� 8VH

WKLV VHWWLQJ ZKHQ WKH LPDJH KDV IHZ FXUYHV�

&KRRVH &XUYHV WR FUHDWH WUDFLQJV ZLWK FXUYHV� ,W LV VOLJKWO\ PRUH DFFXUDWH

WKDQ XVLQJ OLQHV�

Tips for Tracing

.HHS WKH IROORZLQJ LQ PLQG ZKHQ WUDFLQJ LPDJHV�

v %LWPDSV ZLWK IHZ FRORUV JHQHUDOO\ WUDFH EHVW� 8VH 3LFWXUH 3XEOLVKHU WR

UHGXFH WKH QXPEHU RI FRORUV LQ D ELWPDS LPDJH EHIRUH \RX WUDFH�

v *UD\VFDOH LPDJHV WUDFH EHWWHU WKDQ FRORU LPDJHV� 0RQRFKURPH LPDJHV�

KRZHYHU� WUDFH EHVW RI DOO�

v 'RQjW WUDFH ELWPDS WH[W� $GG WH[W WR D GUDZLQJ ZLWK 'HVLJQHUjV 7H[W

WRRO � 6FDQQHG WH[W DQG WH[W DGGHG ZLWK DQ LPDJH HGLWRU DUH RI

ORZHU TXDOLW\�

v 6LPSOH� XQFRPSOLFDWHG LPDJHV WUDFH EHWWHU WKDQ FRPSOLFDWHG RQHV�

v 'DUN REMHFWV RQ OLJKW EDFNJURXQGV DUH EHVW� ,I \RX KDYH D GDUN

EDFNJURXQG� XVH L*UDI[ %XVLQHVV ,PDJH WR OLJKWHQ LW EHIRUH WUDFLQJ�

7LSV

5HPHPEHU� \RX FDQ SUHVV ESC DW DQ\ WLPH WR VWRS WKH WUDFH�

)RU GHWDLOV RQ UHGXFLQJ WKH QXPEHU RI SRLQWV LQ WUDFHG ELWPDSV� VHH
6PRRWKLQJ DQ 2EMHFW�
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To trace a bitma p

1 &OLFN WKH %LWPDS WRRO LQ WKH WRROER[�

2 6HOHFW WKH ELWPDS LPDJH \RX ZDQW WR WUDFH�

3 'UDJ D UHFWDQJOH RYHU DQ DUHD RI WKH LPDJH� 7KH DUHD LQ WKH UHFWDQJOH LV

WUDFHG� $ ERUGHU DSSHDUV DURXQG WKH LPDJH� DQG 'HVLJQHU GUDZV WKH

WUDFLQJ LQ IURQW RI WKH RULJLQDO LPDJH�

4 $IWHU WUDFLQJ� FOLFN RXWVLGH RI WKH ERUGHU� SRLQW WR WKH LPDJH DQG GUDJ

WKH WUDFLQJ RII RI WKH ELWPDS� LI QHFHVVDU\�
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Printing Your Work
Adding, Removing, and Connecting Printers

:LQGRZV XVHV D VRIWZDUH SURJUDP FDOOHG D SULQWHU GULYHU WKDW

FRPPXQLFDWHV ZLWK \RXU SULQWHU RU RWKHU RXWSXW GHYLFH� 3ULQWHU GULYHUV DUH

SURYLGHG ZLWK :LQGRZV�

7KH :LQGRZV &RQWURO 3DQHO OHWV \RX DGG� UHPRYH� DQG VHW XS SULQWHU

GULYHUV� <RX FDQ DGG PXOWLSOH SULQWHU GULYHUV LI \RX XVH PRUH WKDQ RQH W\SH

RI SULQWHU�

,I \RX ZDQW WR XVH D SULQWHU WKDW LV QRW FRQQHFWHG WR \RXU FRPSXWHU� \RX

FDQ IRUFH WKH GULYHU WR VHQG LWV RXWSXW GLUHFWO\ WR D ILOH RQ GLVN E\ VSHFLI\LQJ

),/( DV WKH SULQWHU SRUW� <RX WKHQ FDQ WDNH WKH GLVN WR D FRPSXWHU WKDW LV

FRQQHFWHG WR WKH GHVLUHG SULQWHU DQG FRS\ �XVLQJ WKH &23< FRPPDQG LQ

'26� WKH RXWSXW ILOH WR WKH SULQWHU�

6HH \RXU :LQGRZV GRFXPHQWDWLRQ IRU LQVWUXFWLRQV RQ DGGLQJ RU UHPRYLQJ

D SULQWHU DQG FRQQHFWLQJ D SULQWHU WR D SRUW�
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Selecting and Setting Up Your Printer

$IWHU \RX DGG D SULQWHU� \RX FDQ VHOHFW DQG VHW XS WKH WDUJHW �GHIDXOW� SULQWHU

ZLWK WKH :LQGRZV &RQWURO 3DQHO� RU \RX FDQ VHOHFW D SULQWHU DQG FKDQJH WKH

VHWXS DV QHHGHG LQ 'HVLJQHU� 6HWXS FKRLFHV YDU\ IURP RQH SULQWHU WR DQRWKHU�

EXW FRPPRQ RSWLRQV LQFOXGH FKDQJLQJ WKH RULHQWDWLRQ �SRUWUDLW RU

ODQGVFDSH�� SDSHU VL]H� DQG SDSHU VRXUFH�

<RX FDQ VHOHFW WKH WDUJHW SULQWHU DQG FKDQJH WKH VHWXS RI WKH SULQWHU IURP

WKH 3ULQW 'RFXPHQW GLDORJ ER[�

Selectin g the Tar get Printer

7R FKDQJH WKH WDUJHW SULQWHU� FOLFN WKH SULQWHU QDPH LQ WKH 3ULQW 'RFXPHQW

GLDORJ ER[� 7KH ER[ RSHQV WR VKRZ WKH OLVW RI LQVWDOOHG SULQWHUV� <RX FDQ WKHQ

FKRRVH D GLIIHUHQW WDUJHW SULQWHU�

Settin g the Printer’s Pro perties

7R RSHQ WKH SURSHUW\ VKHHW IRU WKH VHOHFWHG SULQWHU� FOLFN 3URSHUWLHV LQ WKH

3ULQW 'RFXPHQW GLDORJ ER[� <RX FDQ PDNH FKDQJHV VXFK DV FKDQJLQJ WKH

RULHQWDWLRQ �SRUWUDLW RU ODQGVFDSH� DQG VFDOLQJ WKH SULQWRXW�

RT_To_print_the_current_ page
HT_Selecting_and_Setting_Up_Your_Printer
7R VHOHFW D WDUJHW SULQWHU

7R VHW XS D WDUJHW SULQWHU

To select a tar get printer

1 2Q WKH )LOH PHQX� FOLFN 3ULQW� 7KH 3ULQW VXEPHQX RSHQV�

2 &OLFN 7DUJHW 3ULQWHU� 7KH 7DUJHW 3ULQWHU GLDORJ ER[ RSHQV�

3 6HOHFW WKH SULQWHU \RX ZDQW WR XVH�

7LS

,I \RXU SULQWHU LV QRW OLVWHG LQ WKH 7DUJHW 3ULQWHU GLDORJ ER[� RSHQ WKH
:LQGRZV &RQWURO 3DQHO DQG DGG LW�
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To set u p a tar get printer

1 2Q WKH )LOH PHQX� FOLFN 3ULQW� 7KH 3ULQW VXEPHQX RSHQV�

2 &OLFN 7DUJHW 3ULQWHU� 7KH 7DUJHW 3ULQWHU GLDORJ ER[ RSHQV�

3 6HOHFW WKH SULQWHU \RX ZDQW WR XVH�

4 &OLFN 3URSHUWLHV� 7KH SURSHUW\ VKHHW IRU WKH VHOHFWHG SULQWHU GULYHU

RSHQV�

5 6HOHFW WKH RSWLRQV \RX ZDQW� 0DNH VXUH WKH RULHQWDWLRQ �SRUWUDLW RU

ODQGVFDSH� PDWFKHV WKH RQ�VFUHHQ RULHQWDWLRQ�

7LS

,I \RXU SULQWHU LV QRW OLVWHG LQ WKH 7DUJHW 3ULQWHU GLDORJ ER[� RSHQ WKH
:LQGRZV &RQWURO 3DQHO DQG DGG LW�

Using a Pen Plotter

,I \RX DUH XVLQJ D SHQ SORWWHU LQVWHDG RI D SULQWHU� \RX VKRXOG EH DZDUH RI D

IHZ GLIIHUHQFHV�

v %LWPDSV DQG ELWPDS ILOO SDWWHUQV GR QRW SORW�

v 7R DYRLG SORWWHU SHQ GDPDJH �GXH WR VWDLQLQJ�� \RX PD\ ZDQW WR XVH

WKH 9HFWRU &OLSSLQJ RSWLRQ LQ WKH 3ULQW 'RFXPHQW GLDORJ ER[�

v <RX VKRXOG FUHDWH D VSHFLDO FRORU SDOHWWH WKDW PDWFKHV WKH FRORUV RI

WKH SHQV XVHG E\ \RXU SORWWHU�

Scalable Fonts

6FDODEOH IRQWV DUH IRQWV WKDW FDQ EH VL]HG RU URWDWHG DV QHHGHG� 7UXH7\SH

IRQWV DUH DQ H[DPSOH RI VFDODEOH IRQWV� 7KH\ JLYH \RX :<6,:<* �ZKDW \RX

VHH LV ZKDW \RX JHW� SULQWHG RXWSXW� :LQGRZV KDQGOHV WKH WDVNV RI GLVSOD\LQJ�

VFDOLQJ� DQG SULQWLQJ 7UXH7\SH IRQWV VR WKDW VHSDUDWH VFUHHQ IRQWV DUH QRW

QHFHVVDU\�
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$GREH 7\SH 0DQDJHU� LI \RX KDYH LW LQVWDOOHG� KDQGOHV WKH GLVSOD\� VFDOLQJ� DQG

SULQWLQJ RI 7\SH � IRQWV DQG DOVR HQVXUHV WKDW WKHVH IRQWV DUH WUHDWHG DV

VFDODEOH IRQWV DQG DUH QRW OLPLWHG WR 3RVW6FULSW SULQWHUV�

,I� KRZHYHU� \RX XVH QRQ�VFDODEOH� GHYLFH�GHSHQGHQW SULQWHU IRQWV �VXFK DV

FDUWULGJH IRQWV ZLWK DQ +3 /DVHU-HW SULQWHU�� \RX VKRXOG UHDG DQG XQGHUVWDQG

WKH QH[W VHFWLRQ� �'HYLFH�'HSHQGHQW )RQWV��

Device-Dependent Fonts

'HYLFH�GHSHQGHQW SULQWHU IRQWV� LQFOXGLQJ FDUWULGJH IRQWV DQG VRIW IRQWV� DUH

OLPLWHG WR WKH VHW RI W\SHIDFHV� SRLQW VL]HV� DQG VW\OHV VXSSRUWHG E\ \RXU

SULQWHU� ,I \RX FUHDWH D GRFXPHQW ZLWK RQH SULQWHU VSHFLILHG� XVH LWV SULQWHU

IRQWV� DQG WKHQ FKDQJH WR D GLIIHUHQW WDUJHW SULQWHU� WKH IRQWV GLVSOD\HG LQ WKH

GRFXPHQW FKDQJH� 7KLV PD\ QRW EH HYLGHQW IURP WKH RQ�VFUHHQ DSSHDUDQFH�

)RU H[DPSOH� VXSSRVH \RX VSHFLI\ D 3RVW6FULSW SULQWHU DQG KDYH ���SRLQW

%RRNPDQ WH[W ZLWK ���SRLQW $YDQW *DUGH KHDGOLQHV LQ \RXU GRFXPHQW� ,I \RX

FKDQJH WR D SULQWHU WKDW GRHV QRW VXSSRUW WKHVH IRQWV� 'HVLJQHU FKRRVHV WKH

FORVHVW DYDLODEOH IRQWV� ZKLFK ZLOO QRW GLVSOD\ RU SULQW DV \RX H[SHFW� <RX FDQ

HLWKHU FKDQJH EDFN WR D 3RVW6FULSW SULQWHU RU FKDQJH WKH IRQWV LQ WKH

GRFXPHQW WR IRQWV VXSSRUWHG E\ WKH QHZ SULQWHU�

'HVLJQHU DOVR VXEVWLWXWHV WKH FORVHVW DYDLODEOH IRQW ZKHQ \RX XVH D GHYLFH�

GHSHQGHQW IRQW DQG WKHQ URWDWH WKH WH[W�
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Basic Printing Methods

<RX FDQ XVH WKH 3ULQW 'RFXPHQW GLDORJ ER[ WR FKRRVH SULQWLQJ RSWLRQV� 7KH

3ULQW 'RFXPHQW GLDORJ ER[ OHWV \RX SULQW WKH GRFXPHQW LQ WKH DFWLYH

ZLQGRZ� <RX FDQ VSHFLI\ WKH FXUUHQW SDJH� DOO SDJHV� RU VHOHFWHG SDJHV IURP

WKH GRFXPHQW� WKH QXPEHU RI FRSLHV WR EH SULQWHG� ZKHWKHU WR FROODWH WKH

FRSLHV� ZKHWKHU WR LQFOXGH SDJH ODEHOV� DQG ZKHWKHU WR XVH YHFWRU FOLSSLQJ

�IRU XVH ZLWK D SHQ SORWWHU��

<RX DOVR FDQ SULQW PXOWLSOH GRFXPHQWV�

7R XVH FURS PDUNV� VHOHFW WKH 6KRZ 3DJH &URS 0DUNV RSWLRQ LQ WKH 3DJH

6HWXS GLDORJ ER[�

<RX FDQ XVH &XUUHQW 3DJH WR SULQW RQO\ WKH FXUUHQWO\ GLVSOD\HG SDJH� QR

PDWWHU KRZ PDQ\ SDJHV DUH LQ \RXU GRFXPHQW�

<RX FDQ XVH 6HOHFWLRQ WR SULQW RQO\ WKH VHOHFWHG REMHFWV RQ WKH FXUUHQW SDJH�

6HOHFWHG REMHFWV GR QRW FKDQJH LQ VL]H RU SRVLWLRQ LQ WKH SULQWRXW�

<RX FDQ XVH 9LHZ WR SULQW DQ DUHD WKDW \RX GHILQH �E\ GUDJJLQJ D UHFWDQJOH��

7KH DUHD LV VFDOHG WR ILW WKH SULQWDEOH DUHD RI WKH SULQWHU SDJH�

Printing Selected Objects

1 6HOHFW WKH REMHFW RQ WKH FXUUHQW SDJH \RX ZDQW WR SULQW�

2 2Q WKH )LOH PHQX� FOLFN 3ULQW� 7KH 3ULQW VXEPHQX RSHQV�

3 &OLFN 6HOHFWLRQ� 7KH VHOHFWHG REMHFW LV SULQWHG�

Printing a Defined Area

1 2Q WKH )LOH PHQX� FOLFN 3ULQW� 7KH 3ULQW VXEPHQX RSHQV�

2 &OLFN 9LHZ� 7KH SULQW YLHZ SRLQWHU DSSHDUV�

3 3RVLWLRQ WKH SULQW YLHZ SRLQWHU DW RQH FRUQHU RI WKH DUHD \RX ZDQW WR

SULQW� DQG SUHVV DQG KROG WKH OHIW PRXVH EXWWRQ�

4 'UDJ D ERXQGLQJ ER[ DURXQG WKH DUHD \RX ZDQW WR SULQW� 5HOHDVH WKH

PRXVH EXWWRQ� 7KH VHOHFWHG DUHD LV SULQWHG�
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Printing Page Ranges

,I GHVLUHG� \RX FDQ SULQW RQO\ WKH SDJHV RU SDJH WLOHV \RX QHHG� )RU H[DPSOH� LI

\RX KDYH D WHQ�SDJH GRFXPHQW� \RX FDQ W\SH 1,3-5,10 WR SULQW SDJHV �� �� ��

�� DQG ���

,Q WKH 3ULQW 'RFXPHQW GLDORJ ER[� HQWHU D SDJH QXPEHU VHSDUDWHG E\ D

FRPPD WR SULQW D SDJH� HQWHU D UDQJH ZLWK WKH ILUVW DQG ODVW SDJHV VHSDUDWHG

E\ D K\SKHQ WR SULQW D VHTXHQFH RI SDJHV� 7R VSHFLI\ D SDJH WLOH� HQWHU D SDJH

QXPEHU� D FRORQ� DQG D WLOH QXPEHU�

Collating Printed Pages

7KH &ROODWH RSWLRQ LQ WKH 3ULQW 'RFXPHQW GLDORJ ER[ SULQWV D FRPSOHWH FRS\

RI D GRFXPHQW EHIRUH SULQWLQJ WKH QH[W FRS\� &ROODWH LV RQO\ DYDLODEOH ZKHQ

\RX SULQW PRUH WKDQ RQH FRS\ RI D PXOWLSOH�SDJH GRFXPHQW� &ROODWLQJ FDQ

VORZ WKH SULQW VSHHG RQ VRPH SULQWHUV�

Printing Mirror Images

7KH 0LUURU RSWLRQ IOLSV D GUDZLQJ VR WKDW LW SULQWV UHYHUVHG�DV WKRXJK \RX

ZHUH YLHZLQJ LW LQ D PLUURU� 8VH WKLV RSWLRQ WR SULQW 7�VKLUW WUDQVIHUV RU RWKHU

GUDZLQJV WKDW PXVW EH JLYHQ WR D SULQW VKRS UHYHUVHG�

7KH 0LUURU RSWLRQ LV DYDLODEOH LQ WKH 3ULQW 'RFXPHQW GLDORJ ER[ RQO\ ZLWK

FHUWDLQ SULQWHU GULYHUV� 7KLV RSWLRQ LV JUD\ LI WKH SULQWHU GULYHU GRHV QRW

VXSSRUW PLUURULQJ�

7R SULQW WKLV� 7\SH�

3DJHV �� �� �� �� �� � 1,2,6-9

3DJHV �� �� �� WR HQG RI GRFXPHQW 6-

3DJH �� WLOH � 1:2

3DJH �� WLOH � DQG SDJH �� WLOH � 1:4,2:6

3DJH �� WLOH � WKURXJK �� WLOH � 3:8-4:9
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Vector Clipping

9HFWRU FOLSSLQJ LPSURYHV WKH RXWSXW RI GUDZLQJV RQ SHQ SORWWHUV E\ FDXVLQJ

WKH WRS REMHFW RI RYHUODSSLQJ GUDZLQJV WR FRPSOHWHO\ FRYHU WKH EDFN REMHFW

�WKLV LV GRQH DXWRPDWLFDOO\ ZLWK QRQ�SORWWLQJ SULQWHUV��

9HFWRU FOLSSLQJ DOVR SUHYHQWV WKH GDPDJH WR SORWWHU SHQV WKDW FDQ RFFXU

ZKHQ GLIIHUHQW FRORUV DUH GUDZQ RYHU HDFK RWKHU� )RU H[DPSOH� D \HOORZ OLQH

GUDZQ RYHU D EODFN OLQH FDQ SHUPDQHQWO\ VWDLQ WKH \HOORZ SHQ�

7KH 9HFWRU &OLSSLQJ RSWLRQ LQ WKH 3ULQW 'RFXPHQW GLDORJ ER[ LV DYDLODEOH RQO\

ZKHQ \RX DUH XVLQJ D SORWWHU� 7KLV RSWLRQ LQFUHDVHV WKH WLPH LW WDNHV WR SORW

\RXU GUDZLQJ�

Fitting a Document to the Page

,I WKH SDJH VL]H LV WRR ODUJH IRU WKH WDUJHW SULQWHU
V SDSHU VL]H� 'HVLJQHU

UHGXFHV WKH GUDZLQJ SURSRUWLRQDOO\ VR WKDW DOO RI LW ILWV LQVLGH WKH SULQWDEOH

DUHD ZKHQ )LW WR 3DJH LQ WKH 3ULQW 'RFXPHQW GLDORJ ER[ LV VHOHFWHG� ,I WKLV

RSWLRQ LV QRW VHOHFWHG� WKH GUDZLQJ LV WLOHG RQ DV PDQ\ SDJHV DV QHFHVVDU\ WR

SULQW WKH GUDZLQJ�

Centering a Printout on the Page

7KH &HQWHU RQ 3DJH RSWLRQ FDXVHV WKH FRQWHQWV RI HDFK SDJH LQ WKH

GRFXPHQW WR EH DOLJQHG WR SDJH FHQWHU DQG SDJH PLGGOH IRU WKLV SULQWRXW

RQO\� &HQWHU RQ 3DJH LQ WKH 3ULQW 'RFXPHQW GLDORJ ER[ LV HVSHFLDOO\ XVHIXO LI

\RXU SDJH VL]H LV VPDOOHU WKDQ \RXU SDSHU VL]H� IRU H[DPSOH� DQ RQ�VFUHHQ

SUHVHQWDWLRQ WKDW \RX ZDQW WR SULQW RXW RQ ���� [ ��� SDSHU�

Darkening or lightening printed RGB bitmaps

:KHQ \RX SULQW WR DQ (36 ILOH IURP 'HVLJQHU DQG VHOHFW WKH 2XWSXW IRU

6HSDUDWRU SULQWLQJ RSWLRQ� \RX FDQ GDUNHQ RU OLJKWHQ 5*% ELWPDSV LQ WKH (36

ILOH E\ VHWWLQJ D NH\ YDOXH LQ \RXU UHJLVWU\� )RU GDUNHU 5*% ELWPDSV� VHW WKH

0*;*5( NH\ QDPH (QDEOH&0<.%ODFN2SW WR D YDOXH RI 1� )RU OLJKWHU 5*%

ELWPDSV� VHW WKH NH\ QDPH WR D YDOXH RI 0�
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To set the RGB color value

1 &OLFN 2SWLRQV LQ WKH 7RROV PHQX� &OLFN WKH 5HJLVWU\ WDE�

2 ,Q WKH .H\ OLVW ER[� ORFDWH DQG VHOHFW 0J[JUH DV WKH NH\�

3 &OLFN 1HZ 9DOXH� DQG WKHQ HQWHU EnableCMYKBlackOpt DV WKH

9DOXH 1DPH�

4 &OLFN 1XPHULF 9DOXH 7\SH�

5 (QWHU WKH YDOXH �0 RU 1�� DQG FOLFN WKH $FFHSW HQWU\ EXWWRQ�

To print the current page

1 &OLFN 3ULQW LQ WKH )LOH PHQX� 7KH 3ULQW VXEPHQX RSHQV�

2 &OLFN &XUUHQW 3DJH� $OO REMHFWV RQ WKH FXUUHQW SDJH DUH SULQWHG�

7LS

7KH NH\ERDUG VKRUWFXW IRU &XUUHQW 3DJH LV CTRL+P�

RT_To_print_the_current_ page
RT_To_print_the_current_page
3ULQWLQJ 3DJH 5DQJHV

To print a selection

1 6HOHFW WKH REMHFWV RQ WKH FXUUHQW SDJH \RX ZDQW WR SULQW�

2 &OLFN 3ULQW LQ WKH )LOH PHQX� 7KH 3ULQW VXEPHQX RSHQV�

3 &OLFN 6HOHFWLRQ� $OO VHOHFWHG REMHFWV DUH SULQWHG�

7LS

7KH NH\ERDUG VKRUWFXW IRU 6HOHFWLRQ LV CTRL+SHIFT+P�

RT_To_print_the_current_ page
RT_To_print_the_current_page
3ULQWLQJ 3DJH 5DQJHV
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To print a defined area

1 &OLFN 3ULQW RQ WKH )LOH PHQX� 7KH 3ULQW VXEPHQX RSHQV�

2 &OLFN 9LHZ� 7KH SULQW YLHZ SRLQWHU DSSHDUV�

3 3RVLWLRQ WKH SULQW YLHZ SRLQWHU DW RQH FRUQHU RI WKH DUHD \RX ZDQW WR

SULQW�

4 'UDJ D ERXQGLQJ ER[ DURXQG WKH DUHD \RX ZDQW WR SULQW� :KHQ \RX

UHOHDVH WKH PRXVH EXWWRQ� WKH VHOHFWHG DUHD LV SULQWHG�

RT_To_print_the_current_ page
RT_To_print_the_current_page
3ULQWLQJ 3DJH 5DQJHV

To print the active document

1 &OLFN 3ULQW RQ WKH )LOH PHQX� 7KH 3ULQW VXEPHQX RSHQV�

2 &OLFN 'RFXPHQW� 7KH 3ULQW 'RFXPHQW GLDORJ ER[ RSHQV�

3 7\SH WKH QXPEHU RI FRSLHV \RX ZDQW WR SULQW�

4 &KRRVH WKH RSWLRQV \RX ZDQW�

5 ,I \RX ZLVK� FOLFN 7DUJHW 3ULQWHU� FKRRVH WKH SULQWHU \RX ZDQW WR XVH�

DQG FOLFN 2.�

6 ,I \RX ZLVK� FOLFN 6HWXS� PDNH DQ\ FKDQJHV WR SULQWHU VHWWLQJV� DQG FOLFN

2.�

7 &OLFN 3ULQW� 7KH GRFXPHQW LV SULQWHG�

To print selected pages with the Pa ge Manager

1 2SHQ D GRFXPHQW�

2 &OLFN WKH 3DJH 0DQDJHU WRRO LQ WKH WRROER[� 7KXPEQDLO LPDJHV DUH

GLVSOD\HG IRU HDFK SDJH LQ WKH GRFXPHQW�

3 6HOHFW WKH WKXPEQDLO RI HDFK SDJH \RX ZDQW WR SULQW� $ UHFWDQJOH

DSSHDUV DURXQG HDFK VHOHFWHG SDJH� 3UHVV DQG KROG CTRL WR VHOHFW

PRUH WKDQ RQH SDJH� SUHVV DQG KROG SHIFT WR VHOHFW PRUH WKDQ RQH

FRQVHFXWLYH SDJH�
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4 &OLFN WKH 3ULQW EXWWRQ LQ WKH ULEERQ� 7KH 3ULQW 'RFXPHQW GLDORJ

ER[ RSHQV� 7KH UDQJH RI SDJHV \RX VHOHFWHG LV DXWRPDWLFDOO\ HQWHUHG�

5 7\SH WKH QXPEHU RI FRSLHV \RX ZDQW WR SULQW�

6 &KRRVH WKH RSWLRQV \RX ZDQW�

7 &OLFN 3ULQW� 7KH VHOHFWHG SDJHV DUH VHQW WR WKH WDUJHW SULQWHU�

To print multi ple documents

1 &OLFN 3ULQW LQ WKH )LOH PHQX� 7KH 3ULQW VXEPHQX RSHQV�

2 &OLFN 0XOWLSOH )LOHV� 7KH 3ULQW 0XOWLSOH )LOHV GLDORJ ER[ RSHQV�

3 ,I QHFHVVDU\� FKDQJH WR WKH GHVLUHG GULYH DQG GLUHFWRU\�

4 &KRRVH WKH QDPH RI D GRFXPHQW \RX ZDQW WR SULQW�

5 &OLFN 3ULQW� 7KH VHOHFWHG GRFXPHQW LV VHQW WR WKH SULQWHU�

6 5HSHDW VWHSV � DQG � XQWLO \RX KDYH FKRVHQ DOO WKH GRFXPHQWV \RX

ZDQW WR SULQW�

7LS

:KLOH \RX DUH SULQWLQJ PXOWLSOH GRFXPHQWV� DOO FRPPDQGV LQ WKH
3ULQW VXEPHQX DUH JUD\�

To remove files from the print queue

1 &OLFN 6KRZ 7DVNV LQ WKH 9LHZ PHQX�

2 &OLFN WKH QDPH RI WKH ILOH �RU ILOHV� \RX ZDQW WR UHPRYH IURP WKH

TXHXH�

3 &OLFN WKH 6WRS EXWWRQ �

1RWH

<RX FDQ XVH WKLV PHWKRG RQO\ LI \RX DUH SULQWLQJ PXOWLSOH ILOHV�
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iGrafx Designer 1.0 Tutorial
Getting Started

7KLV FKDSWHU SURYLGHV VWHS�E\�VWHS LQVWUXFWLRQV RQ XVLQJ WKH PRVW SRSXODU

DQG IXQGDPHQWDO WRROV LQ WKH QHZ L*UDI[ 'HVLJQHU ���� 1RWZLWKVWDQGLQJ

\RXU FXUUHQW 'HVLJQHU VNLOOV� WKHVH WXWRULDOV ZLOO KDYH \RX ZRUNLQJ OLNH D

'HVLJQHU SUR LQ QR WLPH� 1RYLFH RU YHWHUDQ XVHUV DOLNH FDQ FRPIRUWDEO\

SURJUHVV DORQJ WKH 'HVLJQHU FXUYH WR FRPSOHWH SURILFLHQF\ DW DQ\ SDFH WKH\

FKRRVH�

:LWK 'HVLJQHU� LW
V HDV\ WR HGLW GUDZLQJV WR JHW WKH UHVXOWV \RX ZDQW�

2EMHFWV FUHDWHG LQ 'HVLJQHU DUH YHFWRU�EDVHG� XVLQJ SRLQWV DQG

PDWKHPDWLFDO FDOFXODWLRQV WR FUHDWH VKDSHV� RU REMHFWV� WKDW FDQ WKHPVHOYHV

EH PDQLSXODWHG WR DQ\ GHVLJQ VSHFLILFDWLRQ LPDJLQDEOH�

%HIRUH VWDUWLQJ WKH WXWRULDOV� \RX VKRXOG NQRZ KRZ WR RSHQ PHQXV DQG

FKRRVH FRPPDQGV� DQG VHOHFW REMHFWV XVLQJ D PRXVH�

Managing a Designer Project

%HIRUH VWDUWLQJ D 'HVLJQHU SURMHFW LW LV LPSRUWDQW WR GHILQH DQG VHW \RXU

XVHU SUHIHUHQFHV� 6LQFH HYHU\ 'HVLJQHU LOOXVWUDWLRQ LV XQLTXH DQG HYROYHV

IURP D XQLTXH VSHFLILFDWLRQ� LW LV LPSRUWDQW WKDW \RXU 'HVLJQHU HQYLURQPHQW

DGDSW DFFRUGLQJ WR HDFK SURMHFW� ,Q WKLV WXWRULDO \RX ZLOO SUHSDUH \RXU

'HVLJQHU ZRUNVSDFH DFFRUGLQJ WR WKH VSHFLILFDWLRQV RI \RXU FXUUHQW SURMHFW�

ZKLFK LV WR LOOXVWUDWH� WR VFDOH� D VXVSHQVLRQ EULGJH ZKLOH NHHSLQJ WUDFN RI D

VSHFLILHG SURMHFW FRPSRQHQW�

$IWHU \RX FRPSOHWH WKLV WXWRULDO� \RX ZLOO EH DEOH WR�

v VHW SDJH RSWLRQV
i G r a f x  D e s i g n e r  1 . 0  T u t o r i a l  303



v VHW JHQHUDO RSWLRQV

v VHW GLVSOD\ RSWLRQV

v VHW UXOHUV RSWLRQV

v VHW VQDS RSWLRQV

v VHW URWDWLRQ RSWLRQV

v GHILQH XVHU SURILOH LQIRUPDWLRQ

v GHILQH DQG HGLW 'HVLJQHU UHJLVWU\ GDWD

v QDPH DQ REMHFW

v GHILQH REMHFW ILHOGV DQG YDOXHV

Setting Page Options

<RXU FOLHQW KDV DVNHG WKDW DOO GUDZLQJV FRPSO\ ZLWK PHWULF VWDQGDUGV� 7R GR

VR� \RX ZLOO QHHG WR VHW XS \RXU SDJH ZLWK PHWULF PHDVXUHPHQWV�

1 )URP WKH )LOH PHQX� FOLFN 3DJH 6HWXS� 7KH 3DJH 6HWXS GLDORJ ER[

RSHQV�

2 &OLFN WKH DUURZ NH\ WR GLVSOD\ WKH SDSHU VL]H VHWWLQJV�

3 6HOHFW $�� 7KLV ZLOO JLYH \RX D SDSHU VL]H RI ��FP [ ����FP�

4 &OLFN WKH 8QLWV EXWWRQ DQG VHOHFW FP DV \RXU VWDQGDUG XQLW RI PHDVXUH�

5 /HDYH WKH RWKHU VHWWLQJV DV WKH\ DUH DQG FOLFN WKH 0DUJLQV WDE�

6 ,Q WKH 0DUJLQV GLDORJ ER[� FOLFN WKH 6KRZ 3DJH &URS 0DUNV EXWWRQ�
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7 7\SH WKH IROORZLQJ QHZ PDUJLQ VL]HV LQ WKH 7RS� %RWWRP� /HIW� DQG

5LJKW 0DUJLQ OLVW ER[HV� ���� ����� ����� DQG �����

8 &OLFN 2.

Setting General Options

7KH GUDZLQJ \RX SODQ WR GR LV YHU\ FRPSOH[ DQG XWLOL]HV D QXPEHU RI

RYHUODSSLQJ VKDSHV DQG FRORUV� $QG VLQFH PDQ\ VKDSHV ZLOO EH GXSOLFDWHG� \RX

ZLOO QHHG WR VHW WKH RIIVHW SUHIHUHQFHV�

1 )URP WKH 7RROV PHQX� FOLFN 2SWLRQV� 7KLV RSHQV WKH 2SWLRQV GLDORJ

ER[� 7KH *HQHUDO RSWLRQV DUH GLVSOD\HG�

�

2 7\SH � LQ WKH 8QGR (YHQW /LPLW ER[� 'HVLJQHU ZLOO QRZ DOORZ \RX WR

XQGR WKH ODVW VHYHQ DFWLRQV�
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3 7\SH � LQ WKH $XWR 6DYH 7LPH 3HULRG ER[ WR DXWRPDWLFDOO\ VDYH \RXU

ZRUN HYHU\ HLJKW PLQXWHV�

4 7\SH ��� LQ WKH +RUL]RQWDO 8QLWV ER[ DQG WKH 9HUWLFDO 8QLWV ER[� :KHQ

\RX GXSOLFDWH D VHOHFWHG REMHFW� LWV GXSOLFDWH ZLOO DSSHDU DW WKHVH RIIVHW

FRRUGLQDWHV�

5 0DNH VXUH WKDW WKH ER[� 8VH 6PDUW &RORUL]DWLRQ :KHQ $SSO\LQJ )LOOV

WR *URXSV LV FKHFNHG� 7KLV ZLOO SUHYHQW JURXSHG REMHFWV IURP ORRVLQJ

FRORU GHILQLWLRQ ZKHQ FKDQJLQJ FRORU�

Setting Display Options

1 &OLFN WKH 'LVSOD\ WDE WR UHYHDO WKH GLVSOD\ VHWWLQJV�

2 6HOHFW $QWL�$OLDV )XOO 6FUHHQ 9LHZ� 7KLV ZLOO GLVSOD\ DQ DQWL�DOLDVHG YLHZ

RI \RXU EULGJH ZKLOH YLHZLQJ WKH IXOO VFUHHQ�

Setting Ruler Options

<RX ZLOO ZDQW WR FKRRVH D XQLW RI PHDVXUH IRU \RXU GUDZLQJ ZRUNVSDFH DV

ZHOO DV WKH ZD\ LQ ZKLFK WKH UXOHUV DUH ODEHOHG� <RX ZLOO DOVR ZDQW WR VHOHFW

WKH QXPEHU RI VQDS GLYLVLRQV IRU HDFK UXOHU XQLW�
306 i G r a f x  D e s i g n e r



1 &OLFN WKH 5XOHUV WDE WR RSHQ WKH 5XOHUV GLDORJ ER[�

2 7\SH �� LQ WKH 6QDSV 3HU 8QLW ER[HV� 7KLV VHWV WKH QXPEHU RI VQDS

SRLQWV WR �� SHU LQFK DQG DIIHFWV WKH QXPEHU RI JULG GRWV WKDW DSSHDU

RQ \RXU ZRUNVSDFH�

3 /HDYH WKH /DEHO )UHTXHQF\ DW �� 7KH /DEHO UHIHUV WR WKH DFWXDO XQLW

QXPEHU WKDW DSSHDUV RQ WKH UXOHUV� H�J� �� �� ��� 7KH )UHTXHQF\ UHIHUV

WR WKH DPRXQW RI WLPHV WKH ODEHO �RU QXPEHU� DSSHDUV LQ WKH JLYHQ XQLW

RI PHDVXUH�

4 &OLFN WKH DUURZ LQ ERWK 'LVSOD\HG 3UHFLVLRQ ER[HV DQG VHOHFW [�[[[�

7KLV YDOXH VHWV WKH GHFLPDO SUHFLVLRQ RI WKH FRRUGLQDWHV GLVSOD\HG LQ WKH

VWDWXV EDU�

Setting Snap Options

6QDS RSWLRQV OHW \RX VHOHFW RU GHVHOHFW ZKHUH 'HVLJQHU SODFHV VQDS SRLQWV RQ

DQ REMHFW� 6QDS SRLQWV DFW DV PDJQHWV WR DWWUDFW DQ REMHFW WR D JLYHQ

UHIHUHQFH VXFK DV D JXLGH RU UXOHU� 8VLQJ 'HVLJQHU
V VQDS IHDWXUH ZLVHO\ FDQ

PDNH DOLJQLQJ REMHFWV HDV\ DQG DFFXUDWH�
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1 &OLFN WKH 6QDS WDE� 7KH 6QDS GLDORJ ER[ RSHQV�

2 ,Q WKH 6HWWLQJV VHFWLRQ� VHOHFW 6QDS WR 5XOHUV DQG 6QDS WR *XLGHV WR

DOLJQ REMHFWV SUHFLVHO\ DORQJ WKH UXOHU DQG WKH JXLGHV� UHVSHFWLYHO\�

3 6HOHFW 'UDJJLQJ 6QDS WR DOORZ DQ REMHFW
V ERXQGLQJ ER[ �LWV VHOHFWLRQ

IUDPH� WR VQDS WR D UXOHU RU JXLGH ZKLOH EHLQJ PRYHG�

4 6HOHFW '\QDPLF 6QDS WR OLQN REMHFW OLQHV WRJHWKHU� 7KLV LV D JUHDW ZD\ WR

PDNH DFFXUDWH H[WHQVLRQV RI RQH REMHFW WR DQRWKHU RU IURP RQH SRLQW

WR DQRWKHU SRLQW�

5 ,Q WKH 2EMHFW 6QDS 3RLQWV VHFWLRQ� VHOHFW ZKHUH \RX ZDQW D VQDS SRLQW

WR DSSHDU RQ DQ REMHFW� &OLFN WR VHOHFW WKH IROORZLQJ ORFDWLRQV� &HQWHU�

3LYRW� 9HUWLFHV� (QGSRLQWV� DQG ,QWHUVHFWLRQ�

Setting Rotation Options

,I \RX IRUHVHH WKH QHHG WR XVH 'HVLJQHU
V URWDWLRQ IHDWXUHV� \RX FDQ DGMXVW WKH

URWDWLRQ SUHVHWV DFFRUGLQJ WR \RXU RZQ SUHIHUHQFHV� <RX FDQ VHW WKH URWDWLRQ

DQJOH LQFUHPHQW IRU URWDWLQJ DQ REMHFW E\ SUHVVLQJ WKH )� NH\� <RX FDQ DOVR

GHILQH WKH URWDWLRQ XQLWV DV HLWKHU UDGLDQV RU GHJUHHV�
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1 &OLFN WKH 5RWDWLRQ WDE WR GLVSOD\ WKH 5RWDWLRQ GLDORJ ER[�

2 7\SH �� LQ WKH )� 5RWDWLRQ ,QFUHPHQW ER[�

Defining Custom Units

7KLV SURFHGXUH LOOXVWUDWHV WKH XVH RI WKH &XVWRP 8QLWV GLDORJ ER[ WR GHILQH D

VFDOH RI � PHWHUV SHU FHQWLPHWHU�

1RWH

<RX FDQ DOVR GHILQH FXVWRP XQLWV XVLQJ WKH 6FDOH 'UDZLQJ :L]DUG� 6LPSO\
FOLFN 6FDOH 6HWXS IURP WKH )LOH PHQX DQG IROORZ WKH LQVWUXFWLRQV RQ WKH
VFUHHQ�

1 2Q WKH 7RROV PHQX� FOLFN &XVWRP 8QLWV� 7KH 'HILQHG &XVWRP 8QLWV

GLDORJ ER[ RSHQV�

2 &OLFN $GG 8QLW� 7KH $GG &XVWRP 8QLW GLDORJ ER[ RSHQV�

3 7\SH 0(7(56 �6&$/( �� LQ WKH 8QLW 1DPH ER[� $GGLQJ 6&$/( � WR

WKH QDPH PDNHV LW HDV\ WR LGHQWLI\ WKH VFDOH LQ WKH XQLWV OLVW�

4 8QGHU 'HVLJQHU 8QLWV� W\SH � LQ WKH 6FDOH VSLQ ER[� RU FOLFN WKH DUURZV

EHVLGH WKH ER[ WR VHOHFW D YDOXH�

5 8QGHU 'HVLJQHU 8QLWV� W\SH P LQ WKH /DEHO ER[�

6 8QGHU 5HDO :RUOG 8QLWV� FOLFN WKH DUURZ EHVLGH WKH ODEHO OLVW ER[� DQG

FKRRVH FHQWLPHWHUV�
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7 &OLFN 2N� WKHQ FOLFN 2N DJDLQ�

7LS

7KH XQLW \RX HQWHUHG DERYH RQO\ GHILQHV D SULPDU\ XQLW� ,I QHHGHG� \RX DOVR
FDQ VSHFLI\ D VHFRQGDU\ XQLW� <DUGV DQG IHHW� IHHW DQG LQFKHV� DQG ZHHNV
DQG GD\V DUH DOO H[DPSOHV RI GHILQLWLRQV ZLWK SULPDU\ DQG VHFRQGDU\ XQLWV�

To chan ge the rulers to the new scale

1 5LJKW�FOLFN RQ WKH UXOHU�

2 6HOHFW 5XOHU�6QDS 2SWLRQV�

3 &OLFN WKH 8QLWV EXWWRQ�

4 6HOHFW 0RUH 8QLWV IURP WKH PHQX� 7KLV RSHQV WKH $YDLODEOH 8QLWV

GLDORJ�

5 6HOHFW \RXU QHZ VFDOH� ,W ZLOO KDYH DQ DVWHULVN E\ LW�

Setting Object Names, Fields and Values

<RX FDQ DVVLJQ QDPHV WR REMHFWV DQG JURXSV RI REMHFWV LQ \RXU GUDZLQJ� 7KLV

OHWV \RX FUHDWH D OLVW RI REMHFWV� DQG VHOHFW REMHFWV E\ QDPH� <RX ZLOO QRZ

DVVLJQ QDPHV� FRVWV� DQG RWKHU ILHOGV WR D SDUW RI \RXU VXVSHQVLRQ EULGJH

GUDZLQJ�

Fields and Values

)LHOGV DUH OLNH FDWHJRULHV RI LQIRUPDWLRQ DERXW WKH REMHFWV LQ \RXU GUDZLQJV�

<RX FDQ GHILQH \RXU RZQ ILHOGV DQG DVVLJQ YDOXHV WR WKHP� )RU H[DPSOH� \RX

FRXOG XVH ILHOGV DQG YDOXHV IRU D SDUW LQ DQ HQJLQHHULQJ GUDZLQJ DV IROORZV�

)LHOG 9DOXH

&RVW ����

1DPH &DEOH )ODQJH
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To name (or rename ) an ob ject:

1 2Q WKH )LOH PHQX� FOLFN 2SHQ�

2 1DYLJDWH WR WKH 7XWRULDOV IROGHU DQG FOLFN %ULGJH�GVI�

3 6HOHFW WKH &DEOH )ODQJH �KLJKOLJKWHG \HOORZ��

4 2Q WKH 2EMHFW PHQX� FOLFN 3URSHUWLHV� 7KH 3URSHUWLHV GLDORJ ER[

RSHQV�

5 7\SH &DEOH )ODQJH LQ WKH 2EMHFW 1DPH ER[ DQG FOLFN $SSO\�

6 &OLFN &ORVH�

1RWH

,I WKH REMHFW DOUHDG\ KDV D QDPH� LW DSSHDUV LQ WKH 2EMHFW 1DPH WH[W ER[� ,I
\RX ZDQW WR FKDQJH WKH QDPH� KLJKOLJKW LW DQG W\SH RYHU LW�

To add fields and values:

1 6HOHFW WKH &DEOH )ODQJH�

2 2Q WKH 2EMHFW PHQX� FOLFN 3URSHUWLHV� 7KH 3URSHUWLHV GLDORJ ER[

RSHQV� 1RWLFH WKDW &DEOH )ODQJH DSSHDUV LQ WKH QDPH ER[�

3 &OLFN $GG�

4 7\SH &RVW LQ WKH )LHOG ER[ DQG SUHVV WKH WDE NH\�

5 7\SH ���� LQ WKH 9DOXH ER[ DQG FOLFN $GG�

6 7\SH 3DUW 1XPEHU LQ WKH )LHOG ER[ DQG SUHVV WKH WDE NH\�

7 7\SH 7/������� LQ WKH 9DOXH ER[ DQG FOLFN $GG�

3DUW 1XPEHU 7/��� ������

3ULPDU\ 9HQGRU $FPH )ODQJHV

6HFRQGDU\ 9HQGRU 1XW
Q EXW )ODQJHV� ,QF�

)LHOG 9DOXH
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8 7\SH WKH UHPDLQLQJ LQIRUPDWLRQ LQ WKH DSSURSULDWH )LHOG DQG 9DOXH ER[

DV LOOXVWUDWHG�

9 &OLFN $SSO\ DQG WKHQ FOLFN &ORVH�

1RWH

<RX FDQ GHOHWH WKH YDOXHV RI DQ\ ILHOG \RX KDYH FUHDWHG E\ FKRRVLQJ WKH
ILHOG DQG YDOXH DQG FOLFNLQJ WKH 'HOHWH EXWWRQ LQ WKH 3URSHUWLHV GLDORJ ER[�
$Q\ ILHOG \RX KDYH DGGHG UHPDLQ XQWLO \RX FORVH 'HVLJQHU VR WKDW \RX FDQ
DVVLJQ WKHP WR RWKHU REMHFWV� ,I WKHUH DUH ILHOGV ZLWK QR YDOXHV ZKHQ \RX
FORVH 'HVLJQHU� WKH QHZ SURSHUWLHV DUH QRW VDYHG�

Assigning Values to Other Properties

,I RWKHU SURSHUWLHV �EHVLGHV 1DPH� KDYH EHHQ FUHDWHG IRU D GRFXPHQW� \RX

FDQ VHOHFW DQ REMHFW� FKRRVH RQH RI LWV SURSHUWLHV� DQG WKHQ DVVLJQ D QHZ

YDOXH WR WKDW SURSHUW\ RU ILQG RXW ZKDW YDOXH KDV DOUHDG\ EHHQ DVVLJQHG�

$IWHU \RX KDYH XVHG WKH 3URSHUWLHV GLDORJ ER[ WR FUHDWH WKH SURSHUWLHV \RX

ZDQW WR XVH� \RX FDQ DFFHVV WKHP TXLFNO\ WKURXJK WKH 3URSHUW\ WRROEDU RU

WKURXJK WKH 3URSHUWLHV GLDORJ ER[�

To list ob jects

<RX FDQ FUHDWH D OLVW RI REMHFWV LQ \RXU GUDZLQJ� 7KLV OHWV \RX FUHDWH D QDPHG

SDUWV OLVW RI DOO WKH SLHFHV RI \RXU GUDZLQJ� SOXV D OLVW RI RWKHU GHILQHG

SURSHUWLHV�
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` 2Q WKH 2EMHFWV PHQX� FOLFN /LVW� 7KH /LVW 2EMHFWV GLDORJ ER[ RSHQV

ZKLFK DOSKDEHWLFDOO\ OLVWV WKH QDPHV �WKH YDOXHV DVVLJQHG WR WKH SURSHUW\

kQDPHy� IRU WKH REMHFWV VHOHFWHG LQ WKH FXUUHQW GUDZLQJ� DQG VKRZV WKH

QXPEHU RI WLPHV HDFK REMHFW DSSHDUV �TXDQWLW\��

1RWH

,I QR REMHFWV DUH VHOHFWHG� WKH OLVW FRQWDLQV WKH QDPHV IRU DOO WKH REMHFWV LQ
WKH GUDZLQJ� 2EMHFWV ZLWKRXW QDPHV DUH OLVWHG DV kXQQDPHG�y

Managing User Profiles

3URILOHV DUH D FROOHFWLRQ RI DOO RI \RXU SUHIHUHQFHV� H�J� FXVWRPL]HG WRROEDU

EXWWRQV DQG ORFDWLRQ� VWDWXV EDU VHWWLQJV� VQDS DQG UXOHU VHWWLQJV� HWF�

*HQHUDOO\� \RX PD\ ZDQW WR XVH D GLIIHUHQW SURILOH IRU GLIIHUHQW NLQGV RI ZRUN

�VXFK DV JUDSKLF GHVLJQ RU WHFKQLFDO LOOXVWUDWLRQ�� )RU QRZ� DOO RI WKH

SUHIHUHQFHV \RX KDYH VHW WR WKLV SRLQW ZLOO EH VDYHG LQ D SURILOH QDPHG *UHJ7�

D IHOORZ HPSOR\HH ZKR ZLOO EH KHOSLQJ \RX UHQGHU WKH GUDZLQJV IRU \RXU

FXUUHQW SURMHFW�

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV DQG WKHQ WKH 3URILOH WDE� 7KH

2SWLRQV GLDORJ ER[ RSHQV�
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2 &OLFN WKH 3URILOH EXWWRQ DQG WKHQ FOLFN 1HZ�

3 7\SH *UHJ7 LQ WKH 3URILOH 'RFXPHQW OLVW ER[� &OLFN 2N�

4 7\SH 0RQURH $FFRXQW�&&����� LQ WKH 'HVFULSWLRQ OLVW ER[�

5 &OLFN 2.�

1RWH

8VH WKH 3URILOH GLDORJ ER[ WR VHOHFW� FUHDWH� FRS\� GHOHWH� DQG XSGDWH DOO
XVHU SURILOHV�
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Managing the Designer Registry

0RVW SURJUDPV VDYH VWDWXV LQIRUPDWLRQ LQ D ILOH FDOOHG WKH V\VWHP UHJLVWU\�

&KDQJHV LQ WKH UHJLVWU\ DUH GHWHFWHG E\ WKH :LQGRZV RSHUDWLQJ V\VWHP DQG

SURJUDPV WKDW PRQLWRU WKH UHJLVWU\� 7KH UHJLVWU\ HQWULHV IRU 'HVLJQHU UHIOHFW

\RXU V\VWHP
V KDUGZDUH DQG RSHUDWLQJ V\VWHP VSHFLILFDWLRQV� 6HYHUDO HQWULHV

DUH FUHDWHG E\ WKH L*UDI[ LQVWDOOHU ZKHQ \RX LQVWDOO 'HVLJQHU� <RX ZLOO QRZ

XVH WKH 5HJLVWU\ WDE RI WKH 2SWLRQV GLDORJ ER[ WR HGLW WKRVH HQWULHV�

To chan ge the value of a re gistr y key

L*UDI[ 'HVLJQHU ZLOO JHQHUDWH LWV RZQ 3RVW 6FULSW RXWSXW WR D 3RVW 6FULSW

SULQWHU� )RU WKLV SURMHFW \RX ZDQW \RXU 3RVW 6FULSW SULQWHU GULYHU WR FRQWURO

WKH RXWSXW LQ VWHDG RI 'HVLJQHU� 7R DOORZ WKLV� \RX PXVW FKDQJH D UHJLVWU\ NH\

LQ WKH 5HJLVWU\ GLDORJ ER[�

1 2Q WKH 7RROV PHQX� FOLFN 2SWLRQV DQG WKHQ WKH 5HJLVWU\ WDE� 7KH

5HJLVWU\ GLDORJ ER[ RSHQV�

2 &OLFN WR KLJKOLJKW WKH 0J[JUH NH\ QDPH IURP WKH .H\ OLVW ER[�

3 &OLFN 1HZ�

4 6HOHFW %RROHDQ 9DOXH IURP WKH PHQX�

5 7\SH (QDEOH36$GDSW DQG SUHVV (17(5�

6 ,Q WKH 9DOXH OLVW� FOLFN LQ WKH YDOXH ER[ EHVLGH (QDEOH36$GDSW� $ ER[

ZLWK D FKHFN PDUN ZLOO DSSHDU�
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7 &OLFN WKH FKHFN PDUN VR LW GLVDSSHDUV� 7KLV ZLOO FKDQJH WKH YDOXH IURP �

WR � ZKLFK PHDQV \RXU SULQWHU GULYHU ZLOO FRQWURO WKH RXWSXW RI D

GUDZLQJ DQG QRW 'HVLJQHU�

8 &OLFN 2. WR FRQILUP WKH FKDQJH DQG WR FORVH WKH 2SWLRQV GLDORJ ER[�
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Creating a Technical Illustration

7KLV WXWRULDO VKRZV \RX KRZ WR FUHDWH DQ LOOXVWUDWLRQ RI WKH LQVLGH RI D

PHFKDQLFDO ZULVWZDWFK�

$IWHU \RX FRPSOHWH WKLV WXWRULDO� \RX ZLOO EH DEOH WR�

v LPSRUW QRQ�'HVLJQHU ILOHV

v XVH JXLGHV WR KHOS SRVLWLRQ DQG DOLJQ REMHFWV

v PRYH WR GLIIHUHQW OD\HUV

v FKDQJH OLQH VW\OHV DQG HQGV

v HQWHU FRRUGLQDWHV WR GUDZ REMHFWV

v FXW OLQHV

v DVVLJQ SURSHUWLHV DQG QDPHV WR D GUDZLQJ

v OLVW WKH SDUWV ZLWKLQ D GUDZLQJ
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Opening the Designer File

1 )URP WKH )LOH PHQX� FOLFN 2SHQ�

2 'RXEOH FOLFN WKH ILOH :$7&+�'6)� 7KH GUDZLQJ DSSHDUV LQ WKH GUDZLQJ

DUHD�

3 )URP WKH )LOH PHQX� FOLFN 6DYH $V� 7KH 6DYH $V GLDORJ ER[ RSHQV�

4 7\SH 0<:$7&+ LQ WKH WH[W ER[ DQG SUHVV HQWHU� 7KH ILOH LV VDYHG DV

0<:$7&+�'6)�

Changing the Page Color

,Q WKLV SDUW \RX FKDQJH WKH EDFNJURXQG SDJH FRORU IURP LQYLVLEOH �WKH GHIDXOW�

WR OLJKW JUD\�

1 )URP WKH )LOH PHQX� FOLFN 3DJH 6HWXS� 7KH 3DJH 6HWXS GLDORJ ER[

RSHQV�

2 &OLFN WKH 0DUJLQV 7DE�

3 &OLFN (QDEOHG LQ WKH 3DJH )LOO GLDORJ�
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4 &OLFN WKH 3DJH )LOO EXWWRQ WR RSHQ WKH 2EMHFW )RUPDW GLDORJ ER[�

5 &OLFN WKH 6ROLG )LOO EXWWRQ DQG GRXEOH FOLFN D OLJKW JUD\ FRORU VZDWFK LQ

WKH &RORU 3DOHWWH�

6 &OLFN 2. LQ WKH 2EMHFW )RUPDW GLDORJ ER[� 7KH SDJH SUHYLHZ EHFRPHV

JUD\�

7 &OLFN 2. LQ WKH 3DJH 6HWXS GLDORJ ER[�

Dragging a Guide

*XLGHV FDQ KHOS \RX ZLWK WKH SODFHPHQW RI REMHFWV LQ \RXU GUDZLQJ� *XLGHV

GR QRW SULQW DQG FDQ EH UHPRYHG DQ\ WLPH�

,Q WKLV H[HUFLVH \RX GUDJ D JXLGH WR KHOS SRVLWLRQ WKH WRS ZDWFK DVVHPEO\

FRUUHFWO\ DERYH WKH ERWWRP DVVHPEO\�

1 3RLQW WR WKH YHUWLFDO UXOHU DW WKH OHIW�

2 3UHVV DQG KROG WKH OHIW PRXVH EXWWRQ DQG GUDJ WRZDUG WKH ULJKW� $

YHUWLFDO JXLGH DSSHDUV�

3 0RYH WKH YHUWLFDO JXLGH OLQH VR WKDW LW SDVVHV WKURXJK WKH FHQWHU RI WKH

ERWWRP ZDWFK PHFKDQLVP� 5HOHDVH WKH OHIW PRXVH EXWWRQ�

4 3RLQW WR D KRUL]RQWDO UXOHU DW WKH WRS RI WKH 'HVLJQHU ZLQGRZ�

5 3UHVV DQG KROG WKH OHIW PRXVH EXWWRQ DQG GUDJ GRZQZDUG� $

KRUL]RQWDO JXLGH DSSHDUV�
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6 0RYH WKH KRUL]RQWDO JXLGH OLQH VR WKDW LW UHVWV RQ WKH WRS RI WKH

ERWWRP ZDWFK PHFKDQLVP� 5HOHDVH WKH OHIW PRXVH EXWWRQ�

7 3UHVV &75/�6 WR VDYH \RXU ZRUN�

Importing an AutoCAD File

<RX FDQ XVH WKH ,PSRUW FRPPDQG WR LPSRUW GUDZLQJV DQG WH[W WKDW ZHUH

FUHDWHG LQ RWKHU SURJUDPV� RU WR LPSRUW GUDZLQJV WKDW PD\ EH WRR ODUJH IRU

WKH &OLSERDUG�

,Q WKLV VHFWLRQ� \RX LPSRUW D GUDZLQJ WKDW ZDV VDYHG LQ WKH $XWR&$' ILOH

IRUPDW�

To im port a DX F File

1 )URP WKH )LOH PHQX� FOLFN ,PSRUW� 7KH ,PSRUW GLDORJ ER[ RSHQV�

2 &OLFN WKH GRZQ DUURZ LQ WKH )LOHV RI 7\SH ER[ DQG FOLFN WKH ';)

IRUPDW WR VHOHFW LW�

M e c h a n i c a l  W a t c h  A s s e m b l y
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3 'RXEOH FOLFN WKH ILOH :$7&+723�';)� 7KH LPSRUWHG GUDZLQJ RI WKH

ZDWFK
V WRS DVVHPEO\ DSSHDUV LQ WKH GUDZLQJ DUHD�

4 /LQH XS WKH ZDWFK WRS DJDLQVW WKH JXLGHV \RX FUHDWHG HDUOLHU�

7LS

3UHVV DQG KROG WKH VSDFH EDU ZKLOH WDSSLQJ WKH DSSURSULDWH DUURZ NH\ WR
QXGJH� LQFUHPHQWDOO\� WKH VHOHFWHG REMHFW�
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Changing to a Different Layer

7KLV LOOXVWUDWLRQ ZDV FUHDWHG RQ IRXU GLIIHUHQW OD\HUV� /D\HUV FDQ KHOS RUJDQL]H

\RXU GUDZLQJ VR WKDW� IRU H[DPSOH� \RX FDQ PRUH HDVLO\ VHOHFW REMHFWV�

,Q WKLV SDUW \RX FKDQJH WR WKH OD\HU QDPHG 6FUHZV VR \RX FDQ DGG HOHPHQWV

WR WKLV OD\HU�

` &OLFN WKH 6FUHZV WDE DW WKH ERWWRP RI WKH GUDZLQJ DUHD� �7KH VHOHFWHG

WDE FXUUHQWO\ UHDGV %RWWRP $VVHPEO\�� 7KH OD\HUV XVHG LQ WKH GUDZLQJ

DSSHDU ZLWK WKH FXUUHQW OD\HU KLJKOLJKWHG�

Drawing Two Lines Using Exact Coordinates

,Q WKLV SDUW \RX XVH WKH &RRUGLQDWH GLDORJ ER[ WR GUDZ WZR OLQHV� 7KHVH OLQHV

VKRZ WKH SDWK RI VFUHZV WKURXJK WKH WRS DQG ERWWRP DVVHPEOLHV�

7KLV PHWKRG LV H[WUHPHO\ SUHFLVH� :LWK LW� \RX XVH RQ�VFUHHQ FRRUGLQDWHV WR

SRVLWLRQ DQG PRYH WKH SRLQWHU H[DFWO\�\RX GR QRW XVH WKH PRXVH� 7KH

SRLQWHU XVHV WKH FXUUHQWO\ VHOHFWHG GUDZLQJ PHWKRG�

To draw the first line

1 )URP WKH 2EMHFW PHQX� FOLFN &RRUGLQDWHV� 7KH &RRUGLQDWHV GLDORJ ER[

RSHQV�

2 &OLFN WKH &UHDWH D 1HZ UDGLR EXWWRQ�

3 &OLFN WKH DUURZ EXWWRQ DQG VHOHFW -RLQWHG /LQH IURP WKH OLVW RI REMHFWV�

4 )URP WKH 0HWKRG OLVW ER[� FOLFN WKH DUURZ EXWWRQ DQG VHOHFW 5DQJH�

5 +LJKOLJKW WKH QXPEHU LQ WKH ;� FRRUGLQDWH ER[� 7\SH ����

6 3UHVV WDE WR KLJKOLJKW WKH <� FRRUGLQDWH ER[� 7\SH �����

7 3UHVV WDE WR KLJKOLJKW WKH ;� FRRUGLQDWH ER[� 7\SH ����

8 3UHVV WDE WR KLJKOLJKW WKH <� FRRUGLQDWH ER[� 7\SH �����

9 3UHVV HQWHU� 7KH OLQH LV FUHDWHG DW WKH VSHFLILHG ORFDWLRQ�
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To draw the second line:

1 ,Q WKH ;� FRRUGLQDWH ER[� W\SH �����

2 ,Q WKH <� FRRUGLQDWH ER[� W\SH �����

3 ,Q WKH ;� FRRUGLQDWH ER[� W\SH �����

4 ,Q WKH <� FRRUGLQDWH ER[� W\SH �����

5 3UHVV HQWHU� 7KH OLQH PRYHV WR WKH VSHFLILHG ORFDWLRQ�

6 &OLFN &ORVH WR FORVH WKH &RRUGLQDWHV GLDORJ ER[�

Changing Line Styles

<RX PXVW QRZ VHW WKH GHIDXOW ZHLJKW �ZLGWK� DQG HQG VW\OHV IRU WKH WZR OLQHV�

1 6HOHFW ERWK OLQHV E\ FOLFNLQJ WKH ILUVW OLQH� KROGLQJ GRZQ WKH VKLIW NH\�

DQG WKHQ FOLFNLQJ WKH VHFRQG OLQH� %RWK OLQHV DUH QRZ VHOHFWHG�

2 &OLFN WKH 6LPSOH /LQH WRRO LQ WKH WRROER[�

3 &OLFN WKH /LQH 6W\OH EXWWRQ LQ WKH VWDWXV EDU� 7KH 2EMHFW )RUPDW GLDORJ

ER[ RSHQV�

4 &OLFN WKH /LQH 6W\OH WDE�
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5 &OLFN WKH /LQH 6W\OH EXWWRQ WR GLVSOD\ WKH DYDLODEOH OLQHV�

6 &OLFN D kGDVK�GRWy VW\OH WR FKRRVH LW �\RX FDQ FKRRVH DQ\ VW\OH \RX

SUHIHU��

7 &OLFN $SSO\ DQG WKHQ &ORVH WR FORVH WKH GLDORJ ER[�

Changing the Line Weight and Cap Style

,Q WKLV H[HUFLVH \RX FKDQJH WKH GHIDXOW WKLFNQHVV DQG FDS VW\OH RI OLQHV� <RX

DOVR VHOHFW WKH 6FDOH ZLWK REMHFW RSWLRQ VR WKDW OLQHV PDLQWDLQ WKHLU

SURSRUWLRQV LI WKH\ DUH UHVL]HG� )RU H[DPSOH� LI \RX HQODUJH WKH OLQH� LWV ZLGWK

LQFUHDVHV�

1 &OLFN WKH 6LPSOH /LQH WRRO LQ WKH WRROER[�

2 &OLFN WKH /LQH 6W\OH EXWWRQ LQ WKH VWDWXV EDU� 7KH 2EMHFW )RUPDW GLDORJ

ER[ RSHQV�

3 &OLFN WKH /LQH 6W\OH WDE�

4 &OLFN WKH /LQH 7KLFNQHVV EXWWRQ�

5 6HOHFW 7KLFN DV WKH OLQH ZHLJKW�

6 7\SH ���� LQ WKH :LGWK ER[�

7 &OLFN WKH 5RXQG -RLQ EXWWRQ�

8 &OLFN $SSO\ DQG WKHQ &ORVH WR FORVH WKH GLDORJ ER[�

Moving and Duplicating Objects

,Q WKLV VHFWLRQ� \RX PDNH D GXSOLFDWH RI WKH VFUHZ LQ WKH XSSHU ULJKW SRUWLRQ

RI WKH GUDZLQJ� 7KHQ \RX PRYH HDFK VFUHZ DERYH LWV OLQH�

1 6HOHFW WKH VFUHZ LQ WKH XSSHU ULJKW FRUQHU RI WKH GUDZLQJ�

2 )URP WKH $UUDQJH PHQX� SRLQW WR 7UDQVIRUP DQG FOLFN 0RYH� 7KH

7UDQVIRUP GLDORJ ER[ RSHQV�

3 7\SH � LQ WKH &RSLHV OLVW ER[�

4 &OLFN $SSO\�
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5 'UDJ WKH VFUHZ VR WKDW WKH GXSOLFDWH LV DERYH WKH ILUVW �OHIW� GRWWHG

OLQH�

6 &OLFN &ORVH�

7 ,I QHFHVVDU\� VHOHFW DQG GUDJ WKH RULJLQDO VFUHZ VR WKDW LW LV DERYH WKH

VHFRQG �ULJKW� GRWWHG OLQH�

1RWH

7KH GRWWHG OLQHV ZLOO DSSHDU DV WKRXJK WKH\ DUH SDVVLQJ WKURXJK WKH KROHV
RQ WKH WRS SDUW RI WKH DVVHPEO\�

Slicing Lines

,Q WKLV SDUW \RX VOLFH WKH OLQHV DQG GHOHWH WKH SRUWLRQ WKDW ZRXOG EH FRYHUHG

E\ WKH DVVHPEO\�

To zoom in and slice the lines

1 &OLFN WKH 9LHZ WRRO LQ WKH WRROER[ DQG FOLFN WKH =RRP ,Q WRRO�

2 =RRP LQ WR WKH WRS ULJKW SRUWLRQ RI WKH GUDZLQJ E\ GUDJJLQJ WKH

SRLQWHU RYHU WKH DUHD \RX ZDQW WR PDJQLI\�

3 6HOHFW WKH ILUVW �OHIW� GRWWHG OLQH�

4 &OLFN WKH (GLW WRRO LQ WKH WRROER[�
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5 &OLFN 5HVKDSH 3RLQWV IURP WKH PHQX�

6 &OLFN WKH &XW DW 3RLQW EXWWRQ LQ WKH ULEERQ�

7 'UDJ DFURVV WKH GRWWHG OLQH ZKHUH WKH OLQH FURVVHV WKH ILUVW KROH� �6HH

WKH LOOXVWUDWLRQ IRU ZKHUH WR FXW�� 7KH WRS OLQH VHFWLRQ LV QRZ VHOHFWHG�

8 3UHVV HVF WR OHDYH WKH UHVKDSH SRLQWV PRGH�

9 6HOHFW WKH ERWWRP VHFWLRQ RI WKH OLQH DQG UHSHDW VWHS ��

10 'UDJ DFURVV WKH GRWWHG OLQH ZKHUH LW LQWHUVHFWV WKH ERWWRP RI WKH WRS

DVVHPEO\� 7KH FXW VHFWLRQ LV QRZ VHOHFWHG�

11 3UHVV GHO WR GHOHWH WKH VHOHFWHG OLQH�

12 6HOHFW WKH VHFRQG �ULJKW� GRWWHG OLQH�

13 5HSHDW VWHSV � WKURXJK ��

'HOHWH WKLV OLQH

'HOHWH WKLV OLQH
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14 &OLFN WKH 9LHZ WRRO DQG FOLFN )XOO 3DJH WR YLHZ WKH HQWLUH GUDZLQJ�

15 3UHVV &75/�6 WR VDYH \RXU ZRUN�

Showing Dimensions

,Q WKLV SDUW� \RX PHDVXUH WKH ZLGWK RI WKH ZDWFK E\ GUDZLQJ D KRUL]RQWDO

GLPHQVLRQ OLQH WKDW LV DV ZLGH DV WKH ZLGHVW SRUWLRQ RI WKH ZDWFK�

1 &OLFN WKH %RWWRP $VVHPEO\ OD\HU WDE DW WKH ERWWRP RI WKH VFUHHQ�

2 &OLFN WKH 'LPHQVLRQ WRRO DQG FOLFN WKH +RUL]RQWDO 'LPHQVLRQ /LQH

EXWWRQ LQ WKH ULEERQ�

3 &OLFN WKH 'LPHQVLRQ /LQH (QGV EXWWRQ LQ WKH ULEERQ� &KRRVH DQ DUURZ

HQG VW\OH WKDW GLVSOD\V DUURZV DW ERWK HQGV RI WKH OLQH�

4 &OLFN WKH &HQWHU 7H[W EXWWRQ LQ WKH ULEERQ�

5 3RLQW WR WKH OHIW HGJH RI WKH ERWWRP DVVHPEO\ RI WKH ZDWFK� DQG SUHVV

DQG KROG WKH OHIW PRXVH EXWWRQ�

6 'UDJ WKH SRLQWHU KRUL]RQWDOO\ WR WKH ULJKW HGJH RI WKH ERWWRP DVVHPEO\

DQG UHOHDVH WKH PRXVH EXWWRQ� $ GLPHQVLRQ OLQH DSSHDUV EHWZHHQ WKH

WZR SRLQWV�
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7 0RYH WKH PRXVH WR WKH WRS RI WKH GUDZLQJ� MXVW XQGHU WKH WLWOH�

k0HFKDQLFDO :DWFK $VVHPEO\�y

8 &OLFN WKH OHIW PRXVH EXWWRQ�

9 ,I \RX PDNH D PLVWDNH ZKLOH GUDZLQJ D GLPHQVLRQ OLQH� \RX FDQ SUHVV HVF

WR VWDUW RYHU�

10 3UHVV FWUO�V WR VDYH \RXU ZRUN�

11 $VVLJQLQJ 1DPHV� )LHOGV� DQG 9DOXHV WR 2EMHFWV

12 <RX FDQ XVH 'HVLJQHU WR KHOS NHHS WUDFN RI WKH QXPEHU DQG QDPHV RI

SDUWV LQ D GUDZLQJ� ,Q WKLV H[HUFLVH \RX DVVLJQ QDPHV� ILHOGV� DQG YDOXHV

WR WKH WZR VFUHZV DW WKH WRS RI WKH GUDZLQJ DQG JHQHUDWH D OLVW RI SDUWV

IRU WKH GUDZLQJ�

13 )URP WKH )LOH PHQX� FOLFN 2SHQ�

14 1DYLJDWH WR WKH 7XWRULDOV IROGHU DQG GRXEOH�FOLFN :$7&+��'6)�

15 6HOHFW WKH ODUJH VFUHZ DW WKH WRS ULJKW SRUWLRQ RI WKH GUDZLQJ�

16 3RLQW WR WKH 2EMHFW PHQX DQG FOLFN 3URSHUWLHV� 7KH 2EMHFW 3URSHUWLHV

GLDORJ ER[ RSHQV�
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17 ,Q WKH 2EMHFW 1DPH ER[� W\SH 6FUHZ�

18 &OLFN WKH )LHOGV EXWWRQ� VHOHFW 6L]H� DQG FOLFN 2.�

19 ,Q WKH 9DOXH DUHD� W\SH /DUJH�

20 &OLFN $SSO\�

21 6HOHFW D PHGLXP VL]HG VFUHZ RQ WKH OHIW SRUWLRQ RI WKH GUDZLQJ�

22 ,Q WKH 2EMHFW 1DPH ER[� W\SH VFUHZ�

23 ,Q WKH 9DOXH DUHD� W\SH PHGLXP�

24 &OLFN $SSO\�

Listing the Parts in a Drawing

<RX FDQ OLVW DOO WKH QDPHG REMHFWV LQ D GUDZLQJ� <RX FDQ WKHQ SULQW WKH OLVW RU

FRS\ LW WR WKH &OLSERDUG� ,Q WKLV H[HUFLVH \RX YLHZ WKH SDUWV OLVW DQG FRS\ LW WR

WKH &OLSERDUG�

1 )URP WKH 2EMHFW PHQX� FOLFN /LVW� 7KH 2EMHFW 3URSHUWLHV /LVW GLDORJ

ER[ RSHQV�

2 &OLFN &RS\ WR FRS\ WKH OLVW WR WKH &OLSERDUG� DQG FOLFN &ORVH WR FORVH

WKH 2EMHFW 3URSHUWLHV /LVW ER[�

Adding a New Page

1 &OLFN WKH 3DJHV EXWWRQ DW WKH ERWWRP OHIW RI WKH GUDZLQJ ZLQGRZ� 7KH

3DJHV GLDORJ ER[ RSHQV�

2 &OLFN $GG WR DGG D VHFRQG SDJH WR WKH GUDZLQJ� 7KH VHFRQG SDJH

GLVSOD\V�

3 &OLFN &ORVH WR FORVH WKH 3DJHV GLDORJ ER[�

4 )URP WKH (GLW PHQX� FOLFN 3DVWH� 7KH OLVW RI SDUWV DSSHDUV LQ WKH FHQWHU

RI WKH SDJH�

5 &OLFN WKH 3DJH � WDE WR UHWXUQ WR WKH ILUVW SDJH�

6 3UHVV FWUO�V WR VDYH \RXU ZRUN�
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Index
$

DGG D JUDGLHQW ILOO WR D VHOHFWHG REMHFW ���

DGG D QHZ DQFKRU WR DQ REMHFW ���

DGG D QHZ ZDUS HQYHORSH ���

DGG D SDJH ��

DGG D WH[W EORFN ���

DGG DQ REMHFW WR WKH JDOOHU\ ���

DGG IUHHIRUP WH[W ���

DGG OLQH HQGV WR WKH OLQH�HQGV GLDORJ ER[ ���

DGG SRLQW EXWWRQ ���

DGG SUHIL[ DQG VXIIL[ WH[W WR D GLPHQVLRQ OLQH ���

DGGLQJ

D OD\HU ��

JUDGLHQW ���

DOLJQ REMHFWV WR HDFK RWKHU ���

DOLJQHG GLPHQVLRQ ���

DOLJQLQJ

IUHHIRUP WH[W ���

REMHFWV WR D SDWK ���

REMHFWV WR RWKHU REMHFWV ���

WH[W ���

WH[W WR D SDWK ���

ZKLOH SDVWLQJ ���

ZLWKLQ D WH[W EORFN ���

DOLJQPHQW RSWLRQV

WH[W ���

DOWHUQDWH ���

DQFKRUV

DGGLQJ ���

GHOHWLQJ ���

UHGXFLQJ QXPEHU ���
I n d e x
DQJOH FRQVWUDLQW� GLPHQVLRQ OLQHV ���

DSSO\ D WH[W DWWULEXWH XVLQJ WKH VKRUWFXW PHQX ���

DSSO\ WH[W DWWULEXWHV ZLWK WKH WH[W ULEERQ ���

DUUDQJLQJ REMHFW ILOOV ���

DUURZKHDGV ���

DXWRWUDFH ���

%

EDFNJURXQG

REMHFW�ILOO FRORU ���

RI PRQRFKURPH ELWPDS ���

WH[W ���

EHYHO MRLQ RSWLRQ ���

EH]LHU FXUYHV

FRQWURO SRLQWV ���

FUHDWLQJ D FRUQHU ���

FUHDWLQJ D FXVS ���

GLVSOD\LQJ FRQWURO SRLQWV ���

GUDZLQJ ���

UHVKDSLQJ ���� ���

XVLQJ V\PPHWULFDO FXUYHV ���

ELWPDS

FURSSLQJ ���

WUDFH D ELWPDS ���

WUDQVSDUHQF\ ���

ELWPDS WRRO ���

ELWPDSV

FRORULQJ PRQRFKURPH LPDJHV ���

HGLWLQJ ���
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LPSRUWLQJ ���

OLQH W\SH IRU WUDFLQJ ���

WLSV IRU WUDFLQJ ���

WUDFLQJ ���

WUDFLQJ RSWLRQV ���

EODFN FRPSRQHQW ���

EOHQG WZR REMHFWV ���

EOHQGLQJ

KLJKOLJKWLQJ HIIHFWV ���

WUDQVIRUPDWLRQ HIIHFWV ���

EOHQGLQJ HIIHFWV ���

EORFN WH[W

DOLJQLQJ ���

ERUGHU

DOLJQLQJ WR ���

EUHDN DSDUW DQ REMHFW DW DQ DQFKRU ���

EUHDNLQJ DQ ROH OLQN ���

EUHDNLQJ DSDUW DW DQ DQFKRU ���

E�VSOLQHV

GUDZLQJ ���

EXWWRQ�SRLQW UHVKDSH ���

&

FDS RSWLRQV ���

FDUWHVLDQ FRRUGLQDWHV ��

FHQWHU WH[W LQ GLPHQVLRQ OLQHV ���

FKDLQ OLQHV ZKLOH GUDZLQJ ���

FKDLQLQJ RSHQ REMHFW ���

FKDQJH DQ ROH OLQN ���

FKDQJH VQDS SRLQW VHQVLWLYLW\ ��

FKDQJH WH[W EDFNJURXQG FRORU ���

FKDQJH WH[W OHDGLQJ ���

FKDQJH WH[W OLQH DQG LQWHULRU FRORU ���

FKDQJH WKH OLQH WKLFNQHVV DQG VSDFLQJ RI KDWFK ILOOV

���

FKDQJH WKH RUGHU RI REMHFWV ���

FKDQJH WR D GLIIHUHQW OD\HU ��

FKDQJH ZRUG DQG FKDUDFWHU VSDFLQJ ���

FKDQJLQJ WKH LPDJH VFDOH ���
332
FKDQJLQJ WKH ORFDWLRQ RI D OLQNHG ILOH ���

FKDQJLQJ WKH QXPEHU RI VQDSV ��

FKDQJLQJ WKH RULJLQV EHIRUH EOHQGLQJ ���

FKDQJLQJWKHZD\GHVLJQHUQRUPDOL]HVFP\NSHUFHQWDJHV

���

FKRRVH D KDWFK SDWWHUQ ���

FKRRVH D OLQH HQG ���

FKRRVH D OLQH HQG IURP WKH PHQX ���

FKRRVH D OLQH VW\OH IURP WKH OLQH�VW\OH GLDORJ ER[ ���

FKRRVH D OLQH VW\OH IURP WKH PHQX ���

FKRRVH D OLQH WKLFNQHVV IURP WKH PHQX ���

FKRRVH DQ REMHFW
V FRORU IURP WKH ILOO�VROLG GLDORJ ER[

���

FKRRVH HQGV IURP WKH OLQH�HQGV GLDORJ ER[ ���

FKRRVH VQDS SRLQW SODFHPHQW ��

FKRRVLQJ FP\N FRORUV ���

FKRRVLQJ FRORUV ZLWK D FRORU PRGHO ���

FKRRVLQJ KOV FRORUV ���

FKRRVLQJ UJE FRORUV ���

FKRRVLQJ ZKHUH VQDS SRLQWV DSSHDU RQ DQ REMHFW ��

FP\N ���� ���

FP\N FRORU PRGHO ���

FRORU

EOHQGLQJ ���

FKDQJLQJ WH[W EDFNJURXQG ���

FKDQJLQJ WH[W LQWHULRU ���

FKDQJLQJ WH[W OLQH ���

FKRRVLQJ ���

FRQYHUWLQJ ���

GLWKHUHG ���

QXPHULF YDOXHV ���

SDOHWWHV ���

VHOHFWLQJ ILOO ���

FRORU DUUD\ ���

FRORU PRGHO ���

FRORU SDOHWWH ���

FP\N FRORUV ���

FRQYHUWLQJ FRORU PRGHO YDOXHV ���

KOV FRORUV ���

RSHQLQJ ���

UJE FRORUV ���

XVLQJ ���

XVLQJ FRORU PRGHOV ���

FRORU SDOHWWHV
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FKRRVLQJ FRORUV ���

LQFOXGHG ZLWK GHVLJQHU ���

XVLQJ FRORU SLFNHU ���

FRORU SLFNHU ���

FRORU YDOXHV ���

FRQQHFW FORVHG ���

FRQQHFW FORVHG ZKHQ REMHFWV RYHUODS ���

FRQQHFW RSHQ ���

FRQQHFWLQJ REMHFWV ���

FRQWLQXRXV ILOO ���

FRQWURO SRLQWV ���

FRQYHUW D FRUQHU WR D V\PPHWULFDO FXUYH ���

FRQYHUW D FXUYH WR D FRUQHU ���

FRQYHUW D VSHFLDO REMHFW WR FXUYHV ���

FRQYHUW EHWZHHQ EORFN WH[W DQG IUHHIRUP WH[W ���

FRQYHUW WH[W WR REMHFW RXWOLQHV ���

FRQYHUWLQJ

REMHFW WR FXUYHV ���

FRQYHUWLQJ EHWZHHQ EORFN DQG IUHHIRUP WH[W ���

FRQYHUWLQJ FRORU YDOXHV WR DQRWKHU FRORU PRGHO ���

FRQYHUWLQJ FRORU�PRGHO YDOXHV ���

FRQYHUWLQJ VSHFLDO REMHFWV WR FXUYHV ���

FRQYHUWLQJ WH[W WR FXUYHV ���

FRRUGLQDWHV ��� ��

FDUWHVLDQ ��

FKRRVLQJ D FRRUGLQDWH V\VWHP ��

GLVSOD\LQJ ��

GUDZLQJ ZLWK ��

SRODU ��

UHFWDQJXODU ��

XVLQJ ��

FRS\ VW\OH DWWULEXWHV EHWZHHQ REMHFWV ���

FRS\LQJ DQ REMHFW IURP WKH JDOOHU\ ���

FRS\LQJ DQG SDVWLQJ REMHFWV ���

FRS\LQJ VW\OH DWWULEXWHV ���

&RS\ULJKW ��

FRUQHU

FUHDWLQJ ���

FRUQHUV ���

FUHDWH D FXVS ���

FUHDWLQJ D FXVS ���

FUHDWLQJ LPDJH SDWWHUQV ���

FUHDWLQJ V\PPHWULFDO FXUYHV ���

FURSSLQJ D ELWPDS LPDJH ���
I n d e x  
FXUUHQW SDJH FRPPDQG ���

FXUYH UHVKDSH EXWWRQ ���

FXUYH UHVKDSLQJ ���� ���

FXUYHV

FUHDWLQJ D FXVS ���

GLVSOD\LQJ FRQWURO SRLQWV ���

GUDZLQJ ���

ILWWLQJ WH[W RQ ���

V\PPHWULFDO ���

FXVS ���

FXVWRP XQLWV ��

'

GDVKHG OLQHV ���

GHIDXOW FRORU ���

GHIDXOW VW\OHV ���

GHILQLQJ VFDOH XQLWV ��

GHILQLQJ XQVFDOHG XQLWV ��

GHOHWH D SDJH ��

GHOHWH DQ DQFKRU ���

GHOHWLQJ

D GHILQHG XQLW ��

GLDORJ ER[

FXVWRP XQLWV ��

HGLW REMHFW ILOOV ���

ILOO � JUDGLHQW ���

ILOO � REMHFW ���

OLQH � HQGV ���

OLQH � VW\OH ���

OLQH � WKLFNQHVV ���

RSWLRQV � UHJLVWU\ VHWWLQJV ��

SUHIHUHQFHV � UXOHUV�VQDS ��

UHGXFH SRLQWV ���

VDYH DV ���

WH[W � SDUDJUDSK ��

GLPHQVLRQ OLQHV

HGLWLQJ ���

UHVKDSLQJ ���

GLPHQVLRQ WRRO ���
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GLPHQVLRQV ���

DGGLQJ SUHIL[ DQG VXIIL[ WH[W ���

GHILQHG ���

GHILQLQJ VFDOH XQLWV ��

GUDZLQJ ���

VHWWLQJ GLVSOD\HG SUHFLVLRQ ���

WH[W SRVLWLRQ RSWLRQV ���

WUDQVIRUPLQJ ���

GLVFRQQHFW FRQQHFWHG REMHFWV ���

GLVFRQQHFWLQJ REMHFWV ���

GLVSOD\ RSWLRQV ���� ���� ���� ���

JUDGLHQW ���

KDWFK ���

LPDJH ILOOV ���

REMHFW ILOOV ���

GLVSOD\ XQLWV DERYH D GLPHQVLRQ OLQH ���

GLVSOD\LQJ DQ DQFKRU
V FRQWURO SRLQWV ���

GLVSOD\LQJ FRRUGLQDWHV ��

GLVWULEXWLQJ PXOWLSOH REMHFWV HYHQO\ ���

GLWKHUHG FRORUV ���

GRWWHG OLQHV ���

GUDJ D FRS\ ���

GUDZ D ��SRLQW HOOLSWLFDO DUF ���

GUDZ D EH]LHU FXUYH ���

GUDZ D E�VSOLQH ���

GUDZ D FLUFOH XVLQJ WKH ��SRLQW FLUFOH PHWKRG ���

GUDZ D FXUYH ���

GUDZ D GLPHQVLRQ OLQH ���

GUDZ D IUHHKDQG REMHFW ���

GUDZ D SHUSHQGLFXODU OLQH ���

GUDZ D SRO\JRQ IURP FHQWHU WR D FRUQHU ���

GUDZ D UHFWDQJOH RU VTXDUH XVLQJ WKH GLDJRQDO PHWKRG

���

GUDZ DQ HOOLSVH XVLQJ WKH GLDJRQDO PHWKRG ���

GUDZ DQ LUUHJXODU SRO\JRQ ���

GUDZLQJ ��

EH]LHU FXUYHV ���

E�VSOLQHV ���

FKDLQLQJ RSHQ REMHFW ���

FXUYHV ���

IUHHKDQG REMHFWV ���

LUUHJXODU SRO\JRQV ���

MRLQWHG OLQHV ���

UHFWDQJXODU REMHFWV ���
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VWDUV ���

ZLWK FRRUGLQDWHV ��

GUDZLQJ EH]LHU FXUYHV ���

GUDZLQJ E�VSOLQHV ���

GUDZLQJ FXUYHV ���

GUDZLQJ GLPHQVLRQ OLQHV ���

GUDZLQJ IUHHKDQG REMHFWV ���

GUDZLQJ LUUHJXODU SRO\JRQV ���

GUDZLQJ MRLQWHG OLQHV ���

GUDZLQJ REMHFWV ���

GUDZLQJ VWDUV ���

GUDZLQJ ZLWK FRRUGLQDWHV ��

(

HGLW OLQH HQGV ���

HGLW REMHFW ILOO ���

HGLW REMHFW ILOOV ���

HGLWLQJ

ELWPDS LPDJH ���

HGLWLQJ D JURXSHG REMHFW ���

HGLWLQJ OLQH HQGV ���

HGLWLQJ REMHFW ILOOV ���

HPEHGGLQJ ROH REMHFWV ���

HQGV

VHWWLQJ OLQH HQGV ���

HQWHU WH[W GLUHFWO\ DORQJ DQ REMHFW
V SDWK ���

HQWHULQJ WH[W DORQJ D SDWK ���

HQYHORSH

DGGLQJ ���

UHPRYLQJ ZDUS ���

H[SRUWLQJ D ILOH ���

)

ILOHV
I n d e x



LPSRUWLQJ DQG H[SRUWLQJ ���

ILOO DQ REMHFW ZLWK RWKHU REMHFWV ���

ILOO EHIRUH RU DIWHU OLQH ���

ILOO RSWLRQV ���

ILOO SDWWHUQV ���

DGGLQJ JUDGLHQW ���

DIWHU OLQH ���

EHIRUH OLQH ���

FRQWLQXRXV ���

FUHDWLQJ LPDJH SDWWHUQV ���

GHILQHG ���

GLVSOD\ RSWLRQV ���

ILOOLQJ ZLWK RWKHU REMHFWV ���

JUDGLHQW ���

LQYLVLEOH ���

PDVNLQJ ���

RYHUODSV ���

UHPRYLQJ LPDJH SDWWHUQV ���

VROLG FRORU ���

ILOOLQJ DQ REMHFW ZLWK RWKHU REMHFWV ���

ILOOLQJ VHYHUDO REMHFWV ZLWK D FRQWLQXRXV ILOO ���

ILWWLQJ WH[W WR D SDWK ���

IOLS DQ REMHFW DW D VSHFLILHG DQJOH ���

IOLS DQ REMHFW KRUL]RQWDOO\ RU YHUWLFDOO\ ���

IOLS DQ REMHFW PDQXDOO\ ���

IOLSSLQJ

PDQXDOO\ ���

QXPHULFDOO\ ���

IOLSSLQJ REMHFW ILOOV ���

IRQW

EROG ���

LWDOLF ���

VL]H ���

VPDOO FDSV ���

VXEVFULSW ���

VXSHUVFULSW ���

XQGHUOLQH ���

IRQW UHFDOO EXWWRQ ���

IRQW VL]HV ���

IRQW VW\OHV ���

IRQWV

LFRQV ���

VHOHFWLQJ DYDLODEOH ���

IRUHJURXQG FRORU ���
I n d e x  
IRXQWDLQ ���

IUHHKDQG REMHFWV

GUDZLQJ ���

*

JDQWW FKDUW ���

JUDGDWLRQV ���

JUDGLHQW ILOOV

DGGLQJ ���

GLVSOD\ RSWLRQV ���

JURXS REMHFWV ���

JURXSHG REMHFWV

VHSDUDWLQJ ���

VSOLWWLQJ XS ���

XQJURXSLQJ ���

ZRUNLQJ ZLWK ���

JURXSLQJ REMHFWV ���

JXLGHV ��

DGGLQJ ��

XVLQJ ��

+

KDLUOLQH ���

KDWFK SDWWHUQV

FKDQJLQJ OLQH WKLFNQHVV ���

FKDQJLQJ VSDFLQJ ���

KLGLQJ D ELWPDS ���

KLGLQJ DQG ORFNLQJ LQGLYLGXDO REMHFWV ��

KLGLQJ OD\HUV ��

KLGLQJ REMHFWV ��

KLJKOLJKWLQJ HIIHFWV ���

KOV ���

KOV FRORU PRGHO ���

KRUL]RQWDO GLPHQVLRQ ���
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,

LPDJH SDWWHUQ

VHWWLQJ ���

LPDJH SDWWHUQV

DGGLQJ ���

FKDQJLQJ VFDOH RI ���

FUHDWLQJ ���

GLVSOD\ RSWLRQV ���

UHPRYLQJ ���

LPDJH VFDOH

FKDQJLQJ ���

LPSRUW RSWLRQV ���

LPSRUWLQJ ���

ELWPDSV ���

LPSRUWLQJ D ILOH ���

LPSRUWLQJ DQG H[SRUWLQJ ILOHV ���

LQGLYLGXDO REMHFWV

KLGLQJ ��

ORFNLQJ ��

LQYLVLEOH ILOO ���

LUUHJXODU SRO\JRQV

GUDZLQJ ���

-

MRLQ HQGSRLQWV RI DQ RSHQ REMHFW ���

MRLQ RSWLRQV ���

MRLQLQJ HQGSRLQWV RI DQ RSHQ REMHFW ���

MRLQWHG OLQHV

GUDZLQJ ���
336
.

NH\ERDUG VKRUWFXWV

DOLJQLQJ WH[W ���

IRQW VW\OHV ���

/

OD\HUV

DGGLQJ ��� ��

FKDQJLQJ ��

ORFNLQJ ��

PDQDJLQJ PXOWLSOH ��

UHPRYLQJ ��

VHOHFWLQJ PXOWLSOH ��

VKRZLQJ DQG KLGLQJ ��

XQORFNLQJ ��

/LFHQVH DJUHHPHQW ��� ��

OLQH HQGV� VHWWLQJ ���

OLQH VW\OH� LQYLVLEOH ���

OLQH WKLFNQHVV� VHWWLQJ ���

OLQH W\SH IRU ELWPDS WUDFLQJ� VHWWLQJ ���

OLQHV

DGGLQJ HQGV ���

EH]LHU FXUYHV ���

E�VSOLQHV ���

FDS RSWLRQV ���

FXUYHV ���

GDVKHG ���

GRWWHG ���

HGLWLQJ HQGV ���

IUHHKDQG REMHFWV ���

LUUHJXODU SRO\JRQ ���

MRLQ RSWLRQV ���

MRLQWHG ���

UHPRYLQJ HQGV ���

VHWWLQJ VW\OHV ���

VW\OH DWWULEXWHV ���
I n d e x



ZHLJKWHG ���

OLQNHG REMHFW

GHVFULSWLRQ ���

OLQNLQJ ROH REMHFWV ���

ORFNHG FXVS EXWWRQ ���

ORFNLQJ DQG XQORFNLQJ OD\HUV ��

ORFNLQJ REMHFWV ��

0

PDJQLILFDWLRQ

DSSO\LQJ WR DQ REMHFW ���

UHPRYLQJ IURP DQ REMHFW ���

PDJQLILFDWLRQ IHDWXUH ���

PDNH JUDGLHQW ILOOV GUDZ IDVWHU ���

PDNH KDWFK SDWWHUQV GUDZ IDVWHU ���

PDNH REMHFW ILOOV GUDZ IDVWHU ���

PDNLQJ LPDJH ILOOV GUDZ IDVWHU ���

PDUJLQV ��

PDVN DQ REMHFW ���

PDVNLQJ REMHFWV ���

PDVWHU SDJH ��

XVLQJ ��

PDVWHU SDOHWWH ���

PLUURULQJ DQ REMHFW ���

PLWUH MRLQ RSWLRQ ���

PRYH PXOWLSOH DQFKRUV ���

PXOWLFRORU RU VLQJOH�FRORU OD\HUV ��

PXOWLSOH SDJHV ��

RSHQLQJ ���

VHWWLQJ XS ��

XVLQJ ��

1

QDPLQJ D FRORU ���
I n d e x  
QRGHV ���

2

REMHFW

DSSO\ WUDQVSDUHQF\ WR ���

DV D PDJQLI\LQJ GHYLFH ���

HQWHULQJ WH[W DORQJ ���

ILWWLQJ WH[W WR SDWK ���

SDVWLQJ WH[W LQVLGH ���

SDWK ILW SDOHWWH ���

UHPRYH WUDQVSDUHQF\ IURP ���

UHPRYLQJ PDJQLILFDWLRQ IURP ���

UHSODFLQJ ���

WUDQVSDUHQF\ ���

XVLQJ DV PDJQLI\LQJ GHYLFH ���

2EMHFW ([SORUHU ���

REMHFW ILOOV

DGGLQJ DQG UHPRYLQJ ���

FRS\LQJ ���

GHILQHG ���

HGLWLQJ ���

REMHFW LG ��

REMHFWV

DGGLQJ DQFKRUV ���

DUUD\V RI ���

EOHQGLQJ ���

EULQJ IRUZDUG ���

EULQJ WR IURQW ���

FRQWLQXRXV ILOO ���

FRQWURO SRLQWV ���

FRS\LQJ WR FOLSERDUG ���

FXUYH UHVKDSLQJ ���� ���

GHOHWLQJ DQFKRUV ���

GLPHQVLRQ OLQHV ���

GLVSOD\LQJ FRQWURO SRLQWV ���

GLVWULEXWLQJ ���

HPEHGGLQJ ���

ILOOLQJ ZLWK RWKHU REMHFWV ���

IOLSSLQJ PDQXDOO\ ���
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IOLSSLQJ QXPHULFDOO\ ���

IUHHKDQG ���

JURXSLQJ ���

KLGLQJ ��

LUUHJXODU SRO\JRQV ���

OLQNLQJ ���

ORFNLQJ ��

PDVNLQJ ���

RUGHU RI ���

SDVWLQJ IURP FOLSERDUG ���

SURSHUW\ QDPHV ��

UHGXFLQJ DQFKRUV ���

UHSODFLQJ ���

UHSODFLQJ PXOWLSOH ���

UHVKDSLQJ ���

UHVKDSLQJ HOOLSVHV ���

UHVKDSLQJ UHFWDQJOH ���

UHYHUVH RUGHU ���

VHQG EDFNZDUG ���

VHQG WR EDFN ���

VHSDUDWLQJ ���

VNHZLQJ ���

VNHZLQJ PDQXDOO\ ���

VSDFLQJ ���

VSHFLDO SRLQW UHVKDSH FDVHV ���

VSOLWWLQJ XS ���

VSUHDGLQJ ���

VWDUV ���

XQJURXSLQJ ���

ZDUSLQJ ���

ROH

EUHDNLQJ D OLQN ���

FKDQJLQJ ILOH ORFDWLRQ ���

GHILQHG ���

HPEHGGLQJ REMHFWV ���

OLQNLQJ REMHFWV ���

SDVWLQJ LQVLGH ���

XSGDWLQJ DQ REMHFW ���

YLHZLQJ D OLQN ���

ROH �REMHFW OLQNLQJ DQG HPEHGGLQJ� ���

RSHQLQJ ILOHV ZLWK PXOWLSOH SDJHV ���

RSHQLQJ WKH FRORU SDOHWWH ���

RSHQLQJ WKH FRORU SLFNHU GLDORJ ER[ ���

RSWLRQV
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REMHFW ILOOV GLVSOD\ ���

VHWWLQJ ILOO�GLVSOD\ ���

VHWWLQJ JUDGLHQW GLVSOD\ ���

VHWWLQJ KDWFK GLVSOD\ ���

WUDFLQJ ���

RUGHU

EULQJ IRUZDUG ���

EULQJ WR IURQW ���

FKDQJH WKH RUGHU RI REMHFWV ���

UHYHUVH ���

VHQG EDFNZDUG ���

VHQG WR EDFN ���

RYHUODS ���

RYHUYLHZ RI SRLQW UHVKDSLQJ ���

RYHUYLHZ RI VSHFLDO REMHFWV ���

3

SDJH

SULQWLQJ FXUUHQW ���

VHWWLQJ XS PXOWLSOH SDJHV ��

XVLQJ PDVWHU SDJH ��

SDJH UDQJHV ���

SDJHV

PXOWLSOH

RSHQLQJ ���

VHWWLQJ XS ��

XVLQJ ��

SDOHWWH

FP\N FRORUV ���

FRORU ���

FRQYHUWLQJ FRORU�PRGHO YDOXHV ���

KOV FRORUV ���

UJE FRORUV ���

XVLQJ FRORU PRGHOV ���

SDOHWWHV

FKRRVLQJ FRORUV ���

LQFOXGHG ZLWK GHVLJQHU ���

XVLQJ FRORU SLFNHU ���

SDOHWWHV LQFOXGHG ZLWK GHVLJQHU ���
I n d e x



SDUDJUDSK VSDFLQJ ���

SDVWLQJ WH[W LQVLGH DQ REMHFW ���

SDWK ILW SDOHWWH ���

SRLQW UHVKDSH EXWWRQ ���

SRLQW UHVKDSLQJ ���

SRLQWV ���� ���

SRODU FRRUGLQDWHV ��

SRSXS PHQX ���

SULQWHU

VHOHFWLQJ ���

VHWWLQJ XS ���

SULQWHUV

DGGLQJ� UHPRYLQJ� DQG FRQQHFWLQJ ���

SULQWLQJ ���

FXUUHQW SDJH ���

SDJH UDQJHV ���

VHOHFWLRQ ���

SULQWLQJ D VHOHFWLRQ ���

SULQWLQJ D YLHZ ���

SULQWLQJ WKH FXUUHQW SDJH ���

SURSHUWLHV

REMHFWV ��

SURSHUWLHV DQG YDOXHV ��

4

TXLFN FKRLFH EXWWRQV

IRU ILWWLQJ WH[W WR D SDWK ���

5

UDQJH RI SDJHV ���

UHGXFLQJ DQFKRUV ���

UHJLVWU\ ��

UHJLVWU\ VHWWLQJV ��

UHPRYH
I n d e x  
WUDQVSDUHQF\ IURP REMHFW ���

UHPRYH D ZDUS HQYHORSH ���

UHPRYH DQ REMHFW IURP WKH JDOOHU\ ���

UHPRYH OLQH HQGV IURP WKH OLQH�HQGV GLDORJ ER[ ���

UHPRYH SRLQW EXWWRQ ���

UHPRYLQJ

LPDJH SDWWHUQV ���

UHQDPH D OD\HU ��

UHQDPH D SDJH ��

UHSODFLQJ

REMHFWV ���

ZLWK PXOWLSOH REMHFWV ���

UHVKDSH D FXUYH ���

UHVKDSH D GLPHQVLRQ OLQH ���

UHVKDSH E\ PRYLQJ DQ DQFKRU ���

UHVKDSH WKH ZDUS HQYHORSH ���

UHVKDSLQJ

DUFV ���

E\ DGGLQJ DQFKRUV ���

FXUYHV ���

HOOLSVHV ���

REMHFWV ���

UHFWDQJOHV ���

WH[W ���

UHVKDSLQJ FXUYHV DQG FRUQHUV ���

UHVKDSLQJ GLPHQVLRQ OLQHV ���

UHVKDSLQJ REMHFWV

FRQWURO SRLQWV ���

FRUQHUV ���

FXVSV ���

GLVSOD\LQJ FRQWURO SRLQWV ���

UHGXFLQJ DQFKRUV ���

VSHFLDO SRLQW�UHVKDSH FDVHV ���

V\PPHWULFDO FXUYHV DQG FRUQHUV ���

XVLQJ V\PPHWULFDO FXUYHV ���

UHVKDSLQJ�SRLQW ���

UHYHUVH WKH EOHQG GLUHFWLRQ ���

UJE ���

UJE FRORU PRGHO ���

URWDWH D GUDZLQJ ZLWK GLPHQVLRQ OLQHV ���

URWDWH DQ REMHFW QXPHULFDOO\ ���

URWDWLQJ REMHFW ILOOV ���

URXQG MRLQ RSWLRQ ���
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6

VDYH D GRFXPHQW ���

VFDOH

GHILQLQJ ��

VFDOLQJ DQG SRVLWLRQLQJ REMHFW ILOOV ���

VFDOLQJ REMHFWV ���

VHOHFW D WDUJHW SULQWHU ���

VHOHFW DQ LQYLVLEOH ILOO RU OLQH ���

VHOHFW DQ REMHFW IRU SRLQW UHVKDSLQJ ���

VHOHFW PXOWLSOH SDJHV ��

VHOHFW PXOWLSOH SDJHV WKDW DUH QRW QH[W WR HDFK RWKHU

��

VHOHFW WH[W DWWULEXWHV ZLWK WKH WH[W GLDORJ ER[ ���

VHOHFWLQJ

D SULQWHU ���

LQYLVLEOH ILOO ���

PDVWHU SDJH ��

VROLG FRORU ILOO ���

W\SH DWWULEXWHV ���

VHOHFWLQJ D VROLG FRORU ILOO ���

VHOHFWLQJ DQG VHWWLQJ XS \RXU SULQWHU ���

VHOHFWLQJ IRQWV� VL]HV� DQG VW\OHV ���

VHOHFWLRQ FRPPDQG ���

VHW D FXVWRP DQJOH ���

VHW ILOO RSWLRQV ���

VHW MRLQ DQG FDS RSWLRQV ���

VHW WKH OLQH WKLFNQHVV LQ WKH OLQH�WKLFNQHVV GLDORJ ER[

���

VHW XS D WDUJHW SULQWHU ���

VHW XS PXOWLSOH SDJHV ��

VHWWLQJ

VQDS RSWLRQV ��

XQLWV ��

VHWWLQJ GHIDXOW VW\OHV ���

VHWWLQJ GLVSOD\HG SUHFLVLRQ ���

VHWWLQJ MRLQ DQG FDS RSWLRQV ���

VHWWLQJ OLQH HQGV ���

VHWWLQJ OLQH VW\OHV ���

VHWWLQJ PDUJLQV ��

VHWWLQJ WKH LPDJH SDWWHUQ ���

VHWWLQJ WKH OLQH WKLFNQHVV ���
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VHWWLQJ WKH OLQH W\SH IRU WUDFLQJ ���

VHWWLQJ WKH WUDFH TXDOLW\ ���

VHWWLQJ WUDFLQJ RSWLRQV ���

VHWWLQJ XS

D SULQWHU ���

PDVWHU SDJH ��

VHWWLQJ XS PXOWLSOH SDJHV ��

VHWWLQJ XS XQLWV RI PHDVXUH ��

VKDGH ���

VKRUWFXW PHQX ���

VKRZLQJ D KLGGHQ ELWPDS ���

VKRZLQJ DQG KLGLQJ OD\HUV ��

VKRZLQJ OD\HUV ��

VKRZLQJ REMHFWV ��

VNHZLQJ

PDNLQJ FRSLHV ���

PDQXDOO\ ���

VODQW ���

VOLFH DQ REMHFW ���

VPRRWK ���

VPRRWK DQ REMHFW ���

VPRRWKLQJ DQ REMHFW ���

VQDS

VHWWLQJ RSWLRQV ��

VQDS SRLQWV

FKDQJLQJ VHQVLWLYLW\ ��

FKRRVLQJ SODFHPHQW ��

VROLG FRORU ILOO ���

VSDFLQJ REMHFWV ���

VSDFLQJ� SDUDJUDSK VSDFLQJ ���

VSHFLDO HIIHFWV

EOHQGLQJ ���

ZDUSLQJ REMHFWV ���

VSHFLDO WH[W HIIHFWV ���
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WDUJHW SULQWHU

VHOHFWLQJ ���
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DGGLQJ EORFN ���

DOLJQLQJ ���

DOLJQLQJ IUHHIRUP ���

DOLJQLQJ ZLWKLQ D EORFN ���

DOLJQPHQW RSWLRQV ���

EROG ���

FKDQJLQJ EDFNJURXQG FRORU ���

FKDQJLQJ LQWHULRU FRORU ���

FKDQJLQJ OLQH FRORU ���

FRQYHUWLQJ EHWZHHQ EORFN DQG IUHHIRUP ���

FRQYHUWLQJ WR FXUYHV ���

HGLWLQJ DORQJ D SDWK ���

HQWHULQJ DORQJ D SDWK ���

ILWWLQJ WR D SDWK ���

IORZLQJ EHWZHHQ FRQWDLQHUV ���

IRQW VL]H ���

IRQW VW\OHV ���

LWDOLF ���

NH\ERDUG VKRUWFXWV IRU DOLJQLQJ ���

PDUJLQV ��

RQ D FXUYH ���

RQ D SDWK ���

SDUDJUDSK VSDFLQJ ���

SDVWLQJ LQVLGH DQ REMHFW ���

SDWK ILW SDOHWWH ���

UHVKDSLQJ ���

UHVL]LQJ EORFN ���

ULEERQ ���
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WUDFLQJ ELWPDSV ���
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WUDQVSDUHQF\
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XQJURXS REMHFWV ���
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GHILQLQJ VFDOH ��
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XSGDWLQJ DQ ROH REMHFW ���
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8VLQJ ���
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YHUWLFDO GLPHQVLRQ ���

YLHZ ���

YLHZ FRPPDQG ���

YLHZLQJ DQ ROH OLQN ���
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ZDUS

DGGLQJ D QHZ HQYHORSH ���

LQFUHDVLQJ GHQVLW\ RI HQYHORSH ���

UHPRYLQJ DQ HQYHORSH ���

ZDUS DQ REMHFW ���

ZDUSLQJ HIIHFWV ���

ZDUSLQJ REMHFWV ���

ZDVK ���

ZHLJKWHG OLQHV ���

ZLQGLQJ ���
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	Copyright
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	Installing Designer
	To install Designer from CD-ROM
	1 Start Windows. The Program Manager opens.
	2 Insert the Designer CD-ROM in your CD-ROM drive.
	3 Open the File menu and choose Run. The Run dialog box opens.
	4 Type x:\setup (where x is the drive letter for your CD-ROM drive) and press enter.
	5 Follow the instructions on your screen.

	Installing Designer on a Network

	Uninstalling Designer
	To remove Designer
	1 Click Start and select Settings.
	2 From the Settings submenu, select Control Panel.
	3 From the Control Panel, select Add/Remove programs.
	4 Click the Install/Uninstall tab.
	5 Select iGrafx System Uninstaller and click the Add/Remove button.
	6 Follow the instructions on the screen.


	Starting Designer
	To start Designer
	Displaying the Welcome Screen
	Getting Around in Designer
	The Designer Window
	Menu Commands
	Hints
	To show or hide tool tips
	To show or hide longer hints
	1 Open the Display menu and choose Hint Line. A submenu opens.
	2 Select Window to display the floating hint window.

	Drawing Windows
	Rulers and Grid

	Creating a New Designer Window
	To create a new drawing

	Accessing On-line Help
	To use context-sensitive help
	1 Highlight a command, open a dialog box, or point to a tool or button.
	2 Press F1. A context-sensitive message appears in the help window.


	Technical Support
	Complimentary support
	Continued Support Options

	Tool and Button Summary
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	Permanent Project Buttons/Tabs
	Status Bar Buttons
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	Rotate/Skew Tool
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	Using the Status Bar
	Setting the Preview (on the View menu)
	General Options
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	Setting the Auto Save Time Period
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	Setting the Output to QSF
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	Setting Ruler Options
	Setting the Ruler Units
	Setting the Number of Snaps Per Unit
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	Setting Displayed Precision Coordinates
	Changing the Ruler Origin
	To change the placement of the ruler origin
	1 Make sure that rulers are displayed. On the View menu, click Rulers, and then click Show Rulers...
	2 Point to the button at the intersection of the two rulers and press and hold the left mouse but...
	3 Drag the mouse pointer to the desired position.
	4 Release the mouse button. The zero point on each ruler changes to reflect the new placement.


	Setting Snap Options
	Snapping to the Ruler
	Snapping to Guides
	Setting a Dragging Snap
	Setting the Dynamic Snap
	To set the Dynamic Snap
	1 On the Tools menu, click Snap.
	2 Click Dynamic Snap on the submenu. or Click Options and then click the Snap tab. Click the Dyna...

	To add dynamic snaps
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	2 On the Tools menu, click Snap. Select Customize Dynamic Snaps from the submenu.
	3 On the Customize Dynamic Snaps dialog box, click Add.
	4 On the dialog box display, click where you want each additional snap point.
	5 Click Apply and then click Close.

	To delete dynamic snaps
	1 Select an object.
	2 On the Tools menu, click Snap. Select Customize Dynamic Snaps from the submenu.
	3 On the Customize Dynamic Snaps dialog box, click the snap point you want to delete. To select m...
	4 Click Delete.
	5 Click Apply and then click Close.

	To move dynamic snaps
	1 Select an object.
	2 On the Tools menu, click Snap. Select Customize Dynamic Snaps from the submenu.
	3 On the Customize Dynamic Snaps dialog box, click the snap point you want to move. To select mor...
	4 Keep the left mouse button pressed and drag the snap point(s) to their new location. Release th...
	5 Click Apply and then click Close.


	Changing Snap Point Sensitivity
	To change snap point sensitivity
	1 On the Tools menu, click Options.
	2 Select a handle size. A large handle size increases the snap range; a smaller size decreases th...

	To toggle Snap to Rulers on or off
	To toggle Snap to Guides on or off
	To toggle Dynamic Snap on or off
	To toggle Dynamic Snap on or off

	Choosing Where Snap Points Appear on an Object
	Object Snap Points
	To choose snap point placement
	1 Open the Tools menu and click Options.
	2 Click Snap to display the Snap panel.
	3 Choose the locations where you want snap points to appear.
	4 Click OK when you finish.


	Changing the Number of Snaps
	To change the number of snaps
	1 On the Tools menu, click Options
	2 Click the Ruler tab.
	3 Change the number of snaps per ruler unit. The rulers redraw to correspond to the number of sna...


	Setting Rotation Options
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	Setting a Manual Rotation Increment

	Setting Input Options
	Setting the Left Button Click
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	Setting the Intellimouse Wheel
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	Setting Profile Options
	To change or select a different profile
	1 On the Tools menu, click Options.
	2 Click the Profile tab. The Profile panel opens.
	3 Choose a different PRO file from the Profile Document list box.
	4 Select Save on Exit if you want Designer to use the new profile the next time Designer is opened.
	5 Click OK. Designer now uses the preferences in the profile to which you changed, and any change...

	To create a new profile
	1 On the Tools menu, click Options.
	2 Choose Profile. The Profile panel opens.
	3 Click the File Options button and choose New. The New Profile Document dialog box opens.
	4 Type a filename for the new profile and press enter. The New Profile Document dialog box closes...

	To copy a profile
	1 On the Tools menu, click Options.
	2 Click Profile. The Profile panel opens.
	3 Click the File Options button and choose Copy. The Copy Profile Document dialog box opens.
	4 Type a new filename and press enter. The Copy Profile Document dialog box closes. The new filen...

	To delete a profile
	1 On the Tools menu, click Options.
	2 Click Profile. The Profile panel opens.
	3 Choose a file in the Profile Document list box that you want to delete.
	4 Click the File Options button and choose Delete. You are asked to confirm that you want to dele...
	5 Click Yes to confirm the deletion.

	To rename a profile
	1 On the Tools menu, click Options.
	2 Choose Profile. The Profile panel opens.
	3 Click the File Options button and choose Rename. The Rename Profile Document dialog box opens.
	4 Type a new filename and press enter. The Rename Profile Document dialog box closes, and the ren...

	To update a profile
	1 On the Tools menu, click Options.
	2 Choose Profile. The Profile panel opens.
	3 Click the File Options button and choose Update. The current profile is updated with any prefer...


	Setting Registry Options
	1 On the Tools menu, click Options.
	2 Click the Registry tab.
	3 Choose the key name from the Key list box.
	4 In the Value Name list, click the name whose value you want to change.
	5 Highlight the old value and type the new value over it.
	6 Click OK to confirm the change and to close the Options dialog box.
	To add a new value to a registry key
	1 On the Tools menu, click Options.
	2 Click the Registry tab.
	3 Choose the key name from the Key list box.
	4 Click the New Value button.
	5 Type the name of the new value. If the value is numeric, click Numeric Value Type.
	6 In the Value box, type the new value.
	7 Click OK to confirm the addition and to close the Options dialog box.

	To delete a value from a registry key
	1 On the Tools menu, click Options.
	2 Click the Registry tab.
	3 Choose the key name from the Key list box.
	4 Choose a name from the Value Name list box.
	5 Click the Delete Value button.
	6 Click OK to confirm the deletion and to close the Options dialog box.


	Setting Spelling Options
	Setting Guide Lines
	Adding Guide Lines
	To add a guide line
	1 Move the selection pointer to the top or side ruler (for a horizontal or vertical guideline, re...
	2 Press and hold the left mouse button, and drag a guide line to the desired position in the draw...
	3 Release the left mouse button.



	Setting Up Units of Measure
	Setting Standard Units
	Changing a Units Setting
	To change the units setting for the page size
	1 Open the File menu and choose Page Setup. The Page Setup dialog box opens.
	2 Click the Units button (marked with an abbreviation for a standard unit, such as “in” or “cm”)....
	3 Choose the desired units setting from the menu.
	4 The menu closes and the Units button in the Page Setup dialog box changes to reflect the new se...
	5 Click OK to close the Page Setup dialog box.


	Defining Scale Units
	To define a scale unit of 2 feet per inch
	1 Open the Tools menu and choose Custom Units. The Defined Custom Units dialog box opens.
	2 Click Add Unit. The Add Custom Unit dialog opens.
	3 Click in the Unit Name field and type the name Feet (scale 2).
	4 In the Primary Unit section, enter 2 in the Scale field.
	5 In the Label field, enter m.
	6 In the Real World Units section, select Centimeters from the drop list.
	7 Click OK.

	To apply scale units to a dimension line
	1 Click the Dimension tool .
	2 Click the Units button in the ribbon. A menu opens.
	3 Choose More Units. The Available Units dialog box opens.
	4 Highlight the scale units you want to use.
	5 Click OK.


	Defining Unscaled Units
	Updating Unit Settings
	Defining Units with the Scale Drawing Wizard
	To set units with the Scale Drawing Wizard
	1 On the File menu, click Scale Setup.
	2 Click the appropriate measurement system, Imperial or Metric. Click Next.
	3 If you selected Imperial, click the appropriate scale type, Architectural or Engineering. Click...
	4 Click the appropriate scale setting. Click Next.
	5 Click the applicable Designer drawing.
	6 Click Finish.


	Deleting a Defined Unit

	Setting Up a Page
	Setting Page Options
	Setting the Page Size
	Using a Master Page
	Setting the Page Orientation
	Using the Printable Area
	Setting the Width/Height
	Defining Units
	Applying to All Open Pages
	Page Tiling

	Setting Margins
	Using the Master Page
	To set up and use the master page
	1 Create a new document.
	2 Click the Master Page tab at the bottom left of the window. The master page displays.
	3 Click Page Setup on the File menu. The Page Setup dialog box opens.
	4 Choose page size and orientation, and adjust the margins if necessary.
	5 If you want a background color or fill, choose the Page Fill option, click the Page Fill button...
	6 Click OK to close the Page Setup dialog box.
	7 Place any items on the master page that you want to appear on all your pages.
	8 Use the Master Page as the Page Size for all other pages in your document.


	Using Multiple Pages
	Setting Up Multiple Pages
	To set up multiple pages
	1 Open a document with multiple pages.
	2 Click the Page Manager tool in the toolbox. Thumbnail images are displayed for each page in the...
	3 Press and hold ctrl and select each page you want to setup.
	4 Click the Page Setup button in the ribbon. The Page Setup dialog box opens.
	5 Choose the page size, orientation, margins, and so forth.

	To select multiple pages
	1 In Page Manager view, you can simply click the desired page to select it.Click the Page Manager...
	2 Click the first page you want to select.
	3 Press and hold shift and click the last page you want to select. Designer selects every page be...

	To select multiple pages that are not next to each other
	1 Click the Page Manager tool . The drawing area changes to Page Manager view.
	2 Click the first page you want to select.
	3 Press and hold ctrl and click the other pages you want to select. Only the pages you click are ...

	To view a different page in the document
	To sort pages in a document into a different order
	1 Open a document with multiple pages.
	2 Click the Page Manager tool . The drawing area changes to Page Manager view.
	3 Select a page and drag it to the beginning, end, or middle of the sequence.

	To rename a page
	1 Right-click the Page tab of the page you want to rename. The Page menu opens.
	2 Click Rename Page.
	3 Type in the page name and click Ok.
	1 Click the Pages button in the lower left corner of the window. The Pages dialog opens.
	2 Under Current Page, select the page you want to rename.
	3 Point to the Page name text box and click the left mouse button.
	4 Type a new page name and press enter.

	To add a page
	1 Click the Pages button at the bottom left of the active window. The Page dialog opens.
	2 Click Add or right-click on a page tab and select Add Page from the menu.

	To delete a page
	1 Click the Pages button at the bottom left of the active window.
	2 The Pages dialog box opens.
	3 Highlight a page name and click Delete to delete the specified page and its contents



	Setting Up Layers
	Benefits of Layers
	Basic Layer Tasks
	To change to a different layer
	To select multiple layers
	1 Create or open a document with multiple layers.
	2 Click the Layers button at the bottom of the active window. The Layers dialog box opens.
	3 Choose the first layer you want to select.
	4 Press and hold shift and choose the last layer you want to select. Every layer between the two ...

	To select multiple layers that are not next to each other
	1 Create or open a document with multiple layers.
	2 Click the Layers button at the bottom of the active window. The Layers dialog box opens.
	3 Choose the first layer you want to select.
	4 Press and hold ctrl and choose the other layers you want to select. Only the layers you choose ...

	To rename a layer
	1 Right-click the layer you want to rename.
	2 Select Rename layer from the menu.
	3 Type in the layer name.
	4 Click Ok.
	1 Click the Layers button at the bottom of the active window. The Layer menu opens.
	2 Click the Layers button in the menu. The Layers dialog box opens.
	3 Highlight the name of the layer you want to rename.
	4 Point to the Layer Name text box and click the left mouse button.
	5 Type a new name and press enter. The new name appears in the list of names.

	To add and remove layers
	1 Right-click on a layer tab.
	2 To add a layer, choose Add Layer from the menu. or To delete a layer, choose Delete Layer from ...
	1 Click the Layers button at the bottom of the active window. The Layers dialog box opens.
	2 To add a layer, click the Add Layer button.
	3 To remove a layer, choose the layer you want to remove and click the Delete Layer button. The l...

	To change the order of layers
	1 Right-click on a layer tab.
	2 Use the Move Layer Up and Move Layer Down commands in the Layers menu.
	1 Click the Layer button at the bottom of the active window. The Layer menu opens.
	2 Click the Layers button in the menu. The Layers dialog box opens.
	3 To move a layer up the list, choose the layer you want to move and click the Move Up button.
	4 To move a layer down the list, choose the layer you want to move and click the Move Down button.

	To move an object from one layer to another
	1 Select the object you want to move to another layer.
	2 Right-click on the active layer tab. The Layer menu opens.
	3 Select Move to Layer from the menu.
	4 Double click the name of the layer to which you want to move. The selected object moves to the ...

	To edit all layers
	1 Right-click on a layer tab and select Edit All Layers. or Click the Layers button at the bottom...
	2 Select the Edit All Layers option. You can now select and edit all objects on all layers. Desel...


	Locking and Unlocking Layers
	To lock or unlock layers
	1 right-click on a layer tab and choose Locked. or Click the Layer button at the bottom of the ac...
	2 To lock a layer, choose the layer you want to lock and click the Lock Layer button.
	3 To unlock a layer, choose the layer you want to unlock and click the Unlock Layer button.


	Showing and Hiding Layers
	To show or hide layers
	1 Right-click on a layer tab and select Visible from the menu. or Click the Layers button at the ...
	2 To show a layer, choose the layer you want to show and click the Show button.
	3 To hide a layer, choose the layer you want to hide and click the Hide button.


	Hiding and Locking Individual Objects
	To hide or lock individual objects
	1 Select one or more objects to hide or lock.
	2 Open the Arrange menu.
	3 Choose Hide or Lock.

	To show or unlock all objects
	1 Open the Arrange menu.
	2 Choose Show All or Unlock All.


	Using Multicolor or Single-Color Layers
	To change a layer to a single-color layer
	1 Click the Layers button at the bottom of the active window. The Layers dialog box opens.
	2 Choose the layer that you want to make a single color.
	3 Click the Layer Color button. A color palette opens.
	4 Choose a color from the color palette.
	5 Click the Single-color button. An indicator appears to mark the chosen layer as all one color.


	Printable Layers
	To make a layer printable or non-printable
	1 Right-click the layer tab and select Printable from the menu. or Click the Layers button at the...
	2 To make a layer printable, choose the layer you want to print and click the Printable Layer but...
	3 To make a layer non-printable, choose the layer you do not want to print and click the Non-Prin...



	Setting Up Coordinates
	Displaying Coordinates
	Choosing a Coordinate System
	Using Cartesian Coordinates
	Using Polar Coordinates
	To choose a coordinate system
	1 Click the Coordinates button in the status bar.
	2 Choose Cartesian, Polar (Radians), or Polar (Degrees). The position and object information refl...


	Drawing with Coordinates
	To draw a rectangle with coordinates
	1 Click the Coordinates button in the status bar and choose Coordinates. The Coordinates dialog b...
	2 Click Create a New, then select Rectangle from the list.
	3 Click the down arrow in the Method list box and choose Width/ Height, if necessary.
	4 In the Position section choose the top left handle in the From list.
	5 Place the cursor at the X scroll box. Type 4 and press the Tab key.
	6 In the Y scroll box, type 6. You have now specified the X and Y coordinates for the starting po...
	7 In the Width scroll box, type 10 and press tab. The width of the rectangle is 10 centimeters.
	8 In the Height scroll box, type 3.
	9 Press enter or click Create. Designer draws the rectangle on the page with the exact starting p...
	10 Click Close to close the Coordinates dialog box.



	Setting Object Names and Other Properties
	To name (or rename) an object
	1 Select an object.
	2 On the Object menu, click Properties. The Properties dialog box opens.
	3 Type a name in the Object Name box and click Apply.
	4 Click Close.

	To create a new field
	1 Select an object.
	2 On the Object menu, click Properties. The Properties dialog box opens. Notice the name of the o...
	3 Click Add.
	4 Type Cost, for example, in the Field box and press the tab key.
	5 Type 3.25, for example in the Value box and click Apply or press the Enter key.
	6 Repeat steps 3 through 5 to add additional fields and values.
	7 Click Close

	Working with Files
	Opening Files
	To open a file
	1 On the File menu, click Open. The Open dialog box opens. (Keyboard shortcut ctrl+o)
	2 Click the drive that contains the document you want to open.
	3 Double click the appropriate folder.
	4 Click a filename to see a preview of the drawing.
	5 Click Open. The drawing appears in the drawing area.

	To create a new file
	To name a new file
	1 Click Save or Save As on the File menu. The Save As dialog box opens.
	2 Type a name in the File Name text box and press enter.


	Recalling a File
	To open a recently used file

	Closing a File
	To close a file
	To make a copy of a file
	1 Click Open on the File menu. The Open dialog box opens.
	2 Click the right mouse button on the name of the file you want to copy.
	3 Click Copy on the shortcut menu.
	4 Double-click the folder where you want the copy to reside.
	5 Click the right mouse button outside of any file names, and click Paste.

	To delete a file
	1 On the File menu, click Open. The Open dialog box opens.
	2 Click the right mouse button on the name of the file you want to delete.
	3 On the shortcut menu, click Delete.
	4 Click Yes to delete the file or click No to cancel the deletion.

	To rename a file
	1 On the File menu, click Open. The Open dialog box opens.
	2 Click the right mouse button on the name of the file you want to rename.
	3 On the shortcut menu, click Rename.
	4 Type the new filename and extension and press enter.


	Finding a File
	To find a file
	1 On the File menu, click Open. The Open dialog box opens.
	2 Click Find. The Find File dialog box opens.
	3 Type the name of the file you want to search for.
	4 Type a drive and folder, or click the Browse button to search for the folder.
	5 Click Find new. Designer lists the names and locations of matching files.
	6 Highlight one or more file names from the search list.
	7 Click Open. Each selected document opens in its own window.


	Saving a File
	To save a file
	1 If you have more than one document open, select the window of the document you want to save.
	2 On the File menu, click Save. If you are saving a document for the first time, the Save As dial...
	3 Type the filename you want. If you do not provide an extension, DSF is used.
	4 Choose the drive and folder in which you want to store the file.
	5 Choose the file format you want in the file type list box if you want to save the document as a...
	6 Click Save to save the file.

	Import and Export
	When you close Designer

	Saving Copies of a File
	To save a copy of a file
	1 On the File menu, click Save As. The Save As dialog box opens. (Keyboard shortcut ctrl+shift+s)
	2 Type a different filename for the document copy.
	3 Choose the drive and folder in which you want to store the copy.
	4 Click Save. A copy of the document is stored with the new filename.

	To revert to a saved file
	1 On the File menu, click Revert To Saved. Designer asks if you are sure you want to ignore all c...
	2 Click Yes to open the most recently saved version of the document, or click No to return to the...


	Closing Designer
	To close Designer



	Importing and Exporting Files
	Import/Export Filters
	Multiple pages and layers during import/export

	Importing Files
	Multiple pages and layers during import
	To import a file
	1 On the File menu, click Import. The Import dialog box opens.
	2 Click the down arrow in the Files of Type list box.
	3 Choose the type of file you want to import.
	4 Change to the drive and folder you want.
	5 Highlight the name of the file you want to import.
	6 Click Setup if you want to change import settings (if available).
	7 Click Import. The dialog box closes and the imported file appears in the drawing area.


	Exporting Files
	Multiple pages and layers during export
	To export a file
	1 Select the objects you want to export. If no objects are selected, the entire page is exported.
	2 On the File menu, click Export. The Export dialog box opens.
	3 Choose a drive and folder for the exported file’s destination, if necessary.
	4 Type a name for the file.
	5 Click the down arrow in the Save as Type list box.
	6 Choose the type of file you want to export. Designer automatically adds the proper extension to...
	7 Click Setup if you want to change export settings (if available).
	8 Click Export. Designer exports the file in the chosen format.


	Drawing Objects

	What is a Designer Object?
	Basics of Drawing
	Drawing with the Toolbar and Ribbon
	To draw an object using the ribbon
	1 Click the Simple Line tool in the toolbox.
	2 Click a drawing method. For example, click the Line Segment button to draw a straight line.
	3 Move the pointer onto the drawing area and drag to create the desired object.

	To draw using the last drawing method
	1 Point to an empty area and double click the left mouse button.
	2 Your cursor changes back to the last drawing tool used. Drag to create an object.

	To draw with crosshairs
	To cancel an action before completing it
	To undo an action
	To redo an action

	Resetting an Object Transformation
	To reset an object transformation
	1 Select the objects to reset.
	2 On the Arrange menu, click Reset Transform.



	Drawing with the Constraint Tools
	Constraining with the Keyboard
	Constraining to a 15-degree Angle
	Constraining to a Square or Circle
	Reversing the Drawing Direction
	Using the From Center Button

	Drawing with Snap Points
	Adding Snap Points to an Object
	To add snap points to an object
	1 Select the objects you want to have snap points.
	2 Click the Add Snap Points button in the menu bar. Snap points are placed at the locations selec...


	Removing Snap Points from an Object
	To remove snap points

	Using Connect-A-Draw
	To chain lines while drawing
	1 Draw a segment of the line.
	2 Select a different drawing method, if you wish. Hollow boxes appear at both ends of the line.
	3 Point to a hollow box at one end of the line and draw the next portion of the object.
	4 Repeat steps 2 and 3 to chain more segments.

	To chain an existing open object
	1 Select the object you want to augment.
	2 Select a drawing method. Hollow boxes appear at both ends of the line when an applicable method...
	3 Point to a box at one end of the line and draw the next portion of the object.
	4 Repeat steps 3 and 4 to chain more segments.



	Choosing Drawing Shapes and Objects
	Drawing Simple Lines
	To draw a simple line segment
	1 Click the Simple Line tool in the toolbox.
	2 Click the Line Segment button in the ribbon.
	3 Move the pointer to the drawing area.
	4 Drag to draw the line.
	5 Release the mouse button when you finish drawing the line.

	Drawing Parallel Lines
	To draw a parallel or tangent line
	1 Click the Simple Line tool in the toolbox.
	2 Click the Line Segment button in the ribbon.
	3 Draw your initial line segment by dragging it across your Designer page.
	4 Click the Parallel Line button in the ribbon.
	5 Move the pointer near the object, and press and hold the left mouse button.
	6 Drag the pointer the desired distance from the line or curve to draw the second line.
	7 Release the mouse button when you finish drawing the line.


	Drawing Perpendicular Lines
	To draw a perpendicular line
	1 Click the Simple Line tool in the toolbox, if necessary.
	2 On the ribbon, click the Line Segment button
	3 Draw your initial line segment by dragging it across your Designer page.
	4 On the ribbon, click the Perpendicular Line button .
	5 Move the pointer near your first line, and press and hold the left mouse button.
	6 Drag the pointer the desired distance from the line or curve to draw the line.
	7 Release the mouse button when you finish drawing the line.


	Extending a Line
	To extend a straight line
	1 Double click the line you want to extend.
	2 Click the Simple Line tool in the toolbox.
	3 Click the Parallel button or the Perpendicular button in the ribbon.
	4 Point to the end of the line you want to extend, and drag to extend line.

	To draw an arc
	1 Click the Ellipse tool in the toolbox.
	2 Click the 3-Point Arc button in the ribbon.
	3 Drag to draw a line between the first two points. Release the mouse button. The arc appears on ...
	4 Click the mouse button when you finish drawing the arc.


	Drawing a Parabola
	To draw a parabola
	1 Click the Simple Line tool in the toolbox.
	2 Click the Parabola button in the ribbon.
	3 Point where you want to begin the parabola.
	4 Drag where you want to place the other end of the parabola. Release the mouse button.
	5 Move the pointer to where you want the highest point of the curve.
	6 Click the mouse button to finish drawing the parabola.



	Drawing Compound Lines
	Drawing Jointed Lines
	To draw a jointed line
	1 Click the Compound Line tool in the toolbox.
	2 Click the Jointed Line button in the ribbon.
	3 Point where you want to begin the jointed line, and click the left mouse button.
	4 Move the mouse to the second point, and click the left mouse button.
	5 Repeat for each segment or point.
	6 Press esc when you finish.


	Drawing Curves
	To draw a curve
	1 Click the Compound Line tool in the toolbox.
	2 Click the Curved Line button in the ribbon.
	3 Point where you want to begin the curve, and click the left mouse button.
	4 Drag to draw a line, and click the left mouse button.
	5 Drag the pointer. The line curves in the direction you move the pointer. Click the left mouse b...
	6 Repeat steps 3 and 5 to add more curved segments.
	7 Press esc when you finish.


	Drawing Bézier Curves
	To draw a Bézier curve
	1 Click the Compound Line tool in the toolbox.
	2 Click the Bézier Curve button in the ribbon.
	3 Point where you want to begin the curve, and click the left mouse button.
	4 Move the pointer where you want to place the second point. Press and hold the left mouse button...
	5 Drag the pointer to change the curvature of the line. Release the mouse button when you have th...
	6 Repeat steps 3 and 6 to draw more (connected) curves.
	7 Press esc when you finish.


	Drawing B-Splines
	To draw a B-spline
	1 Click the Compound Line tool in the toolbox.
	2 Click the B-Spline button in the ribbon.
	3 Point where you want to begin the curve, and click the left mouse button.
	4 Drag to draw the first line of the curve, and click the left mouse button.
	5 Drag to draw the second line of the curve, and click the left mouse button.
	6 Repeat step 5 to draw additional (connected) curves.
	7 Press esc when you finish.


	Drawing Freehand Objects
	To draw a freehand object
	1 Click the Compound Line button in the toolbox.
	2 Click the Freehand button in the ribbon.
	3 Point where you want to begin drawing.
	4 Drag to draw the object.
	5 Release the mouse button when you finish drawing.


	Drawing Irregular Polygons
	To draw an irregular polygon
	1 Click the Compound Line tool in the toolbox.
	2 Click the Irregular Polygon button in the ribbon.
	3 Point where you want to begin the polygon.
	4 Drag to draw the first side of the polygon. Release the mouse button when you have the first si...
	5 Move the pointer where you want to place the third point. Click the left mouse buttons.
	6 Repeat step 5 to place more points, if you wish.
	7 Press esc when you finish.



	Drawing Sticky Lines
	To draw a sticky line
	1 Select the Sticky Line tool in the toolbox.
	2 Click where you want the line to start.
	3 Keeping the mouse button pressed, move the pointer where you want the line to end.
	4 To complete the line, release the mouse button.

	To draw a sticky quarter arc
	1 Select the Sticky Quarter Arc tool in the toolbox.
	2 Click where you want the line to start.
	3 Keeping the mouse button pressed, move the pointer where you want the line to end.
	4 To complete the line, release the mouse button.

	To draw a sticky jointed line
	1 Select the Sticky Jointed Line tool in the toolbox.
	2 Click where you want the line to start.
	3 Keeping the mouse button pressed, move the pointer where you want the line to stop.
	4 Release the mouse button and click and drag the line again, moving the pointer where you want t...
	5 To complete the line, release the mouse button and press esc.

	To draw a sticky curved line
	1 Select the Sticky Curved Line tool in the toolbox.
	2 Click where you want the line to start.
	3 Keeping the mouse button pressed, move the pointer where you want the line to curve.
	4 Release the mouse button and click and drag the line again, moving the pointer where you want t...
	5 To complete the line, release the mouse button and press esc.

	To draw a sticky freehand line
	1 Select the Sticky Freehand Line tool in the toolbox.
	2 Click where you want the line to start.
	3 Keeping the mouse button pressed, move the pointer where you want the line to end.
	4 To complete the line, release the mouse button.

	To draw a sticky right-angle line
	1 Select the Sticky Right-Angle Line tool in the toolbox.
	2 Click where you want the line to start.
	3 Keeping the mouse button pressed, move the pointer where you want the line to end.
	4 To complete the line, release the mouse button.

	To draw a sticky Bézier line
	1 Select the Sticky Bézier Line tool in the toolbox.
	2 Click where you want the line to start.
	3 Keeping the mouse button pressed, move the pointer where you want the line to end.
	4 To complete the line, release the mouse button.


	Drawing Rectangular Objects
	Drawing a Rectangle or Square
	Using the Diagonal Method
	Using the Height/Width Method
	Using the Single Side Method
	To draw a rectangle or square using the Diagonal method
	1 Click the Rectangle tool in the toolbox.
	2 Click the Diagonal button in the ribbon.
	3 Point where you want to begin the rectangle and drag the pointer to the opposite corner.
	4 Release the mouse button when you finish the rectangle.

	To draw a rectangle or parallelogram using the Height/Width method
	1 Click the Rectangle tool in the toolbox.
	2 Click the Height/Width button in the ribbon.
	3 Point where you want to begin the rectangle or parallelogram.
	4 Drag to draw the first edge.
	5 Release the mouse button.
	6 Move the pointer to draw the rest of the object.
	7 Click the right mouse button (and release shift if you drew a rectangle) when you finish.


	Drawing Rectangles with Rounded Corners
	To draw a rounded rectangle
	1 Click the Rectangle tool in the toolbox.
	2 From the ribbon, click the method button of your choice.
	3 Click the Rounded Rectangle button in the ribbon.
	4 Change the radius in the Radius box, if you wish.
	5 Point to where you want to begin the rectangle.
	6 Draw the rectangle.


	Rounding Existing Rectangles
	To add rounded corners to an existing rectangle
	1 Double click the rectangle with the select pointer. A blue handle appears near the rectangle's ...
	2 Drag the blue handle toward the center of the rectangle.
	3 Release the mouse button when you finish rounding the corners.



	Drawing Regular Polygons
	Using the To Corner Method
	Using the To Side Method
	Using the Single Side Method
	To draw a polygon from center to a corner or a side
	1 Click the Polygon tool in the toolbox.
	2 Click the To Corner button in the ribbon, or click the To Side button in the ribbon.
	3 Enter the number of sides for the polygon in the Sides box (three or more).
	4 Point where you want the center of the polygon.
	5 Drag to draw the polygon.
	6 Release the mouse button when the polygon is the size you want.

	To draw a polygon from the center to a side
	1 Click the Polygon tool in the toolbox.
	2 Click the To Side button in the ribbon.
	3 Enter the number of sides for the polygon in the Sides box (three or more).
	4 Point where you want the center of the polygon.
	5 Drag to draw the polygon.
	6 Release the mouse button when the polygon is the size you want.


	Drawing Stars
	To draw a star
	1 Click the polygon tool in the toolbox.
	2 Click any of the three Star buttons in the ribbon. For example, click the To Point button, the ...
	3 Type the number of points for the star in the Sides box, if you wish.
	4 Press and hold the left mouse button and draw a polygon. To complete the star, release the mous...

	To draw a curvygon
	1 Click the curvygon tool in the toolbox.
	2 Point the cursor where you want the curvygon to start.
	3 Keeping the mouse button pressed, move the pointer to create the curvygon.
	4 You can change the shape of the curvygon by pressing the mouse button while moving the pointer....
	5 To complete the curvygon, either press esc or double-click outside of the curvygon.



	Drawing Elliptical Objects
	Constraining with the Keyboard
	Constraining to a 15-degree Angle
	Constraining to a Square or Circle
	Reversing the Drawing Direction
	Using the From Center Button
	Using the Diagonal Method
	To draw an ellipse using the Diagonal method
	1 Click the Ellipse tool in the toolbox.
	2 Click the Diagonal button in the ribbon.
	3 Point where you want to begin the ellipse's (invisible) rectangular bounding box.
	4 Drag diagonally to draw the ellipse.
	5 Release the mouse button when you finish.


	Using the Height/Width Method
	Using the Diameter Method
	Using the 3-Point Circle Method
	To draw a circle using the 3-Point Circle method
	1 Click the Ellipse tool in the toolbox.
	2 Click the 3-Point Circle button in the ribbon.
	3 Point where you want to place the first point on the circle. Press and hold the left mouse button.
	4 Drag the pointer where you want to place the second point. Release the mouse button.
	5 Move the pointer where you want to place the third point. Click the left mouse button to draw t...


	Drawing an Elliptical Arc
	Using the 3-Point Arc Method
	To draw a 3-point elliptical arc
	1 Click the Ellipse tool in the toolbox.
	2 Click the 3-Point Arc button in the ribbon.
	3 Drag the arc's diameter and release the mouse button.
	4 Move the pointer to create the arc.
	5 Click the left mouse button to draw the arc.


	Tracing the Arc of an Ellipse
	To draw an elliptical arc by tracing an ellipse
	1 Draw the ellipse to use as a template for the arc.
	2 Select the ellipse.
	3 Click the Edit tool and Point Reshape button in the ribbon.
	4 Position the pointer outside the ellipse.
	5 Drag in a circular motion outside of the ellipse. An arc draws on top of the ellipse’s edge.
	6 Release the mouse button and press esc when you finish.


	Editing an Arc
	Drawing a Pie Wedge
	To draw pie wedges using the ribbon
	1 Draw an ellipse.
	2 Click the Pie button in the ribbon.
	3 Position the pointer near the ellipse and drag in a circular motion to create the first wedge.
	4 Release the mouse button when the wedge is the size you want.
	5 Repeat steps 3 and 4 to add more adjacent wedges to the pie.
	6 Press esc or click outside the object when you finish.


	Converting an Ellipse into a Pie Wedge
	To convert an ellipse into a pie wedge
	1 Double click the ellipse with the select pointer to select it for reshaping.
	2 Drag the pointer in a circular motion inside the ellipse. (Dragging outside the ellipse creates...
	3 Press esc or double click when you finish.


	Working with Objects

	Using the Object Explorer
	Selecting an Object
	Clicking to Select Objects
	To select an object by clicking it

	Selecting Overlapping Objects
	Deselecting Objects
	Implied Selection
	Block Selecting Objects
	Selecting All Objects
	Selecting by Name or Physical Characteristic
	To select objects by attribute
	1 Select the object upon which you want to base your search.
	2 Open the Edit menu and choose Select. The Select dialog box opens.
	3 Select the attributes for which to search. For example, if the selected object has a red interi...
	4 Click Select.


	Selecting Objects by Property Value
	To select objects by property value
	1 Open the Edit menu and choose Select. The Select dialog box opens.
	2 Choose a property you want to search for in the Field list box.
	3 Type the value of the property. You can use wildcard characters to search for partial matches.
	4 Click Select.


	Selecting Matching Objects
	Other Clicking Actions
	Moving an Object
	To move an object with the mouse
	1 Select one or more objects you want to move.
	2 Position the pointer anywhere inside the object or group of objects (do not place the pointer o...
	3 Drag the object to the new position.
	4 Release the mouse button.

	To move an object with the arrow keys
	1 Select one or more objects you want to move.
	2 Point anywhere inside the object or group of objects (do not point to a handle).
	3 Press and hold the spacebar.
	4 Press an arrow key to nudge the object.
	5 Release the spacebar when you finish.


	Moving an Object While Drawing it
	To move an object while drawing
	1 Start drawing.
	2 Press and hold the right mouse button without releasing the left mouse button.
	3 Move the outline of the unfinished drawing to its new position.
	4 Release the right mouse button and continue drawing.


	Constraining an Object’s Movement
	Applying Multiple Changes to an Object
	To apply multiple changes to an object
	1 On the Arrange menu, click Transform.
	2 Click one of the submenu commands to display the Transform dialog box.
	3 Click the Details button to show the Multiple Transforms area.
	4 Click a transform tab and select the transformation amounts, origin, and the number of copies.
	5 Click Add in the Multiple Transforms area. The transform type and amount appears.
	6 Repeat steps 5 and 6 to add more transformations to the list.
	7 Select an object and click Apply to apply the multiple transforms.


	Updating a Remembered Transformation
	To update a remembered transformation
	1 On the Arrange menu, click Transform.
	2 Click one of the submenu commands to display the Transform dialog box.
	3 Click the Details button to show the Multiple Transforms area.
	4 Highlight the remembered transform you want to change
	5 Make the changes in the left portion of the dialog box, and click Modify. The new measurements ...

	To delete a remembered transformation
	1 Click Empty to delete all remembered transforms, or
	2 Click Delete to delete the last transform on the list.


	Duplicating Objects
	To drag a copy
	1 Select the object you want to copy.
	2 Press and hold ctrl.
	3 Drag the duplicate object to a new position.
	4 Release the mouse button and then release ctrl.

	To duplicate using the menu
	1 Select the object you want to copy.
	2 From the Edit menu, select Duplicate.


	Scaling Objects
	Resizing Objects Manually
	To resize an object manually
	1 Select the object to resize.
	2 Move the pointer to one of the object’s eight handles.
	3 Drag the handle to resize the object.
	4 Release the mouse button when you finish.


	Resizing Objects Numerically
	To resize an object numerically
	1 Select the object to scale.
	2 Open the Arrange menu and choose Transform.
	3 Choose Scale to display the Scale panel.
	4 Select the origin of the resize in the Origin list box, if you want.
	5 Type a number in the Horizontal and Vertical boxes. A red outline of the resized object appears...
	6 Type the number of copies you want to make, if any.
	7 Click Apply to accept the change.


	Scaling an Object in the Transform Dialog Box
	Making Equally Resized Copies
	Flipping Objects
	Flipping Manually
	To flip an object manually

	Flipping Numerically
	To flip an object horizontally or vertically
	1 Select the object you want to flip.
	2 On the Arrange menu, click Transform, and then click Flip to display the Flip panel.
	3 Choose Flip Horizontal to flip the object horizontally (like a page in a book), or choose Flip ...

	To flip an object at a specified angle
	1 Select the object you want to flip.
	2 On the Change menu, click Transform.
	3 Choose Flip to display the Flip panel.
	4 In the Origin list box, select a point on the object. This is the point that the flip axis pass...
	5 Type an angle from 0 to 179 in the Angle box or drag the red needle to specify a flip angle.

	To make copies of an object while flipping it
	1 Select the object you want to flip.
	2 On the Arrange menu, click Transform.
	3 Choose Flip to display the Flip panel.
	4 Type the number of copies in the Copies box. Designer repeats the flipping, placing copies on t...


	Rotating Objects
	Rotating Objects Manually
	To rotate an object manually
	1 Select the object you want to rotate, and then click the Rotate/Skew button in the toolbar.
	2 Drag the pivot point to a new location, even outside the object, if you want.
	3 Move the pointer to a corner handle.
	4 Drag in a circular motion around the object.
	5 Release the mouse button when you are finished.


	Constraining Manual Rotation
	To change the Manual Rotation Increment
	1 On the Tools menu, click Options.
	2 Click Rotation to go to the Rotate tab.
	3 Enter the rotation amount in the Manual Rotation Increment box (or drag the red needle in the d...


	Using the Preset Rotation Key
	To change the rotation key setting
	1 From the Tools menu, click Options. The Options dialog opens.
	2 Click Rotation.
	3 In the F8 Rotation Increment box, drag the red needle to the desired increment, or type in the ...
	4 Click OK to close the Options dialog.


	Rotating Objects Numerically
	Setting the Rotation Angle
	Changing the Pivot Point
	To rotate an object numerically
	1 Select the object to rotate.
	2 On the Arrange menu, click Transform. A submenu opens.
	3 Click Rotate to display the Rotate panel.
	4 Type a number in the Angle box, or drag the dial to specify a rotation angle.
	5 Select a new pivot point in the Origin list box, if you wish.
	6 Click Apply to rotate the object.


	Copying Rotated/Skewed Objects
	To copy rotated/skewed objects
	1 Select the object to rotate.
	2 From the Arrange menu, click Transform. A submenu opens.
	3 Click Rotate or Skew and type the specifications you want.
	4 Type the number of copies you want to create.
	5 Click Apply to draw the copies.


	Grouping Rotated/Skewed Copies

	Changing the Order of Objects
	To change the order of objects
	1 Select one or more objects.
	2 On the Arrange menu, click Order and click a command on the Order submenu.

	Grouping Objects
	To group objects
	1 Select the objects you want in the group (they don't have to be adjacent)
	2 On the Arrange menu, click Group.


	Ungrouping Objects
	To ungroup objects
	1 Select the group to break apart
	2 On the Arrange menu, click Ungroup.


	Working with Grouped Objects
	Editing a Grouped Object
	To edit an object without ungrouping it
	1 Using the select pointer, double click the object group that contains the object you want to ed...
	2 Select the object to edit. Blue handles appear around the selected object. Edit or move it as y...
	3 Double click anywhere outside the group when you finish.


	Adding a New Object to a Group
	Removing an Object from a Group
	Connecting Objects
	Connect Open
	To connect open
	1 Select the objects you want to connect
	2 On the Arrange menu, click Connect Open, or press ctrl+f11.


	Connect Closed
	To connect closed
	1 Select the objects you want to connect.
	2 On the Arrange menu, click Connect Close, or press f11 (keyboard shortcut).


	Connect Closed when Objects Overlap
	Disconnecting Objects
	To disconnect connected objects
	1 Select the connected object you want to disconnect.
	2 On the Arrange menu, click Disconnect, or press shift+f11.



	Aligning Objects
	Aligning Objects to the Page
	Keyboard Shortcuts for aligning objects
	To align objects to a page
	1 Select the objects you want to align.
	2 From the Arrange menu, click Align. (Keyboard shortcut ALT+1.)
	3 In the Align Selection, click To Page.
	4 Click a vertical and/or horizontal alignment button. The preview box shows an example of the al...
	5 Click Apply to align the objects.


	Aligning Objects as a Group
	Aligning Objects to Other Objects
	To align objects to each other
	1 Select the objects you want to align.
	2 On the Arrange menu, click Align.
	3 Click To Object in the Align Selection section.
	4 Click a vertical and/or horizontal alignment button. The preview box in the panel shows an exam...
	5 Click Apply to align the objects.


	Aligning Objects to a Path
	Distributing Multiple Objects Evenly
	Selecting the Path Object
	Changing the Alignment Justification
	Changing the Alignment Pitch
	Changing the Alignment Direction
	Changing the Alignment Offset
	Changing the Alignment Point
	To set the alignment point to a custom location
	1 Click To Path to display the Align To Path tab.
	2 If the Align To Path tab obscures the objects you want to align, drag it out of the way.
	3 Click the Choose Position button .
	4 Drag the red Alignment Point to the location that you want

	To align objects to a path
	1 Select the objects you want to align, including the object you want to use as a path.
	2 On the Change menu, click Align. A submenu opens.
	3 Click To Path to display the Align To Path tab.
	4 If the Align To Path tab obscures the objects you want to align, drag it out of the way.
	5 Choose the object to use as the path by clicking the Previous button or the Next button in the ...
	6 Choose the Alignment Point that you want.
	7 Change the justification, pitch, and direction settings, if you wish.
	8 Click Apply to align the objects.



	Copying and Pasting Objects
	Pasting Inside
	Paste Special
	Replacing Objects
	Replacing with Multiple Objects
	To replace an object
	1 Cut or copy one or more objects to the Clipboard.
	2 Select the object or group of objects to replace.
	3 On the Arrange menu, click Replace. The Replace dialog box opens.
	4 Change the replacement options, if you wish.
	5 Click Apply. The object in the drawing area is replaced with the contents of the Clipboard.


	Pasting to Fit
	Aligning while Pasting

	OLE (Object Linking and Embedding)
	Embedding/Inserting OLE Objects
	To insert an OLE object
	1 On the Insert menu, click OLE Object. The Insert Object dialog box opens.
	2 Click Create New, and then select the type of object that you want to create. Click OK. The oth...
	3 Use the program to create the object.
	4 When you finish, press the esc key. The object is inserted in the Designer drawing.

	To create an OLE object
	1 On the Insert menu, click OLE Object. The Insert Object dialog box opens.
	2 Click the Create from File option.
	3 Click the Link option if you want to link rather than embed the object.
	4 Click Browse, locate the file, and click Open.


	Linking OLE Objects
	To link an OLE object
	1 Create the object in its original program and save it as a file.
	2 Copy the object you want to link to the Clipboard.
	3 Close the original program if you want.
	4 Open Designer, if necessary.
	5 On Designer’s Edit menu, click Paste Special. The Paste Special dialog box opens.
	6 Click Paste Link. The object is pasted in the center of the page.

	To edit a linked/embedded object
	1 Double click the object to edit. The program in which the object was created (the server) opens...
	2 Edit the object.
	3 On the File menu, click Save to update the changes in Designer.
	4 Close the server program when you finish editing.
	5 Click Yes to save the linked file and update the object in Designer; click No to disregard chan...


	Activating Linked Objects
	Viewing an OLE Link
	Updating an OLE Object
	Breaking an OLE Link
	To break an OLE link
	1 Select the linked object in Designer.
	2 On the Edit menu, click OLE Links.
	3 Click Cancel Link.
	4 You are asked if you want to sever the link permanently. Click Yes to break the link; click No ...


	Changing the Location of a Linked File
	To change an OLE link
	1 Select the object in Designer.
	2 On the Edit menu, click OLE Links. The Links dialog box opens.
	3 Click Change Link. The Change link dialog box opens.
	4 Change to the directory where the source file is located and select the new filename, if necess...
	5 Click OK. The link is reestablished.



	Overview of Point Reshaping
	To select an object for Point Reshaping
	1 Select the object.
	2 In the Toolbox, click the Edit tool .
	3 From the menu, select the Reshape Points command.

	Displaying an Anchor’s Control Points
	To reshape by moving an anchor
	1 Select the object that you want to reshape.
	2 In the Toolbox, click the Edit tool .
	3 From the menu, click the Reshape Points command.
	4 If the object shows a solid anchor (indicating a special Point Reshape case), click the right m...
	5 Click an anchor to select it. It turns solid.
	6 Drag the anchor to a new location. The object’s shape changes.

	To move multiple anchors
	1 Select the object that you want to reshape.
	2 Click the Edit tool in the toolbox.
	3 From the menu, click the Reshape Points command.
	4 If the object shows a solid anchor (indicating a special Point Reshape case), click the right m...
	5 Drag a box around the anchors you want to select.
	6 Press and hold shift, and click the other anchors you want to select. Selected anchors become s...
	7 Drag any selected anchor. All anchors follow the movement.


	Overview of Curve Reshaping
	Moving a single anchor
	Moving multiple anchors
	To select an object for Curve Reshaping
	1 Select the object.
	2 In the Toolbox, click the Edit tool .
	3 From the menu, select Reshape Curves, or select the object, press and hold ctrl+shift, and click.


	Adding and Deleting Anchors
	To add a new anchor to an object
	1 Select the object.
	2 In the Toolbox, click the Edit tool .
	3 On the menu, select Reshape Points or Reshape Curves.
	4 If the object shows a solid anchor (indicating a special Point Reshape case), click the right m...
	5 Click the Add Point button .
	6 Click where you want to add anchor.

	To delete an anchor
	1 If necessary, double-click the object to allow point reshaping.
	2 Click the anchor you want to delete.
	3 On the ribbon, click the Remove Point button . Only the selected anchors are deleted.


	Breaking Apart at an Anchor
	To break apart an object at an anchor
	1 Select the object you want to slice.
	2 In the Toolbox, click the Edit tool .
	3 Select Reshape Points or Reshape Curve from the menu.
	4 If the object shows a solid anchor (indicating a special Point-Reshape case), click the right m...
	5 Select the anchor to break apart.
	6 Click the Slice button . The line is now severed at the anchor.


	Reshaping Curves and Corners
	Converting a corner to a curve
	Converting a curve to a corner
	To reshape a curve
	1 Select the object that you want to reshape.
	2 Click the Edit tool in the toolbox.
	3 Select Reshape Curve in the menu or Hold ctrl+shift and click the object or click the right mou...
	4 Select an anchor on the edge that you want to reshape. Checkerboard-shaped control points appea...
	5 Drag the control points to change the edge’s shape.


	Converting to Curves
	Creating Symmetrical Curves
	To convert a corner to a symmetrical curve
	1 Select the object that you want to reshape.
	2 In the Toolbox, click the Edit tool .
	3 Select Reshape points from the menu or click the right mouse button or hold ctrl and click the ...
	4 If the object shows a solid anchor (indicating a special Point-Reshape case), click the right m...
	5 Click an anchor to select it. It turns solid.
	6 On the ribbon, click the Symmetrical Curve button . The lines touching the anchor become symmet...

	To convert a curve to a corner
	1 Select the object that you want to reshape.
	2 In the Toolbox, click the Edit tool , and select Reshape Points or Reshape Curve.
	3 If the object shows a solid anchor (indicating a special Point-Reshape case), click the right m...
	4 Select the anchor.
	5 Click the Corner button on the Ribbon.


	Creating a Corner
	To create a corner
	1 Select the object that you want to reshape.
	2 In the Toolbox, click the Edit tool .
	3 On the ribbon, click the Curve Reshape button or hold ctrl+shift and click the object.
	4 Select an anchor on the curve.
	5 Click the Corner button . The lines touching the anchor become straight so that a corner is for...


	Creating a Cusp
	To create a cusp
	1 Select the object that you want to reshape.
	2 In the Toolbox, click the Edit tool .
	3 Select Reshape Curve on the menu or hold ctrl+shift and click the object.
	4 Select an anchor on the curve.
	5 Click the Unlocked Cusp button .
	6 Drag one of the control points. Half of the cusp is formed.
	7 Drag the second control point to create the second half of the cusp.


	Cut at Point
	To cut an object
	1 Select the object.
	2 In the Toolbox, click the Edit tool .
	3 Select Reshape Points or Reshape Curve from the menu.
	4 If the object shows a solid anchor (indicating a special Point Reshape case), click the right m...
	5 Click the Cut at Point button .
	6 Drag across the line to be cut. A new, solid anchor appears at the cut location.


	Overview of Special Objects
	To convert a special object to curves

	Joining Endpoints of an Open Object
	To join endpoints of an open object
	1 Select the object that you want to join.
	2 In the Toolbox, click the Edit tool .
	3 Select Reshape Points or Reshape Curve from the menu.
	4 Select one of the endpoints. It turns solid.
	5 Press and hold shift, and select the other endpoint. It turns solid.
	6 Click the Join Points button . Press esc to exit reshape mode. The object is now closed and fil...


	Smoothing an Object
	To smooth an object
	1 Select the object.
	2 On the Object menu, click Reduce Points.
	3 In the Reduce Points dialog box, drag the Points sliding bar toward Less. The further you drag ...


	Trimming Objects
	To trim an inside object
	1 On the Effects menu, select Trim and then click Trim Inside Object on the submenu.
	2 Select the object to be trimmed.
	3 Select the trimming object. The inside object is trimmed.

	To trim an outside object
	1 On the Effects menu, select Trim and then click Trim Outside Object on the submenu.
	2 Select the trimming object.
	3 Select the object to be trimmed. The selected object is trimmed.


	Outlining Objects
	To outline an object
	1 Select one or more objects.
	2 On the Effects menu, select Modify and then click Outline on the submenu.
	3 An outline of the object or group of objects is created.


	Using Dimensions

	Using Dimensions
	Drawing Dimension Lines
	The Dimension Ribbon
	To draw a dimension line
	1 Click the Dimension tool in the toolbox or ctrl+0 (zero).
	2 Click the Aligned, Horizontal, Vertical, Angular, or Radial button in the ribbon.
	3 Move the pointer to the starting point of the object you want to measure, and press and hold th...
	4 Drag the pointer to the endpoint of the object you want to measure and release the mouse button...
	5 Move the mouse in the appropriate direction to offset the dimension line and to adjust the loca...
	6 After positioning the dimension line and text, click the left mouse button to finish drawing th...


	Using Constraint Buttons
	Setting Displayed Precision
	Editing Dimension Lines
	Reshaping Dimension Lines
	To reshape a dimension line
	1 Click the Dimension tool in the toolbox.
	2 Select the dimension line you want to reshape by pointing and clicking the left mouse button.
	3 Click the Reshape button in the ribbon. Solid blue handles appear at the line's endpoints and u...
	4 Drag the handles that you want to change to their new positions. You can use shift to force the...
	5 Press esc or double click the mouse button when you finish.


	Setting Line Ends
	To choose a line end
	1 Click the Dimension tool in the toolbox.
	2 Select the dimension line you want to modify.
	3 Click the Line Ends button in the ribbon. The Line Ends menu opens.
	4 Click the desired line end in the menu. To choose other line ends and other line options, click...


	Transforming Dimension Lines
	To rotate a drawing with dimension lines
	1 Select the objects that you want to rotate, including the dimension lines.
	2 Click the grouped objects a second time to display the rotation handles.
	3 Drag the pivot point to a new location, if you want.
	4 Drag the handles to rotate the drawing. To preview the current location of the rotated drawing,...


	Setting Dimension Text Options
	To add Prefix and Suffix text to a dimension line
	1 Click the Dimension tool in the toolbox.
	2 Select the dimension line you want to modify.
	3 Click the Dimension Options button in the ribbon. The Dimensions dialog box opens.
	4 Click the General button to display the General panel, if necessary.
	5 Click the Prefix text box and enter the text you want to appear before the dimension units; or
	6 Click the Suffix text box and enter the text you want to appear after the dimension units.
	7 Click Apply to add the text to the dimension units.


	Text Orientation Options
	To set a custom angle
	1 Click the Dimension tool in the toolbox.
	2 Select the dimension line you want to modify.
	3 Click the Dimension Options button in the ribbon. The Dimensions dialog box opens.
	4 Click the Text Orientation button to display the Text Orientation panel, if necessary.
	5 Type a number in the Angle text box or drag the red needle in the dial control to specify a cus...
	6 Click the Custom Angle option to select it.
	7 Click Apply to display the dimension at the custom angle.


	Text Position Options
	To display units above a dimension line
	1 Click the Dimension tool in the toolbox.
	2 Select the dimension line you want to modify.
	3 Click the Dimension Options button in the ribbon. The Dimensions dialog box opens.
	4 Click the Text Position button to display the Text Position panel, if necessary.
	5 Click Above Line (under Vert Text Position) to select this option.
	6 Click Apply to reposition the dimension units.


	Using Color

	Display
	Setting Color Options
	Using Dithered Colors
	Black Component
	Choosing Colors
	Using the Color Picker
	To open the Color Picker dialog box
	1 Click Palette Options in the color palette title bar. A menu opens.
	2 Click Add Color.
	3 If the current palette is the master palette, the Palette Name dialog box opens.
	4 Enter a new name for the copy. The Color Picker dialog box opens.


	Choosing HLS Colors
	Choosing RGB Colors
	Choosing CMYK Colors
	To change the way Designer normalizes CMYK percentages
	1 Click the Undercolor Removal button in the Color Picker-CMYK dialog box.
	2 Click Manual if you want to prevent Designer from normalizing the CMYK percentages.


	Naming a Color
	To name a color
	1 Click the New Color color swatch in the Color Picker dialog box.
	2 Type a name.
	3 Press tab or click another field. The name is displayed on the color swatch.


	Using a Color Model
	To choose colors with a color model
	1 Click Palette Options in the Color Palette title bar.
	2 Click Add Color.
	3 If the current palette is the master palette, you are asked if you want to make a copy of the m...
	4 Click a color model tab.
	5 Click the down arrow at the right of the list box to choose the first two dimensions for the co...
	6 Enter the desired value in the current color model's scroll boxes.
	7 Continue to adjust the settings in the selected color model until you have mixed the desired co...
	8 Click Add to add the new color to the current palette.
	9 Repeat steps 5 through 9 to add more colors to the palette.


	Converting Color Model Values
	To convert values to another color model
	1 Click Palette Options in the Color Palette title bar.
	2 Click Palette Manager. The Palette Manager dialog box opens.
	3 Click the color you want to convert and click Model. A menu opens with a check mark by the name...
	4 Click the color model to which you want to convert.
	5 Click OK. The selected color is stored with the new color model.


	Mixing Your Own Color
	To mix colors using the Fill-Solid dialog box
	1 On the Format menu, select Interior Fill and then select Solid from the submenu.
	2 Click the Color Mixer button.
	3 Click a corner of the mixing palette. A pull-down palette opens. Choose a color from the palette.
	4 Repeat steps 2 and 3 to choose a color for each corner of the mixing palette. The color transit...
	5 Select one or more color squares in the mixing palette to choose the desired color(s).
	6 Click Add and Close. The Color Picker dialog closes and your new color(s) now appear in the Obj...
	7 Select the interior or line fill color and click Apply.


	Finding an Object's Color Values
	To find the interior and line color of an object
	1 Select the object
	2 On the Format menu, select Interior Fill and then select Solid from the submenu.
	3 On the Format menu, select Line Fill and then select Solid from the submenu.
	4 The Object Format dialog opens. The fill color and color values display.



	Using the Color Palette
	Palettes Included with Designer
	To open the Color Palette

	Using Lines, Fills, and Patterns

	Overview of the Style Tools
	Style Attributes for Lines Only
	Using Fills with Text
	Using the Object Format Dialog Box
	Selection Tabs
	Format Buttons
	Apply Button and Close Button

	Formatting Lines
	Setting Line Styles
	To choose a line style from the menu
	1 Click the Format tool in the toolbox.
	2 Click the Line Style button in the ribbon. The Line Style menu opens.
	3 Click a style in the menu. The selected line or border changes to the new style.

	To choose a line style from the Line-Style dialog box
	1 Click the Format tool in the toolbox.
	2 Click the Line Style button in the ribbon. The Line Style menu opens.
	3 Click Style. The Line-Style dialog box opens.
	4 Click the style you want.
	5 Click Apply. The selected line or border changes to the new style.


	Setting Line Ends
	To choose a line end from the menu
	1 Click the Format tool in the toolbox.
	2 Click the Line Ends button in the ribbon. The Line Ends menu opens.
	3 Click a line end sample. A selected line changes to the new ends.

	To choose ends from the Line-Ends dialog box
	1 Click the Format tool in the toolbox.
	2 Click the Line Ends button in the ribbon. The Line Ends menu opens.
	3 Click Ends. The Line-Ends dialog box opens.
	4 In the preview window, click the end of the line you want to change. (The end on the left is th...
	5 Click the button of the desired line end, using the scroll arrows to locate the one you want.
	6 Click Apply. A selected line changes to the new style; if no objects are selected, subsequent l...

	To add line ends to the Line-Ends dialog box
	1 Click the Format tool in the toolbox.
	2 Click the Line Ends button in the ribbon. The Line Ends menu opens.
	3 Click Ends. The Line-Ends dialog box opens.
	4 Draw an object to be used as a line end.
	5 On the Edit menu, click Copy to copy your line end to the Clipboard.
	6 Click the Paste button in the Line-Ends dialog box. The line end you created is added to the ga...

	To remove line ends from the Line-Ends dialog box
	1 Click the Format tool in the toolbox.
	2 Click the Line Ends button in the ribbon. The Line Ends menu opens.
	3 Click Ends. The Line-Ends dialog box opens.
	4 Select the line end you want to remove.
	5 Click Remove. The line end is removed from the gallery.


	Editing Line Ends
	Scaling a Line End
	Moving a Line End
	Rotating a Line End
	Setting Line Styles
	To edit line ends
	1 Select the line with the ends you want to edit.
	2 Click the Format tool in the toolbox.
	3 Click the Line Ends button in the ribbon. The Line Ends menu opens.
	4 Click Ends. The Line-Ends dialog box opens.
	5 Choose the settings you want to apply to the line ends.


	Using Weighted Lines
	Setting the Line Thickness
	To choose a line thickness from the menu
	1 Click the Format tool in the toolbox.
	2 Click the Line Thickness button in the ribbon. The Line Thickness menu opens.
	3 Click a line thickness. A selected line changes to the new thickness.

	To set the line thickness in the Line-Thickness dialog box
	1 Click the Format tool in the toolbox.
	2 Click the Line Thickness button in the ribbon. The Line Thickness menu opens.
	3 Click Thickness. The Line-Thickness dialog box opens.
	4 Click the value in the Width box and type a number to change the thickness (width and height ar...
	5 Click Apply.


	Setting Join and Cap Options
	Setting Cap Options
	Setting Join Options
	To set join and cap options
	1 Click the Format tool mp in the toolbox.
	2 Click the Line Thickness button in the ribbon. The Line Thickness menu opens.
	3 Click Thickness. The Line-Thickness dialog box opens.
	4 Click the cap and join options repeatedly until you ones you want are displayed.
	5 Click Apply.


	Creating Calligraphic Lines
	To create calligraphic lines
	1 Click the Format tool in the toolbox.
	2 Click the Line Thickness button in the ribbon. The Line Thickness menu opens.
	3 Click Thickness. The Line-Thickness dialog box opens.
	4 Click Weighted and Calligraphic. Choices for Width, Height, and Pen Angle appear.
	5 Type the Width, Height, and Pen Angle you want. The pen tip is shown in the preview area.
	6 Click Apply.



	Formatting Objects
	Selecting a Solid Color Fill
	To choose an object's color from the Object Format dialog box
	1 Select an object.
	2 Click the Format tool in the toolbox.
	3 Click the Solid Interior Fill button in the ribbon to change the color of the interior.
	4 Click a color in the palette to choose the object's color.
	5 Click Apply to change the object's line or interior color.

	To select an invisible fill or line
	1 Select the object you want to have an invisible fill.
	2 Click the Format tool .
	3 Click the Remove Interior Fill button or the Remove Line button.


	Using Fill Options
	Filling Overlaps
	Fill Before or After Line
	To set fill options
	1 Open the Object Format dialog.
	2 Click Fill Overlaps or Skip Overlaps to set the overlap fill option.
	3 Click Fill Before Line and Fill After Line to set the fill draw sequence option.



	Using Gradient Fills
	Making Gradient Fills Draw Faster
	To make gradient fills draw faster
	To add a gradient fill to a selected object
	1 Click the Format tool in the toolbox. The Format ribbon displays.
	2 Click the Gradient Interior Fill button in the ribbon, or the Gradient Line Fill button . The F...
	3 Click a color in the Color Palette.
	4 Click the point above the color band at 100%.
	5 Click another color in the Color Palette.
	6 Click a gradient button.
	7 To edit, drag the end circles to control the angle. Move the origin square to control the gradi...
	8 You can quickly change the first and last colors for a gradient fill in a selected object witho...



	Using Hatch Fills
	Making Hatch Patterns Draw Faster
	To make hatch patterns draw faster
	To choose a hatch pattern
	1 Select an object.
	2 Click the Format tool in the toolbox.
	3 Click the Hatch Interior Fill button in the ribbon, or the Hatch Line Fill button . The Fill-Ha...
	4 Click a pattern.
	5 To change the foreground color, select Foreground, point to a color in the palette, and click t...
	6 To change the background color, select Background, point to a color in the palette, and click t...
	7 Click Apply. The object redraws with the new hatch pattern and colors.


	Changing the Line Thickness and Spacing of Hatch Fills
	Line Thickness
	Line Spacing
	To change the line thickness and spacing of hatch fills
	1 Select an object.
	2 Click the Format tool in the toolbox.
	3 Click the Hatch Interior Fill button in the ribbon, or the Hatch Line Fill button . The Fill-Ha...
	4 Enter new values for the line thickness and spacing.
	5 Click Apply. The object redraws with the new line thickness and spacing for the hatch pattern.



	Using Image Fills
	To set the image pattern
	1 Select an object.
	2 Click the Format tool in the toolbox.
	3 Click the Image Interior Fill button in the ribbon, or the Image Line Fill button .
	4 Select a category from the pull-down list. The Fill-Image dialog box opens.
	5 Click a pattern to select it.
	6 Click Apply. The object redraws with the new pattern.

	Making Image Fills Draw Faster
	To make image fills draw faster

	Changing the Image Scale
	To change the image scale
	1 Select an object.
	2 Click the Format tool in the toolbox.
	3 Click the Image Interior Fill button in the ribbon, or the Image Line Fill button . The Fill-Im...
	4 Enter a value in the Image Scale area to change the size of the image.
	5 Click Apply. The object redraws with the new image size.


	Creating Image Patterns
	To add image patterns
	1 Create or import a bitmap pattern in your bitmap-editing program.
	2 On the Edit menu, click Copy to copy your pattern to the Clipboard.
	3 In Designer, click the Format tool in the toolbox.
	4 Click the Image Interior Fill button in the ribbon, or the Image Line Fill button . The Fill-Im...
	5 Click Paste. The image pattern you created is added to the gallery of patterns.


	Removing Image Patterns
	To remove image patterns
	1 Click the Format tool in the toolbox.
	2 Click the Image Interior Fill button in the ribbon.
	3 Click the pattern you want to remove to select it.
	4 Click Remove. The image pattern is removed from the gallery of patterns.
	5 Click Apply. The selected object is filled with repetitions of the object chosen from the galle...



	Using Object Fills
	Adding and Removing Object Fills
	To add an object to the gallery
	1 Draw the object to be added to the gallery and select it.
	2 On the Edit menu, click Copy to copy the object to the Clipboard.
	3 Click the Format tool in the toolbox.
	4 Click the Object Interior Fill button in the ribbon, or the Object Line Fill button . The Fill-...
	5 Click Paste to paste the object into the gallery.

	To remove an object from the gallery
	1 Click the Format tool in the toolbox.
	2 Click the Object Interior Fill button in the ribbon, or the Object Line Fill button . The Fill-...
	3 Click the object fill you want to delete.
	4 Click Remove. The object is deleted from the gallery.


	Editing Object Fills
	To edit object fills
	1 Click the Format tool in the toolbox.
	2 Click the Object Interior Fill button in the ribbon.
	3 Select the pattern that you want to edit from the gallery.
	4 Click Edit. The Edit Object Fill dialog box opens.
	5 Make your edits (arrangement, flip, rotate, size, and so forth).
	6 Click Ok and then click Add or Replace to add the edited object fill to the object fill gallery.


	Making Object Fills Draw Faster
	To make object fills draw faster
	To fill an object with other objects
	1 Select the object you want to fill.
	2 Click the Format tool in the toolbox.
	3 Click the Object Interior Fill button in the ribbon, or the Object Line Fill button .
	4 Select the category from the pull-down list. The Fill-Object dialog box opens.
	5 Click the object you want to use for the fill.


	Arranging Object Fills
	Rotating Object Fills
	Scaling and Positioning Object Fills
	Flipping Object Fills
	Masking Objects
	To mask an object
	1 Select an object that you want to mask.
	2 On the Edit menu, click Copy to copy the object to the Clipboard.
	3 Select an object that you want to use as a mask outline.
	4 On the Effects menu, select Masking and then click Paste Inside. A blue edit border appears aro...
	5 Press and hold the left mouse button until an outline of the object to be pasted inside appears.
	6 Position the object and release the mouse button. A copy of the first object is pasted inside t...


	Filling Several Objects with a Continuous Fill

	Using the Style Toolbar
	To apply a style
	1 On the Style toolbar, select a style from the drop list.
	2 Select one or more objects.
	3 Click the Apply Style button on the Style toolbar. The style attributes are applied to the sele...

	To modify a style
	1 On the Style toolbar, click the Modify Style button . The Style dialog displays.
	2 On the Style dialog, click corresponding button for the attribute you want to modify. The Objec...
	3 Make the modifications and click OK to save.
	4 Click Apply and then click OK. The style is modified.

	To add a style
	1 On the Style toolbar, click the Add Style button . The Style dialog displays.
	2 In the Style List, enter a name for the new style and press Enter. The Fill, Line, and Text Sty...
	3 Using the Fill, Line, and Text Style buttons, create the new style.
	4 Click OK. The new style now appears in the style drop list.

	To import a style
	1 On the Style toolbar, click the Style Options button . The Style dialog displays.
	2 Click the Import button. The Import Styles dialog displays.
	3 Click the Open File button. The Open dialog displays. Select the file you want to import and cl...
	4 The style isimported and available for selection.


	Reusing Style Attributes
	Copying and Applying Styles
	To copy style attributes from one object to another
	1 Select an object with the style attributes you want to copy.
	2 On the Format menu, click Pick Up Object Style.
	3 Select the object to which you want to apply the style attributes.
	4 On the Format menu, click Apply Object Style. The style attributes are copied from the first ob...


	Setting Default Styles
	Using Text

	Installing Fonts
	Selecting Fonts, Sizes, and Styles
	Fonts
	Font Sizes
	Font Styles
	To apply text attributes with the Text ribbon
	1 Click the Text tool in the toolbox.
	2 Select the text object or highlight the text you want to change.
	3 Click the attribute in the Text ribbon that you want to apply. The changes are made to the sele...

	To select text attributes with the Text dialog box
	1 Click the Text tool in the toolbox.
	2 Select the text object or highlight the text you want to change.
	3 Click the Text Attributes button in the Text ribbon. The Text dialog box opens.
	4 Click the Fonts button to display the Fonts panel, if necessary.
	5 Choose the attributes you want to apply and click Apply. The changes are made to the selected t...

	To apply a defined style to text
	1 Highlight the text you want to change.
	2 Click the right mouse button. A shortcut menu opens.
	3 Choose the desired style from the menu.

	To apply a text attribute using the shortcut menu
	1 Select the text object or highlight the text you want to change.
	2 Click the right mouse button. The shortcut menu appears.
	3 Choose the attribute you want to apply on the shortcut menu. The changes are made to the select...

	To change text line and interior color
	1 Select or highlight the text you want to change.
	2 Point to a color in the Color Palette and click the left mouse button to change the interior co...
	3 Point to a color in the Color Palette and click the right mouse button to change the line color.

	To change text background color
	1 Select or highlight the text you want to change.
	2 Click the Format tool.
	3 Click the Background Color button. A palette displays.
	4 Point to a color in the palette and click the left mouse button.
	5 Click Apply.



	Using Freeform Text and Block Text
	Adding Freeform Text
	To add freeform text
	1 Click the Text tool in the toolbox.
	2 Click the Text Mode button to display the text pointer, if necessary.
	3 Point where you want the text to begin. Click the left mouse button to display the text cursor.
	4 Type the text. If you make a mistake, press backspace to erase it.
	5 Press esc or double click the left mouse button away from the text when you finish entering the...


	Adding Block Text
	To add a text block
	1 Click the Text tool in the toolbox.
	2 Click the Text Mode button to display the text pointer, if necessary.
	3 Point where you want the text to begin.
	4 Press and hold the left mouse button, and drag the pointer to create a box with dashed lines. T...
	5 Release the mouse button when you finish the box. The text cursor appears inside the container.
	6 Type the text.
	7 Press esc when you finish entering the text.


	Converting between Block and Freeform Text
	To convert between block text and freeform text
	1 Highlight the text you want to convert.
	2 On the Edit menu, click Copy (or Cut) to place the text on the Clipboard.
	3 Double click anywhere outside the text area to deselect all text.
	4 Click the Text tool in the toolbox.
	5 Move the text pointer where you want to place the freeform text, and click the left mouse butto...
	6 On the Edit menu, click Paste. The text appears in the new format.
	7 Press esc when you finish editing.



	Editing Text
	To edit text
	1 Click the Text tool in the toolbox.
	2 Click the Text Mode button to display the text pointer, if necessary.
	3 Point to the text with the text pointer.
	4 Press and hold shift, and click with the left mouse button. The Edit Text window opens.
	5 Edit the text in the window.

	To paste text as freeform text
	1 Copy the text you want in another program.
	2 Change to Designer.
	3 Press ctrl+v to paste the text into Designer
	4 Press esc when you finish editing the text.

	To paste text as block text
	1 Copy the text you want in another program.
	2 Change to Designer.
	3 Click the Text tool in the toolbox.
	4 Click the Text Mode button to display the text pointer, if necessary.
	5 Point where you want the text to begin.
	6 Press and hold the left mouse button, and drag the pointer to create a box with dashed lines. T...
	7 Release the mouse button when you finish the box. The text cursor appears inside the container.
	8 Press ctrl+v to paste the text into Designer
	9 Press esc when you finish editing the text.

	To paste text inside an object
	1 Copy or cut text to the Clipboard.
	2 Select a closed object.
	3 Click the Text tool in the toolbox.
	4 Click the Shape Text button on the Text ribbon.
	5 On the Edit menu, click Paste.
	6 Press esc when you finish editing the text.

	Changing Paragraph Spacing
	Changing Line Spacing
	To change text leading
	1 Click the Text tool in the toolbox.
	2 Select or highlight the text you want to change.
	3 Click the Text Attributes button in the Text ribbon. The Text dialog box opens.
	4 Click the Spacing button to display the Spacing panel, if necessary.
	5 Click the button beside the line leading box and type a new number for the amount of leading.
	6 Click Apply to change the leading.


	Changing Character Spacing
	To change word and character spacing
	1 Click the Text tool in the toolbox.
	2 Select or highlight the text you want to change.
	3 Click the Text Attributes button in the Text ribbon. The Text dialog box opens.
	4 Click the Spacing button to display the Spacing panel, if necessary.
	5 Type a new number in the Inter Word or Inter Character spacing box.
	6 Click Apply to change the spacing.


	Kerning
	To kern text
	1 Click the Text tool in the toolbox.
	2 Click the Text Mode button to display the text pointer, if necessary.
	3 Point to the characters to kern, and press the left mouse button to place the text cursor betwe...
	4 Press and hold ctrl and press the left arrow or right arrow to move the characters closer toget...


	Resizing a Text Container
	To resize a text container
	1 Display the text container, if necessary.
	2 Move the pointer to a container handle.
	3 Drag the handle to a new position.
	4 Release the mouse button.
	5 Repeat steps 2 through 4 to adjust the other handle, if desired.
	6 Press esc when you finish resizing the container.


	Importing Text
	To import text from a text file
	1 Click the Text tool in the toolbox.
	2 Click the Text Mode button to display the text pointer, if necessary.
	3 Click a text object to insert the text cursor.
	4 On the Tools menu, click Import. The Import dialog box opens.
	5 Select Files of type ASCII Text (*.TXT) to import regular ASCII text or select Rich Text Format...
	6 Highlight the file to import and click Import. The text appears.
	7 Press esc when you finish editing.


	Setting Indents, Tabs, and Leaders
	To indent the first line of a paragraph
	1 Click the Text tool in the toolbox.
	2 Select or highlight the text you want to change.
	3 Click the Text Attributes button in the Text ribbon. The Text dialog box opens.
	4 Click the Margins button to display the Margins panel, if necessary.
	5 Type a positive number in the First Indent box to indent the first line of each paragraph to th...
	6 Click Apply to indent the text.


	Setting Tabs
	To set tab stops
	1 Click the Text tool in the toolbox.
	2 Click the Text Attributes button in the Text ribbon to open the Text dialog box.
	3 Click the Tab Stops button to display the Tab Stops panel, if necessary.
	4 Select the type of tab stop, if you want.
	5 Type a position for the tab stop in the Position box.
	6 Click the Add Tab button to add a single tab stop, or click the Repeat Tab button to add repeat...
	7 Click Apply to enter the tab stops.


	Setting Leaders
	To set leaders
	1 Click the Text tool in the toolbox.
	2 Click the Text Attributes button in the Text ribbon to open the Text dialog box.
	3 Click the Tab Stops button to display the Tab Stops panel, if necessary.
	4 Select a current tab in the Current Tabs area.
	5 Select a leader in the Leader box.
	6 Click the Add Tab button . A dialog box appears asking if you want to overwrite the existing tab.
	7 Click Yes. The previous tab is replaced with the new one with the leaders you chose associated ...
	8 Click Apply to put the new tab stops in selected text.

	To use automatic hyphenation
	1 Click the Text tool in the toolbox.
	2 Select or highlight the text you want to hyphenate.
	3 Click the Text Attributes button in the Text ribbon. The Text dialog box opens.
	4 Click the Spacing button to display the Spacing panel, if necessary.
	5 Select the Use Automatic Hyphenation option.
	6 Click Apply to change the spacing.


	Using Drop Caps
	To create an initial drop cap
	1 Click the Text tool in the toolbox.
	2 Select or highlight the text you want to change.
	3 Click the Text Attributes button to open the Text dialog box.
	4 Click the Spacing button to display the Spacing panel, if necessary.
	5 Select the Use Drop Caps option.
	6 Change the percentage for the drop cap size.
	7 Click Apply.


	Aligning Text
	Text Alignment Options
	Aligning Freeform Text
	Aligning Block Text
	Fitting Text to a Path
	Entering Text along a Path
	To enter text directly along an object’s path
	1 Select the object along which you want to place the text.
	2 Click the Text tool in the toolbox.
	3 Click the Path Text button . The text cursor appears on the path.
	4 Type the text, which appears along the object as you type.
	5 Press esc when you finish.


	Using the Path Fit Palette
	Using the Choose Position Ribbon
	To set text alignment for text on a path
	1 Select the text you want to align.
	2 Click the Text tool in the toolbox.
	3 Click the Path Fit button . A palette opens.
	4 Click Choose Position. The Choose Position ribbon opens.
	5 Click an alignment button for the alignment you want.
	6 Press esc when you finish.

	To set text position for text on a path
	1 Select the text you want to change the position of.
	2 Click the Text tool in the toolbox.
	3 Click the Path Fit button . A palette opens.
	4 Click Choose Position. The Choose Position ribbon opens.
	5 Click the Above Path button or Below Path button to specify the position for the text.

	To change the offset of text on a path
	1 Select the text you want to change the offset of.
	2 Click the Text tool in the toolbox.
	3 Click the Path Fit button . A palette opens.
	4 Click Choose Position. The Choose Position ribbon opens.
	5 Enter the offset percentage you want in the Offset Percentage box.

	To change the direction of text on a path
	1 Select the text you want to change the offset of.
	2 Click the Text tool in the toolbox.
	3 Click the Path Fit button . A palette opens.
	4 Click Choose Position. The Choose Position ribbon opens.
	5 Click the Reverse button or Forward button to set the direction you want.

	To change the alignment pitch of text on a path
	1 Select the text you want to change the alignment pitch of.
	2 Click the Text tool in the toolbox.
	3 Click the Path Fit button . A palette opens.
	4 Click Choose Position. The Choose Position ribbon opens.
	5 Click the alignment button to set the alignment you want.

	To resize a text container
	1 Display the text container, if necessary.
	2 Move the pointer to a container handle.
	3 Drag the handle to a new position.
	4 Release the mouse button.
	5 Repeat steps 2 through 4 to adjust the other handle, if desired.
	6 Press esc when you finish resizing the container.


	Importing Text
	To import text from a text file
	1 Click the Text tool in the toolbox.
	2 Click the Text Mode button to display the text pointer, if necessary.
	3 Click a text object to insert the text cursor.
	4 On the Tools menu, click Import. The Import dialog box opens.
	5 Select Files of type ASCII Text (*.TXT) to import regular ASCII text or select Rich Text Format...
	6 Highlight the file to import and click Import. The text appears.
	7 Press esc when you finish editing.


	Setting Indents, Tabs, and Leaders
	To remove text from a path
	1 Select the text you want to remove from a path.
	2 Click the Text tool in the toolbox.
	3 Click the Path Fit button . A palette opens.
	4 Click Remove Curve. The text is removed from the path. It is now freeform text.

	To place existing freeform text along an existing object’s path
	1 Select both the freeform text and the object to which you want to align it.
	2 Click the Text tool in the toolbox.
	3 Click the Path Fit button . The Path Fit palette opens.
	4 Click the desired quick choice button. The text is put along the path.


	Text Inside of an Object
	To place text inside of an object
	1 Select a closed object.
	2 Click the Text tool in the toolbox.
	3 Click the Shape Text button in the Text ribbon. The text cursor appears inside the selected obj...
	4 Type, paste, or import the text.
	5 Press esc when you finish.


	Splitting and Joining Text
	To split a multi-line text object
	1 Select the text object.
	2 On the Change menu, point to Text and click Split Text. Each line of text becomes a separate te...

	To join text objects
	1 Select the text objects to join.
	2 On the Change menu, point to Text and click Join Text. The text becomes one object based on the...



	Reshaping Text
	To reshape a warped object
	1 Select the object.
	2 Click the Edit tool in the toolbox.
	3 Click the Warp button in the ribbon.
	4 Click the Warp Type button .
	5 Click the Bezier Warp button .

	Reshaping Block Text
	To reshape a block text object with anchors
	1 Select the block text you want to reshape.
	2 Click the Edit tool in the toolbox and click the Curve Reshape button in the Edit ribbon.
	3 Point to an unselected anchor.
	4 Press the left mouse button and drag the point to a new location. The text container’s shape ch...
	5 Release the mouse button when you finish. The text reflows to maintain its margins.
	6 Repeat steps 3 through 5 to reshape other edges of the container.

	To reshape a block text object with control points
	1 Select the block text you want to reshape.
	2 Click the Edit tool in the toolbox and click the Curve Reshape button in the Edit ribbon.
	3 Click an anchor to select it. It turns solid.
	4 Drag a control point. The text container’s shape changes.
	5 Release the mouse button when you finish. The text reflows to maintain its margins.
	6 Repeat steps 3 through 5 to reshape other edges of the container.


	Wrapping Text around an Object
	To repel text
	1 Select the object for the text to wrap around.
	2 On the Change menu, point to Text and click Repel Text. The text wraps around the object.


	Flowing Text
	To create a new flowing text container
	1 Click the Text tool in the toolbox.
	2 Click the Text Mode button to display the text pointer, if necessary.
	3 Click the text with the text pointer.
	4 Click the overflow handle to create a second block of the same size near the original.

	To flow text from one container to another
	1 Select the text containers to connect.
	2 On the Change menu, point to Text and click Flow Text. The text containers are connected.



	Checking Spelling
	To check spelling in a drawing
	1 Select the text you want to check.
	2 Click the Text tool in the toolbox.
	3 Click the Spelling button in the Text ribbon. If a misspelled word is found, Designer opens the...
	4 Type the correct spelling for the word in the Change To box and click Change; or
	5 Click Ignore or Ignore All to ignore the word or every instance of the word, respectively; or
	6 Select one of the words in the Suggestions box and click Change or Change All.
	7 Click Add to add the word to the dictionary and continue.

	To ignore misspelled words
	To change the misspelled word
	To add the misspelled word to the dictionary
	Using Dictionaries
	To create a new custom dictionary
	1 Click the Text tool in the toolbox.
	2 Click the Spelling button in the Text ribbon. The Spelling dialog box opens.
	3 Click the Options button to open the Options - Spelling dialog box.
	4 Click New. The Save As dialog box opens.
	5 Type a name for the dictionary. (Designer automatically adds the "dic" extension.)
	6 Click Save. Designer adds the dictionary to the list of Custom Dictionaries.

	To use a custom dictionary
	1 Click the Text tool in the toolbox.
	2 Click the Spelling button in the Text ribbon. The Spelling dialog box opens.
	3 Click the Options button to open the Options - Spelling dialog box.
	4 Click the check box in front of the dictionary you want to use.


	Using Special Characters
	Using the Keypad
	Dingbats
	The Windows Character Map
	To insert a character with the keypad
	1 Select the font to use.
	2 Place the text cursor where you want the special character.
	3 Turn on num lock on the keypad, if necessary.
	4 Press and hold alt and type 0 (zero) and the three digit character code. For example, to insert...
	5 Release alt. The special character is inserted in the text.


	Creating Special Effects

	Warping Effects
	To warp an object
	1 Select the object to warp.
	2 Click the Edit tool in the toolbox.
	3 Click Warp button in the menu. A blue warp envelope appears over the object.
	4 Point to a handle and drag it to change the envelope.
	5 Repeat step 4 to create the desired warp.
	6 Double click or press esc when you finish to remove the envelope.

	To reshape the warp envelope
	1 Select the object to warp.
	2 Click the Edit tool in the toolbox.
	3 Click Warp in the menu. A blue warp envelope appears over the object.
	4 Click the Warp Type button and choose how you want to reshape the warp envelope.
	5 Click Line Warp from the menu to reshape the envelope with lines and no curves.
	6 Click Curve Warp from the menu to create curving lines when you reshape points on the envelope.
	7 Click Bezier Warp from the menu to reshape the envelope with Bezier control points. You can use...
	8 Point to a handle and drag it to change the envelope.
	9 Repeat steps 4 and 5 to create the desired warp.
	10 Double click or press esc when you finish to remove the envelope.

	To add a new warp envelope
	1 Select the object to warp.
	2 Click the Edit tool in the toolbox.
	3 Click Warp on the menu. A blue warp envelope appears over the object.
	4 Point to a handle and drag it to change the envelope.
	5 Repeat step 4 to create the desired warp.
	6 Click the Add Warp button on the ribbon. The previous, warped envelope is replaced with a new e...
	7 Repeat steps 4 through 6 to create the desired warp.
	8 Double click or press esc when you finish to remove the envelope.

	To remove a warp envelope
	1 Select the object to warp.
	2 Click the Edit tool in the toolbox.
	3 Click Warp on the menu. A blue warp envelope appears over the object.
	4 Point to a handle and drag it to change the envelope.
	5 Click the Remove Warp button . The object is restored to its previous shape.
	6 Double click or press esc when you finish to remove the envelope.

	To increase the density of a warp envelope
	1 Select the object to warp.
	2 Click the Edit tool in the toolbox.
	3 Click Warp on the menu. A blue warp envelope appears over the object.
	4 Click the Add Horizontal Lines button to double the number of horizontal envelope grid lines; or
	5 Click the Add Vertical Lines button to double the number of vertical grid lines.
	6 Point to a handle and drag it to change the envelope.
	7 Repeat step 5 to create the desired warp.
	8 Double click or press esc when you finish to remove the envelope.


	Skewing Effects
	Skewing Manually
	To skew an object manually
	1 Click the Rotate/Skew tool in the toolbar.
	2 Point to a side handle of the object.
	3 Drag the handle to skew the object.
	4 Release the handle when you are done.


	Skewing Numerically
	To skew an object numerically
	1 Select the object you want to skew.
	2 From the Arrange menu, click Transform.
	3 Click Skew to display the Skew panel.
	4 Type an angle from -89 to 89 in the Horizontal Angle box, or drag the dial to specify an angle.
	5 Type an angle from -89 to 89 in the Vertical Angle box, or drag the dial to specify an angle.
	6 Select a different pivot point for the slant in the Origin list box, if you want.
	7 Click Apply to skew the object.

	To specify a degree of slant
	1 Select the object you want to skew.
	2 On the Arrange menu, click Transform. A submenu opens.
	3 Click Skew to display the Skew panel.
	4 Type an angle from -89 to 89 in the Horizontal Angle box, or drag the dial to specify an angle.
	5 Type an angle from -89 to 89 in the Vertical Angle box, or drag the dial to specify an angle.
	6 Select a different pivot point for the slant in the Origin list box, if you want.
	7 Click Apply to skew the object.



	Transparency
	Applying Variable Transparency
	To apply variable transparency to an object
	1 Select a closed object.
	2 Click the Format tool in the toolbox to display the Format ribbon.
	3 On the ribbon, click either the Solid Transparency button or the Gradient Transparency button. ...
	4 If you want a dynamic preview, click the Preview button.
	5 Drag the Transparency Control slider to adjust the transparency.
	6 Click the Apply button when you have finished.

	To remove transparency from an object
	1 Select the object.
	2 Click the Format tool in the toolbox to display the Format ribbon.
	3 On the ribbon, click the Remove Transparency button



	Magnification
	Using an Object to Magnify Other Objects
	To apply magnification
	1 Create or select the object that will become a magnifying object.
	2 Move the object to the area you want to magnify.
	3 On the Tools menu, click Magnify. The Magnify dialog box appears.
	4 Click the Enable checkbox to specify that you want to make the currently selected object a magn...
	5 Set the magnification amount as desired. A setting of less than 1.0 shrinks the viewed area ins...
	6 Click the Apply button to update the magnifying object with the area being magnified.
	7 Move and resize the shape as required to show the desired viewing point within it.
	8 When you are satisfied with the viewing point, click the Freeze Viewpoint checkbox, and click A...

	To remove an object’s magnification
	1 Select the object.
	2 On the Tools menu, click Magnify. The Magnify dialog box appears.
	3 Click the Enable checkbox to clear it.
	4 Click the Apply button.



	Blending Effects
	Transformation Effects
	Highlighting Effects
	To blend two objects
	1 Select the objects you want to blend.
	2 Click Blend in the Effects menu. The Blend dialog box opens.
	3 Choose the settings you want.
	4 Click Apply. The objects are blended. The dialog box stays open so you can continue to blend ob...

	To change the origins before blending
	1 Select the objects you want to blend.
	2 On the Effects menu, click Blend. The Blend dialog box opens.
	3 Click Choose Origins.
	4 On the back object, click a hollow box to select that position as the origin.
	5 On the front object, click the hollow box in the position you want to correspond to the point y...
	6 Click Choose Origins again to deselect it.
	7 Choose the other settings you want.
	8 Click Apply. The objects are blended. The dialog box stays open so you can continue to blend ob...

	To reverse the blend direction
	1 Select the objects you want to blend.
	2 Click Blend in the Effects menu. The Blend dialog box opens.
	3 Click Reverse Direction.
	4 Choose the other settings you want.
	5 Click Apply. The objects are blended. The dialog box stays open so you can continue to blend ob...



	Special Text Effects
	Converting Text to Curves
	To convert text to object outlines
	1 Select the text to convert.
	2 Click Convert to Curves in the Object menu.
	3 On the Arrange menu, click Disconnect. You can now click individual characters to select them. ...


	Working with Bitmap Images

	Overview of Working with Bitmap Images
	Bitmap Import Options
	Editing a Bitmap Image
	Coloring Monochrome Images
	Cropping a Bitmap Image
	To crop an image in Designer
	1 Select the bitmap image you want to crop.
	2 Click the Bitmap tool in the toolbox.
	3 Click the Crop button in the ribbon. The bitmap is highlighted and handles appear around the cr...
	4 Resize the crop mask until it is the size you want.
	5 Move the pointer onto the image. Press and hold the mouse button, and position the image under ...
	6 Release the mouse button when you finish.
	7 Repeat steps 4 through 6 to adjust the crop, if necessary.
	8 Double click or press esc to stop cropping.



	Tracing Bitmaps
	Basics of Tracing
	Tracing an Entire Bitmap Image
	Tracing the Rectangular Area of a Bitmap Image
	Tracing an Object in a Bitmap Image
	Stop Tracing

	Setting Tracing Options
	Showing and Hiding the Bitmap
	Setting the Trace Quality
	Setting Noise and Color Controls
	Setting the Line Type
	Tips for Tracing
	To trace a bitmap
	1 Click the Bitmap tool in the toolbox.
	2 Select the bitmap image you want to trace.
	3 Drag a rectangle over an area of the image. The area in the rectangle is traced. A border appea...
	4 After tracing, click outside of the border, point to the image and drag the tracing off of the ...


	Printing Your Work
	Adding, Removing, and Connecting Printers


	Selecting and Setting Up Your Printer
	Selecting the Target Printer
	Setting the Printer’s Properties
	To select a target printer
	1 On the File menu, click Print. The Print submenu opens.
	2 Click Target Printer. The Target Printer dialog box opens.
	3 Select the printer you want to use.

	To set up a target printer
	1 On the File menu, click Print. The Print submenu opens.
	2 Click Target Printer. The Target Printer dialog box opens.
	3 Select the printer you want to use.
	4 Click Properties. The property sheet for the selected printer driver opens.
	5 Select the options you want. Make sure the orientation (portrait or landscape) matches the on-s...

	Using a Pen Plotter
	Scalable Fonts
	Device-Dependent Fonts

	Basic Printing Methods
	Printing Selected Objects
	1 Select the object on the current page you want to print.
	2 On the File menu, click Print. The Print submenu opens.
	3 Click Selection. The selected object is printed.

	Printing a Defined Area
	1 On the File menu, click Print. The Print submenu opens.
	2 Click View. The print view pointer appears.
	3 Position the print view pointer at one corner of the area you want to print, and press and hold...
	4 Drag a bounding box around the area you want to print. Release the mouse button. The selected a...

	Printing Page Ranges
	Collating Printed Pages
	Printing Mirror Images
	Vector Clipping
	Fitting a Document to the Page
	Centering a Printout on the Page
	Darkening or lightening printed RGB bitmaps
	To set the RGB color value
	1 Click Options in the Tools menu. Click the Registry tab.
	2 In the Key list box, locate and select Mgxgre as the key.
	3 Click New Value, and then enter EnableCMYKBlackOpt as the Value Name.
	4 Click Numeric Value Type.
	5 Enter the value (0 or 1), and click the Accept entry button.

	To print the current page
	1 Click Print in the File menu. The Print submenu opens.
	2 Click Current Page. All objects on the current page are printed.

	To print a selection
	1 Select the objects on the current page you want to print.
	2 Click Print in the File menu. The Print submenu opens.
	3 Click Selection. All selected objects are printed.

	To print a defined area
	1 Click Print on the File menu. The Print submenu opens.
	2 Click View. The print view pointer appears.
	3 Position the print view pointer at one corner of the area you want to print.
	4 Drag a bounding box around the area you want to print. When you release the mouse button, the s...

	To print the active document
	1 Click Print on the File menu. The Print submenu opens.
	2 Click Document. The Print Document dialog box opens.
	3 Type the number of copies you want to print.
	4 Choose the options you want.
	5 If you wish, click Target Printer, choose the printer you want to use, and click OK.
	6 If you wish, click Setup, make any changes to printer settings, and click OK.
	7 Click Print. The document is printed.

	To print selected pages with the Page Manager
	1 Open a document.
	2 Click the Page Manager tool in the toolbox. Thumbnail images are displayed for each page in the...
	3 Select the thumbnail of each page you want to print. A rectangle appears around each selected p...
	4 Click the Print button in the ribbon. The Print Document dialog box opens. The range of pages y...
	5 Type the number of copies you want to print.
	6 Choose the options you want.
	7 Click Print. The selected pages are sent to the target printer.

	To print multiple documents
	1 Click Print in the File menu. The Print submenu opens.
	2 Click Multiple Files. The Print Multiple Files dialog box opens.
	3 If necessary, change to the desired drive and directory.
	4 Choose the name of a document you want to print.
	5 Click Print. The selected document is sent to the printer.
	6 Repeat steps 4 and 5 until you have chosen all the documents you want to print.

	To remove files from the print queue
	1 Click Show Tasks in the View menu.
	2 Click the name of the file (or files) you want to remove from the queue.
	3 Click the Stop button .


	iGrafx Designer 1.0 Tutorial

	Getting Started
	Managing a Designer Project
	Setting Page Options
	1 From the File menu, click Page Setup. The Page Setup dialog box opens.
	2 Click the arrow key to display the paper size settings.
	3 Select A4. This will give you a paper size of 21cm x 29.7cm.
	4 Click the Units button and select cm as your standard unit of measure.
	5 Leave the other settings as they are and click the Margins tab.
	6 In the Margins dialog box, click the Show Page Crop Marks button.
	7 Type the following new margin sizes in the Top, Bottom, Left, and Right Margin list boxes: .98,...
	8 Click OK

	Setting General Options
	1 From the Tools menu, click Options. This opens the Options dialog box. The General options are ...
	2 Type 7 in the Undo Event Limit box. Designer will now allow you to undo the last seven actions.
	3 Type 8 in the Auto Save Time Period box to automatically save your work every eight minutes.
	4 Type .25 in the Horizontal Units box and the Vertical Units box. When you duplicate a selected ...
	5 Make sure that the box, Use Smart Colorization When Applying Fills to Groups is checked. This w...

	Setting Display Options
	1 Click the Display tab to reveal the display settings.
	2 Select Anti-Alias Full Screen View. This will display an anti-aliased view of your bridge while...

	Setting Ruler Options
	1 Click the Rulers tab to open the Rulers dialog box.
	2 Type 12 in the Snaps Per Unit boxes. This sets the number of snap points to 12 per inch and aff...
	3 Leave the Label Frequency at 1. The Label refers to the actual unit number that appears on the ...
	4 Click the arrow in both Displayed Precision boxes and select x.xxx. This value sets the decimal...

	Setting Snap Options
	1 Click the Snap tab. The Snap dialog box opens.
	2 In the Settings section, select Snap to Rulers and Snap to Guides to align objects precisely al...
	3 Select Dragging Snap to allow an object’s bounding box (its selection frame) to snap to a ruler...
	4 Select Dynamic Snap to link object lines together. This is a great way to make accurate extensi...
	5 In the Object Snap Points section, select where you want a snap point to appear on an object. C...

	Setting Rotation Options
	1 Click the Rotation tab to display the Rotation dialog box.
	2 Type 45 in the F8 Rotation Increment box.

	Defining Custom Units
	1 On the Tools menu, click Custom Units. The Defined Custom Units dialog box opens.
	2 Click Add Unit. The Add Custom Unit dialog box opens.
	3 Type METERS (SCALE 5) in the Unit Name box. Adding SCALE 5 to the name makes it easy to identif...
	4 Under Designer Units, type 5 in the Scale spin box, or click the arrows beside the box to selec...
	5 Under Designer Units, type m in the Label box.
	6 Under Real World Units, click the arrow beside the label list box, and choose centimeters.
	7 Click Ok, then click Ok again.
	To change the rulers to the new scale
	1 Right-click on the ruler.
	2 Select Ruler/Snap Options.
	3 Click the Units button.
	4 Select More Units from the menu. This opens the Available Units dialog.
	5 Select your new scale. It will have an asterisk by it.


	Setting Object Names, Fields and Values
	Fields and Values
	To name (or rename) an object:
	1 On the File menu, click Open.
	2 Navigate to the Tutorials folder and click Bridge.dsf.
	3 Select the Cable Flange (highlighted yellow).
	4 On the Object menu, click Properties. The Properties dialog box opens.
	5 Type Cable Flange in the Object Name box and click Apply.
	6 Click Close.

	To add fields and values:
	1 Select the Cable Flange.
	2 On the Object menu, click Properties. The Properties dialog box opens. Notice that Cable Flange...
	3 Click Add.
	4 Type Cost in the Field box and press the tab key.
	5 Type 3.25 in the Value box and click Add.
	6 Type Part Number in the Field box and press the tab key.
	7 Type TL805-995 in the Value box and click Add.
	8 Type the remaining information in the appropriate Field and Value box as illustrated.
	9 Click Apply and then click Close.


	Assigning Values to Other Properties
	To list objects

	Managing User Profiles
	1 On the Tools menu, click Options and then the Profile tab. The Options dialog box opens.
	2 Click the Profile button and then click New.
	3 Type GregT in the Profile Document list box. Click Ok.
	4 Type Monroe Account/CC#2256 in the Description list box.
	5 Click OK.


	Managing the Designer Registry
	To change the value of a registry key
	1 On the Tools menu, click Options and then the Registry tab. The Registry dialog box opens.
	2 Click to highlight the Mgxgre key name from the Key list box.
	3 Click New.
	4 Select Boolean Value from the menu.
	5 Type EnablePSAdapt and press enter.
	6 In the Value list, click in the value box beside EnablePSAdapt. A box with a check mark will ap...
	7 Click the check mark so it disappears. This will change the value from 1 to 0 which means your ...
	8 Click OK to confirm the change and to close the Options dialog box.


	Creating a Technical Illustration
	Opening the Designer File
	1 From the File menu, click Open.
	2 Double click the file WATCH.DSF. The drawing appears in the drawing area.
	3 From the File menu, click Save As. The Save As dialog box opens.
	4 Type MYWATCH in the text box and press enter. The file is saved as MYWATCH.DSF.

	Changing the Page Color
	1 From the File menu, click Page Setup. The Page Setup dialog box opens.
	2 Click the Margins Tab.
	3 Click Enabled in the Page Fill dialog.
	4 Click the Page Fill button to open the Object Format dialog box.
	5 Click the Solid Fill button and double click a light gray color swatch in the Color Palette.
	6 Click OK in the Object Format dialog box. The page preview becomes gray.
	7 Click OK in the Page Setup dialog box.

	Dragging a Guide
	1 Point to the vertical ruler at the left.
	2 Press and hold the left mouse button and drag toward the right. A vertical guide appears.
	3 Move the vertical guide line so that it passes through the center of the bottom watch mechanism...
	4 Point to a horizontal ruler at the top of the Designer window.
	5 Press and hold the left mouse button and drag downward. A horizontal guide appears.
	6 Move the horizontal guide line so that it rests on the top of the bottom watch mechanism. Relea...
	7 Press ctrl+s to save your work.

	Importing an AutoCAD File
	To import a DXF File
	1 From the File menu, click Import. The Import dialog box opens.
	2 Click the down arrow in the Files of Type box and click the DXF format to select it.
	3 Double click the file WATCHTOP.DXF. The imported drawing of the watch’s top assembly appears in...
	4 Line up the watch top against the guides you created earlier.


	Changing to a Different Layer
	Drawing Two Lines Using Exact Coordinates
	To draw the first line
	1 From the Object menu, click Coordinates. The Coordinates dialog box opens.
	2 Click the Create a New radio button.
	3 Click the arrow button and select Jointed Line from the list of objects.
	4 From the Method list box, click the arrow button and select Range.
	5 Highlight the number in the X1 coordinate box. Type 4.8.
	6 Press tab to highlight the Y1 coordinate box. Type 2.56.
	7 Press tab to highlight the X2 coordinate box. Type 4.8.
	8 Press tab to highlight the Y2 coordinate box. Type 6.14.
	9 Press enter. The line is created at the specified location.

	To draw the second line:
	1 In the X1 coordinate box, type 6.07.
	2 In the Y1 coordinate box, type 2.56.
	3 In the X2 coordinate box, type 6.07.
	4 In the Y2 coordinate box, type 7.83.
	5 Press enter. The line moves to the specified location.
	6 Click Close to close the Coordinates dialog box.


	Changing Line Styles
	1 Select both lines by clicking the first line, holding down the shift key, and then clicking the...
	2 Click the Simple Line tool in the toolbox.
	3 Click the Line Style button in the status bar. The Object Format dialog box opens.
	4 Click the Line Style tab.
	5 Click the Line Style button to display the available lines.
	6 Click a “dash-dot” style to choose it (you can choose any style you prefer).
	7 Click Apply and then Close to close the dialog box.

	Changing the Line Weight and Cap Style
	1 Click the Simple Line tool in the toolbox.
	2 Click the Line Style button in the status bar. The Object Format dialog box opens.
	3 Click the Line Style tab.
	4 Click the Line Thickness button.
	5 Select Thick as the line weight.
	6 Type 2.00 in the Width box.
	7 Click the Round Join button.
	8 Click Apply and then Close to close the dialog box.

	Moving and Duplicating Objects
	1 Select the screw in the upper right corner of the drawing.
	2 From the Arrange menu, point to Transform and click Move. The Transform dialog box opens.
	3 Type 1 in the Copies list box.
	4 Click Apply.
	5 Drag the screw so that the duplicate is above the first (left) dotted line.
	6 Click Close.
	7 If necessary, select and drag the original screw so that it is above the second (right) dotted ...

	Slicing Lines
	To zoom in and slice the lines
	1 Click the View tool in the toolbox and click the Zoom In tool.
	2 Zoom in to the top right portion of the drawing by dragging the pointer over the area you want ...
	3 Select the first (left) dotted line.
	4 Click the Edit tool in the toolbox.
	5 Click Reshape Points from the menu.
	6 Click the Cut at Point button in the ribbon.
	7 Drag across the dotted line where the line crosses the first hole. (See the illustration for wh...
	8 Press esc to leave the reshape points mode.
	9 Select the bottom section of the line and repeat step 5.
	10 Drag across the dotted line where it intersects the bottom of the top assembly. The cut sectio...
	11 Press del to delete the selected line.
	12 Select the second (right) dotted line.
	13 Repeat steps 4 through 9.
	14 Click the View tool and click Full Page to view the entire drawing.
	15 Press ctrl+s to save your work.


	Showing Dimensions
	1 Click the Bottom Assembly layer tab at the bottom of the screen.
	2 Click the Dimension tool and click the Horizontal Dimension Line button in the ribbon.
	3 Click the Dimension Line Ends button in the ribbon. Choose an arrow end style that displays arr...
	4 Click the Center Text button in the ribbon.
	5 Point to the left edge of the bottom assembly of the watch, and press and hold the left mouse b...
	6 Drag the pointer horizontally to the right edge of the bottom assembly and release the mouse bu...
	7 Move the mouse to the top of the drawing, just under the title, “Mechanical Watch Assembly.”
	8 Click the left mouse button.
	9 If you make a mistake while drawing a dimension line, you can press esc to start over.
	10 Press ctrl+s to save your work.
	11 Assigning Names, Fields, and Values to Objects
	12 You can use Designer to help keep track of the number and names of parts in a drawing. In this...
	13 From the File menu, click Open.
	14 Navigate to the Tutorials folder and double-click WATCH9.DSF.
	15 Select the large screw at the top right portion of the drawing.
	16 Point to the Object menu and click Properties. The Object Properties dialog box opens.
	17 In the Object Name box, type Screw.
	18 Click the Fields button, select Size, and click OK.
	19 In the Value area, type Large.
	20 Click Apply.
	21 Select a medium sized screw on the left portion of the drawing.
	22 In the Object Name box, type screw.
	23 In the Value area, type medium.
	24 Click Apply.

	Listing the Parts in a Drawing
	1 From the Object menu, click List. The Object Properties List dialog box opens.
	2 Click Copy to copy the list to the Clipboard, and click Close to close the Object Properties Li...

	Adding a New Page
	1 Click the Pages button at the bottom left of the drawing window. The Pages dialog box opens.
	2 Click Add to add a second page to the drawing. The second page displays.
	3 Click Close to close the Pages dialog box.
	4 From the Edit menu, click Paste. The list of parts appears in the center of the page.
	5 Click the Page 1 tab to return to the first page.
	6 Press ctrl+s to save your work.
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